ABOUT THE MARK OF THE UNICORN LICENSE AGREEMENT AND LIMITED WARRANTY ON SOFTWARE TO PERSONS WHO PURCHASE OR USE THIS PRODUCT: carefully read all the terms and conditions of the "click-wrap" license agreement presented to you when you install the software. Using the software or this documentation indicates your acceptance of the terms and conditions of that license agreement.

Mark of the Unicorn, Inc. ("MOTU") owns both this program and its documentation. Both the program and the documentation are protected under applicable copyright, trademark, and trade-secret laws. Your right to use the program and the documentation are limited to the terms and conditions described in the license agreement.

REMINDER OF THE TERMS OF YOUR LICENSE
This summary is not your license agreement, just a reminder of its terms. The actual license can be read and printed by running the installation program for the software. That license agreement is a contract, and clicking "Accept" binds you and MOTU to all its terms and conditions. In the event anything contained in this summary is incomplete or in conflict with the actual click-wrap license agreement, the terms of the click-wrap agreement prevail.

YOU MAY: (a) use the enclosed program on a single computer; (b) physically transfer the program from one computer to another provided that the program is used on only one computer at a time and that you remove any copies of the program from the computer from which the program is being transferred; (c) make copies of the program solely for backup purposes. You must reproduce and include the copyright notice on a label on any backup copy.

YOU MAY NOT: (a) distribute copies of the program or the documentation to others; (b) rent, lease or grant sublicenses or other rights to the program; (c) provide use of the program in a computer service business, network, time-sharing, multiple CPU or multiple user arrangement without the prior written consent of MOTU; (d) translate, adapt, reverse engineer, decompile, disassemble, or otherwise alter the program or related documentation without the prior written consent of MOTU.

MOTU warrants to the original licensee that the disk(s) on which the program is recorded be free from defects in materials and workmanship under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of your receipt. If failure of the disk has resulted from accident, abuse or misapplication of the product, then MOTU shall have no responsibility to replace the disk(s) under this Limited Warranty.

THIS LIMITED WARRANTY AND RIGHT OF REPLACEMENT IS IN LIEU OF, AND YOU HEREBY WAIVE, ANY AND ALL OTHER WARRANTIES, BOTH EXPRESS AND IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE LIABILITY OF MOTU PURSUANT TO THIS LIMITED WARRANTY SHALL BE LIMITED TO THE REPLACEMENT OF THE DEFECTIVE DISK(S), AND IN NO EVENT SHALL MOTU OR ITS SUPPLIERS, LICENSORS, OR AFFILIATES BE LIABLE FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT LIMITED TO LOSS OF USE, LOSS OF PROFITS, LOSS OF DATA OR DATA BEING RENDERED INACCURATE, OR LOSSES SUSTAINED BY THIRD PARTIES EVEN IF MOTU HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS WHICH MAY VARY FROM STATE TO STATE. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

UPDATE POLICY
In order to be eligible to obtain updates of the program, you must visit motu.com/registration and complete the on-line product registration form (or complete and return to MOTU the Competitive Upgrade envelope if you have purchased a Competitive Upgrade).

COPYRIGHT NOTICE

Performers Lite, MOTU, Mark of the Unicorn and the unicorn silhouette logo are trademarks of Mark of the Unicorn, Inc.

MPEG LICENSE
Supply of this product does not convey a license nor imply any right to distribute MPEG Layer-3 compliant content created with this product in revenue-generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels), streaming applications (via Internet, intranets and/or other networks), other content distribution systems (pay-audio or audio-on-demand applications and the like) or on physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, memory cards and the like). An independent license for such use is required. For details, please visit http://mp3licensing.com.
# Contents

## Part 1: Setup

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td><strong>Computer Requirements</strong></td>
</tr>
<tr>
<td>15</td>
<td>Minimum computer requirements</td>
</tr>
<tr>
<td>16</td>
<td>Getting started</td>
</tr>
<tr>
<td>16</td>
<td>Familiarity with your computer</td>
</tr>
<tr>
<td>16</td>
<td>Visit motu.com for software updates</td>
</tr>
<tr>
<td>16</td>
<td>Technical support</td>
</tr>
<tr>
<td>17</td>
<td><strong>Installing Performer Lite</strong></td>
</tr>
<tr>
<td>17</td>
<td>Obtaining the Performer Lite installer</td>
</tr>
<tr>
<td>17</td>
<td>Running the Performer Lite installer</td>
</tr>
<tr>
<td>17</td>
<td>Opening Performer Lite</td>
</tr>
<tr>
<td>17</td>
<td>Examining VST and AU plug-ins</td>
</tr>
<tr>
<td>18</td>
<td>The Performer Lite Welcome Window</td>
</tr>
<tr>
<td>18</td>
<td>Enabling audio I/O</td>
</tr>
<tr>
<td>18</td>
<td>Setting up MIDI hardware</td>
</tr>
<tr>
<td>18</td>
<td>Using virtual instruments</td>
</tr>
<tr>
<td>18</td>
<td>Interapplication MIDI (macOS only)</td>
</tr>
<tr>
<td>18</td>
<td>Updating Performer Lite</td>
</tr>
<tr>
<td>18</td>
<td>The Performer Lite User Guide PDF</td>
</tr>
<tr>
<td>19</td>
<td><strong>Configuring Audio Devices</strong></td>
</tr>
<tr>
<td>19</td>
<td>Overview</td>
</tr>
<tr>
<td>19</td>
<td>What is the MOTU Audio System?</td>
</tr>
<tr>
<td>19</td>
<td>Preparing your computer</td>
</tr>
<tr>
<td>19</td>
<td>Supported audio hardware</td>
</tr>
<tr>
<td>19</td>
<td>Configuring the hardware driver</td>
</tr>
<tr>
<td>23</td>
<td>Configure Studio Settings</td>
</tr>
<tr>
<td>25</td>
<td><strong>Configuring MIDI Devices</strong></td>
</tr>
<tr>
<td>25</td>
<td>Overview</td>
</tr>
<tr>
<td>25</td>
<td>Setting up your MIDI equipment</td>
</tr>
<tr>
<td>25</td>
<td>Connecting MIDI gear directly</td>
</tr>
<tr>
<td>25</td>
<td>Connecting MIDI gear using a MIDI interface</td>
</tr>
<tr>
<td>26</td>
<td>The MIDI Devices tab</td>
</tr>
<tr>
<td>28</td>
<td>Audio MIDI Setup (macOS only)</td>
</tr>
<tr>
<td>29</td>
<td>Interapplication MIDI (macOS only)</td>
</tr>
</tbody>
</table>

## Part 2: Getting Started

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>32</td>
<td><strong>Quick-Start Guide</strong></td>
</tr>
<tr>
<td>32</td>
<td>Creating a MIDI and Instrument track</td>
</tr>
<tr>
<td>33</td>
<td>Creating Audio Tracks</td>
</tr>
<tr>
<td>34</td>
<td>Bouncing</td>
</tr>
<tr>
<td>36</td>
<td><strong>About Performer Lite</strong></td>
</tr>
<tr>
<td>36</td>
<td>Overview</td>
</tr>
<tr>
<td>36</td>
<td>Design philosophy</td>
</tr>
<tr>
<td>36</td>
<td>MIDI sequencing</td>
</tr>
<tr>
<td>37</td>
<td>Digital audio recording</td>
</tr>
<tr>
<td>37</td>
<td>Seamless MIDI and audio</td>
</tr>
<tr>
<td>37</td>
<td>Editing</td>
</tr>
<tr>
<td>38</td>
<td>Arranging</td>
</tr>
<tr>
<td>38</td>
<td>Automated mixing</td>
</tr>
<tr>
<td>38</td>
<td>MIDI and audio effects processing</td>
</tr>
<tr>
<td>38</td>
<td>Virtual instruments</td>
</tr>
<tr>
<td>38</td>
<td>Mastering</td>
</tr>
<tr>
<td>38</td>
<td>Music notation</td>
</tr>
<tr>
<td>39</td>
<td><strong>Performer Lite Basics</strong></td>
</tr>
<tr>
<td>39</td>
<td>Overview</td>
</tr>
<tr>
<td>39</td>
<td>Learn to use your computer</td>
</tr>
<tr>
<td>39</td>
<td>The Performer Lite window</td>
</tr>
<tr>
<td>41</td>
<td>Control Panel</td>
</tr>
<tr>
<td>41</td>
<td>Track Selector</td>
</tr>
<tr>
<td>42</td>
<td>Track Inspector</td>
</tr>
<tr>
<td>42</td>
<td>Channel Strip</td>
</tr>
<tr>
<td>43</td>
<td>The Window menu</td>
</tr>
<tr>
<td>43</td>
<td>Modifier keys</td>
</tr>
<tr>
<td>44</td>
<td>Clicking shortcuts</td>
</tr>
<tr>
<td>44</td>
<td>Using modifier keys with cursor actions</td>
</tr>
<tr>
<td>44</td>
<td>Contextual menus</td>
</tr>
<tr>
<td>45</td>
<td>Standard keyboard shortcuts</td>
</tr>
<tr>
<td>46</td>
<td>Customizing keyboard shortcuts</td>
</tr>
<tr>
<td>46</td>
<td>Changing text box values by dragging</td>
</tr>
<tr>
<td>46</td>
<td>Main counter shortcuts</td>
</tr>
<tr>
<td>47</td>
<td>Using the numeric keypad</td>
</tr>
<tr>
<td>47</td>
<td>Performer Lite track limits</td>
</tr>
<tr>
<td>48</td>
<td><strong>Tutorials</strong></td>
</tr>
<tr>
<td>48</td>
<td>using the tutorials sidebar</td>
</tr>
<tr>
<td>48</td>
<td>Videos and example files</td>
</tr>
</tbody>
</table>
Part 3: Tracks

50 Track Basics
50 Overview
50 Basic track types
51 Special track types
51 Track settings
53 Creating a track
53 Creating several tracks at once
53 Duplicating a track’s settings
54 Duplicating a track’s settings and data
54 Renaming a track
54 Deleting a track
54 Track colors
57 Audio Tracks
57 Overview
57 Integrated MIDI and hard disk audio
57 Types of audio tracks
57 Audio (disk) tracks
57 Mono and stereo tracks
57 Creating an audio track
58 Creating several audio tracks at once
58 Audio track settings
58 Input source: Audio bundles
59 Choosing an audio input and output
59 Record-enabling an audio track
59 Input monitor enable
59 Stretch
60 Pitch and Stretch Cache
60 Enabled
61 Monitoring an audio track input
61 Changing audio track settings on the fly
61 Making I/O assignments for multiple tracks
62 Managing your computer’s system resources
63 MIDI Tracks
63 Overview
63 Integrated MIDI and hard disk audio
63 MIDI only
63 What is a MIDI track?
63 Creating a MIDI track
63 Creating several MIDI tracks at once
64 MIDI track settings
64 Record-enabling a MIDI track
64 Choosing an input source
64 Choosing a MIDI output destination
65 Making I/O assignments for multiple MIDI tracks
65 Choosing a default patch (sound)
65 The patch list
65 MIDI Keys
67 Instrument Tracks
67 Overview
67 Creating an instrument track
68 Instrument track settings
68 Working with instrument plug-ins
68 Instrument tracks in the Mixing Board
69 Open Instrument shortcut
69 Instrument track automation
69 Instruments as audio plug-ins
69 Instrument plug-ins in V-Racks
69 Multiple audio outputs
69 Performer Lite’s included instruments
70 Aux Tracks and Master Fader Tracks
70 Overview
70 Aux tracks
71 Master Fader tracks
73 Track Folders and Track Groups
73 Overview
73 Track Folders
73 Track Groups

Part 4: Project Basics

79 The Performer Lite Project
79 Overview
79 Components of a Performer Lite Project
80 Creating a new project
80 Creating a new project from a template
81 Opening an existing project
81 Open Recent sub-menu
81 Saving a project
81 Saving a project file under a different name
81 Save a Copy As
82 Using Save a Copy As for incremental backups
82 Autosave
82 Collecting a project for backup or transfer
83 Avoiding disaster
83 Exporting a project
83 Moving a project between Mac and Windows
83 Exporting to notation software through MusicXML
83 Reverting to a previously saved project
<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>83</td>
<td>Adding project notes</td>
</tr>
<tr>
<td>83</td>
<td>Printing project windows</td>
</tr>
<tr>
<td>85</td>
<td>Closing a project</td>
</tr>
<tr>
<td>85</td>
<td>Quitting/Exiting Performer Lite</td>
</tr>
<tr>
<td>85</td>
<td>Helpful project and disk hints</td>
</tr>
<tr>
<td>87</td>
<td>Control Panel</td>
</tr>
<tr>
<td>87</td>
<td>Overview</td>
</tr>
<tr>
<td>87</td>
<td>Transport Controls</td>
</tr>
<tr>
<td>88</td>
<td>Counter</td>
</tr>
<tr>
<td>92</td>
<td>Tempo Controls</td>
</tr>
<tr>
<td>94</td>
<td>Transport settings</td>
</tr>
<tr>
<td>94</td>
<td>Overdub</td>
</tr>
<tr>
<td>95</td>
<td>Countoff</td>
</tr>
<tr>
<td>95</td>
<td>Countoff preferences</td>
</tr>
<tr>
<td>96</td>
<td>Click</td>
</tr>
<tr>
<td>96</td>
<td>Click Preferences</td>
</tr>
<tr>
<td>98</td>
<td>Memory Cycle</td>
</tr>
<tr>
<td>99</td>
<td>Auto-Record</td>
</tr>
<tr>
<td>100</td>
<td>Solo</td>
</tr>
<tr>
<td>100</td>
<td>Primary and alternate tools</td>
</tr>
<tr>
<td>100</td>
<td>Keypad shortcuts</td>
</tr>
<tr>
<td>102</td>
<td>Sequence Editor</td>
</tr>
<tr>
<td>102</td>
<td>Overview</td>
</tr>
<tr>
<td>103</td>
<td>Quick Reference</td>
</tr>
<tr>
<td>105</td>
<td>Sequence Editor menu</td>
</tr>
<tr>
<td>106</td>
<td>Sequence Editor basics</td>
</tr>
<tr>
<td>106</td>
<td>Opening the Sequence Editor</td>
</tr>
<tr>
<td>106</td>
<td>Switching sequences</td>
</tr>
<tr>
<td>106</td>
<td>Sequence management</td>
</tr>
<tr>
<td>106</td>
<td>Track management</td>
</tr>
<tr>
<td>107</td>
<td>Information Bar</td>
</tr>
<tr>
<td>109</td>
<td>The Time Ruler</td>
</tr>
<tr>
<td>109</td>
<td>The Marker Strip</td>
</tr>
<tr>
<td>110</td>
<td>The Memory Cycle strip</td>
</tr>
<tr>
<td>110</td>
<td>The Auto Record strip</td>
</tr>
<tr>
<td>110</td>
<td>Zoom buttons</td>
</tr>
<tr>
<td>110</td>
<td>Zooming techniques</td>
</tr>
<tr>
<td>110</td>
<td>Audio track settings</td>
</tr>
<tr>
<td>113</td>
<td>Audio editing</td>
</tr>
<tr>
<td>113</td>
<td>MIDI track settings</td>
</tr>
<tr>
<td>114</td>
<td>MIDI editing</td>
</tr>
<tr>
<td>114</td>
<td>Resizing tracks</td>
</tr>
<tr>
<td>115</td>
<td>Effect inserts panel</td>
</tr>
<tr>
<td>115</td>
<td>Takes</td>
</tr>
<tr>
<td>115</td>
<td>The movie track</td>
</tr>
<tr>
<td>115</td>
<td>The Conductor track</td>
</tr>
<tr>
<td>116</td>
<td>Notation Editor</td>
</tr>
<tr>
<td>116</td>
<td>Overview</td>
</tr>
<tr>
<td>117</td>
<td>Notation Editor Quick Reference</td>
</tr>
<tr>
<td>118</td>
<td>Notation Editor menu</td>
</tr>
<tr>
<td>120</td>
<td>Notation Editor basics</td>
</tr>
<tr>
<td>121</td>
<td>Opening the Notation Editor</td>
</tr>
<tr>
<td>121</td>
<td>The Track Selector</td>
</tr>
<tr>
<td>121</td>
<td>The QuickScribe transcription engine</td>
</tr>
<tr>
<td>121</td>
<td>The playback wiper</td>
</tr>
<tr>
<td>122</td>
<td>Getting around in the Notation Editor</td>
</tr>
<tr>
<td>122</td>
<td>Zooming</td>
</tr>
<tr>
<td>123</td>
<td>Notation Editor options sub-menu</td>
</tr>
<tr>
<td>123</td>
<td>Score options</td>
</tr>
<tr>
<td>125</td>
<td>Track options</td>
</tr>
<tr>
<td>127</td>
<td>Marker options</td>
</tr>
<tr>
<td>128</td>
<td>Measure numbers</td>
</tr>
<tr>
<td>128</td>
<td>Measure spacing</td>
</tr>
<tr>
<td>129</td>
<td>Set Score Length</td>
</tr>
<tr>
<td>129</td>
<td>Controlling page size</td>
</tr>
<tr>
<td>129</td>
<td>Adjusting system margins</td>
</tr>
<tr>
<td>129</td>
<td>Information bar</td>
</tr>
<tr>
<td>129</td>
<td>The Notation Editor Tool Palette</td>
</tr>
<tr>
<td>130</td>
<td>Working with notes</td>
</tr>
<tr>
<td>134</td>
<td>Chord Symbols</td>
</tr>
<tr>
<td>135</td>
<td>Inserting a staff brace or bracket</td>
</tr>
<tr>
<td>136</td>
<td>The Dynamics Palette</td>
</tr>
<tr>
<td>137</td>
<td>Popup Meter Changes, key changes and tempos</td>
</tr>
<tr>
<td>138</td>
<td>Working with text</td>
</tr>
<tr>
<td>141</td>
<td>Lyrics</td>
</tr>
<tr>
<td>144</td>
<td>Score Arrangement</td>
</tr>
<tr>
<td>149</td>
<td>Display-only and playback-only notes</td>
</tr>
<tr>
<td>150</td>
<td>Film Cues view</td>
</tr>
<tr>
<td>152</td>
<td>Printing</td>
</tr>
<tr>
<td>153</td>
<td>Exporting a musicXML file</td>
</tr>
<tr>
<td>156</td>
<td>Mixing Board</td>
</tr>
<tr>
<td>156</td>
<td>Overview</td>
</tr>
<tr>
<td>157</td>
<td>Mixing Board quick reference</td>
</tr>
<tr>
<td>159</td>
<td>Mixing Board menu</td>
</tr>
<tr>
<td>160</td>
<td>Mixing Board window basics</td>
</tr>
<tr>
<td>160</td>
<td>Track strips</td>
</tr>
<tr>
<td>166</td>
<td>EQ and Dynamics (audio tracks only)</td>
</tr>
<tr>
<td>171</td>
<td>Instrument tracks</td>
</tr>
<tr>
<td>171</td>
<td>Automated mixing</td>
</tr>
<tr>
<td>172</td>
<td>Mixing in real time</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>173</td>
<td>Editing your mix graphically</td>
</tr>
<tr>
<td>173</td>
<td>Monitoring</td>
</tr>
<tr>
<td>173</td>
<td>Audio mixing features</td>
</tr>
<tr>
<td>174</td>
<td>Aux tracks</td>
</tr>
<tr>
<td>174</td>
<td>Master faders</td>
</tr>
<tr>
<td>174</td>
<td>Track groups</td>
</tr>
<tr>
<td>174</td>
<td>VCA tracks</td>
</tr>
<tr>
<td>174</td>
<td>Remote control</td>
</tr>
<tr>
<td>175</td>
<td>Working with effects plug-ins</td>
</tr>
<tr>
<td>175</td>
<td>Working with multiple mixes</td>
</tr>
<tr>
<td><strong>179</strong></td>
<td><strong>Clips Window</strong></td>
</tr>
<tr>
<td>179</td>
<td>Overview</td>
</tr>
<tr>
<td>180</td>
<td>Quick reference</td>
</tr>
<tr>
<td>181</td>
<td>Clips window menu</td>
</tr>
<tr>
<td>182</td>
<td>What is a clip?</td>
</tr>
<tr>
<td>182</td>
<td>Opening the Clips window</td>
</tr>
<tr>
<td>182</td>
<td>Clips window basics</td>
</tr>
<tr>
<td>183</td>
<td>The track Stretch setting</td>
</tr>
<tr>
<td>183</td>
<td>Showing, hiding and arranging track columns</td>
</tr>
<tr>
<td>183</td>
<td>Track types</td>
</tr>
<tr>
<td>183</td>
<td>Track playback versus clip playback</td>
</tr>
<tr>
<td>183</td>
<td>Creating clips</td>
</tr>
<tr>
<td>184</td>
<td>The trigger button</td>
</tr>
<tr>
<td>185</td>
<td>Track clips</td>
</tr>
<tr>
<td>185</td>
<td>Clip menu</td>
</tr>
<tr>
<td>185</td>
<td>Scenes</td>
</tr>
<tr>
<td>185</td>
<td>The track scene</td>
</tr>
<tr>
<td>185</td>
<td>Playing clips and scenes</td>
</tr>
<tr>
<td>186</td>
<td>The multi-queue</td>
</tr>
<tr>
<td>187</td>
<td>Mixer channels</td>
</tr>
<tr>
<td>187</td>
<td>The Clip Editor</td>
</tr>
<tr>
<td>188</td>
<td>Clip Record mode</td>
</tr>
<tr>
<td>189</td>
<td>MIDI Learn Mode</td>
</tr>
<tr>
<td>189</td>
<td>Attaching MIDI controllers for mixing</td>
</tr>
<tr>
<td><strong>193</strong></td>
<td><strong>Content Browser</strong></td>
</tr>
<tr>
<td>191</td>
<td>Overview</td>
</tr>
<tr>
<td>191</td>
<td>Quick Reference</td>
</tr>
<tr>
<td>192</td>
<td>Content Browser menu</td>
</tr>
<tr>
<td>192</td>
<td>Opening the Content Browser</td>
</tr>
<tr>
<td>192</td>
<td>Opening the Content Browser as a window</td>
</tr>
<tr>
<td>192</td>
<td>Using the Content Browser</td>
</tr>
<tr>
<td>192</td>
<td>Auditioning audio clips</td>
</tr>
<tr>
<td>192</td>
<td>The Performer Producer Pack</td>
</tr>
<tr>
<td><strong>193</strong></td>
<td><strong>Soundbites</strong></td>
</tr>
<tr>
<td>193</td>
<td>Overview</td>
</tr>
<tr>
<td>193</td>
<td>Quick Reference</td>
</tr>
<tr>
<td>194</td>
<td>Soundbites menu</td>
</tr>
<tr>
<td>195</td>
<td>Opening the Soundbite list</td>
</tr>
<tr>
<td>195</td>
<td>Opening the Soundbite list as a window</td>
</tr>
<tr>
<td>196</td>
<td>Soundbite Basics</td>
</tr>
<tr>
<td>196</td>
<td>Mono and stereo audio</td>
</tr>
<tr>
<td>197</td>
<td>Soundbite Management</td>
</tr>
<tr>
<td>199</td>
<td>Dragging and dropping soundbites</td>
</tr>
<tr>
<td>200</td>
<td>Working with multiple sample formats</td>
</tr>
<tr>
<td>200</td>
<td>Converting sample rate/format</td>
</tr>
<tr>
<td>200</td>
<td>Automatic conversions</td>
</tr>
<tr>
<td>200</td>
<td>Importing and exporting audio</td>
</tr>
<tr>
<td>209</td>
<td>Set List</td>
</tr>
<tr>
<td>209</td>
<td>Overview</td>
</tr>
<tr>
<td>209</td>
<td>Set List Quick Reference</td>
</tr>
<tr>
<td>210</td>
<td>Set List basics</td>
</tr>
<tr>
<td>214</td>
<td>Sequence cuing and chaining</td>
</tr>
<tr>
<td><strong>215</strong></td>
<td><strong>Sequence Basics</strong></td>
</tr>
<tr>
<td>215</td>
<td>Overview</td>
</tr>
<tr>
<td>215</td>
<td>Sequence types</td>
</tr>
<tr>
<td>215</td>
<td>Managing sequences and V-racks</td>
</tr>
<tr>
<td>216</td>
<td>V-Racks</td>
</tr>
<tr>
<td>216</td>
<td>Overview</td>
</tr>
<tr>
<td>216</td>
<td>V-Rack basics</td>
</tr>
<tr>
<td>217</td>
<td>Creating a V-Rack</td>
</tr>
<tr>
<td>217</td>
<td>V-Rack quick reference</td>
</tr>
<tr>
<td>217</td>
<td>Working with a V-Rack</td>
</tr>
<tr>
<td>220</td>
<td>Tools</td>
</tr>
<tr>
<td>220</td>
<td>Overview</td>
</tr>
<tr>
<td>221</td>
<td>Main and Alternate Tools</td>
</tr>
<tr>
<td>221</td>
<td>Keyboard shortcuts for tools</td>
</tr>
<tr>
<td>221</td>
<td>Pointer tool</td>
</tr>
<tr>
<td>222</td>
<td>I-Beam tool</td>
</tr>
<tr>
<td>222</td>
<td>Pencil tool</td>
</tr>
<tr>
<td>223</td>
<td>Insert/Reshape Curve</td>
</tr>
<tr>
<td>223</td>
<td>Reshape tool</td>
</tr>
<tr>
<td>223</td>
<td>Reshape Mode menu</td>
</tr>
<tr>
<td>223</td>
<td>Zoom tool</td>
</tr>
<tr>
<td>224</td>
<td>Mute tool</td>
</tr>
<tr>
<td>224</td>
<td>Scissors tool</td>
</tr>
<tr>
<td>225</td>
<td>Trim tool</td>
</tr>
<tr>
<td>226</td>
<td>Roll tool</td>
</tr>
<tr>
<td>226</td>
<td>Slip tool</td>
</tr>
<tr>
<td>226</td>
<td>Slide tool</td>
</tr>
<tr>
<td>226</td>
<td>Comp tool</td>
</tr>
<tr>
<td>Page</td>
<td>Section</td>
</tr>
<tr>
<td>------</td>
<td>---------</td>
</tr>
<tr>
<td>226</td>
<td>Velocity tool</td>
</tr>
<tr>
<td>226</td>
<td>Hand tool</td>
</tr>
<tr>
<td></td>
<td><strong>Part 5: Preferences</strong></td>
</tr>
<tr>
<td>228</td>
<td>Preferences and Settings</td>
</tr>
<tr>
<td>228</td>
<td>Overview</td>
</tr>
<tr>
<td>228</td>
<td>The Preferences window</td>
</tr>
<tr>
<td>229</td>
<td>Audio Plug-ins</td>
</tr>
<tr>
<td>229</td>
<td>Document</td>
</tr>
<tr>
<td>229</td>
<td>Data Display</td>
</tr>
<tr>
<td>229</td>
<td>Automatic Conversions</td>
</tr>
<tr>
<td>230</td>
<td>Chord Symbols</td>
</tr>
<tr>
<td>230</td>
<td>Information Bar</td>
</tr>
<tr>
<td>230</td>
<td>Lyrics</td>
</tr>
<tr>
<td>230</td>
<td>MIDI Editing</td>
</tr>
<tr>
<td>231</td>
<td>Soundbite List</td>
</tr>
<tr>
<td>231</td>
<td>Tools</td>
</tr>
<tr>
<td>231</td>
<td>Undo Pruning</td>
</tr>
<tr>
<td>231</td>
<td>Audio options</td>
</tr>
<tr>
<td>231</td>
<td>Click</td>
</tr>
<tr>
<td>231</td>
<td>Countoff</td>
</tr>
<tr>
<td>231</td>
<td>MIDI Options</td>
</tr>
<tr>
<td>232</td>
<td>Pitch and Stretch</td>
</tr>
<tr>
<td>232</td>
<td>Receive Sync</td>
</tr>
<tr>
<td>232</td>
<td>Transmit Sync</td>
</tr>
<tr>
<td>232</td>
<td>Transport</td>
</tr>
<tr>
<td>232</td>
<td>Scaling all windows up or down</td>
</tr>
<tr>
<td>232</td>
<td>Help menu</td>
</tr>
<tr>
<td>234</td>
<td><strong>Commands</strong></td>
</tr>
<tr>
<td>234</td>
<td>Overview</td>
</tr>
<tr>
<td>234</td>
<td>Opening the commands window</td>
</tr>
<tr>
<td>234</td>
<td>Navigating the commands window</td>
</tr>
<tr>
<td>235</td>
<td>Command groups</td>
</tr>
<tr>
<td>235</td>
<td>MIDI Masters</td>
</tr>
<tr>
<td>235</td>
<td>Assignments</td>
</tr>
<tr>
<td>236</td>
<td>Numeric Base note</td>
</tr>
<tr>
<td>236</td>
<td>Sequence remote assignment</td>
</tr>
<tr>
<td>236</td>
<td>Run command</td>
</tr>
<tr>
<td>237</td>
<td>Export Key Bindings</td>
</tr>
<tr>
<td>237</td>
<td>Import Key Bindings</td>
</tr>
<tr>
<td>238</td>
<td><strong>Bundles</strong></td>
</tr>
<tr>
<td>238</td>
<td>Overview</td>
</tr>
<tr>
<td>238</td>
<td>Audio bundles</td>
</tr>
<tr>
<td>239</td>
<td>Bundle types</td>
</tr>
<tr>
<td>239</td>
<td>Adding and deleting bundles</td>
</tr>
<tr>
<td>239</td>
<td>Renaming bundles</td>
</tr>
<tr>
<td>239</td>
<td>Working with tiles on the grid</td>
</tr>
<tr>
<td>240</td>
<td>Exporting and importing bundles</td>
</tr>
<tr>
<td>241</td>
<td>Bundle channel formats</td>
</tr>
<tr>
<td>241</td>
<td>Reassigning bundles</td>
</tr>
<tr>
<td>241</td>
<td>The instruments tab</td>
</tr>
<tr>
<td>241</td>
<td>The MIDI Devices tab</td>
</tr>
<tr>
<td>245</td>
<td><strong>Part 6: Playing and Recording</strong></td>
</tr>
<tr>
<td>245</td>
<td>Playback</td>
</tr>
<tr>
<td>245</td>
<td>Overview</td>
</tr>
<tr>
<td>245</td>
<td>MIDI Playback basics</td>
</tr>
<tr>
<td>245</td>
<td>Audio playback basics</td>
</tr>
<tr>
<td>245</td>
<td>How to play a sequence</td>
</tr>
<tr>
<td>246</td>
<td>Monitoring levels</td>
</tr>
<tr>
<td>246</td>
<td>Editing during playback</td>
</tr>
<tr>
<td>246</td>
<td>Screen re-display</td>
</tr>
<tr>
<td>246</td>
<td>Muting and unmuting tracks during playback</td>
</tr>
<tr>
<td>246</td>
<td>Soloing Tracks</td>
</tr>
<tr>
<td>247</td>
<td>Looping playback</td>
</tr>
<tr>
<td>247</td>
<td>Playing the current selection</td>
</tr>
<tr>
<td>247</td>
<td>Event Chasing</td>
</tr>
<tr>
<td>249</td>
<td>The playback wiper</td>
</tr>
<tr>
<td>250</td>
<td>Scrubbing multiple MIDI tracks</td>
</tr>
<tr>
<td>250</td>
<td>Scrubbing and grid snapping</td>
</tr>
<tr>
<td>250</td>
<td>Stop Sounding MIDI Devices (Panic)</td>
</tr>
<tr>
<td>251</td>
<td>Recording</td>
</tr>
<tr>
<td>251</td>
<td>Overview</td>
</tr>
<tr>
<td>252</td>
<td>Choosing a sequence to record into</td>
</tr>
<tr>
<td>252</td>
<td>Setting tempo and meter</td>
</tr>
<tr>
<td>252</td>
<td>Recording to a click</td>
</tr>
<tr>
<td>252</td>
<td>Recording with a Countoff</td>
</tr>
<tr>
<td>252</td>
<td>Input Filter</td>
</tr>
<tr>
<td>253</td>
<td>Non-destructive output quantize</td>
</tr>
<tr>
<td>253</td>
<td>Preparing a MIDI track for recording</td>
</tr>
<tr>
<td>254</td>
<td>Preparing an audio track for recording</td>
</tr>
<tr>
<td>254</td>
<td>MIDI input monitoring</td>
</tr>
<tr>
<td>257</td>
<td>Audio input monitoring</td>
</tr>
<tr>
<td>259</td>
<td>Using the countoff</td>
</tr>
<tr>
<td>259</td>
<td>Start recording</td>
</tr>
<tr>
<td>260</td>
<td>Stop recording</td>
</tr>
<tr>
<td>260</td>
<td>How audio is recorded on disk</td>
</tr>
<tr>
<td>260</td>
<td>Undo record</td>
</tr>
</tbody>
</table>
Recording stereo audio
Recording several audio tracks in one pass
Recording audio and MIDI at the same time
Manual punch-in/punch-out on the fly
Automatic punch-in/punch-out
Recording multiple takes
Cycle-recording
Recording in External Sync
Sample Format
Getting an error message
Movie Window
overview
Random access digital picture
Supported video formats
Opening movies
Closing movies
Movie control bar
The movie track
Movie window menu commands
Scrubbing the Movie window
Improving movie window performance
Exporting a Movie

Part 7: Editing

Editing Basics
Overview
Unlimited Undo/Redo
Editing during playback
Selecting and searching
Region editing
Track groups
View menu
Zooming
Scroll To
Graphic editing techniques
Audio editing basics
Sample accurate editing
Listening while editing
Selecting
Overview
Selection basics
Choosing a Pointer tool selection mode
Selecting events
Selecting tracks
Selecting a time range
Smart Selection
MIDI Editing
Overview
Quick Reference
Tool palette quick reference
Accessing a MIDI track
MIDI editing basics
Selection techniques
The Edit Layer
The Clips and Notes edit layers
The MIDI note grid
The Pitch Ruler
Inserting Notes
Selecting Notes
Editing Notes
Editing MIDI CC data
Three controller display modes
The MIDI CC Ruler
Changing MIDI CC colors
Note velocities
Editing MIDI CC’s in Points or Bars mode
Editing CC data in Lines mode
Discrete MIDI events
Audio Editing
Overview
Quick Reference
Tool palette quick reference
Accessing an audio track
The Edit Layer
Audio editing basics
Inserting soundbites
Moving soundbites
Muting and unmuting soundbites
Bite Gain
Overlapping and layering soundbites
Trimming (edge editing) soundbites
Graphic time stretching of audio
Graphic editing techniques
Selection techniques
Working with Clips
Working with breakpoint mix automation
Soundbite volume automation
Fades and Crossfades
Overview
What is a crossfade?
Creating a single fade or crossfade
Types of crossfades
Fade curves
How fades are generated
Fades are anchored to their splice
Applying multiple fades in one operation
Reapplying the last fade settings
Deleting fades
Editing existing fades
Fades that cannot be fully computed
Trimming soundbites that have a fade or crossfade
Clipping when crossfades are calculated

Information Panels
Overview
Opening an information panel
Floating windows or sidebar cells
The Information Bar
Snap Information
Cursor Information
Event Information
Selection Information
Track Inspector
Channel Strip
Track Selector

Edit Menu
Overview
Undo
Redo
Cut
Copy
Paste
Other Paste commands
Erase
Duplicate
Repeat
Paste and Merge
Other Merge commands
Trim
Trim Audio
Trim End / Trim Start
Select All
Select All Tracks in Range
Deselect All

Region Menu
Overview
Region command windows
Previewing
Region command preferences
Transpose
Quantize
Groove Quantize
Create (Extract) Groove
DeFlam
Change Velocity
Change Duration
Split Notes
Invert Pitch
MIDI Effects Plug-ins
Reverse Time and Retrograde
Scale Time
Scale Tempo
Audition Selection

Audio Menu
Overview
Fade
Delete fades
Merge Soundbites
Smooth Audio Edits
Smooth Audio Edits Again
Spectral Effects
Bite volume and gain
Pitch and Stretch
Apply Plug-in
Audio Beats
Soundbite Tempo

Takes and Comping
Overview
Take menu
Indication of multiple takes
Comp takes
Comp tool
Takes and key commands
Conductor track takes
Takes interact with multiple mixdowns

Tempos and Audio
Overview
Soundbite Tempo Maps
The track Stretch layer
Audio menu > Soundbite Tempo
Part 8: Arranging

418 Conductor Track
418 Overview
418 Conductor track basics
418 Types of Conductor track events
421 Editing in the Conductor Track

425 Markers
425 Overview
426 Markers window quick reference
427 Markers window menu
427 Basics
428 Opening a Markers Window
428 Switching between sequences and songs
428 Scrolling during playback
428 Creating new markers
428 Changing the name of a marker
429 Changing a marker time location
429 Marker streamer, punch & Flutter settings
429 Custom pre-gap for CD Burn
429 Setting the counter to a marker location
429 Marker locate numbers
430 Jumping to a marker with a shortcut
430 Selecting markers
430 Using markers to define an edit region
431 Selecting with markers
431 Markers in edit windows
431 Markers in the Song window
431 Editing markers in the conductor track
432 Locking and unlocking markers
432 Shifting locked markers in time
432 Locked markers and the sequence start time
432 Locked markers and changing meter
432 Recording hits
433 Using markers to find a tempo
433 Streamers
433 Marker hints
435 Change Tempo
435 Overview
435 Change Tempo quick reference
436 Change Tempo basics
437 Using Change Tempo
442 Viewing and editing tempo changes
442 Tempo editing resolution
442 Changing tempo on-the-fly during playback
443 Change Meter
443 Overview
443 Change Meter quick reference
443 Change meter basics
444 Using the Change Meter window
446 Viewing meter changes
446 Editing meter changes in the Conductor track
Choosing a SMPTE start frame
Sync to port menu
Record while still-framed
Sample-accurate sync
MTC (MIDI Time Code)
MIDI Beat Clocks
Tap Tempo
Slaving to external sync
Using Tap Tempo
Using Tap Tempo while slaved to external sync
Transmit Sync
Overview
MIDI Time Code
MIDI Beat Clocks
Turn off Transmit Sync when you don’t need it

Part 13: More Information

Hard Disk Recording Concepts
Overview
How audio is recorded on disk
How much disk space does audio require?
Hard disk requirements and maintenance
Digital audio terms
Audio File Management
Overview
The Audio Files folder
Renaming audio files
Moving audio files
Working with multiple drives
Deleting audio files

Getting rid of unused audio
Frequently Asked Questions
Overview
Setting up
Becoming familiar with Performer Lite
Recording and playback
Editing
Mixing and Finishing
Plug-ins
Virtual instruments (“soft synths”)
Additional Resources
Overview
Frequently Asked Questions (FAQ)
The Performer Lite User Guide
Help Tags
Tutorials
motu.com
Training webinars
Youtube.com/motuTV

Part 14: Appendices

Troubleshooting and Support
Overview
Preventing Catastrophe
General troubleshooting
MIDI troubleshooting
Audio troubleshooting
Technical support
Index
Part 1

Setup
minimum computer requirements
Here are the computer system requirements for Performer Lite:

- Mac or PC with Intel Core Duo CPU 1.83 GHz or faster; multiple processors or a multi-core processor is required. Intel Core 2 Duo CPU 2.0 GHz or faster recommended. Only Macs with 64-bit CPUs are supported. (Macs with PowerPC CPUs are not supported.)

- The faster the computer, and the more RAM installed in it, the more responsive Performer Lite is. Scrolling during playback is smoother, the counter updates regularly, and actions that you take with the program are faster — especially during playback.

- 4 GB of RAM is required; more is highly recommended.

- Since plug-ins and virtual instruments are loaded into the computer’s RAM, add as much RAM as possible to your computer.

- Performer Lite is a 64-bit application, which allows full access to your computer’s RAM. Under Windows, it can optionally run in 32-bit mode.

- A display with at least 1024 x 768 resolution (1280 x 1024 resolution or higher is recommended).

- MacOS (version 10.11 or later) or Windows 10, 8 or 7.

- Large hard disk, preferably at least 100 GB. The disk on which tracks are recorded must be a fast drive.

64-bit operation
On macOS, Performer Lite runs in 64-bit mode only.

For native 64-bit operation under Windows, Performer Lite has the following requirements: Windows 10, Windows 8, or a 64-bit version of Windows 7.

Running in 32-bit mode
On Windows, you can run Performer Lite in either 64- or 32-bit mode. This can be useful when using 32-bit plug-ins and virtual instruments that are 32-bit only.

On Windows, there are separate 64- and 32-bit builds of the Performer Lite application. Just run the 32-bit executable instead of the 64-bit executable.

When Performer is operating as a 32-bit application under Windows, the Audio Performance window displays a memory meter, which displays how much of the 4GB memory address space is being used by Performer. If the meter reaches 100%, Performer has run out of memory and you will likely experience performance issues. If the meter approaches 100%, try removing plug-ins from the project.

Retina display support
If you are running Performer Lite on a Mac with a Retina™ display, which offers exceptionally high image resolution, Performer Lite supports the full resolution of your display. You can scale the size of Performer Lite’s overall user interface to make it comfortable for your eyes. Choose View menu > Scale.
GETTING STARTED
Follow the directions in the next few chapters of this guide to successfully begin using Performer Lite.

FAMILIARITY WITH YOUR COMPUTER
This manual assumes that you are familiar with using your computer. If not, please review your computer’s user guide before proceeding.

VISIT MOTU.COM FOR SOFTWARE UPDATES
Software updates are periodically posted on our web site, so check our web site for the latest updates at www.motu.com. You can also check for updates directly using the commands in Performer Lite’s Help menu.

TECHNICAL SUPPORT
If you have questions, please review this manual carefully first. You can reach MOTU tech support as follows:

■ 24-hour online tech support database with search engine: www.motu.com/support

■ Online: www.motu.com/support

■ Phone: +1 (617) 576-3066
  (9 a.m. – 5 p.m. Eastern)

■ Downloads: www.motu.com/download
CHAPTER 2 \hspace{10pt} Installing Performer Lite

### Obtaining the Performer Lite installer

Performer Lite is available free of charge to owners of MOTU audio hardware products. To obtain your free Performer Lite software, locate the serial number of your MOTU hardware product (usually found on a label on the bottom of the unit), and then follow these easy steps:

1. Log in to your motu.com account or create a new account (required).
2. If you haven’t already done so, register your purchased MOTU hardware product (required).

☛ Note: Performer Lite is only available to registered MOTU hardware users.

3. Click View Details for your registered hardware product.
4. Under Included loops and software click the Performer Lite banner.
5. Download the Performer Lite installer.

### Running the Performer Lite installer

1. Double-click the Performer Lite installer package or setup (.exe) file.

2. Follow the directions the installer gives you.

### Opening Performer Lite

After a successful installation, you are ready to launch Performer Lite for the first time.

When you first run the Performer Lite application, you will be required to authenticate and activate your copy of the application. Follow the on-screen instructions. For further information, visit motu.com/activate-Performer Lite.

### Examining VST and AU plug-ins

Performer Lite supports third-party VST plug-ins (on Mac and Windows) and macOS Audio Unit (AU) plug-ins. When you first run Performer Lite, it examines third-party plug-ins currently installed in your system, checking them for problems.

#### Choosing a primary external plug-in format (macOS only)

On macOS, Performer Lite will ask you to choose either VST or AU as your primary external plug-in format. Choose AU if you have a large number of existing Performer Lite projects that use AUs, and you don’t need to transfer Performer Lite projects to and from Windows systems. Choose VST to increase the cross-platform compatibility of your projects. This choice can be changed at any time in the audio plug-in preferences (see “Primary external plug-in format (Mac only)” on page 499). Once you’ve made your initial choice, Performer Lite scans and enables plug-ins in your primary format. Later, you can manually choose the desired format for each plug-in in the audio plug-in preferences.
The plug-in examination process
The plug-in examination process may take a few minutes, depending on the nature and quantity of the plug-ins installed in your system. Each plug-in is examined only once, the first time it is loaded by Performer Lite. On subsequent launches of Performer Lite, plug-ins that have already been examined will not be examined again. If a problem is detected with a particular plug-in, it will not be loaded for use in Performer Lite to prevent crashing and other serious problems. For more details about using VSTs and AUs, see “Working with VST and Audio Unit plug-ins” on page 496.

THE PERFORMER LITE WELCOME WINDOW
After Performer Lite launches, you’ll see the welcome window, which provides a variety of convenient resources. The window provides a menu of file templates to choose from, for quickly creating new projects; this menu can also display your own custom file templates. You’ll also see a list of recently opened projects for quick access.

If you prefer not to see the welcome window, you can disable it in the Performer Preferences in the Performer menu (Mac) or Edit menu (Windows) under the Document>Startup Options.

ENABLING AUDIO I/O
To enable Performer Lite’s audio recording and playback abilities, choose Setup menu> Audio System> MOTU Audio System. For further details, see chapter 3, “Configuring Audio Devices” (page 19).

You can freely disable audio recording and playback at any time by choosing Setup menu> Audio System> MIDI Only.

SETTING UP MIDI HARDWARE
To set up Performer Lite for use with MIDI hardware devices connected to your computer, see chapter 4, “Configuring MIDI Devices” (page 25).

USING VIRTUAL INSTRUMENTS
Performer Lite includes a host of virtual instrument plug-ins, which provides dozens of instruments to choose from. Performer Lite also supports third-party instruments (in industry-standard VST and AU plug-in formats). Performer Lite does not require any additional preparation for use with virtual instrument plug-ins. Simply open virtual instruments as described in chapter 12, “Instrument Tracks” (page 67), and its audio and MIDI inputs and outputs will appear in Performer Lite’s I/O menus. For details about Performer Lite’s including instruments, go to Performer Lite’s Help menu and choose the Performer Lite Plug-ins Guide.

INTERAPPLICATION MIDI (MACOS ONLY)
On macOS, if a virtual instrument operates as a separate application, run it concurrently with Performer Lite, and any MIDI inputs and outputs that it publishes to Core MIDI will appear in Performer Lite’s MIDI input and output menus.

If you would like to work with Core MIDI-compatible MIDI software that does not publish MIDI inputs and/or outputs, Performer Lite has the ability to publish its own Core MIDI inputs and outputs, which the other application can access for MIDI I/O with Performer Lite. For details, see “Interapplication MIDI (macOS only)” on page 29.

UPDATING PERFORMER LITE
Performer Lite can automatically check for updates; see “Checking for updates” on page 233.

THE PERFORMER LITE USER GUIDE PDF
This Performer Lite User Guide PDF can be found in Performer Lite’s Help menu. Table of Contents entries, index entries, and cross references are live links that will jump to their destinations. In some cases, you may need to click directly on the page number (rather than the heading).
CHAPTER 3  Configuring Audio Devices

OVERVIEW
This chapter helps you get the most out of Performer Lite’s audio recording and playback features. This chapter explains what MAS is, how to configure it for your audio hardware, and how to obtain the best performance possible from your computer. The performance tips in this chapter can have a dramatic effect on how well Performer Lite operates, so be sure to review this chapter carefully.

Overview ..................................................19
What is the MOTU Audio System? .................19
Preparing your computer .............................19
Supported audio hardware ............................19
Configuring the hardware driver .....................19
Configure Studio Settings .............................23

WHAT IS THE MOTU AUDIO SYSTEM?
MAS is the hard disk recording engine that drives Performer Lite’s digital audio recording capabilities. MAS provides a complete audio recording environment, including many features previously only available on expensive hardware-based systems. Advanced features include an adjustable number of internal busses, aux tracks, master faders and sends. MAS also provides a plug-in architecture for real-time audio effects, such as reverb, compression and EQ. Real time effects are covered in detail in chapter 57, “Audio Effects Plug-ins” (page 493).

PREPARING YOUR COMPUTER
Here are several things you need to do before using Performer Lite’s native audio recording and playback features.

SUPPORTED AUDIO HARDWARE
Performer Lite supports the built-in audio hardware in your computer and any Mac or Windows compatible audio hardware that ships with standard ASIO drivers, Mac OS Core Audio drivers, or Windows Audio (WASAPI) drivers. After the device’s driver has been successfully installed (as described in its installation instructions), and it has been chosen for use in Performer Lite (Setup menu> Configure Audio System>Configure Hardware Driver), it will appear as a choice for audio input and output inside Performer Lite, as explained in the next section.

All MOTU audio hardware, including Thunderbolt and USB interfaces, ship with Core Audio and ASIO drivers that allow them to operate successfully with virtually all Mac and Windows audio software.

CONFIGURING THE HARDWARE DRIVER
A hardware driver is software component of your computer system that allows Performer Lite to communicate with a piece of audio hardware, such as the audio circuitry inside your computer, a Thunderbolt audio interface, a USB or USB 2.0 audio interface, or an audio PCI card installed in one of your computer’s PCI slots. If you haven’t already installed the driver for your audio hardware, do so now, before proceeding below.

To establish the link between Performer Lite and your audio hardware, you need to activate its driver in Performer Lite. To do so, go to the Setup
menu and choose Configure Audio System>Configure Hardware Driver. The Configure Hardware Driver window appears as shown in Figure 3-1:

The Configure Hardware Driver window appears as shown in Figure 3-1:

![Configure Hardware Driver window](image1.png)

Figure 3-1: The Configure Hardware Driver window for Mac and Windows. On the Mac, you can select multiple drivers to operate several audio devices simultaneously by command-clicking them. In this example, a MOTU 1248 interface is being used with the computer’s built-in audio.

### Enabling the hardware driver

All Core Audio and/or ASIO drivers currently installed in your computer appear as shown in Figure 3-1.

### Enabling the hardware driver under Windows

For Windows, choose the ASIO or Windows Audio driver from the menu. Under Windows, only one driver can be active at a time. For ASIO, choose the desired ASIO driver (device) from the menu provided. For the best audio quality, highest channel counts, and lowest latency, use audio hardware that provides an ASIO driver.

The Windows Audio driver option is primarily intended for situations in which you do not have an ASIO driver installed, or you do not currently have access to ASIO-supported audio hardware. Window Audio is stereo only, but it can sample rate convert on both input and output. If sample rate conversion is engaged, the sample rate setting in Performer Lite’s control panel turns red. In addition, Performer Lite uses the default audio device chosen in the Windows Sound control panel. For best audio quality and lowest latency, go to the Advanced tab of the properties dialog for the default audio device and set the sample rate so that it matches the same rate as the Performer Lite project.

### Enabling the hardware driver under Mac OS

For macOS, click a driver to enable it. Command-click to enable multiple drivers at one time. This allows you to use multiple audio devices simultaneously, but there are additional setup requirements for reliable operation. See “Enabling multiple drivers (Mac only)” on page 22. Note that some Macs have separate drivers for their built-in input and built-in output, so to use both simultaneously you must select both as described above.

### Master Device (Mac only)

If only one driver is enabled (highlighted) in the list, this menu can be ignored.

If you are operating multiple audio devices (you have two or more devices selected in the list), choose the device that you wish to use as the master clock. For further details about this important setting, see “Enabling multiple drivers (Mac only)” on page 22.
Sample Rate
Choose the desired sample rate for recording and playback. 44.1 kHz is the standard rate for audio compact discs. If you intend to play audio files that have already been recorded, make sure you match their sample rate. If you aren’t sure what their sample rate is, import them into a Performer Lite file and look at them in the Soundbites list.

If you are operating multiple devices, this setting applies to all of them.

The choices in the sample rate menu are determined by the currently chosen audio hardware, according to the sample rates it supports. Sometimes, you may see non-standard sample rates in the menu (44,052 kHz for example). Consult the manual for your audio hardware for further details about non-standard sample rates.

Clock source/modes
For Windows, choose the desired clock source for your audio hardware. For macOS, this setting determines the clock source for each audio device. Choose each device from the menu on the left and choose its clock source from the menu on the right.

The choices in the clock source menu depend on the audio hardware, and the items in the menu are supplied by its driver. Most devices have an Internal setting, which means the audio device will run off its own clock. This means that audio playback and recording in Performer Lite will operate at the rate set by the hardware, and Performer Lite will use the hardware as its master time base (so that MIDI and audio stay in sync with each other).

If, however, you make Performer Lite slave to external sync while the audio hardware is running on its internal clock, the audio hardware — and therefore audio playback and recording in general — will not be resolved to external time code. The result is that your audio tracks will probably drift out of time with your MIDI tracks, and they won’t stay in sync with the external time code. Your best bet in this scenario is to slave your audio hardware to the same source that is feeding time code to Performer Lite. You can use a synchronizer to resolve to time code and supply your audio hardware with resolved digital audio clock via word clock or another digital audio sync format. See chapter 66, “Receive Sync” (page 554) for complete details.

If your audio hardware has digital inputs (such as a S/PDIF connector), the clock source menu will probably also provide settings that let you clock off the digital input source. In general, the audio hardware either needs to slave off the external digital source or vice versa. Or both the audio hardware and the external source need to be resolved via a third device, such as a digital audio synchronizer. If the two devices are not resolved with one another, you’ll hear clicks, pops, distortion, or other similar artifacts in your digital transfers.

Configure Driver (Windows ASIO only)
Click the Configure driver button to launch your hardware’s console software for further hardware settings, including the very important buffer size setting (explained below). Some ASIO drivers require that you make this setting in the hardware’s own console software, which you can access from this button.

Buffer Size
Mac OS
On macOS, the buffer size is set in the Configure Hardware Driver window (Figure 3-1 on page 20).

Windows
On Windows, the buffer size can be set by checking the Override internal buffer size check box and choosing the desired buffer from the
menu. If this option is grayed out, it means that your audio hardware’s ASIO driver doesn’t allow host applications to change its buffer size setting. In this case, click the Configure Driver button (Figure 3-1 on page 20) to launch the hardware’s console software to change the setting there.

The importance of buffer size
A buffer is a small part of computer memory that briefly holds digital audio samples as they are passed between the computer and your audio hardware. Choosing a smaller buffer size reduces latency, which is the delay you may hear when listening to live audio input that you are monitoring through Performer Lite — or when triggering virtual instruments from your MIDI controller. But lower settings also increase the processing load on your Mac, which impacts the number of real-time effects plug-ins you can run at one time.

If you won’t be running live inputs through Performer Lite, or playing software instruments, you can choose a higher buffer size to free up CPU processing bandwidth for plug-ins or other processor-intensive components of your virtual studio. A typical setting for this scenario is 512 or 1024 samples.

If you are running live input through Performer Lite, or triggering virtual instruments, choose the lowest setting that your computer can handle, keeping in mind that you still need to give your computer enough processing power to handle the plug-ins and virtual instruments you are using with Performer Lite. Settings of 256 or lower produce reasonable monitoring latency: a setting of 256 samples produces round-trip monitoring latency of around 12-13 milliseconds (ms), and the delay starts to become inaudible. For the lowest possible latency, you can go as low as 16 or 32 samples, if your audio hardware supports these buffer sizes. If, however, you hear clicks and pops in your audio, try raising the buffer size again.

Monitoring latency has no effect on recording: it only exists for a live signal as it is being monitored. It has no effect whatsoever on the timing accuracy of the material being recorded to disk. Performer Lite is precisely calibrated to record and play back hard disk audio perfectly on time.

If adjusting the Buffer Size setting just doesn’t allow you to strike the right balance between processor load and acceptable monitoring latency, you can also try external hardware monitoring, as explained in “Audio input monitoring” on page 257.

Work priority (Mac only)
The Work Priority option (Figure 3-1 on page 20) lets you set the macOS thread priority for the MOTU Audio System engine. Choose the highest setting your audio hardware allows. Some audio devices require the Low setting. If you are experiencing audio performance problems with other third-party audio hardware, try the Medium setting. If problems persist, try the Low setting. When using the Medium and Low settings, you may need to increase the buffer size for best results. For all MOTU audio interfaces, leave this option set to High.

Enabling multiple drivers (Mac only)
As demonstrated in Figure 3-1 on page 20, you can Command-click multiple drivers in the Configure Hardware Driver window. This allows you to use two or more audio devices simultaneously, such as a MOTU 1248 Thunderbolt audio interface and a MOTU UltraLite AVB USB interface. All devices operate at the chosen sample rate in the Configure Hardware Driver window. To prevent two or more systems from drifting apart from one another during playback and recording, you need to resolve their audio clocks.

There are two basic methods for resolving two digital audio devices: slave one device to the other, or slave both devices to a third master clock. If you
have three or more digital audio devices, you need to slave them all to a single master audio clock, such as a word clock distribution device or universal synchronizer.

![Image of audio devices setup](image)

Figure 3-2: To resolve two or more digital audio devices with each other, you need to choose a clock master.

To continue with our earlier example, you could slave the UltraLite AVB interface to the 1248 using optical, as demonstrated below:

![Image of audio devices setup](image)

Figure 3-3: To resolve two or more digital audio devices with each other, you need to choose a clock master.

**Specify the master device**

Specify the device that will be the master device by choosing it from the *Master Device* menu (Figure 3-1 on page 20).

**Configure Studio Settings**

The *Configure Studio Settings* dialog can be opened by choosing *Setup menu > Configure Audio System > Configure Studio Settings*.

![Configure Studio Settings dialog](image)

Figure 3-4: The *Configure Studio Settings* dialog.

The *Configure Studio Settings* dialog lets you fine-tune Performer Lite’s audio engine. These options are best left at their default settings, but they can be adjusted as described in the following sections.

**Stereo buses**

This setting determines the number of internal audio buses provided by Performer Lite and seen in the audio I/O menus throughout the application. This value is fairly arbitrary and does not in itself affect system performance that much. The number of buses you actually use, however, may have an impact your system resources.

**Prime Milliseconds**

The *Prime Milliseconds* setting determines how far in advance Performer Lite processes and cues audio for playback, including any pre-rendering of effects processing or virtual instrument output, if any. For example, if Prime Milliseconds is set to 125, when playback is underway, Performer Lite will generate audio 125 milliseconds ahead of the playback wiper location.

If Performer Lite’s playback isn’t smooth, increasing the Prime Milliseconds value may help. The downside of doing so is that you may experience more latency (delay) when interacting with virtual instruments and effects (turning
knobs, interacting with the instrument or plug-in window, dragging notes in the Sequence Editor, etc.)

**Automatic plug-in latency (delay) compensation**

Some plug-ins introduce a small amount of delay (latency) to the track on which they are instantiated. Here are a few examples of plug-ins that introduce latency:

- Universal Audio UAD plug-ins
- Any plug-in that employs look-ahead

The amount of the delay depends on the plug-in, and the delay is usually unavoidable, due to the nature of the plug-in itself. For example, a look-ahead peak limiter must delay the signal by the amount of the look-ahead in order to do its job (usually several milliseconds). Hardware accelerated plug-ins, such as UAD-1 plug-ins, require an extra loop in their signal path between the host computer and the acceleration hardware, and this loop introduces a small amount of delay (usually on the order of several hundred samples or so).

Performer Lite provides automatic compensation for plug-in latency when disk audio is being played through the plug-in. In essence, Performer Lite knows the exact amount of delay introduced by the plug-in (down to the sample) and simply feeds the disk audio to the plug-in early by that same amount, so that the plug-in has just enough time to process the audio and play it perfectly on time, with sample-accurate precision.

Automatic delay compensation only works with audio files being played back from a hard disk or virtual instruments being triggered by prerecorded MIDI tracks. Delay compensation cannot be applied to live audio or MIDI being patched through from an external live source (because it cannot be cued early by the audio engine).

Performer Lite automatically determines the delay compensation for each plug-in, if any. There is no additional preparation necessary. In addition, Performer Lite supports delay compensation for any MAS, VST, or Audio Unit plug-in or virtual instrument.

Most of the time, you will probably want to leave the **Automatic Plug-in Latency Compensation** option enabled. The only time you would likely need to disable it is if you are working with a project created in an earlier version of Performer Lite in which you set up latency compensation manually with delay plug-ins, etc. To make your old file play back exactly like it did in earlier versions of Performer Lite without making any changes to it, uncheck this option. If you wish, you could then remove your manual latency compensation and then re-enable automatic compensation.
CHAPTER 4 Configuring MIDI Devices

OVERVIEW
This chapter explains how to connect MIDI hardware devices to your computer and successfully establish MIDI input and output with the device. Here are some examples of MIDI devices:

- Controller keyboard
- Keyboard synthesizer
- Drum machine
- Sound module

Additionally, this chapter explains how to set up interapplication MIDI under macOS, which allows other software applications (such as stand-alone virtual instruments) to send and receive MIDI data to and from Performer Lite.

Virtual instrument plug-ins, such as those included with Performer Lite, do not require any configuration for MIDI I/O.

SETTING UP YOUR MIDI EQUIPMENT
MIDI gear connects to your computer in one of two ways:

- Directly (via USB, Thunderbolt, etc.)
  OR
- Using a MIDI interface

CONNECTING MIDI GEAR DIRECTLY
For MIDI equipment that connects directly to your computer with USB, Thunderbolt or other standard computer peripheral connection, follow the directions for installation, including the installation of any software (drivers, etc.) that it may require. No special additional procedures are necessary for Performer Lite. When you are finished installing the MIDI device as directed, Performer Lite should be able to “see” the device’s MIDI input and output channels (and cables).

CONNECTING MIDI GEAR USING A MIDI INTERFACE
For MIDI equipment that connects to your computer using a MIDI interface, you will need:

- Any Mac or PC compatible MIDI interface
- MIDI cables

1. Connect your MIDI interface to your computer and connect your MIDI devices to it as shown in Figure 4-1.

Figure 4-1: An example of connecting a single MIDI device to a MOTU micro express interface. Connect the device’s MIDI OUT and MIDI IN ports to the interface.
2 Turn on the MIDI interface, if it has a power switch (some devices are bus-powered).

**THE MIDI DEVICES TAB**

Once you’ve connected your MIDI hardware devices, you are ready to configure them in Performer Lite for use in all of your Performer Lite projects. To do so:

1. Launch Performer Lite.
2. Create a new project from the File menu.
3. Choose *Studio menu > Bundles* to open the Bundles window.
4. Click the MIDI Devices tab (Figure 4-2).

The MIDI Devices tab lets you create and configure MIDI devices connected to your MIDI hardware. The settings you make here will be available to all Performer Lite projects. If you transfer the project to another computer system, the devices you used will be preserved so that you can easily remap them as needed.

### Making MIDI connections in the I/O grid

Any connected MIDI interfaces appear across the top of the I/O grid, with their MIDI ports shown in columns beneath the interface. Use the Add button to create MIDI devices, which appear in the left-hand column and represent the hardware connected to the interface. Drag the MIDI in (I) and MIDI out (O) tile for each MIDI device to the appropriate MIDI interface port column (the column that represents the physical port it is connected to on the MIDI interface). For example, in Figure 4-2 the Roland JV-1080 is connected to MIDI IN port 1 and MIDI OUT port 1 on the micro express USB interface.

### Devices connected directly with USB, etc.

If you have a controller keyboard or other MIDI device that connects directly to the computer with USB, Thunderbolt, or other standard computer peripheral connection, it will appear above the I/O grid in the same fashion as the MIDI interface shown in Figure 4-2 (as long as its drivers have been installed successfully). In this case, no additional I/O configuration is required and the device will be available as a MIDI input and/or output, as determined by its driver.

---

*Figure 4-2: MIDI Devices tab in the Bundles window.*
Renaming an interface or USB device
To rename an interface or USB device above the grid, double-click its name.

Deleting offline interfaces
If your USB MIDI interface or keyboard goes offline (it gets turned off or disconnected), its name appears in italics. If you wish to remove it from the Bundles window grid, click its name and click the Delete button.

MIDI device properties
Click a MIDI device in the left-hand column to select it and then click the Edit button to specify the manufacturer and model for the device and to make additional device property settings (Figure 4-3).

Device
Choose the manufacturer of the device from the Manufacturer menu, then choose the model of the device from the Model menu. The Name field will be automatically filled in.

If you don’t see the manufacturer or model of the device in the list, or you would like to rename it for whatever reason, you can fill in the Name field manually.

Properties and ports
Specify the properties that describe the device. For example, you can describe what MIDI channels it uses for transmitting and receiving MIDI data. Enable any MIDI data types that are supported. If the device has multiple sets of MIDI ports, configure them in the Ports tab.

Patches
If you have a device which supports expansion boards, such as the Roland JV-1080, use this section to configure which expansion cards are loaded in the device. This will ensure that your patch lists are displayed accurately.

Let’s say you have a JV-1080 and would like to specify that you have the “Bass & Drums” expansion card installed. To configure Expansion Slot A Rhythm Kits, for example, locate Expansion
Slot A Rhythm Kits in the Bank column on the left, then choose “EXP Bass & Drums Rhythm Kits” in the Override column.

Getting started with Audio MIDI Setup

1. Connect your MIDI interface to your Mac and connect your MIDI devices to it as shown in the examples on page 25.

2. Turn on the MIDI interface, if it has a power switch (some devices are bus-powered).

3. Launch the Audio MIDI Setup utility. This can be found in /Applications/Utilities.

4. Confirm that the MIDI interface is present in the MIDI Studio window of Audio MIDI Setup (Window menu).

Audio MIDI Setup (macOS ONLY)

Audio MIDI Setup is a utility included with macOS that provides a graphical interface for configuring the MIDI devices connected to your computer. You can use Audio MIDI Setup as an alternative to the MIDI Devices tab in Performer Lite’s Bundles window. Any changes you make in Audio MIDI Setup are automatically reflected in Performer Lite’s MIDI Devices tab, and vice versa.

Using Audio MIDI Setup is not required. It is merely an alternative to using Performer Lite’s MIDI Devices tab.

Audio MIDI Setup provides two main advantages over the MIDI Devices tab:

- A graphical environment with device icons and “virtual cables” that you can arrange on-screen in a similar fashion to the physical layout in your studio space

- A single place to configure your MIDI devices for multiple MIDI applications, if you use other MIDI software besides Performer Lite

Audio MIDI Setup serves all Core MIDI compatible applications.

Figure 4-4: In this example, a MOTU Micro Express USB interface as it appears in Audio MIDI Setup.

Adding devices

After your MIDI interface appears in Audio MIDI Setup, you are ready to add devices in Audio MIDI Setup, connect them to the interface, and specify properties they may have for particular purposes. All of this information is shared with Performer Lite and other Core MIDI compatible applications.

To add a device in Audio MIDI Setup:

1. In the MIDI Studio window, click the “+” button in the title bar to add a device.
CONFIGURING MIDI DEVICES

2 Drag on its input and output arrows to draw connections to the MIDI interface that match its physical connection.

3 Double-click the device to make settings, such as input and output channels, that further describe the device.

4 Repeat the above steps for each MIDI device connected to the interface.

5 When you are finished, quit Audio MIDI Setup. Your configuration is automatically saved as the default configuration. You can use the Configuration menu to create, duplicate or delete alternative configurations.

INTERAPPLICATION MIDI (MACOS ONLY)
Performer Lite can send MIDI data to other applications and receive data from them as well. These interapplication MIDI streams are handled by Core MIDI, the Mac’s built-in MIDI services.

Most applications that share MIDI input and output with Performer Lite publish their own virtual MIDI inputs and outputs, which automatically appear in Performer Lite’s MIDI input and output menus. Most of the time, you can use the inputs and outputs provided by these other applications.
There may be times, however, when other applications require Performer Lite to publish inputs and outputs. Use the Interapplication MIDI window (Setup menu) to create them.

Click the Add buttons to create an input or output. To rename them, double-click the name. To remove an input or output, click it and click Delete.

Each input or output acts like a virtual MIDI cable, providing sixteen MIDI channels. Inputs appear by name in any menu in Performer Lite that displays MIDI inputs; outputs appear by name in any Performer Lite menu that displays MIDI outputs. For example, if you wish to send data from a Performer Lite MIDI track to another application, assign the track’s output to a Performer Lite MIDI output.

Performer Lite’s interapplication MIDI inputs and outputs are published to all MIDI applications that support the Mac’s built-in MIDI services. A Performer Lite output appears as an input in other applications; conversely, outputs from other applications appear as inputs in Performer Lite.

**The software synthesizer**

MacOS provides a basic software synthesizer that supplies a general MIDI sound set. To make this virtual instrument available as a MIDI destination and sound source in Performer Lite, check the box provided (Figure 4-8), and give it a name. The name you choose then shows up as a MIDI output destination in Performer Lite and other Core MIDI-compatible applications (when Performer Lite is running). To specify the audio output destination for the software synthesizer (i.e. where you’ll hear it), go to the **Audio** tab in macOS’s Audio MIDI Setup utility and choose the desired **Default Output** destination. The **Render quality** menu lets you choose the audio quality for the instrument playback. Higher quality places higher demand on the computer’s CPU resources.
Part 2

Getting Started
CHAPTER 5  Quick-Start Guide

Welcome to Performer Lite! Here’s how to get started quickly.

Creating a MIDI and Instrument track ...................... 32
Creating Audio Tracks ............................................. 33
Bouncing ............................................................... 34

CREATING A MIDI AND INSTRUMENT TRACK
Let’s start in the Sequence Editor.

Figure 5-1: The Sequence Editor button in the control bar.

1  From the Project menu, choose Add Track > Instrument >.

Here you can choose which MOTU or 3rd-party instrument you’d like to play. For this example, let’s choose PolySynth (included with Performer Lite).

Figure 5-2: The PolySynth instrument track and its associated MIDI track.

2  Once the tracks are created, tap on your MIDI controller and you should be able to hear the instrument.

3  If you don’t have a MIDI controller handy, go to Studio menu > MIDI Keys and use your computer keyboard to play.

4  To record your performance, click the Record button in the Transport section of the control bar.

Figure 5-3: The Record and Stop buttons.

As you play on your MIDI Controller or MIDI Keys, you’ll see the MIDI notes record to the MIDI track.

Figure 5-4: Notes recorded in the MIDI track.

To stop recording, press the Spacebar, or the Stop button (Figure 5-3).

You can now listen back to the recording by moving the wiper to the desired location and pressing space bar or Play.

☛ Press Enter/Return on your keyboard at any point to jump the wiper back to the beginning on the Sequence.

In the PolySynth plug-in window (Figure 5-2), you can make adjustments to the synth parameters to change the sound at any time, even after you’ve recorded.
CREATING AUDIO TRACKS

In Performer Lite, audio tracks can be either mono or stereo. So, which track format do you need?

Mono tracks are used for recording single inputs. Stereo tracks are used for recording two inputs at once, usually a left and right channel.

Keep in mind, both track formats use stereo outputs by default.

For example, if you want to record your voice using a single microphone, create a mono track. If you want to record a synthesizer with stereo outputs, create a stereo track to accommodate the left and right signals.

1 To create a mono or stereo track, choose Project menu > Add Track > Mono or Stereo Audio Track.

2 To rename the track, hold the Option or Alt key on your keyboard and click on the name.

New tracks have default colors based on track type. To choose a custom color, click on the track color menu, to the left of the track name.

Choosing the Input and Output

Audio tracks have an Input and Output setting. By default, they should already be set to the first input and output on your audio interface. So, if you plugged in a microphone to Input 1 on your interface and connected speakers to Outputs 1-2, the track’s settings are already correct for recording.

If you are recording on Input 2, go to the mono audio track and click on the “I” menu and choose Input 2 from the list (Figure 5-7).

If you are recording on channels beyond the 2nd input, or don’t see your desired input, choose New Mono Bundle. You should be able to see your interface’s full Input list here.

The same is true for outputs. If you don’t see your desired output, click the “O” menu and choose New Stereo Bundle.
**Input monitoring and arming tracks**

Now that you have assigned the desired input and output to your track, you’re ready to record.

1. To hear the input signal, click the blue speaker icon to the right of the track name (Figure 5-8).

   ![Figure 5-8: The Input Monitor button lets you hear the input signal.](image)

This is called *input monitoring*. It allows you to hear the audio input before you actually record. It’s great for setting your levels before you record.

2. Before pressing the main record button (Figure 5-3), make sure you’ve armed your track. You can do this by pressing the Record Enable button to the right of the Input Monitor button (Figure 5-8).

**Recording**

1. Once you’ve armed your track, press the master Record button in the Transport section of the control bar (Figure 5-3).

   The wiper should start moving and the track will record.

2. To stop recording, press the spacebar, or click the Stop icon in the Transport.

   ![Figure 5-9: Audio recorded in the audio track.](image)

You can now listen back to the recording by moving the wiper to the desired location and pressing space bar or Play. If you want to quickly jump back to the beginning of the sequence, just press the Enter/Return key on your keyboard.

**BOUNCING**

When you’re done recording or mixing, you’ll want to bounce to disk. To do so:

1. Highlight a time range selection with the I-Beam tool.

   ![Figure 5-10: Making a time-range selection with the I-Beam tool.](image)
2 Choose File menu > Bounce to Disk.

Here you can choose the Bounce Format and whether you want to add it back into the sequence.

Congratulations! You’ve created your first Performer project!

Bounce to Disk defaults to a Stereo Bounce of the mix. This means that all tracks playing in the sequence will be bounced down to a single Stereo file.

However, you can also bounce individual tracks by clicking on the Tracks button, and selecting the tracks you want to bounce.

Use the Tracks bounce feature to bounce stems or multi tracks for individual parts. Use the normal Output bounce for a single stereo mixdown of the whole sequence.

Before pressing OK, create a name for the bounce and make note of the location. By default, the bounce will go to the Bounces folder, which lives inside the Project Folder on your hard drive.

If you want to bounce it to a new location (like your Desktop), press Choose Folder.

To start the bounce, click OK.
CHAPTER 6  About Performer Lite

OVERVIEW
Performer Lite is an integrated digital audio workstation and MIDI sequencer designed to make it easy to make music with your computer. Performer Lite is based on Digital Performer, MOTU’s award-winning professional audio workstation software for music and audio professionals. Under the hood, Performer Lite is driven by the same cutting-edge technology as Digital Performer. What you see on screen, however, is a streamlined user interface that makes creating music easy and fun.

Performer Lite offers a combined total of 32 stereo audio and instrument tracks. If you need more tracks, and more advanced features and control, consider upgrading to Digital Performer. Special upgrade pricing is available.

DESIGN PHILOSOPHY
Performer Lite is designed to be simple and easy to use. The basic recording and playback functions are very straightforward, modeled after tape deck functions. They are located in Performer Lite’s Control Panel (Figure 6-1).

Almost every operation in Performer Lite can be done while the sequence is playing back or recording, so you don’t have to stop the music to get things done.

MIDI SEQUENCING
To use Performer Lite for MIDI sequencing, you must have a computer, a MIDI controller of some kind (such as a keyboard synthesizer or MIDI drum kit) and a sound source (such as a MIDI sound module or a software synthesizer running on the computer). Your external MIDI gear may also require a MIDI interface, although some MIDI hardware products now connect directly to a computer through USB.

Performer Lite is compatible with any MIDI-equipped hardware devices, such as synthesizers, samplers and drum machines. It is also compatible with just about all “virtual” software synthesizer and sampler products now available. Using the built-in sound capabilities of your computer and third-party virtual instrument products, you could complete Performer Lite projects with no extra hardware whatsoever.

Figure 6-1: Performer Lite’s Control Panel.
A MIDI sequencer is like a cross between a tape recorder and a player piano: the physical actions you make when playing the keyboard or other MIDI controller instruments are stored not as audio signals (as your tape machine would record) but as performance information that represents music (pitches, attacks, releases, pitch bends and more). The nuances in your musical performance are analyzed and its components encoded and stored. When played back, the synthesizer recreates your original performance. In this way, the recorded sequence is more like a player piano roll, telling the instrument exactly how to play itself. One nice thing about MIDI is that you can use any compatible instrument for playback. You can also edit the individual elements of your sequence, such as a single bad note in an otherwise flawless performance. MIDI sequencing provides you with a way to manipulate virtually any parameter of a musical performance.

Performer Lite offers sophisticated rhythmic correction (quantizing) features for both audio and MIDI tracks. It is possible to vary the degree of effectiveness of quantization, allowing you to preserve the “free” quality of your performance while putting the critical notes on the beat. In addition, special metric effects such as beat shifting and doubling attacks can be done.

**DIGITAL AUDIO RECORDING**

Performer Lite can record and play digital audio on any computer that meets the minimum requirements —without any extra audio hardware connected to the computer. Performer Lite supports Thunderbolt, AVB and high-speed USB hard disk recording systems from MOTU and other companies.

Performer Lite also provides mixing and mastering capabilities. A track bouncing feature allows you to create a mixdown of your project for mastering (in Performer Lite or any other mastering system). Performer Lite can take you from your initial creative idea all the way to your final mix.

If you are not familiar with hard disk recording and playback, there are aspects to Performer Lite that may be entirely new to you. If so, we recommend that you review chapter 68, “Hard Disk Recording Concepts” (page 570) for a briefing on concepts that are crucial for working with Performer Lite.

**SEAMLESS MIDI AND AUDIO**

Throughout Performer Lite, you’ll find features that work on MIDI and audio data in exactly the same way — often in the same window. For example, the Sequence Editor window graphically displays MIDI and audio data side by side in resizable track strips. Soundbites (parcels of audio data) can be cut, copied, and pasted at the same time as MIDI note data.

**EDITING**

After you’ve recorded, there is a great deal of editing power at your fingertips — you can change anything in your sequence, from a single event to a large section of data. Single events or selections of data can be edited or inserted anywhere in the sequence. The basic Cut and Paste operations and the region editing commands allow you to edit and create data: you can transpose whole sections, change controller values smoothly, create new pitch bend data, control velocity to create dynamic effects, create echo effects and more, each in only a few steps. State-of-the-art quantizing features such as Quantize and Groove Quantize help you perfect the rhythmic nuance in your sequences.

To access the data that makes up your sequence, Performer Lite offers powerful event-editing environments: the Sequence Editor and Notation Editor. Both windows support single-event and region editing as described above.
The Undo/Redo commands gives you complete freedom to experiment, always allowing you to return your project to any prior state.

ARRANGING
Performer Lite’s arranging features give you creative freedom to make large-scale changes to your project quickly and efficiently. In addition, many of its arranging features let you interact musically with your project, via key signatures, meter changes, very flexible and powerful tempo control features, and much more.

AUTOMATED MIXING
Performer Lite’s Mixing Board window provides a virtual, automated mixing environment. Use pan pots, volume faders and plug-in parameter controls to automate your entire mix. Based on familiar mixing board designs, Performer Lite’s Mixing Board can be customized to fit your computer screen and your mixing needs. Instantly show and hide tracks, and even hide cross-sections of the console that you aren’t using at the moment. Real time MIDI effects processing inserts can be applied to any track. The Mix menu allows you to create multiple mixdowns, which store all of the mix automation data for the entire sequence under one name. You can create an unlimited number of multiple mixdowns.

MIDI AND AUDIO EFFECTS PROCESSING
Performer Lite ships with dozens of MIDI and audio effects plug-ins that you can apply freely to your mix in the Mixing Board. From a simple 2-band EQ to premium plug-ins such as the 64-bit MasterWorks series, Performer Lite’s included plug-ins give you all the tools you need for great-sounding recordings.

VIRTUAL INSTRUMENTS
Performer Lite includes a host of simple, great-sounding virtual synth instruments that will get you started making music quickly. From the beefy, monophonic BassLine to the evocative FM synth, Proton, hundreds of presets and intuitive programming give you many sounds at your fingertips. Performer Lite also includes a 1.5 GB library of multi-sample instruments, synths, loops and phrases. Categories include acoustic and electronic drum kits, pianos, guitars and basses, along with church organs, electric organs, strings, brass, woodwinds, synths, choirs, voices, percussion, sound effects and more.

Performer Lite also serves as a virtual studio platform for a wide range of compatible third-party plug-in and virtual instrument products.

MASTERING
After you’ve recorded, edited, arranged, mixed and processed your project, Performer Lite gives you mastering plug-ins and bounce to disk features, allowing you to master your mix for delivery in any form, from WAVE and AIFF to audio compact disc and MP3.

MUSIC NOTATION
Performer Lite’s Notation Editor displays any combination of tracks as music notation on screen exactly as it will print out. Add musical symbols such as hairpin dynamics, articulations, and lyrics. Then arrange your score with repeats, endings, codas and other score arrangement features. The Notation Editor is ideal for lead sheets, instrument parts, or scores, which can be printed on any printer.
CHAPTER 7 Performer Lite Basics

OVERVIEW
In this chapter you’ll learn about Performer Lite’s main window and how to do basic tasks.

Overview ............................................. 39
Learn to use your computer ....................... 39
The Performer Lite window ....................... 39
Control Panel ........................................ 41
Track Selector ...................................... 41
Track Inspector ..................................... 42
Channel Strip ........................................ 42
The Window menu ................................ 43
Modifier keys ....................................... 43
Clicking shortcuts .................................. 44
Using modifier keys with cursor actions ......... 44
Contextual menus ................................... 44
Standard keyboard shortcuts ...................... 45
Customizing keyboard shortcuts ................ 46
Changing text box values by dragging .......... 46
Main counter shortcuts ............................. 46
Using the numeric keypad ....................... 47
Performer Lite track limits ....................... 47

LEARN TO USE YOUR COMPUTER
Before using Performer Lite, please review the standard user interface conventions for your computer. Be sure you are familiar with how to:

■ Use the mouse, trackpad and keyboard
■ Open, copy and delete files
■ Drag and drop items
■ Choose commands from menus
■ Select options using push buttons, radio buttons and check boxes
■ Respond to dialog boxes
■ Use keyboard shortcuts
■ Enter and edit text

THE PERFORMER LITE WINDOW
The Performer Lite window is shown in Figure 7-3 on page 40.

Window title
The window title shows the name of the project.

Window controls
Performer Lite’s standard window controls, such as the close button, minimize button, zoom button, and scroll bars, work the same way as standard window controls.

Sidebar
The left- and right-hand sidebars are resizable columns that flank the main body of the window and can be independently shown or hidden. In addition, the sidebars can be divided horizontally into sections.

Sidebar divider
Drag the divider to resize the sidebar; double-click the divider to open or close the sidebar.

Cell divider
Drag the divider to resize the cell.

Left sidebar buttons
Click the sidebar buttons to show or hide each section of the left sidebar: Track Selector (page 41), Track Inspector (page 42) and Channel Strip (page 42).

Figure 7-1: Left sidebar buttons.
**Right sidebar buttons**

Click the sidebar buttons to show or hide each section of the right sidebar: Content Browser (page 191), Soundbites (page 193), Set List (page 209) and Project Notes (page 83).

![Figure 7-2: Right sidebar buttons.](image)

**Zoom controls**

The Zoom controls enlarge and shrink the display horizontally and vertically.

**Track Selector show/hide button**

The Track Selector button shows and hides the Track Selector in the left sidebar.

**Active cell**

Click anywhere in a window cell to make it the currently active cell. When active, a cell displays a light gray border. The Settings menu in the title bar provides features that apply to the currently active cell.

**Settings menu**

The menu items in the Settings menu change, depending on which window cell is currently active. The items in the menu apply to the currently active cell.

![Figure 7-3: The Performer Lite window.](image)
**CONTROL PANEL**

The Control Panel (Figure 7-3) is the command center for your Performer Lite project. It contains basic transport controls, playback location counters, additional playback controls such as Memory Cycle, tools and buttons to access Performer Lite’s main features.

**Tools**

Use the tools in the Sequence Editor and Notation Editor to edit your music. See chapter 26, “Tools” (page 220).

**Transport controls**

Use the Transport Controls to play, stop, rewind, pause, record, skip and return to the beginning. See “Transport Controls” on page 87.

**Counter**

The Counter displays the current playback position in one of Performer Lite’s four time formats: measures|beats|ticks, real time, SMPTE time, or samples. See “Main counter shortcuts” on page 46 and “Counter” on page 88.

**Transport settings**

The transport settings include features like the metronome click, countoff, and memory cycle. See “Transport settings” on page 94.

**Tabs**

The Tabs control what is displayed in the Performer Lite window: Sequence Editor (page 102), Notation Editor (page 116), Mixing Board (page 156) or Clips View (page 179).

---

**TRACK SELECTOR**

To open the Track Selector (Figure 7-3), click its button in the Control Panel (Figure 7-1). Or click the Track selector show/hide button (Figure 7-3). Click track names in the Track Selector to show/hide them (Figure 7-5). Option/Alt-click to hide all except the one you click; Command/Ctrl-click to show all except the one you click. Drag across several adjacent tracks to show or hide them.

You can click track folders to show or hide the entire folder. The same is true for V-Racks. Click the disclosure triangle of a track folder or V-Rack to show or hide the tracks (and sub-folders) contained within it (Figure 7-5).

---

**Track Selector menu**

When the Track Selector is the active cell, the Settings menu (Figure 7-6) provides options for showing and hiding tracks, groups, etc. These are the same options as found in Performer Lite’s View menu. For details see “View menu” on page 273.
**TRACK INSPECTOR**

The Track Inspector (Figure 7-1) provides easy access to track settings such as color, input, output, play-enable status, record-enable status, Pitch mode, Stretch mode, and so on. These are the same settings shown in the track info pane in the Sequence Editor (Figure 17-13 on page 110).

![Figure 7-7: The Track Inspector.](image)

Track Inspector settings can also be displayed in the Info Bar of the Sequence Editor and Notation Editor using Preferences > Information Bar. See “Information Bar” on page 230.

When the Track Inspector is the active cell, the Settings menu (Figure 7-3 on page 40) provides several options.

**Configure Info Bar:** Displays settings in the Track Inspector cell that let you choose which settings in the Track Inspector will appear in the Information Bar. See “Information Bar” on page 230.

**Info Bar Preferences:** Opens the Information Bar preferences. See “Information Bar” on page 230.

**Use Small Menus in Info Bar:** When checked, this menu item reduces the size of the Track Inspector menus shown in the Info Bar.

---

**CHANNEL STRIP**

The Channel Strip (Figure 7-1, Figure 7-3) shows the Mixing Board channel strip controls for the current track you select or work in. If your sequence has a master fader, click the Master button at the top (Figure 7-8) to view its channel strip.

For details about the specific controls in the Channel Strip, see chapter 19, “Mixing Board” (page 156).

![Figure 7-8: The Channel Strip.](image)

When the Channel Strip is the active cell, the Settings menu provides several options. Use the Show/hide section (Figure 7-9) to show or hide sections of the
Channel Strip as desired. Use the Layout and Configuration sections to best arrange the controls within the cell, as desired.

Figure 7-9: The Channel Strip menu.

**Locking the Channel Strip**
The Channel Strip normally updates to follow the selected track, but it can be “locked” to display the track of your choice regardless of the selected track. To lock the Channel Strip to the track currently showing in the Channel Strip, click the lock button beneath the track name (Figure 7-8); click the icon again to unlock it.

**THE WINDOW MENU**
The Window menu helps you manage the Performer Lite windows on your computer screen.

**Enter Fullscreen** causes the Performer Lite window to fill your entire computer screen. Choose Exit Fullscreen to return Performer Lite to a separate window.

The Close command closes the top-most window.

**Push Window to Back** moves the topmost Performer Lite window behind all other Performer Lite windows.

The Set Focus to Next/Previous Cell commands let you move the cell focus in the Consolidated window, for things like keyboard shortcuts and menu commands. Close Cell closes the currently focused cell.

**Pop Out of Consolidated Window** removes the currently focused cell from the Performer Lite window and puts it into its own window. Pop Into Consolidated Window puts the cell back into the Performer Lite window.

**The Windows List** displays all of the open windows, with a check next to the active window. Select a window to make it the active window.

**Closing all windows**
To close all open windows (except the Control Panel, if it is), press Command-Control-W (Mac) or Ctrl-Win-W (Win). If you hold down the Command and Control keys (Mac) or Ctrl and Win keys (Windows) when choosing the Close command in the Window menu, it changes to Close All Windows.

**Closing all effect windows**
To close all open effect windows, press Command-Shift-Control-W (Mac) or Control-Shift-Win-W (Windows). If you hold down the Shift and Control/Win keys when choosing the Close command in the Window menu, it changes to Close All Effect Windows.

**MODIFIER KEYS**
Performer Lite employs the following modifier keys on Mac and Windows:

<table>
<thead>
<tr>
<th>Mac</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>Option</td>
<td>Alt</td>
</tr>
<tr>
<td>Command</td>
<td>Ctrl</td>
</tr>
<tr>
<td>Control</td>
<td>Windows logo (Win)</td>
</tr>
</tbody>
</table>
In this manual, references to the Mac Control key spell out the whole word, while references to the Windows Ctrl key use the abbreviated form found on most PC keyboards.

When referring to modifier keys, this manual uses the following conventions:

<table>
<thead>
<tr>
<th>Separator</th>
<th>Example</th>
<th>What it indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>- (dash)</td>
<td>Ctrl-Alt-click</td>
<td>Indicates modifier keys that should be pressed in combination</td>
</tr>
<tr>
<td>/ (slash)</td>
<td>Option/Alt-click</td>
<td>Serves as a separator between Mac and Windows keys.</td>
</tr>
</tbody>
</table>

**CLICKING SHORTCUTS**

*Option/Alt-click:* If you hold down the Option/Alt key and click on a check box, all check boxes will be unchecked except for the one you Option/Alt-clicked.

*Command/Ctrl-click:* If you hold down the Command/Ctrl key and click on a check box, all check boxes will be checked except for the one you clicked.

**USING MODIFIER KEYS WITH CURSOR ACTIONS**

Some actions are done with the cursor and keyboard together:

*To Control/Win-click:* Hold down the Control/Win key, move the mouse to position the arrow cursor on the object and click the mouse. In many places, Control/Win-clicking will cause a contextual menu to appear with convenient shortcuts to relevant commands and options. See “Contextual menus”, below.

*To Command/Ctrl-click:* Hold down the Command/Ctrl key, move the mouse to position the arrow cursor on the object and click the mouse. Command/Ctrl-clicking is used for selecting non-contiguous items; for example, you would use Command/Ctrl-click to select several independent events in an Edit window.

Command/Ctrl-click also toggles the current grid snapping setting. For example, if grid snapping is turned on, holding down the Command/Ctrl key temporarily disables it.

*To Shift-click,* hold down the Shift key, move the mouse to position the arrow cursor on the object and click the mouse. Shift-clicking is used for selecting non-contiguous items; for example, to select ten consecutive tracks in the Sequence Editor, click on the first track, the hold shift and click on the tenth track. You can also click and drag across items in a list to make a contiguous selection.

*To Shift-drag,* hold down the Shift key while dragging. Doing so extends the current selection — with one exception: in the graphic editors, Shift-dragging one or more events constrains dragging vertically or horizontally.

*To Option/Alt-click,* hold down the Option/Alt key, move the mouse to position the arrow cursor on the object and click the mouse. Option/Alt-click is used to edit the name of a track, sequence, or marker for editing. After editing, the new entry can be confirmed by pressing the Return key.

*To Option/Alt-drag,* hold down the Option/Alt key while dragging. Doing so makes a copy of what you are Option/Alt-dragging. This is also a shortcut for zooming in edit window, if you hold Option/Alt before you click and drag.

**CONTEXTUAL MENUS**

Contextual menus appear throughout Performer Lite to provide convenient access to frequently used commands and options.
To access the contextual menu, click with the right mouse button or hold the Control/Win key and click with the left mouse button.

Existing behaviors which utilize clicking while holding the Control/Win key take precedence over the contextual menu. That is, when Control/Win-click is already used in a particular context for a different function, you must use right-click to access the contextual menu.

**Contextual menu items**

The menu items shown in the contextual menu will depend on the context, as the name implies. For example, if you right-click on a selection of audio data in the Sequence Editor (as shown in Figure 7-10), you will see contextual menu items for moving and editing audio data, opening the data in other windows, and Sequence Editor track options. Some menu items may be unavailable temporarily (grayed out) depending on the kind of selection you have made, which layer is active, whether there is any data on the clipboard, and so on.

All items that appear in the contextual menus are available elsewhere as regular menu items, mini-menu items, keyboard shortcuts, and so on. That is, the contextual menu is never the only place to find a command or option.

**Event selections**

When there is an event selection (such as MIDI notes, soundbites, and so on), right-clicking directly on the selected events will open the contextual menu for those events.

**STANDARD KEYBOARD SHORTCUTS**

The following keyboard commands are applicable to dialog boxes and text boxes.

- **Pressing on the return key** is the same as clicking on OK: it confirms the selection in the dialog box.

- **Pressing on the enter key** will also OK a dialog box. It is also used when editing a list of names or data, confirming the current one and moving to the next.

  (Mac only) **Pressing the command and period keys** together is the same as clicking on the Cancel button: it cancels the selection and leaves the previous settings/values unchanged.

- **Pressing the escape key** is the same as clicking a Cancel button and (Mac only) pressing Command-period ( . ).

- **Pressing the tab key** will confirm the current entry field, then move to the next field in the box or list and highlight it. Pressing Shift-tab does the same thing, only it moves to the previous field or box.

- The **up arrow** will move through a list of names or events, confirming the current selection and moving to the previous one.

- The **down arrow** will move through a list of names or events, confirming the current selection and advancing to the next one.
The *left and right arrows* move to adjacent text fields, confirming the current selection and advancing to the next one in the arrow direction.

In addition to these, there are many shortcut keyboard commands that will allow you to choose commands from menus very quickly. They are indicated on the menus to the right of the commands themselves and can be used instead of pulling down the menu and selecting the command. To use a shortcut command, hold down the Command/Ctrl key and press the indicated key. For example, Command/Ctrl-X is the shortcut for the Cut command. Instead of pulling down the Edit menu and selecting Cut, hold down the Command/Ctrl key and press the X key.

**Figure 7-11: Examples of keyboard equivalents for menu commands in Performer Lite.**

### CUSTOMIZING KEYBOARD SHORTCUTS
Just about all keyboard shortcuts can be customized. For details, see chapter 28, “Commands” (page 234).

### CHANGING TEXT BOX VALUES BY DRAGGING
You can change number or note values in text edit boxes throughout Performer Lite by pressing on the text box and dragging up or down. You can also edit text box values in the usual ways (by typing, etc.)

### MAIN COUNTER SHORTCUTS
The current playback location can be changed at any time by editing the main Counter directly. This is a more precise method for locating than many of the other numerous ways of cuing Performer Lite. You can edit the counter even while the sequence is playing back. There are several ways to edit the current Counter location in Performer Lite, as described below.

**By typing**
To edit the counter by typing:

1. Click on the field in the time display to highlight it.
2. Type in a new time value.

While a field is highlighted, just type in a new value. Use the backspace key to erase an incorrect entry.

Press the Tab key or the decimal key on the numeric keypad to cycle through each field of a time display, highlighting each so that you can type in a value. (On Windows, make sure the Num Lock key is engaged before you use the decimal key on the keypad.) For example, to enter the time 11|1|015 as shown in the example above:

1. Click on the bars field to highlight it.
2. Press 11.
3. Press the Tab or decimal key.
5. Press the Tab or decimal key.
6. Press 0, 1, and 5.
7. Press the Return key.
As a shortcut, you can press the decimal key on the numeric keypad (with the Num Lock key engaged under Windows). To cancel the edit, press Command/Ctrl-period (Mac only) or escape.

**By dragging**
This is a great shortcut for quickly “yanking” the counter:

1. Press on the desired measure, beat, or tick field (or hour, minute, second, or frame field if you are working with SMPTE).
2. Drag up or down.

**By pasting**
Counter values can be copied and pasted from nearly any field where a counter value is displayed: the main counter, aux counter, Information Bar, and so on.

1. Click in any counter field.
2. Press Command/Ctrl-C or choose Edit menu > Copy.
3. Click in the main or aux counter field to highlight it.
4. Press Command/Ctrl-V or choose Edit menu > Paste.

**USING THE NUMERIC KEYPAD**
Performer Lite provides many factory default shortcuts on your computer’s standard extended numeric keypad (if it has one), from basic transport controls to specialized shortcuts for specific features, such as Notation Editor note entry functions.

**Windows Num Lock key**
On Windows, be sure to engage the Num Lock key to enable the numeric keypad shortcuts discussed in this manual.

---

### PERFORMER LITE TRACK LIMITS
As a “lite” version of MOTU’s flagship Digital Performer audio workstation software (which has no track limits), Performer Lite has the following track limits (and other limitations):

<table>
<thead>
<tr>
<th>Feature</th>
<th>Limit in Performer Lite</th>
<th>Limit in Digital Performer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequences and V-racks</td>
<td>6</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Audio tracks</td>
<td>16</td>
<td>Unlimited</td>
</tr>
<tr>
<td>MIDI tracks</td>
<td>16</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Instrument or aux tracks</td>
<td>16</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Busses</td>
<td>16</td>
<td>1024</td>
</tr>
<tr>
<td>Master faders</td>
<td>1</td>
<td>Unlimited</td>
</tr>
</tbody>
</table>

If your projects require more sequences, tracks, busses or master faders, please consider upgrading to Digital Performer. Visit motu.com for details.
An excellent way to learn Performer Lite quickly is to follow the tutorials. Choose Help menu > Tutorials to open the Tutorials sidebar.

**USING THE TUTORIALS SIDEBAR**

Getting around the Tutorials sidebar is easy.

Use the Home button at the top to return to the main menu.

Use the Forward/Back buttons next to the Home button to flip through the pages you've already visited.

To explore a topic, click it, and then use the Next/Previous buttons at the bottom to page through the topic.

To get back to this Tutorial sidebar at any time, choose Help menu > Tutorials.

To close it, click the close button in the title bar, or double-click the left edge of the sidebar.

**VIDEOS AND EXAMPLE FILES**

Within the tutorial pages, you’ll find links to short, helpful videos and demo files that illustrate the material being covered.
Part 3
Tracks
CHAPTER 9  Track Basics

OVERVIEW
Each track in Performer Lite holds an individual stream of MIDI or audio data. Each track has its own settings, input/output assignment, and a separate mixer channel. Tracks can be edited individually or together with other tracks. They can be grouped into track folders.

Overview .......................................................... 50
Basic track types .............................................. 50
Special track types ............................................. 51
Track settings ..................................................... 51
Creating a track .................................................. 53
Creating several tracks at once ......................... 53
Duplicating a track’s settings ............................. 53
Duplicating a track’s settings and data ................ 54
Renaming a track ............................................... 54
Deleting a track ............................................... 54
Track colors ..................................................... 54

BASIC TRACK TYPES
A sequence can have the following types of tracks.

MIDI tracks
A MIDI track is where MIDI data is recorded, edited and played back. In Performer Lite, MIDI data is stored in a MIDI track without channel information. Instead, each track can be assigned to play back to one or more MIDI channels. During playback, the MIDI data in the track is transmitted to the assigned channels. Any MIDI instrument that is listening to (receiving on) that same channel will respond to the MIDI data from the track.

Audio tracks
An audio track is where digital audio data is recorded, edited, and played back. It could be a recording of a single instrument, containing any number of punch-ins and overdubs for the instrument. Or it could contain a wide variety of sounds occurring at different times, such as sound effects. You can record any audio you want into an audio track, including speech, vocals, sound effects, etc.

Instrument tracks
An instrument track is a special kind of audio track which has a virtual instrument plug-in as its first effects insert. Virtual instrument plug-ins work very much like synthesizers, samplers and other hardware instruments: you send them MIDI data and they output an audio signal. Instrument tracks do not contain MIDI or audio data, but you can insert and record mix automation data into an Instrument track. For details, see chapter 12, “Instrument Tracks” (page 67).

Aux tracks
An Aux track is a special kind of audio track that routes an input directly to an output. You cannot record audio into an Aux track, nor can you place pre-recorded audio into it. But you can insert and record mix automation data into an Aux track.

Aux tracks are primarily intended as a routing mechanism. Aux tracks allow you to route audio from any source to any destination. For example, you can route several audio tracks to a single effects plug-in that you have placed on an Aux track effects insert.

Master Fader tracks
A Master Fader track controls the overall level of an output or bus bundle. Like Aux tracks, master fader tracks have no record button, and you cannot place audio in them. Instead, the master fader track provides an output assignment and volume control and automation over the output or bus you assign to it. The most common way to use...
a master fader is as a sub-mix fader for an output (or a bus) to which you have assigned a group of audio tracks. You can then control (automate, process, etc.) them as a group with the master fader.

**VCA tracks**
Similar to their analog mixing console counterparts, VCA tracks are used to control the relative volume, and other mixing parameters, of a group of other tracks with a single VCA track. You can create as many VCA tracks as you want in your mix, and you can even have VCA tracks control other VCA tracks as sub-groups. See chapter 55, “VCA Tracks” (page 481).

**SPECIAL TRACK TYPES**
In addition to the basic track types, there are two special-purpose tracks.

**The Conductor track**
The Conductor track stores meter, key, tempo, and marker information. For details, see the chapter 46, “Conductor Track” (page 418).

**The Movie track**
The Movie track is for playback and display purposes only, and is displayed only in the Sequence Editor. For details, see chapter 17, “Sequence Editor” (page 102).

---

**TRACK SETTINGS**
All basic track types have the following common track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
- Output assignment
- Take
- Automation settings
- Lock
- Color
- Comment

Each track type may also have additional settings which are specific to the track type. Refer to the following chapters for more information on each track type.

**Name**
To change the name of a track, click it while holding down the Option/Alt key and edit the text as desired in the resulting box. To confirm your change, press the Return key. To cancel the change, press the Command and period keys, or the Escape key. You can also click outside the box to confirm your edit. Use the Enter or Down Arrow key to OK the name change and move to the next track in the list. Use the Up Arrow key to OK the name change and move to the previous name in the list. The Conductor Track’s name cannot be changed.
The track type icon
Performer Lite provides the following types of tracks, with the following icons to identify them in the Sequence Editor:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Track type</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Conductor track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>MIDI track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Mono audio track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Stereo audio track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Aux track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Instrument track</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Master fader</td>
</tr>
<tr>
<td>![Icon]</td>
<td>VCA fader</td>
</tr>
</tbody>
</table>

Play/mute
The Play-Enable button engages a track for playback. When the button is lit, the track plays; when the button is empty, the track is muted. If muted, the data for the track is still there; you are just silencing the track during playback. Click the button to toggle between these two states.

Any number of tracks may be play-enabled at one time, but your MIDI and audio hardware resources — the MIDI devices in your studio and the audio hardware installed in your computer — ultimately determine how many tracks you can truly play all at once.

When Solo mode is engaged, clicking the play button toggles between play-enabled (blue) and muted (orange) or disabled (gray), depending on its state before entering solo mode.

The Conductor track contains no MIDI or audio data, so it therefore has no Play-Enable button.

Here are a few shortcuts for play-enabling tracks: to toggle the status of several tracks at one time, just drag (“glide”) over their play buttons. To Play-enable all tracks except for one, command click its play-enable button. To play-enable only one track and unplay-enable all others, Option/Alt-click the track’s play-enable button. This convention also applies throughout Performer Lite to similar toggle buttons, such as record-enable buttons, play and record buttons in other windows (such as the Sequence Editor), and Lock buttons in various windows.

For important information about track soloing and how it relates to the play-enable buttons, see “Soloing Tracks” on page 246.

Solo exemption
When you solo a track, the track you solo plays and all other tracks are muted. However, there are often tracks that should never be muted, even during soloing, such as master faders and aux returns. In addition, there might be disk tracks that you wish to always hear as you work (such as a tempo reference of some kind). For cases like these, tracks provide a setting called Solo Exempt, which appears as a checkable menu item in the track settings menu. If you check this menu item for a track, it turns on solo exemption for the track. This means that the track will not be muted when other tracks are soloed. To further indicate this, the track’s solo button in the Mixing Board disappears. Master faders are always solo exempt; therefore, their setting in the Sequence Editor cannot be toggled. Aux tracks are always Solo Exempt by default (although you can defeat their exempt status, if you wish). Solo exempt status can also be toggled in the track settings menus in the Sequence Editor and the Mixing Board (below the track name).
Output assignment
the Output column displays the destination for the MIDI or audio data in the track.

MIDI tracks, are assigned to a MIDI device in your studio followed by a dash and a MIDI channel number (between 1 and 16). It can also be a MIDI device group, which consists of several devices. The list of possible MIDI devices is provided by your MIDI device configuration (Studio menu > Bundles > MIDI Devices tab). For information, see “Choosing a MIDI output destination” on page 64, and “Changing the MIDI device list” on page 65.

Audio tracks are assigned to physical outputs on your audio hardware (such as the headphone output of your computer or a pair of outputs on an audio interface), or to one of Performer Lite’s internal busses. For information, see “Choosing an audio input and output” on page 59.

Take
The Take menu is used to manage track takes. For more information, see chapter 42, “Takes and Comping” (page 387).

Automation settings
This menu lets you specify various mix automation settings for the track. For details, see “Automation settings in other windows” on page 465.

Lock
When a track is unlocked (the default setting), all data in the track stays anchored to its measure location. If you change the tempo of the sequence, the SMPTE frame location of the data will change.

When a track is locked, all data in the track stays anchored to its current SMPTE frame location, even if you change the tempo of the sequence.

Color
To choose a color for a track, click on the color swatch next to the track name in the Sequence Editor, as shown below in Figure 9-1.

![Figure 9-1: Choosing track color.](image)

See “Track colors” on page 54 for more information on creating, using, and editing color schemes, and “Assigning colors” on page 56 for details about how to assign colors to multiple tracks at one time.

CREATING A TRACK
To create a track, choose the desired track type from the Project menu > Add Track sub-menu: MIDI, mono audio, stereo audio, and so on. New tracks are added to the Sequence Editor and all other windows that display tracks. In addition, a fader strip is added to the Mixing Board. You can create as many tracks as you like. If a current track is selected when you add new tracks, the new tracks are added below the selected track (or the last selected track, if more than one is selected).

CREATING SEVERAL TRACKS AT ONCE
If you want to add several tracks at once, hold down the Option/Alt key and choose the desired track type from the Project menu > Add Track submenu.

DUPLICATING A TRACK’S SETTINGS
You can add new, empty tracks by duplicating existing tracks. To duplicate one or more tracks’ layout, select the desired tracks and choose Add
**Similar Tracks** from the Project menu. The new track will have the word “copy” appended to its name.

This command does not copy the data in the track; instead, it copies only the track’s settings, such as name, input/output assignments, volume fader level, and so on.

**DUPLICATING A TRACK’S SETTINGS AND DATA**
To duplicate one or more existing tracks, including the contents of the tracks, select the tracks you wish to duplicate and choose *Duplicate Tracks* from the Project menu. The new track will have the word “copy” appended to its name.

**RENAME A TRACK**
Option/Alt-click the track name to change it.

**DELETE A TRACK**
To delete a track, select it and choose *Delete Tracks* from the Project menu. The track will be removed from the sequence. Delete several tracks at once by selecting them all before choosing the Delete Track command. When a track is deleted, all of its data is gone. You can undo the Delete command. You may also assign a keyboard shortcut to the Delete Tracks command.

**TRACK COLORS**
Performer Lite allows you to choose any display color you want for each track, as shown in Figure 9-1 on page 53. Coloring tracks can help you to distinguish them more easily in the Sequence Editor and Mixing Board. Performer Lite provides many different color schemes (sets of colors) for you to choose from. You can even create your own schemes.

**Working with color schemes**
A color scheme is a set of related colors that can be easily interchanged with a different set of related colors. For example, you could have a “Metallic” scheme and a “Earthy Pastels” scheme. Performer Lite provides several preset schemes, and you can freely change between them at any time. You can also create your own schemes.

**Changing the color scheme**
To switch to a different color scheme, go to the View menu, choose *Colors* and choose the desired scheme from the sub-menu.

**Editing color schemes**
To edit a color scheme, go to the View menu, choose *Colors > Edit Track Color Schemes*. Doing so opens the Edit Track Color Schemes dialog as shown below in Figure 9-2. The scheme currently being used is highlighted.

![The Color Schemes dialog.](image)

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To choose a different scheme</td>
<td>Click it once to select it and then click Done.</td>
</tr>
<tr>
<td>To edit a scheme</td>
<td>Double-click it. Or click it once to highlight it and click the Edit button.</td>
</tr>
<tr>
<td>To delete a scheme</td>
<td>Click it once to highlight it and click the Delete button.</td>
</tr>
<tr>
<td>To rename a scheme</td>
<td>Click it once to highlight it and click the Rename button.</td>
</tr>
<tr>
<td>To duplicate a scheme</td>
<td>Click it once to highlight it and click the Duplicate button.</td>
</tr>
<tr>
<td>To make a new color scheme</td>
<td>Duplicate an existing one (as described above), rename it, and edit it as desired.</td>
</tr>
</tbody>
</table>
Modifying a color scheme
To modify a color scheme, double-click it in the Edit Track Color Schemes dialog (shown in Figure 9-2). When you do, the color palette appears as shown below in Figure 9-3.

The swatches in these two columns can be changed to any color you want. Notice that they have a heavier border to indicate that they can be changed.

Figure 9-3: A color scheme palette. The 12 swatches in the left-most and right-most columns — the ones with the heavier borders — can be changed. The swatches in-between are automatically filled with a gradual blend between the colors on either end of the row.

Using the Color Picker
The color palette (as shown in Figure 9-3 on page 55) also lets you create your own colors using the macOS or Windows Color Picker. To open the color picker for a swatch, just double-click the swatch. Remember, only the swatches in the left-most and right-most columns of the palette can be modified. The swatches in the middle of each row are automatically filled with a gradual blend between the colors on either end of the row.

Here is a summary of what you can do in this window:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To open the color picker</td>
<td>Double-click any swatch in the left-most or right-most columns.</td>
</tr>
<tr>
<td>To fill a swatch using the eyedropper tool</td>
<td>Click once on the swatch to select it and then move the cursor over any color on your screen — even colors outside of Performer Lite and its windows.</td>
</tr>
<tr>
<td>To move a row up or down</td>
<td>Drag the swatch on either end of the row.</td>
</tr>
<tr>
<td>To flip a row (switch the left- and right-most swatches)</td>
<td>Drag either swatch to the other side of the row.</td>
</tr>
<tr>
<td>To change which swatch is currently selected (with a heavy border)</td>
<td>Use the arrow keys, or click the desired swatch.</td>
</tr>
</tbody>
</table>

Figure 9-4: Double-click any swatch with a heavy border to open the standard macOS or Windows color picker. Use the eye-dropper tool (circled) to choose any color on your screen.
**Using the color picker to “import” colors (Mac only)**

The color picker (as shown in Figure 9-4 above) lets you import any color you like using the magnifying glass tool. Just click the magnifying glass, and then move the cursor anywhere on your computer screen — even windows, dialogs, icons, and other items outside of Performer Lite (on the macOS desktop or in other applications running at the same time as Performer Lite).

For example, you could open a graphic image of some kind in Adobe Photoshop (or other graphics program) and then use the magnifying glass tool to import any color that is currently visible in the graphic image on your screen. You might find it helpful in this situation to close all of Performer Lite’s other windows before opening the color picker so that they will not cover up parts of the image you would like to click with the magnifying glass tool. You could also make a window set that consists of all windows being closed (except the Control Panel, of course).

**Assigning colors**

The Assign Track Colors sub-menu command (View menu) lets you Assign Track Colors to multiple tracks at one time. Numerous options are provided, as shown below in Figure 9-5:

![Assign Colors](image)

Figure 9-5: Assigning colors to many tracks at one time.

To use the Assign Track Colors command, select one or more tracks and then choose View menu > Colors > Assign Track Colors. Choose the option as desired and the click OK. Below is a summary of the assign color options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>according to Color Preferences</td>
<td>Assigns colors to each track according to the currently chosen color scheme in the View menu.</td>
</tr>
<tr>
<td>to all different colors</td>
<td>Assigns a color to each track from the currently selected color scheme (palette). When the &quot;Pick Colors Randomly&quot; check box is not checked, this option starts at the beginning of the palette and works its way towards the end as needed according to the number of tracks selected. If &quot;Pick Colors Randomly&quot; is checked, it will assign colors randomly from the palette.</td>
</tr>
<tr>
<td>to different shades of the same color</td>
<td>Lets you choose a specific color from the color palette and then only uses the various shades of that color (from the same row in the palette).</td>
</tr>
<tr>
<td>to colors in a range</td>
<td>Lets you choose a start color and an end color from the color palette and then cycles through all the colors in between as needed according to the number of tracks selected.</td>
</tr>
<tr>
<td>to the same color</td>
<td>Lets you assign all currently selected tracks to a single color of your choice (as specified by the swatch provided).</td>
</tr>
</tbody>
</table>

**The ‘Pick Colors Randomly’ option**

The Pick colors randomly option appears for several of the choices above it in the Assign Track Colors dialog. When it is checked, it assigns the specified colors at random to all currently selected tracks. When it is unchecked, colors are assigned from the current color scheme palette starting with the first color specified and then proceeding to the right and then down to the beginning of the next row.
CHAPTER 10 Audio Tracks

OVERVIEW
This chapter covers topics that are specific to the setup of audio tracks. For MIDI track setup, see chapter 11, “MIDI Tracks” (page 63).

Overview ........................................ 57
Integrated MIDI and hard disk audio .......... 57
Types of audio tracks ............................. 57
Audio (disk) tracks ............................... 57
Mono and stereo tracks ......................... 57
Creating an audio track ......................... 57
Creating several audio tracks at once ........ 58
Audio track settings ............................. 58
Input source: Audio bundles ................... 58
Choosing an audio input and output ........... 59
Record-enabling an audio track ................. 59
Input monitor enable ............................ 59
Stretch ............................................ 59
Pitch and Stretch Cache ......................... 60
Enabled .......................................... 60
Monitoring an audio track input ............... 61
Changing audio track settings on the fly ...... 61
Making I/O assignments for multiple tracks ... 61
Track limits ...................................... 61
Managing your computer’s system resources .. 62

INTEGRATED MIDI AND HARD DISK AUDIO
In Performer Lite, audio tracks are very similar to MIDI tracks, and they all appear together in Performer Lite’s Sequence Editor and Mixing Board.

TYPES OF AUDIO TRACKS
Performer Lite provides these audio track types:

- Audio (disk) tracks
- Instrument tracks
- Aux tracks
- Master faders

Audio tracks are used for recording and playing hard disk audio. For information on Instrument tracks, Aux tracks, and Master Fader tracks, refer to the following chapters.

AUDIO (DISK) TRACKS
An audio track (disk track) is where digital audio data is recorded, edited, and played back. It could be a recording of a single instrument, containing any number of punch-ins and overdubs for the instrument. Or it could contain a wide variety of sounds occurring at different times, such as sound effects. You can record any audio you want into an audio track, including speech, vocals, sound effects, etc.

Audio (disk) tracks are the only type of audio track into which you can record or place audio. They can be mono or stereo (discussed later in this chapter).

MONO AND STEREO TRACKS
A mono track holds one channel of audio. A stereo track holds two channels of audio. Stereo tracks are designed to support stereo recording and editing. Mono tracks can only hold mono soundbites, while stereo tracks can only hold stereo soundbites. Stereo tracks have an input pair (i.e. in 1-2) instead of a single input, like mono tracks.

CREATING AN AUDIO TRACK
Choose Add Track from the Project menu, and then from the Add Track sub menu choose the desired type of audio track you wish to create.
(mono or stereo track). If you choose stereo, you’ll see the inputs for the track shown as pairs (e.g. 1-2, 3-4, etc.)

New tracks are added to the Sequence Editor and all other windows that display tracks. In addition, a fader strip is added to the Mixing Board.

New audio tracks are named Audio-1, Audio-2, etc. You can rename the track by Option/Alt-clicking the name.

**CREATING SEVERAL AUDIO TRACKS AT ONCE**

If you want to add several audio tracks at once, hold down the Option/Alt key while accessing the Project menu and choose one of the *multiple* track options from the *Add Track* submenu.

**AUDIO TRACK SETTINGS**

Each audio track has the following universal track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
- Output assignment
- Take
- Automation settings
- Lock
- Color
- Comment

For further details on these universal settings, see “Track settings” on page 51. Each audio track also has the following audio-specific settings, discussed in this chapter:

<table>
<thead>
<tr>
<th>Setting</th>
<th>For further information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio Input</td>
<td>“Choosing an audio input and output” on page 59</td>
</tr>
<tr>
<td>Record-enable</td>
<td>“Record-enabling an audio track” on page 59</td>
</tr>
<tr>
<td>Input Monitor-enable</td>
<td>“Input monitor enable” on page 59</td>
</tr>
<tr>
<td>Stretch</td>
<td>“Stretch” on page 59</td>
</tr>
<tr>
<td>Pitch and Stretch Cache</td>
<td>“Pitch and Stretch Cache” on page 60</td>
</tr>
<tr>
<td>Enabled</td>
<td>“Enabled” on page 60</td>
</tr>
</tbody>
</table>

In addition, the Track Settings menu (Figure 10-1) contains a few settings that are specific to the Sequence Editor window, and they are covered in “Track settings menu” on page 112.

![Figure 10-1: Choosing an input and output for an audio track.](image)

**INPUT SOURCE: AUDIO BUNDLES**

Audio bundles serve as the crucial link between the virtual mixing world in Performer Lite and the actual audio hardware that is physically connected to (or installed in) your computer. Bundles provide a convenient layer between them that lets you effectively manage audio and MIDI input and output. To save time, you can create bundles as part of the process of making audio track input and output assignments (as explained in the next...
section). If you have a more elaborate studio setup, you can set up your audio bundles in advance using the Bundles window. For further information, see chapter 29, “Bundles” (page 238).

**CHOOSING AN AUDIO INPUT AND OUTPUT**
For each audio track, choose an input source and output destination as shown in Figure 10-1. The available choices in the input and output menus reflect the physical input and output jacks on the audio hardware installed in or connected to your computer. They also include any virtual instrument software running at the same time as Performer Lite.

You can choose an existing input or output (or input or output pair), or you can create a New mono bundle or New stereo bundle to assign the track to a new input or output. Or you can assign it to an input or output bundle that you created in the Bundles window, as explained in chapter 29, “Bundles” (page 238). Bundles which are already in use are bolded in input and output assignment menus, and a red dot in the input menu indicates that the input is currently record-enabled.

**Output assignments**
The track in Figure 10-1 above is assigned to — and panned across — the main outs of the audio interface. To play a track on a single output, pan hard left or right (where the odd numbered output is left and even is right). Alternatively, you can create a mono bundle and assign the output to that bundle.

**RECORD-ENABLING AN AUDIO TRACK**
The record-enable button (arms the track for recording). When the track is armed, the button is red.

Record-enable buttons are only present if the sequence is selected for playback in the Set List. Multiple audio tracks may be record-enabled at one time, although there is a preference that can restrict them to being record-enabled only one at a time, if you wish.

To arm several adjacent audio tracks, glide the arrow cursor over their record buttons (with the mouse button held down).

**INPUT MONITOR ENABLE**
The Input Monitor enable button (Figure 10-1 on page 58) lets you listen to the live audio signal being received on the audio track’s chosen hardware input. See “Audio input monitoring” on page 257.

**STRETCH**
Stretch is found in the Track Settings menu (Figure 10-1 on page 58) for audio tracks, as shown in Figure 17-15 on page 112. When this menu item is checked, the track’s Stretch edit layer is enabled and all soundbites in the track that have been beat and tempo analyzed (and therefore have their own tempo map) will be stretched to conform to the sequence tempo. As a result, they will always play in time with Performer Lite’s click, as well as other audio and MIDI tracks that have been recorded or sequenced in time with the sequence tempo. This is true regardless of whether the sequence is running under a constant tempo with the Tempo Slider, or with variable tempos in the Conductor Track.

When Stretch is unchecked, no stretching occurs automatically. Instead, soundbites play at their original tempo and duration. For example, if you have a dialog track or sound effects track for a movie, you would want to uncheck Stretch so that the dialog and sound effects do not get time-stretched (unless you do it manually on a per-soundbite basis).
If you lock the track (“Lock” on page 53) when the Stretch layer is enabled, doing so disables track stretching, as if it is turned off. Beat editing, however, remains available for editing.

There are preferences for enabling Stretch in the current project and new projects. See “Pitch and Stretch” on page 232.

For details about beat and tempo analysis, see chapter 44, “Audio Beats and Tempo Detection” (page 400). For details about managing soundbite tempos, see chapter 43, “Tempos and Audio” (page 394).

**Pitch and Stretch Cache**

Pitch and Stretch Cache is found in the Track Settings menu (Figure 10-1 on page 58), as shown in Figure 17-15 on page 112. When this menu item is checked, Performer Lite stops processing audio pitch and stretch operations for the track in real time and instead caches them on disk to reduce the CPU overhead required to produce them. This processing occurs off line, in the background, so it won’t affect playback performance.

If you are making pitch or stretch edits in an audio track, it is recommended that you leave this setting checked to reduce the demand on your computer’s CPU, especially during playback.

The advantage to keeping this menu item unchecked is that making edits in the track’s Pitch and Stretch could be a little more smooth and responsive, depending on how fast your computer is. The disadvantage is that the track will place higher overall demands on your computer’s CPU, especially during playback. There are preferences for enabling this cache in the current project and new projects. See “Pitch and Stretch” on page 232.

**Enabled**

Audio tracks require varying amounts of computing resources, depending on the amount of mix automation data in the track, what plug-ins or instruments are instantiated on the track and other factors. The audio track Enabled option (Figure 10-2 on page 61) allows you to temporarily take an audio track off line to free up its computing resources. Note, however, that doing so causes Performer Lite to re-allocate its audio engine resource. Track enabling/disabling is not designed to produce totally smooth transitions during playback or recording. Therefore it is best done when Performer Lite is stopped. You can certainly do it during playback, but it is strongly recommended that you avoid doing so in critical listening situations.

When an audio track has been disabled, it’s volume fader cap in the Mixing Board disappears, to clearly indicate that the track has been disabled.

If you wish to simply mute and unmute a track during playback (or recording), leave it enabled and use its play button to mute and unmute it. Doing so preserves the track’s system resources and ensures a completely smooth transition.

**Track Enable**

Each audio track has its own Enable feature (Figure 10-2). In the Sequence Editor and Mixing Board, this setting is a checkable menu item in the track settings menu. When a track is disabled, it relinquishes all of its system resources. But note that bringing it back on line is not instantaneous.
MONITORING AN AUDIO TRACK INPUT
Performer Lite lets you listen to the live input signal being fed to a track via its chosen hardware input by “patching thru” the input signal to the track’s output destination. See “Audio input monitoring” on page 257.

CHANGING AUDIO TRACK SETTINGS ON THE FLY
When operating Performer Lite under MAS, you can change audio track input, output and send assignments while playing. However, as noted above, enabling or disabling a track entirely to free up its system resources is best done when Performer Lite is stopped.

MAKING I/O ASSIGNMENTS FOR MULTIPLE TRACKS
The Track Assignments command (Studio menu) provides a convenient way to reassign audio (and MIDI) inputs and outputs. Just select the tracks you wish to assign and then choose this command.

Tip: To quickly change the I/O assignments for all tracks, use keyboard shortcuts: Command/ Ctrl-A to Select All, then Option/Alt-A to open the Track Assignments dialog.

Assigning inputs and outputs
You can choose to include or exclude inputs and/or outputs with the check boxes provided. You can either assign them to the same input/output pair or assign them to consecutive input/output pairs (1-2, then 3-4, etc., for example), starting with the pair that you choose in the menu.

Skipping master faders
Typically, you’ll quickly select all tracks when using the track assignments feature. But master faders usually have their own special output assignment and should therefore be excluded from the audio assignment operation. For your convenience, the Skip Master Fader tracks option, when checked, causes master faders to be left alone. If, for some reason, you would like them to be included, you can unchecked this option.

TRACK LIMITS
As a “light” version of Digital Performer, Performer Lite restricts the number of tracks that can be created. For a summary, see “Performer Lite track limits” on page 47.
MANAGING YOUR COMPUTER’S SYSTEM RESOURCES
The number of tracks you can play or record at the same time depends on the computing resources provided by your computer. See “Configuring the hardware driver” on page 19 to optimize your system for the maximum number of audio tracks.

Track bouncing with the Bounce command
One way to hear more tracks at once is to mix many tracks down to one track. You can do this freely in Performer Lite because in the realm of digital audio, there is no noise accumulation as a result of digital mixing. Another great advantage to digital mixing is that the original tracks remain intact, so you can always go back to them if you want (or you can delete them to free up space on your hard disk). You can even create multiple versions of a mix and quickly A/B the mixes. For more information about using the Bounce command, see chapter 64, “Bounce To Disk” (page 536).
CHAPTER 11  MIDI Tracks

OVERVIEW
This chapter covers topics that are specific to the setup of MIDI tracks for playback and recording. For audio track setup, see chapter 10, “Audio Tracks” (page 57).

WHAT IS A MIDI TRACK?
A MIDI track is where MIDI data is recorded, edited, and played back. In Performer Lite, MIDI data is stored in a MIDI track without channel information. Instead, each track can be assigned to play back to one or more MIDI channels. During playback, the MIDI data in the track is transmitted to the assigned channels. Any MIDI instrument that is listening to (receiving on) that same channel will respond to the MIDI data from the track.

CREATING A MIDI TRACK
To create a MIDI track choose Add Track>MIDI Track from the Project menu. New tracks are added to the Sequence Editor and all other windows that display tracks. In addition, a fader strip is added to the Mixing Board. You can create as many MIDI tracks as you like.

CREATING SEVERAL MIDI TRACKS AT ONCE
If you want to add several MIDI tracks at once, hold down the Option/Alt key and choose the Add Track>Multiple MIDI tracks from the Project menu.

INTEGRATED MIDI AND HARD DISK AUDIO
Performer Lite is designed to facilitate seamless MIDI sequencing and digital audio recording. If you would like to work with both MIDI and audio tracks, choose Setup menu > Audio System > MOTU Audio System. Performer Lite’s MIDI sequencing features are available regardless of whether you use audio or not.

MIDI ONLY
If you would like to run Performer Lite as a MIDI sequencer only (no digital audio), choose Setup menu>Audio System>MIDI Only. Doing so streamlines Performer Lite for MIDI sequencing, although many “off-line” audio features are still available (i.e. features that don’t involve the real-time recording or playing of audio data). For example, you can create new audio tracks and edit existing audio data.
MIDI TRACK SETTINGS
Each MIDI track has the following universal track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
- Output assignment
- Take
- Automation settings
- Lock
- Color
- Comment

For further details on these universal settings, see “Track settings” on page 51. Each MIDI track also has the following MIDI-specific settings:

- Record-enable
- MIDI input source
- MIDI output destination(s)
- Patch
- Default patch

This chapter covers these MIDI track settings.

RECORD-ENABLING A MIDI TRACK
The record-enable button arms the track for recording (red). Record-enable buttons are only present if the sequence is selected for playback in the Set List. Multiple audio tracks may be record-enabled at one time, although there is a preference that can restrict them to being record-enabled only one at a time, if you wish.

CHOOSING AN INPUT SOURCE
A record-enabled MIDI track will record data from any MIDI channel. Each MIDI track can record from an individual MIDI device on a particular MIDI channel. This lets you record into several independent tracks from several independent sources during a single record pass. Each MIDI track displays its own incoming MIDI device and channel number next to its record-enable button. See “Recording several audio tracks in one pass” on page 261 for details.

Click on the current input source to change it. If the input assignment for a MIDI track is blank, click in the blank space to open a menu of MIDI devices. You can select only one device and channel for each MIDI track.

CHOOSING A MIDI OUTPUT DESTINATION
Each MIDI track has an output destination. This is where the MIDI data in the track will be sent. For example, it could be a MIDI synthesizer or sampler in your studio, connected to the computer via a MIDI interface, or it could be a virtual (software) instrument running as a plug-in with Performer Lite, or perhaps concurrently on the computer with Performer Lite.

To select a MIDI output destination, choose it from the menu provided in the Output setting for the track in the Sequence Editor. For your convenience, this same MIDI output assignment menu also appears next to each track’s name in the Sequence Editor and Mixing Board as shown in Figure 19-2 on page 162 and Figure 17-16 on page 113.

The output destination MIDI device list
The devices in the output assignment list are provided by your MIDI device configuration. If a device you want is not present in the list, choose Bundles (Setup menu) and click the MIDI Devices...
MIDI TRACKS

Click in the Default Patch menu (Sequence Editor) to choose a sound for the track. For many popular MIDI devices, Performer Lite provides a list of the factory-default sounds in the instrument.

Figure 11-2: Choosing a MIDI instrument sound from the patch menu. If you see generic names like "Patch 1, Patch 2", etc., you can go ahead and use them anyway, as long as you know what sounds correspond with each patch change number.

CHOOSING A DEFAULT PATCH (SOUND)
The default patch is the sound that the track always begins with. It is remembered when you save the Performer Lite project so that the next time you open the project and press play, the default patch is called up from the synthesizer before playback begins so that the track will play with the correct sound. To select a default patch for a track, choose it from the default patch patch column or menu.

THE PATCH LIST
The list of patches (sounds) you see in the Default Patch menu displays the ‘factory’ sound names for many popular MIDI instruments. In some cases, patches are given the generic name “Patch-1”, “Patch-2”, etc.

MAKING I/O ASSIGNMENTS FOR MULTIPLE MIDI TRACKS
The Track Assignments command (Studio menu) provides a convenient way to reassign MIDI inputs and outputs. Just select the tracks you wish to assign and then choose this command. For details, see “Making I/O assignments for multiple tracks” on page 61.
keys for changing octave, changing on-velocity, applying pitch bend and applying modulation wheel. As a “virtual” controller, MIDI Keys may not be suitable for performing a Chopin Nocturne, but they do serve as a quick and convenient way to enter MIDI data when a “real” MIDI controller is not available.

![MIDI Keys](image)

**Figure 11-3: MIDI Keys**

### Playing notes
Press the keys in the top row (W through P) and middle row (A through ') of the computer keyboard (Figure 11-3) to trigger the notes in the current octave, where the letter A is the pitch C and the letter J is the B just below the next octave.

### Octave up/down
Press the minus (-) and equal (=) keys to go down or up one octave, respectively.

### Octave display
Displays the current octave being played by the MIDI Keys, as controlled by the octave up/down keys. Or click anywhere on the octave display keyboard to jump directly to the desired octave.

### Note-on velocity
Press the Z through period (.) keys to adjust the note-on velocity between 0 and 127 as follows:

<table>
<thead>
<tr>
<th>Key</th>
<th>Note-on velocity</th>
</tr>
</thead>
<tbody>
<tr>
<td>z</td>
<td>10</td>
</tr>
<tr>
<td>x</td>
<td>32</td>
</tr>
<tr>
<td>c</td>
<td>54</td>
</tr>
<tr>
<td>v</td>
<td>76</td>
</tr>
<tr>
<td>b</td>
<td>98</td>
</tr>
<tr>
<td>n</td>
<td>120</td>
</tr>
<tr>
<td>m</td>
<td>127</td>
</tr>
</tbody>
</table>

. (comma) decrease by 1
. (period) increase by 1

### Pitch Bend
Press the 1 and 2 keys to apply pitch bend down or up, respectively.

### Mod wheel
Press the 4 through 9 keys to apply modulation wheel as follows:

<table>
<thead>
<tr>
<th>Key</th>
<th>Mod wheel value</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>6</td>
<td>51</td>
</tr>
<tr>
<td>7</td>
<td>76</td>
</tr>
<tr>
<td>8</td>
<td>102</td>
</tr>
<tr>
<td>9</td>
<td>127</td>
</tr>
</tbody>
</table>

### MIDI sustain
The tab and back slash (\) keys provide MIDI sustain (CC# 64).

### Recording into a MIDI track with MIDI Keys
To record into a MIDI track with MIDI Keys, simply record-enable the MIDI track, start recording and play MIDI Keys.

### Playing a virtual instrument with MIDI Keys
To play a virtual instrument with MIDI Keys, set up a virtual instrument track and a MIDI track for it as described in “Creating an instrument track” on page 67, record-enable the MIDI track and then play MIDI Keys.
OVERVIEW
Virtual instruments, also called “software synthesizers” or “soft synths”, are MIDI instruments which are software-based rather than hardware-based. These appear on instrument tracks in Performer Lite.

Instrument tracks work very much like synthesizers, samplers and other hardware instruments. You send them MIDI data from a MIDI track, and their audio output signal from the output of the instrument track can be routed anywhere in the Performer Lite mixing environment.

Performer Lite provides a variety of included virtual instrument plug-ins; for details on these instruments, see chapter 2, “Instrument Plug-ins” (page 55) in the DP Plug-ins Guide. It also supports third-party virtual instrument plug-ins in its native MAS plug-in format (Mac and Windows), the VST format (Mac and Windows), and Mac OS X’s Audio Unit (AU) format. For further details about VSTs and AUs, see “Working with VST and Audio Unit plug-ins” on page 496.

CREATING AN INSTRUMENT TRACK
To create an instrument track, choose Project menu> Add Track.

From there, you have several choices:

- Choose Add Instrument, and from the sub-menus, choose the instrument you wish to add. Doing so creates an instrument track with that instrument plug-in instantiated on it. In addition, a MIDI track is also created, just below the instrument track in the Sequence Editor, assigned to the instrument track.

- Choose Add Instrument with Options. This opens a dialog that lets you add one or more instrument tracks and one or more MIDI tracks for each instrument at the same time.

If you create multiple MIDI tracks and the instrument you choose has multiple MIDI destinations (such as the 64 individual MIDI inputs in MachFive), Performer Lite will map each MIDI track to a separate channel.

An option is also provided to place the new instrument and MIDI tracks together in a new Track Folder, if desired. Each instrument is placed in its own folder, with its MIDI tracks.
Choose Add Unassigned Instrument. Doing so creates the new instrument track with no instrument yet assigned. You can then assign an instrument in the Mixing Board from the instrument insert, as explained later.

**VST, AU, and MAS instruments**
All instruments in all supported formats (VST, AU and MAS) appear in Performer Lite’s instrument plug-in menus. You can manage which formats you wish to use, using the audio plug-in preferences. See “Plug-ins with multiple versions (formats)” on page 498.

**Organizing instrument menus**
Instruments are organized into several convenient sub-menus, which you can further customize using the plug-in browser. See “Choosing a plug-in for an insert” on page 161.

**Unavailable instruments in the sub-menu**
If an instrument is unavailable (grayed out) in the Instrument Track sub-menu, it means that there is no current audio bundle in the project that supports the instrument’s audio output format (quad, 5.1, etc.) Create a bundle that matches its format, and it will become active in the menu.

**INSTRUMENT TRACK SETTINGS**
Each instrument track has the following universal track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
- Output assignment
- Take
- Automation settings
- Lock
- Color
- Comment

For further details on these universal settings, see “Track settings” on page 51. Each instrument track also has the following setting, discussed in chapter 10, “Audio Tracks”:

- Enable/disable (page 60)

**WORKING WITH INSTRUMENT PLUG-INS**
Instrument plug-ins work very much like synthesizers, samplers and other hardware instruments. You send them MIDI data from a Performer Lite MIDI track, and their audio output goes to the output of the instrument track itself.

When you first open (“instantiate”) an instrument plug-in, it publishes its MIDI ports, which appear in the output menu of Performer Lite’s MIDI tracks.

Make sure that the MIDI channel you choose matches the MIDI receive channel for the virtual instrument. If the instrument is multi timbral, such as MachFive, you can set up one MIDI track for each independent part. For example, with MachFive, which provides unlimited parts using 64 possible MIDI inputs, each playing a different preset (sound or instrument), you could set up as many as 64 MIDI tracks (on separate MIDI channels) to play the parts in one instance of MachFive.

**INSTRUMENT TRACKS IN THE MIXING BOARD**
Instrument tracks appear in the Mixing Board, just like other audio tracks. See “Instrument tracks” on page 171.
OPEN INSTRUMENT SHORTCUT
For instrument tracks and MIDI tracks assigned to virtual instruments, an Open Instrument shortcut is available to quickly open the instrument plug-in window. This shortcut is available in a number of ways:

- keyboard shortcut
- Sequence Editor track menu
- Mixing Board track menu
- Track Inspector/Info Bar button

If a MIDI track is not assigned to a virtual instrument, the Open Instrument command will be unavailable.

INSTRUMENT TRACK AUTOMATION
To control volume, panning, etc. for the instrument, you can use the controls on its channel strip in the Mixing Board. As with aux tracks and disk tracks, these parameters can be automated. Instrument plug-in parameter automation depends on the plug-in. If the plug-in supports automation, it is handled either via Performer Lite’s control point automation features in the instrument audio track, or via MIDI continuous controller data. If the plug-in uses MIDI controllers, you can record, insert, edit and otherwise manage the MIDI controller data in the instrument’s MIDI track. For example, in MachFive, you can control the filter cutoff frequency by sending MIDI Controller #74.

INSTRUMENTS AS AUDIO PLUG-INS
In all other respects, instrument plug-ins work just like audio effects plug-ins. For more information, see chapter 56, “Effects Window” (page 488) and chapter 57, “Audio Effects Plug-ins” (page 493).

INSTRUMENT PLUG-INS IN V-RACKS
If you need to use an instrument plug-in with multiple sequences in a Performer Lite project, you can conserve computer processing power by instantiating the instrument in a V-Rack, which can then be accessed from all sequences in the project. See chapter 25, “V-Racks” (page 216) for more information.

MULTIPLE AUDIO OUTPUTS
Some instrument plug-ins provide multiple audio outputs. You can access them in the Instruments tab in the Bundles window (Studio menu).

Creating instrument output bundles
To make the instrument plug-in’s outputs appear across the top of the Bundles window, instantiate the instrument plug-in as usual. Then use the Add button at the bottom of the window to create as many bundles as needed in the usual fashion: choose the desired channel format, specify a name, and place the tiles on the desired channels.

Using instrument output bundles
Instrument output bundles operate just like a bus: they can be used to route audio from the instrument to any other destination within Performer Lite’s powerful mixing environment. For example, you could route the instrument’s output to an aux track.

PERFORMER LITE’S INCLUDED INSTRUMENTS
Performer Lite includes a variety of instrument plug-ins, plus the MOTU Instruments Lite soundbank, which provides over 100 multi-sampled instruments. Refer to chapter 2, “Instrument Plug-ins” (page 55) in the DP Plugins Guide.

TRACK LIMITS
As a “light” version of Digital Performer, Performer Lite restricts the number of tracks that can be created. For a summary, see “Performer Lite track limits” on page 47.


CHAPTER 13  Aux Tracks and Master Fader Tracks

OVERVIEW
Aux tracks and Master Fader tracks are special kinds of audio tracks for routing and grouping audio signals in the Performer Lite project.

Overview .................................................................................70
Aux tracks .................................................................70
Master Fader tracks ......................................................71
Track limits .................................................................72

AUX TRACKS
An Aux track is a special kind of audio track that routes an input directly to an output. Think of it as an individual signal path within Performer Lite’s virtual mixing environment. You cannot record audio into an Aux track, nor can you place pre-recorded audio into it. But you can insert and record mix automation data into an Aux track (as well as loops).

Aux tracks are primarily intended as a routing mechanism. Aux tracks allow you to route audio from any source to any destination. Here are just a few examples: you can route disk tracks to an Aux track via a bus; you can route an input on an external audio interface (such as a MOTU 2408mk3) directly to an output. You can route several audio tracks to a single effects plug-in that you have placed on an Aux track effects insert.

You can add as many Aux tracks as you like, and, as mentioned earlier, you can use them in many situations to get audio from here to there in your system using the Aux track’s input and output assignments. For details about bussing and aux tracks, see Part 9 “Mixing” (page 461).

Conserving CPU resources with aux tracks
If you would like to apply the same plug-in to two or more audio tracks, consider assigning the plug-in to a single Aux track insert instead. Then, apply it to multiple audio tracks by bussing them to the Aux track, using either their main output assignment, a send, or both (if you’d like a bit of the original signal mixed in with the affected one). Having one plug-in with multiple inputs requires far less processing resources than applying the plug-in on multiple tracks.

Using aux tracks for live inputs such as synthesizers
You can use Aux tracks to feed live inputs (synths, etc.) into your mix. However, you may need to compensate for your system’s monitoring latency. See “ing latency” on page 258.

Monitoring with Aux tracks present
Here’s a problem you may encounter when monitoring inputs: you keep hearing an input, even though you don’t have any tracks record-enabled. Or, you keep hearing an input, no matter which track you record-enable.

The most likely cause of these situations is the presence of an Aux track. If you have created an Aux track that patches an input directly to an output, you’ll always hear the signal from the Aux track’s assigned input — unless you un-play-
enable the Aux track altogether. So if you encounter monitoring problems, check your Aux tracks.

**Aux track shortcut**
You can create an aux track while assigning a track output or a send to a bus. The bus will then feed the track’s signal to the newly created aux track.

**Aux track settings**
Each aux track has the following universal track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
- Output assignment
- Take
- Automation settings
- Lock
- Color
- Comment

For further details on these universal settings, see “Track settings” on page 51. Each aux track also has the following setting, discussed in chapter 10, “Audio Tracks”:

- Input source (page 59)
- Enable/disable (page 60)

**MASTER FADER TRACKS**
A master fader track controls the overall level of an output or bus bundle.

Like aux tracks, master fader tracks have no record button (or pan knob), and you cannot place audio in them. Instead, the master fader track provides an output assignment and volume control and automation over the output or bus you assign to it. The most common way to use a master fader is as a sub-mix fader for an output (or a bus) to which you have assigned a group of audio tracks. You can then control (automate, process, etc.) them as a group with the master fader. This is a great way to automate the level of a group of tracks without having to create a fader group.

**Master Fader track settings**
Each master fader track has the following universal track settings:

- Name
- Track type icon
- Play/mute
- Solo exemption
Output assignment
Take
Automation settings
Lock
Color
Comment

For further details on these universal settings, see “Track settings” on page 51. Each master fader track also has the following setting, discussed in chapter 10, “Audio Tracks”:

Enable/disable (page 60)

**TRACK LIMITS**
As a “light” version of Digital Performer, Performer Lite restricts the number of tracks that can be created. For a summary, see “Performer Lite track limits” on page 47.
CHAPTER 14  Track Folders and Track Groups

OVERVIEW
Track folders allow you to visually group, collapse, and manipulate multiple tracks in the Sequence Editor, Mixing Board and Notation Editor.

Track groups allow you to functionally link multiple tracks for editing and mixing purposes.

Overview ................................. 73
Track Folders ............................. 73
Track Groups ............................. 73

TRACK FOLDERS
There is a Track Folders sub-menu in the Project menu. Choose New Track Folder to create one, and then drag tracks into it (see below). Or select two or more existing tracks first and choose New Track Folder from Selected Tracks. Track folders can be used in all windows that display multiple tracks (the Sequence Editor and Mixing Board). Track folders can be nested (folders within folders).

Folders also have track controls, such as Play-enable, Solo Exempt, and Lock, which toggle the corresponding settings on the tracks inside the folder.

TRACK GROUPS
Performer Lite allows you to create an unlimited number of track groups. Tracks can be linked for editing, mixing, editing and mixing, a customized set of operations that you specify, or VCA control. Tracks can be a member of more than one group. Groups can also be “nested” within each other.

Track folders are independent of track groups.

Creating a track group in the Sequence Editor
To create a track group in the Sequence Editor, select two or more tracks (or make a multitrack selection) and choose Project menu>Modify Track Groups>New Track Group. Or press Command/ Ctrl-Shift-G. (This shortcut can be customized in Setup menu > Commands).

Creating a track group in the Mixing Board
To create a track group in the Mixing Board:

1  Choose New Track Group from the Mixing Board mini-menu.

The cursor turns into a plus sign to indicate that you are now ready to add (or remove) faders and/or pan knobs from the group. Existing faders in the group display a flashing green box.

2  Click the faders (and/or knobs) you want to add.

A flashing green box appears around the fader to indicate that it has been added to the group.

Figure 14-1: Track folders.

Working with track folders
To show or hide the contents of a folder, click its disclosure triangle. Command/Ctrl-click it to show/hide all sub-folders inside it. Option/Alt-click to show/hide all other folders at the same level. Command/Ctrl-Option/Alt-click to show/hide all folders at all levels.

To delete a folder, use the Project menu > Track Folders > Delete Track Folders command.
3 To remove faders (and/or knobs) from the group (ones that already have a flashing box), click them.

4 When you are finished adding and removing items, press the return or enter key to confirm the group, or double-click the last item you want to add or remove.

To cancel, press Command/Ctrl-period, the escape key (esc), or click elsewhere in the window (such as the title bar).

**Deleting a track group**
To delete a track group, click one of its tracks to select it and choose *Project menu>*Modify Track Groups>*Ungroup Tracks*. Or delete it in the Track Groups window (explained below).

**The Track Groups window**
Track groups are displayed and modified in the Track Groups window (Project menu).

![Figure 14-2: Track Groups window.](image)
Use the Track Groups window as follows to manage track groups:

**To do this:**  **Do this:**
---
To rename a track group Double-click or Option/Alt-click its name.
To delete a track group Click it to highlight it and choose Delete Track Group from the mini-menu.
To view the tracks in a group Click its disclosure triangle.
To add a track to a group Select the tracks (or make a selection in the tracks you wish to add), click the track group in the Track Groups window to highlight its name, and then choose Add Selection to Group from the mini-menu.
To add a grouped track to another group Temporarily disable track grouping (see “Temporarily suspending track groups” on page 76) and then use the procedure above.
To remove a track from a group Click it to highlight it and choose Remove Tracks from Group in the mini-menu.
To temporarily disable or enable a group Click the box to the left of its name.
To change the group type Choose it from the Type menu as shown in Figure 14-2.

**Group types**
Track grouping allows you to apply operations to the tracks in the group as a single unit. For example, for a mix group, moving the volume fader for one track in the group moves the faders in all tracks in the group. The Group Type menu (Figure 14-2) lets you determine which operations are affected by the group:

**Mix group**
A Mix group controls track volume, play-enable (mute/unmute), solo, solo exempt status, automation play-enable, automation record-enable and automation mode.

If tracks are grouped for mix volume, dragging any fader within the group moves all members of the group, scaling them proportionally to their current values. Option/Alt-dragging temporarily overrides the group to adjust a control relative to the group.

You can override the grouping for volume and pan in the Mixing Board by holding down the Option/Alt key while dragging the fader or pan pot.

**Edit group**
An Edit group controls time range selections. If you make a time range selection in one track, all other tracks in the group are included. It also includes inserting, reshaping and dragging continuous data, as well as the following track display characteristics in the Sequence Editor: edit layer, continuous data mode, track size and vertical zoom size.

**Mix & Edit group**
A Mix & Edit group controls both the Mix and Edit group operations described above.

**VCA group**
Use the VCA group setting when you wish to control the volume of the tracks in the group with a VCA track, but you don’t want (or need) any Edit, Mix or Custom group parameters for the group. With VCA volume control, the VCA track controls all of the individual track faders, but dragging an individual track fader only controls that fader, not the rest of the group, as it does for a Mix group. In addition, the VCA track controls the Solo, Mute, and Record Enable settings for the VCA group. Mix automation data, if any, is also affected. For more information about VCA tracks, including how to assign a VCA track to a group, see chapter 55, “VCA Tracks” (page 481).

**Custom group**
A Custom edit group lets you control a customized set of operations that you specify in the Custom group dialog (Figure 14-3). Check the items you wish to control in the group. If you choose Edit, Mix, Edit & Mix or VCA from the menu at the top...
of the window, the check boxes in the window will update to show you what the default settings are for these preset groups.

- If the custom group is being controlled by a VCA track, the Volume Fader option will be grayed out to indicate that volume faders are solely under the control of the VCA track (not individual track faders within the group).

2 Click the track group in the Track Groups window to highlight its name.

3 Choose Add Selection to Group from the mini-menu.

Nesting groups within each other
Because tracks can be part of other groups, this allows you to create any grouped configuration you need, including nested groups. For example, you might group your kick, snare and hi-hat tracks into a group called Drum Kit, which is part of a larger group called Percussion, which is part of yet another larger group called Rhythm Section, which might include bass guitar, rhythm guitar, organ, etc. In addition, the group type can be different at each level. For example, the Rhythm Section group in our example might be for mixing only, whereas the Percussion and Drum Kit groups might be mixing and editing.

Temporary track groups
To temporarily group any currently selected tracks (that aren’t already members of an active group), hold down the T key. Or double-tap the T key to make the temporary group “stick” until you tap or tap the T key again.

You can temporarily group all currently visible tracks in the Sequence Editor (or other multitrack editor) using the W key in the same fashion as described above.

Temporarily suspending track groups
To temporarily suspend a track group, press Command-Option-G (Mac) or Ctrl-Alt-G (Windows). Then type in the number of the group (in the order in which it appears in the Track Group window list). Or click the box next to its name in the Track Groups window. The track group name is displayed in italic text when it is temporarily suspended.
To temporarily suspend track groups globally, choose *Project menu>Modify Track Groups>Suspend Track Grouping*, or press Command-Option-Control-G (Mac) or Ctrl-Alt-G (Windows). To do so even more temporarily, hold down the G key. Doing so temporarily toggles the current suspension state.

**Temporarily overriding the group on the fly**
To temporarily override a group when moving a fader, Option/Alt-drag it. This allows you to adjust a track’s level relative to the rest of the group.

**Deleting tracks that belong to a track group**
If you delete one or more tracks that are the sole remaining tracks in a track group, the track group is also discarded.

---

**Track group keyboard shortcuts**
Track grouping has its own set of fully customizable keyboard shortcuts in the Commands window (Setup menu):

<table>
<thead>
<tr>
<th>Command</th>
<th>Default keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Track Group</td>
<td>Command/Ctrl-Shift-G</td>
</tr>
<tr>
<td>Ungroup Tracks</td>
<td>Command-Control-G</td>
</tr>
<tr>
<td></td>
<td>Ctrl-Win-G</td>
</tr>
<tr>
<td>Temporarily Grouping</td>
<td>T</td>
</tr>
<tr>
<td>Temporarily Grouping</td>
<td>W</td>
</tr>
<tr>
<td>Visible Tracks</td>
<td></td>
</tr>
<tr>
<td>Track Group Enable…</td>
<td>Command-Option-G</td>
</tr>
<tr>
<td></td>
<td>Ctrl-Alt-G</td>
</tr>
<tr>
<td>Suspend Track Grouping</td>
<td>Command-Option-Control-G</td>
</tr>
<tr>
<td></td>
<td>Ctrl-Alt-Win-G</td>
</tr>
<tr>
<td>Temporarily Toggle Track Grouping</td>
<td>G</td>
</tr>
<tr>
<td>Add Selection to Group</td>
<td>none</td>
</tr>
<tr>
<td>Remove Tracks from Group</td>
<td>none</td>
</tr>
<tr>
<td>Delete Track Group</td>
<td>none</td>
</tr>
<tr>
<td>Set Temporary Group Type to Edit</td>
<td>none</td>
</tr>
<tr>
<td>Set Temporary Group Type to Mix</td>
<td>none</td>
</tr>
<tr>
<td>Set Temporary Group Type to Edit &amp; Mix</td>
<td>none</td>
</tr>
<tr>
<td>Set Temporary Group Type to Custom Type</td>
<td>none</td>
</tr>
</tbody>
</table>
Part 4
Project Basics
CHAPTER 15  The Performer Lite Project

OVERVIEW
This chapter reviews basic procedures for handling Performer Lite projects. Most are standard File menu procedures; however, Performer Lite is in some ways unique in how it manages projects and their many associated files.

Overview ............................................................. 79
Components of a Performer Lite Project ................. 79
Creating a new project ........................................ 80
Creating a new project from a template ................. 80
Opening an existing project ................................. 81
Open Recent sub-menu ....................................... 81
Saving a project ................................................. 81
Saving a project file under a different name .......... 81
Save a Copy As .................................................. 82
Using Save a Copy As for incremental backups .... 82
Autosave ............................................................ 82
Collecting a project for backup or transfer .......... 82
Avoiding disaster ............................................... 83
Exporting a project ............................................ 83
Moving a project between Mac and Windows ...... 83
Exporting to notation software through MusicXML .. 83
Reverting to a previously saved project ............ 83
Adding project notes ......................................... 83
Printing project windows .................................. 83
Closing a project ............................................... 85
Quitting/Exiting Performer Lite ......................... 85
Helpful project and disk hints .............................. 85

COMPONENTS OF A PERFORMER LITE PROJECT
A typical Performer Lite project consists of the following components:

Figure 15-1: The components of an example Performer Lite project.

The Project Folder
When you first create a new project, Performer Lite makes a project folder in which it places your new Performer Lite project file. In addition, several additional folders, described below, are created to store files that Performer Lite may generate as you work on the project.

Audio Files folder
An audio file is a document on your computer’s hard disk that contains digital audio data. (For further explanation, see chapter 68, “Hard Disk Recording Concepts” (page 570)). As you record, Performer Lite places newly generated audio files into the Audio Folder. Audio files are not required to be in this folder. A Performer Lite project can use audio files located on any available hard drive. Performer Lite keeps track of them, even if you
move them on the computer desktop. The Audio Files folder is primarily intended as a default location for new files that you record in the project.

**Audio Cache folder**
At times, Performer Lite may make temporary audio files for various tasks it is called upon to do. These files are stored temporarily in the Audio Cache folder.

**Autosaves folder**
Performer Lite has the ability to autosave your documents. When doing so, it stores autosaved files in this folder. See “Autosave” on page 82.

**Bounces folder**
The Bounces folder is the default location for audio files created by Performer Lite’s Bounce to Disk feature. See “Bouncing to Disk” on page 536.

**Analysis Files folder**
A Performer Lite project folder may also include an Analysis Files folder; Performer Lite generates analysis files for each audio file being used in the project. Analysis files greatly reduce the amount of time it takes Performer Lite to apply time stretching and pitch-shifting to the audio files. Performer Lite handles analysis files automatically, so you never need to be concerned with them. For further details, see “Audio file analysis” on page 515.

**Plug-in Data folder**
This folder may be created automatically as needed by some of Performer Lite’s included plug-ins. For more information, see chapter 1, “Audio Effects Plug-ins” (page 7) and chapter 2, “Instrument Plug-ins” (page 55) in the **DP Plug-in Guide**.

**Undo folder**
This folder is created automatically as needed when an operation gets rid of an audio file.

For further details, see “Undo” on page 337.

**CREATING A NEW PROJECT**
To create a new project:

1. Launch Performer Lite (if it is not already running).
2. Choose *File menu* > *New*.

You’ll now see a standard Save dialog.

3. Navigate to the hard drive and folder where you’d like to save the new project.
4. Click Save.

**CREATING A NEW PROJECT FROM A TEMPLATE**
Performer Lite provides many useful file templates to get you going quickly. These files have tracks already set up with virtual instruments ready to play and record, such as piano, bass, guitar, drums and more, depending on the template. They also include tracks already prepared for recording vocals, guitar and other instruments.

To create a new project based on one of these template files, close the currently open file, if any. You should then see the *Welcome to Performer Lite* window. If not, choose it from the Help menu. Choose the desired template from the menu at the top of the window and click the *New* button.
OPENING AN EXISTING PROJECT
Here are several ways to open a Performer Lite project:

<table>
<thead>
<tr>
<th>Action</th>
<th>What happens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double-click the project file icon.</td>
<td>Launches Performer Lite (if it’s not already running) and opens the project.</td>
</tr>
<tr>
<td>Choose Open from Performer Lite’s file menu.</td>
<td>A standard open dialog appears, from which you can select the project you wish to open. If an unsaved project is open at the time you do this, you’ll be asked if you wish to save the changes before the newly chosen project is opened.</td>
</tr>
<tr>
<td>(Mac only) Drag and drop a project file onto the Performer Lite application icon.</td>
<td>Launches Performer Lite (if it’s not already running) and opens the project.</td>
</tr>
</tbody>
</table>

Only one Performer Lite project can be open at a time.

OPEN RECENT SUB-MENU
For convenient access, the Open Recent sub-menu in the File menu displays the most recent Performer Lite projects you have opened, so you have quick access to them.

To clear the list of recent files, choose Clear Menu.

SAVING A PROJECT
When you choose Save from the File menu, Performer Lite writes the changes you have made into the original project file on the disk. If you do not save, the changes you have made are never written to the disk. For example, if you quit without saving changes, the work you have done is not saved on the disk and is permanently deleted from the computer’s memory.

This is why you should save frequently. If Performer Lite or your computer should malfunction, all of the work you have accomplished since you last saved may be lost! (See “Avoiding disaster” on page 83.) However, if the project was recently saved, you can retrieve the latest version from the disk and proceed without having lost much work.

To save a project:

1. Choose Save from Performer Lite’s File menu.

Your project is saved on disk in its current state, replacing the old version with the same name. If you want to keep the old version, use the Save As command on the File menu (see below) instead to save the current version under a different name.

2. Type in the name of your file.

You can’t use a colon in the name; all other characters are permitted, including spaces. If you enter a name that is already in use, a dialog box will ask you to confirm your choice.

3. Click Save.

SAVING A PROJECT FILE UNDER A DIFFERENT NAME
To preserve the last-saved version of the project and save the current state of the project under a different name:

1. Choose Save As from Performer Lite’s File menu.

The Save As dialog appears.

2. Choose the desired location for the new project file and type in the new name for the project, if desired.

3. Click Save.

Your project is saved on the disk in its current state under the new name. In addition, the project you currently see on your computer screen is the newly created project.

SAVE A COPY AS
The Save a Copy As command works exactly the same way as the Save As command described above, except for the very last sentence. When you’ve completed the Save a Copy As operation,
the project you see on your computer screen is not the newly created project; instead, it’s the original project that you were saving from. In addition, it may still be in an unsaved state (if you haven’t saved it since making any changes).

**USING SAVE A COPY AS FOR INCREMENTAL BACKUPS**

The *Save a Copy As* feature as described above is great for making incremental backups of your project file. To do so:

1. Every 15 minutes (or as often as you can bear), choose *Save A Copy As*.
2. Type in new name for the backup file.
   For example, you might adopt a numbering convention, such as MyProject.1, MyProject.2, etc.
3. Click Save.
4. Continue working on your current project file, which is still on screen.

By choosing *Save a Copy As* every 15 minutes or so and incrementing the number, you have a separate copy of your project file that is never more than around 15 minutes old. This means that if the most current project file is damaged or corrupted somehow, you’ve never lost more than 15 minutes of work. You can also automate this process using Autosave (below).

**AUTOSAVE**

If the Autosave preference is enabled, Performer Lite will save automatically, according to your preferred settings. You can either save, or save a copy as for automatic incremental backups. See “Autosave” on page 229.

**COLLECTING A PROJECT FOR BACKUP OR TRANSFER**

The *Save As* commands described in the last two sections only save the project file under a different name. The rest of the files related to the project (audio files and analysis files) are not included in the *Save As* operation.

There may be times, however, when you need to use the *Save As* operation with the entire project, including all related audio files and analysis files.

There is an option in the *Save As* and *Save a Copy As* windows called *Duplicate audio data and copy shared samples to project*. When checked, this option makes Performer Lite create an entire duplicate set of all the audio files being used by the current project. Also included are all of the analysis files, if any. This command will “collect” all audio files that are being used, even if they are scattered across several hard drives.

**Figure 15-2:** The ‘Duplicate audio data and copy shared samples to project’ option makes a copy of the entire project folder.

The *Duplicate audio data and copy shared samples to project* option is ideal for backing up Performer Lite projects, as well as transferring them to clients or collaborators, because it ensures that all associated audio files, analysis files, and shared samples are included.
**AVOIDING DISASTER**
Performer Lite project files often represent many hours of hard work. If something bad should happen to the file, and it’s your only copy, you’ve lost all that hard work forever. So please follow these guidelines and make them habit:

- Save early and save often
- Make incremental backups with **Save As**
- Backup early and backup often

For details about incremental backups, see “Using Save a Copy As for incremental backups” on page 82.

**EXPORTING A PROJECT**
Performer Lite can export a project to a variety of industry standard interchange formats. Choose the desired Format menu in the Save As dialog, as shown in Figure 15-2 on page 82.

**MOVING A PROJECT BETWEEN MAC AND WINDOWS**
Performer Lite runs on macOS and Windows. You can move Performer Lite projects between Mac and PC computers. Remember, however, that Audio Unit plug-ins and virtual instruments are Mac-only, so if they are used in a Performer Lite project on your Mac, they will not be available when you open the project in Performer Lite running under Windows.

All plug-ins and instruments included with Performer Lite will transfer across platforms just fine. The same is true for any VST plug-ins or instruments, as long as they are installed in both your Mac and PC systems. Check with the plug-in developer for information regarding any differences that may exist between their Mac and Windows VSTs.

**EXPORTING TO NOTATION SOFTWARE THROUGH MUSICXML**
Performer Lite can export a notation score as a MusicXML file for import into notation programs such as Finale™ and Sibelius™. See “Exporting a musicXML file” on page 153.

**REVERTING TO A PREVIOUSLY SAVED PROJECT**
If you’ve made unwanted changes to a project, you can undo the changes you’ve made by returning to the last saved version. This operation is identical to closing the project without saving and opening it again.

1. Choose **Revert to Saved** from the File menu.

A dialog box asks you to confirm this choice.

2. Click on OK to confirm the action, Cancel to withdraw it.

Reverting to the last saved version of the project means that all changes you’ve made since you opened or last saved the project will be lost.

Reverting to a previously saved version is useful when experimenting with a project. You can quickly discard all changes by using this command. Make sure that you save the file in the state you want it before beginning to experiment.

**ADDING PROJECT NOTES**
Click the Project Notes button (Figure 7-2 on page 40) to open the Project Notes cell in the right-hand sidebar (Figure 7-3 on page 40). This is a simple text editor that allows you to type in notes about your project and store them within the project itself.

**PRINTING PROJECT WINDOWS**
You can print the contents of some Performer Lite windows. This includes list windows, such as the Set List and Soundbite List, and Notation Editor.
Printing the contents of a list window
To print the listed contents of a sidebar cell:

1. Click the cell to make it the active cell.

2. Choose Page Setup from the File menu, make any desired changes to the page settings, and click OK to confirm the settings.

The options that appear in this dialog box depend on the type of printer you are using. For example, if you are printing on a laser printer, you can choose an enlargement or reduction above or below 100%.

3. Choose Print Window from the File menu.

The standard print setup dialog box appears for your printer.

4. Set up the printer options as needed, such as the number of copies, and click OK.

The entire contents of the list is printed.

Printing notation
Printing notation in Performer Lite is easy. Performer Lite transcribes unquantized or quantized MIDI data in a readable fashion. You can format the music on screen exactly as it will print, including text, page margins, staff spacing, measure spacing, and more.

To print notation:

1. Choose Page Setup from the File menu, choose the desired page size, make any desired changes to the page settings, and click OK to confirm the settings.

The options that appear in this dialog box depend on the type of printer you are using. For example, if you are printing on a laser printer, you can choose an enlargement or reduction above or below 100%.

2. Open the Notation Editor.

A window appears containing staves for the MIDI track or tracks you have selected. This window displays the music on a page exactly as it will print out. For information about editing music and formatting it in this window, see chapter chapter 18, “Notation Editor” (page 116).

3. Use the track selector to show the tracks that you would like to print (and/or hide the ones you don’t).

4. Use the Notation Editor setting menu and Page Setup commands to format the music on the page as desired.

Summarized below, these menu commands are discussed in detail in chapter chapter 18, “Notation Editor” (page 116).

<table>
<thead>
<tr>
<th>Formatting command</th>
<th>Brief description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Score Options</td>
<td>Provides control for title page, staff names, measure numbering and spacing, and staff spacing.</td>
</tr>
<tr>
<td>Page Margins (Mini-menu)</td>
<td>Lets you adjust top, bottom, left, and right page margins.</td>
</tr>
</tbody>
</table>

5. Add text and musical symbols as desired with the text and symbol tools in the Tools palettes.

See “Working with text” on page 138 for more information.

6. Choose Print from the File menu.

The standard print setup dialog box appears for your printer.

7. Set up the printer options as needed, such as the number of copies desired, and click Print.

Performer Lite proceeds to print the document, providing you with a status window as it does.
CLOSING A PROJECT
To close a project, choose Close ‘Project Name’ from the File menu.

Closing a project without saving
If new audio files have been created in an unsaved project, and you don’t save the project before closing, Performer Lite will alert you to the fact that there are unsaved audio files on disk:

Figure 15-3: If you close an unsaved project, Performer Lite warns you about audio files that were created in the unsaved project and lets you either keep them or discard them.

The alert dialog shown above in Figure 15-3 lets you choose whether you want to delete them or not.

QUITTING/EXITING PERFORMER LITE
Quitting or Exiting Performer Lite returns you to the computer desktop. On the Mac, choose Quit from the Performer Lite menu. On Windows, choose Exit from the File menu.

As when closing a project with unsaved changes, if you quit Performer Lite without saving your project a dialog box may appear asking you if you want to save changes made to the file. To save the changes, press Yes. If you don’t want to save changes, press No. To withdraw the Quit command and return to your Performer Lite file, press Cancel.

HELPFUL PROJECT AND DISK HINTS
File menu commands (except Save) cannot be used during playback. To use a command in the File menu, press the Stop button beforehand.

Save your file as often as possible. You should use the Save command after every significant change to your project. Consider using Autosave.

Always keep backup copies of your important projects. We cannot emphasize enough the importance of this. At the end of a working session, copy to a backup disk all of the files you recorded and edited. (The Save A Copy As command is good for this, together with the Duplicate Audio Data option.) If anything should happen to your original, you will have fully updated backup of the file.

Using the Save A Copy As command while working can be useful when you want to keep a record of earlier versions. You can also use Autosave for this purpose.

Be sure to backup your projects as often as is bearable, at least at the end of every working session and several times during the session if possible. The consequences of not making backups are severe: if your hard disk is damaged, some or all of the projects may be lost forever.
Using the Mac OS stationery feature (Mac only)
Performer Lite supports the Mac OS “Stationery pad” feature in the Get Info window for a project file as shown below:

![Figure 15-4: Stationery pad option in the Get Info window.](image)

When this option is checked, the project file can be opened, but the Finder will prevent you from modifying the original file by forcing you to Save As when you attempt to save the project. This option is great for preserving projects that you do not want to modify and that you use regularly as a “template” from which to build other files. For more information about the Stationery pad option, consult your Mac OS help.
CHAPTER 16  Control Panel

OVERVIEW
Performer Lite’s Control Panel (Figure 16-1) appears across the top of the Performer Lite Window and contains all the functions that make Performer Lite “go”: buttons to record, play, rewind, set tempo, and more. The Transport controls look and act just like standard transport controls. Additional buttons provide immediate access to many of Performer Lite’s significant features.

TRANSPORT CONTROLS
The Transport Controls (Figure 16-1) are the buttons that make Performer Lite “go”: with them you can record, play, rewind and more. The Transport Controls are enabled by clicking them. When a button is enabled, it is highlighted and its function is active: the Record button records, the Pause button pauses, etc. Most buttons can be disabled by clicking a second time. To disable the Play and Record buttons, press the Stop button.

The Play button and playback
Clicking the Play button starts playback. Playback will begin from the current time specified in the Counter. Playback can be delayed by the Countoff button and held by the Pause button. The Play button turns green while the sequence is playing.

If you start playback in the middle of a sequence, and you do not hear exactly what you expect, check Performer Lite’s event chasing settings. for details, see “Event Chasing” on page 247.

Figure 16-2: Left sidebar buttons.

Figure 16-1: Performer Lite’s Control Panel.

Overview .............................. 87
Transport Controls ......................... 87
Counter ....................................... 88
Tempo Controls .................................. 92
Transport settings .......................... 94
Overdub ........................................ 94
Countoff ....................................... 95
Countoff preferences ...................... 95
Click ............................................ 96
Click Preferences .......................... 96
Memory Cycle .............................. 98
Auto-Record .................................. 99
Solo ........................................... 100
Primary and alternate tools ............. 100
Keypad shortcuts .......................... 100
During playback, most Performer Lite features remain accessible, including the Save command and all editing commands. As a general rule, commands that cannot be used will either appear greyed out during playback or they will have no effect.

**The Stop button**
Clicking the Stop button stops playback and recording. It also turns off the Pause button. All notes sounding when the Stop button is clicked will cease (unlike pause).

**The Record button and recording**
Clicking the Record button turns it on and begins recording from the current location in the counter. When it is on, the Record button is red and can be turned off by clicking it again. This disables the record function while continuing playback. You can also turn on and off the record button during playback for manual punch-in and punch-out, as many times as you like. A more general way to think of the Record button is as an on/off toggle switch that you control manually.

At least one track must be record-enabled before the record button is pressed. This is done by clicking the record-enable button for the desired track (or tracks). Record-enabling a track makes it the destination for incoming recorded data.

Also see “Auto-Record” on page 99 and “Overdub” on page 94.

**Undo Record**
Recording can be undone at any time with Performer Lite’s unlimited undo features. For details, see “Undo” on page 337.

**Fast Forward & Rewind**
The Fast Forward/Rewind buttons skip or scrub through your sequence quickly, forward or backwards. The right set of arrows cues forward in time, the left set cues backwards. Use the

Transport preferences (in the File menu under macOS and the Edit menu under Windows) to choose whether cuing occurs smoothly and continuously or in fixed increments of your choosing. For example, you could program the forward/rewind buttons to cue by one measure at a time or by four measures at a time. See “Fast Forward/Rewind buttons” on page 232.

When cuing continuously, the left arrows cause playback to pause while cuing backwards until the arrow is released. If used during recording, the Record button will be turned off before cuing.

**COUNTER**
The Counter (Figure 16-1) displays the current playback position in the currently play-enabled sequence, expressed in different forms: measure time (measure|beat|tick), real time (hours:minutes:seconds.hundredths), frame time (hours:minutes:seconds:frames), samples (digital audio samples), or markers (the most recent marker in the sequence).

For information the marker counter, see “Marker counter” on page 90.

**Using the Counter to change the current playback location**
The current playback location is the position where the sequence will next play or record from. You can edit the counter fields to change the current location.

You can change the current location in the currently play-enabled sequence by editing the counter numbers. This can be done while the sequence is stopped or playing. If you edit the counter while the sequence is playing, it will continue to play while you enter the values and will cue to the new location after you confirm your edit. To edit the counter:

1. Click on the time value you wish to change.
The number field will highlight.

2 Enter the number you want.

Use the Tab key to move from one value field to the next. The decimal point on the keypad can also be used to cycle through fields. (On Windows, make sure the Num Lock key is engaged to use keypad shortcuts.) If you make a mistake in entering a value, press the delete key or click on the field again and re-enter the value.

3 Click outside the highlighted number field or hit the Return key.

Using the decimal key or Command/Ctrl-T to edit SMPTE main counter
The decimal key on the numeric keypad (with Num Lock engaged under Windows) will highlight the main counter, even if it is SMPTE time, real time or samples.

There is a shortcut for setting the measure time: using Command/Ctrl-T or the decimal point on the keypad will select the measure field and set the beat field to 1 and the tick field to 000. You may then enter the number of the measure you want to move to. As soon as you click outside the highlighted field or press the Return key, the specified value will be entered.

These keys will always edit the main counter, even when it is set to SMPTE time, real time or samples.

Setting the counter time format
To change which time format is shown in the Counter, click the Time Format menu to the right of the counter.

Figure 16-3: Use the Time Format menus to choose which of Performer Lite’s various time formats you would like to display in the counter.

The counter displays dashes when no sequence is play-enabled in the file. To display numbers, play-enable a sequence in the Set List.

During playback, the measure time counter is updated each time a metronome click would occur. If the click value is set to a half note in 4/4 time, only beats 1 and 3 will display in each measure. The click value can be set with the Change Meter command in the Conductor Track sub-menu in the Project menu.

Playback dashes
If you would like for the last field of the counter to be displayed as dashes, instead of numbers quickly rolling by, enable the Playback Dashes option. You can set this independently for each counter.

Round on Entry
By default, the Round on Entry option (Figure 16-3) is enabled and edits to larger time fields will clear smaller time fields. When the Round on Entry is disabled, smaller time fields are preserved when editing larger fields.

For example, locate to 3|2|017, then select the counter’s measures field and drag it upward. With Round on Entry enabled, the counter value will become 4|1|000, 5|1|000, 6|1|000, etc.; with Round on Entry disabled, the counter value will become 4|2|017, 5|2|017, 6|2|017, etc.
**Marker counter**

The *Markers* time format displays the most recent marker in the sequence.

The Markers counter can also be used to move the main transport to a marker location. Clicking the marker name makes the field editable and displays a menu; choose the highlighted marker by clicking it, or by pressing the Return or Enter keys.

You can also type in the text field. As you type, the drop-down menu will narrow the list to show only the markers containing the characters that you’ve typed. In the example shown in Figure 16-4, typing “ver” would narrow the list to Verse 1 and Verse 2, while typing “2” would narrow the list to Verse 2. The Up Arrow and Down Arrow keys can be used to navigate the list.

For more information about markers, see chapter 47, “Markers” (page 425).

**Setting the start time**

The start time of the sequence is what you see in the counter when you rewind to the very beginning. Normally, the default start time for a sequence is measure time 1|1|000, real time 0:00:00.00 and frame time 0:00:00:00.

You can, however, use the *Set Sequence Start Time* command under the Settings menu for the Set List (“The Set List menu” on page 210) to change the start time. For example, you might want to create one or more pickup measures before measure 1 (1|1|000).

The start times you enter for measure and real time are arbitrary and only affect the display of time locations.

To set the start times of a sequence:

1. If you have more than one sequence in the file, make sure it is the currently play-enabled sequence in the Set List. Otherwise, click the Set List cell so that it becomes the active cell.

2. Click the Settings menu and choose *Set Sequence Start Time*.

3. A dialog box appears. The current sequence name is displayed near the top of the dialog box.

   ![Figure 16-5: The Set Sequence Start dialog lets you choose completely different start times for each of Performer Lite’s various time formats. This is where you determine the sequence’s SMPTE start time (offset).](image)

4. Click on the values you wish to change.

5. Enter the new values.
You may enter a value for each of the various time formats. Measure values range from -9999 to 9999. Real time ranges from 0:00.00 to 59:59.99. Frame time ranges from 0:00:00:00 to 23:59:59:30.

6 Click on OK to confirm your choice or Cancel to cancel it.

**Using SMPTE timecode bits**

In addition to the start frame, you may offset the SMPTE start time by a number of bits. There are 80 bits per frame. Although Performer Lite does not have single bit time resolution, it does offer sub-frame time resolution. Use the bit offset to finely adjust the start time.

**Setting the SMPTE frame rate**

The SMPTE frame rate can be set with Frame Rate command in the Setup menu.

**Creating pickup measures before 1|1|000**

Normally, when you rewind Performer Lite back to the beginning of the sequence, the measure counter reads 1|1|000. But sometimes you may have several pickup beats (or measures) in your music, and you may still want the music at measure 1 to remain at measure 1. If so, you can create as many pickup measures before 1|1|000 as you need.

To create a pickup measure:

1 As described in the previous section, set the measure start time of the sequence to 0 to create 1 pickup measure.

If you need two pickup measures, set the Measure start time to -1. If you need 4 measures, set it to -3.

2 Now, when you press Rewind back to the beginning of the sequence, the Counter window will read 0|1|000.

If you set up two or four pickup measures instead of only one, the counter would read -1|1|000 or -3|1|000 respectively.

3 If you already had data recorded in the sequence, shift the data back to its original location.

When you change the Measure start time, data that used to be at 1|1|000 is now at 0|1|000, and so on. All data has changed to match the new start time. To restore all data to its original position before you changed the start time, copy and paste it back to where it was before.

4 Choose Edit menu > Select All.

This selects the entire sequence.

5 Choose Cut from the Edit menu.

6 Set the Counter to 1|1|000.

7 Choose Edit menu > Paste.

You have now successfully restored all data back to its original location before changing the measure start time, and you also have several empty pickup measures in which to record.

**Controlling how often the counter updates**

During playback, the measure time counter is updated each time a metronome click would occur. For example, if the click value of the current meter in the sequence is set to a half note in 4/4 time, only beats 1 and 3 will display in each measure. The click value can be set with the Change Meter command in the Conductor Track sub-menu in the Project menu.

**Negative numbers in the counter display**

When using an external sync source, Performer Lite may run for a little while before the sequence actually starts. During this time, you may see
negative measure numbers. These increase in value (towards zero) until the start measure is reached.

**TEMPO CONTROLS**
The Control Panel displays the tempo and meter of your sequence.

![Figure 16-6: Performer Lite’s Tempo Controls give you real time control of the tempo, as well as tempo programming (via the Conductor Track) and remote control of tempos from any MIDI source, such as the mod wheel on your controller keyboard.]

The current tempo
By default, tempos are displayed in beats per minute (bpm). To change the tempo, click the current tempo directly to type in a new tempo (Figure 16-6). If necessary, click the current beat value to change it (see below).

Tempos are displayed and entered with an accuracy of a hundredth of a beat per minute. This allows you to specify tempos with two numbers to the right of the decimal point, e.g. 104.78 beats per minute, providing you with a high degree of resolution.

The beat value
The beat value (Figure 16-6) is the note duration that “gets the beat” in a given meter. Click it to change it.

The beat value can be any standard musical duration between a sixteenth and whole note. All beat values can be dotted. A dotted value is equivalent to one and a half times the value of the duration. (A dotted quarter note is equivalent to one and a half quarter notes, for example.) In 4/4 time, the quarter note usually gets the beat: in this case, the beat value is a quarter note. In 6/8, the beat generally falls on the first and fourth eighth notes in the measure, thus the dotted quarter is the beat value.

The beat value you set does not necessarily correspond to the value you set for the metronome click. The metronome click value is set when specifying the meter with the Change Meter command in the Conductor Track sub-menu in the Project menu. For example, in 6/8 meter, you may set a tempo of an eighth note = 220, but, set the metronome click to a dotted quarter note (standard in 6/8 time). Quite often though, the beat value will be the same as the meter denominator (the lower number of the meter marking).

The current meter
The meter at the current counter location is displayed for your reference (Figure 16-6). To change meter, use the Change Meter command (Project menu > Conductor Track > Change Meter).

The Tempo Control menu
Tempo can be controlled by one of five possible sources:

- The Current Tempo setting
- The Conductor track
- The Tap Pad
- By remote control from an external MIDI controller, such as a modulation wheel
- The back slash key (Tap to Enter Tempo command)
The Tempo Control menu (Figure 16-6 on page 92) displays the current tempo source with a check mark; choose any other source from the menu to change it. You can change the tempo source at any time, even during playback, and the tempos you set in each mode are remembered. In addition, the tempo control settings are saved with each sequence.

**Tempo slider**
When the Tempo Control is set to Tempo Slider, you can change tempo by entering a value in the tempo box. Tempo is expressed in beats per minute (bpm). Any programmed tempo changes (the tempo map) are ignored. You control the tempo directly with the tempo box. This mode is useful for sequences with one constant tempo or for temporarily adjusting tempos when working on a sequence.

**Conductor Track**
When the Tempo Control is set to Conductor Track, you cannot use the tempo box to set the tempo. Instead, the tempo map in the Conductor track takes control of the sequence. In this mode, the tempo box is merely an indicator of the current tempo; you cannot change the tempo or beat value directly.

To hear tempo changes that you create with the Change Tempo command or by using Tap tempo sync, set the Tempo Control to Conductor Track, where programmed tempo changes and tempo maps are stored. See chapter 46, “Conductor Track” (page 418).

**Remote control of the tempo**
When the Tempo Control is set to Remote Control, the tempo slider can be controlled from an external MIDI source such as a modulation wheel on a MIDI keyboard, or any other source of continuous controller data.

To set up the Tempo slider for external MIDI control:

1. Choose Remote Control from the Tempo Control menu.
2. Choose Set Remote Source from the Tempo Control menu.

A dialog box appears.

![Remote Tempo Source](image)

Figure 16-7: The Set Remote Source feature allows you to control Performer Lite's tempo dynamically, during playback or recording, with an external MIDI source, such as the mod wheel on a keyboard.

3. Select the MIDI device from which the external control data will be received from the menu provided.

4. Select which type of MIDI data will be used to control the slider.

Modulation wheels send controller #1.

5. Click OK to confirm your choice or Cancel to withdraw the command.
Tap to Enter Tempo
The Tap to Enter Tempo command in the Commands window (Setup menu) allows you to tap a tempo setting from your computer keyboard (or a MIDI trigger event):

![Commands window with Tap to Enter Tempo command](image)

Figure 16-8: To locate and customize the Tap to Enter Tempo command, search on the word 'tap', and then enter the desired computer keyboard and/or MIDI event.

When the Project’s Tempo control is set to Tempo slider (Figure 16-6 on page 92), you can change the tempo of the entire project (as displayed in the Control Panel) by simply tapping the back slash key (or your customized keyboard shortcut or MIDI controller event for the Tap to Enter Tempo command). The BPM text box will highlight to indicate that it is being modified by your taps. When you achieve the tempo you want, press the return key to confirm the change. If you attempt to do this while the sequence is playing back, Performer Lite will not closely track your tapping, like it does for the Tap Tempo Receive Sync mode (Setup menu), so you will probably find it most useful to use Tap to Enter Tempo while the sequence is stopped. If you would like Performer Lite to track your tapping during playback, use the Receive Sync Tap Tempo mode (see “Tap Tempo” on page 560).

Canceling tempo entry
If you begin to tap in a tempo, but then change your mind, press the escape key (esc) to exit the tempo text box without making a change to it.

TRANSPORT SETTINGS
The transport settings provide additional functionality to Performer Lite’s transport controls.

![Transport settings](image)

Figure 16-9: Transport settings.

OVERDUB
If you click the Overdub button (Figure 16-9), Performer Lite goes into Overdub record mode. Overdub mode causes all recorded MIDI notes to merge with,
instead of replace, pre-existing notes on the record-selected track. The pre-existing notes on the track are not erased. For audio data, new data is overlaid on top of existing data, rather than erasing and replacing existing data.

For MIDI tracks, the word *overdub* is used in a very specific sense in Performer Lite: real-time merging of incoming notes with note data already in a track. It works as if you recorded one track, recorded a second track to go along with it and then merged the two. You can use Overdub mode in conjunction with Memory Cycle to build patterns in multiple passes over a time range, similar to drum machines. (Overdub does not affect the Conductor Track; specifically, recording on the Conductor Track while slaved to Tap tempo sync always erases existing tempo events.)

For further information, see “MIDI overdub recording” on page 262 and “Audio overdub recording” on page 263.

**COUNTOFF**

Enabling the Countoff (Figure 16-9) causes a countoff of a specified number of measures and/or beats before playback or recording. Clicking the Countoff button enables and highlights it. You must enable the Click (Figure 16-9) to hear the countoff.

To set the number of countoff measures and/or beats, double-click the Countoff button. The Countoff preferences will open, where you can enter the number of measures and beats. Several other options are also provided. See “Countoff preferences” below.

If you choose a countoff that is not simply a whole number of measures, the Countoff button in the Control Panel displays the number of beats in the countoff that you have chosen. For example, the countoff button displays 2 Bars if you have chosen 2 measures and 0 beats. But it displays 9 Beats if you have chosen 2 measures and 1 beat (in 4/4 time).

Use the Countoff to give yourself time to adjust to the current tempo and prepare for recording.

**The counter runs during countoff**
The counter updates during the countoff. For example, if you have a two-measure countoff, and you begin playback at 1|1|000, then the counter begins the countoff at -1|1|000 and counts the two measures leading up to 1|1|000. If you begin playback at 9|1|000, the counter starts at 7|1|000 and counts the two measures leading up to 9|1|000.

**The movie window and countoff**
The movie window runs during countoff. This allows you to see what is happening in the movie during the countoff so that you can better prepare for the downbeat when the countoff is over.

**COUNTOFF PREFERENCES**

To access the Countoff preferences, double-click the Countoff button (Figure 16-9). You can also choose *Preferences* from the Performer Lite menu (macOS) or Edit menu (Windows) and click the Countoff list entry (Figure 16-10).

Figure 16-10: Countoff preferences.
Specifying an audio click during the countoff

The Click option (Figure 16-10) lets you hear an audio click during the countoff. Use the menu to choose the type of audible click you would like to hear. The choices are Follow Conductor, Default for Meter, and Beat Value.

Follow Conductor

The Follow Conductor option causes the Countoff click to follow the Conductor track’s click mode for the bars during which the click will be occurring.

Beat Value

The beat value option clicks according to the current meter’s beat value. See “Change meter basics” on page 443 for an explanation of what a meter’s beat value is.

Default for Meter

The default click is similar to the beat value click, except that the click follows the generally accepted click conventions for various meters and tempos. For example, in 12/8 time, the default click clicks on dotted quarter notes at fast tempos and eighth notes at slow tempos.

Countoff length

The length of the countoff (Figure 16-10) can be specified in a number of whole measures and/or individual beats using the Countoff n measures and y beats setting. Accordingly, the Countoff button in the Control Panel (“Countoff” on page 95) displays the number of beats in the countoff, if you have chosen a countoff that is not a whole number of measures. For example, the countoff button displays 2 Bars if you have chosen 2 measures and 0 beats, and it displays 9 Beats if you have chosen 2 measures and 1 beat (in 4/4 time).

Countoff only when recording

The Countoff only when recording option causes the countoff to occur only before recording, not before playback or any other function.

Countoff at Auto-Record Start Time

The Countoff at Auto-Record Start Time option causes the countoff to start the appropriate number of bars before punch-in when Auto-Record is enabled.

Audition Countoff

Check the Audition Countoff option to hear what the countoff will sound like.

CLICK

The Click (Figure 16-9) is the audible indication of the Metronome beat. The Click can “click” on the beat, or you can customize it to click in any pattern that you prefer. When it clicks on the beat, we refer to the click pattern as a beat click. For the beat click, the beat is determined by each meter change in the Conductor track (or the default 4/4 beat if no meter changes have been added). If the Click is on, Performer Lite will click at the beginning of every measure. The first beat of every measure is slightly accented. The subsequent clicks in the measure depend on how the metronome click value is set in the current meter. To learn more about setting meters, see chapter 49, “Change Meter” (page 443).

Enabling the click

To turn on the Click, press the Click button. You can also choose Click from the Studio menu or press Command/Ctrl-5. To turn off the click, press the Click button again (or choose it from the menu again). When the Click is on, the Click menu item will be checked.

CLICK PREFERENCES

The Click Preferences (Studio menu) provides settings for the click ( ). You can also open this dialog by Option/Alt-clicking the Click button in the Control Panel, or by opening the Preferences
from Performer Lite menu (macOS) or Edit menu (Windows) and clicking the Click list entry (Figure 16-11).

**Audio click menu**
Choose the desired audio output in your system from the **Audio Click** menu. This is where you will hear the click. A variety of preset click sounds are provided, and you can add an unlimited number of your own custom click sounds. The click plays back with sample-accurate precision.

**Accented and Normal click**
Choose the desired accented and normal click sounds from the menus provided (Figure 16-11). A variety of preset sounds are provided, including the ubiquitous Urei metronome click sound. Or you can use any compatible audio file you wish using the **Choose File** menu item.

**Audio click volume control**
Use the **Master Volume** slider (Figure 16-11) to control the overall volume of both the accented and normal clicks. Use the individual volume knobs to the right of each click sound menu to adjust their volume relative to each other.

**Adding your own click sounds**
To add your own clicks to the click sound menus, save them as a mono AIFF, or WAVE audio file, give the file the name you wish to see in the menu, and then drop it into the **Clicks** folder below. You can add as many click sounds as you wish.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>macOS</td>
<td>/Library/Application Support/MOTU/Digital Performer Lite/Clicks</td>
</tr>
<tr>
<td>Windows</td>
<td>C:\ProgramData\MOTU\Performer Lite\Clicks</td>
</tr>
</tbody>
</table>

**Playing the audio click on the computer internal speaker (Mac only)**
You can play the audio click on the computer’s internal speaker, even when you are using a third-party audio interface product general audio input and output. Just Command/Ctrl-click the **Built-in Audio** option in the Configure Hardware Driver dialog to select it (along with your third-party hardware driver), as shown in Figure 3-1 on page 20. Then choose **Built-in Audio** from the audio click’s output menu (Figure 16-11).

**Click options**
**Always click** makes the click audible whenever Performer Lite is counting off, playing or recording.

![Figure 16-11: Click preferences.](image-url)
Only during countoff makes the click audible only during countoff measures. When playback or recording begins, the click will fall silent. See “Countoff preferences” on page 95 for more information about the countoff.

Only when recording makes the click audible only when Performer Lite is in record mode. If the Countoff button is enabled, Performer Lite will also click during the countoff in this mode.

No accent removes the accent from the first click in each measure. This option affects both the audio click and the MIDI click.

Audition Click
If the Audition Click option is enabled, Performer Lite will audition the metronome sound as it is currently configured, at the current tempo.

MEMORY CYCLE
Memory Cycle (Figure 16-9 on page 94) is a cycle-playback and cycle-recording feature that causes a portion of the entire sequence to be played repeatedly until the stop button is pressed, just like drum machines and hardware sequencers. Cyclic playback begins when the sequence reaches the specified Memory Cycle time rage. When the Counter reaches the end of the cycle range, it seamlessly returns to the beginning and will continue to do so until you press the stop button, un-highlight the Memory Cycle button, or cue past the end time.

Use Memory Cycle for multiple consecutive playbacks of a particular time range. This can be very useful for cycle-recording a loop section or drum pattern, mixdowns, rehearsing a part that you plan to record, or for scrutinizing a particular section of a performance.

When cycle-recording, you add a new part to the loop with each consecutive pass. For MIDI tracks, be sure Performer Lite is in overdub record mode so that each new pass doesn’t erase the last one. For audio, you can use Memory Cycle to overdub multiple audio passes into new takes. For details, see chapter 42, “Takes and Comping” (page 387).

Figure 16-12: Playback and recording loop seamlessly between the Memory Cycle start and end markers, which you can drag with Snap to Grid turned on or off.
If you want to permanently loop a clip in one or more tracks and specify the number of times the clip will repeat, see “Looping a clip” on page 317.

Click on the Memory Cycle button to enable it. The next section discusses several ways to set the start and end times in the Memory Bar as shown in Figure 16-12.

**Controlling the Memory Cycle bar and endpoints**

When Memory Cycle is enabled, the Memory Cycle Strip displays the Memory Cycle loop as a green bar (Figure 16-12). Drag in the strip to enable Memory Cycle and set the start and end times. Drag the endpoints of the bar to change them, or drag the bar to move it. Click the bar to toggle Memory Cycle on or off.

If the edit resolution check box is checked, dragging gestures snap to the current resolution setting (such as 8th notes, for example). For an explanation of edit resolution, see “Snap to Grid” on page 331.

You can adjust the cycle points at any time, even during playback. This lets you build patterns and other tasks without ever having to stop the music.

**Selecting the Memory Cycle range for editing**

If you would like to quickly select the time range within the Memory Cycle repeat barlines to insert a loop, quantize, or any other editing operation, click one of the two repeat barlines.

**AUTO-RECORD**

Auto-Record (Figure 16-9 on page 94) causes recording to automatically turn on and off in a specific time range. This allows you to record without having to manually enable and disable the Record button.

Clicking on the Auto-Record button enables and highlights it. Clicking on the Auto-Record button also causes the Auto-Record punch in and punch out bar to appear in the Auto-Record strip (Figure 16-13). Drag in the strip to enable Auto-Record and set the punch-in and -out times. Drag the endpoints of the bar to change them, or drag the bar to move it. Click the bar to toggle Auto-Record on or off.

![Figure 16-13: Punch-in and Punch-out points are depicted graphically as a red bar in the Auto-Record strip, which you can drag with Snap to Grid turned on or off.](image-url)
If the edit resolution check box is checked, your actions snap to the current resolution setting (such as 8th notes, for example) as you drag. For an explanation of edit resolution, see “Snap to Grid” on page 331.

You can adjust the Auto-Record bar at any time, even during playback or recording. This lets you adjust punch-in and punch-out on the fly without having to stop the music.

Auto-Record will remain enabled until you click on its button again to disable it. Remember to disable it when you finish using it.

**Quickly selecting what you have recorded**

You can quickly select the time range between the punch points by clicking one of the arrows. This is a handy shortcut for editing what you have just recorded with auto-record.

**SOLO**

The Solo button toggles Solo Mode on and off. For more details on Solo Mode, see “Soloing Tracks” on page 246.

**PRIMARY AND ALTERNATE TOOLS**

Choose the desired tool from the Primary Tool menu (Figure 16-1 on page 87). The cursor will then switch to the primary tool when you hover over an edit window, or any location where the tool applies.

The Alternate Tool (Figure 16-1 on page 87) serves as a temporary alternative to the primary tool. To temporarily switch to the alternate tool, hold down the ‘x’ key. This keyboard shortcut allows you to quickly switch between the main and alternate tool, without having to visit the Tool palette (Figure 26-1 on page 220). This keyboard shortcut can be changed in the Commands window (page 234): search for the Alternate Tool shortcut.

For more information about the tools, see chapter 26, “Tools” (page 220).

**KEYPAD SHORTCUTS**

The Control Panel functions can be operated from the numeric keypad on an extended keyboard.
In addition, the spacebar acts as a play/stop toggle.
These key assignments are provided for your convenience. However, you can create your own customized key assignments using the Commands window. See chapter 28, “Commands” (page 234) for more information.
CHAPTER 17  Sequence Editor

OVERVIEW
The Sequence Editor provides a multitrack graphic environment for editing audio tracks and MIDI tracks side by side. It includes a movie track for displaying a project’s movie along the same timeline. You can view one or more tracks at a time using Performer Lite’s standard track selector to show and hide tracks as desired.

MIDI tracks are displayed with a “piano roll” style graphic note grid. Similarly, audio tracks display waveform data. MIDI continuous controller (CC) data and audio automation data are displayed and in separate edit layers. You can switch edit layers in each track independently to bring any type of data to the front for editing.

The Sequence Editor provides sample-accurate editing of MIDI and audio.

The Sequence Editor includes basic track management features, such as adding, duplicating and deleting tracks and sequences. Combined with its MIDI and audio editing features, the Sequence Editor provides “one-stop shopping” for editing and managing a Performer Lite project.

Overview .................................................. 102
Quick Reference ................................. 103
Sequence Editor menu ...................... 105
Sequence Editor basics ..................... 106
Opening the Sequence Editor .......... 106
Switching sequences .......................... 106
Sequence management ......................... 106
Track management ............................... 106
Information Bar ................................. 107
The Time Ruler .................................. 109
The Marker Strip ............................... 109
The Memory Cycle strip .................... 110
The Auto Record strip ....................... 110
Zoom buttons .................................. 110
Zooming techniques .......................... 110
Audio track settings .......................... 110
Audio editing .................................. 113
MIDI track settings ............................ 113
MIDI editing .................................. 114
Resizing tracks ................................. 114
Effect inserts panel ............................ 115
Takes .................................. 115
The movie track ................................. 115
The Conductor track ............................ 115
Figure 17-1: The Sequence Editor
**Track selector:** Click or drag over the names of the tracks in this list to show or hide them in the Sequence Editor. Option/Alt-click to hide all except the one you click; Command/Ctrl-click to show all except the one you click. Use the commands in the View menu to show/hide tracks.

**Information bar:** A configurable strip for displaying some or all of the information shown in each of the Information panels. See “Information Bar” on page 107.

**Cursor Coordinates:** Displays the mouse pointer’s current location in the unit of measurement for the currently active Edit Layer in the track (dB for audio volume, 0-127 for MIDI volume, note pitch for MIDI notes, the name of the soundbite the cursor is currently over for, etc.)

**Mixer Channel:** Displays basic mix controls for the currently selected track.

**Event Information:** Displays the currently selected soundbite, MIDI note, audio automation control point, MIDI controller, or other type of event numerically and allows you to edit the event’s parameters, such as name, velocity, and attack time.

**Time Ruler:** Measures time in any combination of Performer Lite’s various time formats. Double-click on the ruler to place the playback wiper. Drag within the ruler to make a time range selection. Shift-click in the ruler to extend or shorten the existing time range selection.

**Marker Strip:** Displays markers, meter changes, and key changes. Markers and meter changes must be edited in the Conductor track or Markers window. No MIDI or audio data appears in the Marker Strip.

**Auto Record strip:** Displays the Auto Record region as a red bar. Click and/or drag in the Auto Record strip to enable the feature and set the punch-in and punch-out times. Drag the endpoints to change them, or drag the bar to move it.

**Memory Cycle strip:** Displays the Memory Cycle loop as a green bar. Drag in the strip to enable the feature and set the start and end times. Drag the endpoints of the bar to change them, or drag the bar to move it. Click the bar to toggle Memory Cycle on or off.

**Selection Info:** Displays precise, numerical information about the current selection, if any. Double-click the “S” symbol to open the selection Info panel.

**Selection menu:** Provides several shortcuts for making selections.

**Smart Selections:** Toggles the Smart Selections feature. See “Smart Selection” on page 286.
**Edit Grid:** If the Edit Grid box is turned on, data snaps to the edit grid. If it is turned off, data doesn’t snap to grid. Edit Resolution can be changed by typing in a different number of beats/ticks, or by choosing a duration from the note menu.

**Beat Grid:** Snaps actions to the beats within the waveform. See “Snap to Beat” on page 332.

**Snap to Marker:** Snaps actions to markers. See “Snap to Markers” on page 110.

**Snap Relative:** When checked, an event moves relative to its original position, rather than snapping to the time line’s absolute grid. For example, if the grid unit is set to 120 ticks, and the original event is located at 013 ticks, it will snap to 133, 253, and 373 (which are all 13 ticks after 000, 120, 240 and 360).

**Show/hide track selector:** Opens and closes the track selector.

**Track settings panel:** Displays information and track settings. The amount of information displayed depends on the track’s current vertical size. All settings are always available in the Track settings menu.

**Track settings menu:** Contains all settings for the track. Some of these settings might also be displayed in the Track settings panel, depending on the track’s current vertical size.

**MIDI Notes:** MIDI tracks in the Sequence Editor display notes on a note grid. The note grid changes into a continuous data grid when any type of MIDI controller data is chosen as the Edit Layer for the track.

**Scrolling wiper:** Indicates the current playback location. Drag it to change it or double-click in the time ruler.

**Selected soundbite:** Soundbites can be manipulated directly (and inserted) when they are chosen as the Edit Layer for the track. Use the Pointer tool for most soundbite editing operations.

**Zoom buttons:** Reduce and enlarge the display vertically or horizontally. Click the plus sign to zoom in; click on the minus sign to zoom out. Press to zoom continuously. Zooming out gives you an overview; zooming in focuses on a shorter period of time at higher resolution. Editing can be done at any zoom level. Option/Alt-click to zoom in or out to minimum or maximum zoom level.

**SEQUENCE EDITOR MENU**

To access the Sequence Editor menu, click anywhere in the Sequence Editor to activate it and click the menu icon on the far right of the Control Panel.

![Sequence Editor Menu](image)

**Sequences:** “Sequence management” on page 106.

**Scroll To Counter:** Scrolls the editor window to the time currently displayed in the Counter.

**Scroll To:** Scrolls the editor data display to a time you specify.

**Clear default patch:** Removes the default patch assignment in the Default patch column for the currently selected MIDI tracks.

**MIDI Edit:** Allows data in the Sequence Editor to be edited from a MIDI controller.
Edit Window Preferences: Opens the preferences for edit windows.

MIDI Editing Preferences: Opens the preferences for the MIDI editing.

Continuous Data Preferences: Opens the preferences for the display of continuous data in the Sequence Editor.

Show Times: This menu item produces a submenu, from which you can choose which timestamp to display on soundbites: none, the current time, the original timestamp (if any) or the user timestamp (if any).

Edge Edit Copy: This item affects soundbite trimming (edge editing). When checked, this item causes a new soundbite to be created when you trim (edge edit) any soundbite, preserving the original. When Edge Edit Copy is unchecked, trimming a soundbite affects the original soundbite (and all instances of it in elsewhere in the project). Option/Alt-drag to override the current Edge Edit Copy setting (checked or unchecked).

SEQUENCE EDITOR BASICS
The Sequence Editor is the most comprehensive edit window in Performer Lite. It serves as a multitrack waveform editor for audio tracks, a side-by-side multitrack graphic editor for MIDI tracks, and a combined editor for both MIDI and audio tracks. There is one Sequence Editor window for each sequence. In projects with more than one sequence, you can open multiple Sequence Editors (one for each sequence).

OPENING THE SEQUENCE EDITOR
To open the Sequence Editor, click the Sequence Editor button (Figure 7-4 on page 41).

SWITCHING SEQUENCES
If your Performer Lite project has multiple sequences in the Set List (Figure 23-1 on page 209), play-enable the sequence you wish to view in the Sequence Editor.

SEQUENCE MANAGEMENT
Use the Sequences sub-menu in the Sequence Editor menu (Figure 17-4 on page 105) to view a different sequence in the Sequence Editor window, to create a new sequence, or to conduct other sequence management tasks.

TRACK MANAGEMENT
The Sequence Editor provides many features for managing both audio and MIDI tracks in the project.

The Track Selector
Performer Lite’s track selector lets you show and hide tracks (and track folders) as desired in the Sequence Editor. See “Track Selector” on page 41.

Moving tracks up or down
To move tracks up or down in the Sequence Editor, drag them by the left edge of their information panel as shown below in the Sequence Editor, or you can grab the area just to the right of its name.

Track Folders
To show or hide the contents of a folder, click its disclosure triangle. Command/Ctrl-click it to show/hide all sub-folders inside it. Option/Alt-
click to show/hide all other folders at the same level. Command/Ctrl-Option/Alt-click to show/hide all folders at all levels.

In the Sequence Editor, you can freely drag tracks in and out of folders, even empty folders, by dragging them vertically. To span multiple levels of the folder hierarchy, drag left or right as you also drag vertically. Tracks become indented when they are dragged into a folder. You can also use Performer Lite’s track color assignment features to further enhance your track folder organization.

Selecting tracks
To select tracks for the track management operations discussed in the next three sections, click or Command/Ctrl-click their names to select them.

Adding, duplicating and deleting tracks
Use the track-related menu items in the Project menu to add, duplicate, delete and otherwise manage tracks in the Sequence Editor. Select the tracks you wish to duplicate or delete. You can also select a track to add a new track just below it. Making audio track input/output assignments

The Track Assignments command in the Studio menu is a convenient shortcut for making input and output assignments to many tracks in one quick operation. Select the tracks you wish to assign and then choose the Track Assignments from the Studio menu. For further details, see “Making I/O assignments for multiple tracks” on page 61.

INFORMATION BAR
The Information Bar (Figure 17-1 on page 103) is a configurable strip at the top of the Sequence Editor (Figure 17-6). It provides convenient access to essential settings from the Information panels (chapter 38, “Information Panels” (page 330)).

Configuring the Information Bar
To configure the Information Bar, right-click anywhere on it (as shown in Figure 17-6) or go to the Preferences > Information Bar (Figure 17-7). Show and hide sections as desired.

![Figure 17-6: The Information Bar.](image-url)
When configuring the Information Bar, you can:

■ choose which sections are visible, and
■ choose which fields are shown within each section.

To choose which sections are visible, check or uncheck them as desired (Figure 17-7). To completely hide the Information Bar, hide all panels.

To choose which fields from a particular Information panel appear in the Information Bar, open the panel and choose Configure Info Bar from its mini-menu: the panel will enter configuration mode, as shown in Figure 17-8.

When an Information window is in configuration mode, you’re configuring its appearance in the active window’s Information Bar. For example, when the Sequence Editor is focused and the Cursor Info window is open in configuration mode, enabling or disabling a field does so for the Cursor Info section of the Information Bar in the Sequence Editor. If you leave the Cursor Info window in configuration mode and change which edit window is focused, say, from the Sequence Editor to the Notation Editor, the Cursor Info window will update to the configuration used for the new window. If you wish to enable or disable a field for all windows at once, Option/Alt-click the field’s circle.

**Using two lines for the Information Bar**

The “Use two lines…” option in the Information Bar preferences splits the Information Bar elements into two lines when more than three sections are showing to give each section more room to display its contents.

**Opening the Information panels**

To open an Information window from the Information Bar, click the letter at the left of the section, as shown in Figure 17-6. Option/Alt-click the letter to open the Information panel in configuration mode. Command/Ctrl-click the letter to open the Information Bar preferences.

For more information about the Information Panels, see chapter 38, “Information Panels” (page 330).
THE TIME RULER
The Time Ruler (Figure 17-1 on page 103) measures time horizontally for all MIDI and audio data in the Sequence Editor tracks below it.

Figure 17-9: The Time Ruler gives you a visual indication of where data is. It can display time in any of Performer Lite’s various time formats.

Cursor tracking
To help align the mouse pointer with the Time Ruler, a line appears inside the Time Ruler to indicate the current position of the mouse. The cursor location is displayed numerically in the cursor information section of the information bar.

Choosing time formats
The Time Ruler can display time in any of Performer Lite’s various time formats. Right-click to choose the desired format.

Using the Time Ruler to cue playback
You can click the time ruler as shown below to cue Performer Lite to that location.

Figure 17-10: Setting the format for the Time Ruler.

Zooming the Time Ruler
See “Zoom buttons” and “Zooming techniques” on page 110.

Using the Time Ruler to select a time range
A time range can be selected by dragging horizontally in the lower half of the Main Time Ruler with the I-beam cursor as shown below. For more similar techniques, see “Time Ruler selection techniques” on page 285.

Figure 17-11: Setting the format for the Time Ruler.

THE MARKER STRIP
The Marker Strip appears just below the Time Ruler (Figure 17-1 on page 103). It displays markers, meter changes, and key changes. It is always visible and is not affected by vertical scrolling.

The Marker Strip shares the Time Ruler with the audio, MIDI and movie tracks below it. Therefore, the location of items in the Marker Strip will always correspond with data displayed below.

Markers
To add a marker, click the marker icon to the right of the strip and drag and drop the marker onto the Marker Strip at the desired location.

In the Marker Strip, a marker appears as a marker icon, followed by the marker’s name. The marker icon indicates the marker’s exact location. If the marker is locked, a lock icon will appear between the pointer and the marker name.
Snap to Markers
To make items snap to marker locations (regardless of whether marker grid lines are currently displayed), enable the Snap to Marker option (Figure 17-1 on page 103).

Making a time-range selection with markers
Click the marker to make a time range selection that extends to the next marker.

Meter and key changes
Meter and key changes appear in the Marker Strip (Tempo changes are not displayed in the Marker Strip.) Similarly, they can only be edited in the Conductor track. See “Editing in the Conductor Track” on page 421.

THE MEMORY CYCLE STRIP
The Memory Cycle strip (Figure 17-1 on page 103) displays the Memory Cycle loop as a colored bar. Drag in the strip to enable Memory Cycle and set the start and end times. Drag the endpoints of the bar to change them, or drag the bar to move it. Click the bar to toggle Memory Cycle on or off. Also see “Memory Cycle” on page 98.

THE AUTO RECORD STRIP
The Auto Record strip (Figure 17-1 on page 103) displays the Auto Record punch-in/out region as a colored bar, which works in the same fashion as described for the Memory Cycle bar above. Also see “Auto-Record” on page 99.

ZOOMING TECHNIQUES
In addition to the zoom buttons shown in Figure 17-1 on page 103, Performer Lite provides many other ways to zoom in and out, including many useful zooming shortcuts. In particular, you can very quickly and conveniently zoom in and out by Control/Win-dragging vertically on the green playback wiper.

Zoom shortcuts
The View menu > Zoom sub-menu provides many useful options for magnifying or reducing the data displayed in the Sequence Editor. See “Zoom menu shortcuts” on page 275.

AUDIO TRACK SETTINGS
The panel to the left of each track shows all of the settings for the track. Audio track settings are as follows:

ZOOM BUTTONS
The Sequence Editor zoom buttons (Figure 17-1 on page 103) let you zoom all tracks both horizontally and vertically. Zoom in using the 'plus' button to get more detail. Zoom out with the 'minus' to get more of an overview. If you press continuously, the window zooms continuously. Shortcut: Option/Alt-click to zoom to the maximum or minimum setting. When zooming vertically, tracks proportionally maintain their relative vertical sizes.

Track names
- Click, Command/Ctrl-click, or Shift-click a track name to select the track for deleting, duplicating and other track management tasks.
- Option/Alt-click the track name to rename it.
- Command–double-click a track name to open the Mixing Board with that track’s channel showing.

- Track names highlight if there is a selection in the track.

**Track type icon/color selector**
The track type icon serves two roles: 1) it tells you what type of track you are looking at with an icon (identified in “The track type icon” on page 52), and 2) if you click on the icon, you can choose the track color.

**Locked tracks display a line under their name**
If a track is locked, its name is underlined.

**The Edit Layer**
In the Sequence Editor, each type of data resides in its own edit layer, which you can make **active** (bring to the front) while other layers remain dimmed or hidden in the background.

The **Edit Layer menu** (Figure 17-13 on page 110) lets you choose what type of data you would like to make active, as shown below in Figure 17-14. In audio tracks, mix automation data (volume, pan, etc.) is displayed directly on top of the soundbites, which are dimmed in the background. When soundbites are made active, automation data is hidden. In MIDI tracks, the same is true for MIDI continuous controller (CC) data and MIDI notes on the note grid.

When a data type is made active, it can be inserted and edited independently of other data types.

---

![Figure 17-14: Choosing the edit layer.](image)

**Choosing the edit layer for all tracks at once**
Hold down the Option/Alt key when choosing what to display to change all tracks at once. You can do so from any track.

**Using lanes instead of edit layers**
As an alternative to using edit layers, you can show separate lanes for each type of automation data. See “Displaying automation lanes” on page 318.

**Using edit layers**
For further information about using each edit layer, see below.

<table>
<thead>
<tr>
<th>Edit layer</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Lanes</td>
<td>“Displaying automation lanes” on page 318</td>
</tr>
<tr>
<td>Soundbites</td>
<td>“Audio editing basics” on page 306</td>
</tr>
<tr>
<td>Volume Pan</td>
<td>“Working with breakpoint mix automation” on page 317</td>
</tr>
<tr>
<td>Pitch</td>
<td>chapter 61, “Transposing Audio” (page 519)</td>
</tr>
<tr>
<td>Stretch</td>
<td>“Stretching audio beats” on page 407</td>
</tr>
<tr>
<td>Bite Volume</td>
<td>“Soundbite volume automation” on page 321</td>
</tr>
</tbody>
</table>
**Level meter**
Each audio and MIDI track displays a mono or stereo level meter (with red clip indicator). These level meters function identically to the level meters in the Mixing Board. For details, see “Level meters” on page 170.

**Track settings menu**
The track settings menu (Figure 17-13 on page 110) provides all of the track’s settings in menu form, as shown in Figure 17-15. Since tracks can be resized vertically (see “Resizing tracks” on page 114), many of their panel settings get covered up when their vertical size is reduced. However, the Track Settings menu remains visible, even at a track’s smallest vertical height, so that you always have access to all of the track’s settings.

For audio tracks, most of the items in the Track Settings menu are explained in “Audio track settings” on page 58. However, there are a few menu settings that are specifically related to the Sequence Editor:

<table>
<thead>
<tr>
<th>Setting</th>
<th>For further information</th>
</tr>
</thead>
<tbody>
<tr>
<td>View mode</td>
<td>“View Mode” on page 112</td>
</tr>
<tr>
<td>Set Pitch Mode</td>
<td>“Setting the pitch mode” on page 524</td>
</tr>
<tr>
<td>Pitch</td>
<td>“Temporarily disabling pitch modifications” on page 527</td>
</tr>
</tbody>
</table>

**View Mode**
The View Mode sub-menu (Figure 17-15 on page 112) lets you display an audio track in the Sequence Editor in three ways: as a waveform, as a spectrogram or both.

**The spectrogram display**
The spectrogram display shows frequency content (along the vertical axis) against the Sequence Editor time line (horizontal axis). Bright spots indicate harmonic content in the audio frequency spectrum. This gives you visual insight into the frequency content of your audio, which can help you do things like balance the frequency content of your tracks using visual feedback. You can also use Performer Lite’s extensive plug-in processing to manage and manipulate the frequency content of your audio tracks, and the spectrogram display allows you to view the results visually.

**Waveform/note grid vertical zoom**
The vertical zoom menu (Figure 17-13 on page 110 and Figure 17-16 below) vertically shrinks or expands the waveform display in an audio track and the note grid in a MIDI track. In audio tracks, it has no effect on the actual amplitude of the audio in the track; it is for display purposes only. Option-drag to vertically zoom all audio tracks or all MIDI tracks.
**Insert menu**
The insert menu in each track lets you choose any type of data to insert into the track (except soundbites). In audio tracks, you can insert volume, pan, send levels, track mutes and plug-in parameter automation for any plug-ins currently assigned to the track. For complete details, see “Inserting and editing automation” on page 471. In MIDI tracks, you can insert any type of MIDI data.

**AUDIO EDITING**
To learn about Performer Lite’s powerful audio editing features, see chapter 36, “Audio Editing” (page 304).

**MIDI TRACK SETTINGS**
MIDI tracks have the settings shown in Figure 17-16.

Several of these settings are the same as they are for audio tracks:

- “Track names” on page 110
- “Track type icon/color selector” on page 111
- “The Edit Layer” on page 111
- “Track settings menu” on page 112
- “Level meter” on page 112

For the following MIDI-specific track settings, see “MIDI track settings” on page 64:

- Default patch
- MIDI input
- MIDI output

The remaining MIDI track settings, which are unique to the Sequence Editor, are discussed below.

**MIDI track settings menu**
The track settings menu provides all of the track’s settings in menu form. Since tracks can be resized vertically (see “Resizing tracks” on page 114), their panel settings get covered up when their vertical size is reduced. However, the Track Settings menu remains visible, even at a track’s smallest vertical height, so that you always have access to the track’s settings.
Figure 17-17: All of a MIDI track’s settings are available in its track settings menu, including MIDI device output assignment and continuous data display mode.

Note grid vertical zoom
The note grid vertical zoom menu lets you grow or shrink the number of octaves visible in the track’s note grid.

Note grid scroll bar
The note grid scroll bar lets you scroll the note grid up and down. See “The Pitch Ruler” on page 293 and also see “Viewing notes that are out of view” on page 292.

MIDI EDITING
To learn about Performer Lite’s powerful MIDI editing features, see chapter 35, “MIDI Editing” (page 289).

RESIZING TRACKS
Both MIDI and audio tracks can be resized vertically. Position the mouse over the bottom edge of the track settings panel until you see the hand cursor. Then drag up or down as desired.

Shortcuts for vertical track resizing
Use the following shortcuts to resize tracks:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Hold down this key while dragging:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To make all tracks the same height</td>
<td>Option/Alt key</td>
</tr>
<tr>
<td>To enlarge one track and make all other tracks scale their height to fit in the window</td>
<td>Control/Win key</td>
</tr>
<tr>
<td>To zoom back to the previous state after either of the above operations</td>
<td>Press command-[ (left bracket), or choose Zoom Back from the Zoom sub-menu in the Sequence Editor menu.</td>
</tr>
<tr>
<td>To make tracks snap to fixed sizes vertically</td>
<td>Command/Ctrl key</td>
</tr>
</tbody>
</table>

These modifier key shortcuts can also be used when vertically resizing from track setting menus as shown below:

Resizing the track info panel
The Track Info Panel (Figure 17-13 on page 110) can be resized horizontally by dragging the handle on its right-hand edge. The menu items for each track automatically rearrange themselves in the panel as its width changes. By dragging it further to the right, you have more direct access to the menus when viewing many tracks at once with small vertical track settings, as demonstrated in Figure 17-19:

Figure 17-18: Resizing tracks from the track settings menu.
EFFECT INSERTS PANEL
Click the Effect Inserts panel button (Figure 17-13 on page 110) to show or hide the effect insert panel for each track as shown below. These are the same effects inserts for the track in the Mixing Board. See “Inserts” on page 160.

TAKES
Takes are a way to store multiple versions of a track within a single track. You can add, delete, expand, absorb, and comp takes using the Takes menu and the Comp tool. For complete details, see chapter 42, “Takes and Comping” (page 387).

THE MOVIE TRACK
The movie track displays the movie you’ve opened in the Performer Lite project, if any. Frames are displayed as frequently as possible, given the horizontal frame size. Frames will never overlap, but if you zoom in further than the resolution of the movie frames (such as 15 frames per second), movie frames might be repeated in the display (if there’s room) until the next frame occurs.

All of the controls for the Movie window, such as the movie start time, are available in the track setting panel to the left of the movie track. For details about these settings, see “Movie Window” on page 267.

THE CONDUCTOR TRACK
See “Editing in the Conductor Track” on page 421.
CHAPTER 18  Notation Editor

OVERVIEW
The Notation Editor allows you to view and edit any number of MIDI tracks as standard music notation.

Performer Lite interprets unquantized MIDI data, notating it in a readable fashion without permanently quantizing the data, so your original performance is always preserved. In fact, the notation transcription engine used in Performer Lite has been recognized by industry experts as the best available in any music software program. Music is displayed and edited on a page on the screen exactly as it will print on your printer.

Notes can be inserted with the mouse, computer keyboard, or via MIDI step entry. You can also transpose and edit using all of Performer Lite's powerful commands in the Edit and Region menus.

The Notation Editor provides intuitive text entry for preparing title pages, headers, footers, lyrics, and page numbers. It lets you adjust system margins, staff spacing, measure spacing, and other formatting. Arrangement features let you print out scores, lead sheets and other music documents that have been fine-tuned and consolidated for printing.
NOTATION EDITOR QUICK REFERENCE

Figure 18-1: The Notation Editor gives you a “what you see is what you get” notation window in which you can view, edit, and print your music.
Dynamics Palette: Provides graphic insertion of dynamics symbols.

Arrangement Palette: Provides symbols, such as repeat barlines and endings, that help to condense the display of the score for previewing and printing.

Insertion Cursor: Indicates the location at which notes will be inserted via computer keyboard entry. Click on the staff with the pointer to activate the insertion cursor, and then use the arrow keys to change its location and pitch.

Next/Previous Page: Scrolls to the next or previous page, if any.

Page number: Click on the page number and type in a different page number to jump directly to that page.

Page zoom: Provides preset levels at which to enlarge or reduce the size of the notation displayed in the window. You can also zoom with the Zoom tool in the Tool palette.

Playback Wiper: Indicates the main counter location. Drag it to scrub all MIDI tracks.

Notation Tool palette: Provides mouse insertion of notes, dotted notes, triplets, text, lyrics, chord symbols, braces, brackets and note spellings.

Tool palette: When the Notation Editor is open, the Tool palette gives you access to the Pointer and Zoom tools, which both can be used in the Notation Editor.

Track Selector: Click track names to show or hide them in the Notation Editor.

---

NOTATION EDITOR MENU

Go to Page: Provides sub-menu commands for scrolling to the next, previous, first or last page.

Go to measure: Jumps to the page containing the measure you specify.

Options>Score options: Provides many options for displaying the score in the Notation Editor.

Options>Track options: Provides unique display options for individual tracks.

Options>Marker options: Provides options for the display of markers in the score.

Options>Lyrics options: Provides options for the display of lyrics in the score.

Options>Chord Symbol options: Provides options for the display of chord symbols in the score.

Options>Measure numbers: Provides options for the display of measure numbers in the score.

Options>Measure spacing: Provides options for how tightly or loosely notes are spaced in the score.

Options>Set Score Length: Lets you specify the length of the score, for both linear view and arrangement view. In linear view, the score length can also be determined automatically.

Edit System Margins: When checked, this menu item displays draggable system margins for the current page. The Notation Editor provides separate system margin settings for the first page versus all subsequent pages. The system margins control the distance of staff lines, as well as all staff-related text like instrument names, from the edge of the page.
**Print Individual Parts:** Prints each staff currently being shown in the Notation Editor as a separate part using the current system margin and page text settings. Each part is printed exactly the same way as it would if it were being displayed by itself in the Notation Editor, including its part transposition, if any.

**Tool Palette:** This checkable menu item shows and hides the Notation Editor tool palette.

**Dynamics Palette:** This checkable menu item shows and hides the Notation Editor dynamics palette.

**Arrangement Palette:** This checkable menu item shows and hides the Notation Editor Arrangement palette. These tools only work when you have selected Show Arranged Score (described earlier), except for the Time-Anchored text tool, which can be used in the linear score view as well.

**Switch Staff:** Moves the currently selected notes into the other hand on a piano (grand) staff.

**Change Selected Notes to:** Lets you specify notes as Display-only (silent) or Playback-only (hidden), change notes to small noteheads (or back to normal-sized noteheads), or change note durations to Automatic or Manual.

**Split Selected Normal Notes:** This command operates only on those selected notes that are normal, i.e. a note that is not set to be Display-only or Playback-only. This command replaces each selected normal note with two copies of itself: a Playback-only copy and a Display-only copy. The purpose of this command is to make it easy to start editing the appearance of a measure without changing the playback of the measure.

**Display-only Notes:** This sub-menu provides several commands for selecting, showing/hiding, and playing/muting notes that have been designated as Display-only notes (with the Change Selected Notes to menu command described above).

**Playback-only Notes:** This sub-menu provides several commands for selecting, showing/hiding, and playing/muting notes that have been designated as Playback-only notes (with the Change selected notes to menu command described above).

**Show Lyrics:** This option toggles the display of lyric text in the Notation Editor score.

**Show Film Cues:** This checkable menu item shows and hides the Film Cues View at the top of each system in the Notation Editor.

**Show Arranged Score:** When checked, this menu item causes the Notation Editor to display the arranged notation view. When not checked, the Notation Editor will show the linear notation view. Initially, the arranged view will be the same as the linear view, except that certain tools and commands can be used only in the arranged view. In the arranged view, the score can contain repeats, endings, coda and segno symbols, and score jumps like D.S. al Coda (which the wiper will follow during playback). As you apply tools from the Arrangement palette and begin to “hide” and “move” measures, the arranged view will start to differ from the linear view. Changing the arranged view does not change the playback of the piece — it just changes the look of the score and changes where the wiper goes during playback (and makes your notation more readable when you print it out). See “Score Arrangement” on page 144 for a complete explanation of how to create and print out an arranged view of your score.

**Show Alternate Bar Menus:** Displays a small square pop-up menu next to each regular measure number displayed on the Notation Editor page. Each alternate bar menu shows all of the linear
bars that are currently associated with an arrangement bar. This menu item is only available when the *Show Arranged Score* command is checked. When working on an arrangement, also be sure that *Show measure numbers* is turned on (under *Options* > *Measure Numbers*), and that they are set to display on every measure.

**Allow Measure Selection:** When checked, this menu item lets you select entire measures by clicking and Shift-clicking on them with the Notation Editor arrow tool. When a measure is selected, you can then apply score arrangement operations to the measure (such as hiding, “popping-out” or moving them).

**Clear Arrangement:** Reshuffles the measures in the arrangement view back to a completely linear state where no bars are hidden. All consolidated rests are unconsolidated. Deletes all Coda, double Coda, Segno and double Segno symbols from the score, as well as all endings. It will NOT delete any time-anchored text, including time-anchored text boxes that were created using the D.C., D.S., or D.S.S. tool.

**Edit Selected Measures>Hide:** When you *Hide* a measure behind another measure, it disappears. But when playback reaches a hidden linear measure number, the wiper will jump to the measure where you “hid” it and wipe over that measure while playing the hidden linear measure. Use this feature to hide the second instance of repeated measures behind the first instance, or to hide the second and third verse measures behind the first verse measures.

**Edit Selected Measures>Pop Out:** Extracts the currently visible linear measure (in a selected arrangement measure that has several linear measures “hidden” in it) and places it just to the right of the arrangement measure you selected. After being liberated, you can then move the popped-out measure anywhere in the score (such as its original linear position). This operation is the opposite of “hiding” a measure.

**Edit Selected Measures>Move:** Positions the currently selected measure anywhere in the score. You will be asked where you want to move the selected measure to, and you then specify an arrangement measure location.

**Consolidate Rests / Unconsolidate Rests:** Specifies the minimum number of consecutive empty measures that will be displayed as consolidated rests for all tracks currently visible. If a track is already set to consolidate rests in a certain way, it will continue to prefer that setting when it is shown by itself or in combination with other tracks.

**Make Arrangement Markers:** Creates markers for interesting points in an arranged score. In particular, a marker is created at the start of every repeat, at segno and coda marks, and at the start of each ending. Open the markers window to quickly navigate to the various parts of the arrangement. Markers can be shown or hidden in the Notation Editor with the *Show Markers* check box in the Marker Options window.

**Open Selected Ending Bracket:** Gets rid of the small vertical line at the end of the currently selected ending bracket. Doing so implies that the reader of the score should continue on after taking the ending.

**NOTATION EDITOR BASICS**
The Notation Editor display MIDI tracks as music notation, and you can easily change which tracks are displayed. Page formatting is preserved, even if you decide to change what is displayed in the window. The Notation Editor is ideal for quickly printing scores and parts.
The Notation Editor uses engraver spacing so that the notation looks more natural for printing. In addition, the Notation Editor displays staves on a page — essentially a virtual piece of paper — such that what you see on-screen is what you get when you print a Notation Editor score. The Notation Editor automatically generates as many pages as needed to hold your score. The contents of the Notation Editor can be printed at any time. This chapter explains all about preparing the appearance of the score. For information about printing it, see “Printing project windows” on page 83.

OPENING THE NOTATION EDITOR
To open the Notation Editor, click its button in the Control panel (Figure 7-4 on page 41).

THE TRACK SELECTOR
Use the Track Selector (page 41) to choose which tracks (instruments) you’d like to see in the Notation Editor.

THE QUICKSCRIBE TRANSCRIPTION ENGINE
The Notation Editor employs a highly sophisticated transcription engine called QuickScribe to interpret unquantized MIDI data as readable music notation. QuickScribe tries to write the music just like it sounds — perhaps like you might write it down if you listened to a tape of it and tried to transcribe it yourself by ear. Transcription is not an exact science, and QuickScribe does its best to take precisely recorded MIDI data (which is often played much differently than the way it is written), make “human” judgments about how it might be written, and then turn it into readable notation.

Floating split points and multiple voices
Performer Lite’s QuickScribe transcription engine is quite sophisticated. For example, it employs floating split points when notating a track on a grand staff, intelligently deciding whether notes should be written on the treble or bass clef staves. QuickScribe can also notate multiple voices on a single staff — that is, notes that have different rhythms happening at the same time in the same measure. But you don’t really need to know any of this; the result of it all is that you get some of the best automated notation transcription available in music software.

Displaying triplets and tuplets
In addition to being able to properly display unquantized data, Performer Lite automatically detects triplets and tuplets and displays them with the appropriate bracket and note spacing. In some cases, the placement of the notes in the tuplet may not be accurate enough for Performer Lite to properly detect the tuplet. If you’d like to see the tuplet properly displayed, try quantizing the data with the tuplet option in the Quantize command. Try experimenting with Strength settings less than 100%, as the tuplet does not need to be fully quantized for Performer Lite to recognize it. However, if all else fails, quantize the start time of all notes in a given measure to be sure that triplets and certain other rhythms will be detected.

Context sensitive note spelling
QuickScribe’s transcription engine also takes into account the context in which an accidental is spelled. For example, in an ascending line, QuickScribe will use a sharp to notate an accidental, but use a flat in a descending line.

THE PLAYBACK WIPER
The playback wiper operates as usual in the Notation Editor, with the following exception: since the Notation Editor employs engraver spacing for notes, it does not have a linear time ruler like Performer Lite’s other editors. Therefore, to make the playback wiper jump immediately to a particular location, double-click on a staff at the desired spot. To scrub, drag the wiper as usual. Note that you can drag it vertically to jump to the next or previous staff system. If you drag horizontally off the end of a system, the wiper will
continue on to the next system at its current speed, as long as the mouse is held down. Continuing to drag left and right with the mouse will change the speed and direction of the “runaway wiper”.

GETTING AROUND IN THE NOTATION EDITOR
Use the next/previous page buttons (Figure 18-1 on page 117) or the corresponding Notation Editor menu commands to scroll through each page and go to the first or last page. The menu commands have the following keyboard shortcuts:

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next page</td>
<td>N</td>
</tr>
<tr>
<td>Previous page</td>
<td>P</td>
</tr>
<tr>
<td>First page</td>
<td>F</td>
</tr>
<tr>
<td>Last page</td>
<td>L</td>
</tr>
</tbody>
</table>

You can also jump to a particular page by using the page number box at the bottom of the window.

Figure 18-2: Click the page number to go to any page.

Mouse wheel scrolling
If your mouse has a wheel on it, you can scroll the Notation Editor vertically and horizontally with the wheel. To scroll horizontally, hold down the Shift key.

Notation Editor commands
There are many Notation Editor commands in the Commands window. These keyboard shortcut operations can greatly speed up your work in the Notation Editor, and they can be fully customized. For details, search for “Notation Editor” in the Commands window (Setup menu).

ZOOMING
The contents of the Notation Editor can be magnified and reduced with the following mouse techniques:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To go directly to a particular zoom magnification (such as 400%)</td>
<td>Choose it from the zoom menu at the bottom of the window (Figure 18-1 on page 117).</td>
</tr>
<tr>
<td>To zoom in with the Zoom tool</td>
<td>Select the Zoom tool in the Tool palette (Figure 18-1 on page 117) and drag over the desired area, or click to zoom in one level.</td>
</tr>
<tr>
<td>To zoom out with the Zoom tool</td>
<td>Option/Alt-click.</td>
</tr>
<tr>
<td>To zoom in with the Pointer tool</td>
<td>Select the Pointer tool and Option/Alt-drag over the desired area.</td>
</tr>
<tr>
<td>To zoom forward with the Pointer tool</td>
<td>Option/Alt-Control/Win-Shift-click.</td>
</tr>
<tr>
<td>To zoom back with the Pointer tool</td>
<td>Option/Alt-Shift-click.</td>
</tr>
</tbody>
</table>

Keyboard zooming shortcuts
The Notation Editor supports Performer Lite’s zooming keyboard shortcuts for Zoom to Selection, Zoom Forward/Back, Zoom to Setting, and Set Zoom Setting. These shortcuts are explained in “Zoom menu shortcuts” on page 275. They can be customized as explained in chapter 28, “Commands” (page 234). When zooming to a selection, the Notation Editor zooms to the center of the area prescribed by the currently selected notes.
NOTATION EDITOR OPTIONS SUB-MENU

The Options sub-menu in the Notation Editor menu provides several commands for controlling the appearance of your score.

Figure 18-3: The Options sub-menu.

Separate Notation Editor options for three different views

Performer Lite maintains a separate set of score options for three separate Notation Editor views: Normal Notation, Notation + Film Cues, and Film Cues Only. (See “Three different Notation Editor views” on page 151.) When you enable one of the three different views, they are displayed with their own set of options. Four of the options dialogs shown above in Figure 18-3 (Score Options, Measure Spacing, Measure Numbers and Marker Options) contain a popup menu that lets you select which set of preferences you are editing:

Figure 18-4: Setting options for the three different Notation Editor views.

SCORE OPTIONS

Choose Score Options (Figure 18-3) to open the Score Options dialog box:

Figure 18-5: The Score options command in the menu gives you many choices for laying out your score.

All score option settings are saved with the file, and they can be included in your New file template.

Creating a title page

The “First page is title page” option allows the first page of music to be formatted differently from the rest of the body pages. Its system margins can be adjusted separately from other pages to allow for a title, subtitle, composer, and other text. Text can be inserted on the title page without having it be displayed on other pages.

Full part names/Abbreviated part names

Two options are provided for displaying staff names, which appear between the left margin and the left edge of the staff. In both cases, the staff name is derived from the track name. Check the first option, Full name before first system, to display the full track name to the left of the first staff. Check the second option, Abbreviated names before other systems, if you would like an abbreviated name to appear next to each staff after the first one. By default, the abbreviation is the
first four letters of the staff name, but this can be customized as explained in “Track name abbreviation” on page 126. If you don’t want staff names, uncheck both options.

The Abbreviation maximum length option lets you choose the maximum length of the default abbreviated staff names.

To set the font, style, size, etc. of all staff names, click any staff name and choose the desired text settings from the Text menu. The settings you choose will affect all staff names and abbreviations.

**Adjusting the space between staves and staff systems**

In addition to the space created above and below individual staves by their ledger line settings, you can make more space between staves and staff systems globally with the “Extra spacing” options. When you are printing a single track, use either option to increase the amount of space between the staves. If you are printing several tracks at the same time, they are grouped together into a staff system. Use the staff spacing option to increase space within the system; use the system spacing option to increase space between systems.

**Show tempo marking above first measure**

Performer Lite takes the tempo for the metronome marking from the tempo setting in the first measure displayed in the score. The tempo number is taken from the current settings in the metronome panel. For example, if the tempo control is set to the tempo slider, the current tempo slider setting is used. If tempo control is set to the Conductor track, the current tempo setting in the Conductor track is used.

The Pixel offsets option lets you adjust the position of the tempo marking. Positive offsets move the marking up and to the right. Negative offsets move it down and to the left.

**System Bracket/Grand Staff Brace options**

These two options let you choose whether or not new tracks should default to using a bracket or a brace. Brace and bracket groupings can easily be changed by using the brace and bracket tools in the Notation Editor Tool Palette.

**Show rests in empty measures**

You may choose whether or not to show a whole rest in empty measures (measures with no note data in them).

**Showing/hiding time-anchored text**

Use the Show time-anchored text option (Figure 18-5 on page 123) to show or hide time anchored text (“Time-Anchored Text” on page 139).

**Transcription**

The Ignore Mistakes options help clean up the transcription by ignoring (hiding) notes that have either a very short duration or a very low velocity—typical characteristics of notes that were played by mistake. You can adjust threshold for what is considered a “mistake” by adjusting the duration and velocity settings provided. The Ignore Mistakes option can be especially helpful when viewing performances with lots of grace...
notes or lead-ins. Note, however, that if you want to choose which notes to show on a case-by-case basis, you can also make any note invisible by setting it to be “playback only”. For details, see “Display-only and playback-only notes” on page 149.

When you check the Straighten Swing option, the Notation Editor automatically writes swung eighth notes as straight eighths, instead of writing them as triplets with a triplet bracket. Only the display of the notes is affected. The actual MIDI data remains unmodified, so it will still play back with the original feel. This option is a great way to instantly clean up any score that was recorded with a swing feel.

**TRACK OPTIONS**
When displaying a track in the Notation Editor, the Track options sub-menu command (Figure 18-3) lets you specify how you want it to be displayed, such as whether to display the track on a single staff or a grand staff.

**Track menu**
Choose each track one at a time from this menu and, below, choose the unique settings you want for each track. Settings are remembered. You can change them at any time. The “Default” item in this menu has its own settings, too; they are applied to any track for which you have checked the Use Default option (see below).

**Use Default**
This check box causes the track to use the default settings. To change the default settings, choose Default from the Track menu at the top of the dialog box (as shown in Figure 18-6).

**Figure 18-6: Track options.**

**Type of staff (and clef)**
When viewing the track options for an existing track as shown in Figure 18-6, choose the desired staff type and clef from the menu provided.

**Figure 18-7: The ‘Use Default’ track option.**
When viewing the ‘Default’ track options as shown in (Figure 18-7), you have five staff options.

**Single staff**
The *Single staff* option causes tracks using the default settings to be displayed on a single staff, regardless of what notes are in the track. When using a single staff, Performer Lite automatically chooses either a bass clef or treble clef in an effort to place most of the notes inside the staff and to avoid lots of ledger lines.

**Grand staff**
The *grand staff* option causes tracks using the default settings to be displayed on a grand staff, regardless of the notes in the track. Hand splitting is taken care of dynamically by Performer Lite’s transcription engine.

**Use single staff unless it requires more than ___ ledger lines**
This option causes Performer Lite to use a grand staff for the track if notes exist more than the specified number of ledger lines above or below a single staff. Use the ledger line option to control when a grand staff will be used instead of a single staff. Raise the number if you want to avoid using the grand staff very often.

**Track name abbreviation**
When viewing the track options for an existing track as shown in Figure 18-6, type in any track name abbreviation you wish in the text box provided. This custom name abbreviation overrides the “Default” track abbreviation (as specified by the track abbreviation settings in the Score Options menu command).

When viewing the ‘Default’ track options as shown in (Figure 18-7), each track is given a default track abbreviation as specified in the Score Options (Figure 18-5 on page 123). See “Full part names/Abbreviated part names” on page 123.

**Transposition**
The *Transpose* settings specify a part (instrument) transposition for each track, as well as a score transposition. The Notation Editor uses the part transposition when you view or print the track by itself; it uses the score transposition when you view or print the track together with other tracks. You will most likely want to set the score transposition for each track to concert pitch, which is represented as C natural. For transposing instruments, choose the appropriate transposition. For example, you will also most likely want to set the part transposition for a B flat trumpet track to B flat.

**Inter-staff spacing**
These options give you control over the amount of space above and below the staff. This spacing is specific to the one track you are making settings for. To change the spacing of all staves, see “Adjusting the space between staves and staff systems” on page 124.
MARKER OPTIONS
Choose Marker Options (Figure 18-3) to display markers in the score at their location in the sequence. The marker text can appear above or below the staff, and you can control the distance from the staff by typing in a number of ledger lines in the box provided.

Displaying marker location
You can also choose to show the exact location of markers along with their name in any combination of Performer Lite’s various time formats. Just check the box next to the time format you wish. This time is appended to the marker text:

Cascading overlapping markers
If markers occur close to one another, given the spacing of your score, you can use the Cascade overlapping markers option to force the Notation Editor to cascade them vertically rather than overlap their names:

Hiding markers in a dense score
If you are using the _ measures per line measure spacing option, and measure spacing gets very dense, you can hide markers altogether with the Hide markers when showing _ or more bars per line option. When this option is enabled, and markers are being hidden, markers weighted Very Important remain visible and are displayed as dots.

Setting marker font, size, and style
To set the font, style, size, etc. of all markers, click any marker name and choose the desired text settings from the Text menu. The settings you choose will affect all markers.
MEASURE NUMBERS

The Measure numbers sub-menu command (Figure 18-3) sets the frequency and position of measure numbers in the score.

Measure number text formatting

Click any measure number displayed in the Notation Editor to select all measure numbers and change their font, size and style using the Text menu. Changes apply to all measure numbers in the document. Changes are saved in the preferences for the current view (Notation, Notation + Film Cues, or Film Cues Only), so the setting can be made independently by view.

If you want a certain font, size or style to be the default for measure numbers, first make a file that has measure numbers the way you like them. Then save it as a file template (File menu > Save As Template) and check the Use as default New template option.

The measure numbers displayed just below the Show Film Cues staff (Figure 18-38 on page 150) cannot be formatted in this manner. They are displayed in a fixed font, size and style.

MEASURE SPACING

The measure spacing sub-menu command (Figure 18-3) lets you determine the number of measures per line or the overall spacing of notes.

Space measures ___ per line

This option lets you choose a certain number of measures per line, such as four or five. You can type in the desired number. With this option, each measure is the same size no matter what notes are in the measures.

If measures have lots of notes in them, use automatic spacing for best results.

Space measures automatically

This option lets Performer Lite decide how many measures to put on each line, depending on how many notes are in them. You can tighten or expand the overall spacing of measures by adjusting the slider. Its range depends on the music: don’t hesitate to experiment with its full range. The score will update in realtime as you drag the slider.

In many cases (depending on the music itself), automatic spacing produces the best-looking results.
SET SCORE LENGTH
The Set Score Length sub-menu command (Figure 18-3) lets you determine the length of the score.

Linear Score
The “Auto” option lets Performer Lite determine how long the score is; however, it won’t be shorter than the minimum length specified here. The “Fixed” option sets the score to the exact length specified.

Non-linear (Arranged) Score
This specifies the length of the score when “Show Arranged Score” is enabled. This section is unavailable when “Show Arranged Score” is not enabled; likewise, when “Show Arranged Score” is enabled, the Linear Score section is unavailable.

CONTROLLING PAGE SIZE
The size of the page in the Notation Editor is controlled by the Page Setup command in the File menu. Custom page sizes are not supported.

ADJUSTING SYSTEM MARGINS
System margins can be adjusted graphically by choosing the Edit System Margins menu command in the Notation Editor. Doing so causes system margins to appear on each page. The adjustments you make on any page will automatically be reflected on all other pages, except for the title page, if there is one. If the First page is title page option is enabled in the Score options dialog (Notation Editor menu), the title page margins can be adjusted separately from the rest of the pages to allow for title text. In this case, you can adjust the system margins of the other pages by scrolling to any page besides the title page.

INFORMATION BAR
Similar to the Sequence Editor, the Information Bar (Figure 18-1 on page 117) can display useful information, such as tracks settings, mixer channel settings and so on, as shown below in Figure 18-12.

THE NOTATION EDITOR TOOL PALETTE
The Notation Editor Tool Palette allows you to insert notes, text, system brackets and braces, dots and tuplets. It also provides a tool for changing the enharmonic spelling of accidentals. The tools in this palette are explained in the following sections.

Braces, brackets and barlines
Barlines extend across the staff systems that are grouped together with a brace or bracket.
WORKING WITH NOTES
The Notation Editor allows you to do basic sequencing tasks, including inserting, step-recording, transposing, and editing notes.

You can insert notes with the mouse, the computer keyboard, or a MIDI keyboard. All three methods involve using the tool palette.

Rests are automatic
Rests are handled automatically by Performer Lite’s transcription algorithms. You do not need to enter them.

Inserting notes with the mouse
Insert notes and chords with the mouse as follows:

<table>
<thead>
<tr>
<th>To insert this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A note</td>
<td>Click the desired note duration in the tool palette. Press anywhere in the measure where you want to insert the note. With the mouse still held down, drag to the desired pitch and location. Watch the Cursor Information window to help determine the beat location.</td>
</tr>
<tr>
<td>A note with an accidental</td>
<td>Same as above.</td>
</tr>
<tr>
<td>A dotted note</td>
<td>Click both the desired note duration and the dot in the palette. Then insert the same as above.</td>
</tr>
<tr>
<td>A chord</td>
<td>Insert the first note as described above. Click directly above or below the first note to add more notes to the chord.</td>
</tr>
<tr>
<td>A triplet</td>
<td>Click a note duration in the tool palette and click the triplet tool. Both are now selected. Insert each note in the triplet as described above. See “Displaying triplets and tuplets” on page 121 for more information about triplet detection.</td>
</tr>
<tr>
<td>To add a dot to a note</td>
<td>Click the dot tool and then click on the notehead you want to add it to.</td>
</tr>
<tr>
<td>To change the duration of a note</td>
<td>Click the desired duration in the palette and click the note.</td>
</tr>
<tr>
<td>To change several notes to the same duration</td>
<td>Select the notes with the pointer. Command/Ctrl-click the desired duration or dot in the tool palette. Note: to scale durations (to double or halve them, for example) use the Scale Time command in the Region menu.</td>
</tr>
</tbody>
</table>

Selecting durations with the extended keypad
The extended keypad can be used to select durations in the Notation Editor tool palette during keyboard insertion, as shown below in

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move the cursor</td>
<td>Use the arrow keys.</td>
</tr>
<tr>
<td>To determine the exact beat location and pitch of the insertion cursor</td>
<td>Use the Cursor Information window.</td>
</tr>
<tr>
<td>To select a duration</td>
<td>Use the open bracket ( [ ) and closed bracket ( ] ) keys to choose the next highest and lowest duration. Or use the extended keypad (see &quot;Selecting durations with the extended keypad&quot; on page 130). Or click the desired duration in the palette.</td>
</tr>
<tr>
<td>To add a dotted duration to the current note duration</td>
<td>Press the d key to turn on the dotted duration tool; press it again to turn it off.</td>
</tr>
<tr>
<td>To insert a note and advance</td>
<td>Press return.</td>
</tr>
<tr>
<td>To insert a note with an accidental</td>
<td>Press the + or - key on the extended keypad.</td>
</tr>
<tr>
<td>To insert the first note of a chord</td>
<td>Press the enter key. (Enter inserts the note without advancing the insertion cursor.)</td>
</tr>
<tr>
<td>To insert the second, third, fourth, etc. note in a chord</td>
<td>Press the enter key.</td>
</tr>
<tr>
<td>To insert a tuplet</td>
<td>Press the t key to turn on the tuplet tool, and use the bracket keys as described above to select any note duration. Press t again to toggle off the tuplet tool.</td>
</tr>
<tr>
<td>To delete a note or chord</td>
<td>Position the insertion cursor to the right of the note and press the delete (backspace) key.</td>
</tr>
</tbody>
</table>

Inserting notes with the computer keyboard
To insert notes and other symbols with the computer keyboard:

1. Click the Pointer tool in the palette.
2. Click on the staff at the desired pitch and location for the symbol.
3. After you have a blinking insertion cursor on the staff, refer to the following table:

<table>
<thead>
<tr>
<th>To insert this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To move the cursor</td>
<td>Use the arrow keys.</td>
</tr>
<tr>
<td>To determine the exact beat location and pitch of the insertion cursor</td>
<td>Use the Cursor Information window.</td>
</tr>
<tr>
<td>To select a duration</td>
<td>Use the open bracket ( [ ) and closed bracket ( ] ) keys to choose the next highest and lowest duration. Or use the extended keypad (see &quot;Selecting durations with the extended keypad&quot; on page 130). Or click the desired duration in the palette.</td>
</tr>
<tr>
<td>To add a dotted duration to the current note duration</td>
<td>Press the d key to turn on the dotted duration tool; press it again to turn it off.</td>
</tr>
<tr>
<td>To insert a note and advance</td>
<td>Press return.</td>
</tr>
<tr>
<td>To insert a note with an accidental</td>
<td>Press the + or - key on the extended keypad.</td>
</tr>
<tr>
<td>To insert the first note of a chord</td>
<td>Press the enter key. (Enter inserts the note without advancing the insertion cursor.)</td>
</tr>
<tr>
<td>To insert the second, third, fourth, etc. note in a chord</td>
<td>Press the enter key.</td>
</tr>
<tr>
<td>To insert a tuplet</td>
<td>Press the t key to turn on the tuplet tool, and use the bracket keys as described above to select any note duration. Press t again to toggle off the tuplet tool.</td>
</tr>
<tr>
<td>To delete a note or chord</td>
<td>Position the insertion cursor to the right of the note and press the delete (backspace) key.</td>
</tr>
</tbody>
</table>
Figure 18-14. On Windows, the Num Lock key must be engaged to enable these keypad shortcuts. These Notation Editor keypad shortcuts are only available when there is an active insertion cursor somewhere in the Notation Editor. Otherwise, the keypad keys are bound to Performer Lite’s standard transport shortcuts.

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow tool</td>
<td>[Clear]</td>
</tr>
<tr>
<td>Tuplet</td>
<td>[/]</td>
</tr>
<tr>
<td>64th note</td>
<td>[8]</td>
</tr>
<tr>
<td>32nd note</td>
<td>[7]</td>
</tr>
<tr>
<td>16th note</td>
<td>[6]</td>
</tr>
<tr>
<td>8th note</td>
<td>[5]</td>
</tr>
<tr>
<td>Quarter note</td>
<td>[4]</td>
</tr>
<tr>
<td>Half note</td>
<td>[3]</td>
</tr>
<tr>
<td>Whole note</td>
<td>[2]</td>
</tr>
<tr>
<td>Dot</td>
<td>[.]</td>
</tr>
<tr>
<td>Double dot</td>
<td>[=]</td>
</tr>
</tbody>
</table>

Hearing notes while inserting them with the mouse
To hear notes played back on a MIDI device as you insert them, make sure the device is on line and audible (through your headphones or speakers).

Step Recording notes with a MIDI controller
To insert notes with a MIDI controller:

1. Click the Pointer tool in the palette.
2. Click on the staff at the location where you would like to begin entering notes.

A blinking insertion cursor appears on the staff. Use the Cursor Information window to determine the exact location in the measure. If necessary, use the Left Arrow and Right Arrow keys to move the cursor.

3. Select a note duration.

There are several ways to select a duration: 1) click the desired note duration in the tool palette, 2) press the open bracket ( [ ) and closed bracket ( ] ) keys on the computer keyboard repeatedly, or 3) use the extended keypad as described in “Selecting durations with the extended keypad” on page 130. The currently selected duration is displayed in the tool palette.

4. Play the desired note or chord on your MIDI controller.

Notes appear when you release the keys, so be careful not to slur notes together. It’s best to play in a staccato fashion to avoid accidentally inserting two notes when you only want to enter one. If you would like to hold one note while inserting others, just keep holding it down while inserting the other notes.
Play as many notes and chords as you’d like.

Change durations as needed. Step Recording uses many of the same keyboard actions as computer keyboard entry, so you may want to review the section “Inserting notes with the computer keyboard” on page 130.

**Getting the pointer temporarily**
While working with the Notation Editor Tool palette, you may want to temporarily restore the pointer for selecting or some other purpose. To do so, press the Option/Alt key. While you hold it down, the cursor turns into a pointer. When you release the Option/Alt key, the cursor switches back to whatever it was.

**Selecting notes for editing**
Below is a summary of how to select notes for editing in the Notation Editor. Notes are selected with the Pointer tool.

<table>
<thead>
<tr>
<th>To select this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>A single note</td>
<td>Click it once.</td>
</tr>
<tr>
<td>Several notes that are not next to</td>
<td>Shift-click each note.</td>
</tr>
<tr>
<td>one another</td>
<td></td>
</tr>
<tr>
<td>The notes in several measures</td>
<td>Drag a selection box over the measures.</td>
</tr>
<tr>
<td>A region of notes</td>
<td>Drag a selection box over them.</td>
</tr>
<tr>
<td>All notes in the track</td>
<td>Double-click any note.</td>
</tr>
</tbody>
</table>

If a note is displayed as several tied notes, you can click any notehead to select the entire note.

When a single note is selected, its information appears in the Event Info window. This information can be edited as usual.

**Dragging selected notes**
To change the pitch of selected notes, drag them vertically. To change their time location, drag them horizontally. In either case, your action is constrained to the direction you first drag. For example, if you drag vertically to change pitch, your action is constrained to the vertical axis as soon as you begin dragging so that you don’t accidentally move the notes in time as well. Conversely, if you drag horizontally first, your action is constrained horizontally so that you don’t accidentally change pitch.

When dragging horizontally across multiple systems, you can drag to any staff in the system. (You are not limited to the original staff.)

Hold down the Option/Alt key when dragging notes if you want to drag copies of the notes.

**Drag and drop from the Notation Editor**
You can drag and drop selected notes out of the Notation Editor onto your computer desktop or into other Performer Lite windows. To do so, drag the material horizontally, not vertically, as vertical dragging is reserved for transposing the pitch.

**Cutting, copying & pasting notes**
After notes are selected as described in the previous section, they can be cut, copied, and pasted using the commands in the Edit menu. To paste notes you have either cut or copied, click the staff with the pointer on the location at which you would like to paste the material. Watch the Cursor Information window to specify the exact beat location at which you will paste. You can copy and paste between other editing windows as well.

**Using Region menu commands**
Similar to the Edit menu commands mentioned above. Any Region menu command can be applied to notes you have selected. This includes quantizing, transposing, and any other command from the Region menu.
Changing note durations
To change a note duration, click the desired duration from the tool palette and click on the note you wish to change. To change several notes at once, select them and then Command/Control-click the desired duration in the tool palette.

Automatic vs. Manual durations
The Notation Editor’s transcription engine automatically displays notes with intelligent durations that are best for notation. The Change Selected Notes to Automatic Durations and Change Selected Notes to Manual Durations commands, available under the Notation Editor menu’s Change Selected Notes to sub-menu, let you change the display duration for selected notes.

Using Change Selected Notes to Manual Durations is somewhat like quantizing durations in the Notation Editor without changing the actual durations in the MIDI data. It means, “Be more precise in how the durations are notated, instead of using durations that make live recorded MIDI data look simpler.” Using Change Selected Notes to Automatic Durations tells the Notation Editor to use durations which may be less precise but produce simpler notation. Neither command changes the duration of the actual MIDI note event.

Controlling note spellings
Accidentals in the Notation Editor are automatically calculated by the transcription engine.

Changing how an accidental is spelled
To change how an accidental is spelled:

1. Click the Change Enharmonic Spelling tool (Figure 18-13 on page 129).

2. Press on the notehead to the right of the accidental with the Change Enharmonic Spelling Cursor as shown below in Figure 18-15.

3. Choose the desired enharmonic spelling from the menu. Choose Auto to let the Notation Editor automatically choose the spelling using context-sensitive note spelling algorithms.

Figure 18-15: Changing the spelling of an accidental. Choose 'Auto' to let the Notation Editor automatically choose the accidental using context-sensitive note spelling algorithms.

Moving a note into the left or right hand on a grand staff
The QuickScribe transcription engine employs sophisticated, context-sensitive algorithms to determine if a note should be written in the right hand (treble clef) or left hand (bass clef) on a piano staff. There may be times, however, where you’d like to manually override QuickScribe and move a note to the opposite staff. To do so, select the note and choose Switch Staff from the Notation Editor menu.

Changing the size of a notehead
Performer Lite offers two notehead sizes: normal and small. Small noteheads can be used for embellishments, cue notes, and other notational elements that call for small noteheads. To change the size of noteheads:

1. Select the notes.

2. From the Notation Editor menu, choose Change Selected Notes to> Small noteheads or Change Selected Notes to> Normal noteheads.
CHORD SYMBOLS
Chord symbols can be added to your score. Chord symbols are MIDI track events, and can be transposed along with MIDI notes.

Entering chord symbols
To enter a chord symbol, choose the Chord Symbol tool in the Notation Editor tool palette and click on or above the desired note. Alternatively, assign a keyboard shortcut to the Enter Chord Symbol command (Setup menu > Commands) and press the keyboard shortcut to enter a chord symbol above the selected note (or if there is no selection, above the playback wiper).

An empty chord symbol edit box will appear, ready for you to type in the symbol:

Figure 18-16: An empty chord symbol edit box

Type the desired chord symbol in the empty box. The first character, the root note, must be a letter A–G; after that, you may use any of the following symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>What to type</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>sharp</td>
<td>pound sign ( # )</td>
</tr>
<tr>
<td>b</td>
<td>flat</td>
<td>B</td>
</tr>
<tr>
<td>0</td>
<td>diminished symbol</td>
<td>Option/Alt-Shift-8</td>
</tr>
<tr>
<td>ø</td>
<td>half diminished symbol</td>
<td>Option/Alt-O</td>
</tr>
<tr>
<td>š</td>
<td>major 7th triangle</td>
<td>Option/Alt-J</td>
</tr>
<tr>
<td>6/9</td>
<td>6/9 chord suffix</td>
<td>6/9</td>
</tr>
<tr>
<td>\</td>
<td>diagonal slash for hybrid chord, inversion, or altered bass</td>
<td>slash ( / )</td>
</tr>
<tr>
<td>—</td>
<td>horizontal slash for a poly chord</td>
<td>underline ( _ )</td>
</tr>
<tr>
<td></td>
<td>any other text</td>
<td>the text itself</td>
</tr>
</tbody>
</table>

For chord suffixes, type the opening character, the desired suffix, then the closing character. Use these opening and closing characters:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>What to type</th>
</tr>
</thead>
<tbody>
<tr>
<td>(</td>
<td>stacked suffix with parentheses</td>
<td>Left parenthesis, Right parenthesis</td>
</tr>
<tr>
<td>{</td>
<td>stacked suffix with braces</td>
<td>Left Braces { }, Right Braces { }</td>
</tr>
<tr>
<td>[</td>
<td>stacked suffix with brackets</td>
<td>Left Bracket [ ], Right Bracket [ ]</td>
</tr>
<tr>
<td></td>
<td>stacked suffix with no braces or brackets</td>
<td>Option/Alt-Backslash ( « ), Option/Alt-Shift-Backslash ( » )</td>
</tr>
</tbody>
</table>

For example, to create this chord symbol:

\[ C^7(\#9) \]

…type “C7(#9b13)”.

After typing a chord symbol, press Enter or Return to confirm.

To enter additional chord symbols, press Tab or Shift-Tab to advance to the next/previous metric position in the measure (as determined by the “Tab key advances” preference explained below) or Option/Alt-Tab or Option/Alt-Shift-Tab to jump to the next/previous measure. If a chord symbol already exists at or before the next position that you will Tab or Shift-Tab to, the chord symbol will be selected for editing.
Transposing chord symbols
Chord Symbols are transposable along with other MIDI data. Select the desired chord symbols, with or without a MIDI note selection, and choose Region menu > Transpose. Select the “Transpose chord symbols” check box, choose the desired transpose options, and Apply.

Hiding chord symbols
Chord symbols can be dragged freely within the score; hold the Shift key to constrain the drag horizontally or vertically, as described in “Shift-drag to constrain” on page 277.

The arrow keys can also be used to nudge the selected chord symbol up, down, left, or right.

Chord symbols preferences
The Preferences window has a Chord Symbols pane to specify the default text style and tabbing behavior.

Apply To Score
The Apply To Score button applies changes made in the Chord Symbol preferences to the current project’s score.

Setting preferences from existing chord symbol
The Commands window (Setup menu) includes a Use Chord Symbol Settings as Prefs command. If you select a chord symbol and invoke this command, the font, size, style and vertical offset settings for the selected chord symbol are copied into the Chord Symbol preferences for use by all new chord symbols.

This command is available only when you have a single chord symbol selected.

Setting preferences on-the-fly
Hold down the Control/Win key while dragging a chord symbol to set the resulting vertical offset of the chord symbol in the Chord Symbol preferences, which will be used by all new chord symbols.

INSERTING A STAFF BRACE OR BRACKET
The Staff Brace and Bracket tools in the Notation Editor Tool Palette (Figure 18-13 on page 129) allow you to add and remove staff braces and brackets as desired to a staff system. Each staff can display—or be grouped by—one brace, one bracket or both. Each staff (track) remembers its brace/bracket status when you show or hide it. It might be useful to think of staff braces and brackets as an attribute of each staff that can be toggled on or off, rather than thinking of the brace...
or bracket as an object. With this in mind, below is a summary of how to add and remove brackets and braces:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a brace or bracket to a single staff or grand staff</td>
<td>Click the staff with the Brace or Bracket tool.</td>
</tr>
<tr>
<td>To remove a brace or bracket from a single staff or grand staff</td>
<td>Click the staff with the Brace or Bracket tool.</td>
</tr>
<tr>
<td>To add a brace or bracket to several adjacent staves</td>
<td>Drag over them with the Brace or Bracket tool.</td>
</tr>
<tr>
<td>To remove a brace or bracket from several adjacent staves</td>
<td>Drag over them with the Brace or Bracket tool.</td>
</tr>
</tbody>
</table>

**THE DYNAMICS PALETTE**

To open the Notation Editor Dynamics Palette (Figure 18-1 on page 117), choose it from the Notation Editor menu. This palette allows you to insert standard dynamic symbols, including hairpin crescendos and decrescendos.

**Dynamic symbol placement**

Dynamic symbols are associated with the nearest staff (track). If you show and hide the track, the dynamic symbol will show and hide with its track. When you insert or move a dynamic symbol, make sure it is closest to the track and measure to which it applies. In regards to time, dynamic symbols are associated with and remain at the measure and time location at which you place them, except as noted in the next section when moving them together with notes.

**Working with dynamic symbols**

Below is a summary of how to work with dynamic symbols:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To insert a dynamic symbol</td>
<td>Click the desired symbol in the palette and then click on the page.</td>
</tr>
<tr>
<td>To insert a crescendo/decrescendo</td>
<td>Click the Crescendo or Decrescendo tool and then either click or drag on the page.</td>
</tr>
<tr>
<td>To select one or more dynamic symbols</td>
<td>Use the same Pointer tool selection techniques as described in “Selecting notes for editing” on page 132.</td>
</tr>
<tr>
<td>To move a dynamic symbol</td>
<td>Drag it with the Pointer tool.</td>
</tr>
<tr>
<td>To duplicate a dynamic symbol</td>
<td>Option/Alt-drag it.</td>
</tr>
<tr>
<td>To move a dynamic together with notes</td>
<td>Select both with the Pointer tool and then drag the selected notes.</td>
</tr>
<tr>
<td>To copy and paste dynamic symbols</td>
<td>Select them (as described above), copy, click at the desired location to place the insertion cursor, and paste.</td>
</tr>
<tr>
<td>To copy and paste dynamic symbols together with notes</td>
<td>Select them both with the Pointer tool, copy, and then paste the notes as explained earlier in “Cutting, copying &amp; pasting notes” on page 132.</td>
</tr>
<tr>
<td>To adjust the shape of a crescendo or decrescendo</td>
<td>See “Adjusting a hairpin crescendo/decrescendo” below.</td>
</tr>
<tr>
<td>To remove a dynamic symbol</td>
<td>Click it with the Pointer tool to select it and the press the delete key.</td>
</tr>
</tbody>
</table>

**Adjusting a hairpin crescendo/decrescendo**

You can adjust the length and angle of a hairpin crescendo or decrescendo as shown below:

![Figure 18-18: Adjusting a hairpin crescendo or decrescendo.](image)
**Closing the Dynamics Palette**

To close the Dynamics Palette, uncheck it in the Notation Editor menu, or click the close button in its title bar.

**POPUP METER CHANGES, KEY CHANGES AND TEMPOS**

You can change meters directly on the score page using the Arrow tool as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change an existing meter</td>
<td>Click on it with the “4/4” cursor for a pop-up menu of options.</td>
</tr>
<tr>
<td>To add a meter change after a key change</td>
<td>Click on the right third of a key signature with the “4/4” cursor to get the meter change popup.</td>
</tr>
<tr>
<td>To add a meter change at a measure that has no key or meter change</td>
<td>Click on the barline itself with the “4/4” cursor to get the meter change popup.</td>
</tr>
</tbody>
</table>

Meter changes performed with the mouse always use the Only move barlines option (“Only move barlines” on page 446), and take effect until the next meter change. The metronome click value is set to the denominator of the time signature (except that for 6/8, 9/8 and 12/8 it is set to a dotted quarter note). For more options, use the Change Meter dialog in the Project menu> Conductor Track sub-menu.

**Popup Key Changes**

You can change keys directly on the score page using the Arrow tool as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change an existing key signature</td>
<td>Click on it with the “♯/♭” cursor for a pop-up menu of options.</td>
</tr>
<tr>
<td>To add a key change before a meter change</td>
<td>Click on the left third of a meter with the “♯/♭” cursor to get the key change popup.</td>
</tr>
<tr>
<td>To add a key change at a measure that has no key or meter change</td>
<td>Hold down the Option/Alt key and click on the barline itself to get the key change popup.</td>
</tr>
</tbody>
</table>

Key changes performed with the mouse take effect until the next key change. For more options, use the Change Key dialog in the Project menu> Conductor Track sub-menu. Note that popup key changes cannot be performed in the Film Cues only view, which does not display key signatures.

![Figure 18-19: Changing meter in the Notation Editor.](image)

![Figure 18-20: Changing key signature in the Notation Editor.](image)
**Popup Tempo Changes**

You can change tempo at the beginning of a measure directly on the page using the mouse. To do so, hold down the Control/Win key and click on any barline (or near the beginning of the first measure in a system) with the “bpm” cursor to get a simple Set Tempo dialog box.

![Set Tempo Dialog](image)

*Figure 18-21: Setting the tempo directly in the Notation Editor.*

Tempo changes performed with the mouse take effect until the next tempo change. For more options, use the Change Tempo dialog in the Project menu > Conductor Track sub-menu.

- Tempo changes that you enter in the Notation Editor are placed in the Conductor track. They display in the Notation Editor only if you have set Performer Lite’s main Tempo Control to Conductor Track as explained in “Tempo Controls” on page 92. Even then, only the tempo at the start of the first measure is displayed in the Notation Editor via the metronome marking — unless you have checked Show Film Cues in the Notation Editor menu. Then all tempos that don’t collide with other text in the Film Cues View will be shown in italics.

**WORKING WITH TEXT**

The Notation Editor Tool palette has several text items that let you enter titles and other text on the page, including page numbers and metronome markings.

Text is handled in a similar fashion to standard computer graphics programs. Text is placed on the page inside text boxes, which can be cut, copied, pasted, and otherwise edited. A text box is a resizeable, transparent box in which you can type and edit text. If you have worked with graphics software, you are already familiar with how to use text boxes in Performer Lite.

**Inserting text**

To insert text:

1. Scroll to the page on which you’d like to insert the text.

   If you are inserting title page text, scroll to the title page. If you’d like the text to appear on body pages, scroll to any body page.

2. Click the Text tool in the Tool palette (Figure 18-13 on page 129).

3. As a shortcut, if you want the text to be time-anchored text (see “Time-Anchored Text” on page 139), hold down the Control/Win key.

4. Drag out a text box on the page.

5. Choose the desired font, point size, style, justification, and display properties from the Text menu. For details about the Display text attribute, see the next section, “Choosing where to display text”.

6. Type the desired text.

7. Click anywhere outside the text box to complete the text entry.
Choosing where to display text

The display sub-menu (in the Text menu) provides several ways to control where text appears in your score. Here is a summary:

<table>
<thead>
<tr>
<th>Display menu item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>This page only</td>
<td>Text only appears on the page on which it is entered.</td>
</tr>
<tr>
<td>Title page only</td>
<td>Text only appears on the first page of the score.</td>
</tr>
<tr>
<td>Body pages only</td>
<td>Text only appears on body pages (all pages except the first page).</td>
</tr>
<tr>
<td>Both title &amp; body pages</td>
<td>Text appears on all pages.</td>
</tr>
<tr>
<td>Time anchor left/center/right</td>
<td>Text is anchored to the linear measure where it is inserted.</td>
</tr>
<tr>
<td>On linear score only</td>
<td>Text only appears when the Show Arranged Score menu item is unchecked.</td>
</tr>
<tr>
<td>On arranged score only</td>
<td>Text only appears when the Show Arranged Score menu item is checked.</td>
</tr>
<tr>
<td>On These Parts Only</td>
<td>Text only appears when one or more of the checked tracks in this submenu are showing in the Notation Editor.</td>
</tr>
<tr>
<td>On Single Part Only</td>
<td>Text only appears when a single part (track) is showing in the Notation Editor. When two or more tracks are visible, the text box will not appear.</td>
</tr>
</tbody>
</table>

The first two groups of items in the Display menu are mutually exclusive: either the text box is time-anchored in some way, or it is set to appear on title page/body pages/both. The last four items in the Display menu (linear or arranged score visibility; on specific track[s] or on single part displays) can be used with either type of text box.

Time-Anchored Text

Time-anchored text boxes stay with the measure where they are inserted. If the Notation Editor display changes in such a way that the measure moves to a different location on the page — or to a completely different page altogether — the text will stay with the measure. For example, if you change the measure spacing of the score, the text will move with the measure. Time-anchored text sticks to a particular time within a linear measure. If you “hide” a linear measure that contains time-anchored text (see “Hiding, extracting and moving measures” on page 145), the text will become invisible until the linear measure containing that time is made visible again.

Time Anchored Text will adjust its horizontal position on the page when notes are added or removed, or when anything else happens that changes the position and size of measures on the page. If the time-anchored text is not associated with a particular track (see “On These Parts Only” below), then its vertical position will always be a constant distance from the top of the system in which it appears. If the time-anchored text is associated with a particular track, then its vertical position will always be a constant distance from the top of the first staff for that track.

Time-anchored text is good for entering the names of chords over the top of each system, and for adding arranged score directions and labels like To Bridge, To Coda, and ritard. Time-anchored text that is also associated with a specific track can be used to enter textual directions that apply only to the performance of a specific part, or symbols that you want to attach to specific notes within that part.

Time-anchored text can be shown or hidden with the Show time-anchored text option in the Score Options dialog. See “Showing/hiding time-anchored text” on page 124.

On These Parts Only

When one or more of the items in this sub-menu are checked, the text box will appear only when one or more of the checked tracks are showing in the Notation Editor. You can associate a text object with as many tracks as you’d like.
On Single Part Only
When this Display sub-menu item (in the Text menu) is checked, the text box will appear only when a single part (track) is showing in the Notation Editor. When two or more tracks are visible, the text box will not appear.

If both On “Track-1” Only and On Single Part Only are checked, then the text box will appear only when Track-1 is the only track showing.

Making titles, headers and footers
Titles, headers, and footers are inserted in the manner described in “Inserting text” on page 138. Just choose the appropriate Display attribute in the Text menu.

If the Title page only and Body pages only menu items are grayed out, check the First page is title page option in the Score options command located in the notation view menu. For more information about this option, see “Creating a title page” on page 123.

Making page numbers
Page numbers are inserted using the Page Number tool (Figure 18-13 on page 129). Using this tool, insert them in the same manner as described in “Inserting text” on page 138. The page number automatically appears in the text box. Be sure to choose the appropriate Display attribute (Body pages only or Both title & body pages). See “Choosing where to display text” on page 139 for more information.

Displaying the current date
The current date can be inserted using the Date tool (Figure 18-13 on page 129). Using this tool, insert the date in the same manner as described in “Inserting text” on page 138. The current date (as specified by your computer) automatically appears in the text box. Be sure to choose the appropriate Display attribute (Body pages only or Both title & body pages).

Selecting text
To select an entire block of text, click it once with the Pointer tool. Handles appear to indicate that it is selected.

To select individual words within a text box:

1. Double-click the text box with the Pointer tool, or click once on it with the Text tool.

2. Select the desired text by dragging over it.

To select multiple text boxes, hold the Shift key while clicking on each text box, or make a lasso selection with the Pointer tool.

After text is selected, it can be cut, copied, or deleted. You can also change the font, style, and other attributes of the text.

Moving page text
Page text objects can be dragged freely within the score; hold the Shift key to constrain the drag horizontally or vertically, as described in “Shift-drag to constrain” on page 277.

The arrow keys can also be used to nudge the selected page text object up, down, left, or right.

Typing and editing text inside a text box
To edit text, double-click it with the Pointer tool (or click once with the Text tool) to get an insertion cursor inside the text box. After you have an insertion cursor inside the text box, use the following actions to edit the text:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the text cursor within the</td>
<td>Press the arrow keys</td>
</tr>
<tr>
<td>text box</td>
<td></td>
</tr>
<tr>
<td>Delete a character</td>
<td>Position the cursor to the right of it</td>
</tr>
<tr>
<td></td>
<td>and press the delete key</td>
</tr>
<tr>
<td>Select a word</td>
<td>Double-click the word</td>
</tr>
<tr>
<td>Select several words or sentences</td>
<td>Drag over them inside the text box</td>
</tr>
</tbody>
</table>
You can copy text from a text editing program such as Microsoft Word and then paste it into a text box in the Notation Editor. Just copy the text from the other program, switch into Performer Lite, double-click or insert a text box, and then paste.

Changing text attributes
Text attributes like point size, style (bold, italic, etc.), justification (left, center, or right), and display properties (title page only, time anchored, arranged score versus linear score, etc.) can be changed after text has been entered.

To change the attributes of an entire text box, click the text once with the Pointer tool to select it. Then choose the desired attributes in the Text menu. This works for staff names, staff abbreviations, measure numbers and marker text as well.

To change the attributes of individual words within a text box:

1. Select the desired text as described in “Selecting text” on page 140.

2. Choose the desired text attribute from the Text menu.

3. Click anywhere outside the text box to complete the edit.

Installing fonts in the Text menu
The fonts that you see in the Text menu are the fonts that you have installed in your computer system. If you are not familiar with how to install text fonts in your computer system, refer to your computer documentation.

When troubleshooting font problems in Performer Lite, determine if the problem occurs in a word processor program, or other programs that deal with text. For example, if you can’t find a font that should be in the list, check the font list in your word processor. Most likely, it will be missing there, too, and you then know that the problem lies somewhere in the computer system.

LYRICS
Lyrics can be added to your score in the Notation Editor.

Entering lyrics for a single track
To enter lyrics for a single track, choose the Lyric Text tool in the Notation Editor tool palette and then click on or below the desired note. Alternatively, assign a keyboard shortcut to the Enter Lyric command (Setup menu> Commands) and press the keyboard shortcut to enter a lyric below the selected note (or, if there is no selection, below the note nearest to the playback wiper).
An empty lyric text box will appear, ready for you to type in:

![Figure 18-23: An empty lyric text box](image)

Type a single word or syllable in the empty box. To advance the edit box to the next note, press the space bar to start a new word, a dash ( - ) to enter another syllable in the current word, or an underscore ( _ ) to extend the current word or syllable to the next note. (Note, however, that you don’t have to add underscores for a syllable that extends across tied notes — underscores are added automatically beneath tied notes when you hit the space bar to go to the next non-tied note.)

To dismiss the lyric text box, press Enter or Return to confirm, or Escape to cancel.

**Entering lyrics shared by multiple tracks**

Lyrics can be associated with two or more tracks. For example, in a SATB choral score (Soprano, Alto, Tenor and Bass), you might have lyrics that are shared among the Tenor and Bass parts (tracks) for a portion of the score, or perhaps shared by all four parts. You can freely choose which parts the lyrics are associated with, at any time. For example, the four SATB parts might have individual lyrics for some sections of the score and shared lyrics for other sections of the score. You have complete control over which parts (tracks) the lyrics are associated with.

If you wish to associate lyrics for multiple tracks when first entering the text, simply select a note in each track at the location where you want the shared lyric text to begin, and then either click with the Lyric Text tool or press the Enter Lyric command keyboard shortcut, as usual. An empty lyric text box will appear, but its vertical position below (or between) the shared staves will be governed by the Lyrics Preferences. See “Lyrics placement” on page 143.

**Working with shared lyrics**

Lyric text that is shared among several staves, will appear with each staff that it is linked with, whether the staff is displayed by itself or together with shared tracks.

If you have existing lyric text on the page, and you would like to see which tracks it is linked with, click the lyric text box with the Arrow cursor to select it and choose *Text menu > Display > On These Parts Only*. Tracks with check marks next to their names are linked to the lyric. Choose any track from this sub-menu to toggle its checked/unchecked status. Doing so will link/unlink the track to the lyric text, respectively.

You can freely assign and unassign lyric text to any track or tracks using the *On These Parts Only* sub-menu as explained above.

**Editing lyric text**

To edit existing lyric text, double-click the lyric. While the lyric text box is selected for editing, you can press Tab or Shift-Tab to advance to the next/previous lyric. Tabbing will go to the next or previous lyric that is linked with that same track or tracks. Be sure to keep this in mind when you are working on a section of a score that has lyrics linked to different tracks, as tabbing may not necessarily jump to the very next, adjacent lyric text box if it is not linked to the same tracks as the current text box.
Erasing lyrics
To erase lyrics, use the Arrow tool to select the desired lyrics in the Notation Editor and press the Delete key or choose Erase from the Edit menu.

Copying and pasting lyrics
Lyrics are not MIDI events; rather, they are a special kind of page text. Therefore, they will not copy along with notes if you cut and paste sections of the notes themselves. You can, however, easily copy and paste them separately. After you paste the notes, copy the original lyrics and paste them beneath the copied notes.

Hiding lyrics
To temporarily hide lyrics, deselect “Show Lyrics” in the Notation Editor menu.

Lyrics in an arranged score
You can enter lyrics into a linear score and then arrange it. Once arranged, lyrics for verses will automatically stack on top of each other in verse sections. You can also arrange the score first, and then Auto Flow into the arranged score. In that case, the Auto Flow algorithm still flows the lyrics into each linear measure in turn, stacking the lyrics as needed in the second, third, etc. pass through the repeated sections.

Lyrics preferences
The Preferences window in the Performer Lite menu (Mac OS) or Edit menu (Windows) has a Lyrics pane to specify the default text style, placement, and syllable extension behavior of lyrics.

Lyric text style
Options are provided to specify the font, size, and style of lyric text on the page.

Lyrics placement
Various options specify the placement of lyric text on the page.

- When specifying a vertical offset between two staves or tracks, the offset is the distance beneath the top staff or track.

Syllable extensions
By default, syllables are extended by underlining, but you can alternatively put a dash under each note.

Apply To Score
The Apply To Score button applies changes made in the Lyrics preferences to the current project’s score.
**SCORE ARRANGEMENT**

The Notation Editor arrangement view is shown by selecting *Show Arranged Score* from the Notation Editor menu. The purpose of this view is to collapse a linear score into a compact arrangement using repeats, endings, and score jumps like D.S. al Coda. When you add a repeat in the arrangement view, it does not change the playback of the piece: it just changes the look of the score and changes where the wiper goes during playback (and makes your notation more readable when you print it).

In a linear score, measures are displayed consecutively as demonstrated below:

![Figure 18-25: A linear score.](image)

In an arranged score, you use repeat barlines, endings, and other similar arrangement symbols to condense the score. For example, when a repeat happens, the continuous linear measures are folded back on themselves, like a ribbon, for the length of the repeated section:

![Figure 18-26: In an arranged score, linear measures are folded back like a ribbon to share arranged score measures.](image)

If, in the example above, we made the repeat a 2x (“two times”) repeat, meaning that you repeat twice instead of just once, the linear measures would flow through the arranged score like this:

![Figure 18-27: In this example, the repeat is taken twice, so measures 5 and 6 are included in the repeat, and therefore fall in measures 1 and 2 of the arranged score.](image)

Figure 18-28 below shows an arrangement that has a repeat followed by first and second endings, along with how this would look in the arranged score.

**Linear bars and Arrangement bars**

A *linear bar* number is the number of the bar from the beginning of the unarranged piece, the number of the bar that appears in the global counter, and the number of the bar in every other editing window in Performer Lite. Every bar of music has a unique linear bar number. The first bar is linear bar 1.

An *arrangement bar* number is the number of the bar in an arranged score. Each arrangement bar will be associated with one or more linear bars. In other words, if your chorus is visited three times during playback, then each bar of the chorus will have a single arrangement bar number, but will be associated with three different linear bar numbers.

**Showing alternate bar menus**

When working on an arrangement, you should turn on *Show Alternate Bar Menus* in the Notation Editor menu. This displays a small pop-up menu next to the regular measure number on the page:
Figure 18-29: Showing alternate bar menus.

The alternate bar menu shows all of the linear bars that are currently associated with an arrangement bar. In the example above, arrangement bar 2 will be visited four times during playback: when the counter reaches linear bars 2, 4, 19 and 21. The checked item is the linear bar whose data is currently being shown. The rest of the associated linear bars are hidden.

When working on an arrangement, also be sure that Show measure numbers is turned on (Notation Editor menu > Options > Measure Numbers) and that they are set to display on every measure.

Figure 18-28: Above, linear bars are condensed into an arranged score with a repeat, combined with first and second endings. Below, this same example is shown as it would appear in the Notation Editor, except that the alternate bar menus have all been opened simultaneously to show you which linear bars reside in each arranged score measure.

Hiding, extracting and moving measures

Most of the tools for arranging a score simply make cosmetic changes to it. There are only four operations that cause the wiper to jump around on the score during playback. One of them is rest consolidation, which will be discussed later. The other three all appear under Edit Selected Measures in the Notation Editor menu:

When you “Hide” a measure behind another measure, it disappears. But when playback reaches a hidden linear bar number, the wiper will jump to the bar where you “hid” it, and wipe over that bar while playing the hidden linear bar. Use this feature to “hide” the second or third instance of some repeated measures behind the first instance, or to hide the second or third verse measures behind the first verse measures.

Figure 18-30: Use these commands to hide, extract and move measures in the arranged score.

Hide

| Arranged score bars: 1 2 3 4 5 6 7 8 |
| Linear score bars: 1 2 3 4 5 6 7 8 |
| Track-1: 1 2 3 4 5 6 7 8 |
To hide a measure:

1. Make sure that **Show Arranged Score** is enabled in the Notation Editor menu.

2. Turn on **Allow Measure Selection** in the Notation Editor menu.

3. Click the Pointer tool in the Notation Editor tool bar.

4. Click anywhere in the measure you wish to select. Shift-click to select two or more measures.

   You cannot hide a measure which contains hidden measures itself, so be sure to select a measure that has none.

5. Choose **Edit Selected Measures > Hide**.

   You will be asked where you want to hide the measures. You must specify an arrangement measure location as the destination.

   After you click OK, the selected measures will be hidden in the arrangement measures you specified. You can view them by choosing them from the alternate bar menu in that measure, as demonstrated below.

   ![Figure 18-32: Choosing a destination for the hidden measures.](image)

   **Figure 18-32:** Choosing a destination for the hidden measures.

   **Displaying hidden measures does not change playback**

   Note that when you hide a measure behind another measure, you do not change playback. If you have linear bars 2 and 4 associated with arrangement bar 2 in your arranged score, you can choose either linear bar as the representation that you want to see for that bar (as demonstrated in Figure 18-33). But choosing a linear bar for display purposes does not mean that those notes are going to play every time through the bar. The hidden linear bars always play exactly as recorded when it is their turn to play. The wiper will wipe over whatever representation is on the screen for that bar, but the performance of linear bars 2 and 4 will happen exactly as recorded regardless of what is on the screen (and on the printed page).

   **The Hide measures in sequential bars option**

   If the **Hide measures in sequential bars** option is unchecked, then all of the measures that you have selected will be hidden in the destination bar you choose. For example, if you’ve selected bars 7, 8 and 9, and you choose bar 1 as destination bar to hide them in, they will all go into bar 1. However, if the **Hide measures in sequential bars** option is checked, then bars 7, 8 and 9 will be hidden consecutively in bars 1, 2 and 3.
Locating hidden linear measures
To quickly locate a hidden linear measure, try entering that measure number in the global counter and hitting play. The wiper will jump to the arrangement measure where that linear measure is hidden. You can then select the hidden linear measure from the alternate measure popup next to the measure number in order to see it and edit its data. You can also use the Pop Out command (explained below) to extract it from that arrangement measure.

Pop Out
*Pop Out* is the opposite of *Hide*. If you select an arrangement bar that contains more than one linear bar, the Edit Selected Measures> Pop Out command (Figure 18-30 on page 145) extracts the currently visible linear bar and places it just to the right of the arrangement bar you selected. After being liberated, you can then move the popped-out bar anywhere in the score (such as its original linear position).

Moving measures
*Edit Selected Measures> Move* (Figure 18-30 on page 145) allows you to position a selected measure anywhere in the score. You will be asked where you want to move the selected measures, and you specify an arrangement measure location. This command is seldom needed, but will become necessary sometimes when you have multiple endings in a score, with other sections (like a bridge) occurring in between. After you finish collapsing the score, you may find that your bridge lies between your second and third ending, and the only way to get all of the endings together is to move the third ending measures just after the second ending measures.

A suggested approach to hiding measures
In general, when building an arrangement you want to start at the beginning of the piece and proceed forward. As soon as you encounter a measure that is another instance of a previously played measure, hide that measure under the previous instance. Later, you can use the alternate measure menu to select which linear measure instance is the best representation of the notation for a given arrangement measure.

The Arrangement palette
To open the Notation Editor Arrangement palette, choose it from the Notation Editor menu. The Notation Editor Arrangement palette contains tools that work only when you have selected *Show Arranged Score* from the Notation Editor menu, except for the Time-Anchored Text tool, which can be used in the linear score view as well.

![Figure 18-34: The Arrangement palette.](image)

Selecting any of these tools changes your cursor to an image of the tool, and allows you to click on the score to do something.

**Begin Repeat:** Click near a barline to enter a begin repeat. Click near the barline again to remove a begin repeat.

**End Repeat:** Click near a barline to enter an end repeat. Click near the barline again to remove an end repeat.

**Fine Bar:** Click near a barline to select where the Fine bar should go. There can only be one Fine Bar in the score, so if it is already present in a score, clicking with this tool will move the Fine Bar to where you click.

**Thin Double Barline:** Click near a barline to enter a thin double barline. Click near the barline again to remove a thin double barline.
Endings: Click and drag over a number of sequential measures to create an ending bracket. To extend an existing ending, hold down the Shift key and drag in the measures after the existing ending. (This is especially useful if an ending needs to extend across a page break.)

![Figure 18-35: A first and second ending.](image)

To adjust the height of an ending, uncheck Allow Measure Selection and then drag it vertically with the arrow tool. All ending brackets in the score are adjusted.

To edit the ending number, or change its font or style, uncheck Allow Measure Selection and then click the ending number with the Arrow tool.

To remove the vertical bar at the right-hand edge of the ending, click the ending with the Arrow tool to select it and choose Open Selected Ending Bracket from the Notation Editor menu.

To get rid of an ending, click it with the Arrow tool to select it, and press the delete key.

D.C.: Click on the page to enter time-anchored text that says “D.C.”. You can set the font, size, style, etc. of the text as described earlier in this chapter.

Segno: Click on the page to enter a time-anchored Segno symbol.

D.S.: Click on the page to enter time-anchored text that says “D.S.”. You can set the font, size, style, etc. of the text as described earlier in this chapter.

Double Segno: Click on the page to enter a time-anchored double Segno symbol.

D.S. S.: Click on the page to enter time-anchored text that says “D.S.S.”. You can set the font, size, style, etc. of the text as described earlier in this chapter.

Coda and Double Coda: Click on the page to enter a time-anchored coda or double coda symbol.

Consolidated Rest tool
Click an empty measure to consolidate it with another empty measure just to the right of it. To unconsolidate one measure within a consolidated rest, hold down the Control/Win key while clicking with this tool.

![Figure 18-36: Consolidated rests in an arranged score.](image)

The Consolidated Rest tool makes small changes to a specific consolidated rest, whereas the Consolidate/Unconsolidate Rests commands in the Notation Editor menu make changes to all consolidated rests in the visible tracks. These operations change the pattern of consolidated rests for all tracks currently visible. However, if a track is already set to consolidate rests in a certain way with the Consolidate Rest tool, it will continue to prefer that setting when it is shown by itself or in combination with other tracks. This makes it possible to customize rest consolidation for each part individually, but still control the way rests consolidate when a specific combination of tracks are shown.

Consolidated rests automatically break at meter changes.
Time-Anchored Text tool
Use the Time-Anchored Text tool in the Arrangement palette just like the normal text box tool in the main Notation Editor tool palette. However, this tool creates a text box that is anchored to a time in the score. For details, see “Time-Anchored Text” on page 139.

Use the Text menu in the main menu bar to select whether the time anchor is at the left, center or right of the text bounding box. You can also choose whether you want your time-anchored text to appear in the arranged view, the linear view, or both, and whether it should appear only when a certain track is showing, or when any single track is showing.

The Time-Anchored Text tool is just a convenience. You can actually create either type of text box with either text tool with these shortcuts:

- If you are using the normal Text tool, hold down the Control/Win key to enter time-anchored text.
- If you are using the Time-Anchored Text tool, hold down the Control/Win key to make normal text.

DISPLAY-ONLY AND PLAYBACK-ONLY NOTES
There may be times when you wish to hide notes in the Notation Editor, but still hear them play back. For example, you may have played a grace note or other performance-related material that wouldn’t normally be written as notation.

Conversely, you may sometimes wish to display notes in the Notation Editor that don’t play back, such as cue notes for individual instrument parts, or simplified notation for an embellished performance.

The Notation Editor menu lets you specify notes as playback-only (hidden) notes or display-only (silent) notes. Just select the notes and then choose Playback-only or Display-only from the Notation Editor’s Change Selected Notes to menu command.

To change notes back to normal notes (i.e. they appear in the Notation Editor and play back), choose Change Selected Notes to> Normal. If the notes are hidden (Playback-only), you’ll need to display them in order to select them and turn them back into normal notes.

Figure 18-37: Above: the two circled notes will be turned into Playback-only notes.

Split Selected Normal Notes
The Split Selected Normal Notes menu command operates only on those selected notes that are normal. A normal note is a note that is not set to be display-only or playback-only. This command replaces each selected normal note with two copies of itself: a playback-only copy and a display-only copy. The purpose of this command is to make it easy to start editing the appearance of a measure without changing the playback of the measure. After issuing this command, you can then edit the display-only notes without affecting the (now hidden) playback-only notes. Just make sure that playback-only notes are set to be hidden (their Display sub-menu item is unchecked).
Finding hidden notes
If there is a note in the track that is not showing up in the Notation Editor, then one of the following is happening:

- The note is being hidden from the Notation Editor display due to the Ignore Mistakes settings in the Score Options dialog.
- The note has been designated as a playback-only note, and playback-only notes are currently being hidden (the Notation Editor menu > Playback-only Notes > Display setting is unchecked).
- The note has been designated as a display-only note, and display-only notes are currently being hidden (the Notation Editor menu > Display-only Notes > Display setting is unchecked).
- The note is in a linear measure that has been hidden using the Edit Selected Measures > Hide command in the Notation Editor menu, and the linear measure is currently not being used to represent the arrangement measure to which it belongs. To view it, choose the measure from the alternate measure menu. If you can’t find the hidden measure, see “Finding hidden notes” on page 150.

FILM CUES VIEW
The Notation Editor can display film cues in a manner familiar to film composers. To see this view, open the Notation Editor and choose Show Film Cues from the Notation Editor menu.

When Show Film Cues is checked, the Notation Editor includes an extra area of film cue information above the top staff in every system, as shown in Figure 18-38.

Tempo changes
As shown in Figure 18-38, the top line of information in this view (50.00, 40.00, 50.00) shows tempo changes in Beats Per Minute (BPM) in italic text.

Beat location
The next line of information in Figure 18-38 (B1.00, B4.08) shows the beat location of a cue point (marker), accurate to hundredths of a beat. These numbers appear only where a cue point falls within a measure. It is displayed with the same color as the cue point text. In addition, beat location times are appended with a + or - sign if their associated cue point is late or early, in relation to the closest beat or half-beat. The hit range settings in the Markers window for the cue point’s marker are considered when determining whether or not a cue point is hitting a beat or half-beat.

Figure 18-38: Notation + Film Cues view.
Measure start time
The next line in Figure 18-38 (0:00.00, 0:03.60, 0:09.30, etc.) shows the time at the start of each measure in minutes:seconds:hundredths of a second.

Beat number
Also at the beginning of each measure in Figure 18-38, two integers are displayed. The number above the horizontal line is the beat number from the beginning of the sequence. The number below the horizontal line is the measure number from the beginning of the sequence.

Beat marks
Each measure in Figure 18-38 shows a small “x” where the beats lie in the measure. If a cue point lies within the measure, then the nearest beat to the cue point is marked with a bold “X”.

Cue points
The Film Cues view uses markers as cue points, as demonstrated below in Figure 18-38 by the words WS Swamp and Arial Swamp. To create or edit markers, choose Project menu> Markers. For complete details, see chapter 47, “Markers” (page 425). This section covers the specifics of marker operation with regard to the Film Cues View.

Markers appear in the same measure as their closest beat. By default, the Film Cues View does not display any marker whose weight is set to None in the Markers window. To change which types of markers appear on the page, use the Marker Options window. If the weight of a marker is set to Very Important, it appears in red. Use the Very Important weight to indicate markers that are key hits.

Three different Notation Editor views
Performer Lite maintains a separate set of score options for three separate views:

<table>
<thead>
<tr>
<th>View</th>
<th>How to view it</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Notation</td>
<td>Uncheck the Show Film Cues menu item</td>
</tr>
<tr>
<td>Notation + Film Cues</td>
<td>Check the Show Film Cues menu item and display one or more staves in the Notation Editor using the track selector.</td>
</tr>
<tr>
<td>Film Cues Only</td>
<td>Check the Show Film Cues menu item and hide all staves in the Notation Editor using the track selector.</td>
</tr>
</tbody>
</table>

Film Cues Only view
If you use the track selector in the Notation Editor to turn off all tracks, and if you have selected Show Film Cues in the Notation Editor menu, then you will see a trackless Film Cues Only view shown below in Figure 18-39.

In the Film Cues only view, you can use the popup meter change and popup tempo change features described in “Popup Meter Changes, key changes and tempos” on page 137, but not the popup key change feature. Key signatures do not display in this view.

Figure 18-39: Film Cues Only view.
Default Options in the Film Cues Views
When you choose Show Film Cues for the first time in a document, Performer Lite will set the following default viewing options for optimal appearance:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Notation plus Film Cues</th>
<th>Film Cues only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Score options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show rest in empty measures</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Show tempo above first measure</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Tempo mark pixel offsets</td>
<td>V = -4</td>
<td>V = -43</td>
</tr>
<tr>
<td>(first measure)</td>
<td>H = -18</td>
<td>H = -20</td>
</tr>
<tr>
<td>Measure numbers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show measure numbers</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>Measure spacing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space measures _ per line</td>
<td>On 6 per line</td>
<td>On 6 per line</td>
</tr>
<tr>
<td>Marker options</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show markers</td>
<td>On 5 legers above system</td>
<td>On 2 legers below system</td>
</tr>
<tr>
<td>Measure time, real time, frame</td>
<td>Off, off, off</td>
<td>Off, off, off</td>
</tr>
<tr>
<td>time</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show markers with weights</td>
<td>All except markers</td>
<td>All except markers</td>
</tr>
<tr>
<td></td>
<td>weighted None</td>
<td>weighted None</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can change these options, and any other score options that you wish, in order to adjust the Film Cues view to your liking. Remember only that Show Markers must be turned on (Marker Options window) in order to see the names of your cues.

Changing the height of the Film Cues staff
You can change the height of the Film Cues staff simply by dragging it up or down. The staff height will be the same for every system in the document.

Figure 18-40: Adjusting the height of the Film Cues staff.

PRINTING
The following sections explain the procedure for various common printing tasks.

Printing instrument parts
To print instrument parts:

1. Use the Track Selector list (Figure 18-1 on page 117) to display a single track (instrument), and then format the page as desired (system margins, text, track name, etc.) as described in this chapter. To display the track name in front of the staff as the instrument name, use the Part Names option in the Score Options menu command.

2. Use the Track Selector to show all tracks that you wish to print as individual parts.

3. Choose Print Individual Parts from the Notation Editor menu.

Each track currently being displayed in the Notation Editor will be printed by itself using the formatting you arranged in step 1.

Preserving formatting for individual parts
If you want to preserve the Notation Editor formatting separately for each track, you can do so by copying each track into its own separate sequence. Since each sequence has its own separate Notation Editor, each part will be preserved.
Print Individual Parts and grouped tracks
When using Print Individual Parts with tracks which are a member of an active track group, the grouped tracks will print together, once for each track in the group. For example, if you have four horn parts grouped together and you print them with Print Individual Parts, you will get four copies, each showing all four parts.

This is useful when printing out a copy for each member of the group. However, if you have grouped tracks which will be played by a single player, such as the individual elements of a drum kit, suspend the track group before printing with Print Individual Parts, or use File menu > Print.

Printing a keyboard part on a piano staff
To print a keyboard track on a grand staff:

1. Use the Track Selector list (Figure 18-1 on page 117) to display the track.
2. Choose Track Options from the Notation Editor menu.
3. Choose the track that contains the keyboard part from the Track menu.
4. Uncheck the Use Default check box, if necessary.
5. Choose the Grand Staff from the staff type menu.
6. Set the spacing options as desired and click OK.
7. Set the Score Options, text, margins and other formatting as desired.
8. Choose Print from the File menu.

Printing a score
When you display multiple tracks in the Notation Editor, Performer Lite places them together in the same staff system. So, to print a score, use the Track Selector to show all tracks that you wish to include in the staff system for the score. To adjust the spacing between the staves in the system, as well as the spacing between systems, choose Score Options (Notation Editor menu).

Creating blank staff paper
To create blank staff paper:

1. Create one or more empty MIDI tracks.
2. Use the Track Selector to display the empty MIDI tracks in the Notation Editor.
3. In Score Options, disable the “Show rest in empty measures” option.
4. In Measure Spacing Options, choose Space measures _ per line and set the number of measures per line as desired.
5. If necessary, you can lengthen the tracks (and therefore the number of pages) by extending the length of the sequence. To do so, choose Notation Editor menu > Options > Set Score Length.

EXPORTING A MUSICXML FILE
MusicXML is an XML-based file format for representing Western musical notation. It is a proprietary file format developed by Recordare LLC that is fully and openly documented, and it can be freely used under public license. For further information, visit musicxml.com.

MusicXML can be used to export a Performer Lite score to other programs that support MusicXML importing, such as Finale™ and Sibelius™. For a list of music software applications that support MusicXML, visit musicxml.com/software.
What gets exported
Performer Lite exports the following elements of a score:

- Notation transcription, as it appears in the Notation Editor
- Key signatures
- Meter changes
- Dynamic markings
- Lyrics
- Transpositions
- Marker text
- Tempo changes (requires that the tempo source is set to Conductor Track)

As of this writing, the following elements are not exported, although future versions of Performer Lite may support these elements as well:

- Score arrangement markings (repeats, endings, etc.)
- Chord symbols
- Page text

Exporting a MusicXML file
To export a Music XML file, choose File menu > Export. In the resulting sub-menu, there are two MusicXML export commands.

Export > Selected Tracks As MusicXML: Exports the currently selected tracks, which can be selected in any edit window. If no tracks are currently selected, then all MIDI tracks are exported.

Export > Score As MusicXML: This command is only available when the Notation Editor is open, and it exports whatever is currently being shown in the Notation Editor.

Tips for exporting MusicXML
Importing MusicXML files into Sibelius, Finale or any program that imports this file format is a simple and straightforward process. The key to smooth transfers is preparing the score in Performer Lite to make sure all the information you require is included in the exported MusicXML file.

Here are some things to check before exporting a Performer Lite project as a MusicXML file.

Key signatures
It is easy to work in Performer Lite without specifying a key signature. Therefore, be sure to choose Project > Conductor Track > Change Key to place a key signature at measure one (and any other locations in the score where the key changes).

Tempos
Performer Lite will include all tempo changes as metronome markings in the MusicXML file. However, you must have the conductor track selected in Tempo Control Menu as your tempo source to have all your tempo changes included. If you have another source selected, it will only include a metronome marking on measure one of the exported MusicXML file.

Markers
Performer Lite will include all markers as staff text attached to the top staff of the exported score. You may find it helpful to go through your project and add markers at all the important points to make them easier to find when you import the MusicXML file into your notation program.

Instrument transpositions
The transposition of each track in the score is dictated by the transposition of the instrument’s staff in the score. If, for example, you have a trumpet staff set to C transposition in the score and B flat transposition in the part, the exported MusicXML file will use the C transposition (not B
flat). If you require the trumpet to be in B flat, you will need to change the staff to B flat transposition in the score before exporting. Alternately, you can change the instrument definition in your notation program after you import the MusicXML file.

**Selecting which tracks to include**
You may have a project with many tracks that do not need to be included in the exported MusicXML file, such as key switch control tracks, synth tracks, etc. In this case, go to the Sequence Editor, select only the tracks you wish to export and use the *Export* > *Selected Tracks as MusicXML* command.

If you have tracks organized into track folders, you can select a folder (or folders) and just those tracks will be included in the exported MusicXML file.

**Importing MusicXML files into Finale**
Once you have exported your Performer Lite project as a MusicXML file, it can be imported into Finale 2014 (and several earlier versions) by following these steps.

- From the Launch window, click on the “IMPORT MUSICXML” button. Locate the MusicXML file you have exported from Performer Lite on your hard drive and click the open button.
  
or

- Go directly to the File menu and select *Import* > *MusicXML*. Locate the MusicXML file you have exported from Performer Lite and click the open button.

Finale now opens the MusicXML file as Finale score.

**Importing MusicXML files into Sibelius**
Once you have exported your Performer Lite project as a MusicXML file, it can be imported into Sibelius 6, 7 or 7.5 by following these steps.

Sibelius opens MusicXML files the same way it opens Sibelius score files.

- From the Quick start window, click the *Open Other*... button in the lower left corner, locate the MusicXML file you have exported from Performer Lite on your hard drive and click the open button.
  
or

- Go directly to File menu bar, select *Open*, locate the MusicXML file you have exported from Performer Lite and click the open button.

The *Open MusicXML File* window appears. Here you can specify paper size, house style and instrument options. Explore these options and see what best fits your workflow. Generally speaking, the default settings with the house style you need for your project works well.

Sibelius now opens the MusicXML as a Sibelius score.
OVERVIEW
Performer Lite’s Mixing Board window provides a powerful integrated mixing environment for MIDI and audio tracks. It also provides access to real-time effects processing and virtual instrument plug-ins.

The Mixing Board will seem familiar because it is modeled after standard hardware consoles. Lurking under the hood, however, are many powerful features, as well as many time-saving shortcuts. This chapter covers them all.
Figure 19-1: The Mixing Board gives you a fully automated mixing environment.
Track Selector: Click or drag over the names of the tracks in this list to show or hide them in the Mixing Board. Option/Alt-click to hide all except the track you click; Command/Ctrl-click to show all except the track you click.

Show/Hide Track Selector: Shows and hides the list of tracks at the left side of the window.

V-Rack Edit: Toggles the Mixing Board between the currently play-enabled sequence and the last viewed V-Rack. Option/Alt-clicking this button toggles the “Show V-Racks” menu option.

Snapshot button: Takes a snapshot of the current mix automation settings of your choice for the tracks and time range you specify. The snapshot operation inserts mix automation events in each included track at the current main counter location. This can be done while Performer Lite is stopped or playing back.

Mix Mode menu: Lets you create and manage multiple mixes for a sequence. A mix consists of all of the volume pan and effects automation data in all tracks. You can duplicate a current mix and then modify it, or start from scratch by creating a new, blank mix. Volume and pan automation data for the current mix is recorded into tracks as usual with the Mixing Board controls, or with the other continuous controller features in Performer Lite. After you’ve created more than one mix, you can instantly switch between mixes by choosing them from this menu.

Insert Settings menu: Save, recall, and manage chains of inserts.

Track Insert Section: Displays real-time processing inserts for MIDI and audio tracks. Choose the desired effect from the insert. MIDI track inserts consist of MIDI processing effects such as the transposer and Change velocity. Audio inserts consist of plug-in effects, such as EQ, dynamics, reverb, delays, and any 3rd-party plug-ins you currently have installed in your system. You can change the number of inserts per track with the Set Number of Inserts menu item.

MIDI effects processors: MIDI effects processors are non-destructive, real-time output processors that affect the track’s playback. The choices include Shift, Quantize, Transpose, Change velocity, Echo and many others. These effects only affect playback and can be changed or turned off (bypassed) at any time. They do not modify the original data in the track.

Audio effects processors: These are real-time, non-destructive audio processing inserts that can be applied to audio tracks.

Audio track sends: Allow you to bus the track’s signal, either pre- or post-fader, to other tracks.

EQ and Dynamics: Provide visual feedback and quick-access control of each track’s EQ and dynamics plug-ins.

Solo/Mute/Rec/Input: These buttons perform standard solo, mute, record and input monitor enable functions. “Glide” horizontally across these buttons with the mouse to quickly toggle several tracks at once.

Automation: Enables playback and recording of automation data and sets the automation mode. For more information, see chapter 54, “Mix Automation” (page 462).

Pan: For MIDI tracks, the pan knob generates standard MIDI pan controller data (controller #10). Typically, this controls the panning of the MIDI track across the main stereo outputs of the MIDI instrument, although this depends entirely on the instrument. For audio tracks, the pan knob pans an audio track across its pair of outputs. For example, if a track is assigned to outputs 3 and 4,
pan hard left sends the track to output 3; pan hard right sends it to 4. Double-click the pan knob to go to pan center. If pan automation data has been recorded, knobs animate during playback (when the Automation play button is enabled).

**Faders:** Control volume for each MIDI and audio track by generating MIDI and audio volume events, which can be recorded into the track for automation. If automation data has been recorded, faders animate during playback (when the Automation play button is enabled). If the fader cap is missing, it means that the audio track has been disabled. See “Enabled” on page 60.

**Level Meters:** The level meters display the audio output level for each audio track. For MIDI tracks, the level meters indicate MIDI note-on velocities.

**Track I/O:** These menus give you direct access to each track’s input and output assignments. Instrument tracks and master faders don’t have inputs.

**Track name and assignment:** Double-click the track name to open the editor for the track. Drag it left or right to move the track in Mixing Board.

**Tracks:** Each strip in the Mixing Board represents a MIDI, audio, instrument, aux or master fader track in the currently play-enabled sequence. Show or hide them as desired using the Show/Hide Track Selector (described above). Drag the track strip name horizontally to re-order them.

### MIXING BOARD MENU

**Mixer section show/hide:** This section of the Mixing Board menu displays checkable menu items that show and hide each section of the console. Checked items are visible. Unchecked items are hidden. Hold down the Option/Alt key to hide all sections except the one you choose; use the Command/Ctrl key to show all sections except the one you choose. If the Auto Resize command is checked, the console window will automatically resize itself when sections are shown or hidden. You can use these options to customize your mixing board and save screen real-estate.

By default, sends are not shown. If you would like to use sends in your project, be sure to check ‘Sends’ in the menu.

**Use Narrow View:** When checked, this menu item reduces the mixer channels horizontally, enabling you to display more channels in the same space.

**V-Rack Edit:** Toggles the Mixing Board between the currently play-enabled sequence and the last viewed V-Rack. This is the same as pressing the V-Rack button in the lower left corner of the Mixing Board. See chapter 25, “V-Racks” (page 216).

**Show V-Racks:** Toggles the display of V-Rack tracks alongside your sequence tracks. See chapter 25, “V-Racks” (page 216).

**Enable Mouse Wheel for Sliders and Knobs:** When enabled, the mouse scroll wheel can be used to adjust the volume fader, pan knob, and other sliders and knobs; when disabled, the mouse scroll wheel only scrolls the Mixing Board window.

**Set Number of Effect Inserts:** Lets you determine the number of insert slots per channel. Up to 20 insert slots can be specified.
Automatically Add Inserts: When checked, the Mixing Board adds another row of inserts automatically when you fill the last (bottom-most) insert slot.

Set Number of Sends: Lets you determine the number of sends per channel. Up to 20 sends can be specified.

New Track Group: Lets you create a track group of any kind.

Attach MIDI Controller: Lets you connect a mixing board fader or knob to an external MIDI controller, such as a mod wheel. This includes send level knobs, send pan and send mute buttons.

Clear MIDI Controller: Removes the connection to an external controller from the knob or fader that you select with the cursor.

Min Time and Value Change: Allows you to set the minimum amount of time between volume and pan events that the mixing board controls will generate when you move them. Also lets you choose the minimum value change. Raising these values can prevent unnecessarily high data density. But raising them too high can result in zipper noise, or audible “stepping” during smooth changes.

MIXING BOARD WINDOW BASICS
The Mixing Board is a track-based mixing console for all MIDI and audio tracks. It has one strip for each track in the sequence.

Opening the Mixing Board
To open the Mixing Board, click it’s button in the Control panel (Figure 7-4 on page 41). If you have multiple sequences in the file, the Mixing Board shows the sequence that is currently play-enabled.

Showing and hiding tracks
Use the Track Selector (page 41) to choose which tracks you’d like to see in the Mixing Board.

Changing the order of the track strips
To move tracks left or right, drag them by their name at the bottom of the strip.

Showing and hiding sections
Use the section names at the top of the Mixing Board window menu to show and hide console sections, such as the Inserts section. Checked items are visible. Unchecked items are hidden. This allows you to optimize the console appearance for your screen size. Hold down the Option/Alt key to hide all sections except the one you choose; use the Command/Ctrl key to show all sections except the one you choose. If the Auto Resize command is checked, the console window will automatically resize itself when sections are shown or hidden.

Switching sequences
To quickly switch the sequence you are looking at in the Mixing Board window, change the play-enabled sequence.

Switching between sequences and V-Racks
To switch to a V-Rack, click the V-Rack Edit button in the lower left corner of the Mixing Board (Figure 19-1 on page 157) or choose V-Rack Edit from the menu to toggle the Mixing Board between the currently play-enabled sequence and the last viewed V-Rack. See chapter 25, “V-Racks” (page 216).

TRACK STRIPS
Each MIDI and audio track strip has the sections shown below in Figure 19-2 on page 162.

Inserts
An insert is a real-time effect that is non-destructively applied to the data in the track on playback. MIDI tracks can be processed with MIDI plug-ins (such as the transposer and velocity compressor) and audio tracks can be processed with audio plug-ins. Virtual instrument
plug-ins can also be inserted on the top-most insert of instrument tracks (see chapter 12, “Instrument Tracks” (page 67)).

Each insert slot in the track can hold one effect. To choose the desired effect plug-in for the insert, see “Choosing a plug-in for an insert” on page 161.

Up to 20 inserts can be simultaneously applied to an individual track, depending on how many inserts are configured with the Set number of inserts menu option. When you choose the desired effect plug-in for the insert slot, the Effects window opens to display the selected processor’s parameters. See chapter 56, “Effects Window” (page 488) for more information.

The signal for a track passes through the inserts from top to bottom. Accordingly, inserts are labelled A, B, C, etc. from top to bottom. Similar to hardware mixing consoles, the order in which effects are applied makes a difference, so keep this in mind when employing multiple inserts. Insert settings apply globally to the entire track and are remembered until you change them.

**Configuring the number of insert slots (audio tracks only)**
If you find yourself running out of insert slots, you can add insert slots with the Set Number of Effect Inserts command located in the Mixing Board menu. You can configure up to 20 inserts per channel.

If you place an effects plug-in in the last (bottommost) insert, another row of inserts will be added automatically. If you don’t want this behavior, uncheck the Automatically Add Inserts menu command.

**Configuring inserts as pre- or post-fader**
Performer Lite allows you to graphically configure inserts as either pre- or post-fader inserts with the pre/post fader divider line as shown below in Figure 19-3. Inserts above the line are pre fader. Inserts below the line are post fader. A pre-fader insert is applied to the signal running through the channel before it reaches the channel’s fader; similarly, a post-fader insert effect is applied to the signal after the channel’s fader.

You can grab the handle on either side of the pre/post fader divider to move the location of the divider in the inserts chain.

![Figure 19-3: Configuring pre- and post-fader effects with the pre/post fader divider line.](image)

**Be careful when boosting gain**
Some plug-ins provide volume controls of their own. By default, Performer Lite’s effects inserts are pre-fader, so it is possible to boost level above unity gain with a plug-in’s volume control. So be careful when setting levels for plug-ins that have been configured pre-fader.

**Choosing a plug-in for an insert**
For MIDI tracks, insert slots are menus. Simply choose the desired MIDI plug-in from the menu.

For audio tracks, click the insert slot to open the plug-in chooser (Figure 19-4). This window lets you quickly find the effect you are looking for, and you can then click Select to place it in the insert.

![Figure 19-4: The plug-in chooser.](image)
Figure 19-2: A Mixing Board track strip.
If an insert already holds a plug-in, right-click or Command/Ctrl-click the existing plug-in to open the plug-in chooser.

**Effects versus presets**
The plug-in chooser provides two buttons at the top, which let you browse plug-ins by name or by their presets. The window functions in a similar fashion, either way.

**Searching**
To search for a particular effect or preset, type its name into the search field above the list. All matches appear in the list.

**Folders and categories**
The left-hand list provides organized folders and categories for your effects plug-ins. Factory-supplied folders include Categories, Manufacturers, and Formats. Use the plus (+), minus (-) and folder buttons above the list to create your own. Or right-click anywhere in the list. User-created categories can be dragged into user-created folders. Folder can also be dragged into other folders to create hierarchical organization.

To organize your plug-ins, drag and drop them from the right-hand list into the categories in the left-hand list. Shift-click and Command/Ctrl-click to select and drag multiple plug-ins at a time.

The same organizational techniques apply to both effects plug-ins and presets.

You can also right-click in the right-hand list to access several shortcuts (Figure 19-6).

**Save As Menu Category**
When choosing plug-ins in the Mixing Board inserts, as a shortcut, you can right-click an insert to access a menu of the category you have designated as the *Menu Category*. To do, right-click the desired category and choose *Save As Menu Category* (Figure 19-5).
Insert Settings presets
Chains of inserts can be saved and recalled with the Insert Settings menu found at the top of the Inserts section in the Mixing Board and Channel Strip. A variety of factory presets are included, and you can edit, save, and recall your own presets.

![Figure 19-7: Insert Settings presets menu in the Mixing Board.](image)

These presets affect only the inserts; other track settings, such as the fader or pan knob, are not affected.

Insert Settings menu commands

Save Insert Settings: saves a new insert settings file.

Delete Insert Settings: deletes the current insert settings file and clears the inserts. You will be warned that the action cannot be undone.

Restore Last Insert Settings: reloads the preset which was most recently loaded.

Open Insert Settings Folder: opens a Finder or Explorer window revealing the insert settings files. There, you can rename, copy, delete, and move your files.

Cut Inserts: Removes all effects on the channel and places the effects chain on the clipboard.

Copy Inserts: Copies all effects on the channel onto the clipboard.

Paste Inserts: Pastes any effects inserts currently on the clipboard onto the track’s inserts.

Clear Inserts: removes all effects inserts. On instrument tracks, this command removes only the effects inserts; the instrument insert is unaffected.

Common folder
Presets for each track type (MIDI, Audio, Aux, and so on) are saved in separate folders. However, if you would like a preset to appear in the Insert Settings menu for all types of tracks that use audio effects plug-ins (Audio, Aux, Instrument, and Master Fader), save the preset in the Common folder. Common presets appear at the bottom of the Insert Settings menu on audio tracks.

Bypass toggle
Option/Alt-click the Insert Settings menu to toggle Bypass of all inserts on that track at once.

Insert Settings presets in insert slots
Insert Settings presets can also be loaded from individual insert slots (using the plug-in chooser). In this case, the Insert Settings preset will be spliced in starting at the chosen slot. Other inserts that are already loaded on that track will not be removed; if necessary, existing inserts will be moved to lower slots to allow room for the new inserts.

Insert Settings presets when adding instrument tracks
Insert Settings presets are also available when adding an instrument track via Project menu > Add Track > Instrument Track or Project menu > Add Track > Add Instruments.
Sends (audio tracks only)
The Mixing Board provides up to 20 sends per track. (See “Configuring the number of sends” on page 166.) A send can be routed to a physical output in your system or to any virtual bus that you configure in the Bundles window.

Each send has the following controls:

- **Send mute/unmute switch**
  Click the “M” button to mute or unmute the send. When engaged (on/illuminated), the send is muted.

- **Pre-fader button**
  The “P” Pre-fader button (Figure 19-8) determines whether the signal is passed to the send bus before the channel bus (pre) or after the channel the fader (post). When disengaged (off/dark), the send is post-fader. When engaged (on/illuminated), the send is pre-fader. When set to pre-fader, the send level is not affected by the main volume fader of the track. When set to post-fader, it is affected by the main volume fader.

- **Send panners**
  If you have assigned a send to a stereo destination, a stereo panner appears, as shown in Figure 19-8, to control send panning. As a shortcut, double-click the panner to return to pan center.

- **Send From Channel**
  For stereo tracks (or tracks whose signal has been split into stereo by insert plug-ins), the Send From Channel command in the Send Assignment menu (Figure 19-8) lets you choose how the source signal is fed to the send.

  For mono send destinations, the Send From Channel sub-menu lets you choose which individual source channel (left or right) goes to the send. Or you can choose Mono Sum to send both source channels merged down to one channel.

When viewing the Mixing Board in Narrow Mode (“Mixing Board menu” on page 159), the send mute buttons and pre-fader buttons are converted into a checkable menu command in the send menu.

**Mono or stereo sends**
Use the Send assignment menu (Figure 19-8) to route the send to any desired bus or output destination. Sends can be assigned to a destination in any channel format (mono or stereo).

**Send level**
Use the Send level knob (Figure 19-8) to control the amount of signal going to the send destination. The range is from $-\infty$ to $+6.02\text{dB}$. Option--double-click the send level knob to set the send level to unity gain (0 dB), as indicated by the blue dot at the 2 o’clock position.

When you turn the send level knob, Performer Lite displays the send amount (in dB) in a pop-up box.
For stereo send destinations, choose *Stereo* from the *Send From Channel* sub-menu to feed the stereo source signal to the stereo send. Or you can choose an individual component channel (left, right, etc.) to go to the send (in stereo). For example, you could feed only the left channel of the source signal to the left and right channels of the send.

**Configuring the number of sends**

If you find yourself running out of sends, you can add more with the *Set Number of Sends* command located in the Mixing Board menu. You can configure up to 20 sends per channel.

**Replicating active sends using drag & drop**

To replicate an active send (one that already has a send assignment) to any other send slot in the Mixing Board, Option/Alt-drag it to any other empty or occupied send slot.

**EQ and Dynamics (audio tracks only)**

The EQ and Dynamics sections provide visual feedback and quick-access control of each track’s EQ and dynamics plug-ins.
Effect toggle button: When the section is empty, this button instantiates the default EQ or Dynamics plug-in (as chosen in the Select Insert/Default menu, below). When a plug-in is already present, clicking this button toggles the plug-in’s bypass.

Open plug-in button: Clicking this button opens the Effects window for the associated EQ or Dynamics plug-in.

Select Insert/Default menu: The top portion of this menu chooses the insert assigned to the section; the bottom portion chooses the default kind of EQ or Dynamics plug-in.

Compatible plug-ins
The EQ and Dynamics sections are compatible with all of Performer Lite’s included EQ and dynamics plug-ins:

- MasterWorks EQ
- MasterWorks Compressor
- MasterWorks Gate
- MasterWorks Limiter

Selecting a plug-in
To select a plug-in for the EQ or Dynamics section when the section is empty, you can choose the desired plug-in from the bottom portion of the Select Insert/Default menu. You can also instantiate the default (checked) plug-in by pressing the Effect toggle button or by double-clicking the graph.

Alternatively, you can associate the EQ or Dynamics sections with any compatible EQ or Dynamics plug-ins which are already instantiated. Use the top portion of the Select Insert/Default menu to choose an existing instance.

When opening projects from previous versions of Performer Lite, the EQ and Dynamics sections will automatically display the first compatible EQ and Dynamics plug-ins. If you have multiple EQ or Dynamics plug-ins instantiated on a track, use the top portion of the Select Insert/Default menu to change which plug-in’s controls appear in the EQ or Dynamics section, as described above.

EQ Controls
The EQ controls display the settings for the EQ band chosen under the Band Selection menu.

![Figure 19-13: EQ controls](image)

The controls in the EQ section work similarly when using MasterWorks EQ. For more information on each plug-in, see “MasterWorks EQ” on page 27 in the DP Plug-in Guide.
Dynamics Controls

The controls shown in the Dynamics section vary according to the plug-in you have chosen.

MasterWorks Compressor

For more information, see “MasterWorks Compressor” on page 24 in the DP Plug-in Guide.

MasterWorks Gate

For more information, see “MasterWorks Gate” on page 34 in the DP Plug-in Guide.

MasterWorks Limiter

For more information, see “MasterWorks Limiter” on page 39 in the DP Plug-in Guide.

Graphs

The EQ and Dynamics graphs provide a visual representation of the plug-in’s settings. The graphs are customized for each plug-in so the most relevant settings are displayed. Two example graphs are shown below:

Figure 19-17: EQ and Dynamics graphs

The controls shown in the graphs cannot be edited directly. To edit the plug-in settings, use the EQ or Dynamics controls beneath the graphs, or double-click a graph to open the Effects window.

To toggle the plug-in’s bypass state, Option/Alt-click the graph.

Pre-rendering

Showing the EQ and Dynamics sections in the Mixing Board causes any associated plug-ins to be processed in real-time, i.e. not pre-rendered.

Hiding the EQ and Dynamics sections

The EQ and Dynamics sections can be shown or hidden by toggling them in the Mixing Board menu. The EQ Controls, EQ Graph, Dynamics Controls, and Dynamics Graph can all be hidden or shown independently.

Solo / Mute buttons

Solo and Mute buttons perform standard soloing and muting functions for each track. In fact, they correspond directly to the soloing and muting features throughout Performer Lite. For example, if you mute a track in the Mixing Board, its play-enable button becomes disabled in the Sequence Editor.
When soloing and muting, the volume fader color changes to indicate the playback state of the track as follows:

<table>
<thead>
<tr>
<th>Fader background color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Light gray</td>
<td>Track can play</td>
</tr>
<tr>
<td>Dark gray</td>
<td>Track cannot play because at least one other track is soloed, or the track is muted</td>
</tr>
</tbody>
</table>

**Record / Input (monitor) buttons**
The Record button puts the track into record. The Input button engages input monitoring. These buttons function identically to their counterparts in the Sequence Editor. See “The record button” on page 257 and “Audio input monitoring” on page 257.

**Automation play buttons**
When the Automation play button is turned off, all automation data in the track is temporarily disabled, allowing you to override the automation data with the current settings.

**Button shortcuts**
The table below describes several shortcuts for the Solo, Mute, and automation play buttons:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To solo or mute all tracks except the one you click</td>
<td>Command/Ctrl-click the track's solo or mute button</td>
</tr>
<tr>
<td>To unsolo or unmute all tracks except Option/Alt-click the track’s solo or mute button</td>
<td>Drag across the buttons horizontally with the cursor</td>
</tr>
</tbody>
</table>

**Panning**
For MIDI tracks, pan pots generate standard MIDI panning controller data (controller #10). The data range for MIDI tracks is zero to 127, where 64 is pan center, 0 is hard left, and 127 is hard right. The data range for audio tracks is <64 (hard left) to 63> (hard right) with zero as pan center.

Pan pots pan an audio track across its pair of outputs. For example, if a track is assigned to outputs 3 and 4, pan left sends the track to output 3; pan right sends it to 4.

Below is a summary of techniques for pan knobs:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change panning smoothly</td>
<td>Drag the pan knob up and down or left and right, or click on the number in the value readout and drag up or down</td>
</tr>
<tr>
<td>Go directly to pan center</td>
<td>Double-click the knob</td>
</tr>
<tr>
<td>Increment or decrement the pan setting by one</td>
<td>Click the left or right arrow button</td>
</tr>
</tbody>
</table>

**Stereo panning**
The following chart demonstrates the results of stereo panning. In general, center the knob for full separation of the stereo signal.

<table>
<thead>
<tr>
<th>Stereo pan knob position</th>
<th>Left signal</th>
<th>Right signal</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Figure" /></td>
<td><img src="image2.png" alt="Figure" /></td>
<td><img src="image3.png" alt="Figure" /></td>
</tr>
<tr>
<td><img src="image4.png" alt="Figure" /></td>
<td><img src="image5.png" alt="Figure" /></td>
<td><img src="image6.png" alt="Figure" /></td>
</tr>
<tr>
<td><img src="image7.png" alt="Figure" /></td>
<td><img src="image8.png" alt="Figure" /></td>
<td><img src="image9.png" alt="Figure" /></td>
</tr>
</tbody>
</table>

The Trim plug-in (see “Trim” on page 50 in the DP Plug-in Guide) can be used to invert the phase of an audio signal or constrain the stereo image of a stereo track.
**Volume faders**
The volume faders control the output level for each MIDI and audio track by generating MIDI and audio volume events, which can be recorded into the track for automation. If automation data has been recorded, faders will animate during playback (when the Automation play button is enabled).

If the fader cap is missing, it means that the audio track has been disabled. See “Enabled” on page 60.

MIDI volume has a scale from 0-127; audio volume is expressed in decibels (dB) where zero is unity gain. Audio faders provide an additional +6 dB of boost above zero dB. For example, if you move a fader in the Mixing Board as high as it can go, it will be set at 6.02 dB above unity gain. This range is provided throughout the program, wherever audio volume data values are displayed.

The background color of volume faders changes depending on the solo and mute state of the track. See “Solo / Mute buttons” on page 168 for details.

Below is a summary of mousing techniques for changing the values of Mixing Board volume faders:

Using MIDI note velocities to control volume
MIDI notes have on-velocities that affect their volume. The range is from zero to 127. You can edit velocities individually in the edit windows, or you can use the Change Velocity command in the Region menu. Keep in mind, however, that velocity only affects the initial volume of the note and offers no way to change the note’s volume while it’s playing.

Controlling pan, volume and send controls from an external MIDI controller
To control a volume fader, pan knob, send level knobs, send pan, or send mute buttons from an external MIDI controller such as a mod wheel on a keyboard, use the Attach MIDI Controller command in the Mixing Board window menu as described later in this chapter in “Remote control” on page 174.

**Level meters**
For MIDI tracks, the level meters indicate MIDI note-on velocities only (the fader indicates controller #7 MIDI volume).

For audio tracks, the level meters display the audio output level in dB for the track as determined by the volume automation data in the track. For even more detailed metering, you can use the Trim plug-in (“Trim” on page 50 in the DP Plug-in Guide), or third-party metering products such as SpectraFoo from Metric Halo.

On stereo audio tracks or tracks that have been made stereo by the application of a stereo (or mono-to-stereo) effects plug-in, the level meter displays the signal with true stereo meters.

**Clip indicators**
Audio tracks display a clip indicator above their level meter. These clip indicators remain illuminated until you click them. Double-click to clear all clip indicators, or choose Clear all clipping indicators from the Studio menu.
Track name
Track names appear here, with an ellipsis for long names, if necessary. You can drag a name horizontally to reposition its channel strip in the Mixing Board window. Option/Alt-clicking on a name allows you to rename the track from the Mixing Board.

You can open the Sequence Editor from the Mixing Board by double-clicking any track name. Use the same modifier keys as you do in the Track.

Input/Output/Bus Assignment menu
The menu below the track name lets you make the following assignments for the track:

For MIDI tracks, this menu includes a MIDI output device assignment, and a MIDI input device assignment.

For audio tracks, this menu provides assignments for input and output, bus assignments, and audio track enable/disable. Solo Exempt status is also provided.

In both cases, these are the same assignments that you can make for the track in other windows, such as the Sequence Editor. They are provided here in the Mixing Board for your convenience.

You can also remove a track entirely using the Delete Track menu item.

For more information about the I/O menus, see chapter 11, “MIDI Tracks” (page 63) and chapter 10, “Audio Tracks” (page 57).

INSTRUMENT TRACKS
Instrument tracks (Figure 19-1) appear in the Mixing Board, just like audio tracks and MIDI tracks. However, instrument tracks have a special instrument insert, shaded in green, at the top of the insert section:

To open an instrument plug-in, choose it from the green-shaded menu at the top of the insert section for the instrument track.

In other respects, virtual instrument plug-ins work the same as audio effects plug-ins in the Mixing Board.

For more information about virtual instruments, see chapter 12, “Instrument Tracks” (page 67).

AUTOMATED MIXING
The Mixing Board is a powerful environment in which to automate the combined mix of your MIDI and audio tracks. This section explains how to accomplish basic mixing tasks with the Mixing Board.

The importance of event chasing for MIDI tracks
Automated mixing of MIDI tracks in Performer Lite is heavily dependent on event chasing. Event chasing causes Performer Lite to always scan tracks for MIDI controller events to make sure that playback levels are correct, regardless of where you start playback. (For complete information, see “Event Chasing” on page 247.)

For consistency during the mixing process, it is best to enable event chasing for MIDI controllers. To do so, choose the Event Chasing command from the Setup menu and make sure that these items are checked.

Setting initial levels with the Mixing Board
Regardless of whether you plan to automate your mixing directly in Performer Lite or externally using an automated mixing console or other hardware automation system, it is always best to
set initial mix automation settings in all of your tracks. This ensures consistency in your mix, gives Performer Lite an initial setting to chase to, and gives you a basis for any changes made later in each track. Performer Lite’s snapshot feature is a powerful and convenient way to create initial values. Snapshots can include any mix automation parameters, including volume, pan, plug-in parameters, mutes, solos, etc. See “Snapshot automation” on page 475.

Setting initial values in MIDI tracks
To set initial values in MIDI tracks, you can either insert volume and pan controllers at the beginning of each track (either individually or all at once via a snapshot), or you can simply set the volume fader and pan knob as desired in the Mixing Board. In the latter case, be sure that MIDI volume and pan are being chased (make sure they are checked in the Event Chasing dialog in the Setup menu).

Defeating initial volume and pan values in MIDI tracks
There may be times when you wish to prevent Performer Lite from sending initial volume and pan controllers for MIDI tracks. For example, you may want to control volume from the front panel of your synthesizer. If so, you can either defeat volume and pan initialization globally for all MIDI tracks, or disable it specifically for individual tracks.

To defeat volume and pan initialization globally for all MIDI tracks, turn off MIDI volume and pan in the Event Chasing window (Setup menu).

To defeat volume and pan initialization for a few individual tracks (while preserving it for others):

- Be sure that MIDI volume and pan chasing is turned on globally (in the Event Chasing window)
- Use the Automation Setup window (Setup menu) to defeat MIDI volume and pan for the desired individual MIDI tracks. (For details about this window, see “Automation setup for each track” on page 464.) In this case, volume and pan controllers will not be sent, regardless of whether automation playback is enabled for the track or not.

Viewing initial settings
To view initial settings, open the Sequence Editor select volume or pan from one of the track display menus with the Option/Alt key held down (which switches all tracks to display volume). To make changes graphically, drag the control points up or down as desired.

Making snapshots elsewhere in the mix
You can make snapshots as described above anywhere in your Performer Lite mix.

Changing initial levels (or any snapshot)
You can change your initial settings at any time, or any snapshot for that matter, by queuing to the same tick location in the main counter and repeating the procedure described earlier in “Setting initial levels with the Mixing Board”. The snapshot feature will never duplicate controller data on the same tick, replacing existing data with the new snapshot value if data already exists at that location. Just make sure the main counter is exactly at 1|1|000 (or wherever your initial settings are located).

MIXING IN REAL TIME
Mix automation is control data that changes the behavior of the effects and mixing board over time. Automation data can be recorded, edited and played back using the sophisticated set of tools that Performer Lite provides. Automation data can be used to control volume, pan, sends and most effects parameters. For complete information on automation, see chapter 54, “Mix Automation” (page 462).
EDITING YOUR MIX GRAPHICALLY
You can edit your mix graphically in the Sequence Editor. See “Inserting and editing automation” on page 471.

MONITORING
An important part of mixing is the process of monitoring live inputs. A live input could be a signal that you are currently recording, such as a microphone, or it could also be a stereo input from a MIDI instrument that you are triggering live from a MIDI track. For complete information about monitoring, see “MIDI input monitoring” on page 254 and “Audio input monitoring” on page 257. Also see “Effects can be applied to Patch Thru” on page 175.

AUDIO MIXING FEATURES
The Mixing Board and Effects windows gives you access to Performer Lite’s sophisticated digital audio mixing and routing environment. The following sections discuss several topics that are specific to audio mixing.

Audio mixing features
Performer Lite’s virtual mixing environment provides the following features:

- Mixing
- Automation
- Bussing
- Audio track sends
- Aux tracks
- Master faders
- Real time effects plug-ins

Bussing
A bus is an internal signal path. Performer Lite’s virtual bussing is modeled after a conventional mixing board. Under the MOTU Audio System, Performer Lite provides up to 16 stereo busses.

You can set the number of busses in the Studio Configure Studio Settings dialog (Setup menu > Configure Audio System).

A bus routes signal from one place to another. It can also combine several signals as a sub-mix and route them together. To use a bus, you assign a bus bundle as an input or output of an audio track or aux track (explained in the next section). You can also assign a bus bundle as the output of a master fader. Audio track sends can also be assigned to a bus.

There are many useful ways to employ this powerful bussing architecture. For example, you can save large amounts of your system’s processing resources by applying effects plug-ins to an aux track and then bussing multiple audio tracks to it, rather than applying the same plug-in multiple times to each individual audio track. By applying the plug-in only once on the aux track, you conserve processing resources.

The impact of mixing and bussing on MOTU Audio System resources
The MOTU Audio System relies on the main CPU in your computer for all of its processing. Mixing and bussing require a certain amount of CPU power; the more you mix, split, route, and merge tracks using input, output and bus assignments in the Sequence Editor and Mixing Board, the more CPU power you’ll use up. Each time you make a connection, split a signal, or merge two or more signals together in Performer Lite’s virtual mixing environment, you’ll use a tiny bit more CPU power. However, the amount of bandwidth taken up by such a connection is relatively small compared to the amounts required by MOTU Audio System effects plug-ins—even low-overhead ones like the EQ plug-ins. You won’t need to be very concerned about CPU power for basic mixing and routing. But you will need to be a lot more conscious of your CPU resources as soon as you start using effects plug-ins.
**Multi-processor support**
When operating Performer Lite with the MOTU Audio System on a multi-processor or multi-core computer, you can take full advantage of distributed processing. A dual-processor or dual-core computer, for example, effectively doubles the amount of processing available for mixing and plug-in processing (over its single-CPU or single-core counterpart). If you have a multi-processor/core computer, Performer Lite takes full advantage of the multiple processors/cores.

**AUX TRACKS**
In the Mixing Board, Aux tracks look just like disk tracks, with effects inserts, sends, solo, mute, etc. The only difference is that aux tracks have no input monitoring button and no record-enable button. If the Aux track has stereo inputs, it will only display stereo effects plug-ins in the effects insert menus. If the track has mono inputs, it will only display mono or mono-to-stereo plug-ins in the insert menus. Aux tracks are primarily intended as a routing mechanism. Aux tracks allow you to route audio from any source to any destination. For further information, see chapter 13, “Aux Tracks and Master Fader Tracks” (page 70).

**MASTER FADERS**
In the Mixing Board, the only way master faders differ from other types of audio tracks is that they do not have a pan knob. In their place, master faders have built in fold-down menu. When working in stereo, the fold-down menu allows you to ‘fold down’ your mix to stereo or mono if you need to generate a mono or stereo mix or to check for mono/stereo compatibility. Note that you can apply plug-ins to the inserts of a master fader to apply the plug-in effect to your entire mix (or all tracks being sub-mixed to that master fader). For additional information about master faders, see chapter 13, “Aux Tracks and Master Fader Tracks” (page 70).

**TRACK GROUPS**
Performer Lite allows you to create an unlimited number of track groups. Tracks can be linked for mixing, editing, both, or for a customized set of operations that you specify. Tracks can be a member of more than one group. Groups can also be “nested” within each other.

For information about track groups, refer to “Track Groups” on page 73.

**VCA TRACKS**
Similar to their analog mixing console counterparts, VCA tracks are used to control the relative volume, and other mixing parameters, of a group of other tracks with a single VCA track. You can create as many VCA tracks as you want in your mix, and you can even have VCA tracks control other VCA tracks as sub-groups. See chapter 55, “VCA Tracks” (page 481).

**REMOTE CONTROL**
You can control any of the faders or pan knobs in the Mixing Board from any external source that can generate MIDI controller data, such as a mod wheel on your controller keyboard or a fader on a control surface that generates MIDI data.

**Attaching a MIDI controller to faders and pan knobs**
Use the Attach MIDI Controller command to set up external control of faders and pan knobs as follows:

1. Choose Attach MIDI Controller.
   The cursor changes to a plus sign.

2. Click the fader or pan knob you wish to control externally.
   A red box appears around the control indicating that Performer Lite is waiting for an incoming MIDI controller event.
3 Transmit the data from your MIDI Controller and the box flashes green.

Only MIDI continuous controller data can be used; pitch bend, note-ons, etc. cannot.

4 (Optional) Click another fader or pan knob, or use the arrow keys to move the flashing box around to attach other controls in a similar fashion.

5 When you are done attaching controllers, press return or enter, or double-click the last item you attached.

To cancel, press Command/Ctrl-period (.), the Escape key (Esc), or click elsewhere in the window (such as the title bar).

Clearing MIDI controllers
Use the Clear MIDI Controller command to display all controls that have MIDI controllers attached. They all flash green. Click a control to detach it from the controller. Type Return or Enter to confirm the detachment or Command/Ctrl-period (.) to cancel.

Attaching a MIDI controller to sends or send pan
To attach a MIDI controller to a send knob or send pan knob in the Mixing Board, use the Learn Controller command. See “Attaching a MIDI controller to plug-in parameters” on page 500.

Setting the punch-out delay
When you record a fader or knob via remote control, it punches in and out in much the same fashion as when you grab it with the mouse. To punch in, the fader or knob waits to receive an event from its external controller. When it does, it punches in. Punch out, however, is done automatically by Performer Lite and is determined by the amount of time after the last event was received from the controller. Since controllers send data with different degrees of sensitivity, you may find that punch out occurs too frequently. To avoid stuttering the punch out, you can lengthen the delay before Performer Lite punches out with the Auto Punch-Out Delay command in the Automation Setup window (Setup menu).

WORKING WITH EFFECTS PLUG-INS

How effects settings apply to a track
Effects settings apply globally to the entire track. To apply an effect to just a portion of a track, you can use bypass automation to disable, enable and then disable again the effect. Or you can apply the effect ‘constructively’ using one of the following procedures. Make a time range selection in the track and then do one of the following:

- Bounce to disk (for audio tracks only)
- Choose Capture real-time MIDI effects in the Region menu (MIDI tracks only)
- Save the plug-in settings as a preset, remove the real-time plug-in from the track (delete the plug-in from the insert) and then apply it ‘constructively’ from the Audio menu>Apply Plug-in submenu using the same preset you just saved. (Audio tracks only)

Effects can be applied to Patch Thru
Both MIDI and audio effects processors can be applied to any MIDI or audio input that you are Patching Thru. To real-time process a patched thru signal:

1 Assign the desired effects insert to a track in the Mixing Board window insert section.

2 Record-enable the track in the Sequence Editor.

3 If its a MIDI track, play your MIDI controller.

4 If its an audio track, feed live audio to its input.
Patch thru effects work even when playback is stopped
Plug-in effects can be applied to a live input signal, even when playback is stopped.

Audio monitoring settings
When monitoring live audio through MAS effects, be sure to enable Monitor record-enabled tracks through effects in the Input Monitoring Mode window which is accessed from the Configure Audio System (Setup menu). For details, see “Audio input monitoring” on page 257.

Copying and pasting parameters from one insert to another
You can copy and paste effects parameters from one insert to another. Just choose Copy from the Edit menu while a specific insert’s effect is being displayed, switch to a different insert with that same effect, and choose Paste.

Plug-in insert assignments and effects settings are remembered
Effects settings are saved with the file. In addition, the settings for each insert and track are remembered even if you temporarily remove the effect and re-apply later on. Settings are also remembered if you switch audio hardware.

Mono and stereo effects
Audio plug-ins come in mono and stereo variants. When using a stereo mix bus destination, effects plug-ins can be mono-to-mono, stereo-to-stereo or mono-to-stereo. If a mono audio track is assigned to a stereo bundle, it is panned across the bundle’s output pair. If you assign mono plug-in, the track remains mono. However, as soon as you choose a mono-to-stereo plug-in, the track’s output becomes stereo. In addition, all plug-ins on subsequent inserts will dynamically switch to stereo as well. If you remove the stereo plug-in, the track output will revert to mono.

When DSP resources are exceeded
Performer Lite will warn you if it cannot successfully allocate resources as a result of something that you do, such as add more audio tracks or choose a new type of effect.

Missing plug-ins in effects inserts
If an effect plug-in is missing when you open a Performer Lite project that uses it, an alert window appears, and you are given the option of remembering or forgetting the missing plug-in. If you choose to remember it, the missing effect will be displayed in parentheses in any inserts in the Mixing Board where it was being used. This allows you to preserve missing effects assignments in a project when they are not present. For example, you might copy a project from the main computer in your studio onto your laptop, but perhaps your laptop doesn’t have all the same plug-ins installed. You can work on the project, save it, and then open it again in the studio without losing plug-in assignments in the Mixing Board.

Drag & drop plug-ins
After you choose a plug-in for an insert, it fills the slot as shown in the Insert section of the channel strip shown in Figure 19-2 on page 162. You can now treat the plug-in as an object that can be selected, deleted, dragged to a different insert or duplicated.
Here is a summary of drag and drop techniques for plug-ins in the Mixing Board.

**To do this** | **Do this**
--- | ---
To change to a different plug-in on the same insert | Click the right-hand side of the insert with the chooser cursor to open the plug-in chooser.
To open the plug-in’s window | Double-click the left side of the insert with the hand cursor.
To select a plug-in | Click the left side of the insert with the hand cursor.
To remove a plug-in | Select it and press the delete key.
To move a plug-in to another insert | Position the hand cursor over the left side of the insert, and then drag it.
To duplicate a plug-in on another insert | Hold down the Option/Alt key while dragging, as above.
To select several plug-ins | Shift-click the left side of each insert with the hand cursor.
To move several plug-ins to other inserts with the hand cursor, and drag them to the destination inserts. | Select them, grab the left side of one of them with the hand cursor, and drag them to the destination inserts.
To duplicate several plug-ins | Hold down the Option/Alt key while dragging them with the hand cursor, as above.

**WORKING WITH MULTIPLE MIXES**

The Mixing Board window has a very powerful feature called the Mix Mode menu, which is located in the lower left-hand corner of the window as shown below. This feature allows you to create an unlimited number of independent mixes in a sequence.

**What is a mix?**

A mix consists of all of the volume, pan and other mix settings and automation data in all tracks in the sequence, as well as all of the current effects insert assignments and their settings. The Mix Mode menu allows you to create, save, and recall any number of mixes. Each mix can be completely different than the others. You can also create alternative mixes that are slightly different from each other by starting with the Duplicate Mix command. You can even copy and paste data between mixes by simply switching between them.

**How mix mode impacts your sequencing**

When Mix Mode is off, mix settings and automation data “belong” to the Track and Take in which they were set, recorded or inserted. If you switch takes, the mix settings and automation data switch along with the take, just like the rest of the data in the take. (For an explanation of takes, see chapter 42, “Takes and Comping” (page 387).)
When Mix Mode is on, however, mix settings and mix automation data “belong” to the current mix. If you switch takes, the mix settings and automation data in the track remain behind as part of the current mix. If, however, you switch to a different mix, the current mix automation data goes along with the mix, temporarily disappearing from all tracks. (You can restore the data, of course, simply by reselecting the Mix from the Mix Mode menu.)

**Mixes include initial track settings**

Each mix includes the following initial track settings, regardless of whether there is currently any automation data in the track:

- Track volume
- Pan
- Send levels
- Send mute states
- Track automation mode
- Track play-enable/disable state

By including these track attributes to each saved mixdown, the Mix Mode menu provides complete independence among separate mixes, even if they don’t have any automation data in them. For example, you could simply set initial volume and pan settings for each track, create a mix, duplicate it, adjust the faders and then switch back and forth between the two mixes. You can then freely switch between them, comparing the fader settings, without the need to insert or render any automation data. In general, you will find it very easy to create and use multiple mixdowns because they include initial track settings.

**Creating a new or duplicate mix**

To create a new, empty mix (with no mix automation data in any of the tracks), choose New Mix from the Mix Mode menu (as shown in Figure 19-20 on page 177). Or you can choose Duplicate Mix to create a new mix based on the current mix (that is, the current volume and pan in all tracks, as well as the current effects insert assignments in the Mixing Board).

**Renaming or deleting a mix**

To rename or delete a mix, choose it by name from the Mix Mode menu and then choose either Rename Mix or Delete Mix from the same menu.

**Recalling a mix**

To recall a mix, just choose it by name from the Mix Mode menu Figure 19-20 on page 177.

**Copying and pasting data between mixes**

You can easily copy and paste data between mixes by switching between them (as described in “Recalling a mix” above). Copy data from the desired tracks in one mix, recall a different mix, and paste into the same or different tracks in the second mix.
CHAPTER 20  Clips Window

OVERVIEW
The Clips window is a dynamic, interactive environment for triggering audio and MIDI clips during live performance. You can prepare any number of MIDI and audio clips and then individually trigger them during playback. If you enable the queue, you can cue up any number of clips in advance to play consecutively. You can also set up and trigger scenes, which consist of multiple clips arranged in a single row for simultaneous triggering. The Clip Editor lets you view, edit and create clips. You can also copy and paste track material to make clips, or drag and drop them from the Soundbites list or Content Browser.
**QUICK REFERENCE**

**Audio track (column):** Each track is represented as a column.

**Clips:** Clips of any length can be placed in cells and triggered randomly in any order you wish. Audio clips go in audio tracks (mono or stereo) and MIDI clips go in MIDI tracks.

**Clip trigger:** Click to play or queue the clip. The clip drops to the *Now Playing row* or *Multi-queue* section at the bottom of the column.

**Track clip:** The top row of cells are track clips, which represent material in the track itself. When a track clip plays, you will hear any audio or MIDI data in the track at that moment (i.e. the main counter location).

---

Figure 20-1: The Clips window.
**Track clip trigger:** Click to play or queue the clip. The clip drops to the *Now Playing row* or *Multi-queue* section at the bottom of the column.

**Selected clip:** Select a clip to view it in the Clip Editor. You can also cut, copy and delete it.

**Scene list:** A scene consists of an entire row of cells. Each row represents a different scene.

**Scene trigger:** Click to queue or play the scene (row). All the clips in the row drop to the *Now Playing row* or *Multi-queue* section at the bottom of the column.

**Clip scene (row):** A scene consisting of any clips present in the row. Click the scene trigger to play or queue the scene.

**Track scene (row):** A scene consisting entirely of track clips (in the top row). Click the scene trigger to play or queue the scene.

**Multi-queue:** Enable the Multi-queue from the Clips window menu. When enabled, you can cue any number of clips, in the queue, where they then play consecutively.

**Queue grid:** Determines the interval at which queued clips begin to play, i.e. every 2 bars, 4 bars, 8 bars, etc.

**Queued clips:** When the Multi-queue is enabled, queued clips appear in stacked fashion here. When the cue empties, the last clip will loop continuously.

**Now playing (row):** Shows the clip currently playing in each track.

**Clip length (in beats):** The length of the current clip (in beats).

**Progress wheel:** Shows the playback progress of the current clip.

**Beats played:** The number of beats already played for the current clip.

**Mixer channels:** Displays basic Mixing Board settings for each track, including volume fader, pan, Solo, Mute, I/O assignments and inserts.

**Clip Editor:** Displays the contents of the selected clip. Lets you set basic parameters and edit the clip’s audio or MIDI data.

**Clip settings:** Basic settings for the clip, including its name, start/end times, etc.

**Show/hide clip settings:** Shows or hides the clip settings section of the Clip Editor.

**Edit layer menu:** Access edit layers for clips here, just like the Sequence Editor.

**Insert menu:** Insert audio or MIDI data into the clip using this menu, just like the Insert menu in the Sequence Editor.

**Clip start:** Drag the Clip Start marker to graphically adjust the clip’s start location.

**Loop bar:** If the clip’s Loop option is enabled, drag the loop bar or its end points to adjust the loop graphically.

**CLIPS WINDOW MENU**

- **Play on Clip Queue:** When enabled (checked), Performer Lite’s main transports will begin playback when you trigger a clip. When unchecked, cuing clips does not start playback.

- **Auto End Clip Record:** When recording into a clip, enable (check) this option if you would like the record pass to finish after the first time through the queue grid loop (four bars, for example). When disabled (unchecked), recording continues indefinitely for the entire duration of the record pass.
**Show Clip Editor:** Displays the Clip Editor (Figure 20-1) below the Clips window.

**Enable Multi-Queue:** Enables the Multi-queue (Figure 20-1). When enabled, you can stack any number of clips in the queue, where they then play consecutively.

**Show Mixer:** Shows or hides the mixer section at the bottom of the window (Figure 20-1).

**Attach/Clear Mixer MIDI Controller:** Lets you assign MIDI controller data to items in the Clips window mixer panels for hands-on mixing from your MIDI controller device.

**MIDI Learn Mode:** Puts the Clips window into a special mode where you can click active items to assign them to any incoming MIDI triggers, like keyboard keys, controller pads, MIDI pedals, etc.

**Enable MIDI Bindings:** Temporarily enables or disables any MIDI assignments you’ve made in MIDI Learn Mode.

**WHAT IS A CLIP?**
A clip is a container for a single track’s worth of data. Think of it as a small slice of a track that you can manipulate as a single object.

Clips are typically one, two, four or eight bars long. However, they can be of any length, as short as one beat or as long as an entire song.

Clips can contain any combination of track data. For example, a MIDI clip can contain anything that goes in a MIDI track, such as notes and controller data. Audio clips can contain anything that goes in an audio track, including one or more soundbites, volume automation, plug-in automation, pitch and stretch layer edits, and so on.

Clips also have their own object settings, such as a clip name, color, duration and so on. These settings can be accessed and edited in the Clip Editor (see “Clip settings” on page 187).

Clips can reside in the Clips window and also in tracks. However, they are required to match the basic format of their track. MIDI clips can only go in MIDI tracks. Audio clips can only go in audio tracks. Further, mono audio clips can only go in mono audio tracks, stereo clips in stereo tracks, and so on.

Clips are independent objects. For example, if you duplicate a clip, the resulting duplicate is a new, completely different clip. It is not a ‘clone’ — or ‘instance’ — of the original clip. Therefore, if you make change in one, it will not be reflected in the other.

**OPENING THE CLIPS WINDOW**
To open the Clips window, choose *Project menu > Clips*. You can also simply click the Clips tab in the Consolidated clips Window.

**CLIPS WINDOW BASICS**
The Clips window displays tracks in the current sequence as columns with cells that hold clips (Figure 20-1 on page 180). Clips can be dragged and dropped into cells from the Content Browser, Soundbites list, Sequence Editor and other edit windows. Clip data can also be copied from other windows and pasted into a cell, or recorded directly into a cell. Within a track (column), clips can be arranged however you want in the cells; their order top to bottom doesn’t matter (except for arranging scenes, as explained later).

Each clip has a trigger (play) button (Figure 20-1). Clicking it causes the clip to be queued for playback, either before or while Performer Lite is playing back. Once queued, clips initiate playback according to the queue grid setting at the time they are triggered (Figure 20-1). The Queue grid is
adjustable and typically set to 2 bars, 4 bars, 8 bars, etc. For example, if the queue grid is set to 4 bars, newly queued clips will begin to play on the downbeat of bars 1, 5, 9, 13, 17, 21, etc. The queue grid only affects clips at the time they are triggered; clips that have already been triggered are not affected if you change it.

As explained earlier, clips consist of audio or MIDI data compatible with their corresponding track type. If you try to put a MIDI clip into a mono audio track, for example, it won’t play; accordingly, it will have no trigger button (as shown in Figure 20-3 on page 185).

THE TRACK STRETCH SETTING
Before you begin using the Clips window, it is a good idea to enable the Stretch setting for any audio tracks you’ll be using in the Clips window. This ensures that your clips will play in time with the time line and each other. See “Stretch” on page 59.

SHOWING, HIDING AND ARRANGING TRACK COLUMNS
Use the Track Selector to show and hide tracks in the Clips window.

Tracks are ordered left to right according to their position in the Sequence Editor, top to bottom. To rearrange the track columns, reorder the Sequence Editor (“Moving tracks up or down” on page 106).

TRACK TYPES
You can use any type of track in the Clips window (“Basic track types” on page 50). Most often, you’ll be using MIDI tracks, and mono and stereo audio tracks. However, you can also include instrument tracks, aux tracks, VCA tracks or even Master Fader tracks, for the purposes of triggering mix automation data.

TRACK PLAYBACK VERSUS CLIP PLAYBACK
Once clips have been placed in the cells of a track, they aren’t actually “in” the track. In other words, they exist independently of any material in the track, as viewed in the Sequence Editor or other edit windows. Accordingly, they won’t play until you trigger them with their trigger buttons. Until you do, you’ll hear whatever material is in the track. As soon as you trigger the clip, it “takes over” the track’s playback. So at any given time, you will only hear either the clip or the track material, but not both. Similarly, only one clip can play at a time within a track. So, if you have clips that you intend to play consecutively, you can place them in the same track. For clips that you might want to play simultaneously, place them in separate tracks.

☛ The top row of clips are an exception: see “Track clips” below.

CREATING CLIPS
To create a clip, you can:

- place existing material into a cell in the grid
- create a new, empty clip and use the Clip Editor to construct new material
- record directly into a new, empty clip
- record into an existing clip

☛ When placing existing material in a cell, it must be compatible with the track format (MIDI, mono audio, stereo audio, etc.)

Drag and drop
Drag and drop items from other windows (the Soundbites list, Content Browser, Sequence Editor, etc.) into any compatible cell. If the cell is already occupied by a clip, the existing clip is replaced.

Copy and paste
To create a clip using copy and paste:
Copy material from any single track in the Sequence Editor or any other editor.

You can do so from an object selection or a time-range selection.

Select a cell in the Clips window and paste. Be sure the cell belongs to a track that is compatible with the data you’ve copied (MIDI, mono audio, stereo audio, etc.)

A new clip is created from the material on the clipboard. If the cell is already occupied by a clip, the existing clip is replaced.

Create a new, empty clip
1 Right-click an empty cell and choose New Clip from the menu.

2 Use the Clip Editor to build the clip’s content. See “The Clip Editor” on page 187.

Record into an empty clip
To record into an empty audio or MIDI clip:

1 Disable the Play on Clip Queue option in the Clips window menu (page 181).

Otherwise, recording will begin as soon as you click the cell’s record button (Figure 20-2).

2 Record-enable the track (Figure 20-7 on page 187).

Each empty cell in the track now displays a record button.

3 Click the cell’s record button to record-arm the cell.

4 Set the Queue Grid for the desired duration of the clip you wish to record (such as two bars).

Start recording.

Recording occurs the first time through the loop (for duration you set for the queue grid, such as two bars). Then the clip drops into the queue and starts looping.

Record into an existing clip
To record into an existing clip, follow the same procedure as above, except for the following two additional steps after Step 2:

- Option/Alt-click the Record button (Figure 20-11 on page 188) to engage Clip Record mode. This gives existing clips a record button, similar to what is shown in Figure 20-2.

- If you are recording into a MIDI clip and wish to overdub record over the existing material in the clip, enable Overdub Record mode (page 94).

While recording in Clip Record mode, the clip is also recorded into its respective track. The same goes for any existing clips that you trigger in the Clips window: they are also recorded into their respective tracks, even if those tracks are not record-enabled. See “Recording triggered clips to tracks” on page 188. Be careful if there is existing material in the tracks that you wish to preserve; if so, don’t trigger any other clips while recording into an existing clip.

THE TRIGGER BUTTON
To trigger a clip, click its trigger button (Figure 20-1 on page 180).

If the trigger button is missing from a clip, it means that the clip is not compatible with the track. For example, if you place a MIDI clip in an audio track cell, its trigger button will disappear to indicate that it cannot be played.

While a clip is playing, its trigger button is shaded blue. When not playing, it is gray.
TRACK CLIPS

Track clips are displayed across the very top of the Clips window grid, in the top row. These track clips are “hard-coded” to represent material in the track itself. When a track clip plays, you will hear any audio or MIDI data in the track at that moment (i.e. the main counter location). Because track clips exclusively represent time line material in the track, they cannot be pasted into, and the clip menu (Figure 20-4) is not available.

CLIP MENU

Right-click a clip to open the Clip menu.

- **Rename Clip:** Lets you rename the clip.
- **Link Clip to Scene:** Links or unlinks the clip to its corresponding scene. When linked, it will get triggered with the scene. When unlinked, it won’t.
- **Set Clip Color:** Brings up the standard color picker with eye dropper, allowing you to set the clip’s color.
- **Clear Clip Color:** Reverts the clip color to black.
- **Insert Scene Above/Below:** Inserts a new, empty scene (row) above or below the row you’ve right-clicked.
- **Delete Scene:** Removes the scene (row) that you’ve right-clicked.
- **Cut/Copy/Paste:** Cuts, copies or pastes into the contents of the cell.
- **Erase:** Empties the cell without affecting the clipboard.
- **Learn MIDI Binding:** Lets you assign a MIDI command to the clip, as indicated in the Clip Editor.

SCENES

A scene is an entire row of cells in the Clips window (Figure 20-1 on page 180). Each row represents a different scene. When you trigger a scene using the scene trigger button (Figure 20-1), the entire row of clips is queued for playback. A typical use of scenes is for different sections of a song, such as the intro, chorus, verse, bridge, solo section, etc. However, you can structure and use scenes however you want.

THE TRACK SCENE

The track scene (Figure 20-1 on page 180) triggers track time line playback for all tracks in the Clips window, as explained earlier in “Track clips” on page 185).

PLAYING CLIPS AND SCENES

When you trigger clips or scenes, they “drop” into the Now Playing row (Figure 20-5) and either begin playing, or they are queued to begin playing at the next queue grid boundary. The clip
continues to loop until you either cancel it or trigger another clip (unless it’s a one-shot clip, as explained later in this chapter).

Figure 20-5: The ‘Now Playing’ row.

For example, in Figure 20-5, the queue grid is set to 2 measures. If you trigger a clip or scene at 5|3|000, it will be queued to begin playing at the next two-bar downbeat, which would be 7|1|000.

Queue grid boundaries are measured from the beginning of the sequence. So, if you set the queue grid to 4 measures, the queue grid boundaries occur at the downbeats of bars 1, 5, 9, 13, 17, 21, 25, etc., When you then trigger a clip or scene, it plays at the next grid boundary.

To cancel a clip, or all currently playing clips, click the cancel buttons shown in Figure 20-5.

THE MULTI-QUEUE

When the multi-queue is enabled in the Clips window menu, the multi-queue appears above the Now Playing row (Figure 20-6). When you then trigger clips or scenes, they get stacked in the queue, each playing consecutively until the final clip makes it to the Now Playing row, where it will loop indefinitely until you either cancel it or trigger another clip.

Figure 20-6: The multi-queue.

When queued clips play consecutively, they play as follows, depending on their length and the size of the queue grid:

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The clip is shorter than the queue grid</td>
<td>It loops until the next queue grid boundary.</td>
</tr>
<tr>
<td>The clip is the same duration as the queue grid</td>
<td>It plays once through.</td>
</tr>
<tr>
<td>The clip is longer than the queue grid</td>
<td>It plays partially, stopping at the next queue grid boundary.</td>
</tr>
</tbody>
</table>

For example, if you had an 8-bar grid and you queued a 1-bar drum loop, followed by a 4-bar drum loop and then an 8-bar drum loop, the 1-bar drum loop would play eight times, the 4-bar loop would play twice and then the 8-bar loop would play all the way through, indefinitely (since it’s the last one queued).

This is really useful, for example, when you have eight bar bass and rhythm lines but you want to use 2-bar drum loops with them.

Once clips are queued, you can’t rearrange their order, but you can cancel them, regardless of where they are in the queue stack.
MIXER CHANNELS
Use Show Mixer in the Clips window menu to show or hide the mixer channels (Figure 20-1 on page 180). These mix settings are the same as described for the Mixing Board. See chapter 19, “Mixing Board” (page 156).

![Mixer channel](Figure 20-7: Mixer channel)

THE CLIP EDITOR
Use Show Clip Editor in the Clips window menu to show or hide the Clip Editor (Figure 20-1 on page 180). The Clip Editor lets you view the contents of a clip, along with basic clip settings such as its name, length, etc.

Clip settings
Each clip has the following clip settings:

- Name
- Color
- MIDI binding
- Link clip to Scene
- Start time
- Loop enable
- Loop start
- Loop end
- Loop Duration
- Meter

![Clip settings](Figure 20-8: Clip settings)

Color
Each clip can be assigned a color to help you organize clips visually by color. Click the color swatch to open the standard color picker, which includes the eyedropper for copying other colors on your screen.

MIDI binding
Click Learn to assign the clip to a MIDI command. When you send that MIDI command, doing so triggers the clip. Also see “MIDI Learn Mode” on page 189.

Link Clip to Scene
When checked, the clip is linked to its corresponding scene. When linked, it will get triggered with the scene. When unlinked, it won’t.

Start
The Start time (Figure 20-8) lets you determine where the Clip will start playing, relative to the data it contains. You can also adjust this setting graphically, as shown in Figure 20-9.

Loop (versus one-shot)
When Loop is checked, the clip loops indefinitely until you either cancel it or trigger another clip. When Loop is unchecked, the clip will play as a one-shot clip (once through only).
Loop Start time/End/Duration
Use the Loop Start/End/Duration times to determine when the clip starts and stops looping. You can set these values wherever you want in the clip. You can also edit them graphically using the loop points in the clip editor time ruler (Figure 20-9).

Meter
Enter the desired meter for the clip.

Clip Editor
The Clip Editor works the same way as the equivalent features found in the Sequence Editor (chapter 17, “Sequence Editor” (page 102). Here, you can edit audio data, MIDI data, automation, pitch, stretch and so on. The Start Time strip works similarly to the Loop strip: drag the start time marker to change it. If you hold down the shift key while dragging the start time handle, the loop start handle or either bar, both move together. As another shortcut, click the start time handle or the loop boundary handles to make a time range selection.

For MIDI tracks, the clip editor works like MIDI track editing in the Sequence Editor (chapter 35, “MIDI Editing” (page 289)).

CLIP RECORD MODE
Option/Alt-click the Record button to toggle between Record mode and Clip Record mode.

In Clip Record mode, two things happen:

- Clips that are triggered in the Clips window are recorded into their respective tracks.
- Existing clips in the Clips window can be recorded into (see “Record into an existing clip” on page 184).

Recording triggered clips to tracks
Clip Record mode allows you to capture your performance as you trigger clips in the Clips window. You do not need to record-enable any tracks beforehand. With Clip Record mode enabled (as shown in Figure 20-11), simply click the Clip Record button (in Figure 20-11) to start
recording. Any clips you trigger are placed in their respective track at the current counter location. If they repeat, they are looped within the track for as long as they remain looping. (For more information about looping clips in tracks, see “Looping a clip” on page 317.)

When using Clip Record mode, you do not need to record-enable each track. Any clip that is triggered is recorded.

Be mindful when using Clip Record. Every triggered clip is recorded, covering up any material already in the track. For details about editing clips, especially layered ones, see “Clip layering” on page 316.

MIDI LEARN MODE
Choose MIDI Learn Mode from the Clips window menu to put the window into a mode where you can assign MIDI bindings to items in the window, to be able to trigger them from a MIDI controller (Figure 20-12). Assignable items appear in gray against a darkened background. The currently active item flashes blue, and its MIDI settings are displayed in the pane below the window, as shown.

Making assignments
To make an assignment click the item you wish to assign. Alternately, you can use the tab key to move to different sections of the window, and then use the arrow keys to navigate through the eligible items in that section to choose the desired active item. Once active, send the MIDI data from your MIDI controller and it appears in the pane below.

Learn channel/source
When making MIDI bindings, use the Learn Channel and Learn Source check box options to remember the specific MIDI channel or even MIDI source for the MIDI binding. This can be very useful when you are using multiple MIDI devices to trigger clips and other items in the Clips window.

ATTACHING MIDI CONTROLLERS FOR MIXING
Choose Attach Mixer MIDI Controller from the Clips window menu to assign a MIDI controller to any item in the Clips window Mixer panel for remote control from any MIDI device. Use the Clear Mixer MIDI Controller command to remove the assignment. You can also access these commands by right-clicking a mixer item. This works the same way as the Mixing Board. See “Remote control” on page 174.
Figure 20-12: MIDI Learn mode in the Clips window.
CHAPTER 21  

Content Browser

OVERVIEW

The Content Browser gives you immediate access to assets that you can quickly drag and drop into your Performer Lite project. Examples include audio files, loops, plug-ins and virtual instruments.

Quick Reference: Provides access to audio files, bounces, and other project-related content.

Places: Folders on your hard drive(s). Click the Add Place item to add a folder to the list. The folders can contain any content that is relevant to Performer Lite, including audio files, loops, etc.

Quick Reference

Project: Provides access to audio files, bounces, and other project-related content.

Places: Folders on your hard drive(s). Click the Add Place item to add a folder to the list. The folders can contain any content that is relevant to Performer Lite, including audio files, loops, etc.

Figure 21-1: The Content Browser.
Plug-ins: This section provides access to assets that are specific to plug-in operation, such as virtual instruments and plug-ins you have installed in your system, plug-in presets and samples used by virtual instruments.

Preview pane: Shows information about the currently selected item.

Forward/backward buttons: Moves forward and backward through your browsing history.

Go up one folder level: Goes to the enclosing folder of the one you are currently viewing in the browser.

CONTENT BROWSER MENU
The Content Browser menu (Figure 21-1) only has one menu item:

Show Content Info: When checked, this command displays the Preview pane (Figure 21-1).

OPENING THE CONTENT BROWSER
To open the Content Browser, click the Content Browser button (Figure 21-1). It appears in the right-hand sidebar of the Performer Lite window (Figure 7-3 on page 40).

OPENING THE CONTENT BROWSER AS A WINDOW
The Content Browser can be popped out of the Performer Lite window to become a separate window that shows more columns of information. To do so, click anywhere on the Content Browser to make it the active cell in the Performer Lite window, and then choose Window menu > Pop Out of Consolidated window. To put it back in, choose Window menu > Pop Into Consolidated window. The keyboard shortcut for both of these commands is Ctrl-1.

USING THE CONTENT BROWSER
Use the Content Browser for quick access to assets...any items you might use as you work with Performer Lite. Use the Content Browser to navigate to a particular audio loop, plug-in, Mixing Board insert preset or any similar item and then drag and drop it into any Performer Lite window that accepts that type of item.

For example, you can drag and drop audio loops from the Content Browser into the Clips window or Sequence Editor. Or drag and drop plug-ins — or entire plug-in chains — into the insert section of the Mixing Board.

AUDITIONING AUDIO CLIPS
To audition audio clips in the Content browser, click the item you wish to audition. Note that some audio file types may not support auditioning.

THE PERFORMER PRODUCER PACK
The Performer Producer Pack appears in the Extras section of the Content Browser. The Performer Producer Pack is a collection of MIDI chords, audio loops and their MIDI loop equivalents. Their purpose is to get you started writing music quickly and easily, while giving you plenty of creative flexibility.

Everything in the Performer Producer Pack was curated in house, and comes automatically installed with the latest version of Performer Lite.

Visit motu.com and youtube.com/motuTV for videos on how to get the most out of the Performer Producer Pack.
CHAPTER 22  Soundbites

OVERVIEW
This chapter assumes that you are familiar with terms like audio file, region, soundbite, playlist and audio track. If not, review “Hard Disk Recording Concepts” on page 570.

As you work with Performer Lite, you’ll create many soundbites. The Soundbite list helps you manage them. Think of the Soundbite list as your “catalog” of audio data. It lists all of the portions of audio that you are dealing with in the project. It helps you keep the ones you want and throw away the ones you don’t.

Overview .................................................. 193
Quick Reference ........................................... 193
Soundbite menu .......................................... 194
Opening the Soundbite list ............................. 195
Opening the Soundbite list as a window .......... 195
Soundbite Basics ........................................ 199
Mono and stereo audio ................................. 199
Soundbite Management ............................... 200
Dragging and dropping soundbites ................. 203
Working with multiple sample formats .......... 203
Converting sample rate/format .................... 203
Automatic conversions .............................. 204
Importing and exporting audio ..................... 204

Figure 22-1: The Soundbite list serves as a catalog and “command center” for all of the audio files in a project.

Soundbite list: Click the Soundbite list button to show or hide the list.

View By menu: This controls how the soundbites how are sorted: by soundbite name, audio file name, duration, sample rate, and so on.

Search box: Searches soundbite names and audio file names for the entered text. As you type a search term, the window will update in real-time to display the relevant results.

Settings: When you click the Soundbite list to make it the active cell in the Performer Lite window, the Settings menu provides items that apply to Soundbites and the Soundbite list (Figure 22-2).
**SOUNDBITE MENU**

- **New Audio File**: Creates an empty mono, stereo or multichannel audio file on your hard drive.
- **New Audio File from Selected Soundbites**: Creates a new, separate audio file on your hard drive based on the currently selected soundbite(s). In other words, the new audio file will contain a copy of the currently selected audio.
- **Import Audio**: Opens a dialog box that allows you to audition and import audio files and/or individual soundbites. This is the same as the *Import Audio* command in the File menu.
- **Export Selected Soundbites**: Lets you save the currently selected stereo soundbites in a variety of file formats, including AIFF, WAVE, Sound Designer II, and MP3.
- **Edit Audio Export Formats**: Lets you delete and rename saved audio export formats.
- **Columns Setup**: Lets you show and hide the columns in the Soundbite list.
- **New Soundbite Folder**: Adds a new folder to the soundbite list. This command is only available when *Folders* is chosen in the View by menu at the top of the Soundbite list.
- **Select Unused Soundbites**: Highlights all soundbites in the list that are not currently being used in any tracks in any sequence in the file. The highlighted soundbites can be removed from the list or deleted entirely from their parent audio file. (Note that the audio data itself is not removed by deleting. See *Compact* below.)
- **Compact**: Caution! Unlike Delete, this command actually removes audio data from the hard disk. Compact removes all portions of the parent audio file of the currently selected soundbites which are not defined as a region in the audio file region list. This command can be used to remove unused audio data in one or more audio files to free up space on the hard disk.
- **Convert Audio File**: Opens a dialog box that lets you change the sample rate, sample format, file format, and/or interleaved format of the currently selected soundbites in the list. Several levels of quality are provided. For complete information, see chapter 59, “Audio File Conversion” (page 511).
- **Automatic Conversions Settings**: Opens the Automatic Conversions preferences where you configure how Performer Lite automatically converts audio data, wherever necessary, to make it conform to the current project’s sample rate, file format, interleave format, and tempo.
- **Remove from list**: Deletes the soundbite from the Soundbite list without deleting its corresponding region in the audio file region list.
- **Delete soundbite**: Removes the selected soundbites from the list, removing Performer Lite’s reference to the data from the Soundbite list. If the soundbite is the last one in the parent audio file to be deleted, Performer Lite asks if you would like to delete the parent audio file entirely.
OPENING THE SOUNDBITE LIST
To open the Soundbite list, click the Soundbite list button (Figure 22-1), or press its keyboard shortcut, Shift-B. It appears in the right-hand sidebar of the Performer Lite window (Figure 7-3 on page 40).

The Soundbite list provides a complete list of all soundbites in the Performer Lite project, along with detailed information about each soundbite.

OPENING THE SOUNDBITE LIST AS A WINDOW
The Soundbite list can be popped out of the Performer Lite window to become a separate window that shows many columns of detailed information about each soundbite, as shown in Figure 22-3.

To do so, click anywhere on the Soundbite list to make it the active cell in the Performer Lite window, and then choose Window menu > Pop Out of Consolidated window. To put it back in, choose Window menu > Pop Into Consolidated window. The keyboard shortcut for both of these commands is Ctrl-1.

Showing/hiding columns in the soundbite list
The Columns Setup menu item lets you show and hide columns as desired. (As a shortcut, double-click or Option/Alt-click the label at the top of one of the columns to open these preferences.) Figure 22-3 below shows all of the columns.

Rearranging soundbite list columns
To rearrange the order of the columns, drag the label at the top of a column to the left or right. Performer Lite saves your customized column arrangement in the Performer Lite preferences file, so it is remembered in all of your Performer Lite files.

Figure 22-3: The soundbite list with all detail columns shown.
Soundbite list quick reference
Here is a brief explanation of each column in the soundbite list.

**Move Handle:** Drag up or down to reposition the soundbite in the list. Also use it to drag and drop the soundbite into other windows or the computer desktop. When dropping it into an audio track in the Sequence Editor, hold down the Command/ Ctrl key while dragging to make it “snap” to the end of the previous soundbite in the track. A question mark icon on the move handle means that Performer Lite does not currently know the location of the audio file containing the soundbite. The soundbite can’t be played and its waveform can’t be displayed. An ‘X’ icon on the move handle means that Performer Lite cannot currently play the soundbite for some reason. For example, it may not match the current sample rate setting of your audio hardware.

**Name:** Displays the name of the soundbite (region). Click the name to select it and hear it play back. Option/Alt-click the name to rename the soundbite.

**Creation time:** The time at which the soundbite was originally recorded (or created), regardless of where it currently resides. If a soundbite does not have an original time stamps, then no time is shown.

**User time:** Displays the soundbite’s user time stamp, if it has one. A user time stamps can be applied to a soundbite at any time with the Timestamps command in the Audio menu. If a soundbite does not have a user timestamps, then no time is shown.

**Duration (real time):** Indicates the length of the soundbite in hours, minutes, seconds, and hundredths of a second.

**Ticks (duration in ticks):** Displays the length of the soundbite in quarter notes and ticks. If the soundbite doesn’t have a tempo map, this column will be empty.

**Tempo:** In order to make time-scaling musically useful, Performer Lite allows Soundbites to have tempo maps. This makes it very easy for you to manipulate audio along with MIDI without worrying about the tempo, and change the tempo however and whenever you want. A soundbite does not have to have a tempo, but if it does, it is displayed here. If the tempo of the soundbite varies, the average tempo is shown (labeled “avg.”) If the soundbite doesn’t have a tempo map, this column will be empty. For complete information, see chapter 43, “Tempos and Audio” (page 394).

**Sample Rate:** Indicates the rate in samples per second at which the audio data making up the soundbite was sampled.

**Format:** Displays the bit depth (e.g. 16-bit, 24-bit, or 32-bit floating point) of the audio data in the soundbite.

**Interleaved Format:** Displays the interleaved format (mono, deinterleaved, or interleaved) of the audio file the soundbite is from.

**Source:** Explains briefly how the soundbite was created.

**DSP:** The DSP column shows the soundbite’s preference settings for transposing and time scaling. These settings determine what happens (or does not happen) when you attempt to transpose to time-scale the soundbite. Each soundbite can have its own unique settings. For complete information about these preferences, how to set them, and what the results will be, see “Dragging and dropping soundbites” on page 203.
File: This is the name of the audio file that contains the soundbite. Double-click to replace or relocate the soundbite. Option/Alt-click to change the name of the audio file.

Disk: Shows the name of the disk on which the audio file resides.

View By menu
The View By menu at the top of the Soundbite list is a powerful sorting feature that allows you to view soundbites hierarchically by the characteristics shown below in Figure 22-5:

![Figure 22-5: Hierarchical sorting in the Soundbite list.]

When you choose an item from the View By menu, the Soundbite list sorts all soundbites alphabetically and/or numerically based on what you choose, displaying soundbites hierarchically beneath the attribute that you choose, with disclosure triangles so that you can show/hide all of the soundbites for a certain attribute. For example, if you sort by file name, audio files will be listed alphabetically with a disclosure triangle that shows the soundbites indented to the right beneath it, as demonstrated below in Figure 22-6:

![Figure 22-6: Sorting by file name.]

Here are a few other examples: you could sort by Time Created to find a soundbite you recorded during a particular recording session. Or you could sort by Channel Format to view all stereo soundbites currently being used.

Organizing soundbites into folders
The Soundbite list allows you to create your own folders and then view soundbites By Folder. To create a folder, first view By Folder and then choose Create New Folder from the Soundbite menu. A new Folder appears, either at the bottom of the list or just below the currently selected item in the list. You can then drag soundbites into it using their move handles.

☛ When creating a new folder, you may need to scroll to the bottom of the list to see the new folder.

☛ Command–double-click a folder (or any other ‘view by’ container) to select all soundbites within it.
Soundbite source
The Soundbite list displays the source of each soundbite (as shown in Figure 22-7), to provide you with information about where it came from. For example, the source might say “Transpose from Guitar.1” or “Bounce”. This setting can often help you trace the relationships between soundbites. If you view by source type, soundbites are organized into folders for each source type, as shown in Figure 22-7.

Viewing soundbite sources hierarchically with ‘By Folder’ view
The By Folder view has one additional feature over other views: it displays the sources of soundbites and newly generated audio files hierarchically, so that you can trace their origins. For example, if you use the Edge Edit Copy feature to make a new soundbite from an existing soundbite, the new soundbite will be listed below the original with an indentation to the right. If you make yet a third soundbite from the second, it will be listed below the second and further indented to the right. This is demonstrated in Figure 22-8:

There is no limit to the number of possible levels in the hierarchical display shown above in Figure 22-8. This sort of hierarchical grouping only occurs for audio files generated from existing files by operations (such as time-stretching, file-based plug-in processing, etc.) or from soundbite editing operations (such as Edge Edit Copy) where there is a clearly defined source soundbite.

You can separate hierarchically related items by dragging them elsewhere in the list, but the visual representation of their relation to one another cannot be later restored after you’ve done so.

Dragging soundbites into folders
In ‘By Folder’ view, there are two ways to put a soundbite into a folder:

---

**Figure 22-7**: The Soundbite list displays where a soundbite came from in the Source column. In this example, the soundbite list is being sorted by source, as well.

**Figure 22-8**: The ‘By Folders’ view shows the origins of soundbites by displaying them below their source soundbite or audio file. In this example, several soundbites created by edge edit copying are shown below their source soundbite.
by dragging the soundbite’s move handle into the name column to manually determine its position in the list, or

by dragging the soundbite’s move handle onto the folder name in the name column. In this case, the soundbite will be put at the top of the list inside the folder.

If you drag the soundbite’s move handle onto the folder icon, the soundbite will not be placed in the folder. Instead, it will be placed below the folder in the list.

Searching the Soundbite list
A search field is provided to search soundbite names and audio file names (Figure 22-1 on page 193).

As you type a search term, the window will update in real-time to display the relevant results.

To clear the search results and return to the regular view, click the “x” button at the right side of the search field, or press the Escape key.

Shortcut for finding soundbites in the Soundbite list
The shortcut for selecting a soundbite in a track (in the Sequence Editor) and then viewing that soundbite in the Soundbite list is Command-Option-Control-L (Mac) or Ctrl-Alt-Win-L (Windows).

SOUNDBITE BASICS
A new soundbite is created in Performer Lite every time you record audio. For example, when you record-enable an audio track, hit the record button, play in some audio, and press stop, you have just created a soundbite in the track. In addition, the soundbite gets added to the list in the Soundbite list. New soundbites are also generated when you apply file-based DSP operations to existing soundbites, or perform a bounce to disk operation. Any time you create new audio, a soundbite is added to the soundbite list.

Generating soundbites while editing
Soundbites can also be created in Performer Lite with soundbite editing commands like Trim and Trim End. For example, when you select a portion of the existing soundbite and choose Trim, the unselected portions get stripped away, and the highlighted portion that you are left with is a new soundbite. As always, the new soundbite gets added to the list in the Soundbite list.

MONO AND STEREO AUDIO
Soundbites may be mono or stereo. Performer Lite supports both interleaved and deinterleaved audio files as native formats.

When using interleaved audio files, a stereo or multi-channel soundbite stores all of its channels in one file.

When using deinterleaved, a stereo soundbite comes from a stereo pair of files that have the same name (except that one contains ‘.L’ and the other ‘.R’, as in “Guitar-1.L.wav” and “Guitar-1.R.wav”), the same length, the same sample rate, and the same sample format.

When using the deinterleaved format, you can’t really tell the difference from within the program. You can think of a stereo soundbite as a single soundbite that just happens to have individual channel components. But the channels are tightly linked; there is no way to accidentally shift one relative to the other. Even Performer Lite’s pitch-shifting, time-scaling, and tempo-adjusting features preserve the phase relation between the left and right channels of stereo soundbites.
SOUNDBITE MANAGEMENT
As you work with Performer Lite, you’ll create many soundbites. The Soundbite list helps you manage them. Think of the Soundbite list as your “catalog” of audio data. It lists all of the portions of audio that you are dealing with in the file. It helps you save the ones you want to keep and throw away the ones you don’t.

Sorting the soundbites list
The View by menu at the top of the Soundbite list lets you sort soundbites by any criterion shown in the list. For details, see “View By menu” on page 197.

Auditioning soundbites
To audition a soundbite, click it.

If you don’t hear anything, see “Specifying audio output for auditioning” below.

To stop playback, wait for the soundbite to finish playing, or click anywhere.

Specifying audio output for auditioning
When you audition a mono soundbite, Performer Lite plays it via the first mono output bundle that it encounters in the Bundles window (i.e. the highest one in the list). Similarly, when you audition a stereo soundbite, it plays via the highest stereo bundle in the Bundles window list. To change which bundle is used, make it the highest bundle in the list using the move handle.

Renaming a soundbite
To rename a soundbite in the Soundbites list, Option/Alt-click its name.

When you change the name of a soundbite, Performer Lite updates the name of the corresponding region in the audio file. For example, if you use the Trim command to create a new soundbite, it appears in the Soundbite list with a name like Soundbite.3. Performer Lite adds a new region to the audio file region list called Soundbite.3 as well. At this point, if you viewed the audio file’s region list with third-party waveform editing software, you would see Soundbite.3 in the audio file’s region list. If you change the name of Soundbite.3 to Low whistle in Performer Lite’s Soundbite list, Performer Lite updates the name of Soundbite.3 to Low whistle in the audio file region list as well.

Lost soundbites
At times, Performer Lite may lose track of the location of an audio file. For example, the audio file may have been dragged to the trash since the Performer Lite file was last saved. Or the hard disk on which the audio file is located may be off line at

Figure 22-9: Renaming a soundbite.
the moment. In this case, Performer Lite displays the move handle of the soundbite with a question mark as shown below:

Figure 22-11: Performer Lite displays this icon when it does not currently know the location of the audio file containing the soundbite.

Soundbites that cannot be played
If a soundbite cannot be played back for some reason (perhaps its sample rate doesn’t match the current sample of the project), Performer Lite displays an “X” icon as shown below:

Figure 22-12: Performer Lite displays this icon when it cannot play back the soundbite for some reason.

If necessary, you can convert the soundbite’s sample rate using the Convert Audio File menu item (Figure 22-2 on page 194).

Selecting unused soundbites
While you work with Performer Lite, you may find that you have many soundbites in the list, but some of them are not going to be used in the sequence and are no longer needed for any other purpose.

The Select unused soundbites command searches through every track in every sequence in the file to determine which soundbites are being used in a track and which ones are not. It then highlights all the soundbites that are not being used, and you can inspect, audition, delete, or group them as desired to clean up the list.

To select unused soundbites, choose Select unused soundbites from the Soundbite list menu. All soundbites that are not being used in a track become highlighted in the Soundbite list.

Deleting soundbites
The Delete Soundbite command in the Soundbite list menu removes currently selected soundbites from the list. In addition, the soundbite’s corresponding region is removed from the audio file region list as shown in Figure 22-14 below (unless the region is being used as part of a playlist in the audio file).

Figure 22-10: Deleting soundbites removes their corresponding region in the audio file. Just the region and its pointers are removed; not the actual audio data.
Note that the Delete command will only delete the actual audio data when the last soundbite referring to an audio file is deleted. If you want to delete just a portion of the audio data from an audio file, use the Compact command. See “Compacting audio files” on page 576. If you do not want Performer Lite to remove the region from the audio file region list (because it is used in another Performer Lite project, for example), use the Remove from list command described in the next section.

Deleting soundbites that are currently being used in a track
If a soundbite you are deleting is being used in a track, Performer Lite presents a warning box as shown below.

![Figure 22-13: Hold down the Option/Alt key while choosing Delete from the menu to bypass this warning.](image)

Removing soundbites from the soundbites list without deleting their corresponding region in the audio file
There may be times that you wish to delete a soundbite from the list, but you do not want to delete its corresponding region in the audio file region list as shown in Figure 22-14 on page 203. For example, the region might be part of a sequence in another Performer Lite project. In this situation, use the Remove from list command.

After this command severs the connection between the soundbite and the region in the audio file, you won’t have access to the region unless you import it again. Also, after removing a soundbite from the list, you cannot compact its audio data without first importing it and then deleting the soundbite. (See “Compacting audio files” on page 576 for more information.)

Deleting the last soundbite in an audio file
If you delete a soundbite, and it is the last soundbite belonging to a particular audio file, Performer Lite asks you if you wish to completely remove (delete) the audio file from the hard disk:

![Image of warning dialog box](image)

Remember, Performer Lite is cautious about deleting audio data: it never deletes audio data that is possibly being used in other files. Therefore, if an audio file has regions in its regions list, Performer Lite won’t allow you to accidentally delete it.

Bypassing warning dialogs when deleting audio files
You can bypass warning dialog boxes by holding down the Option/Alt key while you choose Delete or Remove from list from the menu. Performer Lite proceeds as if you answer Yes to the alerts.

Deleting an audio file that contains regions
If an audio file contains regions, but you are absolutely sure that you want to throw away the file, you can do so by dragging the file into the trash on the computer desktop.

Getting rid of unused soundbites after a session
After a recording session with Performer Lite, you can quickly get rid of all the soundbites that you did not use in a track as follows:

1. Choose Select unused soundbites from the Soundbite list menu.

This highlights all soundbites that are not being used in a track.
Hold down the Option/Alt key and choose Delete from the Soundbite list menu.

All of the highlighted soundbites are removed from the list, and their parent audio files are deleted from the hard disk.

**Compacting audio files**
The Compact command in the Soundbite list menu deletes portions of an audio file that are not part of a soundbite and then closes the gaps between the leftover regions. For more information, see “Compacting audio files” on page 576.

**DRAGGING AND DROPPING SOUNDBITES**
You can “drag and drop” soundbites into the Sequence Editor and even the computer desktop (or any desktop window). To do so, grab the move handle of the soundbite and drop it into the desired window.

In the Sequence Editor, the soundbite is placed where the cursor is located when you drop. If you hold down the Command/Ctrl key while dragging, the soundbite will “snap” to the end of the previous soundbite in the track from the drop point or the beginning of the track. For more information, see “Dragging and dropping audio into the Sequence Editor” on page 307.

You can drag and drop a soundbite into the left-hand side of the Sequence Editor where the track information panels are displayed to add a new track to the project and insert the soundbite into the new track. The soundbite is placed at its original time stamps, or, if there is none, at the beginning of the track.

**WORKING WITH MULTIPLE SAMPLE FORMATS**
Performer Lite can use 16-bit integer, 24-bit integer, and 32-bit floating point audio files together in the same project, without any conversions.

**CONVERTING SAMPLE RATE/FORMAT**
The Convert Audio File command in the Soundbite list menu allows you to change the sample rate, sample format (bit depth), file format (AIFF, Broadcast WAVE, or Sound Designer II), or interleave format of an audio file or soundbite. Like Performer Lite’s other file-based “constructive” DSP processes, these operations can occur in the background. For complete details, see chapter 59, “Audio File Conversion” (page 511).

![Figure 22.14](image)

Figure 22.14: The Remove from list command leaves the region list in the audio file untouched. You can re-import the soundbites later, if desired.
AUTOMATIC CONVERSIONS
Performer Lite can automatically convert audio data wherever necessary to make it conform to the current project’s sample rate, file format, interleave format and tempo. Because processing is initiated automatically and carried out via background processing (for lengthy operations), these auto-conversion features greatly streamline the process of importing audio quickly into your projects, or the process of converting the entire project to a different sample rate, bit depth or tempo. For complete details, see “Automatic Conversions” on page 229.

IMPORTING AND EXPORTING AUDIO
The Soundbites window provides many features for exporting and importing digital audio into and out of Performer Lite. Many audio file formats are supported.

Importing audio with the Import Audio command
The Import Audio command lets you to browse audio files and soundbites before importing.

To import using the Import Audio command, choose Import Audio from the Soundbites window mini-menu. You’ll see the standard file window (as shown below in Figure 22-15). In this window, you can import individual regions from an audio file (unlike drag & drop into the Soundbite list, which imports all regions), and you can audition them before importing. (See “Specifying audio output for auditioning” on page 338.)

Video sound tracks, MP3 files and many other types of audio files can be auditioned in the Import Audio dialog.

Performer Lite can natively use interleaved or deinterleaved 16-bit, 24-bit, or 32-bit floating point audio files in AIFF and WAVE formats.

Other types of audio files are converted into the project audio file format for use in Performer Lite. For a list of audio file types that can be imported, see “Audio file formats that can be imported” on
page 205, and for details on the conversion settings, see “Automatic Conversions” on page 920.

**Importing and exporting audio by drag & drop**  
Performer Lite supports standard drag and drop techniques for importing audio files from the computer desktop into any window in Performer Lite that holds audio, such as the Soundbites window. This is true for all of the supported file formats listed in “Audio file formats that can be imported” on page 205. If the imported file does not match one of Performer Lite’s supported native formats, Performer Lite can automatically convert the file for you.

Soundbites can be exported in a similar fashion by grabbing their move handle in the Soundbites window and dragging them to the computer desktop (or any window on the computer desktop).

**Importing an entire audio file**  
The easiest way to import an entire audio file is to drag and drop it into a track in Performer Lite’s Sequencer Editor. Make sure the track type (mono or stereo) matches the audio file. You can also import an entire audio file using the Import Audio File menu command as described in the previous few sections.

**Converting soundbites that cannot be played**  
When you import soundbites into Performer Lite, it may be the case that they cannot be played properly. For example, the imported audio’s sample rate might not match the playback sample rate currently chosen in the Configure Hardware dialog box. In this case, Performer Lite can automatically convert the audio to the project’s sample rate, sample format and even tempo. For complete details, see “Automatic conversions” on page 204.

If an audio file has a sample rate that does not match the current sample rate setting in the Configure Audio System > Configure Hardware Driver command in the Setup menu, it appears with an “X” on its move handle in the Soundbites window, as shown in Figure 3-12 on page 49. You can play the audio file either by changing the sample rate setting in the Configure Hardware dialog to match the audio file, or by changing the sample rate of the audio file itself with the Convert Audio File command in the Soundbites window mini-menu. For more information, see chapter 59, “Audio File Conversion” (page 511).

**Audio file formats that can be imported**  
Performer Lite is able to import the following audio file formats:

- AIFF
- WAV
- Broadcast WAV (non-MPEG)
- Sound Designer II
- mp3
- Acid
- REX (and RCY)
- Apple Loops (AIFF or CAF)
- Core Audio Format (CAF)
- QuickTime movies
- AVI movies
- Audio CD files
- MuLaw files

You can import any of the file formats above by dragging the file into Performer Lite and dropping it into the Soundbites window or — in most cases — any window that holds audio.
If you drag and drop an audio file into Performer Lite’s Soundbites window, all of the regions in the audio file are imported.

**Importing REX files**
Recycle 1.0 and 2.0 REX files can be imported into Performer Lite, either by dragging and dropping them from the computer desktop into a mono or stereo audio track, or by using the Import Audio command (File menu). Recycle 1.0 RCY files can also be imported.

**Importing a REX file into a track**
When you drag and drop a REX file into a track, be sure that the track format (mono or stereo) matches the REX loop. As shown in Figure 22-16, the individual audio slices in the REX loop are placed in the track at the appropriate measure, beat and tick location to preserve the feel of the loop at the current tempo of the sequence. After importing, each slice of the REX loop is treated as individual soundbite, both in the track and in the Soundbites window.

If you change the tempo, the REX slices will “breath” with the tempo, staying precisely in time with the conductor track. When they are first imported, REX slice soundbites are given the Don’t time scale attribute in the Soundbites window, so each individual slice won’t be automatically time-stretched when the tempo is changed. However, you can easily change this attribute to Time Scale in the Soundbites window, as explained below.

**Importing REX files into the Soundbites window**
You can import REX files using the Import Audio command in the Soundbites window mini-menu (or the File menu). This opens the audio import window, in which the REX file can be auditioned before importing. Just enable auditioning by...

![Figure 22-16: Importing a REX file into a track. Each slice is placed as a separate soundbite to conform to the sequence’s meter and tempo.](image-url)
clicking the speaker button and the click on the REX file in the file list. After importing, all of the REX file’s individual slices are handled as individual soundbites, with no further grouping or association. Therefore, it is better to drag and drop a REX file into a track, where you can then loop, repeat or cut/paste it as a whole loop.

Viewing REX loop slices and changing their time-stretch attribute
You can easily view all of the soundbite slices that belong to a REX file with the Soundbite window’s sorting features. Just view by file name, and the REX file will appear with a disclosure triangle next to its name that lists all slices below it. If you wish to change the time scale attribute of the slices, select them and open the Sound File Information window, and choose either Time Scale or Don’t Time Scale for the Time Compress/Expand soundbite attribute. You can do so for multiple selected soundbites (REX slices) at one time. If you don’t time scale the slices, you might (but are unlikely to) hear gaps between the slices when using the loop at a tempo that is considerably less than its original tempo. Most of the time, however, you will get better results with the Don’t Time Scale setting, which preserves the audio slices in their original form (tempo). For more details, see “Sound File Information” on page 365.

Acid file and Apple Loop import
Performer Lite can import Acid WAV and Apple Loop AIFF files. To do so, drag and drop the Acid or Apple Loop file into the Soundbites window or into an audio track of the same format (mono or stereo). Or import them as usual using the Import Audio command in the Soundbites window mini-menu (or the File menu). If the file has a tempo, the tempo will be imported with the audio so that it will automatically conform to the sequence tempo when placed in a track, as long as automatic tempo conversion (as explained in “Automatic Conversions” on page 89) is enabled.

Audio file exporting
The Export Selected Soundbites command in the Soundbites window mini-menu can export any soundbite in the file formats shown in Figure 22-17 for Mac and Windows.

For the macOS Core Audio Export formats, stereo soundbites are exported in the interleaved stereo version of these formats.

For further information about exporting to the MP3 file format, see “Bouncing to MP3” on page 960, as MP3 export works the same way for bouncing as it does for exporting.

Saving an audio export preset
To create and save an audio export preset, check the Save Settings as Audio Export Format option in the audio export dialog (Figure 22-17). If there are any additional settings required, they will appear in subsequent dialogs. Then, you’ll be asked to name your export preset. After a preset has been saved, it appears in the audio export file format menu (shown in Figure 22-17) for your convenience, as well as the Bounce to Disk format menu (Figure 84-8 on page 959). To use an export...
preset, simply choose it from the menu when bouncing or exporting. These presets are saved as a preference, so they are not project-specific. They are global to all projects. See also “Editing audio export presets” on page 959.
CHAPTER 23 Set List

OVERVIEW
The Set List displays the sequences and V-Racks in a Performer Lite project file. A sequence is a collection of disk tracks, instrument tracks and/or aux tracks. A V-Rack™ is a collection of instrument tracks and/or aux tracks. A Performer Lite file can contain as many sequences and V-Racks as memory in your computer will allow. Sequences can be cued for playback, either automatically or manually.

V-Racks have no disk tracks and therefore do not "play back" in the same sense as sequences. Instead, they serve as a virtual “effects rack” that can also contain virtual instruments. These effect and instrument plug-ins can be accessed by any audio and/or MIDI track in the currently play-enabled sequence.

Set List Quick Reference .............................................. 209
Set List basics .............................................................. 210
Sequence cuing and chaining ................................. 214

SET LIST QUICK REFERENCE

Type: Displays each item by icon. Drag this icon vertically to reorder items in the Set List.

Figure 23-2: The sequence and V-Rack icons.

Col (color): Click to choose a color for the sequence.

Play: Shows the play-enable button for each sequence. When a play-enable button is blue, the sequence is play-enabled. Only one sequence can be play-enabled at a time. V-Racks, on the other hand, display a blue power icon to indicate that they are active and available at any time. Click their power icon at any time to bring them on line or to take them off line.

Name: Displays the name of the sequence. Click the name to select the sequence. Option/Alt-click the name to change it. Double-click the name to open the Sequence Editor belonging to the sequence.

Search

Figure 23-1: The Set List shows sequences and V-Racks in the Performer Lite project.

Because sequences can be imported into other files, use the most descriptive sequence name possible to avoid confusion.

S# (Song Select Number): Displays the song select number that will play-enable the sequence when received from a MIDI controller. Song select numbers range from 0-127. If a sequence has no song number assigned, the column displays a single dash (-). V-Racks do not have a song select number because they do not have disk tracks that play back in the conventional sense.
If Performer Lite receives a song select number that is assigned to two or more sequences, Performer Lite will cue the sequence that appears highest in the list. For this reason, it is best to assign a unique Song Select number to each sequence.

**End time**: Displays each sequence’s End time. End time is the downbeat of the measure following the last complete measure in the sequence. When a sequence’s End time is specified manually, it is bold and can be edited to be any length. V-Racks do not have an end time because they hold no audio or MIDI data.

**Comments**: Click to view and edit the comment for the sequence or V-Rack.

**Next/Previous Sequence buttons**: If you have more than one sequence in the file, these buttons skip to the next or previous one.

**Cue button**: When highlighted, the Cue button play-enables the next sequence in the Set List after the current playback sequence reaches its End time and stops. To begin playback of the next sequence, press the Play button (or a command for the Play button).

**Chain button**: When highlighted, the Chain button starts playback of the next sequence in the list after the current sequence reaches its End Time.

**Search**: If you have a lot of sequences in the list, type in the name of the one you are searching for.

### The Set List menu

The Set List menu contains the following commands:

- **New Sequence**: Creates a new sequence. To create several sequences at once, press the Option/Alt key while choosing New Sequence.

- **New V-Rack**: Creates a new V-Rack. To create several V-Racks at once, press the Option/Alt key while choosing New V-Rack.

- **Duplicate Track Layout**: Creates a new, empty sequence with the same track layout as the selected sequence. Select an existing sequence before choosing this command.

- **Duplicate Sequence**: Creates an exact copy of the currently selected sequence.

- **Auto/manual end time**: Toggles the Auto/manual status of the selected sequences. Automatic mode locks the sequence’s End time at the downbeat of the measure following the last complete measure in the sequence. Manual mode changes the time to boldface and allows it to be edited.

- **Set Sequence Start**: Establishes the start times of the currently selected sequences in three of Performer Lite’s time formats: measures, real time, and SMPTE time. The start times are what you see in the Counter when you rewind back to the beginning of the sequence.

- **Delete**: Deletes the selected sequences.

### SET LIST BASICS

The Set List displays the sequences in a file and provides useful features to manage them, such as adding, deleting, and other operations. Sequences can also be automatically cued to playback in the order in which they are listed in the Set List. For more information about cuing, see “Sequence cuing and chaining” on page 214. Sequences can
also be cued remotely from your MIDI controller. For more information, refer to chapter 28, “Commands” (page 234).

Opening the Set List
To open the Set List, click the Set List button (Figure 7-2 on page 40). The Set List appears in the right-hand sidebar, displaying a list of all sequences and V-Racks in the open file.

Selecting Sequences
There are several methods of selecting sequences:

To select a single sequence, click on its name. The name will highlight.

To select several adjacent sequences, click a sequence name and drag over the desired names. All sequences dragged over will highlight.

To select several non-adjacent sequences, hold down the Command/Ctrl key and click on the names of the sequences you wish to select. They will highlight.

To deselect sequences when more than one are highlighted, hold down the Command/Ctrl key and click on the sequences you wish to deselect. They will unhighlight.

Creating new sequences
To create a new, empty sequence, choose New Sequence or New V-Rack from the Set List mini-menu. To add several at once, hold down the Option/Alt key while choosing Add. You will be prompted for the number of sequences to add.

To create a new sequence with the same track layout as an existing Sequence, highlight the existing sequence and select Duplicate Track Layout from the Set List mini-menu. A new sequence will be added with the same name as the sequence you highlighted, appended by the word “copy”. It will have the same track layout as the original: the number of tracks, the track names, and the track output assignment will be identical to the original.

Duplicating existing sequences
Sometimes you may want to duplicate a sequence to experiment with changes or for some other reason. To duplicate a sequence:

1. Select the sequence.

2. Choose Duplicate Sequence from the Set List menu.

An exact copy of the sequence, including all the data in the tracks, will be placed at the end of the Set List.

Copying and pasting Sequences between projects
You can copy and paste entire sequences and/or V-Racks that have been selected in the Set List. When copying and pasting sequences, all soundbites and sequences used in them are also copied and pasted into the destination project.

Splitting up a sequence into separate sequences
The Copy selection to new sequence command in the Sequence Editor menu (page 105) takes the current selection and turns it into its own sequence in the Set List window.

To create a sequence Sequence from the Sequence Editor window:

1. Make any selection that you wish.

2. Choose Copy Selection to New Sequence from the Sequence Editor menu.

A dialog box appears.
3 Type in a name for the sequence.

4 Type in an End Time to determine the length of the sequence.

By default, the end time is determined by the length of the selection.

5 (Optional) Type in any other information you wish.

6 Press OK to confirm your choice or Cancel to withdraw the command.

Deleting sequences
To delete a sequence, click its name to highlight it and choose Delete from the Set List mini-menu. To delete several sequences at once, highlight the name of each one as described in the Selecting Sequences section above. You can Undo this command.

Choosing the current playback sequence
At any given time, one sequence is designated for playback, and it is the only one you can play and record into. Certain functions, such as recording, are available only to the currently play-enabled sequence. For example, if a sequence is play-enabled, its tracks have record-enable buttons.

V-Racks, on the other hand, are always play-enabled, making their tracks available at all times to the currently play-enabled sequence.

You may edit any sequence in the file at any time regardless of whether it is play-enabled or not.

To play-enable a sequence:

- Click the play-enable button to the left of its name. It will turn blue. The play-enable buttons of the other sequences will be gray.

OR

- Click the Next/Previous Sequence buttons as needed until the sequence’s play button turns blue.

OR

- Select the sequence from the Sequence sub-menu in the Settings menu.

Play-enabling by remote control
Performer Lite also provides two different methods of play-enabling sequences from a remote device.

Sequence Selection commands
The first method is with the Sequence select Commands found in the Commands window, where each Sequence is assigned a computer key binding and MIDI event. You play-enable a Sequence by pressing its corresponding computer key binding or sending its corresponding MIDI event from your MIDI keyboard (or controller). Please refer to chapter 28, “Commands” (page 234) for more information.

Song Select messages
The second method is Sequence Select, which allows you to cue sequences for playback by sending a MIDI Song Select message from a MIDI controller. The Set List column S# displays the Song Select number that, when received, will cue the corresponding sequence for playback. If a sequence has no Song number assigned, the S# column displays a single dash (-).
Most hardware sequencers and some MIDI keyboard controllers can send and receive Song Select messages. Simply send a Song Select message as instructed in that module’s documentation. If the open file contains a sequence assigned to the Song number in the message, that sequence will be play-enabled. If more than one sequence has the same Song number assigned, the one highest in the Set List will be cued.

When used in combination with the Sequence Chaining buttons in the Set List, a Song Select message cues the corresponding sequence to be play-enabled or played back.

**Rearranging the order of sequences**

You can rearrange the Sequences in any order you wish. To change the position of a Sequence in the Set List:

1. Press the type icon of the Sequence you want to move.

   The cursor changes into that sequence icon.

2. Drag and drop the mouse to the position where you want the Sequence.

   If you wish to move two or more Sequences at once:

   1. Shift-click or Command/Ctrl-click their names to select them.

   2. Grab the type icon of one of them.

   3. Drag and drop to the position in the list where you want them.

Rearranging the order of the Sequences is a useful organizational tool. In addition, it lets you determine the Sequences’ default cuing order when using the Next/Previous Sequence, Cue Sequences, and Cue buttons described later in this chapter.

**Changing the name of a sequence**

To change the name of a Sequence:

1. Option/Alt-click the name of the sequence.

   A small box will pop up.

2. Type the sequence name in the box.

3. Press the Return key or click outside the box to confirm the name or Command/Ctrl-period to cancel it.

You can use the Enter or Down Arrow key to approve the change and edit the next sequence name in the list. You can also use the Up Arrow key to approve the change and edit the previous sequence name in the list.

**Entering comments**

To enter or modify comments for a sequence:

1. Click in the comments field to the right of the sequence name.

   A box appears. If you’ve already entered a comment for the sequence, the entire comment appears highlighted in the box.

2. Enter or edit the comment.

3. Click OK to confirm the changes you’ve made and close the comments box, or click Cancel to discard the changes.

Press the Down Arrow key or the Enter key to approve the changes you’ve made and move to the comment for the next Sequence. The Up Arrow key likewise moves to the comment for the previous Sequence.

When entering or editing a comment, the Return key starts a new line of text instead of approving the changes as usual in Performer Lite’s user interface.
Auto versus manual end time
The Set List field End Time displays either the automatic, Performer Lite-generated ending time of the Sequence, or a time that you have entered manually. It’s important to understand how this time affects your music.

Performer Lite can play Sequences sequentially with the Cue, Chain, and Next/Previous Sequence buttons in the Set List. When using these Sequence controls, you’ll find that each Sequence’s End time affects its playback length. For example, clicking Play with the Cue button enabled causes playback of one Sequence after another, each Sequence playing until the counter reaches that Sequence’s End time. Phrases, even notes that normally would last through the End time will be cut off. You can avoid this by setting a Sequence’s End time to be later, thereby building sustain into the Sequence’s play length.

SEQUENCE CUING AND CHAINING
The Next/Previous Sequence buttons (Figure 23-3) cue up (play-enable) the next or previous Sequence in the Set List, similar to the skip buttons on your favorite music player.

To begin playback of the next sequence, press the Play button, or a command for the Play button.

The Chain button
The Chain button (Figure 23-3), when highlighted, starts playback of the next Sequence in the Set List after the current playback Sequence reaches its End time. This is a simple way of automatically chaining Sequences in their Set List order.

Sequence cuing is not seamless
Sequence cuing does not yield seamless transitions between Sequences. Use cuing for situations where a pause between Sequences — either brief or indefinite — is acceptable or preferred.

For example, sequence cuing is perfect for live performance. Before a set, you could organize the Set List in the order you wish for the set. To begin the set, you simply press play. When the first sequence ends, the next sequence automatically cues up, and you can trigger it at your leisure from your MIDI keyboard. Or, with the Chain button, you can have Performer Lite go right into the next sequence without waiting.

It is also possible to cue and play Sequences remotely from your MIDI controller. For more information, see chapter 28, “Commands” (page 234).

For seamless chaining, it is better to consolidate multiple sequences into a single master sequence that plays continuously from one to the next. This can be done by copying and pasting from component sequences into a master sequence.

Viewing the Sequence End Time
When the Cue or Chain button is highlighted, the end time of the sequence is graphically displayed as the end of the Memory Cycle bar.
CHAPTER 24 Sequence Basics

OVERVIEW
Performer Lite is modeled after the straightforward, conventional concept of a multitrack recorder. For a multitrack tape recorder, the basic unit of musical organization is a reel of tape. Typically, one song would be recorded on one reel of tape.

In Performer Lite, the basic unit of organization is called a sequence (a term that originates from Performer Lite’s roots as a MIDI sequencer). A sequence holds a set of tracks. (Think of a sequence as a reel of tape — or one section of the tape, like the chorus or the first verse.) Each track, in turn, holds an individual stream of MIDI or audio data.

Every Performer Lite project must contain at least one sequence. By default, this sequence is named “Seq-1”.

SEQUENCE TYPES
There are two kinds of sequences: sequences and V-Racks. Each type is described briefly below.

Sequence
A sequence is a complete performance of MIDI and/or audio consisting of any number of tracks, which are shown in the Sequence Editor, Mixing Board, and so on. Each track contains MIDI or audio data which may be assigned to a MIDI destination or audio output. A sequence also has a Conductor track, which contains meter, key, and tempo information.

V-Rack
V-Racks“ (virtual racks) are similar to sequences, except that they have no time domain and they do not hold track data or automation. The only types of tracks that you can add to them are Instrument tracks, aux tracks and master faders. As such, they are intended to be used as “effects” racks, a centralized location for effects processing and virtual instruments.

For more information, see chapter 25, “V-Racks” (page 216).

MANAGING SEQUENCES AND V-RACKS
The Set List window lets you add, duplicate, delete, rename, and otherwise manage multiple sequences and V-racks in your Performer Lite project. For complete details, see chapter 23, “Set List” (page 209).
CHAPTER 25  V-Racks

OVERVIEW
V-Racks™ (virtual racks) are similar to sequences, except that they have no time domain and they do not hold track data or automation. The only types of tracks that you can add to them are Instrument tracks, aux tracks and master fader tracks. As such, they are intended to be used as “effects” racks, a centralized location for effects processing and virtual instruments.

V-Racks can be created and managed in the Set List window. See chapter 23, “Set List” (page 209).

V-RACK BASICS
V-Racks™ (virtual racks) are similar to regular sequences, but they are streamlined as follows:

- They have no time domain.
- They do not hold track data or automation.
- The only types of tracks that you can add are: Instrument tracks, aux tracks and master faders.
- They do not have a Sequence Editor or any other type of edit window. The only window that can be opened to modify them is the Mixing Board.

V-Racks have several significant characteristics that makes them very useful:

- They are always active, regardless of what sequence is play-enabled.
- Their track inputs and outputs are always available to all other sequences in the project.
- They provide all of the real-time processing capabilities of a regular sequence, including the ability to host virtual instruments.

A virtual effects and instrument rack
When you add up all of the above characteristics, essentially what you have is a virtual effects and instrument rack — hence the name V-Rack.

V-Racks are ideal in situations where you are using multiple sequences in a project, as the following examples illustrate.

Virtual instruments
A very common situation is as follows: you have a project with multiple sequences that are all playing the same virtual instrument. For example, you might be working on different variations of a song (the original version plus several remixes). But they are all playing essentially the same sounds loaded into MachFive (or other multi-part virtual instrument). To work most efficiently, you can create one instance of MachFive in a V-Rack, and then access MachFive from any of the other sequences, just as if it were instantiated in each sequence individually. By instantiating it only once in the V-Rack, you save memory and computer processing resources. Samples and patches will not need to reload when switching among sequences.

Mastering
Another very common situation is this: you have multiple sequences that you want to master using the same mastering effects chain. To ensure consistency and to maximize efficiency, you can add a master fader track to a V-Rack, apply the desired effects processing and then run the master output of each individual sequence into the master fader in the V-Rack. Regardless of which sequence...
is play enabled, the V-Rack master fader settings can be applied. Not only do you conserve your computer’s processing resources (since you only have to create one instance of the effects), you also ensure that each individual sequence is processed with exactly the same plug-in settings in your mastering chain.

Effects loops
A another common situation is this: you have multiple sequences and you wish to use the same effect in all of them as a send/return loop. For example, suppose all your sequences contain vocal tracks that you would like to process through identical compression and reverb. To once again ensure consistency and simplify the setup of this loop across all sequences, you can add an aux track to the V-Rack and then add the desired effects chain plug-ins to it. Set the input to be a bus, and its output to be the main outs (or another bus, for added flexibility). Now, all tracks in any sequence assigned to that effect bus will receive identical effect processing.

Live effects processing
A final example for V-Racks is this: you are performing music in a live context, and you would like to have an effects chain set up that is always active, regardless of what sequence is playing back. You could set up an aux track in a V-Rack from a physical input on your audio hardware to a physical output, and add whatever processing you would like. Now Performer Lite can perform as a virtual effects rack, no matter which sequence is play enabled.

CREATING A V-RACK
You can add any number of V-Racks to a Performer Lite project in any of the following ways:

- Choose Project menu> Sequences> New V-Rack
- Choose New V-Rack from the Set List menu.

Selected V-Rack

V-RACK QUICK REFERENCE
Move handle: Drag this handle vertically to change its position in the list.

Enable/Disable: Brings the V-Rack on line (active and processing audio) or offline (inactive).

WORKING WITH A V-RACK
V-Racks are viewed in the Mixing Board. To view a V-Rack, do one of the following:

- Double-click its name in the Set List
- Choose Show V-Racks from the Mixing Board menu (page 159)
- Choose V-Rack Edit from the Mixing Board menu

For your convenience, in the Commands window (Setup menu), there is a command called V-Rack Edit that switches the Mixing Board between the sequence and V-Rack that was last viewed in the Mixing Board. The default keyboard shortcut is Command/Ctrl-Shift-V.

Adding tracks to a V-Rack
After you have opened the V-Rack in the Mixing Board, you can then add aux tracks, instrument tracks and master faders to it using any of the
standard techniques for adding tracks to a sequence. For example, you could choose Project menu > Add Track.

Moving tracks from a sequence to a V-Rack
If you would like to move an aux track, master fader or instrument track from a regular sequence to a V-Rack:

1 Make sure the source sequence is play-enabled.
2 Select the tracks you wish to move.
3 Choose Move Selected Tracks to V-Rack from the Sequences sub-menu in the Settings menu (Figure 7-3 on page 40)
4 Choose the desired destination V-Rack from the resulting dialog.

The track disappears from the source sequence and is moved to the destination V-Rack.

Deleting tracks from a V-Rack
To delete tracks from a V-Rack, choose Delete Track from the pop-up menu at the bottom of each channel strip in the Mixing Board.

The V-Rack button
The V-Rack (V) button in the lower left corner of the Mixing Board window toggles between the last-viewed sequence and the last-viewed V-Rack.

Displaying V-Racks alongside a sequence
To display V-Racks alongside your sequence tracks in the Mixing Board, use the Show V-Racks option in the Mixing Board menu.

When enabled, the V-Rack tracks will be displayed to the right of your sequence tracks (Figure 25-4) and each V-Rack is displayed as a track folder in the Mixing Board’s track selector (Figure 25-4).

To hide individual tracks from the V-Racks, deselect their names in the track selector (Figure 25-4); to hide an entire V-Rack, deselect the V-Rack’s folder by clicking on its name, or collapse the folder by clicking its disclosure triangle.

V-Rack tracks are visually separated from sequence tracks by divider lines as shown in Figure 25-4. Additionally, each sequence and V-Rack has a label with its name above their associated tracks.
Figure 25-4: V-Rack tracks alongside sequence tracks in the Mixing Board.
CHAPTER 26  Tools

OVERVIEW
Tools are available in the Primary and Alternate Tool menus in the Control Panel (Figure 16-1 on page 87). Tools are used for inserting, selecting, editing, reshaping, zooming, looping and scrubbing data in Performer Lite’s various editors.

Figure 26-1: The Tool palette.
MAIN AND ALTERNATE TOOLS
The Main and Alternate Tool menus in the Control Panel (Figure 16-1 on page 87) let you choose two different tools that you can quickly switch between using a keyboard shortcut, to avoid repetitive trips to the Tool palette. See “Primary and alternate tools” on page 100.

KEYBOARD SHORTCUTS FOR TOOLS
Hold down the following keys for tool selection:

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer tool</td>
<td>A</td>
</tr>
<tr>
<td>I-Beam tool</td>
<td>I</td>
</tr>
<tr>
<td>Pencil tool</td>
<td>P</td>
</tr>
<tr>
<td>Reshape tool</td>
<td>R</td>
</tr>
<tr>
<td>Zoom tool</td>
<td>Z</td>
</tr>
<tr>
<td>Mute tool</td>
<td>M</td>
</tr>
<tr>
<td>Scissor tool</td>
<td>C</td>
</tr>
<tr>
<td>Slip tool</td>
<td>, (comma)</td>
</tr>
<tr>
<td>Slide tool</td>
<td>. (period)</td>
</tr>
<tr>
<td>Roll tool</td>
<td>' (apostrophe)</td>
</tr>
<tr>
<td>Trim tool</td>
<td>/</td>
</tr>
<tr>
<td>Comp tool</td>
<td>B</td>
</tr>
<tr>
<td>Velocity tool</td>
<td>V</td>
</tr>
<tr>
<td>Hand tool</td>
<td>G</td>
</tr>
</tbody>
</table>

**Tool shortcuts can be “sticky”**
If you double-tap the keys shown in the tool shortcuts above, the tool will remain selected until you select another tool.

**Cycling tools**
Shift-tilde (~) cycles to the next tool.

POINTER TOOL
The Pointer tool produces the standard ‘cross-hair’ selection cursor for ‘marquee’ selections over multiple events and ‘finger’ selection cursor for selecting and editing individual events. For example, you could select several measures of notes by positioning the cross-hair cursor over an empty portion of the data grid and dragging out a selection box over the desired events. Here’s a summary:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this with the Pointer tool:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select an event</td>
<td>Click it with the ‘finger’ cursor.</td>
</tr>
<tr>
<td>To select several events</td>
<td>Shift-click each one.</td>
</tr>
<tr>
<td>To select a region of events</td>
<td>Drag a selection box over them with the cross-hair cursor. To get the cross-hair, position the cursor over an empty cell.</td>
</tr>
<tr>
<td>To select all events within a time range</td>
<td>Drag in the time ruler.</td>
</tr>
<tr>
<td>To duplicate an event</td>
<td>Option/Alt-drag it.</td>
</tr>
<tr>
<td>To move an event</td>
<td>Drag it with the finger cursor.</td>
</tr>
<tr>
<td>To move several events together</td>
<td>Select them, grab one with the finger tool and drag.</td>
</tr>
<tr>
<td>To change the duration of a note (only available where note durations are displayed)</td>
<td>Position the cursor over its right edge until you see the ‘hand’ cursor and then drag it.</td>
</tr>
</tbody>
</table>

The Pointer tool can use different selection modes, which will change what kinds of selections are made in some places; see “Choosing a Pointer tool selection mode” on page 282.
I-BEAM TOOL

The I-Beam tool allows you to make time range selections in any editor, regardless of the material you are dragging over to make the selection. Time range selections in the Sequence Editor are much easier with this tool, especially when you are making selections that begin in the middle of soundbites. As usual, you can hold down the Shift key while using the I-Beam tool to extend or shorten the current selection. Shift-click other tracks to add them to the current selection without changing the start and end times. To make a time range selection that matches the duration of a soundbite or MIDI note, double-click the soundbite or note with the I-Beam. To temporarily get the I-Beam cursor when another tool is selected, hold down the “i” key.

Here are some further details about double-clicking with the I-Beam to create time range selections.

Selecting soundbites with the I-Beam tool
If, using the I-Beam tool, you double-click a portion of a soundbite that is partially covered by other soundbites, you’ll select the entire soundbite, even the parts that are covered. However, if you hold down the Option/Alt key while double-clicking it with the I-Beam tool, you’ll only select the portion of it that you clicked, as determined by soundbites that cover it on either side of where you click.

Selecting MIDI notes with the I-Beam tool
If you double-click a MIDI note with the I-Beam cursor, you aren’t really double-clicking the note itself. Instead, you are clicking a location in time for all pitches in the track. Doing so creates a time range selection that is determined by any notes of any pitch whose duration crosses the time location you clicked.

Here’s an example: if you double-click a MIDI note, you’ll get a time range selection in the track that matches the duration of the note. If the note’s duration overlaps the duration of another note (of the same pitch or a different pitch), then you can double-click it with the I-Beam tool in two places: where it overlaps, or where it doesn’t overlap. If you double-click where it overlaps, you’ll get a time range selection that includes the durations of both notes. If you double-click where it doesn’t overlap, you’ll get a time range selection of just the note you clicked.

I-Beam cursor
Click the I-Beam tool at any location in any Sequence Editor to place an I-Beam cursor (flashing vertical line) wherever you click. The I-Beam cursor serves two basic purposes:

■ An insertion point for a paste or merge operation
■ An anchor point for selection commands

For further information about making selections with the insertion point, see “Initiating time range selections with an insertion point” on page 285 and “Modifying a time-range selection using the computer keyboard” on page 285.

PENCIL TOOL

The Pencil tool lets you insert data using the following techniques:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this with the Pencil tool:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To insert an event</td>
<td>Click in a note grid or continuous data grid.</td>
</tr>
<tr>
<td>To remove a MIDI note</td>
<td>Click it on a MIDI note grid.</td>
</tr>
<tr>
<td>To insert continuous data curve</td>
<td>Click the master track button for the desired track, if any, click the Pencil tool, choose the desired shape from the in the Tool palette, choose the desired data type in the continuous data grid (or make it the active layer in the Sequence Editor) and then click or drag on the grid.</td>
</tr>
<tr>
<td>To edit audio pitch automation</td>
<td>Click and drag on the audio pitch display.</td>
</tr>
</tbody>
</table>
**INSERT/RESHAPE CURVE**
Controls the shape or curve of continuous data when you insert it with the Pencil tool or modify it with the Reshape tool. For complete details, see “Inserting CC data in Points or Bars mode” on page 299 and “Reshape tool”, below.

**RESHAPE TOOL**
The Reshape tool lets you reshape a stream of continuous data. For complete details, see “Reshape Mode menu”. The techniques can be used for any continuous data, including volume data for audio and MIDI tracks in the Sequence Editor.

**RESHAPE MODE MENU**
Performer Lite provides several powerful ways to reshape continuous data curves.

A variety of reshape modes are available, as shown in Figure 26-1 on page 220 and summarized below:

<table>
<thead>
<tr>
<th>Reshape mode</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set</td>
<td>Forces data values to exactly match the curve that you draw.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds or subtracts a fixed amount to all data values based on how far above or below the origin you draw the reshape curve. Draw above the origin to add; draw below it to subtract.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scales all data values based on how far above or below the origin you draw the reshape curve. Draw above the origin to scale up; draw below it to scale down.</td>
</tr>
<tr>
<td>Max limit</td>
<td>Lowers all data values that are above the reshape curve.</td>
</tr>
<tr>
<td>Min limit</td>
<td>Raises all data values that are below the reshape curve.</td>
</tr>
</tbody>
</table>

You can reshape any kind of continuous data, such as MIDI continuous controllers, audio volume automation, etc. To reshape a stream of continuous data, in this example a MIDI CC:

1. Click the Reshape tool in the Tool palette.

2. Choose the desired shape of the curve from the Pencil/Reshape Curve menu in the Tool palette (Figure 26-1 on page 220).

3. Drag over the data you wish to reshape, as demonstrated below in Figure 26-2.

   ![Figure 26-2: In this reshape example, a stream of volume controllers are being scaled with the sine wave reshape tool.](image)

**ZOOM TOOL**
The Zoom tool (magnifying glass) in the Tool palette lets you zoom in on a portion of an editor by dragging a zoom box over it. Click to zoom in and Option/Alt-click to zoom out. In the time ruler or continuous data grid, drag horizontally to zoom the time axis only.
**Zoom tool shortcuts**

Here are some zooming shortcuts:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click once</td>
<td>To zoom in horizontally.</td>
</tr>
<tr>
<td>Option/Alt-click</td>
<td>To zoom out horizontally.</td>
</tr>
<tr>
<td>Shift click</td>
<td>To zoom backward through zoom history</td>
</tr>
<tr>
<td>Shift-control click</td>
<td>To zoom forward through zoom history</td>
</tr>
<tr>
<td>Drag in the time ruler</td>
<td>To fill the window with the region you select without affecting the pitch zoom</td>
</tr>
<tr>
<td>Drag over an area in the note grid</td>
<td>To zoom time and pitch simultaneously</td>
</tr>
<tr>
<td>Option/Alt-click the zoom out button</td>
<td>To zoom all the way out</td>
</tr>
<tr>
<td>Option/Alt-click the zoom in button</td>
<td>To zoom all the way in</td>
</tr>
<tr>
<td>Command/Ctrl-click the zoom buttons</td>
<td>To toggle between the last two zoom levels</td>
</tr>
</tbody>
</table>

For other zooming features and shortcuts, see “Zooming” on page 274.

**MUTE TOOL**

The Mute tool mutes and unmutes soundbites or MIDI notes when you click them or drag over them in the Sequence Editor. The Mute tool only works when soundbites or MIDI notes are the active layer in the track. Muting occurs independently of any volume automation in the track. Muted soundbites appear with a grayed-out waveform; muted MIDI notes appear as grayed out notes.

The Mute tool is a handy way to temporarily mute soundbites or notes, but it is also great for arranging and creating interesting rhythm parts. Here’s just one example: use the Scissors tool to split an ambient pad into a rhythmic grid of slivers (explained further in the next section) and then use the Mute tool to quickly create syncopated riffs by muting various combinations of the slivers.

To temporarily get the Mute tool when another tool is selected, hold down the “M” key. The same technique could be used on a MIDI drum loop or phrase of any kind.

**SCISSORS TOOL**

The Scissors tool splits a MIDI note or soundbite where you click. With the edit grid turned on, you can also drag across a note or soundbite to split it repeatedly on grid lines, as demonstrated below in Figure 26-3. To temporarily get the Scissors tool when another tool is selected, hold down the “C” key.

![Figure 26-3: Turn on the edit grid and drag across a MIDI note or soundbite to split it repeatedly along edit grid lines.](image)
**TRIM TOOL**
The *Trim tool* allows you to trim soundbites and continuous data. To temporarily get the Trim tool when another tool is selected, hold down the forward slash key (/).

**Soundbites**
With the Trim tool chosen, click anywhere in a soundbite to move the right edge to the location where you clicked. Hold down the Option/Alt key to move the left edge of a soundbite.

**Continuous data**
The Trim tool can also be used on continuous data, such as audio track volume, MIDI CCs, and pitch bend.

When the Trim tool is chosen and the mouse is directly over continuous data, the Trim tool cursor will change to a hand with a pointed finger. You can click on a data point, or on the line segment between data points, and drag it up or down to trim its value.

![Figure 26-4: Trimming continuous data.](image)

If there is a time range selection or event selection of continuous data, clicking and dragging on one of the selected line segments or data points will move all of the selected data.

**Scaling continuous data**
A selection of continuous data can also be scaled with the Trim tool. When there is a time range or event selection of continuous data, move the cursor within the selection (but not directly over a point or line segment) then click and drag up or down.

![Figure 26-5: Scaling continuous data.](image)

Points are automatically added at the boundaries of the selection to preserve the data before and after the selection.

**Flattening continuous data**
Holding the Option/Alt key while using the Trim tool as described above will flatten the data rather than scale it.

![Figure 26-6: Flattening continuous data.](image)
ROLL TOOL
The Roll tool allows you to edge edit the beginning of one soundbite and the end of another where they abut each other. They must be touching one another. To temporarily get the Roll tool when another tool is selected, hold down the apostrophe key (‘).

SLIP TOOL
The Slip tool allows you to edge edit the start and end of a soundbite while the soundbite remains at the same position in the track. The soundbite’s length does not change. To temporarily get the Slip tool when another tool is selected, hold down the comma key (,).

SLIDE TOOL
The Slide tool allows you to move a soundbite in the sequence while leaving the soundbite’s audio at the same playback time. This is the same as edge editing both ends by the same amount forwards or backwards. To temporarily get the Slide tool when another tool is selected, hold down the period key (.)

COMP TOOL
The Comp tool allows you to create a composite, or “comp,” take from multiple takes in an audio track. To temporarily get the Comp tool when another tool is selected, hold down the “B” key. See chapter 42, “Takes and Comping” (page 387).

VELOCITY TOOL
The Velocity tool allows you to click on a MIDI note and drag up or down to adjust its velocity. You can also swipe horizontally in the Velocity Edit Layer or the note velocity lane in the Sequence Editor to adjust multiple note velocities in a single gesture.

HAND TOOL
The Hand tool allows you to scroll smoothly and precisely. It also lets you scroll vertically and horizontally in a single gesture. Simply click anywhere in the Sequence Editor grid and drag as desired.
Part 5
Preferences
CHAPTER 27  Preferences and Settings

OVERVIEW
The Preferences command in the Performer Lite menu (Mac OS) or Edit menu (Windows) lets you further customize your Performer Lite workspace.

Overview .................................................... 228
The Preferences window ............................. 228
Audio Plug-ins ........................................ 229
Document ................................................ 229
Data Display .......................................... 229
Automatic Conversions ............................. 229
Chord Symbols ...................................... 230
Information Bar ....................................... 230
Lyrics ...................................................... 230
MIDI Editing .......................................... 230
Soundbite List ....................................... 231
Tools ...................................................... 231
Undo Pruning ......................................... 231
Audio options ...................................... 231
Click ...................................................... 231
Countoff ............................................... 231
MIDI Options ........................................ 231
Pitch and Stretch ................................. 232
Receive Sync ...................................... 232
Transmit Sync ...................................... 232
Transport ............................................ 232
Scaling all windows up or down ............ 232
Help menu .......................................... 232

THE PREFERENCES WINDOW
To view a set of preferences, click their name in the list. The settings are displayed on the right. Fly-over help is supplied in the Description section below: when you move the cursor over a setting, a brief explanation of it appears below.

Restoring factory default settings
To restore factory default settings for the current preferences being displayed in the window (as indicated by what is currently selected in the list), click the Defaults button.

Reverting
If you have made changes to the current preferences being displayed in the window (as indicated by what is currently selected in the list), and you change your mind and wish to go back to the settings as they were before you made changes, click the Revert button.

Closing the Preferences window
Changes you make in the Preferences and Settings window go into effect as soon as you make them. To close the window, click its close button, or click the Done button.
AUDIO PLUG-INS
This preference pane allows you to manage your audio plug-ins. For details, see “Audio plug-in preferences” on page 497.

DOCUMENT
The Document preferences are shown in Figure 27-1 on page 228.

Startup Options
Choose how you would like Performer Lite to open when you first launch the application. Performer Lite can do one of three things:

- Open the Welcome to Performer Lite window
- Open the project you last had open

Recent Documents
Specify the number of recent documents that you want to appear under File menu > Open Recent.

Ask before closing
When the Ask before closing preference is enabled, Performer Lite always asks before closing the project. This is useful in situations where re-opening projects might take a long time due to virtual instrument loading.

Autosave
Autosave can be toggled on or off, and the save interval can be specified (from 1 to 60 minutes). You can keep all Autosave files or limit to a certain number of the most recent ones. Autosaved files go in an Autosave sub-folder in the project folder.

Document Templates
This “Open” button will open the folder on disk which contains your Document Template files. There, you can rename, copy, delete, etc. your template files.

DATA DISPLAY
The Data Display Preferences give you several choices for how to display MIDI pitch info.

AUTOMATIC CONVERSIONS
Performer Lite can automatically convert audio data wherever necessary to make it conform to the current project’s sample rate, file format, interleaved format, and tempo. Because processing is initiated automatically and carried out via background processing (for lengthy operations), these auto-conversion features greatly streamline the process of importing audio quickly into your projects, or the process of converting the entire project to a different sample rate, file format, interleaved format, or tempo.

The Automatic Conversions preferences (Figure 27-3) provide a global switch (the Enable Automatic Conversions option), and it also allows you to further specify your preferences for how audio is automatically converted.
**Enabling and disabling automatic conversions**

Use the Enable Automatic Conversions check box to turn automatic conversions on or off for the current project. This setting is saved with the project. You can also toggle this setting with a key binding.

**Automatic conversion settings**

The following settings let you customize how files are automatically converted. Settings are provided to handle sample rate, file format, interleaved format, and tempo.

**On Import**

This option, along with the *When Bite is Added to A Track* option, converts audio when it is first imported into Performer Lite, and in the case of tempo, when it is first placed in a track.

**Whenever File Doesn’t Match Project**

These options do the same thing as the *On Import* option, plus they automatically convert audio whenever circumstances arise where the audio no longer matches the project. For example, if you change the tempo for the sequence, all audio that is affected by the new tempo will automatically be time-stretched to match the new tempo. Or if you decide to change the project’s sample rate, say from 48kHz to 44.1kHz, all audio will automatically be sample rate converted. Needless to say, you need to be mindful of making changes like this, as very large amounts of audio data can be generated as a result of using these options.

**Never**

Choose this option when you don’t want audio files to be automatically converted for this file characteristic.

**CHORD SYMBOLS**

For details about the Chord Symbols settings, see “Chord symbols preferences” on page 135.

**INFORMATION BAR**

This preference pane is used to configure how the Information Bar will appear in each edit window. For more information, see “Information Bar” on page 107.

**LYRICS**

For details about the Lyrics settings, see “Lyrics preferences” on page 143.

**MIDI EDITING**

**MIDI Note Display preferences**

**Show note pitch:** When checked, MIDI notes display their MIDI note number inside the note bar itself, at the left edge of the note. MIDI note numbers appear when the note grid is vertically zoomed in far enough to display text inside the note.

**Show velocity as bar:** When checked, MIDI notes display their note-on velocity as a bar inside the note, similar to a thermometer. The higher the velocity, the longer the bar (from left to right).

**Shade Notes using Velocity:** When checked, MIDI notes will be shaded according to their on-velocity. The higher the velocity, the darker the note. Conversely, the lower the velocity, the lighter the note.

**Show notes with gradient:** When checked, MIDI notes are displayed with gradient shading to give them a more 3D appearance.

**Show notes with rounded corners:** When checked, MIDI notes are displayed with rounded corners.

**Show notes with colored border when zoomed out:** When checked, notes have a colored border instead of a black border when zoomed out.
Show Notes When Scrolling Offscreen: When this item is checked, the note grid displays a small bar at the top border or bottom border when a note resides above or below the pitch range currently being displayed.

SOUNDBITE LIST
For details about the Soundbite list column setup preferences, see “Showing/hiding columns in the soundbite list” on page 195.

TOOLS

Tool Palette Options
The Tool Palette Options allow you to show and hide tools in the tool palette. Check the box next to the tools you would like to see in the Tool palette.

UNDO PRUNING
The undo history has the potential to take up large amounts of memory and disk space, depending on the type of work you are doing. In addition, you may find that you rarely go back in time more than, say, an hour as you work. For circumstances like these, Performer can discard — or “prune” — branches according to rules that you specify and that accommodate your work style and needs, as shown below in the Undo Pruning preferences:

The *Prune entries when there are more than* _entries_ option lets you limit the number of undo history entries to any number that you specify from the menu provided. When an undo entry moves back in the history further than this limit, it is permanently discarded.

The *Prune Entries taking up more than* option applies to all actions, both on the main trunk and in all branches. This option can be useful during recording sessions, in which you are likely to generate and discard large amounts of audio data. But if you are the type of person who often searches back for takes you recorded way back at the beginning of your sessions, use this option with caution!

The last option, *When Audio recording try to keep…*, forces the undo history to flush items when disk space gets low. It starts with actions farthest back in the history and works its way forward as needed. What you choose here depends largely on how much disk space your system provides, and the manner in which you record.

AUDIO OPTIONS

_Audition volume_ determines how loud various audio operations will be, such as previewing items in the Content Browser and Soundbite List or scrubbing audio.

CLICK
For details about the click preferences, see “Click Preferences” on page 96.

COUNTOFF
For details about the countoff options, see “Countoff preferences” on page 95.

MIDI OPTIONS
For details about the MIDI Patch Thru preferences, see “MIDI input monitoring” on page 254.
PITCH AND STRETCH

The Pitch and Time Stretch Options (Figure 27-5) provide several settings that affect the CPU load and processing time of audio time-stretching and pitch-shifting throughout Performer Lite.

The Stretch and Pitch and Stretch Cache options let you choose whether these features are enabled for tracks that you add in new projects and the current project. For information about these features, see “Stretch” on page 59 and “Pitch and Stretch Cache” on page 60.

The ZTX-related settings also have an effect on the nature and quality of pitch-shifting processing, from pencil tool edits in the Sequence Editor pitch layer to wholesale transposition using the Transpose command. For details on these settings, see “ZTX Preferences” on page 516.

RECEIVE SYNC

For details about the Receive Sync settings, see “Using Receive Sync” on page 555.

TRANSPORT

The Transport preference controls the behavior of the Fast Forward/Rewind buttons.

Fast Forward/Rewind buttons

Forward/Rewind buttons move playback position by

Choose this option to move the playback position by a fixed increment in one of the following formats, chosen from the menu: measures, beats, ticks, frames or seconds. You can then specify different increments for slow versus fast cueing.

Forward/Rewind buttons move playback position continuously

Choose this option to move the playback position smoothly, like an old tape recorder.

SCALING ALL WINDOWS UP OR DOWN

Performer Lite gives you the ability to scale the appearance of all windows and text larger or smaller. To do so, choose View menu > Scale > Scale All Windows Up/Down.

HELP MENU

Tutorials

Choose Tutorials from the Help menu to open the Tutorials sidebar, which is a great way to learn Performer Lite quickly. See chapter 8, “Tutorials” (page 48).
Help Tags
There is a Show Help Tags checkable item under the Help menu.

When checked, you can hover over most items for a second or two and a “tooltip” description of the item will appear.

Checking for updates
Performer Lite can automatically check for new versions. When a new version is available, a dialog will prompt you with options to download or skip the update.

This automatic check can be disabled by deselecting Help menu > Check for Updates Automatically. To check for updates manually, choose Help menu > Check for Updates Now.

Additional Help menu resources
The help menu also provides additional resources, including a direct links to PDF files for the Performer Lite User Guide, Getting Started Guide, Plug-in Guide, and additional PDF documentation files. There are also menu items that provide direct web links for on-line product registration, technical support, and downloads.
CHAPTER 28  Commands

OVERVIEW
The Commands window lets you assign keyboard shortcuts and/or MIDI events to Performer Lite functions. This allows you to use the wide variety of MIDI controllers as well as your computer's keyboard to quickly execute Performer Lite operations. For example, a MIDI note value of C0 could operate the Stop button in the Transport; controller 64 On could operate the Skip Forward button.

Opening the commands window .................................. 234
Navigating the commands window .......................... 234
Command groups .................................. 235
MIDI Masters .................................. 235
Assignments .................................. 235
Numeric Base note .................................. 236
Sequence remote assignment .................................. 236
Run command .................................. 236
Export Key Bindings .................................. 237
Import Key Bindings .................................. 237

OPENING THE COMMANDS WINDOW
The Commands window is opened by choosing it from the Setup menu. The window contains a list of all assignable commands in Performer Lite. It is arranged in columns that display two keyboard assignments, a MIDI event assignment and master group designation.

NAVIGATING THE COMMANDS WINDOW
There are several ways to search and browse in the Commands window.

Searching for commands
Type in a text string at the top of the window. As you type a search term, the window will update in real-time to display the relevant results.

To clear the search results and return to the regular view, click the “x” button at the right side of the search field, or press the Escape key.

Browsing with the list navigation commands
You can use the List Navigation Commands to navigate the Commands window, select any command and give it a key binding.

Figure 28-1: To search for a command, type in a text string and click Search.

Figure 28-2: Use the List Navigation
COMMAND GROUPS
Commands are visually organized into logical groups. For example, all menu items found under the File menu are grouped together. Each group can be displayed or hidden by clicking the disclosure triangle to the left of the group name. Option/Alt-clicking a disclosure triangle will show or hide all groups.

MIDI MASTERS
The first group of commands are MIDI Master controls. MIDI Master controls enable or disable MIDI control of commands by group. Keyboard shortcut operation is unaffected. Like other commands, Masters can be assigned keyboard shortcuts or MIDI events.

Master controls have an additional check box next to their name that indicates their current status and allows you to manually enable or disable with the mouse.

The ‘Master’ column in the Commands window indicates which master individual commands are controlled by.

The Master Master is a special master control that enables or disables all master controls, effectively enabling or disabling MIDI control of all commands.

The General Master governs all commands that are not covered by the other master commands (Navigation, Sound Selection, etc.)

You can see which master a command is assigned to by widening the Commands window to view the master assignment column, as shown below:

Figure 28-3: Viewing the master assignment for each command.

ASSIGNMENTS
To assign a key binding to a given Command, simply click in the ‘Key’ column of a command and a field will appear indicating it is ready to receive a key stroke from the keyboard. The key or combination of key and modifiers you press at this time will be entered into the field.

There are two key bindings available for any given command. For example, the Slave to External Sync command could be mapped to both Command/ Ctrl-7 and Option/Alt-s.

You can use any key you want, except for the delete key, which removes the current key binding, if any.

For your convenience, keyboard shortcut key assignments are displayed in Performer Lite’s menus.

MIDI Assignments
Any MIDI event can be mapped to a command. You can further define the MIDI event by specifying a source. Click in the source column to reveal available devices as defined in your MIDI Device configuration (Setup menu > Bundles > MIDI Devices tab). If you have multiple
controllers in your setup, you may want to dedicate a controller exclusively to executing Performer Lite commands.

**NUMERIC BASE NOTE**
The *Numeric Base Note* is an arbitrary MIDI note of your choice. It is used to specify numbers from your MIDI controller when using other remotes that require you to specify something by number. To designate the base note, choose *Set Numeric Base Note* from the mini-menu in the Commands window.

![Figure 28-4: The Numeric Base control.](image)

To specify a number, you count notes, going up from the *numeric base* note, until you reach the number you want, and then you play that note. For example, if your *numeric base* note is C3, you would play C3 to specify the number 1, C#3 to specify the number 2, D3 to specify the number 3, etc.

**SEQUENCE REMOTE ASSIGNMENT**
When you create new sequences, Performer Lite automatically gives them control assignments if *Add sequence selection commands automatically* is checked in the Commands window mini-menu. The first sequence in a file is assigned to the ‘a’ key on your computer keyboard. The second is assigned to the letter ‘b’, then ‘c’, and so on. Performer Lite automatically avoids all conflicts with other existing Commands, skipping letters as needed so the sequence won’t have the same letter as another command. For example, the letters d, f, l, n and p are always skipped because they are used in the Notation Editor for other purposes.

**RUN COMMAND**
Type shift-spacebar (or choose *Setup menu > Run Command…*) to open the *Run Command* window (Figure 28-5), which provides a command-line style interface for quick access to commands. Essentially, it’s like Spotlight (in macOS) or Windows Search (in the Start menu) for commands.

![Figure 28-5: The Run Command window.](image)

As soon as you begin typing in the Run Command window, the list immediately populates with any commands that match the text string you’ve typed so far. Keep typing to narrow your search. Each hit shows the command name, its group, if any, and its current key binding, if there is one.

If a hit is grayed out, it means that it cannot currently be executed, due to the current operational context (there is no current selection, for example).

Search results in the list are divided into three sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>What is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Hits</td>
<td>Displays up to three of the most recently used commands that match the entered query.</td>
</tr>
<tr>
<td>Search results</td>
<td>Shows all commands whose titles contain text that matches to the entered query.</td>
</tr>
<tr>
<td>Relevant command groups</td>
<td>Shows all command from a command group whose name matches the query.</td>
</tr>
</tbody>
</table>
If you’ve saved specific Region menu command presets, you can use the command group section of the results list to recall them quickly.

**EXPORT KEY BINDINGS**

Commands are stored in the “Command Bindings” file inside the Performer Lite Preferences folder. Key bindings can also be exported to a file which can be imported at a later date.

This allows you to:

- Create libraries of key binding sets with different personalities.
- Back up your key bindings.
- Export your key bindings for use on another Performer Lite system.
- Save your key bindings before importing another set.

To export a set of key bindings, select Export Key Bindings from the Commands window mini-menu.

This will bring up the standard save dialog box where you can name your key bindings file and choose a location where it will be saved.

**IMPORT KEY BINDINGS**

Key bindings can be imported from previously exported files. Performer Lite comes with a set of key binding files that match the operation of other sequencing and digital audio packages. If you are upgrading to Performer Lite from another software package, you may find it helpful to import the key bindings from your old software to ease the transition. Be sure to check the MOTU web site (www.motu.com) for updated and additional key binding sets.

To import a set of key bindings, select Import Key Bindings from the Commands window mini-menu (Figure 28-6).

This will bring up the standard open dialog box where you can choose a key bindings file to import.

When importing commands, Performer Lite gives you the option of merging the new shortcuts (ones that differ from your current shortcuts) with your current set, and you can save or print a list of bindings that don’t match.
CHAPTER 29  Bundles

OVERVIEW
The Bundles window (Studio menu) serves as the crucial link between the virtual mixing world in Performer Lite and the audio and MIDI hardware that is physically connected to your computer. The Bundles window provides a convenient layer between them that lets you effectively manage audio and MIDI inputs and outputs.

Overview ....................................................... 238
Audio bundles ........................................... 238
Bundle types ............................................ 239
Adding and deleting bundles ......................... 239
Renaming bundles ..................................... 239
Working with tiles on the grid ....................... 239
Exporting and importing bundles .................. 240
Bundle channel formats .............................. 240
Reassigning bundles ................................ 241
The instruments tab .................................. 241
The MIDI Devices tab ............................... 241

AUDIO BUNDLES
Audio inputs, outputs and busses are all accessed via audio bundles. An audio bundle groups together a set of ins, outs or busses, then lets you refer to that group as a single entity. Audio bundles provide a layer of indirection between the audio assignment menus and the inputs, outputs and busses they contain. This is similar to how style sheets work in word processing programs. Instead of defining “Times, 12pt” for sections of text, you define a style called ‘Body Text” whose properties are “Times, 12pt” This way, you can re-format your entire document by simply redefining what “Body Text” means.

In Performer Lite, you could have a large project consisting of many sequences with complex output and bussing assignments. Should you decide to switch a bus from an outboard reverb to
an internal plug-in, the Bundles window allows you to rewire your entire project in a single operation.

You can even change the behavior of existing bundles. If you decide you want to make a mono mix of your stereo project, simply change your primary output assignment from a stereo bundle to a mono bundle.

Bundles allow you to clean up your assignment menus, choosing only to display bundles that you’ll actually use. For example, you might not need to look at 32 outputs from any single virtual instrument.

After a bundle is defined, it is available on the input and output assignment menus throughout Performer Lite.

**BUNDLE TYPES**
The Bundles window has tabs that display inputs, outputs, busses, instrument outputs, and MIDI devices. Click on a tab to view the type of bundle you wish to edit. Before adding or removing bundles, be sure you are looking at the correct tab.

**ADDING AND DELETING BUNDLES**
At the bottom of the bundles window, you will find five buttons (Figure 29-1). Click the Add button to add a single bundle, or if you need to create a number of bundles, click the Add multiple button. Bundles can be deleted by selecting a bundle and clicking the delete button. Use the Del. Unused button to get rid of all bundles shown in the list that are not currently being used in the project. The Edit button is used to modify MIDI devices, as described in “MIDI device properties” on page 242.

**Creating an audio bundle from assignment menus**
Anywhere in Performer Lite where you can choose an input or output assignment, such as in the Sequence Editor, you can also create a new bundle.

After a bundle is defined, it will remain available until the bundle is deleted.

**RENAMEING BUNDLES**
By renaming a bundle, you can create your own names for audio inputs, outputs and busses. For example, instead of generic terms like “Analog 1”, you could name an audio input in your system “My U87 Mic”. The customized bundle name will appear in all menus that display audio inputs, outputs and/or virtual busses.

To name a bundle, double click or option click on a bundle name. When you’re done, hit the return key. The enter key moves the edit field to the next bundle name.

**WORKING WITH TILES ON THE GRID**
The Bundles window consists of a grid where you can place and move tiles that connect audio bundles (rows) to their sources or destinations (columns). You make a connection by placing a tile in the grid square that intersects the bundle (row) with its source or destination (column).

Most sources or destinations are the physical inputs and outputs on an audio or MIDI interface, but they can also be busses inside of Performer Lite or connections to virtual instruments.

The sources and destinations available are displayed in the upper right corner of the Bundles window (Figure 29-1 on page 238). The are identified by device and then individual input or output. You may have to scroll left to right to see all available inputs and outputs for each device, especially if you are using multiple devices.
For examples, see “Reassigning bundles” on page 241.

**EXPORTING AND IMPORTING BUNDLES**

There are two options in the Bundles window mini-menu that allow you to exchange bundles between Performer Lite projects.

**Import Bundles**: Imports saved bundles into the current Performer Lite project.

**Clear and Import Bundles**: Clears the existing bundles and imports saved bundles into the current Performer Lite project.

**Export Bundles**: Exports all audio bundles for use in any other Performer Lite project.

**BUNDLE CHANNEL FORMATS**

After you’ve created a bundle, choose a channel format for it (mono or stereo) from the menu to its right, as shown below.

![Figure 29-2: Choosing a channel format for a bundle. This determines what type of bundle it is (mono or stereo) and the number of tiles available for output and bus assignments to the right.](image)

**Audio bundle properties are bound to a hardware driver**

When you create bundles, the following properties are bound to the audio hardware driver currently active in the Configure Hardware Driver dialog (under Setup menu> Configure Audio System):

- the bundle model (mono, stereo, 5.1, etc.)
- the bundle’s physical output assignments (the arrangement of the channel tiles in the grid)

If you switch to a different hardware driver, the bundles you’ve created remain, but you can completely reconfigure the properties listed above without disturbing these same properties for the original hardware driver. For example, if you are working with a MOTU 2408mk3 (or other PCI-424 based audio interface), and you then switch to built-in audio, you can change the physical output assignments (move the tiles) for a bundle for built-in audio without disturbing your 2408mk3 output assignments.

This same principle applies when switching between different MOTU drivers (such as from a USB to Thunderbolt driver).

**Bundles and panners**

The output bundle assigned to a track determines the type of panner it has. There are two types of panners: stereo and mono (direct). Stereo panners look and operate exactly like stereo pan knobs on a normal mixing console. Mono bundles remove the panner altogether, offering a direct path from the channel to the bus or output.

![Figure 29-3: The output bundle assigned to a track determines what type of panner it has in the Mixing Board.](image)

A mixing board can contain both mono and stereo bundles.
**REASSIGNING BUNDLES**

After a bundle is defined, you can move the assignment to another location. This is a powerful feature of bundles.

To reassign the reverb send of a project to a new set of busses, simply grab the bundle tiles and move to the new assignment.

![Figure 29-4: Moving a bundle to a different set of outputs.](image)

To swap the left right output of a stereo bundle, drag the tiles to swap their positions.

Stereo bundles can be split over non-adjacent destination pairs.

![Stereo bundles can be split over non-adjacent destination pairs.](image)

You can double-click a box to move the tiles in that row directly to the box (without having to drag them).

**THE INSTRUMENTS TAB**

Some plug-ins and ReWire-compatible applications provide multiple audio outputs. You can use the *Instruments* tab to route them anywhere in the Performer Lite mixing environment.

**THE MIDI DEVICES TAB**

Once you’ve connected your MIDI hardware devices, you are ready to configure them in Performer Lite for use in all of your Performer Lite projects. To do so:

1. Launch Performer Lite.
2. Create a new project from the File menu.
3. Choose *Studio menu > Bundles* to open the Bundles window.
4. Click the MIDI Devices tab (Figure 29-5).

The MIDI devices tab lets you create and configure MIDI devices connected to your MIDI hardware. The settings you make here will be available to all Performer Lite projects. If you transfer the project to another computer system, the devices you used will be preserved so that you can easily remap them as needed.

**Making MIDI connections in the I/O grid**

Any connected MIDI interfaces appear across the top of the I/O grid, with their MIDI ports shown in columns beneath the interface. Use the Add buttons to create MIDI devices, which appear in the left-hand column and represent the hardware connected to the interface. Drag the MIDI in (I) and MIDI out (O) tile for each MIDI device to the appropriate MIDI interface port column (the column that represents the physical port it is connected to on the MIDI interface). For example,
in Figure 29-5 the Roland JV-1080 is connected to MIDI IN port 1 and MIDI OUT port 1 on the micro express USB interface.

**Devices connected directly with USB, etc.**
If you have a controller keyboard or other MIDI device that connects directly to the computer with USB, Thunderbolt, or other standard computer peripheral connection, it will appear above the I/O grid in the same fashion as the MIDI interface shown in Figure 29-5 (as long as its drivers have been installed successfully). In this case, no additional I/O configuration is required and the device will be available as a MIDI input and/or output, as determined by its driver.

**Renaming an interface or USB device**
To rename an interface or USB device above the grid, double-click its name.

**Deleting offline interfaces**
If your USB MIDI interface or keyboard goes offline (it gets turned off or disconnected), its name appears in italics. If you wish to remove it from the Bundles window grid, click its name and click the Delete button.

**MIDI device properties**
Click a MIDI device in the left-hand column to select it and then click the *Edit* button to specify the manufacturer and model for the device and to make additional device property settings (Figure 29-6).

![MIDI device properties](image)

**Device**
Choose the manufacturer of the device from the *Manufacturer* pop-up menu, then choose the model of the device from the *Model* pop-up menu. The *Name* field will be automatically filled in.

![MIDI Devices tab in the Bundles window](image)
If you don’t see the manufacturer or model of the device in the list, or you would like to rename it for whatever reason, you can fill in the **Name** field manually.

**Properties and ports**
Specify the properties that describe the device. For example, you can describe what MIDI channels it uses for transmitting and receiving MIDI data. Enable any MIDI data types that are supported. If the device has multiple sets of MIDI ports, configure them in the Ports tab.

**Patches**
If you have a device which supports expansion boards, such as the Roland JV-1080, use this section to configure which expansion cards are loaded in the device. This will ensure that your patch lists are displayed accurately.

Let’s say you have a JV-1080 and would like to specify that you have the “Bass & Drums” expansion card installed. To configure Expansion Slot A Rhythm Kits, for example, locate Expansion Slot A Rhythm Kits in the Bank column on the left, then choose “EXP Bass & Drums Rhythm Kits” in the Override column.
Part 6
Playing and Recording
CHAPTER 30  Playback

OVERVIEW
Except where noted, this chapter applies to both MIDI and audio track playback.

Overview .................................................. 245
MIDI Playback basics .................................. 245
Audio playback basics ................................. 245
How to play a sequence ............................... 245
Monitoring levels ....................................... 246
Editing during playback ............................... 246
Screen re-display ....................................... 246
Muting and unmuting tracks during playback .... 246
Soloing Tracks ......................................... 246
Looping playback ..................................... 247
Playing the current selection ....................... 247
Event Chasing .......................................... 247
The playback wiper ................................... 249
Scrubbing multiple MIDI tracks .................... 250
Scrubbing and grid snapping ........................ 250
Stop Sounding MIDI Devices (Panic) .............. 250

MIDI PLAYBACK BASICS
When Performer Lite “plays” MIDI tracks, it is not playing audio of any kind. Instead, it is sending out performance information in the form of stored MIDI data to MIDI-equipped instruments. These instruments use the data as instructions for when to turn notes on and off, how loud to play them, and so on. Conceptually, Performer Lite is similar to a player piano which uses a set of recorded data (the piano roll) to control its “instrument” (the piano mechanism). The synthesizer, sound module, or virtual instrument produces the actual sound, and Performer Lite tells it when and how to do so.

AUDIO PLAYBACK BASICS
When Performer Lite plays audio tracks, it reads audio data from the hard disk and sends the digitally encoded audio signal to your audio hardware (the built-in speaker output of your computer or your MOTU audio interface, for example). The digital-to-analog (D-to-A) converters in the audio hardware then convert the digital audio signal into an analog one that plays from the speakers you have attached to the audio hardware. Because the audio data is stored on the hard disk, Performer Lite has random access to the audio and can cue virtually instantaneously to any location in the stream of audio. For more information about these basic hard disk recording concepts, see chapter 68, “Hard Disk Recording Concepts” (page 570).

HOW TO PLAY A SEQUENCE
To play a Performer Lite sequence:

1  Open a Performer Lite project.

2  If the project contains more than one sequence, open the Set List (Figure 7-2 on page 40) and play-enable the sequence that you wish to play back.

Only one sequence can play at a time.

3  Play-enable the tracks you wish to play back.

If the track is not play enabled, you will hear nothing from the track.

4  For each MIDI track, choose a MIDI output destination and patch (sound) as explained in “Choosing a MIDI output destination” on page 64 and “Choosing a default patch (sound)” on page 65.

5  For each audio track, choose an audio output destination as explained in “Choosing an audio input and output” on page 59.
6 Set the location from which you want playback to begin.

There are many ways to cue Performer Lite. Here are just a few: to simply rewind to the beginning of the sequence, click the Rewind button. To choose a general location, click the “wiper” cursor at the desired playback location in any time ruler in any window.

7 Press the Play button or press the spacebar.

The sequence will begin to play. The Counter advances.

8 When finished playing back, press the Stop button, or press the spacebar again.

**MONITORING LEVELS**

Long throw metering is available in the Mixing Board (“Level meters” on page 170).

**EDITING DURING PLAYBACK**

Many of Performer Lite’s features, such as windows, dialog boxes, edit region selection, edit commands, and other features can be used during playback. For example, you can open another window or use the Transpose command while the music is playing back; you do not have to press the Stop button beforehand. As you listen to your music and find that you would like to make a change, don’t reach for the Stop button. Just execute the command while the music is playing.

Here are some examples of things you can do during playback:

- Select a region for editing
- Edit a region with the Edit or Region menu commands
- Cut, copy, drag, Option/Alt-drag (copy), etc.
- Choose a different output destination for a track
- Add, delete, rename, or reposition a track
- Access a mini-menu command

Some features, because of their nature, cannot be accessed during playback. These features are either greyed out (inaccessible) during playback or will have no effect unless you press the Stop button before using them.

**SCREEN RE-DISPLAY**

During playback, Performer Lite does its best to update items on the computer screen, such as the Counter and scrolling windows. However, audio recording and playback can often place a high demand on the computing power of the machine, and Performer Lite makes playback a much higher priority than refreshing the screen display. Therefore, you may find at times that Performer Lite must devote all of the computer’s resources towards this end and thus may not be able to keep the screen display completely smooth and current. In addition, editing commands may sometimes take longer due to the amount of processor time required to deal playback. Rest assured, however, that your data is playing back accurately.

**MUTING AND UNMUTING TRACKS DURING PLAYBACK**

Both MIDI and audio tracks can be muted and unmuted during playback by using solo mode or by clicking their play-enable button in the Sequence Editor, or their mute button in the Mixing Board. You can also record the action of muting and unmuting tracks. For details, see chapter 54, “Mix Automation” (page 462).

When muting a track, the response is instantaneous.

**SOLOING TRACKS**

Soloing tracks allows you to isolate tracks for playback. This is a quick way to temporarily mute or unmute many tracks at once without having to
click on the Play-Enable buttons of each. Think of soloing as a second, independent play-enable state for all tracks. Any combination of tracks can be play-enabled when solo is turned on — even tracks that have been muted when solo is off.

The color of the play-enable button tells you its play status:

- Blue — means the track will play in the current mode (solo or not soloed)
- Gray — means the track is muted and will not play
- Orange — means that the track is muted when soloing is on but play-enabled (blue) when soloing is turned off

Click a play-enable button to change its status at any time, regardless of whether solo is turned on or off.

Solo is turned on and off by pressing the Solo Mode button (labelled “S”) in the Control Panel. Solo status can be changed during playback. You may mute and unmute tracks at any time during playback.

Both the soloed play state and the un-soloed play state are remembered until you change them, and both are also saved with the project.

When tracks are muted during soloing, Performer Lite continues to process the MIDI and audio data contained in them. This allows tracks to be soloed and un-soloed during playback without pauses or glitching.

**LOOPING PLAYBACK**

Playback of the entire sequence can be looped seamlessly between any two points. For information see “Memory Cycle” on page 98.

**PLAYING THE CURRENT SELECTION**

To audition the current selection, choose Audition Selection from the Region menu (or press Option/Alt-spacebar).

**EVENT CHASING**

Event chasing addresses a common difficulty in MIDI sequencing: Since MIDI data is transmitted serially (one event at a time), events that occur early in the sequence will not change the sound of a virtual instrument plug-in or MIDI sound module when playback is started from a point later in the sequence. For instance, if a program change event (patch change) occurs in the sequence at measure five and you begin playback at measure twenty, then the program change event will not be played and the synthesizer may produce the wrong sound (such as a trumpet sound instead of a bass sound).

Event chasing prevents such discrepancies: Whenever playback is stopped, Performer Lite searches backward through each MIDI track for the previous occurrence of each type of MIDI event. When playback starts again, it transmits those events, which updates the destination instrument plug-in or MIDI sound module to the expected settings. In the previous example, this would ensure that the synthesizer changes to the bass sound (according to the previous patch change event) when playback begins from measure twenty. Event chasing is also very useful for making sure that plug-ins and sound modules are updated to the correct settings for volume, pan, and other control change data (controller data).
**Enabling event chasing**
To enable event chasing, choose Event Chasing in the Setup menu. Event chasing can be enabled or disabled for different types of MIDI events independently of each other.

![Event Chasing](image)

Figure 30-1: Event Chasing ensures that you get what you expect to hear from your MIDI tracks, no matter where you start playback in your sequence or song.

Enable the types of MIDI events that you want Performer Lite to chase. Click Set All to enable event chasing for all types. In some cases, you may not want certain types of MIDI events to be chased.

**Event chasing in audio tracks**
Audio, instrument and auxiliary tracks always chases mix automation events in those types of tracks. The same is true for the Master Fader track.

**Inserting initial events in MIDI tracks**
Inserting initial MIDI events such as patch change and controller values at the beginning of each track in the sequence is a useful practice in MIDI sequencing. This ensures that you hear what you expect from your instrument plug-ins and MIDI sound modules regardless of the state in which they were left when you finished working on a different sequence or playing a different part of the current sequence. It is especially useful because it ensures that there are events for Performer Lite to chase when playback is started before any notes are transmitted from a given track.

For example, you might use the same hardware synth for a drum kit patch in two different sequences. In one sequence, the drum kit part plays quietly because its controller 11 (expression) value is 20. In the second sequence, the drum kit plays louder because its controller 11 value is 100. When you stop the first sequence and begin playing back the second sequence, the sampler’s volume will still be low before the higher controller 11 value is received. Placing an initial controller 11 event with value 100 at the beginning of the drum kit track in the second sequence guarantees that the sampler will play at the intended volume.

The Automation Snapshot button is a convenient way to insert controller events for controller 7 (volume) and controller 10 (pan). For details, see “Snapshot automation” on page 475.

**Omitting initial controllers in MIDI tracks**
If you don’t insert initial controller events at the beginning of a track, Performer Lite transmits a default value when playback begins before the first event of a given type in a track (except for a few commonly used controllers discussed below). This only occurs for MIDI event types that are present somewhere in the track.

For example, the first pitch bend event in a track is in measure five and its value is -100. When event chasing is enabled for pitch bend and playback is started from measure one, Performer Lite will transmit a pitch bend event with value 0. When the wiper reaches measure five, a pitch bend event with value -100 will be transmitted as usual.
Forward chasing
The following commonly used controller types actually chase forward if there is no initial even in the track: CCs 1, 7, 10, and 11. For example, if you have CC7 in the track and the playback wiper is before the first CC7 event in the track, Performer Lite chases forward to the first event in the track to establish the current value, rather than using a default value of 127. This is similar to how Performer Lite’s audio automation works.

Event chasing and audio track editing
When the Interpolate chased automation events when editing option is enabled (Figure 30-1 on page 248), copying audio track data selections will generate and place ramp-style automation events at the selection boundaries and include them when pasting the clipboard data. When cutting or erasing, interpolated automation events are left behind at the region boundaries.

By interpolating automation events at edit boundaries in this fashion, surrounding automation curves are preserved.

In addition, DP interpolates automation events at the paste destination boundaries to preserve automation values within the originally selected data region.

THE PLAYBACK WIPER
The playback “wiper” is a vertical line that scrolls across the Sequence Editor during playback, as shown in Figure 30-2. It indicates the current playback location (in the counter).

Figure 30-2: If you check the Wiper option for a window, a “wiper” appears to show the currently playback location of the sequence. This wiper can be dragged to change the playback location. You can also double-click inside the time ruler at any location to make the cursor jump to that location.

Cueing with the wiper
There are several ways to cue the current playback location with the wiper, either when Performer Lite is stopped or playing:

■ Double-click any time ruler at the desired location
■ Click once in the upper half of the time ruler with the “wiper” cursor
■ Drag the wiper tab in the time ruler

Zooming with the wiper
You can zoom in and out by Control/Win-dragging vertically on the playback wiper handle. Control/Win-drag down to zoom in; drag up to zoom out. Release the Control/Win key to temporarily suspend wiper zooming. This allows you to continue zooming, even after you’ve reached the top or bottom of the computer screen. For example, if you pull down to zoom in, and you
want to zoom in further but you’re getting close to the bottom of the screen, release control, move back up to the top of the wiper (doing so maintains the current zoom level), press control/Win, and then pull down to continue zooming in further.

To move horizontally while zooming, simply release the Control/Win key temporarily while continuing your drag gesture. For example, you can drag left or right and then press Control/Win again to further zero in on a particular location.

Wiper zooming is an extremely useful zooming shortcut. It works particularly well when used hand in hand with the Zoom Back command (command-[ ).

**SCRUBBING MULTIPLE MIDI TRACKS**

Scrubbing refers to the act of controlling playback manually, forwards or backwards, by dragging the Performer Lite’s current playback location left or right. Scrubbing allows you to play MIDI tracks forwards or backwards in non-real time, where you control the tempo by how quickly you drag. Scrubbing is great for zeroing in on wrong notes or other artifacts that you hear during playback.

You can scrub playback by using any of the following techniques:

- Drag the playback wiper
- Drag the Notation Editor playback wiper
- Drag Movie Window slider
- Press the fast forward/rewind buttons or slow forward/rewind buttons in the Control Panel

Scrubbing respects the solo states of tracks, and in general, plays the same tracks that you would hear if you pressed the play button.

Scrubbing always chases:

- patch changes
- notes
- pitch bend
- volume controllers
- sustain pedal controllers

While scrubbing, however, only the following event types are played back:

- notes
- pitch bend
- sustain pedal

**SCRUBBING AND GRID SNAPPING**

If Snap to Grid is enabled, the wiper snaps to the grid while scrubbing. To scrub smoothly, disable the grid. See “Snap Information” on page 331.

**STOP SOUNDING MIDI DEVICES (PANIC)**

The Stop Sounding MIDI Notes command (Studio menu) is a MIDI “panic” command – it will send an “all notes off” message to all MIDI devices. This is helpful if there is a stuck note or a MIDI feedback loop.
CHAPTER 31  Recording

OVERVIEW

Except where noted, this chapter applies to both MIDI and audio track recording.

Performer Lite records very much like a multi-track tape deck: you connect inputs, specify tracks to record into and push the record button. Performer Lite, however, has a great deal more flexibility than a tape deck. There are many features you can use while recording that affect which types of data are recorded, control the time span in which recording takes place, manage multiple takes on the fly, automate loop-recording, and much more.
CHOOSING A SEQUENCE TO RECORD INTO
If you have more than one sequence in the project, be sure to play-enable the one that you wish to record into. If you need to switch sequences, play-enable it in the Set List window.

SETTING TEMPO AND METER
If the material you are recording is musical in nature, then it is best to match it with the tempo and meter changes in the sequence, if any. Then it will be much easier to edit and mix the material musically with reference to measures and beats.

There are two ways to align live-recorded audio and MIDI data with the beats and barlines in Performer Lite:

- Record to existing material, such as a drum loop
or
- Record to a click

Recording to existing material is self-explanatory. Recording to a click is covered in the next section.

Setting the tempo
To set a constant tempo, choose Tempo Slider from the Tempo Control menu in the Control Panel and drag the tempo slider to the desired tempo. Using the tempo slider is handy for quickly setting a straight tempo. If your music involves a tempo map (a series of tempo changes, including, perhaps, ones that change smoothly over time), you may prefer to set these up before actually recording any MIDI data. See chapter 46, “Conductor Track” (page 418) and chapter 48, “Change Tempo” (page 435) for details.

Programming a meter map
A meter map is a series of meter changes. To set up a meter map before recording, see chapter 49, “Change Meter” (page 443).

Recording at a slower tempo
If the MIDI or audio material you are recording is particularly challenging for you to play, try setting the tempo slider to a slower tempo, perhaps 10 to 20 bpm slower than normal, and record at the slower tempo. Afterwards, you can return the tempo slider to the correct tempo. MIDI data will be scaled to the correct tempo automatically. Audio data can be scaled to match the correct tempo in one easy step. For details, see “Stretch” on page 59.

RECORDING TO A CLICK
Performer Lite lets you record to a click. To learn more about Performer Lite’s advanced click settings, see “Click” on page 96.

RECORDING WITH A COUNTOFF
Performer Lite can help you start a recording pass with a programmable countoff. For further information, see “Countoff” on page 95.

INPUT FILTER
The Input Filter (Setup menu) allows you to specify what types of MIDI data are recorded.

Figure 31-1: The Input Filter allows you to control what types of data Performer Lite will record.
Choose the types of data to be input by clicking on the corresponding check box(es).

☛ Please note! The types of data you select will stay in effect until you change the filter setting. The Input Filter setting will affect all data recorded. Be especially careful when muting types of data that you normally don’t filter. If you don’t remember to turn them back on afterwards, you may lose valuable data in the future during recording.

**Specifying controller numbers**
The buttons under the Controllers check box in the Input Filter allow you to quickly choose which controller data to record. Click in the Controllers check box, click on the type of option you wish, and then enter the controller numbers if necessary.

*All:* Information from all controllers will be recorded.

*All except:* Information from all controllers except the controller numbers you enter will be recorded.

*Only:* Only information from the controller numbers you enter will be recorded.

To add and remove controller numbers in the list for the *All except* and *Only* options, use the Add and Remove buttons to the right of the list.

**NON-DESTRUCTIVE OUTPUT QUANTIZE**
As an alternative to input quantizing, you can instead apply non-destructive quantizing on MIDI track playback with the Quantize MIDI plug-in. This preserves the original performance you record in the track, while at the same time playing it back quantized. The advantage to this scenario is that you can remove the quantization at any time to return to the original performance in the track, if desired.

**PREPARING A MIDI TRACK FOR RECORDING**
To prepare a MIDI track for recording:

1. Record-enable the MIDI track.

   This can be done in several different windows in Performer Lite. In the Sequence Editor, click the Record button in the track settings panel. If the button is red, the track is record-enabled. In the Mixing Board, click the record button below the solo and mute buttons. In the Sequence Editor, click the record button next to the track name. Several MIDI tracks may be record-enabled (see “Recording several audio tracks in one pass” on page 261).

2. If you need to specify a MIDI device and channel to record from (in order to exclude data received from other input sources at the time of recording), choose the input device and channel from the track’s settings panel in the Sequence Editor.

   See “Choosing an input source” on page 64 for details.

3. Select the playback device for the track being recorded.

   See “Choosing a MIDI output destination” on page 64 for details.

4. (Optional) Turn on MIDI Patch Thru (Studio menu) so that you’ll record the track with the same sound as it will play back with.

   Patch Thru echoes incoming data to the output destination device you’ve chosen for the track. This is essential when using a separate MIDI controller instrument: it allows you to hear what you are playing while it is being recorded. For details, see “MIDI input monitoring” on page 254.
5 (Optional) If you are using MIDI Patch Thru, choose the desired patch (sound) for the track from its Default Patch menu in the track settings panel. For details, see “The patch list” on page 65.

6 (Optional) Set the Input Filter, if needed.

See “Input Filter” on page 252 for details.

You are now ready to record MIDI.

PREPARING AN AUDIO TRACK FOR RECORDING

To prepare an audio track for recording:

1 Make sure that the audio hardware that you are using for recording is activated.

If you are using the MOTU Audio System, choose Setup menu > Configure Audio System > Configure Hardware Driver to activate the hardware driver. For details, see “Configuring the hardware driver” on page 19.

2 Choose an audio input to record from.

This is the microphone input on your computer, a physical input jack (or pair of jacks) on your recording hardware, or a virtual input from a software synthesizer or sampler. You can also choose one of Performer Lite’s internal virtual busses as the input. This means that you can record output from any other track—or combination of tracks—that are assigned to the bus you choose. You can choose the track input from the Mixing Board or Sequence Editor windows (from the menu next to or below the track name).

3 Record-enable the audio track.

This can be done in several different windows in Performer Lite. In the Sequence Editor, click the Record button in the track settings panel. If the button is red, the track is record-enabled. In the Mixing Board, click the record button below the solo and mute buttons. In the Sequence Editor, click the record button next to the track name. Only one audio track can be record-enabled at a time.

☛ Record-enabling should be done before you actually begin recording; audio tracks can be record-enabled during playback or recording, but you may experience a brief pause. A better alternative is to punch in and out on the fly. See “Manual punch-in/punch-out on the fly” on page 261 and “Automatic punch-in/punch-out” on page 261 later in this chapter.

☛ If the track’s record button is missing, you need to choose an input first (Step 2 above).

4 Check the audio input level.

Play the input signal at its peak levels, and watch the level meter and adjust the input so that the peaks occur as close to 0 dB as possible without triggering the Clip indicator.

Digital clipping is much harsher than analog clipping. Therefore, it’s better to err on the low side.

You can monitor input levels using the meters in the Mixing Board (chapter 19, “Mixing Board” (page 156)).

MIDI INPUT MONITORING

MIDI Patch Thru (Studio menu) allows you to hear incoming MIDI data from your MIDI controller instrument played back on your output synthesizers (Figure 31-2) or virtual instruments. More technically, Patch Thru echoes MIDI data received by Performer Lite to any MIDI device in your studio that you choose. You’ll want to use Patch Thru most of the time because it allows you to hear what you are playing on your MIDI sound modules while recording. Patch Thru also provides an easy way to experiment with different
playback synthesizers without having to manually reconnect patch cords and change MIDI channels on the instruments.

Patch Thru works whether you are recording or not. However, MIDI data will only be patched through tracks which are record-enabled. If you don’t hear anything on your synthesizer modules when playing your controller, check to be sure that the correct track or tracks are record-enabled.

Timing and synchronization data are not echoed in Patch Thru.

**Turning on MIDI Patch Thru**

To turn on MIDI Patch Thru, choose it from the Studio menu and select either **Direct Echo** or **Auto Channelize**:

**Direct echo**

Direct Echo causes incoming MIDI data from your controller to be echoed back out on the same channel it was received. For example, if your MIDI controller is transmitting on channel 3, MIDI data is echoed back out on channel 3 by Performer Lite. The Input Filter settings do not affect direct-echoed data; information is simply echoed straight through, bypassing most of Performer Lite’s MIDI processing.

Direct Echo is useful in situations where you want to be able to change the channel you are echoing to from your MIDI controller keyboard by simply changing its transmit channel.

**Auto channelize**

Auto Channelize causes incoming MIDI data from your controller to be echoed to the output device and channel for the currently record-enabled MIDI track. The following sections discuss several scenarios that affect Auto Channelize.

**Auto channelizing in a sequence**

When a sequence is play-enabled in the Set List, here is how Auto Channelize Patch Thru works. Only MIDI data received on the specified recording Device for a track will be echoed to the corresponding playback channels for that track.
Since Patch Thru works even when you’re not recording, you can use Performer Lite as a sophisticated MIDI merger, mapper, or rechannelizer during playback, recording or when stopped. Patch Thru allows you to route MIDI information from your controller instrument to any combination of synthesizer modules. By adding a group of tracks, each assigned to a different MIDI channel or set of channels, you can change the module configuration used for playback by simply clicking on the record-enable button for the track or tracks with the desired channel configuration. This allows you to experiment with channelization freely.

**Auto channelizing with MIDI effects plug-ins**
The Mixing Board allows you to apply real-time MIDI effects plug-ins to a track. For example, you could apply the Echo effect to a MIDI track to make it echo during playback.

These same effects plug-ins will affect MIDI Patch Thru as well. When you record-enable a track, and the track has MIDI effects plug-ins currently applied to it, you will hear the effects on what you play.

This allows you to apply effects — in real time — to what you are recording into (and patching thru) Performer Lite. For example, you can apply a Transpose Map that constrains all notes to within a certain scale — which automatically cleans up any wrong notes that you play! Or you can apply a MIDI echo as you record. See “Working with effects plug-ins” on page 175 for details.

**Auto channelizing and the Input Filter**
The Input Filter affects incoming data in MIDI Patch Thru mode. All data selected to be filtered out will not be echoed to the outputs. For example, if the pitch bend box is not checked in the Input Filter dialog box, pitch bend information will not be echoed through in MIDI Patch Thru.

**Patching thru in the background**
Performer Lite continues to patch thru even when it is in the background, i.e. not the active application. For example, if you bring another program to the front, you’ll still be able to patch thru from your controller via Performer Lite.

**MIDI beat clocks and MIDI Patch Thru**
If you use MIDI Patch Thru with a drum machine or any device that outputs timing information, the timing information will not be echoed through. To echo timing information, see chapter 67, “Transmit Sync” (page 566).

**MIDI patch thru via a MIDI interface**
Some MIDI interfaces, such as the MIDI Express XT, have a patch thru option built into them. If you choose to use the echo feature, turn off MIDI Patch Thru on Performer Lite or incoming data will be echoed twice. If you choose to use MIDI Patch Thru in Performer Lite, turn off the echo feature on the interface for the same reason.

**Sync Recorded MIDI to Patch Thru**
If you have a MOTU USB MIDI interface, Performer Lite records with an extra degree of precision. When you are recording with MIDI Patch Thru turned on, Performer Lite places the events in the track so that what you heard yourself play when recording is exactly what you’ll hear when you play back your performance. To do this, Performer Lite must compensate for the inherent, small amount of time it takes for the computer to receive the incoming MIDI data and send it back out to the patch thru destination. It does so by placing the event in the track a few milliseconds after the time at which it was actually received.

However, there may be times when you are not listening to your performance via Performer Lite’s MIDI Patch Thru. For example, you might be playing your synthesizer with local control turned on, i.e. triggering sounds directly from its own
keyboard. In this situation, be sure to turn MIDI Patch Thru off. Or, leave MIDI Patch Thru on and disable the Sync Recorded MIDI to Patch Thru option in the MIDI Patch Thru dialog (Studio menu) as shown below in Figure 31-3 on page 255. Doing so ensures that events are recorded exactly when they’re received (as you heard when playing them).

**Patch Thru in Background**
The Patch Thru in Background option (Figure 31-3 on page 255), when checked, lets you continue to use Performer Lite’s MIDI patch thru, even when Performer Lite is not the active application. For example, you could switch to the computer desktop and still continue to play a virtual instrument from your controller.

**AUDIO INPUT MONITORING**
Audio input monitoring is the process of listening to the live input signal being fed to a track via its chosen hardware input (Figure 10-1 on page 58). Performer Lite lets you do this by “patching thru” the input signal to the track’s output destination (see “Choosing an audio input and output” on page 59). So be sure to choose an output destination assignment that is patched to a listening device. For example, you might choose a pair of audio outputs on your audio interface that is connected to a set of speakers, or a pair of outputs that is patched to the headphone outs on your audio interface. The output assignment can also be a bus that is being routed via an aux track to your speakers.

**The input monitor button**
To monitor an audio track’s input, click its input monitor button to enable it. If you don’t see the Input Monitor button for a track, you need to choose an input for the track. See “Choosing an audio input and output” on page 59.

Input monitoring can be enabled or disabled independently of the track’s record-enable state.

**The record button**
When you record-enable a track (Figure 10-1 on page 58), input monitoring is enabled and you will begin to hear the live signal being received on the track’s chosen hardware input. This is true, regardless of whether or not the track’s input monitor button is engaged.

If you don’t hear live input when the track is record-enabled, audio patch thru might be turned off, as explained in the next section.

**Input monitoring modes (Audio Patch Thru)**
Performer Lite provides four input monitoring modes that govern when you hear live input and how the live input signal interacts with disk audio (existing audio material in the track) during playback and Auto Record. In addition, input monitoring can be disabled entirely. To access these input monitoring modes, go to the Studio menu > Audio Patch Thru sub-menu:

<table>
<thead>
<tr>
<th>Audio Patch Thru setting</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The track input is never audible, regardless of the input monitor or record button state.</td>
</tr>
<tr>
<td>Input Only</td>
<td>When the track is either record-enabled or the input monitor button is enabled (or both), you hear the track input only, and you will not hear any disk audio during playback.</td>
</tr>
<tr>
<td>Auto</td>
<td>Same as Input Only, except that during Auto Record, when you are playing but not yet punched in, you will still hear disk audio (until punch in occurs).</td>
</tr>
<tr>
<td>Blend</td>
<td>When the track is either record-enabled or the input monitor button is enabled (or both), during playback, you hear both the input and the disk audio.</td>
</tr>
</tbody>
</table>

**Monitoring input levels**
In addition to the level meter in the track’s settings pane (Figure 10-1 on page 58), long throw metering is available in the Mixing Board (“Level meters” on page 170).
Monitoring outside of Performer Lite
If you are using Performer Lite with an external mixer, or via the hardware-based CueMix DSP monitoring features in your MOTU audio interface, you might choose to monitor in the external hardware instead of through Performer Lite. In this scenario, or any situation in which you do not need to monitor the incoming audio via the outputs of the audio interface connected to your computer, disable Audio Patch Thru.

Applying real-time audio effects plug-ins to live audio input
You can apply effects plug-ins to the live input signal by adding effects plug-ins to the track in the Mixing Board. (See “Inserts” on page 160.) However, you should read the following sections first, which discuss several important issues regarding audio input monitoring under the MOTU Audio System.

Monitoring latency
You might hear a slight delay when monitoring audio input. For example, if you have a sequence that already has several tracks of audio recorded, and you then try to record along with it while monitoring your input via Audio Patch Thru, you might hear a slight delay in what you are playing. This delay is commonly referred to as monitoring latency. Fortunately, however, the audio will be recorded into the sequence accurately and in sync with the other previously recorded audio tracks (as long as you managed to play it in sync with the sequence). But what you hear while you are recording will be noticeably and consistently behind. In other words, what you hear during recording will not be what you get: during recording, the input signal will sound late, but when you play it back after recording it, it will be fine (again, as long as you managed to play it in time with the sequence).

Again, audio is always recorded accurately. Latency is only an issue for monitoring (the live audio input that you listen to while recording).

There are several ways to minimize monitoring latency. Some of them are specific to certain hardware.

- Monitor outside of Performer Lite entirely (with a mixing console, for example).
- Use your audio hardware’s direct, hardware-based monitoring feature, if any.
- For MOTU audio hardware, set input monitoring mode to ‘Direct hardware playthrough’. You will not be able to monitor through audio effects plug-ins, but monitoring latency will be greatly reduced or completely eliminated. See “Hardware monitoring versus monitoring with effects” below for more information.

Hardware monitoring versus monitoring with effects
When you use your audio hardware’s built-in “hardware-based” monitoring feature (if any), there is little or no audible delay. However, the trade-off is that the input signal is not routed through the MOTU Audio System. This means that if you have effects such as EQ or reverb assigned to the track that is currently record-enabled, you will not hear the effects applied to the input signal.

In summary, your two choices for monitoring input are: 1) delayed input with effects, or 2) dry input with no delay.

You also have a third option: turn off your audio hardware’s “hardware-based” monitoring and lower the Buffer Size setting. The default settings is 1024 samples. Try lowering it to 512, 256 or even 128 samples. This gives you the best of both worlds: very low monitoring latency (3-6 ms) with
effects processing. The trade-off in this scenario is that the lower buffer settings put more strain on your computer.

**Setting the input monitoring mode**
The two choices for input monitoring described in the previous section are provided by choosing *Configure Audio System > Input Monitoring Mode* from the Setup menu, which opens the dialog shown below in Figure 31-4.

![Figure 31-4: Under the MOTU Audio System, Performer Lite provides two input monitoring modes. 'Direct hardware playthrough' provides monitoring without delays, but it does not provide effects on the monitored signal. 'Monitoring record-enabled tracks through effects' lets you monitor input with effects applied to it, but there could be a noticeable delay in the signal.](image)

**Direct hardware playthrough**
*Direct hardware playthrough* provides accurate monitoring with no delays, but if you have real time effects (EQ, reverb, etc.) assigned to the track being recorded into, you will not hear them during monitoring. Effects will, however, be applied to the recorded material during subsequent playback.

When this option is chosen, the input signal currently being monitored can always be heard, i.e. it will be patched through when Performer Lite is stopped, playing or recording.

When operating Performer Lite with a MOTU audio hardware system, this option is required to enable the Cue Mix™ monitoring feature.

**Monitor record-enabled tracks through effects**
*Monitor record-enabled tracks through effects* lets you apply effects to the input signal (via the effects inserts of the currently record-enabled track), but you might hear a delay during recording. If, however, the input signal is actually received by the computer in sync with the rest of the sequence, the input signal will be recorded properly (with no delay).

When this option is chosen, the input signal currently being monitored can always be heard when Performer Lite is either stopped or recording. During playback, however, the input signal being monitored will never be summed with existing track contents. Instead, you will hear either one or the other.

**USING THE COUNTOFF**
Countoff gives you a number of measures of countoff in the starting tempo before recording begins. For details, see “Click” on page 96 and “Click Preferences” on page 96.

**START RECORDING**
After making the preparations already discussed in this chapter, you are ready to begin recording:

1. Set the Counter to the location in the sequence at which you want to begin recording.

   If you are recording into a new sequence, you’ll probably want to start at the beginning of the sequence. To do so, click the Rewind button. To start at a specific location other than the beginning, type in the location in the Counter.

2. To begin recording, press the Record button in the Control Panel.

   The Record button will turn red, indicating that Performer Lite is recording in real-time. You can also trigger recording by pressing the [3] key on the numeric keypad (with Num Lock engaged under Windows) or, if you have already set up a MIDI remote control, by sending a MIDI event from your controller.
To achieve the fastest response possible when you begin recording, use pause-record. That is, press the pause button first and then record. Performer Lite allocates record buffers as needed and then waits for you to press pause again to begin recording.

**Display update during recording**
During recording, Performer Lite displays audio and MIDI data as it is being recorded. For audio, you’ll see a continuously updating red bar. This bar appears temporarily during the record pass; it is for display purposes only and cannot be edited. However, as soon as recording stops, the bar is replaced by a fully editable soundbite.

**Record-enabling audio tracks on the fly**
You can record-enable (and disable) audio tracks while playing (but not while actually recording). In other words, you can toggle audio track record-enable buttons as long as the record button is not red or flashing red. Therefore, to change record-enabled audio tracks during a record pass, just press the record button to temporarily drop out of record, change audio track record-enables as desired, and then press record again to drop back into record. If you have already recorded some material, and you change record enables on the fly in this manner, the previous material is “put away” (the red, temporary waveform bars turn into normal, editable soundbites).

**STOP RECORDING**
To stop recording, stop Performer Lite by clicking the Stop button, pressing the spacebar, or pressing the [0] key on the numeric keypad (with Num Lock engaged under Windows).

Performer Lite stops recording and takes a moment to process the audio data.

For audio tracks, each record pass gets placed in the audio track as a single **soundbite**. The soundbite also gets added to the list in the Soundbites list. You can view the soundbite by opening the Sequence Editor.

**HOW AUDIO IS RECORDED ON DISK**
Performer Lite and other computer-based digital audio recording systems record audio data in much the same way. For a detailed explanation, see “How audio is recorded on disk” on page 570.

**UNDO RECORD**
Immediately after you record (before you do anything else), you can undo what you just recorded. For audio tracks, Performer Lite moves the takefile into the trash. If you then do another undoable action, the takefile is remembered in the undo history. However, at the end of the session, when you close the project, Performer Lite will alert you that there are unused record takes and ask if you want to delete them. This lets you undo and redo as much as you want without worrying about your hard drive filling up with unwanted takes.

**RECORDING STEREO AUDIO**
Stereo recording is done in the same fashion as already described in this chapter, except that you record into a stereo track instead of a mono track. To add a stereo track, choose *Add track > Stereo Track* from the Project menu. Then just record-enable the track and prepare for recording as usual.

- If your project interleave format is interleaved, the stereo audio will be recorded to a single file.
- If your interleave format is deinterleaved, recorded audio data is stored as two separate mono files, each with the same name and .L or .R in the file names (e.g., “Guitar-1.L.wav” and...
“Guitar-1.R.wav”). The corresponding soundbites in the track will remain perfectly sample-locked, no matter what you do.

**RECORDING SEVERAL AUDIO TRACKS IN ONE PASS**
Performer Lite lets you record as many audio tracks at one time as your computer and audio hardware allow. Just record-enable the tracks as needed.

The total number of audio tracks you can record into at one time depends on your audio hardware.

**RECORDING AUDIO AND MIDI AT THE SAME TIME**
Performer Lite allows you to record audio tracks and MIDI tracks at the same time. Just record-enable all the tracks that you want to record into.

**MANUAL PUNCH-IN/PUNCH-OUT ON THE FLY**
For both MIDI and audio tracks (when operating Performer Lite under the MOTU Audio System), you can punch in and punch out on the fly as many times as you need during a single record pass, regardless of how many tracks are record-enabled.

To manually punch in, press play and then press the record button in the main transport at the desired time. Press record again to punch out. You can also use the [3] key on the numeric keypad (with Num Lock engaged under Windows). For MIDI tracks, you could alternatively use the track’s individual record-enable button, but not for audio tracks.

**AUTOMATIC PUNCH-IN/PUNCH-OUT**
Performer Lite’s Auto-Record feature allows you to automate recording at precise punch-in and punch-out points. This feature allows you to record without having to manually enable and disable the Record button. Automatic punch-in produces the most accurate results possible when punching in. When you punch-in manually, there may be a brief delay—on the order of a few hundred milliseconds for audio tracks—before recording actually begins.

To punch in automatically, set up Performer Lite’s Auto Record feature in the Control panel.

Clicking on the Auto-Record button (below the main transport controls) enables and highlights it. Clicking on the Auto-Record button also causes the Auto Record punch in and punch out times to appear in the Status Strip. Punch in and punch out times are specified in the Auto Record Bar: Punch in is the time where recording begins; Punch out is where recording ends. Auto-Record can be used while Performer Lite is slaved to external sync; see chapter 66, “Receive Sync” (page 554) for details.

The Auto-Record button will remain on until you click on it again to disable it. Remember to disable it when you finish using it.

To use Auto-Record:

1. Arm the tracks you wish to record into.

2. Press the Auto-Record button, which is located below the transport controls.

   The button highlights to signify that Auto-Record is on.

3. Enter the Punch In and Punch Out locations.

   The Punch In location is where Recording will begin. The Punch Out location is where Recording will end. You can set them up graphically. See “Auto-Record” on page 99.

4. Move to a location in the sequence before the Punch In point.
This location should be a spot that will give you plenty of time to prepare to enter the new material, anywhere from a whole section to a few measures before the Punch In point.

5 Get ready to record.

6 Press the Record button.

The sequence plays from the current location in the Counter. The Record button starts flashing. When the Punch In time is reached, the record button becomes continuously highlighted. When this happens, Performer Lite is recording and you can play new material. When the Punch Out time is reached, the Record button will return to flashing.

7 Press the Stop button when you are finished.

**Punch-in recording in MIDI tracks**

If Performer Lite starts recording in a MIDI track while a pre-existing MIDI note is sustaining, it does not cut off that note. Only notes with attack times after the punch in time are erased. For example, in Figure 31-5 below, the two notes represented by light grey bars begin within the punch in time range, but the sustained note represented by the dark grey bar begins before the punch in point:

![Figure 31-5: A passage of notes before Auto-Recording.](image)

After recording, the notes that began before punch in remain, but the notes that begin within the recorded range are replaced by the new material:

![Figure 31-6: The same passage of notes after Auto-Recording, with the newly recorded material displayed as the bar with the diagonal pattern.](image)

Anything you play while the Record button is grey is not recorded. This allows you to play along with the sequence and only record between the Punch In and Out times. Overdub recording

Overdub recording works slightly differently for MIDI tracks and audio tracks, although the basic principle is the same: existing data in the track is preserved. Overdub mode can be combined with Cycle-Recording (described later in this chapter) for drum-machine style MIDI loop recording and multi-take audio loop recording.

![Figure 31-7: Performer Lite's Overdub Record mode button.](image)

**MIDI overdub recording**

In MIDI tracks, overdub mode causes newly recorded MIDI notes to merge with, instead of replace, pre-existing MIDI notes on the record-selected track. The pre-existing notes on the track are not erased. It works as if you recorded one track, recorded a second track to go along with it and then merged the two.

**Overdub recording and MIDI controller data**

For MIDI continuous controller (CC) data, overdub record mode works differently than with notes. Newly recorded CC data replaces existing data of that same type in the track, according to the automation mode setting for the track in the Mixing Board. For example, with Touch and Latch modes, punch-in occurs when the first CC event is received and continues, replacing existing data of the same type. Existing data stops being replaced when you either stop sending data (Touch mode)
or when you stop the record pass (Latch mode). For details about automation modes, see “Automation modes” on page 466.

**Audio overdub recording**

When overdub record mode is enabled, punched-in audio is layered on top of existing audio. The existing audio remains beneath it, but only the newly overdubbed soundbite will play, i.e. what you see is what you’ll hear. See “Overlapping and layering soundbites” on page 311 for more information about how multiple, overlapping soundbites play back in a track. If you change your mind about the punch-in and wish to remove it, just delete the overdubbed soundbite, which uncovers the original audio beneath.

☛ When overdub recording over existing material, *the new material is not merged with the existing material*. Instead, it is overlaid on top. To merge soundbites together into one soundbite, place them into separate tracks first and then use the *Bounce to Disk* command in the File menu.

When overdub record mode is disabled, and you punch-in over existing audio in a track, the existing audio is completely replaced by the newly recorded audio. This record behavior prevents multiple layers of soundbites from piling up on top of one another when you are over dubbing. Instead, punching in will never create overlapping soundbites. Wherever there is a punch-in, the current soundbite is trimmed and a new soundbite begins. However, only those parts of existing soundbites you recorded over are erased. For example, if you record over the beginning of a soundbite, only the portion recorded over is replaced.

If you change your mind about the punch-in and wish to remove it, go back in the Undo history.

Overdub record mode lets you choose either method (replacing or layering) for punch-in recording.

**Overdub recording and the Conductor Track**

Overdub does not affect the Conductor Track; specifically, recording on the Conductor Track while slaved to Tap tempo sync always erases existing tempo events.

**Record With Overdub On or Off**

Regardless of the current Overdub state, you can override when recording it by using the *Record With Overdub On* or *Record With Overdub Off* commands. These do not have key bindings by default, but can be assigned key bindings in the Commands window.

**RECORDING MULTIPLE TAKES**

A *take* stores the contents of the track. Each track can have an unlimited number of takes. Takes are an ideal way to record, store, edit, and combine multiple versions of the material in a track. For details, see chapter 42, “Takes and Comping” (page 387).

**CYCLE-RECORDING**

Several of Performer Lite’s features can be combined to provide comprehensive cycle-recording, complete with MIDI Spot Erase and erasing the last pass.

**Setting up for cycle-recording**

To cycle-record:

1. Click the Memory Cycle and Overdub record buttons in the Control Panel.

The Memory Cycle button causes Performer Lite to loop a section indefinitely. To prevent accidental erasure of the previous record pass, Performer Lite falls out of record mode when it hits the cycle end point, unless Overdub mode is enabled.
2. Set the start and end times of the time range you want to loop in the Memory bar.

For a two measure loop, make the stop time 3|1|000. For a four measure loop, make the stop time 5|1|000. Stop time is always the downbeat of the measure after the last one in the loop. You can set the loop points graphically by dragging the loop repeat barlines in the time ruler of the Sequence Editor.

3. Set the tempo in the tempo slider.

4. If needed, make sure that the Click is enabled in the Studio menu.

5. Cue Performer Lite to the beginning of the Memory Cycle range.

6. Click the record button in the main transport controls and begin recording.

**Cycle-recording in MIDI tracks**
When you cycle-record into a MIDI track, each new pass is combined with the MIDI notes from previous passes in the same track take. For example, if the track is currently set to Take 1, and you first record a kick drum, the snare drum notes that you play in the second pass are combined with the kick drum notes in Take 1. You can, of course, change takes at any time.

**Editing newly recorded MIDI data**
In Performer Lite, recorded MIDI data and digital audio data appears immediately as you record it, before you press the Stop button. For MIDI data, this allows you to edit the data (erase, transpose, quantize, etc.) without stopping cycle-recording. Audio data, however, cannot be edited until after you press the stop button.

**Erasing the last MIDI pass and MIDI Spot Erasing**
You can easily accomplish common MIDI cycle-recording tasks such as erasing the last pass and Spot Erasing by opening the Drum Editor or other edit window while cycle-recording. As you record, notes appear in the window right away, so you can do whatever you want to them without having to press the stop button. You can even insert notes by hand in the looped time range, as well as continuous controllers such as volume controllers.

To quickly erase the last pass while recording a MIDI drum track, double-click the pitch key on the pitch ruler that corresponds to the note you just recorded. Doing so selects all the notes of that pitch in the track. Then hit the delete key.

To Spot Erase graphically, click the note and hit delete.

**Spot Erasing from your MIDI controller**
A set of cycle-record commands, including a MIDI Spot Erase function, is included in the Commands window. These controls help further provide drum-machine style loop recording by providing the ability to spot erase from your MIDI controller while cycle-recording.

After you’ve assigned a key to Spot Erase, hold down the Spot Erase key and play back; any notes you hold down on your MIDI controller keyboard that exist in the track are erased as the wiper passes them.
Changing the MIDI channel or patch on the fly
While you are cycle-recording, you can change the device, MIDI channel, or current default patch on the fly while recording as follows:

<table>
<thead>
<tr>
<th>Next/Previous item</th>
<th>Key to press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Shift up-arrow</td>
</tr>
<tr>
<td></td>
<td>Shift down-arrow</td>
</tr>
<tr>
<td>MIDI channel</td>
<td>Option/Alt up-arrow</td>
</tr>
<tr>
<td></td>
<td>Option/Alt down-arrow</td>
</tr>
<tr>
<td>Default patch (sound)</td>
<td>Command/Ctrl up-arrow</td>
</tr>
<tr>
<td></td>
<td>Command/Ctrl down-arrow</td>
</tr>
</tbody>
</table>

You can also map these shortcuts to MIDI keys on your MIDI controller, so that you can do everything from your MIDI controller during recording. See chapter 28, “Commands” (page 234) for details.

Cycle-recording in audio tracks
When you cycle-record into an audio track (with Overdub Record mode turned on, Performer Lite automatically creates a new take for each record pass. For example, if you record a bass line into Take 1, the track will automatically switch to take 2 immediately at the end of take 1. This allows you to play a second take that is completely different than the first.

Capturing the perfect take
By automatically creating takes during audio cycle-recording, Performer Lite allows you to continuously record multiple independent passes into an audio track inside the current Memory Cycle loop points. For example, you could set up the Memory Cycle points around a solo section and then continuously play in multiple passes of the solo, one after the other, without ever stopping. Performer Lite saves each pass separately during recording. When you stop recording, Performer Lite then splits each pass into its own take. You can then choose among takes, or even build a composite take based on parts from each pass using Performer Lite’s powerful take comping features; see chapter 42, “Takes and Comping” (page 387).

Audio cycle-recording with punch-in/punch-out
Audio cycle-recording can also be used together with Performer Lite’s Auto-Record punch in/out feature. You can set up an Auto-Record time range inside the Memory Cycle time range and perform multiple record passes in Overdub Mode as described earlier. Each pass inside the Auto-Record range is stored in a separate take. This allows you to give yourself a bit of pre-roll and post-roll when recording multiple passes.

Creating a permanent loop
After you are satisfied with the MIDI or audio loop you’ve created, you can make it permanent by inserting a loop into one or more tracks. Use the Loop tool in the Tool palette (Studio menu).

Recording in external sync
When recording in external sync other than Tap tempo, the Record button is turned off every time the master device stops or rewinds. This is a safety precaution, to prevent accidental erasure of previously recorded data. Refer to chapter 66, “Receive Sync” (page 554) for details on recording while slaved to each type of external sync.

Recording while still-framed
If you are slaving to an external sync source, Performer Lite allows you to remain in record mode while the video parked on a SMPTE frame. To do so, check the Record while still framed option in the Receive Sync settings in the Setup menu.

Sample format
Performer Lite supports three sample formats: 16-bit integer, 24-bit integer, and 32-bit floating point.

24-bit digital audio recording uses a 24-bit word to describe each sample recorded. 16-bit recording provides 2 to the 16th — or 65,536 — values to record the level of audio for any given sample.
24-bit recording supplies 8 more bits (2 to the 24th), providing over 16 million separate values (16,777,216 to be exact) with which to record the level of any given sample. As you can see, 24-bit recording provides 256 times the resolution — or “fineness” — of 16-bit recording.

24-bit recording has several advantages over 16-bit recording. One is signal-to-noise ratio. In digital recording, each bit provides approximately 6 dB of signal-to-noise ratio (SNR). So 16-bit recording provides a theoretical 96 dB of SNR, 20-bits provide 120 dB, and 24-bits provide 144 dB. With medium to loud audio material, such as a pop music recording, this extra 48 dB of SNR is not a significant advantage. On quiet recordings, however, with long instrument decays or reverb tails, the extra SNR can become much more of an important advantage over 16-bit recording.

The much more significant difference between 16 and 24-bit recording is the resolution, and this factor impacts sound at all levels, soft and loud, even to the untrained ear. As mentioned earlier, 24-bit recording has 256 times the resolution of 16-bit recording. You can readily hear the difference when A/B-ing material recording at the two different sample formats. 24-bit audio has a noticeably enhanced detail, tightness in the bottom end, and overall depth.

32-bit floating point audio file resolution is an emerging standard used for high-end recording, mixing and mastering applications. The advantage of floating-point representation over fixed-point representation is that it can support a much wider range of values by allowing the decimal point to “float” among the digits than store the value of each sample. For example, a fixed-point representation that has eight decimal digits, with the decimal point assumed to be positioned after the sixth digit, can represent the numbers 123456.78, 8765.43, 123.00, and so on, whereas a floating-point representation with eight decimal digits could also represent 1.2345678, 1234567.8, 0.00012345678, 12345678000000000, and so on. 32-bit resolution allows audio data to be stored with a very high precision and very wide dynamic range.

Performer Lite’s mix engine employs 32-bit floating point precision throughout. Recording as 32-bit float is a good way to preserve the floating point precision employed by the Performer Lite mix engine at all stages, particularly if you will be re-recording, bouncing, or applying effects constructively or destructively to your audio.

**GETTING AN ERROR MESSAGE**

Performer Lite keeps close track of whether or not it had any trouble processing the audio data during recording. If conditions prevent it from successfully encoding all the digital audio information, you will be presented with an error message letting you know that an error occurred. These errors can be due to conditions such as:

- Other background software interruptions
- A highly fragmented hard disk
- A hard disk that has an access time that is too slow
- Other interruptions

See “Audio troubleshooting” on page 591 for more information about how to handle error messages.
CHAPTER 32  Movie Window

OVERVIEW
overview .................................................. 267
Random access digital picture ....................... 267
Supported video formats ............................... 267
Opening movies .......................................... 267
Closing movies ............................................ 268
Movie control bar ........................................... 268
The movie track ............................................. 269
Movie window menu commands ..................... 269
Scrubbing the Movie window ......................... 270
Improving movie window performance .............. 270
Exporting a Movie .......................................... 270

RANDOM ACCESS DIGITAL PICTURE
Performer Lite's Movie Window provides synchronized playback of video clips with both MIDI and audio tracks in a sequence. Digital video provides random access to picture, just like digital audio and MIDI. For example, you can:

- Instantly locate to any spot in the movie
- Advance forwards or backwards one frame at a time through the picture and music
- Scrub forward or backward (with or without audio and MIDI scrubbing)
- Seamlessly loop both picture and music

All of this can be done without the hassles of slaving to external time code.

SUPPORTED VIDEO FORMATS
Generally speaking, Performer Lite can play any video file that is supported by your computer system. More specifically, if the video file plays successfully in macOS QuickTime Player or Windows Media Player, it should work with Performer Lite as well.

OPENING MOVIES
Only one movie can be open at a time for a sequence. The Movie command in the Project menu opens a movie in Performer Lite. To open a movie for a sequence:

1  Play-enable a sequence in the Set List.

2  Choose Project menu> Movie to open a movie.

A standard file browser appears, allowing you to navigate to the movie file you wish to open. For a discussion of supported video formats, see “Supported video formats” above.

Working with multiple sequences
If you are working with multiple sequences, you can either use the same movie for all sequences, or use a different movie for each sequence. There is a checkable menu item in the Movie Window menu called Use Same Movie for All Sequences. This menu item also appears in the movie track menu in the Sequence Editor. When it is checked, you get the following behavior:

- Every sequence in the project uses the same movie.
- Each sequence can have its own unique sequence start time, but the movie start time is the same for all sequences. Changing the sequence start time will make the movie begin earlier or later in the sequence.
- The movie window is placed at the same position and size for every sequence.
- Closing the movie window closes it for all sequences.
- Choosing a new movie for one sequence chooses that same movie for all sequences.
If you have two or more sequences in the project and you wish to open a separate movie for each sequence, uncheck the Use Same Movie for All Sequences menu command and do the following:

1. Play-enable a sequence in the Set List.

2. Choose Project menu > Movie to open a movie for it.

3. Play-enable a different sequence in the Set List.

The movie window for the first sequence disappears at this point.

4. Choose Project menu > Movie to open a movie for the second sequence.

5. Repeat this procedure for as many sequences as you wish.

When you switch from one sequence to another (by clicking its play-enable button in the Set List), the movie window will update itself to show the movie you chose for that sequence. Each sequence also stores a separate location for the movie window on the screen. So you can reserve a different spot on screen for each movie. Or you can place them all in the same location, if you wish.

Displaying a blank movie for visual cues
You can open a blank movie (with a black background) by choosing Project menu > Movie, but then cancel the resulting dialog box. A blank movie can be used for any purpose.

Closing movies
You may close the Movie window, and Performer Lite will still remember which movie file you opened at the time you last saved the project. To reopen the movie, just play-enable the same sequence choose Movie from the Project menu again. To close the movie permanently so that Performer Lite forgets about it, choose Clear Movie from the menu.

If you have a movie open and want to choose a different movie, choose Open Movie from the menu. Only one movie can open at a time for each sequence. (But each sequence can have its own movie, as explained earlier.)

Movie Control Bar

The movie control bar (Figure 32-1) appears in the movie window when you move the mouse over the window. Drag the bar to reposition it as desired.

Volume
The volume control allows you to set the playback volume for the movie’s audio track.

Play/Stop
The Play/Stop button starts and stops movie playback.

Full screen
Click the full screen control to enter or exit full-screen mode. If you have multiple monitors, place the movie window on the monitor you wish to fill before entering full-screen mode. If the movie window is full screen when you save and close the file, it will reopen in full screen mode when the project is reopened. To exit, press the escape key as a shortcut.

Figure 32-1: The Movie control bar.
Time elapsed/remaining
Displays the amount of time already played (elapsed) and yet to be played (remaining).

Scroll bar
The scroll bar shows where in the movie you are, and can be used to “scrub” the movie or to set your location in the movie.

Frame backward/forward
The frame backward/forward buttons move through the movie one frame at a time. Note that this means movie frames, not SMPTE frames. A movie may have 15 fps, 30 fps, or even a number which varies throughout the movie. The left/right arrow keys will also work if the window is active.

Window resizing
Drag the bottom right corner to resize the movie window, while maintaining its original aspect ratio. Shift-drag to resize and change aspect ratio of the window, which will add black bars (pillar box or letter box) above or below the movie as needed. Drag again without the shift key to remove the black bars.

Popping in and out of the Performer Lite Window
Double-click anywhere on the movie to pop it in or out of a cell in the Performer Lite Window. For example, you may want to edit with the movie displayed in a window cell, then pop it out and go full-screen to review your edits. Exit full-screen mode and double-click it again to pop it back into the original window cell.

THE MOVIE TRACK
Use the Sequence Editor track selector (see “The Track Selector” on page 106) to display the Movie track, which displays the movie you’ve opened in the Performer Lite project, if any. For details about the movie track, see “The movie track” on page 115. All of the controls for the Movie window, such as the movie start time, audio output settings, and menu, are available in the track setting panel to the left of the movie track, as shown in Figure 32-2.

MOVIE WINDOW MENU COMMANDS
The Movie window menu can be accessed by right-clicking anywhere on the movie or by going to the Movie track settings panel in the Sequence Editor (Figure 32-2).

Size: (Movie track menu only) Lets you choose how big or small the movie track is displayed in the Sequence Editor.

Set Movie: Presents you with a standard file dialog to choose the movie file you wish to open.

Use Same Movie for All Sequences: Forces all sequences in the project to use one movie.

Clear Movie: Closes the movie.

Open Movie window: (Movie track menu only) Opens the movie in a separate window.

Reveal Movie in Finder / Show Movie in Explorer: Switches out of Performer Lite and onto your computer desktop to show you the location of the movie on your computer hard drive.
**Set Movie Start Time:** Allows you to set the SMPTE time which corresponds to the beginning of the movie. If you want the movie to start at the beginning of the sequence, this should be set to the same time as the SMPTE sequence start time. You may need to try adjusting the start time by ±40 time code bits if you find that the frames in the movie don’t precisely line up with the frame numbers in Performer Lite’s counter.

**Import Movie Audio:** If the movie has an audio track, this command creates a new track in the current sequence and places the movie’s audio into the new track. If the movie has no audio track, this command is grayed out.

**SCRUBBING THE MOVIE WINDOW**
You can “scrub” playback with the Movie window scroll bar. For more information, see “Scrubbing multiple MIDI tracks” on page 250.

**IMPROVING MOVIE WINDOW PERFORMANCE**
The following things may hinder the computer’s ability to play a movie back smoothly:

- Larger movies (in pixels)
- Movies with higher frame rates
- Playing the movie from slower drives
- Resizing the window to non-optimal sizes (not double, full, or half size)

Avoiding these things will help your movies play back more smoothly.

**EXPORTING A MOVIE**
You can bounce an audio output bundle (mono or stereo), together with video, to a movie file. This allows you to export a complete movie from Performer Lite in one easy operation, complete with a sound track that you’ve created in Performer Lite. For details, see “Bouncing to a Movie” on page 547.
Part 7

Editing
CHAPTER 33 Editing Basics

OVERVIEW
Performer Lite provides unmatched features for editing MIDI data, audio data and both at the same time. This chapter provides a introduction to editing in Performer Lite and covers several general features than can be employed universally while editing.

Overview .................................................. 272
Unlimited Undo/Redo ................................. 272
Editing during playback .............................. 272
Selecting and searching ............................. 272
Region editing ........................................... 272
Track groups ............................................. 273
View menu .............................................. 273
Zooming .................................................. 274
Scroll To .................................................. 277
Graphic editing techniques ....................... 277
Audio editing basics ................................. 278
Sample accurate editing ......................... 279
Listening while editing .............................. 279

UNLIMITED UNDO/REDO
Performer Lite supports unlimited Undo/Redo. It can remember everything you have ever done to a project, even after you close and quit, across any number of sessions, all the way back to the moment the project was first created.

EDITING DURING PLAYBACK
Almost all edit operations in Performer Lite can be done during playing back so that you don’t have to stop and start to hear the result. For example, you could Transpose while the sequence is playing and then use the Undo/Redo command as the music continues playing to compare the original and modified data.

SELECTING AND SEARCHING
To edit anything in Performer Lite, you must first select it. Performer Lite provides many useful ways to make selections, from a single event—or event parameter—to the entire project. After you’ve made a selection, you can apply Performer Lite’s many powerful Edit menu commands to whatever is selected. Be sure to learn all of the ways to make selections by reading chapter 34, “Selecting” (page 281).

REGION EDITING
A region is a span of time across one or more tracks. Performer Lite’s edit windows provide flexible region editing across one or more tracks, allowing you to edit data within that region with a wide range of edit operations. You can edit audio tracks, MIDI tracks, and both simultaneously. The process of region editing consists of the following basic steps:

1 Select a region.

2 Apply the desired operation from the Edit or Region menus.

These steps are discussed briefly in the following sections.

Selecting regions
There are many ways to select regions. For a summary, see “Selecting a time range” on page 284.

Applying Edit and Region menu operations
After you’ve selected a region, you can choose any command from the Edit or Region menu. Edit menu commands affect audio in the same way as MIDI. See chapter 39, “Edit Menu” (page 337) and
chapter 40, “Region Menu” (page 342) for details about these basic commands. Region menu commands affect audio as discussed below.

**Region menu exceptions for audio**
The Transpose command has the ability to transpose the pitch of audio, with or without formant correction. For details, see “Transpose” on page 343 and chapter 61, “Transposing Audio” (page 519).

Some Region menu commands that affect timing (such as Retrograde) only affect the placement of soundbites—that is, the attack time of the soundbite. They do not have an effect on the audio data within the soundbite. For example, if you use Reverse Time over a region containing a soundbite, the soundbite audio data does not play backwards like a reversed sample. Instead, the placement of the soundbite within the region is modified, along with other soundbites and MIDI note data, according to their attack times within the region. To reverse the audio in the soundbite, you would use choose **Audio menu > Plug-ins > Reverse**. For details about Reverse Time, Retrograde, and other Region menu commands for MIDI, see chapter 40, “Region Menu” (page 342).

**TRACK GROUPS**
Performert Lite allows you to create an unlimited number of track groups, and tracks can be linked for mixing, editing, both, or for a customized set of operations that you specify. Tracks can be a member of more than one group. Groups can also be “nested” within each other. For further details, see “Track Groups” on page 73.

**VIEW MENU**
The View menu provides many useful shortcuts for controlling what you see in Performer Lite’s windows and how information is displayed.

**Show/Hide Tracks**
The View menu provides several commands for showing and hiding tracks in any Performer Lite editor that can display multiple tracks, such as the Sequence Editor, Mixing Board or Notation Editor window.

When using these commands, it can be useful to open the Track Selector to get an overview of the results.

To zero in on just the tracks you want, it can be useful to start out with all tracks hidden: choose **View menu > Hide Tracks > All**.

Each Show/Hide Track command provides a submenu that allows you specify which tracks you wish to show or hide. For example, if you choose **Show Tracks > Play Enabled**, all currently play-enabled tracks will be shown.

Showing and hiding is a one-shot operation; in other words, these commands are not checkable (i.e. “sticky”). Instead, they produce a result for the currently active (focused) window, at the moment you choose the command. You can then further adjust what is shown or hidden using additional consecutive show/hide command(s), or by using the track selector.

When using several show/hide commands consecutively, the effect is cumulative, which allows you to fine-tune the track display.

**Show Tracks**
The **Show Tracks** command “unhides” the type of track you choose from the sub-menu. The visibility of any other tracks remains unchanged. This command is good for adding tracks to the display.
Show Only Tracks
The *Show Only Tracks* command “unhides” the type of track you choose from the sub-menu and hides all other tracks. This command is good for “soloing” the type of track you choose from the sub-menu.

Hide Tracks
The *Hide Tracks* command hides the type of track you choose from the sub-menu. The visibility of any other tracks remains unchanged. This command is good for hiding tracks you don’t want to see, while leaving other track types visible.

Track Layouts
A *track layout* is a “snapshot” of which tracks are currently shown and hidden at the time it is created. The commands in the *Track Layouts* sub-menu let you create, name, rename and delete track layouts. To create one, show and hide tracks as desired and then choose *View menu > Track Layouts > Save Track Layout As*. The resulting track layout appears by name at the bottom of the Track Layouts sub-menu, where you can choose it to recall the layout. Saved track layouts also appear in the Commands window (Setup menu), where you can assign them to keyboard shortcuts. To view them, type *Track Layout* into the Commands window search field.

Show Only
The *Show Only*... commands in the View menu control the display of automation data and MIDI continuous controller data in the Sequence Editor.

When *Show Only the Active Edit Type* is checked, the Edit Layer menu (in the Sequence Editor track settings pane as shown in Figure 17-13 on page 110) control the type of automation data that will be visible.

To use the *Show Only Selected Types (Quick Filter)* command (to make it not grayed out), the following two conditions must be met:

- the *Show Only Active Edit Type* command is unchecked, and
- at least one MIDI controller event must be selected

If these two conditions are met, then choosing this command will “solo” the selected data type, temporarily hiding all other.

Show/Hide Lanes
The view menu provides several commands for showing and hiding automation lanes in the Sequence Editor (“Displaying automation lanes” on page 318). To activate these commands (make them not grayed out), make the Sequence Editor visible and active. Choose *Show All Lanes with Data* to expose any automation lanes that contain data of any kind. Choose *Show/Hide Lanes* to show all lanes or hide any currently visible lanes.

Grid
The commands in the Grid sub-menu show and hide various types of grid lines in the Sequence Editor.

Colors
The *Colors* sub-menu in the View menu lets you control track colors in Performer Lite. See “Track colors” on page 54.

ZOOMING
Zooming in the edit windows is similar to the zooming found in most computer graphics programs. When zooming in, objects become larger as the display magnifies a portion of the screen. When zooming out, objects shrink as the display encompasses a larger region.

There are many ways to zoom the edit windows, as explained in the following sections. Individual windows may also have additional zoom abilities; refer to the chapters on each window for more details.
**Zoom buttons**
The Time zoom buttons appear in the bottom right corner of the window. Zooming out ( - ) gives you an overview by compressing more time into the window; zooming in ( + ) focuses on a shorter period of time at a higher viewing resolution.

Some windows, such as the Sequence Editor, also have vertical zoom buttons to increase the height of the data you’re viewing.

Zooming quickly by pressing
If you press continuously on a zoom button, the display will zoom continuously until you release the mouse.

**Wiper zooming**
In many windows that display the playback wiper, you can very quickly and conveniently zoom in and out by Control/Win-dragging vertically on the green playback wiper handle. For details, see “Zooming with the wiper” on page 249.

**Zooming with the scroll wheel**
If your mouse has a scroll wheel, you can use it to zoom. Simply position the cursor over the zoomable portion of an editor and hold down the option/alt key while spinning the scroll wheel.

**Zooming with a track pad**
If you have a track pad, you can use standard pinch gestures to zoom in and out.

**Keyboard zooming shortcuts**
Below are several keyboard shortcuts for zooming. In addition, all of the zooming shortcuts discussed in the next section (“Zoom menu shortcuts”) have keyboard shortcuts, which are available in the Commands window (see chapter 28, “Commands” (page 234).

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command/Ctrl-left arrow</td>
<td>Zoom out horizontally.</td>
</tr>
<tr>
<td>Command/Ctrl-right arrow</td>
<td>Zoom in horizontally.</td>
</tr>
<tr>
<td>Command/Ctrl-up arrow</td>
<td>Zoom in vertically (track height or note grid).</td>
</tr>
<tr>
<td>Command/Ctrl-down arrow</td>
<td>Zoom out vertically (track height or the note grid).</td>
</tr>
<tr>
<td>Option/Alt key</td>
<td>When added to the above shortcuts, the Option/Alt key zooms all the way.</td>
</tr>
</tbody>
</table>

**Zoom menu shortcuts**
The View menu > Zoom sub-menu (Figure 33-1 on page 275) provides many useful options for magnifying or reducing the data displayed in graphic editors. Performer Lite offers completely unlimited zooming between the minimum and maximum horizontal zoom levels.

**Zoom in/out**
Zooming in (either vertically or horizontally) enlarges the data; zooming out reduces it.

**Zoom To Default Zoom**
Zoom To Default Zoom restores the original zoom level for the window.
Zoom to Selected Time Range

*Zoom to Selected Time Range* fits the current selection horizontally to the left and right edges of the window.

**Zoom to Selection**

*Zoom to Selection* fits the current selection both horizontally and vertically in the window in the Sequence Editor.

**Zoom to Track**

*Zoom To Track* fits the currently selected track in the Sequence Editor to the full height of the window.

**Zoom Back and Zoom Forward**

As discussed in “Zoom history and Zoom Forward/Backward” on page 276, the *Zoom Back* and *Zoom Forward* commands keep track of every zoom operation that you do since you first opened the Sequence Editor. Therefore, they allow you to step backwards and forwards through all of the different scrolling and zooming actions you’ve taken. Just keep choosing them over and over to work your way backwards or forwards.

**Auto Zoom Track**

When you select a MIDI track in the Sequence Editor and choose *Auto Zoom Track*, the vertical zoom level and vertical scroll of the track is automatically set, such that all MIDI note data in the track will be visible within the track’s lane in the Sequence Editor. The track will continue to automatically zoom, even when edits are applied to the MIDI note data in the track, so that all notes always remain in view.

If, at any time, you manually zoom the track, perform pencil tool editing, or drag and drop material into the track, auto-zooming becomes disabled so that it doesn’t interfere with your edits. When you are finished, you can re-enable it again by selecting the track and choosing the Auto Zoom Track command again.

Working with the zoom settings

The zoom settings let you store favorite zoom settings and easily restore them by choosing them from the menu (or pressing their key binding). To store a zoom setting:

1. Zoom the display the way you want.

2. Choose the desired *Set Zoom Setting* command in the menu.

To restore the zoom setting, choose the desired *Zoom to Setting* command.

**Switching among 2 or 3 zoom settings**

The zoom settings commands discussed above are ideal for zooming among several different zoom settings. For example, you might want to switch back and forth between the sample level and an overview level to consecutively make small sample edits and then audition them.

**Zoom tool**

The Zoom tool (magnifying glass) in the Tool palette lets you zoom in on a portion of the edit window by dragging a zoom box over it. In the time ruler or continuous data grid, drag horizontally to zoom the time axis only.

See “Zoom tool shortcuts” on page 224 for many Zoom tool shortcuts.

**Zoom history and Zoom Forward/Backward**

Performer Lite remembers consecutive zoom operations in a window. For example, if you zoom in three times consecutively to get a closer look at some data, Performer Lite remembers each zoom setting. You can then use Zoom Backward and Zoom Forward shortcuts to move forwards and backwards through these remembered zoom settings.
**Zooming, Edit Resolution and nudging**
Editing is allowed at any zoom setting. However, the current zoom level may affect the resolution at which events can be edited by dragging. For example, let’s say that the Edit Resolution unit is set to 20 ticks. If you zoom way out, you will not be able to drag a note by only 20 ticks because one screen pixel, which is the smallest unit of movement on the computer screen, will equal a time value greater than 20 ticks. So, even if you move the note as little as possible, you will still have moved it more than 20 ticks.

In the example above, Performer Lite handles the situation by constraining location to multiples of 20 ticks. When you move the note, its new location will become the nearest multiple of 20 ticks, such as 80, 140, or 420 ticks.

If you need more precision, zoom in. Or, you can nudge data in precise increments at any zoom level use the arrow keys and the Nudge Amount window. See “Nudge” on page 332.

**SCROLL TO**
The Scroll sub-menu (View menu) provides two commands for scrolling immediately to the start or end of the current selection or file. The Scroll to File Start or End command applies to the sequence time line for edit windows.

**GRAPHIC EDITING TECHNIQUES**
Performer Lite has many powerful editing features. Most editing can be done with the mouse using familiar actions like clicking, dragging, and Shift-dragging. Such actions can shift data, change note pitch and duration, reshape continuous data curves, and more.

The sections below describe basic features that you will find helpful when working in Performer Lite’s graphic environment.

**Shift-drag to constrain**
If you hold down the Shift key before you begin to drag a selection, the pointer’s movement on the screen will be constrained to either the horizontal or vertical axis, depending on the initial direction of movement. For example, if you click the mouse, hold down the Shift key, and drag upwards, the mouse will only move up or down: it will not stray left or right.

Constraining mouse movement in this way is often extremely helpful. For example, if you want to modify just the pitch of a note without changing its location, the Shift key allows you to do so by preventing the mouse from moving left or right.

**Option/Alt-drag to duplicate**
Option/Alt-dragging an event (or several selected events) leaves the original data unchanged and places a copy of the data at the destination. Option/Alt-dragging is a convenient shortcut for copying and pasting.

**Canceling while dragging**
If you are in the middle of dragging, and you change your mind, you can press the escape key while dragging to immediately cancel the operation and restore the data to its original position, unchanged.

**Shift-clicking to select non-adjacent events**
Holding down the Shift key also serves as a useful way to select more than one event. For example, if you have already selected a note and you want to select another, scroll to the other note (if necessary) and Shift-click on it (but don’t drag). It will highlight, and the first note will remain highlighted.

**Other selection techniques**
There are many other useful selection techniques. See chapter 34, “Selecting” (page 281).
Dragging multiple data types
The Shift-click method of selection allows you to simultaneously select and drag multiple data types.

For example, to move a loop containing notes, pitch bend data, and a patch change, select all four data types by Shift-clicking and drag them to a new location.

Nudging
The Nudge Amount (Snap Information window) lets you move selected data with the left and right arrow keys by any amount in any unit of measurement that you choose. See “Nudge” on page 332.

Using Edit Resolution
When the Snap to Grid check box is selected in the Snap Information window, data that is moved or inserted will ‘snap’ to positions corresponding to the current edit resolution setting. For example, if the current grid resolution unit is 240 ticks, events that are moved with the mouse will snap to positions at every 240 ticks on the grid. If the Snap to Grid check box is not checked, events will move freely. You can temporarily override the current grid setting by holding down the Command/Ctrl key as you drag. Snapping can occur either relative to the original position of the data event, or relative to an absolute grid based on the timeline’s bars and beats. For further review, see “Snap Information” on page 331.

Using Undo
The Undo command in the Edit menu will undo the last action you executed. For example, if you move a note and then change your mind, you can choose Undo Move from the Edit menu and the note will return to its original position.

AUDIO EDITING BASICS
The following sections explain several important concepts to keep in mind when editing digital audio.

Soundbites in a track are ‘clones’ of the original
It is important to understand that soundbites in a track are “clones” of the original soundbite in the Soundbites list. They do not actually consist of the soundbite itself; they are a reference to the original soundbite. As a result, you can freely cut, copy, paste, duplicate, and re-arrange a soundbite in a track as much as you want without affecting or duplicating its original in the Soundbites list. On the other hand, if you change the soundbite’s name or length, all instances will change, including the original. Interestingly, the original soundbite is itself merely a reference to something else: it is a pointer to the original audio data in the audio file. As a result, the amount of data that you generate by duplicating soundbites is insignificant, since soundbite data is merely a pointer to the actual audio data.

Non-destructive, destructive and constructive audio editing
When you edit audio, your edit operation is either non-destructive, destructive or constructive. A clear understanding of these terms will help you make better decisions about how to edit your audio. Here is a brief explanation:

<table>
<thead>
<tr>
<th>Type of audio editing</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-destructive</td>
<td>Original audio data is preserved. Only pointers to the original audio data are modified. Example: trimming the edge of a soundbite in the Sequence Editor.</td>
</tr>
<tr>
<td>Destructive</td>
<td>Original waveform data is permanently modified. Example: normalizing audio.</td>
</tr>
<tr>
<td>Constructive</td>
<td>Original audio data is preserved on disk while being replaced in the Performer Lite project by new audio generated by the constructive editing operation. Example: applying an audio effect via the Audio menu.</td>
</tr>
</tbody>
</table>
Non-destructive Edit menu and Region menu editing
Edit menu and Region menu operations are non-destructive when applied to audio that has been selected in the Sequence Editor, except for the Transpose command in some cases. When using Transpose with the “Transpose audio by creating new soundbites”, audio data is processed constructively, (where the original audio is replaced by newly processed audio.) See “Constructive editing” on page 514.

You can’t mix audio and MIDI in the same track
In Performer Lite, you cannot mix the two data types together into one track. You can, however, edit both types of tracks simultaneously as described in the next section.

Editing audio and MIDI data simultaneously
As an integrated audio and MIDI editing environment, Performer Lite lets you to select audio tracks at the same time as MIDI tracks for simultaneous editing of audio and MIDI data. For example, you can select all tracks of an eight measure chorus, including audio tracks, to cut, copy, or paste the audio data along with the MIDI data.

Editing soundbites in the Sequence Editor
The Sequence Editor offers and advanced, graphic environment for audio editing and selection. See chapter 17, “Sequence Editor” (page 102).

SAMPLE ACCURATE EDITING
Performer Lite provides sample-accurate editing of audio and MIDI data. This capability affects Performer Lite’s interface in several ways, as explained in the following sections.

The Samples time format
Performer Lite has a samples time format, which can be chosen for display in the program’s main counter and auxiliary counters. It is also available as a time ruler in the editor windows.

If you display samples in the counter, it shows the number of digital audio samples from the beginning of the project. This number is, of course, dependent on the project’s overall sample rate. For example, if the sample rate for the project is 44.1 kHz, and you cue the counter to 1 second, the sample counter will display 44,100 samples.

Figure 33-2: Performer Lite’s sample counter.

Zooming in to the sample level for editing, trimming, nudging, etc. by sample
The Sequence Editor allows you to zoom in to the sample level to perform sample-accurate editing tasks. For example, you could place a soundbite — or even a MIDI note — at an exact sample location. (Note, however, that the playback of the MIDI event may not be sample accurate due to the timing resolution of MIDI hardware.) You can also trim the edges of soundbites at the sample level, or select them and nudge them one sample at a time with the arrow keys. Audio playback is sample accurate, and you can even perform sample-accurate digital transfers to other devices, such as ADATs and Tascam digital tape recorders, if your hard disk recording hardware supports this feature, such as the MOTU 2408mk3 audio interface.

LISTENING WHILE EDITING
Performer Lite allows you to see and hear an individual MIDI note or phrase while you are working in Performer Lite’s editing windows. MIDI notes can be played back one at a time by clicking on them individually or as a phrase by highlighting a region.

If you click on a note and don’t hear anything, make sure that the output assignment for the track is set up properly. If the track plays back correctly when you press the Play button in the Control Panel, it will play notes while editing.
Playing individual MIDI notes
When you click on a note, the note will simultaneously select and play back on its MIDI instrument. The note sustains for as long as you hold down the mouse.

Playing phrases
Using the Audition Selection command (Region menu), it is also possible to audition any selection of MIDI and/or audio data.

To audition a selection:

1 Select the data. See chapter 34, “Selecting” (page 281) for details.

2 Choose Audition Selection from the Region menu, or press Option/Alt-spacebar.

When you audition the current selection, the tempo of the phrase is determined by the current tempo setting in the Control Panel. Auditioning can be stopped at any time by clicking or striking a key on the computer keyboard.

Playing MIDI chords
Performer Lite allows you to hear MIDI chords one note at a time, all at once, or only with selected notes. To listen to a chord one note at a time, click each note one at a time.

To hear the entire chord at once, highlight all of the notes and choose Audition Selection from the Region menu. To hear only selected notes within the chord, highlight only the notes you wish to hear.

Playing MIDI data other than notes
Only notes will play back when you highlight them. Other MIDI events such as controllers or pitch bend can be played with the audition feature. For example, to send a patch change to a MIDI instrument directly from the Sequence Editor, highlight the patch change and use the Audition Selection command (Region menu). System exclusive data cannot be auditioned. To play back a system exclusive event, press the Play button in the Control Panel.
CHAPTER 34  Selecting

OVERVIEW
Before you can edit anything in Performer Lite, you must first select it. Performer Lite provides many useful and powerful ways to make selections. After you’ve made a selection, you can apply Performer Lite’s many powerful Edit menu and Region menu commands to whatever is selected.

This chapter shows you the many convenient ways to select data in Performer Lite. Except where noted, these techniques apply to any type of data (MIDI, audio, conductor track, automation, etc.)

Overview .................................................. 281
Selection basics ........................................... 281
Choosing a Pointer tool selection mode ............... 282
Selecting events .......................................... 283
Selecting tracks ......................................... 283
Selecting a time range ................................... 284
Smart Selection .......................................... 286

SELECTION BASICS
There are three ways to make selections in Performer Lite:

■ Event selection — Selects specific events
■ Time range selection — Selects a region of time, regardless of what is in the region

Selecting events
Event selection involves clicking (or dragging over) events in one Performer Lite’s edit windows. The events become highlighted to indicate they are selected, and they can then be edited or otherwise modified.

Selecting a time range
A time range selection spans a certain period of time in one or more tracks, regardless of what data is in the region. In fact, time range selections can even be empty. For example, you could select four empty measures and actually copy them into the Clipboard — perhaps to splic the empty space somewhere in a track. Or, you could select two empty measures at the beginning of a track and then use the Snip command to remove them and move up everything else in the track to replace them.

Time range selections are always affected by Performer Lite’s Smart Selection feature, which has an important impact on what happens when you make selections. So be sure to read “‘Smart’ Boundaries on Time Range Selections” on page 287.

Edit operations that require time range selection
There are a few commands in the Edit menu and Region menu that require time range selection: Snip, Repeat, Paste Repeat, Merge Repeat and Retrograde. These commands wouldn’t be able to do anything useful without a clearly defined end time for the selection, which event selections don’t provide. Therefore, these commands are grayed out if the current selection is an event selection. To use them, make a time range selection as shown later on in “Selecting a time range” on page 284.

The ‘Smart Selection’ feature affects time range selections
Performer Lite’s Smart Selection feature (Edit menu) has an important impact on edits that you apply to Time Range Selections. The effects are
Selections are global
After you have made any type of selection, the selection remains in effect until you either deselect or make another selection. The current selection appears in all edit windows. For example, if you highlight a few notes in the Sequence Editor, and then open the Notation Editor, the notes will be highlighted in the Notation Editor, too.

The current selection remains in effect even if you close all edit windows. So be careful not to inadvertently edit hidden data. Always be certain about what the current selection is before using Edit and Region menu operations.

Applying successive edits to the selection
Data remains selected even after you apply an edit operation to it. This lets you easily apply successive edits to the same data.

Auditioning the current selection
To play back the current selection, choose Audition Selection from the Region menu.

CHOOSING A POINTER TOOL SELECTION MODE
Selection operations are made with either the Pointer tool or the I-Beam tool.

All selection operations made with the Pointer tool in the Sequence Editor depend on the Cursor Selection mode (Preferences > Editing > Tools). These modes control what will happen when you use the Pointer tool to make selections in these multi-track windows.

‘Event & Phrase Selections only’ (lasso mode)
In this cursor selection mode, clicking in empty space makes a lasso selection (data only). Clicking on individual soundbites, MIDI notes, or data points (such as MIDI controllers or automation) selects them.

When dragging to make a selection, you can drag both horizontally and vertically so as to specify a specific time and value range. When you finish dragging to make your selection and let go of the mouse, only the events themselves remain selected; the time range is not selected.

 Holding down the Control/Win key forces a lasso selection, even if you click a soundbite, unless the soundbite is selected, in which case you throw the soundbite.

 Additionally, holding control will cause the selection to span the entire vertical range of the track (for example, to select all MIDI notes in a region without having to drag vertically over all of them).

 Holding down the Control/Win and Option/Alt keys performs a time range (crosshair) selection.

‘Range Selections only’ mode
In this cursor selection mode, clicking anywhere except a selected soundbite or note performs a time range selection (with the crosshair cursor).

 Holding the Control/Win key down allows you to make a range selection even when clicking on a selected soundbite or note. (To perform a throw operation you must hold the Control/Win key down after you click.)

 Holding down the Control/Win and Option/Alt keys performs a lasso style selection.

‘All Selections’ mode
In this cursor selection mode, the Pointer tool is dynamic and will change depending on where it is positioned in the window. This mode gives you
the most immediate flexibility for selection operations. Clicking on individual soundbites, MIDI notes or other events selects them. Moving the cursor over empty space turns the cursor into a cross hair and initiates a time range selection. Holding down the Control/Win key forces a time range selection, even if you click on a soundbite, unless the soundbite is already selected, in which case you throw the soundbite. Option/Alt-Control/Win-clicking performs a lasso-style (event) selection.

SELECTING EVENTS
The following sections explain how to select events. For time range selection techniques, see “Selecting a time range” on page 284. Also see “Edit operations that require time range selection” on page 281 to learn about a few commands in Performer Lite that can’t be applied to event selections.

Event selections are *not* affected by the Smart Selection feature in the Edit menu, even when it is turned on. For more information, see “Smart Selection” on page 286.

Using the Pointer tool for event selection
The Pointer tool in the Tools palette (Figure 26-1 on page 220) is used for event selections. Hold down the “a” key as a temporary shortcut for enabling the Pointer tool. Or double-tap the “a” key to permanently switch to the Pointer tool. With certain windows active, such as the Notation Editor, the Pointer tool is the only available tool.

Making an event selection in the Notation Editor
For information about selecting notes in the Notation Editor, see “Selecting notes for editing” on page 132.

Making an event selection in the Sequence Editor
Use the Pointer tool to make event selections in the Sequence Editor. Be sure that the Cursor Selection Mode (Preferences > Editing > Tools) is set to either Event & Phrase Selections Only or All Selections.

1. Choose the Pointer tool in the Tools palette (or, as a shortcut, double-tap the “a” key).
2. Place the cursor over the item you wish to select so that the cursor turns into an arrow or a pointing finger.
3. Click the event to select it.

SELECTING TRACKS
There are many reasons for selecting tracks. For example, to select data for editing or delete a track, you must first select the track. There are several methods for selecting tracks:

To select a single track, click on its name. It will highlight.

To select several adjacent tracks, press on a track name and drag over the desired names. All tracks dragged over will highlight. You can also click on the first track, the hold down the Shift key and click on a second track to select all tracks between the first and second tracks you clicked on.

To select several non-adjacent tracks, hold down the Command/Ctrl key and click on the names of the tracks you wish to select. They will highlight.

To deselect tracks when more than one are highlighted, hold down the Command/Ctrl key and click on the tracks you wish to deselect. They will unhighlight.
Selecting tracks for editing
The track selection techniques are also used to select data inside the tracks for editing with Performer Lite’s powerful Edit and Region menu commands.

SELECTING A TIME RANGE
The following topics show you the many ways to select a time range. For event selection techniques, see “Selecting events” on page 283.

Time range selections are affected by Performer Lite’s Smart Selection feature, which has an important impact on what happens when you make selections. See “Smart Selection” on page 286 for more information.

Time range selections in the Sequence Editor are affected by the edit grid, if enabled. For details, see “Snap to Grid” on page 331 and the edit grid controls in Figure 17-1 on page 103.

Selecting a time range in the Selection Information window
This method of time range selection allows you to make a selection containing any combination of tracks. It lets you specify the region numerically, which gives you a high degree of precision. It works with all Edit menu and Region menu commands.

1. Open the Selection Info window by clicking the “S” icon above the Sequence Editor.
2. Enter the desired start and end times.
3. Select the track or tracks that contain the region.

You now have a time range selection that includes all of the tracks you highlighted. Notice that the Sequence Editor reflects the selection.

Notation Editor allow event selection only
The Notation Editor does not provide for time range selections because it uses non-linear, engraver spacing to display MIDI events as music notation. Therefore, the Pointer tool can be used to make “marquee” selections over notes and other events (text, etc.) on the page.

Using the Pointer and I-Beam tools to make time range selections in the Sequence Editor
The Pointer and I-Beam tools in the Tools palette (Studio menu) can both be used to make time range selections in graphic editors, as explained in the following sections.

Selecting a time range in the Sequence Editor
Make a time range selection in the Sequence Editor with the I-Beam tool as follows:

<table>
<thead>
<tr>
<th>To select this</th>
<th>Do this with the I-Beam tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within a single track</td>
<td>Drag horizontally in the track lane.</td>
</tr>
<tr>
<td>Across several adjacent tracks</td>
<td>Drag diagonally across the desired tracks.</td>
</tr>
<tr>
<td>Within several non-adjacent tracks</td>
<td>Make a time-range selection in one of the tracks and then shift-click anywhere in the lane of each track you wish to add to the selection. To remove a selected track, Command/Ctrl-click its track name.</td>
</tr>
<tr>
<td>Across all visible tracks</td>
<td>Drag horizontally in the Time Ruler.</td>
</tr>
</tbody>
</table>

Figure 34-1: Using the I-Beam tool to select non-adjacent tracks.

The selection modes (“Choosing a Pointer tool selection mode” on page 282) apply to Pointer tool selections, giving you quick access to a variety of selection techniques via a dynamically changing
cursor. For example, to select a soundbite, click near its (vertical) center with the pointer cursor. To initiate a time range selection in the middle of a soundbite, move the pointer to the bottom edge, where it turns into a cross hair.

**Time Ruler selection techniques**
There are several time-saving techniques for selecting data in the Time Ruler in the Sequence Editor:

- Drag horizontally in the lower half of the Time ruler with the I-Beam cursor. Shift-click to extend the selection. (If Snap to Grid is turned on, dragging will “snap” to the Edit Resolution grid.)

- Click one of the Memory Cycle end points (to select the time range between them).

- Click the Auto Record punch-in or punch-out end time (to select the time range between them).

**Pasting into a time ruler selection**
If there is data in the clipboard, you can use the Paste or Merge commands. Doing so pastes the clipboard contents into the same track (or tracks) it was copied or cut from starting at the beginning of the selected region.

**Initiating time range selections with an insertion point**
If you click the I-Beam tool anywhere in the Sequence Editor, an insertion point appears:

![Figure 34-2: The insertion point in the Sequence Editor.](image)

The insertion point can be placed in the Sequence Editor.

**Modifying a time-range selection using the computer keyboard**
The Commands window (Setup menu) has a large selection of shortcuts for manipulating selections. These commands can be used in the Sequence Editor.
SELECTING

Figure 34-3: selection commands.

Modifying a time-range selection using the mouse
Shift-click (or Shift-drag) near the edge of the selection you want to adjust.

Listening to the current selection
To listen to the currently selected region, press Ctrl-spacebar. Doing so causes the selected region to play in its entirety.

The ‘Remember Times’ command
The Remember Times command (control-R), allows you to save a time range selection, so that you can load it into the Selection bar later on. You can also load remembered times into the Memory Bar and the Auto-Record Bar.

To use Remember Times:

1. Make any selection.

2. Press Control-R.

The start and end time of the current selection is stored by Remember Times.

To load the Remember Times into the Selection Bar, Memory Bar, or Auto-Record Bar, use the “Set to Remembered Times” command under the Selection, Memory, or Auto-Record menus.

SMART SELECTION
Performer Lite has a feature called Smart Selection, which affects Time Range Selections. (For an explanation of what a Time Range selection is, see “Selection basics” on page 281.)

The Smart Selection feature can be turned on or off in the Selections information panel (Figure 38-8 on page 334). Also see “Opening an information panel” on page 330.

What does the Smart Selection feature do when it is enabled? Generally speaking, it makes Time Range selecting and editing operations give you results that are more musical and intuitive. In a way, turning on Smart Selection is like telling Performer Lite, “Do what I mean, not what I say.”

Performer Lite accomplishes this “musical intelligence” in a combination of separate, but related, ways. Below is a summary of Smart Selection features, followed by several sections explaining each feature in further detail.
“Smart boundaries” on time range selections — this means that events that are a few ticks before or after the selection boundaries are either included or excluded, depending on what makes sense musically.

- Measure-relative pasting — allows you to place the playback wiper (or main counter) anywhere in the measure you want to paste into and data will be pasted at its original location within the measure. With Smart Selection turned off, data would be pasted at the exact tick location displayed in Performer Lite’s main counter.

- Controller and pitch bend effects are maintained when cutting and pasting — this means that when controller and pitch bend data is added to or removed from a track via time range selection copying and pasting, Performer Lite maintains the effect of the controllers before and after the selected region by automatically generating and inserting new controller events into the track as needed.

Barline placement is preserved when cutting and pasting in the Conductor track — allows you to freely cut, copy, and paste time range selections in the conductor track, even when it has lots of meter changes in it, without barlines getting out of alignment with existing music in the tracks.

'Smart' Boundaries on Time Range Selections

If Smart Selection is enabled, Performer Lite automatically allows for a bit of musically determined “slop” before and after the boundaries of a time range selection to account for notes and other events that occur a few ticks on either side of the selected region’s boundaries (as shown in Figure 34-4 on page 287). If Smart Selection is turned off, the selection bar start and end times are hard and fast — an event that is even 1 tick outside the region is not included.

If you want precision, turn off Smart Selection. If you want musical results without fussing with details, turn on Smart Selection.

This is a two-measure selection from 23|1|000 to 25|1|000 made with “Snap to Grid” turned on.

This note actually occurs at 24|4|431 — just before 25|1|000. But Smart Selection correctly includes it.

Figure 34-4: An example of how the Smart Selection feature affects time range selections.
Smart Selection must be turned on or off as desired before you make a selection. Turning it on or off does not affect current selections.

The Smart Selection feature affects all of the Time Range selection methods discussed in this chapter; it has no effect on event selections.

**Measure relative pasting**

In general, when you paste, Performer Lite pastes at the location currently displayed in the main counter (and also indicated by the playback wiper in windows that have it) — along with one additional condition: if Performer Lite’s Smart Selection feature is turned off, material is pasted at the exact tick location shown in the counter. If Smart Selection is turned on, material is pasted measure relative, which means that it is placed in the measure at its original location within the measure, so that you don’t have to worry about exact placement of the counter. Just get the counter anywhere into the measure you want and paste.

**Pitch bend and controller effects are preserved**

Whenever you insert a controller or pitch bend event into a track, it affects all notes after it for the rest of the track — or until the next controller in the track. Similarly, when you cut and paste pitch bend or controllers, you are removing from or adding them to the track, which will have an impact on all notes after the cut or paste area.

When Smart Selection is turned on, however, Performer Lite preserves all pitch bend and controller values after the cut or paste region, automatically adding pitch bend or controller events after the edit region as necessary to do so.

The end result is that you will never be surprised: the portion of the track after your edits will always sound the same as it did before your edits.

**Barlines are preserved in the Conductor track**

If Smart Selection is turned off, cutting and pasting time regions in the Conductor Track can get tricky — especially if you have meter changes in the area you are editing. For example, if you cut a meter change, you may find that barlines after the removed meter change are no longer correctly aligned with the notes they are supposed to be aligned with.

Smart Selection takes care of problems like these by making sure that meter changes you introduce by cutting or pasting will preserve subsequent measures and meter changes in the Conductor Track to ensure that nothing gets out of alignment by mistake. If you are cutting and pasting the Conductor Track, be sure to turn on Smart Selection.
CHAPTER 35  MIDI Editing

OVERVIEW
MIDI tracks in a Performer Lite sequence can be viewed and edited in the Sequence Editor. MIDI tracks display notes, velocities, and MIDI continuous controller (CC) data on a scrolling, piano-roll graph that makes melodies, chords, dynamics, and tempo changes easy to recognize.

Before proceeding with this chapter, be sure to review chapter 11, "MIDI Tracks" (page 63).

Figure 35-1: MIDI tracks provide a powerful, “piano-roll” style environment for viewing and editing your music. The tools in the Tool Palette are an important component of working with MIDI tracks.
QUICK REFERENCE

Pitch Ruler: Measures pitch along the vertical axis with a standard keyboard format. Each C-natural indicates the octave. For clarity, shaded lines extend to the right from each black key. With the Pitch Zoom menu, this ruler can zoom to increase or decrease the number of visible octaves.

Edit Layer: Lets you choose the type of data you wish to view and edit in the track lane. Option/Alt click the menu to change all tracks at once.

Pitch Zoom: Zooms the pitch ruler. Zooming out allows you to see more octaves at once. Zooming in allows you to focus on a particular pitch range.

MIDI clip: MIDI notes are encapsulated within clips, which can be moved and manipulated as a single phrase. Drag the clip to move it. Double-click to open the Clip Editor. See “Clip Editor” on page 188. Also see “Working with Clips” on page 315.

MIDI notes on the note grid: If you want, you can unpack MIDI notes from their clip to view and edit them independently. See “Unpacking clips” on page 316.

Track settings: This panel displays basic settings for the MIDI track. See “MIDI track settings” on page 113.

Insert menu: Lets you choose the type of data to be inserted with the Pencil tool.

Controller display menu: This menu lets you choose among three ways to display continuous controller data: Points, Bars and Lines.

MIDI continuous controller (CC) lanes: Displays continuous controller (CC) data, such as pitch bend, key pressure and controllers. Note velocities can also be displayed. Choose the desired data type from the lane’s menu.

Continuous controller ruler: Measures CC data events on one of two different scales, depending on the data type: a controller scale from 0 to 127, whose origin rests at the bottom of the lane or a pitch bend scale from -8192 to 8191, whose origin appears in the middle of the lane.

Continuous controller grid: Displays MIDI CC data on a time vs. value grid. Data appears as lines, points or bars, depending on what you’ve chosen in the controller display menu. An event’s location is measured by the Time Ruler at the top of the window. Its value is determined by the CC data Ruler on the left.

Note Grid: Displays notes as horizontal bars on a time vs. pitch grid. Pitch is determined vertically by the pitch ruler on the left. Location and duration are measured by the Time Ruler above, with duration determined by the length of the bar. If the Shade notes using velocity MIDI Editing preference is checked, a note’s velocity is indicated by its shading. (Darker means a higher velocity; lighter means lower.) Notes can be edited with the mouse one at a time, in a group, by region or together within a clip.

Selected Note: When a note is selected, it highlights. Complete information about the selected note appears in the Information Bar at the top of the window. Drag the end of the note to change its duration.
**TOOL PALETTE QUICK REFERENCE**

The following tools (Figure 26-1 on page 220) can be used for MIDI editing.

**Pointer:** Use the pointer to select data, move data and lengthen or shorten notes.

**I-Beam:** Use the I-Beam tool to make time range selections.

**Pencil:** Use the Pencil tool to insert data or erase existing notes.

**Reshape:** Use the Reshape tool to reshape existing controller data using one of the curves in the curve menu just to the left of the Reshape tool.

**Pencil/Reshape Curve:** Determines the shape of the CC data that you insert with the Pencil or modify with the Reshape tool.

**Reshape mode:** Determines what the Reshape tool does to CC data: set it to a specific value, add to it, subtract from it, scale it or limit it.

**Zoom:** Click or drag to enlarge the note grid. Option/Alt-click to zoom out. Option/Alt-Shift-click to zoom backwards (through previous zoom levels). Option/Alt-Control/Win-Shift click to zoom forwards.

**Mute:** Temporarily mutes or unmutes a note or clip.

**Scissors:** Click on a note or clip to split it. Click on the note grid to split all notes at that location. With the edit grid enabled, drag over a note or clip to split it into subdivisions equal to the current edit grid. Or drag across the note grid to split all notes into subdivisions.

**Velocity:** Click on a note and drag up or down to adjust its velocity. Swipe horizontally in the CC data grid to adjust multiple note velocities in a single gesture.

**Hand:** Allows you to scroll the note grid and CC data grid smoothly and precisely, vertically and horizontally in a single gesture. Simply click anywhere in the grid and drag as desired.

**ACCESSING A MIDI TRACK**

To access a MIDI track in the Sequence Editor, click its name in the track selector (Figure 7-3 on page 40) to highlight it.

**MIDI EDITING BASICS**

In a MIDI track, the piano-roll display for notes and the CC data grid for controllers and pitch bend allows you to manipulate MIDI data using many of the standard conventions established over the years by graphics programs such as clicking, dragging, and shift-dragging. For example, you can insert a note with the pencil tool or drag it with the arrow tool to change its location and lengthen it by dragging its end-point. If the Snap grid is enabled, the note, when moved, will ‘snap’ to a time grid. You can select a group of notes by dragging a selection marquee over them. When you release the mouse, notes inside the box will become selected.

For a summary of Performer Lite’s basic graphic editing techniques, see “Graphic editing techniques” on page 277.

There are, however, many additional powerful features covered in the rest of this chapter.

**SELECTION TECHNIQUES**

Performer Lite offers a variety of ways to select MIDI data. After MIDI is selected, you can apply Performer Lite’s many powerful editing operations. For a complete discussion of selecting techniques, see chapter 34, “Selecting” (page 281). This chapter also explains additional selection techniques specific to MIDI data.
THE EDIT LAYER
In the Sequence Editor, each type of MIDI data resides in its own edit layer (Figure 35-1 on page 289), which you can make active (bring to the front) while other layers remain dimmed or hidden in the background. For further information, see “The Edit Layer” on page 111.

THE CLIPS AND NOTES EDIT LAYERS
In Performer Lite, MIDI notes can be encapsulated together with other notes into singular phrases called clips, which are accessed in the Clips edit layer shown in Figure 35-1 on page 289. Alternately, they can be “unpacked” from their clip to be viewed and edited as separate notes, accessed in the Notes edit layer in Figure 35-1. For details about editing clips, see “Working with Clips” on page 315. The following sections in this chapter cover working with individual notes, either in the Notes edit layer or in the Clip Editor (“The Clip Editor” on page 187).

THE MIDI NOTE GRID
In both the Notes and Clips Edit Layers (Figure 35-1 on page 289), MIDI notes appear on the MIDI Note Grid (also shown in Figure 35-1). The grid functions like a standard graph, where time extends horizontally from left to right and pitch stands vertically. Thus, the higher the pitch of a note is, the higher it will appear on the grid. The later a note occurs, the farther to the right it will appear on the grid.

The time and pitch axes are measured with a Time Ruler at the top of the Sequence Editor and a Pitch Ruler to the left of the grid. The rulers indicate the exact location and pitch of notes. Grid hairlines extend from each ruler to aid you in determining a note’s position.

The vertical scroll bar just to the left of the Pitch Ruler moves the pitch axis up and down over the entire MIDI note range. By scrolling, you can view any time range of the track at any pitch range.

Adjusting the size of the Note Grid
To adjust the size of the Note Grid, resize the track, as explained in “Resizing tracks” on page 114.

Viewing notes that are out of view
The note grid can give you a visual indication of notes that are currently above or below the pitch range currently being viewed in the note grid (Figure 35-2). To enable this feature, enable the Show Notes When Scrolled Off-screen MIDI Editing preference (page 230). You’ll then see small notes at the top and bottom edge of the note grid at any location where notes are currently off-screen.

Displaying notes
Notes are displayed as horizontal bars. The vertical position of the bar indicates pitch. The left end of the bar indicates where the note begins, and the right end indicates where the note releases. The length of the bar represents the note’s duration. All of these characteristics can be determined by the Time Ruler above the grid and the Pitch Ruler to the left.

Note-on and note-off velocities can be displayed in one of three places: the Note velocities edit layer (Figure 17-17 on page 114), the Note velocities lane
(Figure 35-1 on page 289) or directly inside the note itself as a horizontal “velocity thermometer”. See below and “Note velocities” on page 298.

**MIDI note display preferences**
There are several preferences for controlling how MIDI notes are displayed. For example, you can display the MIDI note number and on-velocity bar inside the note, as shown in Figure 35-3. See “MIDI Note Display preferences” on page 230.

![Figure 35-3: MIDI note display preferences.](image)

**THE PITCH RULER**
The Pitch Ruler lies vertically to the left of the Note Grid and measures pitch. It resembles a standard piano keyboard. Because the entire ruler cannot fit in the window at once, a vertical scroll bar is provided to the left of the pitch ruler to allow you to scroll up and down through the entire MIDI pitch range. Octaves are indicated on each C-natural key.

**Zooming the Pitch Ruler**
To zoom the pitch ruler, use the Pitch Zoom control (Figure 35-1 on page 289) as shown below in Figure 35-4. Zooming out reduces the height of each pitch, allowing you to see more octaves at once; zooming in enlarges the height of each pitch, allowing you to focus on a particular pitch range.

Time and Pitch can be zoomed independently. For example, you can zoom out the Time Ruler to see more measures at one time, and zoom in the Pitch Ruler to focus on a specific pitch range.

You can also zoom the note grid with the scroll wheel on your mouse or the track pad on your laptop. See “Zooming with the scroll wheel” on page 275 and “Zooming with a track pad” on page 275.

**INSERTING NOTES**
To insert a note:

1. If desired, set the Snap Grid (see “Snap Information” on page 331).
2. Click the Pencil tool in the Tool palette (Figure 35-1 on page 289), or hold down the “p” key on your computer keyboard.
3. Click in the note grid at the desired location, and then drag vertically to specify the pitch while dragging horizontally to specify the duration.
4. Repeat as desired.
Inserting two or more notes of equal duration
After specifying a duration with the first note inserted, you can insert more notes of the same duration simply by clicking.

Erasing notes with the Pencil
To erase an existing note, click it with the Pencil.

Inserting a note using a MIDI keyboard
To determine the pitch of a note by playing the note on your MIDI keyboard or pad controller when you insert it:

1. Make sure that MIDI Edit is checked in the Sequence Editor menu (Figure 17-4 on page 105).

2. Insert a note with the Pencil tool as described in the previous section—except that you do not need to pay attention to the pitch, just the duration.

3. With the inserted note still selected, press any key on your MIDI keyboard.

The inserted note will move to the pitch that you choose. The inserted note must still be selected from the previous step for this step to work. If you press the wrong note, try again. You can keep changing the note’s pitch in this fashion as long as the note remains selected.

Inserting a chord with a MIDI keyboard
To insert a chord from your MIDI keyboard with the Pencil tool:

1. Make sure that MIDI Edit is checked in the Sequence Editor menu (Figure 17-4 on page 105).

2. Hold down the desired chord on your MIDI keyboard or controller.

3. While holding down the chord on your MIDI keyboard or controller, click in the note grid with the Pencil tool.

The chord is inserted where you click. You can change the notes in the chord while still holding down the mouse.

SELECTING NOTES
This section describes how to select notes individually on the Note Grid. To learn how to select an entire time range, see “Selecting a time range in the Sequence Editor” on page 284.

Selecting a note
To select a note on the Note Grid, click it with the Pointer tool (Figure 35-1 on page 289). The note becomes highlighted to indicate that it is selected.

Selecting a group of notes
To select a group of events, shift click each one or drag over them as follows:

1. Click the Pointer tool in the Tool palette (Figure 35-1 on page 289).

2. Drag over the notes with the cross-hair cursor.

A highlighted box (marquee) indicates the selection area.

All notes within the selection box become selected, even if only a portion of the note lies within the selection box.
Using the Shift key to extend selections
You can add to the current selection by holding down Shift key when selecting individual notes or groups of notes as described in the previous two sections.

Selecting all notes of the same pitch
You can quickly select all notes of the same pitch in the note grid by double-clicking a key on the Pitch Ruler. Shift–double-click multiple keys to select discontiguous pitches. Shift–double-clicking selects or deselects without deselecting other events.

EDITING NOTES
The pitch, duration, and location of notes can be modified on the Note Grid in much the same way as objects in a graphics program. Note velocities can be edited in the CC data Grid.

Changing a note’s pitch or location
To change a note’s pitch or location:

1 Click the Pointer tool in the Tool palette.
2 Drag the note to the desired position.

When you begin dragging, an outline of the note will appear in place of the mouse pointer. Dragging the note vertically changes its pitch. Dragging the note horizontally changes its time location. Duration is not affected when dragging the entire note. When you release the mouse, the note will pop to the new location.

To help position the note in time, hairlines appear in the Time Ruler that show the attack and release of the selected note. In addition, the Pitch Ruler key that corresponds to the note’s current pitch highlights as you move.

If you hold down the Shift key before you drag, the mouse will be constrained either vertically or horizontally, depending on which way you drag first. This allows you to change the note’s pitch or location independently.

Canceling while dragging
If you are in the middle of dragging MIDI notes, and you change your mind, you can press the escape key while dragging to immediately cancel the operation and restore them to their original position, unchanged.

Nudging notes with the Left Arrow and Right Arrow keys
After a note or group of notes have been selected, you can nudge them earlier or later in the track using the Left Arrow and Right Arrow keys; see “Nudge” on page 332.

Changing a note’s duration
To change the duration of a note:

1 Position the cursor near the right-hand tip or the left-hand tip of the note.
2 Drag left or right to shorten or lengthen the note.

Changing a note’s pitch using a MIDI keyboard or controller
To change the pitch of a note with your MIDI keyboard or controller:

1 Make sure that MIDI Edit is checked in the Sequence Editor menu (Figure 17-4 on page 105).
2 Click the note once to select it.

3 Press any note on your MIDI keyboard or controller.

The selected note will change to the pitch you play. This can also be done with more than one note selected. This is a quick way to convert a group of different notes to the same pitch.

**Editing a group of notes**
Editing a group of notes is similar to editing a single note.

1 Select the notes that you wish to edit as described in “Selecting a group of notes” on page 294.

2 Click one of the notes and drag it to a new position. All of the notes will move together. When you begin dragging, an outline of the notes will appear in place of the mouse pointer.

3 To change the duration of all selected notes, drag either edge of one of the selected notes.

**Changing two or more notes to the same pitch**
To convert a group of selected notes to the same pitch:

1 Make sure that MIDI Edit is checked in the Sequence Editor menu (Figure 17-4 on page 105).

2 Select the notes as described in “Selecting a group of notes” on page 294.

3 Press any note on your MIDI keyboard or controller.

The selected notes will change to the pitch you play.

**Temporarily muting notes**
To temporarily mute or unmute a MIDI note, click it with the Mute (X) tool (Figure 26-1 on page 220).

**EDITING MIDI CC DATA**
A MIDI continuous controller (CC) is a MIDI message capable of transmitting a range of values, usually 0-127. The MIDI Spec defines 128 different continuous controllers (identified by their number) per MIDI channel. CC’s are commonly used for things like MIDI volume (#7), pan (#10), data slider position (#6), mod wheel (#1) and other variable parameters. A continuous stream of CC events that gradually change their value over time allows you to capture, create and fine-tune smooth, expressive changes.

Each type of MIDI CC data can be inserted and edited in its respective Edit Layer (Figure 17-16 on page 113 and Figure 17-17 on page 114). Each type of data has its own Edit Layer.

**MIDI CC basics**
The Edit Layer for MIDI CC’s functions like a standard X and Y coordinate graph, in which time lies on the horizontal axis and value along the vertical axis. The higher the value of a CC data event is, the higher it will appear on the grid. The later the event occurs, the farther to the right it will appear on the grid. Grid lines extend from the Time ruler to help in determining an event’s position.

**Adjusting the size of the controller data grid**
To adjust the size of the controller data grid, resize the track, as explained in “Resizing tracks” on page 114.

**Zooming the controller data grid**
See “Zooming” on page 274.
**Displaying MIDI CC data lanes**

To display MIDI CC data in a separate lane below its parent track, choose *Show Lanes* from the Edit Layer menu (Figure 35-1 on page 289), or click the expansion triangle at the bottom of the track settings pane (also shown in Figure 35-1). The separate lanes function in a similar fashion to the MIDI CC data Edit Layer, except that they allow you to view and edit multiple data types simultaneously, rather than one at a time.

For further information about lanes, see “Displaying automation lanes” on page 318.

**THREE CONTROLLER DISPLAY MODES**

The Edit Layer for MIDI CC data provides three modes for displaying continuous controller data: Points, Bars and Lines (Figure 35-1 on page 289).

**Points**

In Points mode (Figure 35-5), a CC data event is displayed on the grid as a colored dot. Pitch bend data, aftertouch, velocities, and controllers each have a unique color. When they are selected, a stalk extends to the origin (zero).

![Figure 35-5: Points mode.](image)

**Bars**

Bars mode (Figure 35-6) is similar to Points mode except that a colored bar extends to the right from each event, allowing you to see the current value for each type of controller, even in portions of the track where no events of that type reside. Bars mode is a more accurate representation of what will happen during playback because the current value of each type of controller is always maintained in the track, regardless of where playback begins.

![Figure 35-6: Bars mode.](image)

Each type of CC data has its own color for the bars. See “Changing MIDI CC colors” on page 298.

**Lines**

In Lines mode (Figure 35-7), Performer Lite employs sophisticated interpolation to draw a line that closely approximates the contour of individual controller events.

![Figure 35-7: Lines mode.](image)

**THE MIDI CC RULER**

All MIDI CC data has a value range from 0 to 127 except pitch bend, which has a value range from -8192 to 8191. Therefore, two scales are provided:

- A controller scale from 0 to 127, whose origin rests at the bottom of the track.
- A pitch bend scale from -8192 to 8191, whose origin appears in the middle of the track.
CHANGING MIDI CC COLORS

To change a MIDI CC color:

1. Select at least one event of the controller data type you wish to change.

2. From the View menu, choose Colors>Set Continuous Data Color.

The standard macOS or Windows color picker appears. Choose the desired color and click OK.

Clearing a continuous data color

To clear a controller data color (so that it matches the track color), select at least one event and then choose Colors>Clear Continuous Data Color from the View menu.

Reverting to a default color

To revert to the default color for a controller data type, select at least one event and then choose Colors>Reset Continuous Data Color to Default from the View menu.

NOTE VELOCITIES

Note-on velocities are displayed and edited in the Note Velocities layer (Figure 35-8). If a note is selected, its velocity icons will be selected with the note.

If notes are inside a clip, switch to the Clip Edit Layer and double-click the clip to open the Clip Editor, where you can edit the velocities there.

Displaying on-velocities in this manner allows you to edit them in the same ways as CC data. For example, you can create a crescendo or decrescendo simply by editing note velocities. See “Editing MIDI CC’s in Points or Bars mode” on page 299 called for more information.

Note velocities cannot be dragged horizontally (in time). To move them, drag the note itself (or its duration).
EDITING MIDI CC’S IN POINTS OR BARS MODE

The procedures for inserting, selecting and editing MIDI CC’s are the same for both Points and Bars mode. Lines mode handles these operations somewhat differently, as explained later in “Editing CC data in Lines mode” on page 301.

Inserting CC data in Points or Bars mode

To insert CC data in Points or Bars mode:

1. Choose the Pencil tool in the Tool palette (Figure 26-1 on page 220), or hold down the “p” key.

2. If you will be inserting a stream of CC data events, choose the desired shape of the curve from the Pencil/Reshape Curve menu in the Tool palette (Figure 26-1 on page 220).

3. If you would like the curve shape you have selected to snap to beats or a similar metric grid, set the Edit Resolution and turn on the Edit Grid (see “Snap Information” on page 331).

Doing so constrains periodic waveshapes to the resolution of the edit grid. For example, if the Edit Grid is set to a quarter note, and you insert a sine wave, the sine wave will cycle once each quarter note.

4. Choose the desired data type from the Insert menu shown below in Figure 35-9.

5. Insert data as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To insert a single event</td>
<td>Click on the grid with the Pencil.</td>
</tr>
<tr>
<td>To insert a stream of events</td>
<td>Drag the Pencil. A stream of data is inserted according to the curve shape that you chose in the Tool palette. You can conform to a beat grid with Edit Resolution as explained in “Constraining a periodic waveform to beats” on page 299, and you can use the waveform modifier keys described in “Using modifier keys to control period, phase, and other waveform parameters” on page 300.</td>
</tr>
</tbody>
</table>

Constraining a periodic waveform to beats

To insert a CC data periodic waveform that conforms to a rhythmic grid (quarter notes, eighth notes, etc.), set the edit grid to the duration that equals one complete period of the waveform. This forces the waveform to conform to the grid duration you specify.
Using modifier keys to control period, phase, and other waveform parameters

When inserting (or reshaping) CC data using a waveform shape, you can hold down modifier keys while dragging to change waveform parameters as follows:

<table>
<thead>
<tr>
<th>To control this:</th>
<th>Hold down this key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggles grid snapping (on/off)</td>
<td>Command/Ctrl key</td>
</tr>
<tr>
<td>Phase</td>
<td>Option/Alt key</td>
</tr>
<tr>
<td>Duty cycle</td>
<td>Control/Win key</td>
</tr>
<tr>
<td>• Triangle wave skew</td>
<td></td>
</tr>
<tr>
<td>• square wave pulse width</td>
<td></td>
</tr>
<tr>
<td>• sine wave pulse width</td>
<td></td>
</tr>
<tr>
<td>• Periodic frequency</td>
<td>Shift key</td>
</tr>
<tr>
<td>• Random curve density</td>
<td></td>
</tr>
</tbody>
</table>

To re-use the last settings for sine, Escape key triangle, square, random steps or random ramps

Selecting CC data in Points or Bars mode

To select CC data in Points or Bars mode:

1. Click the Pointer tool in the Tool palette (Studio menu).

2. Make a selection as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select a single event</td>
<td>Click it with the pointer cursor. A stalk is</td>
</tr>
<tr>
<td></td>
<td>drawn from the icon to the origin of the CC</td>
</tr>
<tr>
<td></td>
<td>data graph.</td>
</tr>
<tr>
<td>To select several events</td>
<td>Drag over the events in the grid with the</td>
</tr>
<tr>
<td></td>
<td>cross-hair cursor.</td>
</tr>
<tr>
<td>To select a CC data curve</td>
<td>Drag over the curve with the cross-hair</td>
</tr>
<tr>
<td></td>
<td>cursor.</td>
</tr>
<tr>
<td>To select all events of one type</td>
<td>Double-click one event.</td>
</tr>
<tr>
<td>To add to the current selection</td>
<td>Hold down the Shift key while using any of</td>
</tr>
<tr>
<td></td>
<td>the selection techniques above.</td>
</tr>
<tr>
<td>To deselect events</td>
<td>Hold down the Shift key while using any of</td>
</tr>
<tr>
<td></td>
<td>the above techniques on selected data.</td>
</tr>
<tr>
<td>To deselect all data</td>
<td>Choose Deselect All from the Edit menu or</td>
</tr>
<tr>
<td></td>
<td>press its keyboard shortcut. Or click once in</td>
</tr>
<tr>
<td></td>
<td>any empty area in the grid.</td>
</tr>
</tbody>
</table>

Dragging events in Points or Bars mode

To change the value or location of CC data events in Points or Bars mode:

1. If desired, set the Edit Resolution (see “Snap Information” on page 331).

2. Choose the desired data type from the track’s Edit Layer menu (Figure 17-16 on page 113).

3. Click the Pointer tool in the Tool palette.

4. If you are modifying a single event, drag its icon to a different position or value.

Hold down the Shift key to constrain vertically or horizontally. For exact positioning, refer to the Cursor Information box and the rulers.

5. If you are modifying several events, select them first as described in the previous section, and then drag one of the selected events.

Scaling by dragging

If you hold down the Control/Win keys when dragging selected continuous controllers, they are scaled in value (vertically) and time (horizontally).

Editing the value of an event using a MIDI keyboard (or controller) in Points or Bars mode

To change the value of an event with your MIDI keyboard or controller:

1. Make sure that “MIDI Edit” is checked under the Sequence Editor mini-menu.

2. Click the event with the Pointer tool to select it.

3. Transmit a corresponding event from your MIDI keyboard (or controller).

For example, if you have selected pitch bend event, move the pitch bend wheel on your controller and the event will change to the new value you set with the wheel.
When you have entered the value you wish, press the Return key or the mouse to confirm the new value.

**Reshaping data curves**
You can modify CC data with the Reshape tool. For example, you can scale, compress or limit it.

For complete details on the Reshape tool, see "Reshape tool" on page 223.

**EDITING CC DATA IN LINES MODE**
Lines Mode attempts to represent a stream of CC data events as a straight line between two points, similar to the breakpoint automation display in audio tracks. This allows you to view and modify continuous MIDI data in a similar fashion as audio automation data. However, MIDI CC data is fundamentally different than audio automation data: MIDI data consists of a stream of individual events, as shown below in Figure 35-10, whereas audio automation data consists of two points that prescribe a ramp. It is very important to keep this distinction in mind when working in Lines Mode because, as explained in the next few sections, MIDI Lines Mode does not always act the same way as audio automation.

![Figure 35-10: Volume controller data displayed in Lines Mode and Bars Mode. Notice the stair-steps in Bars mode—a more accurate representation of the MIDI events that underlie the points and lines in Lines Mode. Lines Mode can be convenient for inserting and editing CC data, but Bars mode tells you 'what's really going on' with the individual events.](image)

**MIDI data versus audio ramps**
The lines and points in Lines Mode look very similar to ramp automation in audio tracks. Editing MIDI CC data in Lines Mode is very similar to audio track break-point automation. However, in the CC data grid, these lines are based on individual MIDI events, as you can see above in Figure 35-10. If you switch to Points or Bars mode, you can see the individual events at any time.

Because MIDI CC data is really a stream of individual events, as opposed to audio automation ramps, which are straight lines calculated with single sample-accuracy between control points, you may sometimes encounter stair-steps and other situations that do not occur in audio tracks. Again, you can always switch to Bars mode for a more clear idea of what’s going on with the events that lie beneath the lines.

**Points, stair-steps and ramps**
Lines Mode employs three elements to represent CC data streams: ramps, points and stair-steps.

**Ramps**
Ramps are straight lines drawn between two points. Lines Mode draws a ramp when CC data events are close enough and straight enough to be drawn as a line.

**Points**
A point consists of a CC data event that falls between two ramps that have different slopes. The point consists of an actual MIDI data event; by moving it such that it falls more in line with events around it, you can actually make it ‘disappear’ when it crosses the threshold for being interpreted as part of the ramp.
Figure 35-11: Ramps and points in Lines Mode. Notice that the selected point is actually a selected event (shown in Points mode).

**Steps**

Lines Mode displays a step (as shown below in Figure 35-12) when consecutive events are too far apart to be interpreted as a line. As you can see, a step gives you an accurate representation of the underlying data and the effect it will have when it is played back.

Figure 35-12: A step in Lines Mode.

### Working with Lines Mode

Use the following techniques in Lines Mode:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To insert a point</td>
<td>Click with the Pencil tool.</td>
</tr>
<tr>
<td>To add a point to an existing line</td>
<td>Click with the Pencil tool on the line and drag a little bit. If you don’t drag, the newly inserted event will be interpreted as part of the line, and it won’t remain an independent point.</td>
</tr>
<tr>
<td>To move a point</td>
<td>Drag it with the Pointer tool.</td>
</tr>
<tr>
<td>To delete a point</td>
<td>Remember, underlying a point (and the lines extending from it), there is an entire stream of events. Deleting one point only deletes one event, but there are many more right next to it, so it may seem like it is not being deleted properly. Instead, try dragging an adjacent point past the one you want to delete. Or make a time range selection with the Pointer tool—and perhaps even switch to Bars Mode or Points Mode—to delete the stream of events that prescribes the point.</td>
</tr>
<tr>
<td>To remove a step</td>
<td>Grab the corner of the step (or anywhere on the horizontal part of it) with the Pointer tool and drag as desired.</td>
</tr>
<tr>
<td>To insert a waveform or reshape an existing line with a waveform</td>
<td>Choose the Pencil tool, choose a reshape curve, and then drag horizontally in the grid. You can conform to a beat grid with Edit Resolution as explained in “Constraining a periodic waveform to beats” on page 299, and you can use the waveform modifier keys described in “Using modifier keys to control period, phase, and other waveform parameters” on page 300.</td>
</tr>
</tbody>
</table>

### Region operations in Lines Mode

Region operations, such as cut, copy, paste and change CC data do not always have the same affect on MIDI data in Lines Mode and audio automation ramps. In the example below (Figure 35-13), both MIDI data and audio data display a single point within the time range selection. However, as you can see in Bars Mode (bottom row), there are actually many selected MIDI events, not just one. If CC data scaling is applied (second column), the single audio control point scales by itself, whereas all of the selected MIDI events scale together, producing a different
final result. Note: to get the same result with MIDI as audio in this example, you could simply drag the control point in the MIDI track downwards.

Figure 35-13: Edit operations like Erase have a different effect on MIDI data and audio automation data.

**DISCRETE MIDI EVENTS**

Discrete MIDI events such as patch changes, mode changes, switch controllers like #64 (sustain pedal), tune requests, song changes, mute automation events and system exclusive events appear at the bottom of the MIDI track lane.

![Figure 35-14: An example of a discrete MIDI event: a MIDI patch change. These are MIDI events that aren't notes and are not continuous.](image)

**Working with discrete MIDI events**

Discrete MIDI events do not have durations. Each event is therefore displayed as a single item. Patch changes, system exclusive events, Mute Automation events, and controllers are displayed with a unique icon; mode changes are displayed as text, such as “Poly” or “Omni on”. An event may be edited in the Information Bar as usual.

**Inserting a discrete MIDI event**

Discrete MIDI events that are not CC data, such as patch changes, mode changes, switch controllers like #64 (sustain pedal), and system exclusive events, can be inserted as follows:

1. If desired, set the Edit Resolution and turn on the Edit Grid (see “Snap to Grid” on page 331).
2. Choose the desired data type from the Insert menu (Figure 35-9 on page 299).
3. Click once at the desired time location in the track lane.

The event will appear where you clicked.

**Editing a discrete MIDI event**

To view and edit discrete MIDI events, choose their data type from the track’s Edit Layer menu (Figure 17-16 on page 113).

To edit a discrete MIDI event’s parameters, click it to select it and then edit its parameters in the Information Bar.

Drag a discrete MIDI event to change its location.
CHAPTER 36  Audio Editing

OVERVIEW
Audio tracks in a Performer Lite sequence can be viewed and edited in the Sequence Editor. Audio tracks contain audio data in the form of soundbites or audio clips. They can also contain automation data for volume, pan, plug-in parameters and even audio pitch shifting and beat stretching.

Before proceeding with this chapter, be sure to review chapter 10, “Audio Tracks” (page 57).

Overview ............................................. 304
Quick Reference ................................. 305
Tool palette quick reference ................. 305

Figure 36-1: Audio tracks provide a powerful environment for viewing and editing audio. The tools in the Tool Palette are an important component of working with MIDI tracks.
QUICK REFERENCE


Stereo waveform: Soundbites can be mono (one channel) or stereo (two channels, left and right). See “Mono and stereo tracks” on page 57.

Soundbite volume: Each soundbite has its own independent bite gain adjustment. See “Bite volume and gain” on page 385. Also see “Soundbite volume automation” on page 321.

Track settings: This panel displays basic settings for the audio track. See “Audio track settings” on page 110.

Edit Layer: Lets you choose the type of data you wish to view and edit in the track lane. Option/Alt click the menu to change all tracks at once.

Insert menu: Lets you choose the type of data to be inserted with the Pencil tool.

Automation data lanes: Displays automation data, such as volume, pan, pitch and plug-in parameter automation. Choose the desired automation type from the lane’s menu.

Volume and pan automation: See chapter 54, “Mix Automation” (page 462).

TOOL PALETTE QUICK REFERENCE

The following tools (Figure 26-1 on page 220) can be used for audio editing.

Pointer: Use the pointer to select audio, move soundbites and stretch them. The pointer also selects and moves automation points.

I-Beam: Use the I-Beam tool to make time range selections.

Pencil: Use the Pencil tool to insert automation in automation lanes (or edit layers).

Reshape: Use the Reshape tool to reshape existing automation data using one of the curves in the curve menu just to the left of the Reshape tool.

Pencil/Reshape Curve: Determines the shape of the automation data that you insert with the Pencil or modify with the Reshape tool.

Reshape mode: Determines what the Reshape tool does to automation data: set it to a specific value, add to it, subtract from it, scale it or limit it.

Zoom: Click or drag to zoom in on a portion of the audio track. Option/Alt-click to zoom out. Option/Alt-Shift-click to zoom backwards (through previous zoom levels). Option/Alt-Control/Win-Shift click to zoom forwards.

Mute: Temporarily mutes or unmutes a soundbite or clip.

Scissors: Click on a soundbite or clip to split it. With the edit grid enabled, drag over a soundbite or clip to split it into subdivisions equal to the current edit grid.

Trim: see “Trim tool” on page 225.

Roll: see “Roll tool” on page 226.

Slip: see “Slip tool” on page 226.

Slide: see “Slide tool” on page 226.

Hand: Allows you to scroll the audio track smoothly and precisely, vertically and horizontally in a single gesture. Simply click anywhere in the track and drag as desired.
ACCESSING AN AUDIO TRACK
To access an audio track in the Sequence Editor, click its name in the track selector (Figure 7-3 on page 40) to highlight it.

THE EDIT LAYER
In the Sequence Editor, each type of data resides in its own edit layer (Figure 17-14 on page 111), which you can make active (bring to the front) while other layers remain dimmed or hidden in the background. For further information, see “The Edit Layer” on page 111.

AUDIO EDITING BASICS
This section explains several important concepts to keep in mind when you work with audio tracks in the Sequence Editor.

Working with waveforms
The Sequence Editor displays soundbites — and the audio data within them — as a waveform in a standard time-versus-amplitude display as shown in Figure 36-2. The waveform shown inside soundbites is a representation of the sound in graphical form. Time is expressed on the horizontal axis. Amplitude (loudness) is expressed on the vertical axis, and the waveform oscillates up and down over a center axis which represents zero, or no sound at all. The louder the sound is at a certain point, the greater the deviation is from zero. Silence is represented by a straight line. The point at which the waveform crosses zero is called a zero-crossing.

A soundbite is represented as a “block” of waveform data with adjustable boundaries. The waveform inside it represents the actual audio data in the audio file on disk. This graphic display allows you to make edit decisions based on what you see, as well as what you hear.

Stereo versus mono waveforms
In stereo tracks, paired left/right soundbites appear in the Sequence Editor as two smaller waveforms joined together as shown in Figure 36-4. A stereo soundbite shows both
channels connected together as one unit, so that they can always be edited simultaneously, with sample-accurate phase lock between the channels.

Figure 36-4: A stereo soundbite is represented as two audio channels joined together, which always remain phase-locked.

**Soundbites are clones**
An important thing to realize about soundbites in the Sequence Editor is that they are “clones” of their original soundbite in the Soundbites list. For further explanation, see “Soundbites in a track are ‘clones’ of the original” on page 278.

**Graphic editing is non-destructive**
All of the editing procedures described in this chapter are non-destructive. For an explanation of non-destructive editing, see “Non-destructive, destructive and constructive audio editing” on page 278.

**Soundbites that cannot play**
Soundbites that cannot be played (because they don’t match the project’s global sample rate, for example) are displayed in the Sequence Editor with a red outline and a grayed waveform, in addition to a red ‘X’ in their icon in the Soundbite list, to alert you to the fact that they cannot currently play back.

**Viewing Sequence Editor soundbites in the Soundbites list**
If you are looking at a soundbite in the Sequence Editor, and you would like to find it in the Soundbite list, use the Command in the Commands window called *Select this soundbite in the Soundbite list*. Use the search feature in the Commands window to find the command and then assign it to any desired keyboard shortcut.

**Reveal In Finder/Show in Explorer command**
The *Reveal In Finder/Show in Explorer* command shows you the location on your computer desktop of the parent audio file for the currently selected soundbite. By default, the keyboard shortcut for this command is Option/Alt-R.

**INSERTING SOUNDBITES**
The following sections explain several different ways to insert soundbites into the Sequence Editor. The soundbite must be present in the Soundbites list before doing so. If it isn’t, you must import it beforehand. See “Importing and exporting audio” on page 204.

**Dragging and dropping audio into the Sequence Editor**
You can also place audio in the Sequence Editor by dragging soundbites from the Soundbites list or the computer desktop. In the Soundbites list, just grab the move handle of the soundbite and drop it on top of the open Sequence Editor. The soundbite is placed at the exact location displayed in the cursor information box at the moment you drop it. Control/Win-drag the soundbite to make it “snap” to the end of the previous one (or the beginning of the track if it is empty). In the Mac OS Finder or Windows Explorer, just drag the audio file icon from the desktop or any window into the Sequence Editor. The soundbite’s number of channels (mono or stereo) must match the number of channels for the track you wish to insert it into.
Figure 36-5: Dragging and dropping Soundbites into the Sequence Editor from the Soundbites list: grab the move handle and drop it on top of the Sequence Editor. Use the Cursor Information for precise placement. Control/Win-drag the soundbite to make it “snap” to the end of the previous one. You can also drag and drop audio into the Sequence Editor from the computer desktop.

**Using the Insert Audio command**

To insert a soundbite in the Sequence Editor with the Insert Audio command:

1. Press Shift-F1.

   This is the default key binding for the Insert Audio command, but this may be reassigned in the Commands window.

2. Select the desired soundbite from the list that appears. The soundbite’s number of channels (mono or stereo) must match the number of channels for the track you wish to insert it into.

Figure 36-6: Click the soundbite name and then click OK, or—as a shortcut—simply double-click the soundbite. You can also select the desired soundbite by typing the first letter of its name. When the list disappears, the cursor turns into a cross-hair.

Click the cross-hair cursor in the Sequence Editor at the location where you want to place the soundbite, using the cursor information (see page 333) to help determine the location.

**Building a playlist**

You can quickly build a playlist in the Sequence Editor by Control/Win-dragging soundbites into it from the Soundbites list. Holding down the Control/Win key when you first grab the soundbite causes it to “snap” to the end of the previous soundbite when you drop it.

**Changing a soundbite name**

To change a soundbite name in the Sequence Editor, Option/Alt-click its name.

**Replacing a soundbite with another**

To replace a soundbite with a another one from the Soundbites list, click it once to select it and click its name in the Event Information window as shown in Figure 36-1 on page 304.

**MOVING SOUNDBITES**

Soundbites can be moved earlier or later in time by simply dragging them left or right, respectively. If the Edit Resolution check box is off, they move freely at the highest resolution allowed by the current zoom level. An information tab appears while dragging (Figure 36-7) to provide metrics regarding the drag operation (new position, offset, start time, end time, destination track, etc.)

Figure 36-7: Dragging a soundbite.
Moving soundbites vertically from one track to another
You can freely drag soundbites from one track to another simply by dragging them vertically — as long as the tracks involved are currently being displayed, of course.

Constraining dragging operations
You can vertically or horizontally constrain dragging operations in the Sequence Editor by holding down the Shift key while dragging. This applies to soundbites, automation data, MIDI data and other events.

Moving multiple soundbites at the same time
You can move several soundbites together by selecting them and dragging them together as a unit. Shift-click to select multiple soundbites. Also see “Selection techniques” on page 315.

Snapping to the edit grid
When the Snap to Grid check box is checked in the Snap Information window, soundbites “snap” to the Edit Resolution grid when you drag them. Snapping can be absolute or relative. See “Snap to Grid” on page 331 and the edit grid controls in Figure 36-1 on page 304.

Canceling while dragging
If you are in the middle of dragging, and you change your mind, you can press the escape key while dragging to immediately cancel the operation and restore the data to its original position, unchanged.

Nudging soundbites with the arrow keys
Select one or more soundbites in the Sequence Editor and type the left or right arrow keys on your computer keyboard to nudge the data forward or backward in time. Use the Nudge Amount in the Snap Information window (or Information Bar) to control the resolution. See “Nudge” on page 332.

“Throwing” soundbites to the next or previous soundbite
There is a shortcut for making a soundbite “snap” to the next or previous soundbite in the window: click the soundbite first to select it, and then Control/Win-drag the soundbite in the direction you want it to snap. For example, if you want a soundbite to be placed end-to-end with the next soundbite to the right as shown below, select it and then control-drag it to the right. You only have to drag a short distance—enough to determine the direction.

Option/Alt-dragging to make a copy
To quickly make a copy of a soundbite while dragging, Option/Alt-drag it. The new soundbite is an exact clone of the original; in other words, they both refer to the same original soundbite listed in the Soundbites list. For example, if you rename either copy, they will both change to the new name.
Option/Alt-Control/Win-dragging to copy soundbites & place them end to end
By holding down both the Option/Alt key and the Control/Win key when dragging soundbites, you can copy and place soundbites end-to-end at the same time. This is a great shortcut for building playlists made up of many repeating soundbites, as shown in the example below.

Creating a stutter effect
You can easily make a stutter effect by Option/Alt-dragging a soundbite several times and overlapping the copies. For rhythmic precision, it is easiest to do so with edit resolution turned on and set to a fairly small increment, such as 16th notes.

MUTING AND UNMUTING SOUNDBITES
There are two ways to temporarily mute a soundbite:

- Insert mute automation
- Use the Mute tool

Inserting mute automation
To mute a soundbite using mute automation, select it and choose Mute Region from the Region menu. This inserts mute automation data at the beginning and end of the soundbite. To unmute, select it again and choose Clear Mute Automation from the Region menu.

Using the Mute tool
To mute the soundbite with the Mute tool, click it with the Mute tool. To unmute, click it again with the Mute tool. The Mute attribute for a soundbite can also be toggled in the Event Info panel. See “Event Information” on page 333.
**BITE GAIN**

When audio tracks are resized vertically, and expanded far enough, each soundbite displays its *Bite Gain* setting and fader in the bottom left corner as shown in Figure 36-14. Bite Gain non-destructively raises or attenuates the overall volume of the soundbite. The range is from -140 to +80 dB. Click the fader icon to adjust the Bite Gain.

![Figure 36-14: Bite Gain setting and fader.](image)

**OVERLAPPING AND LAYERING SOUNDBITES**

Performer Lite allows two or more soundbites—or portions thereof—to occupy the same location in an audio track. Each soundbite is handled in a separate layer that can be manipulated independently of other soundbites. However, only the visible portion of each soundbite plays back. A simple, intuitive rule of thumb is: *what you see is what you hear*. In other words, when one soundbite covers up another, it also takes over playback in the track.

Use the Layering commands in the Audio menu (Move Forward/Backward and Move to Front/Back) to control how overlapping soundbites are layered as you edit them.
TRIMMING (EDGE EDITING) SOUNDBITES

As explained in Figure 68-4 on page 573, a soundbite represents a portion of audio from its parent audio file stored on disk. For example, a soundbite can be as short as a fraction of a second or as long as many hours. A soundbite can represent a portion of the parent audio file, or it can represent the entire file.

The Pointer, Trim, Roll, Slip and Slide tools

The Pointer, Trim, Roll, Slip and Slide tools (shown below in Figure 36-15) can be used to edit the edges of a soundbite. The current edit resolution applies.

Pointer: The Pointer tool allows you to trim the left or right edge of a soundbite. The arrow cursor changes to the trim cursor (Figure 36-15) when you move it near the edge of a soundbite. When trimming, you “uncover” or “cover up” the audio in the audio file as illustrated in Figure 36-15. If the edge stops when you drag it, preventing you from going any further, then you have reached the end of the audio file.

Trim: The Trim tool allows you to click anywhere in a soundbite to move the right edge to the location where you clicked. Hold down the Option/Alt key to move the left edge to where you click.

Roll: The Roll tool allows you to edge edit the beginning of one soundbite and the end of another where they abut each other. They must be touching one another.

Slip: The Slip tool allows you to edge edit the start and end of a soundbite while the soundbite remains at the same position in the track. The soundbite’s length does not change.

![Figure 36-15: Edge editing a soundbite by dragging its boundaries.](image-url)
Slide: The Slide tool allows you to move a soundbite in the sequence while leaving the soundbite’s audio at the same playback time. This is the same as trimming both ends by the same amount forwards or backwards.

**Affecting all copies of a soundbite versus one copy**

The Edge Edit Copy command in the Sequence Editor menu allows you to choose whether you want to modify the original soundbite you are dragging or preserve the original by making a copy of it when you drag.

**Edge editing all copies**

When Edge Edit Copy is unchecked, dragging a soundbite edge affects the original soundbite, as well as every other instance of it. For example, if you edge edit a soundbite called Drum Fill that has been placed many times throughout a percussion track, all copies of it in the track will change.

**Edge editing one copy**

When Edge Edit Copy is checked, it causes a soundbite to be copied when you drag one of its edges, which preserves all original copies of the soundbite. The result is a new soundbite that is identical to the original except for the new boundary and a slightly different name. You probably won’t even notice that a copy is being made. Instead, it will seem like you just moved the edge of the soundbite. The only noticeable change is a number appended to the soundbite (or, if it already has a number, it will increment by 1). The new soundbite is also added to the list in the Soundbites list.

**Option/Alt-dragging to override Edge Edit Copy**

Option/Alt-dragging a soundbite edge temporarily overrides the current setting of the Edge Edit Copy command. This allows you to set it the way you prefer most of the time, and the Option/Alt-drag to temporarily override it when necessary. For example, if you may want to edit all instances of a soundbite most of the time, uncheck the Edge Edit Copy command so you can simply drag soundbite boundaries, and use the Option/Alt key to override this setting when needed.

**Edge editing multiple soundbites**

To trim (edge edit) multiple soundbites together at the same time, select them, and then trim either the left edge or right edge of any selected soundbite.

If you would like all edges to snap to the same location, hold down the Control/Win key while dragging an edge as shown below:
Figure 36-18: To make the edges of multiple soundbites snap to the same location, hold down the Control/Win key while trimming.

**Edge editing when soundbites overlap**
When soundbites overlap one another, you may not have direct access to the soundbite edge you wish to edit because it may be covered up by another soundbite, and you may not want to change how they overlap with the layering command in the Audio menu. In this situation, you can edit the hidden edge by Shift-clicking the opposite, visible edge. Doing so gives you control over the edge you didn’t shift-click.

**Using the edit grid when edge editing**
The edit grid does not affect edge editing. However, if you would like your edge edit to snap to the edit grid, hold down the Command/Ctrl key while clicking on the soundbite edge to move it.

**Using Slip, Slide and Roll on multiple soundbites**
You can use the Slip, Slide and Roll tools (as described earlier on page 312) on multiple selected soundbites.

**GRAPHIC TIME STRETCHING OF AUDIO**
You can time-stretch audio graphically by grabbing the edge of a soundbite with the hand tool and dragging it to the desired length. To get the hand tool, position the cursor over the edge of the soundbite, just below the crossfade handle as shown in Figure 36-20.

**GRAPHIC EDITING TECHNIQUES**
All of Performer Lite’s powerful editing features are available in the Sequence Editor. Most editing can be done with the mouse using familiar actions like clicking, dragging, and Shift-dragging. Such actions can shift data, change note pitch and duration, reshape mix automation data curves, and more. For a summary of Performer Lite’s basic graphic editing techniques, see “Graphic editing techniques” on page 277.
SELECTION TECHNIQUES
Performer Lite offers a variety of ways to select audio and MIDI data in the Sequence Editor. After audio is selected, you can apply one of Performer Lite’s many powerful editing operations. For a complete discussion of selecting techniques in the Sequence Editor, see chapter 34, “Selecting” (page 281).

WORKING WITH CLIPS
In the Sequence Editor, clips are viewed and edited in a fashion similar to soundbites, as explained earlier in this chapter. The following sections cover details that are specific to clips.

Clip basics
A clip is a container for a single track’s worth of data. Think of it as a small slice of a track that you can manipulate as a single object. (See “What is a clip?” on page 182.) Clips also have object properties, such as a start time, duration and looping (on or off). (See “Clip settings” on page 187.) Clips can be identified by their rounded corners.

The Clip edit layer
Each audio and MIDI track provides an edit layer for Clips (Figure 36-21 on page 315) where clips can be managed and edited. Audio and MIDI tracks also have edit layers for soundbites and MIDI notes, respectively, allowing you to work seamlessly with clips and other data in the same track. Figure 36-21 shows an example of MIDI notes side by side with a MIDI clip in the same track. The same goes for soundbites, which can coexist side by side with audio clips in an audio track.

Click a clip in an audio or MIDI track to quickly switch to the Clips layer. Similarly, click a soundbite or MIDI note to quickly switch to the soundbite or notes layer.

Figure 36-21: Clips in the Sequence Editor.
Creating a clip
Here are some ways to create a clip in a track:

■ Use the Pack Into Clips command (see below)
■ Drag and drop a clip from the Clips window into a track
■ Record clips as you trigger them from the Clips window (see “Clip Record mode” on page 188)

Recording MIDI into track clips
When you record into a MIDI track, Performer packs the data into a clip for you.

Packing track data into clips
To make a clip out of existing data in a track:

1. Make a selection (either an object selection or time-range selection) in one or more tracks.
2. Choose Region menu > Pack Into Clips.

Unpacking clips
When unpacking data from a clip, the data remains behind, at its original location in the track, and the clip is removed:

1. Select one or more clips.

2. Choose Region menu > Unpack Clips.

Clip layering
Clips can overlap one another, just like soundbites. The front-most clip is what you hear. Use the layering commands (Edit menu) to manage layering. See “Overlapping and layering soundbites” on page 311. However, since clips can contain multiple types of data (unlike soundbites), layering them has further subtleties.

When the counter reaches a clip event during playback, that clip becomes the sole source of musical events for all the event types it contains. If there are any of the same event types in the track itself or in other clips layered behind the front-most clip, they are suppressed for the duration of that clip event. Types not contained in the front-most clip event are not suppressed by that clip, and will come from whichever source is closest to the front, either another clip event or the track itself. Track data not contained in clips is always considered to be in the back-most layer.

The same concept applies when launching clips in the Clips Window, except only one clip can play per track at any given time, so there are only two possible layers to consider: the track layer and the clip layer. For clip events that are stored directly in tracks (and can be viewed in the Tracks Overview and Sequence Editor) there are as many layers as there are clip events in the track (just like soundbites).

As an example, automation in the track plays while looping a clip that contains only soundbites. However, you also have the flexibility to explicitly override parts of the mix automation, if desired. For example, you might create a one-bar clip that automates the Multimode Filter’s center frequency parameter. Since this clip only contains automation data for a single plug-in parameter, it will not suppress soundbites in the underlying track data. It can then be launched and looped in
the Clips window at will, repeatedly applying the filter sweep to whatever soundbites are playing back in the track.

**Edge-editing a clip**

When you edge-edit a clip, you are changing its start time or end time (“Clip settings” on page 187). To edge edit, position the cursor over the left or right edge of the clip and drag it. If the clip’s loop setting is enabled, position the cursor over the bottom half of edge, as shown in Figure 36-23, to get the edge-edit cursor. The top half produces the loop cursor.

![Figure 36-23: Edge-editing a clip.](image)

**Looping a clip**

To loop a clip, double-click it to open the Clip Editor, and then enable its Loop setting in the settings panel. Once you’ve done so, position the cursor over the top half of the left or right edge of the clip (as shown in Figure 36-24) and drag it. In this example, looping has been extended both before and after the original clip. Each full iteration of the loop is indicated by boundary markers, as shown.

![Figure 36-24: Looping a clip.](image)

**Muting/unmuting clips**

To mute or unmute a clip, click it with the Mute tool (Figure 26-1 on page 220).

**Other clip editing techniques**

Clips can be edited with many of the same techniques as soundbites. See:

- Moving soundbites .................................. 308
- Muting and unmuting soundbites ............... 310
- Overlapping and layering soundbites .......... 311
- The Pointer, Trim, Roll, Slip and Slide tools .... 312
- Edge editing multiple soundbites ............... 313
- Edge editing when soundbites overlap ......... 314
- Using the edit grid when edge editing .......... 314

**Opening the Clip Editor**

To open the Clip Editor for a clip (as shown in Figure 36-21 on page 315), double-click the clip. When a clip is being displayed in the Clip Editor, it is highlighted in its track (as shown in Figure 36-21), so that you can clearly see which clip you are editing.

**WORKING WITH BREAKPOINT MIX AUTOMATION**

The Sequence Editor lets you display, insert, and edit volume, pan, plug-in parameters, send levels, track mutes and other mix automation data in the form of breakpoints (dots) on a continuous line. In audio tracks, mix automation data is stored in the form of sample-accurate control points that
generate sample-accurate ramps during playback. In MIDI tracks, mix automation data is stored in the form of MIDI continuous controller data. For seamless, side-by-side operation of MIDI and audio tracks, the Sequence Editor displays both forms of automation with the same style of lines and points. The following sections discuss the specific techniques of working with breakpoint-style automation lines and points. Unless otherwise noted, the techniques are the same for both MIDI and audio tracks.

**Choosing the active data layer**
To view, insert or edit mix automation data in a track, you must first choose it as the current Edit Layer as explained in “The Edit Layer” on page 306. Alternately, you can choose to show a separate automation lane as described below.

**Displaying automation lanes**
To display automation data in a separate lane below its parent track, choose *Show Lanes* from the Edit Layer menu (Figure 17-15 on page 112), or click the expansion triangle at the bottom of the track settings pane. Click the plus (+) and minus (−) buttons, as shown below in Figure 36-25, to add and remove additional lanes. Use the lane menu to choose the data type for the lane. To hide all lanes for a track, choose *Hide Lanes* from its Edit Layer menu.

The View menu provides shortcuts for showing and hiding automation lanes. See “Show/Hide Lanes” on page 274.

**Zooming for a better resolution**
When inserting controllers, it helps to get a zoom level that best suits what you are doing. For example, if you are making fine adjustments to the track level, use a large vertical zoom level for better resolution. If you need to check out the overall level throughout a track, zoom out.

**Inserting mix automation data**
To insert mix automation data in the Sequence Editor:

1. Choose the data type you wish to insert from the Edit Layer menu (Figure 17-15 on page 112) and then click the Pencil tool in the Tool palette (Studio menu).

2. If the desired data type does not yet have a layer, choose the desired automation data type from the track’s insert menu. This creates a layer and turns the cursor into the Pencil tool.

3. Choose the desired shape of the curve you wish to insert from the Pencil/Reshape Curve menu in the Tool palette. If you wish to insert just a single point, the curve doesn’t matter.

4. If you would like the curve shape you have selected to snap to beats or a similar metric grid, set the Edit Resolution and turn on the Edit Grid (see “Snap to Grid” on page 331).
Doing so constrains periodic waveshapes to the resolution of the edit grid. For example, if the Edit Grid is set to a quarter note, and you insert a sine wave, the sine wave will cycle once each quarter note.

Hold down the Command/Ctrl key to override grid snapping.

1. Insert data as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To insert a single event</td>
<td>Click in the track with the Pencil.</td>
</tr>
<tr>
<td>To insert a stream of events</td>
<td>Drag the Pencil. A stream of data is inserted according to the curve shape that you chose in the Tool palette. You can conform to a beat grid with Edit Resolution as explained in “Constraining a periodic waveform to beats” below, and you can use the waveform modifier keys described in “Using modifier keys to control period, phase, and other waveform parameters” on page 319.</td>
</tr>
</tbody>
</table>

Using modifier keys to control period, phase, and other waveform parameters

When inserting (or reshaping) continuous data using a waveform shape, you can hold down modifier keys while dragging to change waveform parameters as follows:

<table>
<thead>
<tr>
<th>To control this:</th>
<th>Hold down this key:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggles grid snapping (on/off)</td>
<td>Command/Ctrl key</td>
</tr>
<tr>
<td>Phase</td>
<td>Option/Alt key</td>
</tr>
<tr>
<td>Duty cycle</td>
<td>Control/Win key</td>
</tr>
<tr>
<td>* Triangle wave skew</td>
<td></td>
</tr>
<tr>
<td>* Square wave pulse width</td>
<td></td>
</tr>
<tr>
<td>* Sine wave pulse width</td>
<td></td>
</tr>
<tr>
<td>Periodic frequency</td>
<td>Shift key</td>
</tr>
<tr>
<td>Random curve density</td>
<td></td>
</tr>
</tbody>
</table>

To re-use the last settings for sine, triangle, square, random steps or random ramps: Escape key

Using the spline curve

The spline curve provides three handles that can be adjusted for the desired shape during insertion. Just place the handles as demonstrated below in Figure 36-26 and then click anywhere off of the spline to complete the insertion.

![Figure 36-26: Inserting a mix automation curve with the spline tool.](image)
Reshaping an existing curve
Use the same procedure as in the previous section to reshape an existing line or curve. Just drag over the existing data with the Reshape tool.

Selecting mix automation data control points
To select mix automation data:

1. Click the Pointer tool in the Tool palette (Studio menu).

2. Make a selection as follows:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select a single event</td>
<td>Click it with the finger cursor.</td>
</tr>
<tr>
<td>To select several events</td>
<td>Drag over the events in the grid with the lasso cursor.</td>
</tr>
<tr>
<td>To select a continuous data curve</td>
<td>Drag over the curve with the lasso cursor.</td>
</tr>
<tr>
<td>To select all events of a data type</td>
<td>Double-click a control point of that type.</td>
</tr>
<tr>
<td>To add to the current selection</td>
<td>Hold down the Shift key while using any of the selection techniques above.</td>
</tr>
<tr>
<td>To deselect events</td>
<td>Hold down the Shift key while using any of the above techniques on selected data.</td>
</tr>
<tr>
<td>To deselect all data</td>
<td>Choose Deselect All from the Edit menu or press its keyboard shortcut. Or click once in any empty area in the Sequence Editor.</td>
</tr>
</tbody>
</table>

Dragging control points
You can drag any control point on a line anywhere within the track strip. Notice that you can even drag it past events on either side of it as shown below. When you do, you delete the events that you drag over. This is a convenient shortcut for removing a curve.

Selecting multiple data types at one time
To select several data types at one time:

1. Click the Pointer tool in the Tool palette (Studio menu).

2. Hold down the Option/Alt and Control/Win keys to get the cross-hair cursor and then drag over the desired time range in the track. Time range selections select all data within selected area, including audio and other types of automation data. (Lasso selection with the Pointer tool by itself only selects the active data type.)

In audio tracks, another way to make time range selections is to switch the Edit Layer to Soundbites first, and then simply drag horizontally with the cross-hair cursor.

Selecting control points with soundbites (or MIDI notes)
Use the procedure described in the previous section.

Removing control points
To remove a single control point, click it to select it and the press the delete key. To remove a curve, drag over it horizontally in the track to select all of the points and then press the delete key.
**Cutting, copying, and pasting control points**
To cut, copy and paste audio mix automation or MIDI controller data in the Sequence Editor, select it first (as described earlier in “Selecting mix automation data control points” on page 320), and then cut, copy and paste them as usual. When pasting, you might find it useful to insert a control point at the location you wish to paste. Be sure it is selected before you paste. If you wish to preserve soundbites at the location where you are pasting, use Merge instead of Paste.

**Disabling automation temporarily**
To temporarily disable the automation data in an audio track, turn off automation playback as explained in “Global automation enable/disable” on page 463.

**SOUNDBITE VOLUME AUTOMATION**
Performer Lite provides an additional level of flexibility with regard to volume automation: *soundbite volume automation*, also referred to as *bite volume*. This is a non-destructive volume automation curve that you can apply directly to a soundbite. This volume curve then stays with the soundbite, in effect becoming part of the soundbite.

**Accessing bite volume automation**
Bite volume automation works similarly to the pitch automation layer described in “Pitch automation” on page 520. In the Sequence Editor Edit Layer menu (Figure 17-15 on page 112), there is a menu item called *Bite volume*. When you choose the soundbite volume automation layer, you have access to soundbite volume automation data with each soundbite.

**Working with soundbite volume automation**
By default, the bite volume automation data in each soundbite is set to zero dB. The range is the same as track volume: -× to +6.02dB. In all other respects, bite volume data can be viewed, inserted, edited and otherwise handled in the same manner as track volume automation. The only difference is that bite volume automation always stays with the soundbite. You can also use the dedicated bite volume commands in the Audio menu. See “Bite volume and gain” on page 385. Bite volume is supported by the Change Continuous Data command (Region menu).
CHAPTER 37  Fades and Crossfades

OVERVIEW
Performer Lite allows you to apply fades and crossfades to the edges of soundbites.

Overview .................................................. 322
What is a crossfade? ............................... 322
Creating a single fade or crossfade ................. 322
Types of crossfades ................................. 325
Fade curves .............................................. 326
How fades are generated ......................... 327
Fades are anchored to their splice .......... 327
Applying multiple fades in one operation .......... 327
Reapplying the last fade settings .............. 328
Deleting fades ......................................... 328
Editing existing fades ............................... 328
Fades that cannot be fully computed ............ 329
Trimming soundbites that have a fade or crossfade ... 329
Clipping when crossfades are calculated ........ 329

WHAT IS A CROSSFADE?
A crossfade occurs at the boundary — what we’ll call the splice point — between two soundbites. It fades out the volume of the first soundbite while fading in the volume of the second. A crossfade’s main purpose is to produce a smooth transition between the soundbites, preventing clicks and pops and other undesirable artifacts that can sometimes occur. Crossfades are general in nature, however, and they can also be used for volume effects and other purposes.

A fade is similar to a cross fade, except that it occurs at the start or end of a single soundbite, and it fades between the soundbite and silence.

Fades and crossfades do not modify the original audio in any way, and you can remove the fade or crossfade at any time.

WHAT IS A CROSSFADE?
A crossfade occurs at the boundary — what we’ll call the splice point — between two soundbites. It fades out the volume of the first soundbite while fading in the volume of the second. A crossfade’s main purpose is to produce a smooth transition between the soundbites, preventing clicks and pops and other undesirable artifacts that can sometimes occur. Crossfades are general in nature, however, and they can also be used for volume effects and other purposes.

A fade is similar to a cross fade, except that it occurs at the start or end of a single soundbite, and it fades between the soundbite and silence.

Fades and crossfades do not modify the original audio in any way, and you can remove the fade or crossfade at any time.
Creating a fade/crossfade with fade handles
Fades and crossfades can be applied directly to soundbites by pulling fade or crossfade handles directly on the soundbites, as shown below in Figure 37-2:

![Fade/crossfade handles](image)

![Fade/crossfade cursor](image)

![Select/Edit Fade/crossfade cursor](image)

*Figure 37-2: Position the cursor over a fade or crossfade handle until you see the fade/crossfade cursor shown above. Then just pull out a fade of the desired length. Double-click the fade or crossfade to edit its shape further.*

To create a fade at the boundary of two soundbites that are touching, hold down the Command/Ctrl key while dragging one handle or the other:

![Figure 37-3: Hold down the Command/Ctrl key to create a fade (instead of a crossfade) where two soundbites touch.](image)

Fades and crossfades are inserted with the shape most recently specified in the Fade dialog (Audio menu).

By default, fades and crossfades are inserted and edited symmetrically. To shorten or lengthen just one side of a crossfade while pinning the other side where it is, hold down the Option/Alt key while dragging the fade handle as shown below:

![Original crossfade:](image)

![Option drag to edit one side only](image)

*Figure 37-4: Option drag to move just one side of the fade. The other handle remains pinned to its original location.*
To edit multiple fades together in one operation, select the soundbites that contain the fades, and then grab the fade handle of one of the selected soundbites:

For example, if you needed to make all fades in a track a little longer, you can select all soundbites and then grab one fade to change them all.

**Applying a fade/crossfade to a selection**

To apply a single fade or crossfade to a selection:

1. In the Sequence Editor, make a selection over a splice point (the soundbite boundary that defines the fade or crossfade you wish to create).

You can use your selection to define the length of the crossfade, or you can create a fixed-length fade that is different from your selection.

2. Choose **Fade** from the Audio menu to open the **Create Fades** dialog, as shown in Figure 37-1.

3. Set the fade-out and fade-in curves as desired. These curves are explained later in the chapter.

4. To create a fade over the exact length of your original selection, choose the **Fade selected time ranges** option from the menu at the bottom of the dialog. To create a fade of a specific length, choose **Create fixed-length fades** and then enter the desired length for the fade (in milliseconds) in the **before splice** and **after splice** text boxes.

5. Click OK to apply the fade.
**TYPES OF CROSSFADES**

When you apply a crossfade, the selection you make relative to the splice point determines the type of crossfade. If you make a selection with the splice point somewhere in the middle, you will create a standard, centered crossfade as shown below in Figure 37-8.

![Figure 37-8: A centered crossfade.](image)

If you make a selection to the left of the splice point, you create a pre-crossfade before the splice point as shown below in Figure 37-9. This will let you maintain the volume of the beginning of Soundbite 2 without fading across it. This is especially useful if there is a percussive downbeat at the beginning of Soundbite 2 that you want to preserve.

![Figure 37-9: A pre-crossfade.](image)

If you make a selection to the right of the splice point, you create a post-crossfade as shown below. This is useful if you want to maintain the volume of Soundbite 1 right up to the splice point.

![Figure 37-10: A post-crossfade.](image)

**Crossfares use material beyond the splice**

All three types of crossfade discussed in the previous section use “hidden” material in each region beyond the splice point. In the centered crossfade shown below, the fade-out starts in ‘Bass riff 1’ and extends into the beginning of ‘Bass riff 2’; the portion of the fade-out to the right of the splice point is actually calculated from material in Bass riff’s parent audio file — material that is currently not visible.

![Figure 37-11: The area beyond ‘Bass riff 1’ in its parent audio file is used to calculate the fade-out curve of the crossfade. The same is also true for the area preceding ‘Bass riff 2’ in its parent audio file.](image)

If there isn’t enough additional material in the parent audio file for the fade-out (or fade-in) calculation, the fade will drop to zero at that point.
Fades mix with silence
Fades, on the other hand, do not use material beyond the edges of the soundbite from the parent audio file. Instead, they mix with silence to create a smooth transition to (or from) zero volume.

Fade types
The fade dialog box offers three types of crossfades and two types of fades:

- **Equal gain**
  Equal gain crossfades are recommended for material that is phase coherent or nearly phase-coherent, as in crossfades between soundbites from the same audio source material (the same instrument, for example). Equal gain crossfades help avoid clipping that can occur when using equal power crossfades (described below). Equal gain fades are available for both fades and crossfades.

- **Equal power**
  Equal power crossfades are recommended for material that is not phase coherent, such as completely different musical instruments. Equal power crossfades help you to avoid the volume drop that can sometimes occur with equal gain crossfades. Equal gain fades are available for both fades and crossfades.

- **Independent**
  Independent crossfades are recommended for special circumstances in which you cannot achieve the desired results with the equal gain or equal power curves — or when you specifically need to create entirely different fade-out and fade-in curves. This option only applies to crossfades; it is not available for fades (since a fade consists of only one curve).

FADE CURVES

For all of the fade types discussed in the previous section, you can choose between a standard fade curve or an S-shaped curve. If you are using an equal power or equal gain crossfade, both the fade-in and fade-out curve must be the same curve type. (The curve buttons in the window enforce this for you.) However, if you are using independent curves, you can choose a different curve type for the fade-in and fade-out.

Regardless of which fade type you create, you are given handles on the curves in the diagram to further adjust the curve. The standard fade curve offers a single handle; it creates a smooth, continuous general-purpose fade. The one exception to this is when you are using independent curves, in which the standard curve also gives you two end points that let you modify where the curve starts and ends.

![Image of curve types](image)

Figure 37-12: Here is an example of an equal gain crossfade with a standard curve.

S-shaped curves give you several handles, including one at the crossover point where it inverts its shape. S-curves are particularly useful for material that is hard to crossfade with a standard curve.
When you choose independent S-shaped curves, you can get as elaborate as you need.

For the most part, the icons on the buttons give you a pretty good idea of the shape of the curve and the effect it will have on your audio. The “square corner” presets are notable because the keep the volume of the fade-in or fade-out constant — either full volume or zero volume — for the entire length of the fade.

**HOW FADES ARE GENERATED**
When you make a fade (or crossfade), Performer Lite computes the fade on-the-fly — no files are created on disk. Fades are applied non-destructively, just as with volume automation or real-time effect inserts.

**FADES ARE ANCHORED TO THEIR SPLICE**
In general, fades and crossfades are preserved during editing operations such as dragging, shifting, compacting or setting the soundbite start time. For example, if you trim the edge of a soundbite, and it has a fade on it, the fade will remain after the trim operation. If the audio data within the range of the fade or crossfade changes, it will be recomputed automatically.

There are a few situations in which crossfades cannot be preserved, due to their nature. Crossfades are defined by the splice to which they were applied. If the splice point changes, the fade may no longer be valid because the original arrangement of audio data from which the fade was computed no longer exists. As a result, crossfades always remain anchored to the soundbite edge (or boundary between two soundbites) to which they were originally applied. They cannot be moved independently of their splice point — although they can move with their splice point (as long as it doesn’t change in the process). For example, if you move one of the two soundbites that define a crossfade, the crossfade will disappear. If you move them together, the crossfade will move with them.

**APPLYING MULTIPLE FADES IN ONE OPERATION**
Often, you’ll need to apply several — and possibly many — crossfades at one time. Rather than having to painstakingly apply them one at a time,
Performer Lite allows you to apply as many fades as you want in one operation. One way to do this is to use the Shift key to select several splice points at one time before entering the Fades dialog. You can then apply the same fade to all of them, using your selections to define the length of each fade. Or you can apply fixed-length fades.

Another way to apply multiple fades at one time is to make one large selection that contains any number of splice points and then apply fixed-length fades to all of them in one operation. This technique is especially useful when you’ve made many detailed edits — perhaps dozens or even hundreds — and you need to apply crossfades to all of them.

To apply fixed-length fades and/or crossfades to many splice points in one operation:

1. In the Sequence Editor, select the region that contains the splice points you would like to fade and/or crossfade. For example, if you want to apply fades and crossfades to all soundbite boundaries in the entire sequence, display all tracks in the Sequence Editor and Select All.

2. Choose Fade from the Audio menu to open the Fades dialog.

3. Choose Create fixed-length fades from the menu at the bottom of the window.

4. If the region you selected contains existing fades, and you would like to replace them with new fades, check the Update existing fades option. If you want to preserve existing fades, leave it unchecked.

5. If you would like to apply crossfades to all eligible splice points (ones that consist of boundaries between two touching soundbites), check the Create new crossfades option. If you don’t want to create any crossfades where soundbites touch, leave it unchecked.

6. If you would like to apply fades to all soundbite edges (e.g. edges that are not touching another soundbite), check the Create new fade-ins or fade-outs option. If not, leave it unchecked.

7. Enter the length of the fade by entering times in the before splice and after splice value boxes provided. Values are in milliseconds (100 = one tenth of a second).

8. Click OK to generate the fades.

When you click OK, Performer Lite’s applies the fades. You can, of course, proceed with other work when the fades are being processed, if you like. Fades that are not calculated yet are displayed in gray; fades that are done appear in the same color as the soundbite.

REAPPLYING THE LAST FADE SETTINGS
To apply another fade using the same settings you last used, hold down the Option/Alt key while choosing Fade from the audio menu.

DELETING FADES
To delete a single fade, click it and choose Delete Fades from the Audio menu.

To delete all fades within a region, select the region and choose Delete Fades from the Audio menu.

To delete all fades in the entire sequence, use Select All in the Tracks window (or the Sequence Editor with all tracks showing) and choose Delete Fades from the Audio menu.

EDITING EXISTING FADES
To modify an existing fade, double-click it.

To modify several existing fades at one time, select them and choose Fade from the Audio menu.
In either case, after you’ve made the changes you would like in the Fades dialog, make sure that the *Update existing fades* option is checked before clicking OK.

**FADES THAT CANNOT BE FULLY COMPUTED**

If Performer Lite computes a fade or crossfade and the level of the mixed audio in it exceeds unity gain (0 dB), the fade appears bright red to alert you to the fact that it is clipping.

If, for some reason, a fade or crossfade doesn’t have enough audio for Performer Lite to compute the complete fade, it appears bright blue. For example, you might draw a crossfade that is two seconds long, but one of the soundbites involved may not have a full extra second of audio in the parent audio file beyond the edge of the soundbite. In this case, the crossfade appears bright blue to indicate that it cannot be fully computed.

**TRIMMING SOUNDBITES THAT HAVE A FADE OR CROSSFADE**

If a soundbite edge has a fade or crossfade on it, you have to delete the crossfade in order to change it. This makes sense because as soon as you change it, the crossfade is no longer valid anyway (since the splice point has changed). You can reapply the crossfade after you modify the soundbite edge.

**CLIPPING WHEN CROSSFADES ARE CALCULATED**

If clipping occurs when Performer Lite calculates a crossfade, the crossfade is drawn in red instead of the soundbite’s color. In this case, you will probably want to re-apply the crossfade, adjusting the curves. Try using the equal gain curves (since it is impossible for clipping to occur when using equal gain).
CHAPTER 38  Information Panels

OVERVIEW
Information panels provide feedback about a wealth of parameters, events, controls, and more. Each Information panel has its own particular display or purpose, but they all behave similarly in several ways:

- The contents of the Information panels update to the current selection, cursor position, etc. while you work; in this way, they serve as central locations for feedback about your project.
- Information panels “float” (except for the Sound File Information panel).

Opening an Information panel from the Information Bar (Figure 17-1 on page 103), click the letter at the left of the section, as shown in Figure 17-6 on page 107.

To open an Information panel by name from the Run command, press shift-spacebar and type its name.

You can also open an Information panel from an assigned keystroke in the Commands window (Setup menu). The key command associated with each Information panel is a show/hide toggle: press the key command once to show the panel, then press it again to hide the panel.

FLOATING WINDOWS OR SIDEBAR CELLS
When an Information panel is open, it can be displayed either as a sidebar cell or as a separate floating window. If it’s a sidebar cell, and you wish to make it a floating window, click it to make it the focused cell and then choose Windows menu > Pop Out of Consolidated window. To move the floating window back into the sidebar, make it the active window and choose Windows menu > Pop In to Consolidated window.

The settings in Information panels can be displayed in the Sequence Editor and Notation Editor Information Bars. You can even choose which settings to display. For details, see “Information Bar” on page 107.
SNAP INFORMATION

The Snap Information panel contains information pertaining to snapping and nudging.

![Snap Information panel](image)

Figure 38-2: The Snap Information panel (as a floating window).

**Snap to Grid**

The *Snap to Grid* feature can be enabled or disabled with the check box provided. If the Snap to Grid box is turned on, data snaps to the edit grid. If it is turned off, data doesn’t snap to grid. Choose the desired *Snap to Grid* mode from the menu (Figure 38-2): Fixed or Auto.

![Snap to Grid menu](image)

Figure 38-3: Snap to Grid.

**Auto mode**

In *Auto* mode, Performer Lite chooses a reasonable grid size, based on the time format of the time line and the zoom level of the edit window you are working in. For example, if you are zoomed in quite a bit for detailed editing, the Auto grid might snap to 32nd notes. If you zoom out, it will snap to 16th or 8th notes.

**Fixed mode**

In *Fixed* mode, the *Unit* setting (Figure 38-2) determines the minimum time unit for editing, which is shown as a note duration and a number of beats and ticks, such as 240 ticks. The Edit Grid Resolution (*Unit* =) determines the amount of time between grid points. MIDI events, note durations, soundbites, loops, region boundaries, automation data, Memory Cycle repeat barlines, or any event that can be dragged horizontally will snap to time increments in the time line equal to the value of the edit grid unit. For example, if the Unit is set to 120 ticks, events will snap to 000, 120, 240 and 360 ticks.

**Using Snap to Grid**

Press the D key on your keyboard to toggle quickly between Fixed and Auto modes.

Snap to Grid’s on/off state, the edit grid resolution and Snap Relative’s on/off state can be set independently for each edit window.

If you wish to maintain an event’s original, unquantized position relative to the time line’s absolute grid, use the *Snap Relative* option. See “Snap Relative” on page 332.

**Setting the Edit Grid Resolution**

To change the Edit Grid Resolution, first make sure that *Fixed* mode is chosen from the menu and then use the value field provided to type in the desired grid duration, or choose a preset length from the *Unit* menu.

When you type in a value, the note displayed next to the ticks box will grey out (or text will be displayed in italics) if the tick value does not equal one of the presets in the menu.

**Triplet and dotted triplet grid editing**

The edit grid menu also provides choices for triplet and dotted triplet values.

![Edit grid menu for measures and beats](image)

Figure 38-4: The edit grid menu for measures and beats provides triplet and dotted triplet values.
Snap to Grid and selecting
Snap to Grid applies to selection, too, so it is an effective way to constrain selection operations.

Edit resolution when the grid is turned off
When Snap to Grid is turned off, data can be dragged freely. The smallest unit of resolution is one screen pixel, the exact resolution of which is determined by the current zoom level.

Temporarily overriding Snap to Grid
The Command/_CTRL key temporarily overrides the current Snap to Grid enable/disable state. For example, if Snap to Grid is currently enabled, the holding down the Command/_CTRL key while dragging overrides the current edit grid. Conversely, if Snap to Grid is currently disabled, the Command/CTRL key forces dragging to snap to the current Snap to Grid grid setting. The same is true for selection operations.

Don’t let the edit grid fool you
When you zoom in, the edit grid (in Fixed mode) may cause data to seem like it is “stuck”; that is, data will not move when you try to drag it. This is because the fixed-size edit grid is larger than the distance you are dragging. To “unstick” the data, deselect the Snap to Grid check box, or hold down the Command/CTRL key while dragging. Doing so overrides the edit grid temporarily. Alternately, you can use “Auto mode” on page 331.

Snap to Grid and nudging with the arrow keys
Snap to Grid only affects dragging operations. It is independent of nudging data with the arrow keys (except when Nudge is set to Use Edit Grid – see “Nudge” below).

Snap to Beat
Snap to Beat (Figure 38-2 on page 331) snaps actions to the beats within the waveform. This is active only when in the Sequence Editor or Waveform Editor. See “Using the beat grid” on page 406.

Snap to Markers
When Snap to Markers is checked (Figure 38-2 on page 331), dragged events snap to markers. The edges of soundbites and MIDI notes dragged close to a marker location also snap to the marker’s time. For example, the left edge or right edge of a soundbite or MIDI note will snap. Snapping also occurs when spotting soundbites by dragging them from the Soundbites list into the Sequence Editor.

Hold down the Command/CTRL key to toggle the current setting.

Snap Relative
When Snap Relative (Figure 38-2 on page 331) is checked, an event moves relative to its original position, rather than snapping to the time line’s absolute grid. For example, if the grid unit is set to 120 ticks, and the original event is located at 013 ticks, it will snap to 133, 253, and 373 (which are all 13 ticks after 000, 120, 240 and 360). 

Nudge
The Nudge amount (Figure 38-2 on page 331) lets you to choose the unit of time by which you can nudge any selected data with the arrow keys. Many different time formats are supported, including SMPTE frames, SMPTE sub-frames, samples, and milliseconds. Choose the desired time format from the menu and then enter the amount of time. You can change the nudge amount at any time.

Figure 38-5: Setting the Nudge Amount.
When you choose a mensural time format (one that involves measures, beats and/or ticks), data is nudged in the same manner as using the Shift command (Edit menu) with the Preserve Real-time Performance option unchecked. This means that the data being nudged maintains its metrical relationship to the sequence, changing the way it plays back, if necessary, to respect any tempo changes that may be programmed in the conductor track in the area in which the data is being nudged.

When you choose any other time format (real time, SMPTE frames, sub-frames, milliseconds, or samples), the real time performance of the data is preserved, regardless of any tempo changes.

When you choose the Use Edit Grid menu item, the nudge amount is determined by the edit grid setting above. If the edit grid is currently disabled, then nudging occurs in the same manner as in the window itself (by one screen pixel).

### CURSOR INFORMATION

The Cursor Information panel displays the current location of the mouse cursor with respect to the horizontal and vertical axis in the edit windows. Values in this box are continually updated as the mouse cursor moves around the edit window, giving you immediate, numerical accuracy when inserting and manipulating data with the mouse.

#### Time

The pointer’s horizontal coordinate, Time, displays the time of the current cursor location.

#### Value

The cursor’s vertical coordinate, Value, depends on its location in the Sequence Editor and the active layer. It will display MIDI note values when the cursor is over a MIDI note grid, controller values when over a continuous data grid, audio volume when over audio track volume automation, soundbite names when over soundbites, and so on.

### EVENT INFORMATION

The Event Information panel displays numerical details about a single event that has been selected. For example, a selected note appears with its location, pitch, on velocity, off velocity, and duration.

When a soundbite is selected, additional information is displayed: soundbite mute, original timestamp, user timestamp, bite gain, tempo, and time signature.
Information displayed in the Event Information section can be edited by clicking it (with the exception of some soundbite attributes). The usual editing conventions apply, such as using the Tab key and arrow keys to move from field to field and press return to confirm any changes you have made. The event’s graphic display will change to reflect the modifications.

**SELECTION INFORMATION**

The *Selection Information* panel holds the start and end times for any region that you wish to edit in any currently highlighted tracks. If the Performer project file contains multiple sequences, separate Selection Information is stored for each sequence.

You can set these times by:

- making a time range selection in the Sequence Editor
- typing (use the Tab key as usual)
- dragging on the numbers vertically to change them
- choosing the desired command from the Set To menu
- using several clicking shortcuts
- using several keyboard shortcuts
- loading them with the *Remember Times* Command

These techniques are discussed in the following sections.

**Editing the selection bar numbers directly**

To enter a start or end time, click in a field and enter a value. You can use the Tab key (or decimal point key on the keypad) to cycle through the measure|beat|tick fields. Or you can simply press on any field and drag up or down to change its value.
Using the Set To menu shortcuts

The Set To menu holds several great shortcuts for loading times into the Selection Information panel:

<table>
<thead>
<tr>
<th>Command</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set to Selection Bounds</td>
<td>Loads the beginning and end of the currently selected region into the Selection Information panel.</td>
</tr>
<tr>
<td>Set to Sequence Bounds</td>
<td>Loads the very beginning and end of the entire sequence.</td>
</tr>
<tr>
<td>Set to Remembered Times</td>
<td>Loads the times currently stored by the Remember Times feature.</td>
</tr>
<tr>
<td>Set Start to Counter</td>
<td>Loads the current counter location into the start time.</td>
</tr>
<tr>
<td>Set End to Counter</td>
<td>Loads the current counter location into the end time.</td>
</tr>
</tbody>
</table>

For the last two commands, Performer loads the counter location at the time you click the menu, not when you actually choose the command. This helps you load start and end times on the fly during playback. Click the menu at the desired instant, and then take as much time as you need to choose either Set Start or Set End.

Clicking the start and end buttons

The buttons to the right of the Selection Start and Selection End values let you load times as follows:

- Click the button to load the current counter location – even on the fly during playback.
- Command/Ctrl-click the button to load the beginning or end of the sequence into the start time or end time, respectively.

Control/Win-click the button to load the beginning or end of the Remembered Times (previously retrieved from a selection with the Remembered Times command) into the start time or end time, respectively.

The selection bar shortcuts

There are two shortcuts for loading the current counter location into the Selection start and end times. By default, they are assigned to the F5 and F6 keys on your computer keyboard. You can change these key assignments if you like. You can also program these key commands to respond to any MIDI device, so that you can actually load counter times from an external MIDI device. See chapter 28, “Commands” (page 234) for details.

The “Remember Times” command

The Remember Times command (control-R), allows you to save any time range selection, so that you can load it into the Selection Information panel later on. You can also load remembered times into the Memory Bar and the Auto-Record Bar. For complete information, see “The ‘Remember Times’ command” on page 286.

Load Selection

The Load Selection button provides additional shortcuts. Click the Load Selection button once to Set Selection to Remembered Times, or double-click the button to Set Selection to Sequence Bounds.

Making a selection in an edit window

You can make a time range selection in an edit window to set the Selection times. For example, you could click one of the Memory Cycle markers in the Sequence Editor to select the Memory Cycle range. The selection is automatically loaded into the Selection Information panel.

Preroll and Postroll

These text fields set the Preroll and Postroll for Auto Record mode.
**Smart Selection**
A check box is provided as a convenient shortcut to enable or disable *Smart Selection*. For more information, see “Smart Selection” on page 286.

**TRACK INSPECTOR**
The Track Inspector shows track settings such as color, input, output, play-enable status, record-enable status, Pitch mode, Stretch mode, and so on. For further information, see “Track Inspector” on page 42.

**CHANNEL STRIP**
The Channel Strip panel shows the Mixing Board channel strip controls for a single track. The Channel Strip panel updates to focus on the current track at hand. For further information, see “Channel Strip” on page 42.

**TRACK SELECTOR**
The Track Selector lets you show and hide tracks in the Sequence Editor, Mixing Board and Notation Editor. For further information, see “Track Selector” on page 41.
OVERVIEW
For a general explanation of how to use Edit menu operations, see chapter 33, “Editing Basics” (page 272). All Edit menu commands can be applied to MIDI data, audio data or both:

Overview ........................................... 337
Undo .................................................. 337
Redo .................................................. 337
Cut .................................................... 337
Copy ................................................... 337
Paste .................................................. 338
Other Paste commands ........................... 338
Erase .................................................. 339
Duplicate .......................................... 339
Repeat ................................................. 339
Paste and Merge ................................. 339
Other Merge commands ....................... 340
Trim .................................................. 340
Trim Audio ........................................ 340
Trim End / Trim Start ............................ 340
Select All .......................................... 340
Select All Tracks in Range ................. 340
Deselect All ...................................... 341

UNDO
The Undo command will undo the effects of most commands and actions that add, delete, move, or otherwise modify data. Undo will also undo the effects of recording. Undo is unlimited. This means that if you invoke it repeatedly, you can essentially step backwards through your previous actions. For example, if you choose Undo three times, you’ll go back three actions. Undo can be used together with Redo to step forwards and backwards through your document’sUndo history.

REDO
The Redo command restores the action that was just undone. Like Undo, Redo is also unlimited. This means you can restore undone actions until you reach the most recent action you’ve taken in your project.

Together, Undo and Redo allow you to step repeatedly backwards and forwards through the project’s current history of actions.

Both Undo and Redo give you a brief description of the action they are undoing or restoring, such as Undo drag note or Redo paste into track ‘Lead Guitar’.

CUT
The Cut command removes data in the selected region and places it on the Clipboard. This does not remove the time region specified; instead, it leaves the measures blank (silent). The Cut command is undoable.

Before measure 3 is cut:

\[
\begin{array}{cccc}
N & O & P & Q & R \end{array}
\]

After measure 3 is cut:
(The length of the music is the same.)

\[
\begin{array}{cccc}
N & O & P & Q & R \end{array}
\]

COPY
The Copy command copies the data from the selected region and places it on the Clipboard. The original data is not affected at all. The Copy command is undoable.
PASTE
The Paste command inserts the contents of the Clipboard (i.e. whatever was most recently cut or copied) into a track at the location that you specify. When you paste, you need to tell Performer Lite where you want the Clipboard data to go. Performer Lite needs to know:

- What track (or tracks)
- What time in the track (or tracks)

Choosing a track (or tracks) to paste into
To choose the track you want to paste into, click the track’s name in the Sequence Editor to highlight it. To paste into several tracks at once, highlight their names (see “Selecting tracks” on page 283).

Indicating the time at which you want to paste
There are several useful ways to choose the time at which you want to paste:

- If there is already a current selection in any track, Performer Lite will use the beginning of the selection (either the first event of an event selection or the start time of a time range selection) to determine where it pastes.
- If there is no current selection, Performer Lite pastes into the measure currently displayed in the main counter (and also indicated by the playback wiper in windows that have it) — along with one additional condition: if Performer Lite’s Smart Selections feature is turned off, material is pasted at the exact tick location shown in the counter. If Smart Selections is turned on, material is pasted measure relative, which means that it is placed in the measure at its original location within the measure so that you don’t have to worry about exact placement of the counter. Just get the counter anywhere into the measure you want and paste. For more information, see “Smart Selection” on page 286.

Choosing tracks and location at the same time
You can use any of the selection techniques in the Sequence Editor to choose the track and the location at which you want to paste with one easy selection.

What happens when you paste
The length of the pasted region is exactly that of the data in the Clipboard (including any blank space at the beginning and end of the region that was placed on the Clipboard).

Pasting data always replaces what was previously there. The Paste command is undoable.

OTHER PASTE COMMANDS
Several additional variations on the Paste command can be found in the Commands window (Figure 28-1 on page 234). If you search the Commands list for the word Paste, you can find them and assign your own custom keystrokes to them. Included are Paste At Wiper, Paste At Wiper Multiple, Paste At Original Time, and Paste At Original Time Multiple.
ERASE
The Erase command works like the Cut command except that no data is put on the Clipboard: all data in the selected region is removed and the region is left blank. The Erase command is undoable.

Before measure 3 is erased:

\[\begin{array}{ccccccc}
\text{N} & \text{O} & \text{P} & \text{Q} & \text{R} \\
\end{array}\]

After measure 3 is erased: (The clipboard remains empty.)

\[\begin{array}{ccccccc}
\text{N} & \text{O} & \text{P} & \text{Q} & \text{R} \\
\end{array}\]

DUPLICATE
The Duplicate command makes an internal copy (which does not go on the Clipboard) of the current selection (either a time-range selection or an object selection), then pastes a copy of this data immediately following the selected region. The resulting copy is selected, so that you can immediately use the Duplicate command again repeatedly to quickly create consecutive copies of the data.

REPEAT
The Repeat command makes an internal copy (which does not go on the Clipboard) of the data in the selected region, then pastes, splices or merges this data repetitively, immediately following the selected region. For example, repeating measures 1-3 three times places a copy of measures 1-3 in measures 4-6, 7-9, and 10-12. Regardless of the events in the region, the entire selected region is repeated. In the above example, the start and end locations in the Selection bar would be set to 1|1|000 and 4|1|000, respectively. The entire three measure region is repeated, with each repetition starting on the down beat of the following measure. In most cases, it is best to select entire measures or groups of measures to repeat; this ensures that the repetitions will line up correctly with measure boundaries.

The Repeat command requires a time range selection instead of an event selection. For a further explanation, see “Edit operations that require time range selection” on page 281.

Using the Paste option in the Repeat dialog box, the repeated data replaces the data in the repeated region: the pre-existing data is erased. Using the Merge option in the Repeat dialog box, the repeated data is merged with the data in the repeated region. Using the Splice option in the Repeat dialog box, the repeated data moves the pre-existing data to a later time in order to make room for the data in the repeated region.

PASTE AND MERGE
The Paste and Merge command combines the contents of the clipboard with pre-existing data in the selected tracks. The new data is mixed together with the data already in the region. In the case of audio, the merged audio is layered on top of any existing audio at that time, but the actual waveform data is not merged. Instead, the result is two soundbites layered on top of one another.

You need only specify a Start time when merging; the End time has no effect. The Merge command is undoable.

Since Performer Lite allows unlimited tracks assigned to one channel, the Merge command isn’t always necessary. You should use it only when you are certain that data in two tracks should be merged together (this is often true when you create a track during editing for the express
purpose of merging it with another track later). After tracks are merged, they cannot be separated later.

OTHER MERGE COMMANDS
Several additional variations on the Merge command can be found in the Commands window (Figure 28-1 on page 234). If you search the Commands list for the word Merge, you can find them and assign your own custom keystrokes to them. Included are Merge At Wiper, Merge At Wiper Multiple, Merge At Original Time, and Merge At Original Time Multiple.

TRIM
Trim allows you to select a portion of a soundbite and remove the parts of it that are not selected. For example, you might want to extract a single measure from a soundbite that is 8 measures long. It is also very useful for removing silence at the beginning and/or end of a recorded soundbite.

TRIM AUDIO
This variation of the Trim command can be accessed by holding down the Option/Alt key while accessing the Edit menu. Trim Audio does the exact same thing as Trim except that it only affects audio data (and not MIDI data).

TRIM END / TRIM START
The Trim End command (Edit menu) removes any portion of a soundbite between what is currently selected and the end of the soundbite, if any. To change this menu command to Trim Start, hold down the Shift key while accessing the Edit menu.

Trim Start removes any portion of the soundbite between what is selected and the beginning of the soundbite.

SELECT ALL
The Select All command generally selects all items in the active window. If the Sequence Editor is active, choosing Select All will select all the tracks (thus highlighting all track names).

SELECT ALL TRACKS IN RANGE
To access the Select All Tracks in Range command, hold down the Option/Alt key while accessing the Edit menu, or press Command/Ctrl-Option/Alt-A.

The Select All Tracks in Range command selects all tracks, as its name implies, but it only selects a certain time range, rather than the entire length of the sequence. The time range is determined either
by the selection start and end times currently
chosen in the Selection Information window, or by
the current selection, if any.

DESELECT ALL
The Deselect All command makes all currently
selected data not selected.
CHAPTER 40  Region Menu

OVERVIEW
For a general explanation of how to use Region menu operations, see chapter 33, “Editing Basics” (page 272). Region menu commands can be applied to MIDI data, audio data or both, with a few exceptions for audio as noted in “Region menu exceptions for audio” on page 273.

REGION COMMAND WINDOWS
All of the Region menu commands open as a window that can stay open, unlike Edit menu commands, which are dialog boxes that must be okayed or cancelled before you can do anything else. By staying open, Region menu commands let you apply their effect without revisiting the menu each time. For example, if you are quantizing a number of tracks, you can leave the Quantize window open while you successively select different tracks and apply different quantize settings to them.

Because of the way Region menu windows interact with global selection, only one Region menu window can be open at a time. If you have one already open, and you choose a different command from the Region menu, the current window is replaced with the new one.

When you open a Region menu window, its location on your computer screen is remembered when you close it and reopen it. In addition, all Region menu windows share this location, so they will always open in the same spot.

Region command window mini-menus
Region command windows have a mini-menu with several items.

Figure 40-1: Region command window mini-menu.
Preview Stays on when Window Not in Front:
This menu item is available for any Region commands that have previewing, such as the Quantize commands, as explained below in “Previewing”. When checked, previewing continues (before actually applying the effect) even when the Region command window is not the front-most window.

Save Preset: Let’s you name and save the current settings in the window as a preset. Saved presets appear by name at the bottom of the menu for that same Region command (Quantize, Transpose, etc.). They are also added to the Commands window (Setup menu), where you can assign shortcuts to them. This is a great way to save frequently used Region menu operations. If the Region command has a matching real-time MIDI plug-in, saved settings also appear in the Effect window mini-menu as presets for the corresponding real-time MIDI plug-in.

Reveal Presets in Finder/Explorer: Opens the macOS or Windows Explorer window where the preset files are located, where you can rename or delete them.

Set Preset Key Bindings: Opens the Commands window, where you can assign shortcuts to your presets. See chapter 28, “Commands” (page 234).

PREVIEWING
Some Region menu commands have a preview check box to the left of the Apply button:

![Figure 40-2: Previewing a Region command.](image)

The preview check box provides real-time previewing, which allows you to hear the results of the Region operation in real time (as the sequence plays) before you actually apply it permanently with the Apply button. Data remains unaffected until you click the Apply button.

REGION COMMAND PREFERENCES
The Region Commands preferences lets you choose one of the following three options:

Apply closes window: Makes the window close when you click the Apply button or press Enter.

Apply sends window to back: Causes the window to go to the back when you click the Apply button or press the Enter key.

Apply with Enter key sends window to back: Causes the window to stay in front when you click the Apply button and go to the back when you press the Enter key.

Save settings: Lets you name and save the settings currently displayed in the Region commands window. These settings then appear by name at the bottom of the mini-menu.

TRANSPOSE
Performer Lite’s Transpose command, found in the Region menu, transposes the pitches of all MIDI notes in a selected region. It can also transpose the pitch of audio data with either formant-corrected pitch-shifting or conventional pitch-shifting, using Performer Lite’s non-destructive pitch automation or by producing new audio files.
The Transpose command can transpose both audio and MIDI notes in many ways:

- transpose by interval
- transpose diatonically
- change key from any root to any other
- change key from any mode to any other
- map each pitch to any other pitch
- transpose using scale sizes larger or smaller than 12 notes
- transpose up or down, by any number of octaves
- create and save custom transpose maps
- create and save custom scales or keys
- Create harmonies

When performing the above operations, you can:

- play in pitches or entire scales from your MIDI keyboard when setting up the transposition
- Undo and Redo the Transpose command

The Transpose window provides several ways of transposing, options for each type, a Transpose Map that shows you how each pitch will be changed, and a Custom Maps list which can save transposition maps.

**MIDI transpose options**
The following options are provided for MIDI transposition only.

**Harmonizing instead of transposing**
The Transpose window allows you to either transpose or harmonize. The Harmonize option copies the original notes, transposes the copied notes, and merges them together with the original notes. This allows you to build harmonies quickly.

---

![Image of the Transpose window](image)

The Transpose Map changes dynamically to reflect the transposition or custom map you have chosen to the left. You can edit pitches in the To column to create a custom map. Changes in one octave are reflected in all other octaves.

Create your own types of scales with the Edit scales button.

After you have set up a transposition, you can save it by typing in a name and clicking Save; it will then appear in the list. You can use the transposition map at any time by clicking its name.

---

*Figure 40-4: The Transpose command.*
Transposing poly pressure and/or portamento
The Transpose poly pressure option transposes poly pressure (aftertouch data) along with the notes that it modifies.

The Transpose portamento controller (#84) option transposes portamento controllers.

Audio transpose options
The following options are provided for audio transposition only.

Transpose audio by adjusting pitch automation
Choose Transpose audio by adjusting pitch automation if you would like to transpose the audio by affecting Performer Lite’s non-destructive, real-time pitch automation data for the selected audio. The audio data must already have pitch data to transpose; therefore, pitch analysis is required before you can use this option. For complete details, see chapter 61, “Transposing Audio” (page 519).

Transpose audio by creating new soundbites
Choose Transpose audio by creating new soundbites if you would like to transpose the audio by creating a new audio file that is the transposed form of the original file (leaving the original file in tact).

The Transpose Map
The Transpose Map displays a scrolling list of all 128 MIDI notes in a column on the left and the pitch to which each will be transposed in a column on the right. Notes and spellings in the map change dynamically according to the transposition options that you choose. In addition, you can edit values directly in the Transpose Map list to further modify the map, as shown below. Changes in one octave are reflected in all other octaves. As soon as you edit a pitch in the Transpose Map, thus modifying it from the way it was originally set up by the transpose options, the Custom Map transpose option will then become automatically selected to indicate that the transpose map is now a custom map.

Playing in pitches from your MIDI controller
When editing the Transpose Map, you can play individual pitches or an entire scale from your MIDI controller. To play a scale, double-click the first pitch to edit it and then play the scale. As you play, each pitch gets entered into the current box, which then automatically scrolls down to the next note in the list and enters the next pitch you play. If you make a mistake, use the Up Arrow and Down Arrow keys to change the selected pitch.

When you are using the Custom Map option, Performer Lite provides another intuitive way for you to play in pitches from your MIDI controller:

1. Select the Custom Map option.
2. Hold down the pitch you wish to transpose, and while holding it down, play the pitch you wish to transpose it to.

You do not need to select any values with the mouse or computer keyboard to use this method.
Saving a Transpose Map
If you would like to save a transpose map, type in a name for it and click Save as shown below. Custom maps are saved with the project.

Using Transpose Maps
To recall the map, select its name in the list. To remove a Custom Map from the list, click its name and click Delete.

To make changes to an existing map:
1. Select the existing map in the list.
2. Make your changes to the Transpose Map.
3. Click Save.

The changes you made will be saved to the map.

To create a new map based on an existing map:
1. Select the existing map in the list.
2. Type in a new name.
3. Click Save.

The new map will appear in the list.

4. Edit the Transpose Map to make your changes.
5. Click Save to save the changes you have made.

Transposing by interval

Figure 40-5: Transposing by interval.

Transposing by Interval is a chromatic, exact transposition: pitches are shifted by the number of semitones in the interval that you choose. Literally, it causes a mass shift of all pitch values in the selected region, just like dragging MIDI notes up or down in the MIDI Editing or Notation Editors. For example, chromatically transposing from C3 to E3 causes all pitches to shift up a major third (four semitones).

The from and to pitches define the interval. The notes that you enter to define the interval are not important: only the interval between them matters. For example, instead of entering C3 to E3 to shift notes up a major third, you could enter F3 to A3.

The two pitches entered also define the direction of transposition. If the second pitch is above the first pitch, pitches will be transposed up. If the second pitch is below the first, pitches will be transposed down.

Adjusting the MIDI transpose map

Having chosen an interval, you can edit the transpose map to make modifications to it if you like. As soon as you edit a pitch in the Transpose Map, thus modifying it from the way it was originally set up by the Interval transpose options, the Custom Map transpose option will then become automatically selected to indicate that the transpose map is now a custom map.
Transposing audio by interval

If you’ve selected soundbites, and you’d like to include them in the transpose operation, check the Transpose audio check box (as shown in Figure 40-5 on page 346) and type in a number of cents, if desired, for fine-tuning the audio transposition. (There are 100 cents per half-tone.) To choose whether the soundbite is transposed using Performer Lite’s formant-corrected pitch-shifting or conventional pitch-shifting, set the soundbite’s transpose attribute beforehand as explained in “Dragging and dropping soundbites” on page 203.

Transposing diatonically

Diatonic transposition transposes MIDI notes by a number of scale steps within the type of scale that you choose. For example, if you transpose up 2 scale steps in the key of C minor as shown in the above example, all C naturals (the root) will be transposed up two steps to E flat (a minor third). Notice that the number of scale degrees, 2 in this example, refers to the number of scale steps to change by; it does not refer to the destination scale step.

This is extremely useful for quickly creating harmonies. For example, as shown above you can copy and paste a melody line into another track and transpose it diatonically up a third (two scales degrees) to harmonize with the melody. Scale tones in the key you choose are displayed in boldface in the transpose map column.

To Transpose diatonically:

1. Choose the Diatonic option.
2. Choose the direction (Up or Down) and number of octaves.
3. Type or play in the key root pitch and select a mode from the list.

This sets up the Transpose Map. You can play in the root pitch from your MIDI keyboard if you place the insertion point in the From text box.

4. If you would like to transpose all non-scale pitches into the nearest scale pitch, select the Constrain to scale option.

5. If you would like to customize the transposition, edit the pitch values in the Transpose map.

As soon as you edit a pitch in the Transpose Map, thus modifying it from the way it was originally set up by the Diatonic transpose options, the Custom Map transpose option will then become automatically selected to indicate that the transpose map is now a custom map.

6. Click Apply.

The Up and Down options determine the direction of transposition, and the Plus n octaves option allows you to transpose by intervals greater than one octave.

Remember that the key you choose is a way of setting up the diatonic transposition in the Transpose Map. Performer Lite doesn’t really “know” what key the actual data is in. In fact, just about any musical phrase can be described in musical terms as being in one of several different, but related, keys. So, when transposing diatonically, it is up to you to know which key to choose to get the results that you want.

The above also holds true for how notes get spelled. The key that you choose only affects the spellings in the Transpose Map: it will not change...
the spellings of the actual track data. Track note data spellings are controlled by the current key signature in the Conductor track.

**The Constrain to Scale option**

The Constrain to scale option is available with the Diatonic and Key/Scale transpose options. If enabled, it causes all non-scale tones to be transposed to the nearest appropriate scale tone, as shown below:

![Transposing by key/scale](image.png)

**Transposing by key/scale**

Transposing by *Key/Scale* transposes MIDI notes from one key to another. For example, you can change music that is currently in a major key to its corresponding minor key. In the above example, notes in the key of C major are being transposed down to a entirely different root and key: E Harmonic Minor. The Transpose Map shows each note in the key of C Major on the left, and on the right, the pitch each note will be transposed to (in the key of E Harmonic Minor).

To Transpose by key:

1. Choose the Key/Scale option.
2. Choose the direction (Up or Down) and number of octaves.
3. Type or play in the source key root pitch and select a mode from the top list.

This sets up the From column in the Transpose Map. You can play in the root pitch from your MIDI keyboard if you place the insertion point in the From text box.

4. Type or play in the destination key root pitch and select a mode from the bottom list.

This sets up the To column in the Transpose Map.

5. If you would like to transpose all non-scale pitches into the nearest scale pitch, select the Constrain to scale option.
6. If you would like to customize the transposition, edit the pitch values in the Transpose map.

As soon as you edit a pitch in the Transpose Map, thus modifying it from they way it was originally set up by the *Key/Scale* transpose options, the *Custom Map* transpose option will then become automatically selected to indicate that the transpose map is now a custom map.

7. Click Apply.

The Up and Down options determine the direction of transposition, and the Plus ___ octaves option allows you to transpose by intervals greater than one octave.

Remember that the source and destination keys that you choose are a way of setting up the diatonic transposition in the Transpose Map. Performer Lite doesn’t really “know” what key the actual data is in. In fact, just about any musical phrase can be described in musical terms as being in one of
several different, but related, keys. So, when transposing by key, it is up to you to know which key to choose to get the results that you want.

The above also holds true for how notes get spelled. The key that you choose only affects the spellings in the Transpose Map: it will not change the spellings of the actual track data. Track note data spellings are controlled by the current key signature in the Conductor track.

**Transposing using a custom map**
The Custom Map option allows you to do several things. You can:

- create a customized map that is based on one of the other transpose options
- transpose using octave ranges other than 12 halftones
- map each note to any other note
- map all notes to a single pitch

Each of these operations are discussed below.

**Custom transposing based on another transposition**
Often you may want to slightly modify a transposition set up by one of the first three transpose options. For example, you may want to transpose diatonically up two scales steps except for each A-flat, which you would like to maintain as an A-flat. In this case, you can set up the Diatonic transposition and then edit the destination pitch for A-flat so that it doesn’t change pitch.

To create a customized map that is based on the Interval, Diatonic, or Key/Scale Transpose options:

1. Choose the Transpose option you would like to base your custom map on.

Set up the parameters for the option as necessary.

2. To customize the transposition, edit values in the Transpose map as needed.

As soon as you edit a pitch in the Transpose Map, thus modifying it from the way it was originally set up by the transpose options, the Custom Map transpose option will then become automatically selected to indicate that the transpose map is now a custom map.

3. If you would like to save the map, type in a name and click Save.

The map will appear in the Custom Maps list.

4. Click Apply to execute the transposition.

**Custom transposing with a non-standard octave range**
Interval, Diatonic, and Key/Scale transpose options all set up the transpose map in 12 note octaves. Changes in one octave are reflected in all other octaves. The Custom Map option can set up the transpose map in octaves that are more or less than 12 notes. For example, if you have a sampler that has drum pitched drum sounds like tom-tom drums every 6 notes, you can transpose that 6-note range to the 10-note range of another sampler. Or, you can transpose music from a 12-tone synth to a synth that is tuned in quarter-tones.

The Custom Transpose option frees you from the octave and diatonic restrictions of the other transpose options.

To transpose using an custom octave range:

1. Select the Custom Map transpose option.

The Custom Transpose options will appear.
2 Type in the number of notes in the source and destination octaves and a root pitch for the initial octave.

In the example above, a standard 12-note octave is being mapped to a 24-note octave. The scale sizes can be any number between 1 and 128. The root pitches can be any note. Notice that the source octave from C3 to C4 gets mapped to the destination two-octave range of D3 to D5. Also notice that the root pitches do not need to be the same. All other octaves above and below become mapped in the same fashion as the one you define. If notes in other octaves get transposed to pitches outside the 128 note MIDI range, they are substituted with pitches inside the range.

3 If you would like to save the map, type in a name and click Save.

The map will appear in the Custom Maps list.

4 Click Apply to execute the transposition.

Transposing all notes to a single pitch

To map all 128 MIDI notes to a single pitch:

1 Select the Custom Map transpose option.

The Custom Transpose options will appear.

2 Type in 128 in the From: option.

This includes all notes into one, large octave.

3 Type in 1 in the To: option.

This maps all note in the 128-note octave to a single note.

4 Type in or play in a pitch in the To: option.

In the above example, all notes are being mapped to C1.

5 If you would like to save the map, type in a name and click Save.

The map will appear in the Custom Maps list.

6 Click Apply to execute the transposition.

Transposing each pitch to any other pitch

The Custom Map option can also map each pitch to any other pitch, completely independently from the same pitch in other octaves. This allows you to create a transpose map to easily change drum tracks from one drum machine to another.

To set up a drum machine transpose map:

1 Select the Custom Map transpose option.

The Custom Transpose options will appear.

2 Type in 128 in both the From: and To: options.

Since there is only one source and destination octave, each change you make in the Transpose Map’s To column will not be carried through to any other octaves.
3 Edit the pitches in the Transpose Map’s To column.

Notice that each pitch treated individually and does not affect surrounding pitches or octaves. Notice in the above example that a same destination pitch, like Db3, can be used more than once, such as when several pitched tom-tom sounds are being mapped to a single tom sound.

4 If you would like to save the map, type in a name and click Save.

The map will appear in the Custom Maps list.

5 Click Apply to execute the transposition.

Creating a custom scale

The Custom Scale option allows you to create your own scale. To do so, you select which pitches are diatonic and which ones are not.

After you create a custom scale, it appears in the list of keys/scales for the Diatonic and Key/Scale transposition options, allowing you to transpose diatonically using your own scale and any root pitch.

To create a custom scale:

1 Click the Edit Scales button.

The Create Scale dialog box appears.

2 Select the pitches you wish to be diatonic pitches.

You can have as many or as few diatonic notes as you wish. You can also select the diatonic pitches by playing them on your MIDI controller. A pitch turns into boldface to indicate that it is diatonic.

3 Click OK to create the scale.

Your custom scale appears in the key/scale list for the Diatonic or Key/Scale transpose options.

Deleting a custom scale

To remove a custom scale from the list:

1 Click the Edit Scales button in the Transpose window.

2 In the list of scales, click the name of the scale you want to delete.

3 Click Delete.
QUANTIZE
Quantizing changes the attack and release times of MIDI note events and audio soundbites to make them more rhythmically precise. It can also modify beats within soundbites that have been analyzed with Performer Lite’s Beat Detection Engine (chapter 44, “Audio Beats and Tempo Detection” (page 400)). Attacks, releases and beats within soundbites are aligned with a grid, a set of locations that occur on the beat and its subdivisions. Quantize is useful in correcting perceived rhythmic inaccuracies after your sequence is recorded. It does a rhythmic “cleaning up” based upon your specifications.

What to quantize
Quantize will only alter the locations and durations of the types of data you choose in the What to quantize section. All other data in the selected region will be unmodified. The What to quantize section gives you the following choices for what you can quantize:

- Attacks
- Releases
- Don’t change note durations
- Soundbites
- Beats within soundbites
- Exclude soundbites
- Custom edit filter

The Custom edit filter option, shown in Figure 40-12, gives you complete control over what you wish to quantize, including markers, patch changes, and tempo events in the conductor track. You can quantize anything except loops.

Some inaccuracy is good
Quantizing is, in its simplest form, a way to make all note events and/or audio beats in your sequence occur on a beat or one of its subdivisions, eliminating inaccuracies. But inaccuracy is far from undesirable. In fact, inaccuracy is what gives a piece of music its “feel”, its particular rhythmic profile. If you always aligned all attacks and releases with grid locations, your music might have a mechanical, inhuman quality to it. You’ll find that you’ll often want to preserve some of the rhythmic nuances of your playing. Therefore, Performer Lite allows you to quantize selectively and specify the degree of quantizing you want. The Sensitivity and Strength options accomplish this. In addition, you might want to shift the occurrences of the beat slightly ahead or behind the metronome beats in a particular track or section. The Grid Offset option allows you to do this.

Quantizing MIDI notes
When MIDI notes are quantized, they are moved from their original locations to the nearest grid location.

You can choose to change the attack times and/or release times of notes. There is an added option to leave the note durations unaltered. Choosing to
change attack times causes them to be moved to the nearest grid location; release times are left unchanged. Choosing to change release times causes them to be moved to the nearest grid location; attack times are left unchanged. Both of these operations cause an automatic change in note durations.

You can choose not to change the original durations. This prevents durations from being truncated, which may cause the notes to sound chopped.

Note that if you choose to change both the attack and release times, the *Don’t change note durations* option is automatically disabled. This is due to the nature of the operation: if you change both the attack and release times of a note, the durations will automatically be modified.

**Quantizing soundbites**
When quantizing soundbites, only their location is adjusted: their duration, and the beats within the soundbite, are not affected.

**Quantizing beats within soundbites**
For audio that has been beat-analyzed by Performer Lite’s Beat Detection Engine, quantizing beats within soundbites affects the beats without splitting up the soundbite into smaller soundbites. Instead, time-stretching is applied between beats to stretch and shrink them as necessary to move the beat to the nearest quantize grid location. For further details, see “Quantizing beats within soundbites” on page 408.

**Excluding soundbites**
If you don’t wish to affect soundbites at all with the Quantize operation, use the *Exclude Soundbites* option (Figure 40-12 on page 352).

**Custom edit filter**
Check the *Custom edit filter* option to display the additional options shown in Figure 40-12 on page 352.

**Including audio automation data**
If you wish audio effect plug-in automation data to move along with its associated soundbite when the soundbite gets quantized, check the *Move audio effect plug-in automation with soundbites* option (Figure 40-12 on page 352). This preserves the timing between a soundbite and any simultaneously occurring automation data affecting it.

This option also applies when quantizing beats within a soundbite: automation data affecting a certain beat will move with the beat when it is quantized.

**Quantizing MIDI controllers**
When quantizing MIDI controller data, you have two options:

*Move MIDI controller events with notes*
With this option, MIDI controller data moves along with its associated note when the note gets quantized. This preserves the timing between a note and any simultaneously occurring controller data affecting it.

*Quantize MIDI controller events to grid*
With this option, controllers shift their position to the nearest grid location, according to quantize options such as Sensitivity and Offset, just like
MIDI note attacks. Since controllers have no duration or release times, these options have no effect on controllers.

**Specifying the controllers to quantize**

When either of the two options for quantizing controllers are chosen, the filter check boxes shown in Figure 40-12 on page 352 let you choose which controllers to include and exclude. The *MIDI Controllers and Track Automation* list lets you further specify which types of controller and automation data you wish to include in the Quantize operation.

**Quantizing Conductor Track events**

When you choose the *Quantize MIDI controller events to grid* option (Figure 40-14), options for quantizing markers, tempo changes and key changes appear as shown. (Meter changes cannot be quantized because they define the grid itself by determining where the downbeat is.)

The grid value can be modified with the dot and/or tuplet boxes. When the dot is selected, it adds one half of the selected duration to the grid value. For example, if the quarter note and dot are selected, the grid value is a dotted quarter, equivalent to three eighths. If the tuplet box is selected, the tuplet specification is applied to the selected duration. Example: you have three eighth notes in the time of two specified and the tuplet box is checked.

![Figure 40-14: Quantizing Conductor Track events.](image)

**Choosing the grid’s duration value**

The grid value is the distance between grid locations. For example, if you select an eighth note as the grid value, each grid location is an eighth note apart. This means that the note attacks and/or releases will be moved to the nearest eighth note location.

The grid is aligned such that it begins on the first beat of the first measure of the selected region. If a meter change occurs in the selected region, the grid is realigned at the point of the meter change to begin on the first beat of the meter change.

Generally, you should choose a grid value that is the smallest note value in the region. For instance, if you are quantizing a region with lots of sixteenth notes and a few quarter notes, choose a grid value of a sixteenth note.

The grid value can be modified with the dot and/or tuplet boxes. When the dot is selected, it adds one half of the selected duration to the grid value. For example, if the quarter note and dot are selected, the grid value is a dotted quarter, equivalent to three eighths. If the tuplet box is selected, the tuplet specification is applied to the selected duration. Example: you have three eighth notes in the time of two specified and the tuplet box is checked.

The quantize grid will be set to triplet eighth notes. Each triplet grid location will have a duration of 160 ticks, which is equal to a third of a quarter note (480 ticks). To specify a tuplet grid value:

1. Select the base duration you want.
2. Click on one of the note symbols.
3. Check the tuplet check box.
4. Enter the number of tuplets in the left text box.
5. Enter the number of regular note values that the tuplet replaces in the right text box.

**Quantizing to SMPTE frames, real time or samples**

By clicking the time format button in the grid section (Figure 40-15), you can change the quantize grid to any time format, including SMPTE frames, real-time or samples. (This
The feature is available in many other MIDI effects, too.) In the example below, the grid has been set to one SMPTE time code frame:

Figure 40-15: Quantizing to a SMPTE grid, or any time format, including real-time or samples.

**Grid offset**

The start of the grid may be offset from its standard position on the first beat of the selected region by a number of ticks. This is done by clicking in the check box next to **Offset by n ticks** and entering a number of ticks to offset the grid by. Positive values offset the grid forward in time (after the beat), negative values offset it backward (before the beat).

If you enter an offset greater than the distance (in ticks) between grid locations, the number will be scaled down to be less than the distance of the grid value. For example, if you are using a grid value of a quarter note (480 ticks at 480 ppq resolution) and you enter an offset of 500 ticks, it will be reduced to an offset of 20 ticks, that is 500 minus 480. Offset values range from -9999 to 9999.

Figure 40-16: An example of quantizing with a positive or negative grid offset.

**Swing**

The **Swing** option delays every other grid point to create a swing feel.

The Swing option defaults to 100%, which produces straight swing. For example, an eighth note grid produces a grid point every 240 ticks. The swing option, at 100%, will delay every other grid point 80 ticks to 320, which is the attack time of the third eighth note in an eighth note triplet.

A larger percentage such as 120% would delay every other grid point to 336 ticks, creating a “loose” swing feel. A smaller percentage such as 80% would advance every other grid point to 304 ticks, creating more of a straight swing feel. The percentage can be any value between 0% and 300%. 0% does nothing and is the same as quantizing without the swing option. 300% delays every other offbeat all the way to the next grid point.

**Sensitivity**

Each grid location has a “field of effectiveness” in which note events can be moved by the Quantize command. Normally, this field extends from one grid location halfway to the next, affecting all note events. The center of each field is the grid location: each field actually extends out in either direction from the grid location.
Sensitivity is the size of this field. The default sensitivity (without the Sensitivity options selected) is 100%, i.e. extending continuously between grid locations. This field is actually split into 50% before the grid location and 50% after the grid location. If you select Sensitivity and enter a value of 50%, the quantizing field will be reduced:

![Figure 40-18: 50% Sensitivity reaches only part way (25%) on both sides of each grid location, as shown here by the gray regions.](image)

Note that 50% means 25% before the grid location and 25% after it (i.e. 50% of the way to the midpoint between grid locations). Any notes not in the field would not be quantized.

As illustrated, a positive Sensitivity value quantizes notes surrounding a grid location. In contrast, negative Sensitivity values quantize notes surrounding the midpoints between grid locations.

With positive Sensitivity values, the field of effectiveness extends outward from the grid location. In the case of negative sensitivity, the field extends inward from the midpoints on either side of the grid location. As with positive sensitivity, the field is split on either side of the midpoint. So if you enter a Sensitivity value of negative 20%, notes from about 41 to 50% before the grid location and about 41 to 50% after would be moved to the grid location:

What’s most important is the effect that different Sensitivity values will have on your music. To summarize:

- Positive sensitivities clean up the down beats without affecting ‘swung’ or freely played notes in between.
- Negative sensitivities catch major inaccuracies while retaining the music’s ‘feel’.

To use the Sensitivity option:

1. Check the check box next to the Sensitivity option.
2. Enter a number between -100 and 100 for the Sensitivity value.

**Strength**

Another way to preserve some of the rhythmic character of your music while making it more rhythmically accurate is to use the Strength option. Without any options chosen, Quantize will move all note events so that they align perfectly with grid locations. Since this can result in an overly precise effect, you might want to leave some of the original inaccuracy in the passage. The Strength option does this by not moving the note events all the way to the grid locations. Rather, they are moved a percentage of the way toward the grid points. Use the Strength option to tighten up a passage without losing its “feel”.

![Diagram showing field of effectiveness and direction of quantizing for -20% sensitivity.](image)
The Strength value specifies the amount that note events move toward grid locations when quantized. A Strength value of 100% (the default) moves them all the way to the nearest grid locations. A value of 0% leaves them where they are. A value of 50% moves them halfway to the grid locations.

Consider this example: there is a note event occurring at 10|3|450. The grid duration is a quarter note (at 480 ticks per quarter note), the Strength option is selected and a value of 40% is entered. When Quantize is okayed, the note will move to 10|3|462. If no strength option were selected, it would have moved to 10|4|000, a distance of 30 ticks. A Strength value of 40% moved it that percentage of the distance (40% of 30 ticks = 12 ticks) to 10|3|462.

To use the Strength option:

1. Click in the check box next to the Strength option.

2. Enter a number between 0 and 100 for the Strength value.

Randomize
Unlike all of the other Quantize options, which try to make notes more rhythmically precise, the Randomize option does just the opposite: it modifies the quantization randomly to make the notes as rhythmically imprecise as you like. 100% randomization causes note attacks (and/or releases) to be placed entirely randomly. A value of less that 100% reduces the range over which the notes will be randomized, and the grid point sits in the middle of the range. For example, if you choose a 16th note grid (a grid point every 120 ticks), and a randomize value of 50%, the range is 60 ticks, extending 30 ticks before and after each grid point. Thus, a note attack (and/or release) would be randomly placed within 30 ticks of its nearest grid point.

Figure 40-19: 50% Randomization on a 16th note grid produces a region of 30 ticks on either side of each grid point: notes will be placed randomly within this region around each grid point.

Emphasis
This sub-option causes the tendency of the randomization to be earlier or later within the specified range. Thus, if you wish to randomize the note placement within a certain range, but you wish to push the beat by tending to make the notes occur a little bit early, use a negative emphasis; use a positive emphasis if you wish them to tend to be laid back—that is, after the beat. A value of zero equals no emphasis, which causes the randomization to occur evenly within the range.

Hints for quantizing
If you’re trying to simply line up all notes with the beat and its subdivisions, selecting Attacks and Don’t change note durations will most likely yield the results you want. If you select both Attacks and Releases, all notes will begin and end at grid locations. This may make them too precise, sounding chopped, inhuman, or just wrong.
If you are trying to get the notes of a chord to line up to make the attack precise, consider using the DeFlam command on the Region menu instead of Quantize. It will line up the attacks but will not move the notes to a grid location.

If you want to quantize a region containing a mixture of sixteenth, eighth, and quarter notes which contains just two or three thirty-second notes, set the grid value to sixteenths for quantizing. You can subsequently change the thirty-seconds back individually. Otherwise, if you choose too small a duration value, many notes may move to undesirable locations. Choose a grid value that reflects the general rhythmic profile of the region in its most active, complex areas.

Performer Lite is very capable, but it can’t read your mind; you’ll find that there are some notes that just don’t get moved to the locations you want them to be. This is due to the original location of the note not being within the quantize field for the desired grid location. The quickest way to fix this is to change them individually in the Sequence Editor.

You can use the Offset command to do some very fancy quantizing that may not, at first glance, even seem like quantizing. For example, suppose you’ve just entered your sequence in 4/4 time and you decided that you’d like to make notes that fall on the third beat of every measure slightly late. First, set the grid value to the whole note. Grid locations will occur only once per measure, on the first beat. Choose the Offset option and enter a value of 980 ticks. Since 960 ticks constitute one half note (at 480 ppq), 980 ticks is 20 ticks after the third beat. Now choose the Sensitivity option and enter a value of 20%. This limits quantization to those notes near the third beat already (if you didn’t use the Sensitivity option, all notes would end up quantized to the third beat). You may have to experiment with the percentage. Use a larger percentage if some notes don’t get quantized that should; use a smaller percentage if some notes get quantized that shouldn’t.

The Offset option was not designed for the mass shifting of notes in a region. If you want to move a section of your sequence forward or backward in time, use the Shift command on the Edit menu.

**GROOVE QUANTIZE**

Performer Lite’s Groove Quantize feature is easy to use and — from a creative standpoint — one of Performer Lite’s most enjoyable features.

This section tells you how you can do the following:

- Use the Groove Quantize command to control the rhythmic depth and “feel” of your music
- Dynamically adjust the feel of grooves with faders while applying them
- Use Groove Quantize to apply the rhythmic feel of audio or MIDI tracks to other audio or MIDI tracks
- Create your own grooves, of any length, from any music you have recorded into Performer Lite or loaded from a standard MIDI file
- Extract grooves from audio files that have been beat-analyzed with Performer Lite’s Beat Detection Engine and then apply it to other audio or MIDI tracks
- Extract a groove from MIDI data and apply it to other audio or MIDI tracks
- Build a groove database from which you can instantly call up any groove you have created

**Groove Quantizing audio**

Groove quantizing has the ability to affect the timing of beats within soundbites for any audio that has been beat-analyzed with Performer Lite’s
Beat Detection Engine. For details, see “Applying a groove to beats within soundbites” on page 409 and “Extracting a groove from audio” on page 409.

**What is a groove?**
In musical terms, a groove is a unique rhythmic feel. Many artists are famous for a certain feel—or groove—in their music that makes their sound unique.

Performer Lite’s Groove Quantize feature gives you complete reign over this important aspect of your music.

The effect of adding a groove to an otherwise mundane track can be stunning: the music instantly feels like it has a third dimension, and the sensation can be similar to that moment when you put on 3-D glasses in an old 3-D movie. Sometimes, the effect is subtle. Often, however, you’ll find that a groove completely transforms music, making it sound totally different from its original form.

**The elements of a groove**
To master grooves, it is important to recognize the musical elements of a groove. A groove is generated by variations in the timing, accent, and duration of the notes being played. This is true for either MIDI data or audio data. In Performer Lite, a groove consists of a combination of the following elements:

- A quantize grid that affects the timing of notes (attacks only)
- A note-on velocity map
- A note duration map
- A meter
- A length (in measures)
- An overall beat subdivision

For example, a swing groove is usually based on a swung 8th note beat subdivision. If it’s a hard swing, the eighth-note offbeats may be played quite late. The durations of the notes in such a groove tend to be longer, and the velocities emphasize the offbeats. The length of the groove is usually two measures, and it is often in 4/4 time.

When you apply a groove to some MIDI data in a track, the selected notes are modified according to these groove parameters.

**Applying a groove**

To apply an existing groove:

1. Use Performer Lite’s Memory Cycle feature to cycle playback over the region you wish to apply the groove to.
2. Start playback.
3. Select the data you wish to apply the groove to. Make sure that what you select is within the region Performer Lite is currently looping. If you don’t, you won’t be able to audition the groove before applying it. Use any method of selection that you prefer. You can select individual notes or an entire region of data. The groove will be applied at the measure boundaries of the region you select.
4. Choose Groove Quantize from the Region menu, or press command-G.

The Groove Quantize window appears.
5 Open one of the Groove files (or folders) in the list by either double-clicking its name or by clicking its name once and clicking the open button.

You now see a list of grooves stored in that groove file.

6 Select the desired groove by clicking its name.

If the *Instant Preview* button is checked and Performer Lite is playing back the region you selected, you’ll hear the effect of the groove right away. You can audition as many grooves as you want without permanently applying one.

- **Instant preview** does not affect beats within soundbites when Groove Quantizing audio.

7 If you’d like to adjust the feel of the groove, click the *Edit* button.

This option is discussed further later on in this chapter.

8 If you’d like MIDI controllers and audio automation data to move with its associated MIDI notes or audio beats, click the *Move Controllers and Automation* button.

This option is discussed below.

9 To apply the groove, click *Apply*.

**Instant preview**

When the Instant Preview button in the Groove Quantize window is checked, you can preview grooves being applied to MIDI data without having to click Apply to apply them. This lets you quickly scan through a list of grooves, auditioning each one until you find one you like. To apply it, click Apply. When Instant Preview is unchecked, you won’t hear the groove until after you click Apply.

- **Instant preview** does not affect beats within soundbites when Groove Quantizing audio.

**Move Controllers and Automation**

When the *Move Controllers and Automation* option is enabled, MIDI controller data or audio automation data will move together with its associated MIDI notes or audio beats when they are moved by the Groove Quantize command. This helps preserve the effect the controller and automation data has on the notes and audio beats.

**The Recent Files menu**

The Recent Files menu is provided for your convenience. It lets you go directly into recently opened groove files.
The groove quantize sliders
A unique and powerful feature, the groove quantize sliders (Figure 40-20 on page 360) let you adjust the degree to which the groove is applied—in essence, they let you “turn up” or “turn down” the groove. For more information, see “Adjusting groove parameters when applying a groove” on page 361.

Locating a groove
The groove list works like a standard open dialog box. Use it as usual to locate grooves.

Renaming grooves
To rename a groove, option/Alt-click its name in the Groove list to edit the name.

Deleting, moving, and duplicating grooves
Grooves can be cut, copied, and pasted in the Groove Quantize window. This allows you to delete them, move them from one file to another, and duplicate them.

Duplicating is useful because you can make a copy of a groove and then make adjustments to the copy, which preserves the original.

To do any of these operations, you first open the Groove Quantize window. To do so, select some data or a region and choose Groove Quantize from the Region menu. Locate the groove, and then do one of the following desired operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>How to do it</th>
</tr>
</thead>
<tbody>
<tr>
<td>To delete a groove</td>
<td>Click it in the list to select it and choose Cut from the Edit menu.</td>
</tr>
<tr>
<td>To move a groove from one file to another</td>
<td>Cut it (as described above), open another groove file using the menu above the list, and choose Paste from the Edit menu.</td>
</tr>
<tr>
<td>To duplicate a groove</td>
<td>Click it to select it and choose Copy from the Edit menu. Then choose Paste from the Edit menu. After pasting, rename the copy to differentiate them.</td>
</tr>
</tbody>
</table>

Where grooves are stored
Grooves are stored in Performer Lite groove files. You can store as many grooves as you want in a groove file. You can create as many groove files as you want. The only requirement is that groove files must be placed in a folder called “Grooves”, and this folder must be placed here:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS</td>
<td>/Library/Application Support/MOTU/Performer Lite/Grooves</td>
</tr>
<tr>
<td>Windows</td>
<td>C:\ProgramData\MOTU\Performer Lite\Grooves</td>
</tr>
</tbody>
</table>

This is all taken care of for you when you first install Performer Lite, so, unless you have moved the folder, you don’t need to worry about it.

When you create your own groove files (discussed later), we recommend that you organize them by category as shown above. This will make it easier to locate grooves.

Notice that you can further organize your groove files by placing them in folders (as long as they remain inside the Grooves folder). You can even place Mac alias files or Windows shortcuts in the Grooves folder and place the actual groove files somewhere else on your hard disk.

Adjusting groove parameters when applying a groove
When you apply a groove, Performer Lite allows you to adjust groove parameters without permanently altering the groove itself. For example, you can “turn up” the degree to which velocities are affected without changing the original velocity map in the groove. To permanently edit the groove see “Modifying grooves” on page 365.
To adjust groove parameters while applying a groove:

1. Use Performer Lite’s Memory Cycle feature to cycle playback over the region you wish to apply the groove to.

2. Start playback.

3. Select the data you wish to apply the groove to. Make sure that what you select is within the region Performer Lite is currently looping. If you don’t, you won’t be able to audition the groove before applying it. Use any method of selection that you prefer. You can select individual notes or an entire region of data. The groove will be applied at the measure boundaries of the region you select.

4. Choose Groove Quantize from the Region menu.

5. Select the groove you wish to apply from the list.

6. Make sure the Instant Preview check box is checked so you get instant feedback while adjusting the groove.

7. Adjust the groove as desired with the sliders.

These sliders are discussed in the following section.

- Instant preview does not affect beats within soundbites when Groove Quantizing audio.

8. If desired, try different beat divisions by choosing them from the beat division menu.

Changing the beat division often has a dramatic effect on the feel of the groove. This is discussed further in a following section.

9. When you like the groove, click Apply.

**Using the groove adjustment sliders**

The three groove adjustment sliders give you complete control over the feel of a groove. They let you dynamically control the degree to which the timing, note-on velocities, and durations are affected. All three sliders apply to both MIDI data and beats within soundbites.

- When you move a slider, the change occurs when you let go of the slider (as long as the Instant Preview check box is checked). No changes occur while you move the slider.

In essence, these sliders let you control the extent to which you are applying the original feel of the groove. You can either “turn up” or “turn down” its effect. We urge you to experiment with them because they produce interesting effects. The sliders perform as follows:

<table>
<thead>
<tr>
<th>Groove slider setting</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off (0%)</td>
<td>Velocities and durations are unchanged. For timing, a straight grid quantize is applied.</td>
</tr>
<tr>
<td>Full (100%)</td>
<td>Applies the exact feeling of the groove.</td>
</tr>
<tr>
<td>Double (200%)</td>
<td>Groove feeling is exaggerated by a factor of 2.</td>
</tr>
</tbody>
</table>

You can clearly hear the effect of one slider by setting the other two sliders to their *off* position and then trying different strengths on the remaining slider.

One effective approach with these sliders is to set them all to *off* (0%) and then increase each one in small increments. Use the up (+) and down (-) arrow buttons to make small adjustments. This lets you gradually apply the groove to a point that sounds best.
**Auditioning groove settings**

Groove Quantize lets you adjust the sliders without affecting the settings that are currently saved with the slider. The same goes for the Beat Division menu. In addition, you can quickly audition a number of different grooves with the same settings (because the settings won’t change when you select a new groove). For example, if you like the degree of groove you’ve set with the sliders, but you aren’t quite satisfied with the type of groove yet, you can try several other grooves with the same slider settings.

If you’ve auditioned sliders settings and wish to now save them, click **Save**.

**Saving groove settings with a groove**

Click **Save** to apply the current slider and beat division settings with the currently selected groove. Click **Revert** to restore the grooves default settings.

**Using different beat divisions**

The beat division menu lets you choose an underlying quantize grid for the groove. Divisions range from eighth notes to 32nd notes in both straight and triplet time; several combination grids are also provided. See “Choosing a beat division” on page 364 for more information.

This menu allows you to try different beat divisions without losing the original beat division in the groove. For example, you can try applying an 8th-note division to a groove with a 16th triplet beat division. The original beat division is displayed as shown below:

Notice that a groove can have more than one original beat division, and each original beat division can have its own unique settings. This can be accomplished by editing the groove. See “Adding an additional default beat division to a groove” on page 366 for more information.

The beat division menu is governed by auditioning and saving (See “Saving groove settings with a groove” on page 363.) For example, if you have a bunch of grooves that were created in 16th note divisions, but the particular section you are applying the groove to right now is in triplets, you can set the beat division menu to triplets, and leave it there as you audition groove after groove.

The beat subdivision has a dramatic impact on the groove. Try experimenting with different choices.

Grooves usually sound closest to their original feel with the beat division at which they were created.
CREATE (EXTRACT) GROOVE

The Create Groove command lets you create your own Grooves from MIDI note data in any track, or beats within soundbites that have been beat-analyzed by Performer Lite’s Beat Detection Engine. The source material can come from any Performer Lite file, any standard MIDI file or any beat-analyzed audio file or loop. Grooves can be any length.

Extracting grooves from audio

Audio data must be beat-analyzed before you can create a groove from it. For details, see “Extracting a groove from audio” on page 409. After audio has beats, the procedures below can be used to create grooves from the audio.

Creating a groove

To create a groove:

1. Select the MIDI or audio data you wish to use as source material for the groove.

The groove will start at the beginning of the first measure of your selection, and its length will be a whole number of measures.

When you choose MIDI data for a groove, the data must be aligned with Performer Lite’s metronome (main counter). For example, you can’t use a rubato passage, unless you first use the Record Beats feature to align Performer Lite’s measure and beat boundaries with the music. For audio data, however, the groove can be extracted from any audio file that has been beat- and tempo-analyzed, even if it does not currently match Performer Lite’s main time ruler.

2. Choose Create Groove from the Region menu.

The Create Groove window appears.

3. Open a groove file in which to save the groove, or create a new groove file with the New File button.

4. Type in a name for the groove.

5. If desired, change the meter for the groove. This setting affects the overall length of the groove, and it also affects how many beats are in each measure. Try to choose a meter that most closely resembles the beat structure of the groove you are creating.

6. Choose a default beat division for the groove from the menu.

See “Choosing a beat division” below regarding this option.

7. Click OK to save the groove.

The new groove gets added at the bottom of the groove list.

Choosing a beat division

The choice you make for a beat division when creating a groove is an important one, for it governs the underlying resolution of the quantization that occurs when you apply the
groove. The choices range from eighth notes to 32nd notes in both straight and triplet time; several combination grids are also provided.

As a rule of thumb, when you choose a beat division, think of how the music is notated, and use the shortest note duration that would be used to notate it. For example, a swing feel is customarily written as straight eighth notes. So when you are choosing a beat division for a swing groove, use a straight eighth note grid.

If the groove style you are defining has both a straight and triplet feel, use the appropriate combination grid (the straight and triplet options at the bottom of the menu, as shown below). For example, swung music often includes straight sixteenths, so you’d choose a triplet eight/sixteenth combination.

Keep in mind, however, that the combination grid has beat divisions for both straight time and triplet time, so there are more grid points. If the music you apply the groove to is not rhythmically accurate to begin with, there is more of a chance that notes will gravitate to the wrong grid point. For this reason, use discretion when applying combination grids. In some cases, it might be better to use a non-combination grid. When in doubt, you can make two versions of the groove: one with a combination grid and another with a straight or triplet grid.

**Modifying grooves**

Performer Lite provides you with the ability to modify the timing, velocity, and duration information in the groove itself. Fortunately, you can do so quickly and easily, without having to switch files. To modify a groove, click the groove name in the Groove Quantize window and click the Edit button to open the Groove Editor shown below in Figure 40-22.

![Groove Editor](image)

**Combination beat divisions**

- Eighth Notes
- 16th Notes
- 32nd Notes
- Eighth Triples
- 16th Triples
- 32nd Triples
- 8th to 16th
- 8th Triplets & 8th
- 16th Triplets & 26th

Figure 40-22: The Groove Editor.
Edit each beat division as desired. If Instant Preview is enabled, and you are looping a section to hear your changes, you’ll hear them right away as you make them. Here is a summary of what to do in this window.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase or decrease a velocity</td>
<td>Drag it up or down</td>
</tr>
<tr>
<td>Adjust note placement earlier</td>
<td>Drag the note placement bar to the left or right</td>
</tr>
<tr>
<td>Increase or decrease a duration</td>
<td>Drag the right side of the duration icon left or right (0 - 200%)</td>
</tr>
</tbody>
</table>

Duplicating a groove before modifying it to preserve the original
The groove editor makes permanent changes to the groove (unlike adjusting the groove sliders, which doesn’t affect the groove data itself). As a result, if you want to modify a groove but preserve the original, duplicate the groove and then edit the copy. To duplicate a groove, see “Deleting, moving, and duplicating grooves” on page 361.

Adding an additional default beat division to a groove
A groove can have several default beat divisions (as shown in the menu on page 363). This lets you produce several permanent variations of the groove within the groove itself. To do so, select a non-default beat division from the beat division menu in the Groove Quantize window right before you click the Edit button. Doing so lets you modify the groove based on the newly selected beat division. The modifications you make to the groove in the editor will be unique to that beat division; you won’t affect the groove with its original beat division setting. When you click OK, the beat division you chose will become outlined, and you’ll be able to freely change between the two groove variations simply by selecting the outlined beat divisions in the beat division menu.

Obtaining grooves
There are many ways to obtain grooves. You can:

- Use the stock grooves provided with Performer Lite
- Create new grooves from scratch in Performer Lite
- “Cop” grooves from any Performer Lite file, standard MIDI file, audio file or audio loop
- Purchase commercially available loop libraries (such as REX files, ACID files, Apple Loops, etc.) and create grooves from the audio in them
- Purchase commercially available groove libraries

Commercially available MIDI groove libraries are similar to sample libraries; they have been painstakingly produced in the recording studio.

MIDI grooves are similar to digital sampling in the sense that they present us with similar copyright issues. If you cop someone’s groove using Performer Lite’s Create Groove feature, consider handling it in the same fashion as you would for samples.

Cubase grooves
Performer Lite can read Cubase groove files if they are placed in Performer Lite’s Grooves folder. They appear in the Groove Quantize list with a different icon along with all of your Performer Lite groove files. They can be used in the same fashion as Performer Lite grooves.

Cubase grooves can be viewed in Performer Lite’s Groove Editor, but they cannot be edited directly. To edit them, first move them into a Performer Lite groove file using the Copy and Paste commands in the Edit menu (see “Deleting, moving, and duplicating grooves” on page 361).
Applying the groove from one track to another
To apply a groove from one track to another, create a new groove based on the original track. After you have created the groove, you can apply it to any other track you wish using the Groove Quantize command. The Groove you create can be of any length.

DEFLAM
The DeFlam command looks for groups of MIDI notes that are very close together. When such a group is found, the average attack time of the group of notes is computed. All notes in the group are moved such that their attack times are aligned exactly to the average time.

DeFlam basics
When chords are played in real time, the attacks of individual notes are often splayed as in the example below, which shows two four-note chords:

DeFlam is useful for consolidating the attacks of the notes in such chords. The following is the result of using DeFlam with a tick value of 50 on the above passage:

DeFlam attempts to detect grace notes and rolled chords and, if found, will leave them as such.

Using DeFlam
If DeFlam leaves some notes out, try using a larger tick value; if it includes too many notes, try decreasing the tick value. (Remember, you can Undo and Redo the DeFlam command.) The correct tick value depends greatly on the particular passage you are working with. It may take several attempts to determine the correct value.

CHANGE VELOCITY
Change Velocity is a powerful command that lets you modify the velocities of all MIDI notes in a region on a scale from 0-127. You can remove irregularities, make passages louder or softer and create crescendos, diminuendos and other similar effects. Note that not all MIDI instruments respond to velocity data, and those that do may need to be set up to respond correctly to this information. Consult your owner’s manuals for details.

The Change Velocity window provides a menu with numerous options. These options are explained briefly in the following sections.

Change Velocity has no effect on audio.
On velocities or off velocities

On velocities control the speed at which a note is attacked. This affects the note’s loudness most dramatically, but on velocities can also affect other aspects of the note event such as its timbre (e.g. the harder the note is struck, the brighter it sounds). Off velocities control the speed of the release of the note and are sometimes used to control its decay rate. Not all MIDI instruments utilize off velocity information.

The Change Velocity command can be applied to either on or off velocities: choose the type you wish at the top of the window. The default setting changes the on velocities.

Set

This option sets all velocities in the selected region to a single value. Enter a value between 1 and 127. A result of this option is that all note events in the region will be played back at a constant volume.

Add

This option adds the value you enter to all velocities in the selected region. The value must be in the range -127 to 127. Velocities that end up less than 0 or greater than 127 will be set to zero or 127, respectively. A result of this option is a uniform increase or decrease in volume of all notes in the region, within the zero to 127 range.

Scale

This option scales all velocities by the percentage value you enter. Percentage values must be between 1 and 999. For example, if all notes in the region have a velocity of 120 and you enter a percentage value of 50%, the velocities will be set to 60. Thus, to halve velocities, use a value of 50%. To double them, use 200%. Velocities that end up less than 0 or greater than 127 will be set to zero or 127, respectively.

Limit

This option modifies all velocities in the selected region that have a velocity greater than the value you enter, by changing them to that value. Enter a value between 1 and 127. This option imposes a maximum volume level on all notes in the region. You can use it to change the velocities of notes that “stick out”.

Compress/Expand

This option works just like an audio compressor or expander: it reduces or expands the velocities above the threshold you specify by the compression ratio you specify, and then adds any gain that you specify with the gain control. The graph shows a visual display of the current compression settings on a 128 x 128 grid, so you can see exactly how velocities from 0 to 127 will be affected.

Expansion multiplies velocities by the ratio that you choose. Compression divides them. Velocity expansion or compression can be useful in many
situations. For example, if you change the patch for a track, the new patch may have different velocity response characteristics than the original patch, and as a result, the track may not sound as expressive. By applying expansion to the note velocities, you can restore—or even magnify—the original expressiveness of the track. Ratios up to 1:8 are offered.

**Smooth**
This option has two basic sub-options: ____% to ____% of current value and ____ to ____. Each gives you a different way to specify the smooth velocity changes. The first changes by percentages, creating a smooth velocity change for notes in the selected region while preserving some of the original velocity characteristics (most notably the accents); the second creates a smooth change with no fluctuations. You can specify a curvature for the change, which determines its contour.

____% to ____% of current value: This sub-option changes velocities similarly to the Scale option described above. The difference is that the percentage value changes from the first to the second entered value: the first value applies to the beginning of the region, the second to the end. Enter a value from 1 to 999 in each box. The curvature (see below) controls the contour of the change.

____ to ____: This sub-option assigns the first entered value to the first note velocity in the selected region and the second entered value to the last note velocity in the region. All other velocities are calculated to make a smooth transition between the first and last ones. The curvature (see below) controls the contour of the change over the region.

_Curvature:_ This sub-option controls the contour of the smooth change. With a curvature of zero, the change is linear from the first to the second entered value. As you increase the value positively (with values from 1 to 99), more of the change will take place towards the end of the region. As you increase the value negatively (with values from -1 to -99), more of the change will take place towards the beginning of the region.

Here are a few examples to clarify this option:

![Figure 40-25: Change smoothly from 1 to 90, curvature 0. This results in a linear increase. One effect of this is a gradual, even crescendo.](image1)

![Figure 40-26: Change smoothly from 10 to 90, curvature -50. This results in a pronounced upward curve with most of the changes happening at the beginning. One effect of this is a crescendo that occurs more rapidly at the beginning.](image2)

![Figure 40-27: Change smoothly from 96 to 5, curvature 45. This results in a downward curve which is more pronounced at its end, e.g. a diminuendo that speeds up toward its end.](image3)
Figure 40-28: Scale smoothly from 100% to 1%, curvature 0. When applied to a region in which there are several notes accented, this results in a downward “curve”, which retains the accent structure of the original.

The velocity values assigned to notes by this option are calculated based on the distance of the note from the beginning or end of the selected region. If the first note in the region is after the start time, for instance, it will be assigned a velocity value somewhere between the values entered. Notes in a chord (with simultaneous attacks) are assigned the same velocity. If a specific change sounds too abrupt, it is probably due to the position of the note in the region. For instance, if notes occur at irregular times (e.g. bunched together followed by a sparse section), velocities will be assigned on the basis of note placement. The result may not seem smooth on a per-note basis.

**Randomize**

The randomize option allows you to randomize the velocities within a range of the current value, which you specify in the box provided. The emphasis sub-option causes the tendency of the randomization to be higher or lower within the specified range. Thus, if you wish to randomize the velocities within a certain range, but you wish them to tend to be higher, use a positive emphasis; use a negative emphasis if you wish them to tend to be towards the lower end of the range. A value of zero equals no emphasis, which causes the randomization to occur evenly within the range.

Note that the randomize option is a check box, which means that it can be selected together with one of the radio button options above. This allows you to randomize at the same time as executing one of the other Change Velocity options.

**The effect of velocity is instrument-dependent**

MIDI instruments vary widely in their response to velocity information. Some do not respond at all to any velocity information; many do not respond to off velocities. Some patches sound very different when large on velocity values are used. Some patches do not respond at all to velocity information, even when the instrument as a whole does.

Most often, you can be assured that if your instrument does respond to velocity information, you can control the loudness of note events. You should be able to create effective crescendos and diminuendos. This will work well for short-range dynamic effects. For longer effects (a 30 second fade, for instance), you might notice a “staircase” effect, i.e. discrete changes in the volume level.

**Alternative methods for volume changes**

Some MIDI instruments define one of the MIDI controllers as the volume control. If so, you might be able to use the Insert Continuous Data command to create smooth volume changes with a controller. Some instruments have only a few discrete volume levels, making it hard to create smooth changes.

It is also possible with some instruments to control volume directly from an assignable controller. A patch may use the breath controller to control its
volume, for instance. By sending this controller data through Performer Lite, you can control volume changes.

There is no single solution for making volume changes effectively with every patch on every instrument. You must find the best way for each given situation and use the appropriate command (Change Velocity or Insert Continuous Data) to create the kind of volume changes you want.

**CHANGE DURATION**
The Change Duration command modifies the duration of all MIDI notes in the selected region without changing the placement of attack times. This means that the amount of time a note is “on” or sounding can be changed without affecting its actual rhythmic placement in relation to other notes and events. The Change Duration command is useful for changing the articulation or space between notes. You can make note events sound connected or separate in relation to each other, for example.

![Change Duration](image)

**Changing the duration of soundbites**
The Change Duration command does not affect soundbites. To change the duration of a soundbite, trim it as explained in “Trimming (edge editing) soundbites” on page 312. To stretch it, see “Graphic time stretching of audio” on page 314 or “Scale Time” on page 379.

**Change Duration basics**
Duration is the length of a note, i.e. the time between its attack and release. Durations are specified in quarter notes and ticks (e.g. a half note would be 2|000 or two quarter notes). A note must have a duration of at least one tick (0|001).

A note’s duration may be misleading in some cases: what you see might not be what you hear. The actual duration of a note event is dependent upon the MIDI instrument and patch used. The attack and release sent by Performer Lite are equivalent to manually pressing and releasing a key on the instrument. Also, some instruments have a sustain pedal that can be used to hold notes, extending the effective duration of notes far beyond the time when the release has been sent to the instrument.

**Set**
All durations in the selected region will be changed to the entered value. The value entered must be between 0|001 and 9999|999.

**Add**
The value entered will be added to all durations in the selected region. The value entered must be between 0|001 and 9999|999.

**Subtract**
The value entered will be subtracted from all durations in the selected region. The value range is 0|001 and 9999|999. Notes which would have a duration of less than one tick after the subtraction are given a duration of one tick.
Scale
The durations of notes in the selected region are scaled by the entered percentage value. The relative lengths of the notes are preserved and their overall length is modified. The percentage value entered must be between 1 and 999. To halve durations, enter a percentage value of 50%; to double durations, use 200%. Using this option may yield more of the results you want than using the Add __ to all option; durations are scaled proportionally instead of uniformly lengthened. Try both to see which you like best.

Limit
Any notes in the selected region which have a duration greater or less than the values entered will be assigned to the longest and shortest value you specify, respectively. The value entered must be between 0|001 and 9999|999.

Move releases (to closest attack)
The release of each note in the selected region is modified to occur just before the attack of the nearest note following it in time. The duration of the note may increase or diminish depending on when the next note occurs. If the next note occurs before the release of the current one, the release of the current note will be moved back in time, making the duration shorter. If the next note occurs after the release of the current one, the release of the current one will be moved forward in time, making the duration longer. If the note release is after the end of the selected region, the note is left unmodified. This option creates a legato effect, where the notes follow each other smoothly and without a gap.

Extend releases (to the closest attack)
The duration of each note in the selected region is extended until it ends at the same time as the next note begins. This is very similar to the Move releases to the closest attack option but the durations of all notes are guaranteed to increase since the release is always moved forward in time. Any notes which end after the last note in the selected region begins are left unmodified.

This option creates a legato effect, where the notes follow each other smoothly and without a gap.

Extend Releases sub-options
Use these sub-options to extend releases and still preserve rests in a region. If both sub-options are checked, each note in the region is analyzed and the option that results in the smallest duration increase is used. Try using these options after quantizing attacks and releases to improve the notational display of the notes. Doing so adjusts the durations of notes that were not played in a
legato style. For best results, experiment with different values. A good setting to start with is 100%.

**Randomize**
The randomize option allows you to randomize durations within a range of the current duration, which you specify in the box provided. This range can be specified as an absolute number of ticks, or by a percentage of the current duration. The emphasis sub-option causes the tendency of the randomization to be higher or lower within the specified range. Thus, if you wish to randomize the durations within a certain range, but you wish them to tend to be longer, use a positive emphasis; use a negative emphasis if you wish them to tend to be shorter. A value of zero equals no emphasis, which causes the randomization to occur evenly within the range.

Note that the randomize option is a check box, which means that it can be selected together with one of the radio button options above. This allows you to randomize at the same time as executing one of the other Change Duration options.

**Hints**
Some drum machines cannot receive dense bursts of MIDI data; they will often miss data altogether, causing drop-outs and other perplexing problems. Since the durations of drum machine events tend to be very short, the note releases tend to follow the attacks very quickly resulting in a very high data density. One way to improve the situation is to delay the note releases (most drum machines ignore these anyway since their note events have such short decays) by making the note durations longer. Use the Change Duration command to set the durations of these note events to a value somewhere around 10 to 20 ticks.

**Using Change Duration to control articulation**
The Change Duration command is very good for adjusting the articulation of note events. Rendering a passage legato or staccato is simple: for a legato effect (each note releasing just before the next one is attacked):

1. Select the region.
2. Choose *Change Duration* from the Region menu.
3. Choose the *Set* option.
4. Enter a value of 1 tick (0|001) and press Apply. This insures that durations are uniform for the next step.
5. Choose *Change Duration* from the Region menu.
6. Choose the *Extend releases* option and press the Apply button. This is useful for removing any rests or gaps between notes.

For a staccato effect (each note releasing well before the next, giving the passage a rhythmically sharp, incisive character):

1. Select the region.
2. Choose Change Duration from the Region menu.
3. Choose the *Scale* option.
4. Enter a value of 50% and press the Apply button.
SPLIT NOTES
The Split Notes command lets you selectively cut or copy notes in the selected region. The selection is based upon pitch, velocity and/or duration. This means that only notes with specific pitches, ranges, durations and velocities from the selected region are cut or copied. For example, all notes between A3 and C#3 with velocities greater than 100 and with durations above a half note can be extracted from a region. Here are some additional things you can do with Split Notes:

- Use an on-screen graphic keyboard to specify the pitches of notes you wish to split. This keyboard allows you to pick a non-contiguous range of pitches for splitting.
- Automatically Paste or Merge the split notes to a pre-existing track.
- Automatically create a new track and Paste the split notes to it.
- Automatically create a set of new tracks and paste the split notes to each track according to pitch.

Split Notes can be used to split a drum track into separate tracks, extract or double a melody line, separate one keyboard part into two parts to segregate right and left hand activity, pick out and double accented or long tones, and much more.

Split Notes basics
Split Notes is a highly specialized version of the Cut and Copy commands on the Edit menu. Only notes in the selected region and with specific properties are affected, other events are not affected. Each note is tested to see if it meets the requirements you specify, including velocity, pitch, and duration. They are then placed in a destination you select, such as the Clipboard or a new track. If cut, they are removed from the selected region.

The Split Notes window remembers the settings you last chose.

Cut or Copy
If you choose the Cut option, the Split Notes command will place the selected notes on the Clipboard and remove them from the selected region. If you choose the Copy option, the Split Notes command will place the selected notes on the Clipboard without removing them from the selected region.

Send notes to
You have several choices here. Select the Clipboard option to place notes on the Clipboard (for the purpose of pasting afterwards). Select the One track option and select a track name from the menu to send the notes to one existing track. Select the One new track option and type in a name or use the default name to send the notes to a new track that will be added to the bottom of the Sequence Editor. Select the Separate tracks by pitch option to remove the notes by pitch and place them into new, individual tracks. Each new track will contain the pitch name in parentheses after the track name. The track name used for this option can be entered in the One new track option text entry box above. This last option is ideal for splitting up a drum track into separate tracks.
Paste or Merge
These options let you choose whether you would like the split notes to be pasted at their destination, which replaces what is already there, or merged together with what is already there.

All Notes
All notes will be cut or copied unless excluded by velocity or duration selections. Use this mode when you wish to cut or copy notes based solely on velocity or duration criteria.

Range of Pitches
All notes between the two entered pitch values will be cut or copied. The pitch range is inclusive (it includes the two entered pitch values and all notes between them). You must enter a pitch in each box for this option.

You can enter pitch and velocity values directly from your MIDI keyboard. The note you play will be entered directly into the value box which contains the flashing text cursor or is highlighted.

Top ____ notes
The specified number of notes from the top of each chord are cut or copied. A chord is defined as two or more notes which have the same attack times. If single notes are encountered (i.e. not in chords), they alone are copied to the Clipboard. It is useful to use the DeFlam command on the Region menu to make sure that attack times of all chords line up before using this option. Enter the number of notes to be cut or copied from the top of each chord in the box for this option.

Bottom ____ notes
This option is similar to Top ____ notes except that the notes are cut or copied from the bottom of each chord.

Select notes
Click keys on the keyboard to select and deselect specific pitches. Click Clear Keyboard to clear the currently selected pitches on the keyboard. Use the scroll bar and scroll arrows to select pitches that are above or below those pitches which are currently displayed. You can also play keys on your MIDI keyboard (or other controller) to select and deselect specific pitches.

The Select notes keyboard remembers the selected notes even when those notes are scrolled to the left or right and are not displaying. When you open the dialog and want to select some pitches on the keyboard and are not sure if there are selected notes above or below the pitches that are currently displayed, click Clear Keyboard to be sure that notes that are not displayed are also not selected.

The following are velocity and duration options that can be selected in addition to pitch options.

Durations
Notes in the selected region with durations within the specified range are cut or copied. You must enter two durations in the boxes from 0|001 to 9999|999. The duration range is inclusive (it includes the two entered values and all those between them).

On velocities
This option, when selected, allows only notes with the specified velocity range to be cut or copied from the selected region. You must enter two velocities (between 1 and 127) in the two boxes. The velocity range is inclusive (it includes the two entered values and all those between them).

Off velocities
This mode is similar to the On velocities mode except that notes with off velocities in the specified range are cut or copied.

Hints for using Split Notes
The Split Notes command by itself is not always completely useful: it can be used in conjunction with other region commands and operations to fully accomplish an editing task. We therefore
have included some effective ways to use the Split Notes command as part of more complex operations.

**Splitting up a drum part into separate tracks**

You can use the *Separate tracks by pitch* option in combination with the *Select notes* option to quickly explode tracks such as drum parts into separate tracks so that each pitch can be treated uniquely. This is great for being able to shift, quantize and otherwise edit a certain percussion instrument without affecting others.

**Using a temporary track**

You can process data independently that is cut or copied with the Split Notes by pasting it into another track. You can perform various operations on the data in the temporary track (transpose, velocity editing, etc.), then merge it back into the original track and delete the extra track.

**Extracting a lead line**

Extracting the lead line from a passage (perhaps from block chords where the top notes of each chord form a melody) can be easily done with the Split Notes command. After the lead line is separated from the chords, it can be modified (doubled, accented or otherwise enhanced) in an extra track.

**Enhancing a lead line**

After you have the lead line separated out, you can change it in useful ways. Two suggested enhancements are doubling it an octave higher and increasing its velocity values. After you have made the modifications, you can merge the enhanced lead line back with the original material.

A variation on the operation to double the lead line an octave higher is to double the bass line an octave lower. Use the *Bottom ___ notes* option and transpose it down an octave with the Transpose command.

Some variations on the operation to increase the velocity values of the lead line are as follows:

Make the notes of the chords softer (by decreasing their velocities) instead of the making the lead line louder. This would involve modifying the notes of the chords after you extracted the lead line from them and merging the (unaltered) lead line back with the modified chords.

Use the *Change to ___% of current value* option in the Change Velocity window rather than adding a constant value to the lead line. This better preserves the dynamic contour of the lead line.

Leave the lead line on a separate track and play it back through another MIDI instrument as well as on the instrument playing back the chords. This highlights the lead line through timbral or tone color means.

**Doubling accented notes**

Another procedure is to split out only those notes which have a higher velocity in order to accent them. After extracting them with Split Notes, use other Region commands (such as Transpose) to enhance the accented notes. Alternatively, you can simply assign the track with only the accented notes to be played back on a separate channel by another MIDI instrument.

**Dividing a keyboard part into its right and Left hand components**

Sometimes, it is useful to be able to treat the left-hand and right-hand parts of a keyboard track separately. Performer Lite does this automatically in the Notation Editor. If you want, you can do it manually by following the earlier procedure for extracting a lead line but use the *Notes with pitches between ___ and ___* option. The pitches you enter should correspond with the range of either the right or left hand. Since this range is rarely consistent, you will probably have to organize your sequence into sections according to one hand’s
You can add a new track and paste the notes into it.

**INVERT PITCH**

The Invert Pitch command inverts or flips MIDI notes around a specified axis. The inversion is chromatic, that is, exact. For example, if the following E major scale (starting on E3),

is inverted around an axis of D3, the following will result:

**Basics**

Inversion is an operation in which the interval between a note and the inversion axis pitch is measured and the note is transposed the same interval on the opposite side of the axis pitch. Two examples are shown below: If the note to be inverted is F4 and the axis pitch is C4, the interval between them is a perfect fourth. Since F4 is above C4, it will be transposed down by the same interval, a perfect fourth, resulting in a G3. If the note to be inverted is C#3 and the axis pitch is A3, the resulting pitch would be F4. In the following picture, the axis pitch in each measure is represented by a diamond:

The inversion is always exact, transposing the note the same chromatic interval above or below the axis pitch.

**Hints**

You can invert a region of notes around a pair of axis pitches. Follow the above procedure for normal inversion specifying the lower of the two pitches in the Invert Pitch window. Then use the Transpose command on the Region menu to transpose the region by the interval between the two axis pitches.

Example: You wish to transpose the following passage around the axis pitch pair C3 and E flat 3.

Use Invert Pitch on the passage specifying C3. The following is the result:

Select the region containing the passage and use the Transpose command on the Region menu transposing from C3 to E flat 3 (a minor third, the interval between the two axis pitches).

This is the final result, inverted correctly around the pair of axis pitches:

**MIDI EFFECTS PLUG-INS**

The **MIDI Effects Plug-ins** hierarchical menu supplies “special effects” processing to your MIDI tracks. These are plug-ins that can be applied to
your MIDI tracks in the same fashion as Performer Lite’s standard Region menu operations.

For details regarding the options in the Echo and Arpeggiator effects, see “Echo and Arpeggiator” on page 504.

For details regarding the options in the Remove Duplicates effect, see “Remove Duplicates” on page 510.

For details regarding the options in the Reassign Continuous Data effect, see “Reassign Continuous Data” on page 510.

**Real-time MIDI effects processing**
MIDI Effects plug-ins can also support Performer Lite’s real-time MIDI effects processing in the Mixing Board. If the plug-in supports real-time processing, it will automatically appear in the effects inserts of MIDI tracks in the Mixing Board window. If the plug-in appears in the Region menu, but not in the Mixing Board inserts, then it doesn’t support real-time operation. Real-time operation has the advantage of not permanently altering the data in the track. It only alters the data during playback.

**REVERSE TIME AND RETROGRADE**
The Reverse Time and Retrograde commands reverse the order of MIDI events in a selected region. However, each command reverses notes in a slightly different way, producing much different results.

**Reverse Time**
Reverse Time reverses the order of notes’ attack times in a region. A note whose attack occurs two beats from the beginning of the region is moved so that its attack occurs two beats before the end of the region. In doing so, Performer Lite either maintains the note’s duration or ends the duration just before the next attack. Notice in the example below that Reverse Time places the attack of the first note exactly at the end of the region, extending the duration into the next measure.
Retrograde
Retrograde inversion simply reverses the order of notes within the region: the first note becomes the last note, the last note becomes the first note, and so on. This is analogous to playing a tape backwards and recording the result.

Note: for clarity, we have shortened the durations in the Reverse Time example so that they don’t extend beyond the next attack. In actuality, the notes maintain their original durations after being reversed.

To get an exact reversal of the notes, you must select a region of time rather than specific events. In addition, the region of time must include the duration of the last note in the region. In the example above, the last note is the sixteenth note, G4. To obtain the results shown on the bottom staff, you would have to select the region from 1|1|000 to 2|1|000, where 2|1|000 takes into account the duration of the G4 sixteenth note.

To specify a region of time that includes the final duration, select the region using the Selection Information window, or by dragging in the Time Ruler Sequence Editor. Selecting specific events won’t work because the duration of the final note is not included.

Using Retrograde
When using the Retrograde command, you must select a time range. The Retrograde command will have no effect on event selections. For details, see “Selecting a time range” on page 281 and “Edit operations that require time range selection” on page 281 for details.

SCALE TIME
The Scale Time command expands or compresses the duration of MIDI and audio events in the selected region by the length, end time, percentage or ratio (e.g. 2:3) that you specify. This effectively changes the distance between MIDI notes and soundbites, making them closer together or farther apart. Since the actual duration of events changes, the region will become smaller or larger after this command is invoked. If you check the Time-scale audio check box, then the actual waveform data inside the soundbites is “constructively” time-stretched, too. For details about constructive soundbite time stretching, see “Constructive editing” on page 514. For more information about time-scaling audio, see chapter 63, “Scale Time” (page 533).

The Scale Time command does not affect loops or any event in the Conductor track.

Specifying the scale amount
To specify the amount of time by which to scale, you can type in the desired:

- End time
- Length
- Percentage
- Ratio

Entering a value in one of these fields automatically updates the three other fields.

When entering a ratio, if the first number in the ratio is larger than the second, the region is expanded; if the first number is smaller than the second, the region is compressed. A ratio of 2:1 doubles the duration of all events in the region (and doubles the length of the entire region as well); a ratio of 1:2 halves the duration of all events in the region. You can enter integer ratios with up to two decimal places.

Events at the Start time of the region will remain in place. Since the overall length of the region changes, events at the end will be moved. If the end of the region expands, events in it will be merged with data already there.

![Diagram of Scale Time](image)

**Scale time examples**

Here are three examples to give you a better idea of the use of Scale Time:

You’ve entered a melody in eighths but decided it would sound better in sixteens. Select the region of the melody and use Scale Time with a ratio of 1:2.

Your sequence is in 4/4 time with lots of triplets, and you want to modify it to be in 12/8, converting the triplets to regular eighths. Select the entire sequence. Use Scale Time with a ratio of 3:2. Afterwards, change the meter and tempo appropriately.

You’ve entered a melodic idea in quarter notes and decide that it should actually be the bass line for the sequence — and all notes should be whole notes.
Select the region with the melody and use Scale Time with a ratio of 4:1. Then transpose it down to the correct octave.

**SCALE TEMPO**
The Scale Tempo command provides several ways to modify existing tempos within a selected region in the Conductor track of a sequence. It modifies existing tempo events within the region, but it does not generate new tempo events. (To do so, use Project menu>Conductor Track>Change Tempo.) The Scale Tempo command is ideal for making global changes to an existing tempo map that you have already created with the Change Tempo command. For example, you might have created an elaborate tempo map with many tempo nuances, and you would like to increase the overall tempo while maintaining the nuances.

Note that the Scale Tempo command only affects tempo events that already exist in the Conductor track. If the region you select has no tempo events in it, this command will have no effect. If so, use the Change Tempo command in the Project menu (in the Conductor Track sub-menu) to generate tempo events.

There are several ways to select a region in the Conductor track. For more information, see chapter 34, “Selecting”.

**Add ____ bpm to all tempos**
This option adds the number of beats per minute (bpm) you enter to each tempo event within the selected region.

**Subtract ____ bpm from all tempos**
This option subtracts the number of beats per minute (bpm) you enter from each tempo event within the selected region.

**Limit to a range from ____ to ____**
This option searches for tempo events above or below the specified range. When it finds one, it changes the tempo to fall within the range. For example, if the tempo range is from 200 to 300, a tempo of 351 would be changed to 300 and a tempo of 60 would be changed to 200.

**Change to ____% of current value**
This option increases or decreases each tempo event by a percent of its current value, where the current value is 100%. Use a percentage lower than 100% to slow down the tempo; use a value above 100% to raise it. Use this option when you wish to maintain the degree of change between tempos within the tempo map when you raise or lower it.

**Change overall tempo from ____ to ____ and scale accordingly**
This option scales the tempo events by a percentage, just like the option above it. However, it lets you specify the change in beats per minute (bpm) rather than as a percentage. For example,
suppose you have a piece of music with varying tempos, but whose approximate tempo is 80 bpm. You simply wish to change it’s overall tempo from around 80 bpm to around 96 bpm. Rather than figuring out what percent to type in the percentage option to achieve this change, you can use this option to type in the original approximate tempo of 80 bpm and the desired increased tempo of 96 bpm, and let Performer Lite figure out the percent increase for you. All in all, this option provides a more musical way of specifying a percent by which you wish to scale the tempos, even though it accomplishes the same thing as the “scale by percent” option.

**Scale all tempos to fit new end time**
This option scales all existing tempo events to increase or decrease the overall elapsed time of the selected region. The start time of the region is fixed, and the end time can be made earlier or later. Times can be expressed in real time or SMPTE frame time. Here is an example: suppose that you have created a sequence with many tempo changes, and it is around 3 minutes long. But you would like to make it 3 and a half minutes long. This option lets you select the three minute region and scale all the tempos so that it stretches out evenly to 3 1/2 minutes.

Here’s another example: suppose you are locking a sequence to picture via SMPTE time code. You have composed a section of music, and you’ve programmed all of the tempo changes. You’ve got the section starting at the correct frame time, but it ends with a hit that is off by several frames. With the Scale all tempos to fit new end time option, you can select the region with the hit as the end time of the region and type in the new end time where the hit should occur. This changes the elapsed time such that the hit lands at the correct frame.

**Randomize**
The randomize option is a check box option that works in conjunction with the radio button option selected above.

**By ___% of current value**
This option randomizes the tempo of each selected tempo event within a range that is expressed as a percentage of the tempo value. For example, if the tempo is 100 bpm, and you enter 10 percent, the tempo will be randomized within a range between 90 to 110 bpm ($\pm 10$ bpm).

**By ± _____ bpm**
This option randomizes the tempo of each selected tempo event within a range of beats per minute.

**Emphasis**
This sub-option causes the tendency of the randomization to be higher or lower within the specified range. Thus, if you wish to randomize the tempos within a certain range, but you wish them to tend to be higher, use a positive emphasis; use a negative emphasis if you wish them to tend to be towards the lower end of the range. A value of zero equals no emphasis, which causes the randomization to occur evenly within the range.

**AUDITION SELECTION**
The Audition Selection command lets you audition a selection of MIDI and/or audio data. For details, see “Playing phrases” on page 280.
CHAPTER 41 Audio Menu

OVERVIEW
The Audio menu is, in part, an extension of the Edit menu and Region menu, providing further editing operations that apply to audio data only. The Audio menu has a combination of non-destructive, destructive and constructive editing operations. (See “Non-destructive, destructive and constructive audio editing” on page 278.) In general, the non-destructive commands (such as Strip Silence) can be applied to audio that has been selected in any editor window. The Spectral Effects command can be applied constructively in all windows, including the Soundbites list. For details about selecting soundbites in editors, see chapter 34, “Selecting” (page 281).

The Audio menu also contains soundbite management features and other audio-related operations and settings.

Overview .............................................. 383
Fade ................................................. 383
Delete fades ....................................... 383
Merge Soundbites ............................... 383
Smooth Audio Edits ............................ 383
Smooth Audio Edits Again ................. 385
Spectral Effects ................................. 385
Bite volume and gain .......................... 385
Pitch and Stretch ............................... 385
Apply Plug-in ..................................... 386
Audio Beats ...................................... 386
Soundbite Tempo .............................. 386

FADE
The Fade command lets you create fades and crossfades at the boundaries of soundbites to eliminate undesirable artifacts. For complete details, see “Fades and Crossfades” on page 322.

DELETE FADES
See “Deleting fades” on page 328.

MERGE SOUNDBITES
Use Merge Soundbites to quickly create a single, new soundbite out of several adjacent soundbites.

To do so, select the adjacent soundbites and choose Merge Soundbites from the Audio menu. This operation creates a new audio file, sort of like a “mini-bounce”. But it does not include any volume, pan or other automation data. It is meant for joining audio regions on a small, local scale.

If you use the Merge Soundbites command when there is a time range selection that extends beyond the selected soundbites, the resulting soundbite extends to the beginning and end of the selection.

SMOOTH AUDIO EDITS
Audio edits often produce gaps between soundbites. This is especially true when editing dialog, or splitting soundbites into small slices using the New Soundbites from Beats command (Audio menu > Audio Beats). Gaps of silence between soundbites can be audible and usually sound unnatural. The Smooth Audio Edits feature fills these gaps with “room tone” to mask them.

Room tone
Room tone is Performer Lite’s term for a small portion of ambient sound from the original audio file (or possibly another audio file). Performer Lite can automatically search the parent audio file for a small portion of the waveform that consists of noise floor: consistent, low-level background noise that can fill silence between soundbites and crossfade seamlessly with the beginning and end of each soundbite. Or you can manually specify a room tone audio file. In either case, Performer Lite then fills the gaps between soundbites with the
room tone “silence”, which matches the noise floor in the soundbites enough to provide a smooth, unnoticeable transition from one soundbite to the next.

At times, the gap to be filled may sit between soundbites that are from different recording sessions with completely different noise floor characteristics. If so, Performer Lite still tries to make the transition as smooth as possible. To do so, it finds noise from each parent audio file and creates a new soundbite to fill the gap that consists of a crossfade blend from one file’s noise to the other file’s noise.

To apply Smooth Audio Edits, make a time range selection over the area that contains the gaps between soundbites that you wish to fill. Then choose Audio menu> Smooth Audio Edits. A window appears (Figure 41-2) with the several options discussed below.

**Specifying what gaps to fill**
To fill all gaps of silence, choose Replace Silence with Room Tone.

To specify the size of the gaps to be filled, choose Only Fill Gaps smaller than _ with Room Tone.

If you wish to automatically generate crossfades between soundbites and the newly created room tone soundbites between them, check the Crossfade Edits check box.

**Specifying how to fill gaps**
The Find Room Tone By options let you decide how the gaps will be filled. There are essentially two basic techniques for doing so: edge edit (trim) the edges of the existing soundbites to “uncover” room tone that is just past the edge of the soundbite, or insert new room tone soundbites. Or, you can do both by trimming soundbites as far as possible until they run out of audio (or run into other portions of the waveform that rise above the noise floor), and then inserting room tone soundbites to fill any remaining gaps. This last approach usually produces the most natural sounding and complete results. To employ it,
choose *Edge Editing then Inserting Audio From File*. If you wish to edge edit only or insert room tone only, choose either *Edge Editing Only* or *Inserting Room Tone Audio From File*.

**Specifying how room tone is generated**
The final options in the Smooth Audio Edits dialog let you choose how room tone is generated. If you want Performer Lite to automatically generate room tone by searching for it near the soundbites in their parent audio file, choose *Creating Room Tone from Adjacent Audio*. If you would like to create your own room tone audio file and use that instead, choose *Use Room Tone Soundbite* and click the *Choose* button to specify the file.

**SMOOTH AUDIO EDITS AGAIN**
If you wish to apply the same smoothing settings as were just used, hold down the Command/Ctrl key and choose *Audio menu* > *Smooth Audio Edits Again*. Doing so applies the same settings last used by this command to the current selection, as a convenient shortcut.

**SPECTRAL EFFECTS**
The Spectral Effects command allows you to apply Performer Lite’s formant-corrected pitch-shifting, time stretching and “gender-bending” to monophonic digital audio. For details, see chapter 62, “Spectral Effects” (page 530).

**BITE VOLUME AND GAIN**
There is a soundbite attribute, accessed in the Sequence Editor (“Bite Gain” on page 311), called *Bite Gain*. It non-destructively raises or attenuates the overall volume of the soundbite. The range is from -140 to +80 dB. There is an additional soundbite attribute that temporarily bypasses both soundbite gain and soundbite volume automation. When bypass is engaged, the soundbite plays at its original volume. The commands in the *Bite Volume and Gain* sub-menu control these settings for individual soundbites. To use them, select a soundbite (in the Sequence Editor) and choose the desired command below:

<table>
<thead>
<tr>
<th>Soundbite volume submenu item</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Bite Gain</td>
<td>Sets the selected soundbite’s gain to the value entered in the dialog.</td>
</tr>
<tr>
<td>Clear Bite Gain</td>
<td>Sets the selected soundbite’s gain to 0.0dB</td>
</tr>
<tr>
<td>Toggle Bite Volume Bypass</td>
<td>Toggles the gain/volume bypass setting for the selected soundbites</td>
</tr>
<tr>
<td>Adjust Bite Volume +0.5dB</td>
<td>Adds a half a dB to any soundbite volume within the current selection.</td>
</tr>
<tr>
<td>Adjust Bite Volume -0.5dB</td>
<td>Subtracts a half a dB from any soundbite volume within the current selection.</td>
</tr>
<tr>
<td>Clear Bite Volume</td>
<td>Clears the selected range in the soundbite volume curve.</td>
</tr>
</tbody>
</table>

For breakpoint editing of soundbite volume automation in the Sequence Editor, see “Soundbite volume automation” on page 321.

**PITCH AND STRETCH**
The commands in the Pitch and Stretch sub-menu let you control Performer Lite’s real-time pitch automation data. For complete information, see
chapter 61, “Transposing Audio” (page 519). Here is a brief summary of the commands in this submenu:

<table>
<thead>
<tr>
<th>Pitch mode command</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Pitch</td>
<td>Returns a pitch segment to its original pitch. See “Pitch curve control points” on page 522.</td>
</tr>
<tr>
<td>Clear Pitch Control Points</td>
<td>Removes any control points in the currently selected portion of a pitch curve. See “Pitch curve control points” on page 522.</td>
</tr>
<tr>
<td>Quantize Pitch</td>
<td>Centers any currently selected pitch segments, so that they are tuned exactly to their relative root pitch (to fix any notes that are a little sharp or flat). See “Quantizing pitch” on page 526.</td>
</tr>
<tr>
<td>Scale Expression</td>
<td>Accentuates or flattens the currently selected pitch curve. See “Scaling the pitch curve” on page 523.</td>
</tr>
<tr>
<td>Adjust Pitch Segmentation</td>
<td>Raises or lowers the number of pitch segments used to manipulate audio pitch. See “Adjusting pitch segmentation” on page 524.</td>
</tr>
<tr>
<td>Set Track Pitch Mode</td>
<td>Sets the default pitch mode for any audio material newly recorded into that track. It does NOT affect existing soundbites already in the track, or soundbites dragged into the track. See “Setting the pitch mode” on page 524.</td>
</tr>
<tr>
<td>Set Pitch Mode for Selected Bites</td>
<td>Sets the pitch mode and modifies the pitch segments accordingly for the currently selected audio in the Soundbites list or in any tracks. See “Setting the pitch mode” on page 524.</td>
</tr>
<tr>
<td>Set Pitch Mode for Track and Selected Bites</td>
<td>Applies the pitch mode to both the track and any currently selected soundbites as described above in one operation. See “Setting the pitch mode” on page 524.</td>
</tr>
</tbody>
</table>

### AUDIO BEATS

The Audio Beats sub-menu lets you manage Performer Lite’s extensive audio beat detection features.

<table>
<thead>
<tr>
<th>Audio beats menu item</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find Beats...</td>
<td>Triggers Beat Detection on selected audio files in the Sequence Editor with the user-set detector sensitivity setting. See “Find Beats” on page 402.</td>
</tr>
<tr>
<td>Clear Beats</td>
<td>Removes all the beats from the selected audio files.</td>
</tr>
<tr>
<td>Disable Beats under Strength Threshold…</td>
<td>Controls how many beats are enabled or disabled in a soundbite based on their velocity threshold. See “Disable Beats under Strength Threshold” on page 402.</td>
</tr>
<tr>
<td>New Soundbites From Beats…</td>
<td>Lets you split up a soundbite into pieces at beat boundaries. See “New Soundbites from Beats” on page 403.</td>
</tr>
<tr>
<td>Copy Beats…</td>
<td>Copies beats from one track to another. See “Copy Beats” on page 405.</td>
</tr>
<tr>
<td>Copy Beats as MIDI</td>
<td>Copies beats into the clipboard as MIDI notes with velocities that match the beat strength. See “Copy Beats As MIDI” on page 406.</td>
</tr>
</tbody>
</table>

### SOUNDBYTE TEMPO

Performer Lite provides many advanced features for managing audio tempos. For complete information about the soundbite tempo commands in the Audio menu, see “Tempos and Audio” on page 394 and chapter 44, “Audio Beats and Tempo Detection” (page 400).

### APPLY PLUG-IN

The Apply Plug-in sub-menu holds non-real-time versions of your MAS, VST and AU plug-ins, allowing you to apply them constructively as region operations on audio selected in any window. For more information, see “File-based plug-in processing” on page 494.
CHAPTER 42  Takes and Comping

OVERVIEW
A take stores the contents of the track. Each track can have an unlimited number of different takes. If you want to keep what is already in a track, but you want to try an alternative version of it (either recorded from scratch or based on the current take), choose New Take or Duplicate Take from the Take menu. The original data is preserved in its own take, which you can always return to by choosing it by name from the Take menu.

Takes are great for cycle-recording. If you’d like to try recording again the next time through the loop, just choose New Take from the menu. Your previous take is saved, and a new, empty take is ready to be recorded into. After you are done, you can either choose the best take, or quickly build a final composite track made of the best parts of several takes using the Comp tool.

Takes can be used with all track types. When used with audio tracks in the Sequence Editor, you can use Performer Lite’s powerful comping features to quickly create a comp take from multiple takes.

TAKE MENU
The Take menu (Figure 42-1), found in the Sequence Editor info panel as shown below, has several commands to help you manage takes.

New Take
(Figure 42-1) creates a new, empty take for the track.

Rename Take
(Rename Take (Figure 42-1) lets you rename the current take. The current take is the one with the check mark next to it in the top portion of the menu.

Duplicate Take
(Figure 42-1) creates an exact duplicate of the current take, including all of the data in the track. The current take is the one with the check mark next to it in the top portion of the menu.
**Delete Take**
*Delete Take* (Figure 42-1) gets rid of the current take.

**Delete all except ‘current take’**
*Delete all except ‘current take’* (Figure 42-1) gets rid of all takes except the current take.

**Next/Previous Take**
The *Next/Previous Take* commands make the next or previous take in the list the current take.

**Turn Takes into Tracks**
*Turn Takes into Tracks* (Figure 42-1) removes takes from the track and turns them into separate tracks. The *Current Take* sub-menu option is only available when there are two or more takes, and it operates on the current take. The *All Takes* option removes each take and turns it into a separate track containing a single take.

**Absorb Selected Tracks**
*Absorb Selected Tracks* (Figure 42-1) lets you collect takes from other tracks into the track from which you choose this command. To do so, select the tracks you wish to “absorb”, then choose this command from the take menu of the track you wish to absorb them into. The selected tracks are deleted. The *Current Takes* sub-menu option only absorbs the current take of the selected tracks, whereas the *All Takes* option absorbs all takes from the selected tracks.

For audio tracks in the Sequence Editor, there are some additional commands for take comping. See “Comp takes” below.

**Show Takes**
The *Show Takes* command displays each take as a separate lane in the Sequence Editor. See “Creating a comp take” below.

**INDICATION OF MULTIPLE TAKES**
When a track contains multiple takes, a bullet (•) is displayed to the right of the take name.

**COMP TAKES**
Compositing (“comping”) is the process of building a composite take — *comp take* — from portions of several regular takes. For example, you might record five or six guitar overdubs as separate regular takes and then take the best parts of each one to build a comp take that plays smoothly and seamlessly through the chosen portions from each take. Comp takes are different from regular takes in that they are built from portions of regular takes, although they also operate in many ways just like regular takes. For example, they appear in the Takes sub-menu side by side with regular takes, and you can record new material into them, just like a regular take. You can also use a comp take to build other comp takes. But comp takes differ from regular takes in that they remain connected to the component takes used to build them.

**Creating a comp take**
Choose *Show Takes* (Figure 42-2) to create a new comp take for the track (*Comp 1* in Figure 42-2) and also open a scrolling *take grid* that displays all other takes in the track (*Takes G, A, B* and *C* in Figure 42-2).

When a comp take is first created, it contains a copy of contents of the current take at the time the Show Takes command is invoked. In the example shown in Figure 42-2, *Take 1* was the current take at the time Show Takes was chosen, so its contents appear in the *Comp 1* take, as indicated by the Take 1’s shading in the take grid.

If you want to start with an empty comp take, create a new empty regular take first (with the New Take command) and then choose *Show Takes*. 
You can create as many comp takes as you wish. To create a second, third, fourth, etc. comp take for a track, first choose a regular take from the Takes sub-menu (instead of an existing comp take) and then choose Show Takes.

**The take grid**

To view the take grid for an existing comp take, choose the comp take from the Take menu and then choose Show Takes from the Take menu. The take grid (Figure 42-2) displays all takes for the track in a scrolling, resizable grid. Shaded areas (Figure 42-5 on page 391) indicate portions of each take that are being used in the track’s current comp take (the comp take currently chosen in the takes menu).

**Resizing and scrolling the take grid**

The take grid can be resized with the resize handle (Figure 42-3). If it is not opened all the way, use the take grid scroll bar (Figure 42-3) to vertically scroll through all of the takes displayed in the grid.

**Working with take tracks within the take grid**

Takes appear in the take grid list in a fashion very similar to regular tracks. They are slightly indented below their parent track. You can resize them and reorder them vertically within the take grid, just like regular tracks. (For example, option drag to resize them all to the same height.) You can show and hide take tracks within the take grid using the Sequence Editor’s track selector.

**Take track settings**

Take tracks have many settings similar to normal audio tracks (Figure 42-3), such as play-enable, record-enable and input monitoring buttons. They can also have their own independent audio input and output assignments, automation mode settings, etc. These track settings take affect when the take grid is visible. As soon as you collapse the take grid using the Hide Takes command (explained below), the track settings no longer apply; instead, the parent track settings take effect over the currently selected take or comp take.

**“Soloing” a take track**

The take track solo button (Figure 42-3) works slightly differently than a normal track solo button. Click it to temporarily change the parent
comp take to a complete copy of that take. Usually, the only thing that plays back while the take grid is showing is the parent comp take (the current comp take in the main track strip). Therefore, if you want to temporarily hear a single take in its entirety instead, the easiest way is to use the take track solo button to temporarily copy all of that take’s data into the comp take. Click it again to restore the comp take to its previous state. As you can see, this is a special kind of “soloing” that is not related to the solo button in the Mixing Board.

Editing take tracks
Take tracks in the take grid are fully editable, just like normal tracks.

Switching takes when the take grid is open
If you switch the current take on the track while it is showing takes, the take grid will remain open if you switch to another comp take. If you switch to a normal take, or choose New Take, the take grid will close and the track will display the normal take. If you duplicate a comp take, the take grid will remain open and display the duplicated comp take.

Hide takes
After you use the Show Takes command, its text in the Take sub-menu changes to Hide Takes.

Choosing Hide Takes hides the Take grid and its take tracks. If a new comp take was created when you chose Show Takes, but you did not edit that comp take in any way, then the new comp take is discarded when you choose Hide Takes and the original current take is restored. However, if you did edit the comp take, it is saved and added to the Takes sub-menu (Figure 42-4):

After the Hide Takes command is invoked, its text in the Take sub-menu item changes to Show Takes.

Working with comp takes
When you use Hide Takes after creating and modifying a comp take, the comp take appears in the Takes menu (Figure 42-4) and behaves just like a regular take. You can make it the current take in the track and then edit it in the main track strip just like a regular take. You can even use it as a regular take track for other comp takes.

Viewing and modifying a comp take
To view and modify the take tracks for a comp take, choose it from the Takes menu to make it the track’s current take, and then choose Show Takes. The take grid reappears and shows you via shading how the comp take was originally constructed from its component takes (Figure 42-5).

COMP TOOL
Use the Comp tool to construct a comp take from portions of its take tracks (Figure 42-5). Use the Comp tool to create vertical red dividers across all take tracks and then build the comp take by selecting different take sections prescribed by the dividers. Only one take track at a time can be chosen for any given region between dividers. After you create dividers, use the Comp tool to click the sections you wish to
include in the comp take. Here is a summary of Comp tool techniques you can use to build comp takes:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a divider at the current cursor location</td>
<td>Option click.</td>
</tr>
<tr>
<td>To add a take section between dividers to the comp take</td>
<td>Click it.</td>
</tr>
<tr>
<td>To create a take section and add it to the comp take in one gesture</td>
<td>Drag over the desired take track section.</td>
</tr>
<tr>
<td>To move a divider line</td>
<td>Drag it left or right. (See note below.)</td>
</tr>
<tr>
<td>To select a divider line</td>
<td>Click it. It turns white.</td>
</tr>
<tr>
<td>To delete a selected divider line</td>
<td>Press the delete key.</td>
</tr>
<tr>
<td>To nudge a selected divider line</td>
<td>Press left/right arrow key.</td>
</tr>
<tr>
<td>To create silence in the comp take</td>
<td>Control/Win-drag a divider</td>
</tr>
</tbody>
</table>

When dragging a comp divider line, the snapping behavior is the same as when edge editing: dragging is unconstrained by default. Snapping will occur if it is enabled and you hold down the Command/Ctrl key while dragging.

**Re-applying track takes after making changes**
If you make changes to track takes used in a comp take, the comp take will not inherit those changes unless you click on those portions of the take grid with the Comp tool to “re-apply” them to the comp take. Only those portions of the take grid that you click will be re-applied to the comp take. If you made any changes or edits directly to the comp take itself within the re-applied time range, they will be lost and replaced by the re-applied material.

![Figure 42-5: Building a comp take.](image)
Divide Comp commands
The Divide Comp sub-menu in the Takes menu (Figure 42-6) provides several convenient shortcuts for creating comp divider lines.

At wiper
The at Wiper command (Figure 42-6) creates a divider line in the Take grid at the current playback wiper time.

At selection boundaries
If the current selection is an insert point, the at Selection Boundaries command (Figure 42-6) creates a single comp divider line in the Take grid at that insert point. If the current selection is a time range selection, this command creates two divider lines in the Take grid: one at the start of the selection range and one at the end of the selection range. For example, you could use the Scrub tool in a take track to zero in on the desired time range selection that you want, then choose Divide Comp at Selection Boundaries to create a comp region.

At selected soundbite boundaries
The At Selected Soundbite Boundaries command (Figure 42-6) creates a comp divider line at the beginning and end of each selected soundbite.

Comping Multiple Tracks Simultaneously
There are some cases where you might want to simultaneously comp two or more grouped tracks. For example, you might want to comp multi-tracked drums, or a bass/guitar track that you recorded direct on one track and amped on another.

In cases like these, you can collect the related tracks into a track group and use the “Show/Hide Takes” track group option to show and hide takes for all tracks in the group at the same time. Use the “Take comping” track group option if you also want to apply comping operations to all tracks in the track group simultaneously. That way, you can define comp regions and select takes in just one open take grid and have those choices take effect for all tracks in the track group. (Obviously, this is desirable only if each track in the track group has the same number of takes, and if the nth take on each track corresponds to elements of the same nth performance.)

TAKES AND KEY COMMANDS
There are key bindings for the items in the Take menu, as well as additional commands like Next Take and Previous Take. When invoked, these commands will affect all record-enabled tracks; if there are none, they will affect the selected tracks.
CONDUCTOR TRACK TAKES
The Conductor track holds tempo changes, meter changes, key changes and markers. However, switching takes on the Conductor track only affects tempo data. Meter changes, key changes, and markers are not affected by takes. For example, if you have a meter change at measure 3, as well as a number of tempo change events, and you choose New Take from the Conductor Track take menu, the tempo events will disappear from the track (as part of Take 1, which is being replaced by Take 2), but the meter change at measure 3 will remain.

Also, as there can be only one Conductor Track in a sequence, the Turn Takes into Tracks and Absorb Selected Tracks commands are not available for the Conductor Track.

TAKES INTERACT WITH MULTIPLE MIXDOWNS
See “How mix mode impacts your sequencing” on page 177 for an important discussion about how working with multiple mixdowns in the Mixing Board interacts with takes.
CHAPTER 43  Tempos and Audio

OVERVIEW
This chapter explains how to:

- Apply tempo maps to soundbites
- Extract tempo maps from soundbites that already have them
- Make soundbites follow the tempo of a sequence, including tempo maps with ritards, accelerandi, and rubato
- Make a sequence follow the tempo of a soundbite
- View and edit embedded soundbite tempo maps

For information about a related feature, see chapter 44, “Audio Beats and Tempo Detection” (page 400) and chapter 63, “Scale Time” (page 533).

Audio beats and tempo detection
For audio that is not originally recorded in Performer Lite (in time with the project time line), Performer Lite can analyze the audio to detect beats and extrapolate the audio’s tempo with a great deal of precision, even for long, complex tempo maps. See the next chapter, “Audio Beats and Tempo Detection” on page 400.

Working with soundbite tempo maps
This chapter explains how you can manually specify a soundbite’s tempo, modify soundbite tempo maps and adjust the sequence to match the audio tempo, or vice versa.

An example of a soundbite tempo map
For now let’s just consider the simplest case: a soundbite with a fixed tempo. The most common example of this case is a soundbite that was recorded to a click with a fixed tempo. If Performer Lite knows the tempo of a soundbite, it

When you record audio in time with the project time line, the new soundbite “knows” about the tempo map in effect at the time it was recorded, whether in manual tempo mode, or using a conductor track with tempo changes. Then, you may modify the tempo changes in the conductor track any way you like — manually with the Sequence Editor or by calculation with the Scale Tempos or Change Tempo commands. At this point, the audio will no longer be lined up properly with any MIDI data in your sequence. All you need to do is enable the Stretch layer (“Stretch” on page 59) for the track and everything is perfectly aligned again! Performer Lite time-scales the soundbites, conforming their embedded tempo map with any tempo changes in the conductor track.

SOUNDBITE TEMPO MAPS
In order to make time-scaling musically useful, Performer Lite allows soundbites to have tempo maps. This makes it very easy for you to manipulate audio along with MIDI without worrying about the tempo, and change the tempo however and whenever you want.
can compute the exact duration, in beats and ticks. If you have configured the Soundbites list to show the "Duration (beat|ticks)" and "Tempo" columns, you will see this, as shown below in Figure 43-1.

![Soundbites with tempo maps. This soundbite has no tempo map.]

Figure 43-1: The Soundbites list has two columns that show information about a soundbite’s tempo map, if it has one: the TEMPO column, which shows the constant or average tempo, and the QUARTER | TICKS column, which shows its duration in quarter notes and ticks. You can show and hide these columns by double-clicking one of the column titles.

**Viewing soundbite tempo maps in the Sequence Editor**

In the Sequence Editor, Soundbites with tempo maps are drawn with gray lines on them, corresponding to the grid lines in the time ruler, as shown below in Figure 43-2.

![A soundbite recorded at 120 bpm in a 120bpm sequence (above), and the same soundbite placed in a 114 bpm sequence (below). Notice how the grid lines inside the soundbite no longer line up with the grid lines in the ruler to alert you that the soundbite currently has a different tempo than the sequence. When this happens, the lines inside the soundbite are drawn in red, to further alert you to the discrepancy.](image)

If a soundbite has a tempo map, the time ruler grid lines inside the soundbite stick to the audio data, not to the sequence. As a result, if a soundbite was recorded at 120 bpm, and you place it in a sequence with a tempo of 114 bpm, its gridlines won’t line up with the time ruler grid lines to alert you that soundbite currently has a different tempo than the sequence. When this happens, the lines inside the soundbite are drawn in red, to further alert you to the discrepancy.

**Ritards, accelerandi, and rubato tempos**

Soundbites will usually have a constant tempo, but they are not required to. Each soundbite can essentially have an entire conductor track inside it! If you set up a conductor track with ritards and accelerandi, and record a soundbite, the soundbite automatically gets a copy of the current tempo map. If you later decide to change the conductor track, Performer Lite remembers the original tempo map with which the soundbite was recorded, and the audio will be stretched to remain in time with the new tempo (when the Stretch layer is enabled).

**THE TRACK STRETCH LAYER**

When the track Stretch layer is enabled for an audio track (Figure 17-15 on page 112), soundbites in the track will always remain conformed to the measures and beats of the project time line, as long as the soundbites have a tempo map that accurately reflects their tempo. The Stretch layer can be enabled on a per-track basis, so you can disable it for things like movie dialog tracks or sound effects tracks. For details, see “Stretch” on page 59.

**AUDIO MENU > SOUNDBITE TEMPO**

In addition to the automatic beat detection and tempo analysis features discussed in the next chapter, Performer Lite has several commands for manually creating or modifying a soundbite tempo map, as discussed in the following sections. These commands are found in the Audio menu > Soundbite Tempo sub-menu.
Selecting audio to apply tempo commands
Most of the Audio Tempo commands work on selected soundbites or selections within pop-edited soundbites. For time-ruler selections, they affect all soundbites that start within the selection.

ANALYZE SOUNDBITE TEMPO
The Analyze Soundbite Tempo command engages Performer Lite’s automatic tempo analysis features to generate a tempo map for a soundbite. This can be applied to any audio that has been beat-analyzed by Performer Lite’s Beat Detection Engine; ensuring the audio file’s beats are optimal before choosing this command can improve results. See “Editing beats to improve tempo detection” on page 410.

SET SOUNDBITE TEMPO
The Set Soundbite Tempo command (in the Soundbite Tempo sub-menu in the Audio menu) allows you to define a constant tempo for a soundbite or a portion of a soundbite. This is particularly useful with audio that was not recorded to the click, or that was obtained from a sample library, for instance. You can also make a selection within a soundbite while snapping to beats (see “Using the beat grid” on page 406) and quickly set the tempo based on the number of beats you have selected — very quick and easy.

What happens depends on whether the soundbite already has a tempo map or not. If the soundbite doesn’t have a tempo map yet, a new tempo map is created using a fixed tempo for the whole soundbite. But if the soundbite already has a tempo map, only the tempo of the selected part of the soundbite is changed. This is one way of defining a varying tempo map for a soundbite.

The Set Soundbite Tempo command also works on selections in the Soundbites list. Note that in all cases, though, it only works on a single soundbite at a time.
This command has no effect on the audio data itself; it only affects the tempo map stored with the soundbite.

CLEAR SOUNDBYTE TEMPO
The Clear Soundbite Tempo command (in the Audio menu > Soundbite Tempo sub-menu) removes the tempo maps from any selected soundbites.

HALVE/DOUBLE SOUNDBYTE TEMPO
These commands (in the Audio menu > Soundbite Tempo sub-menu) divide or multiply an existing soundbite tempo map by a factor of two.

Sometimes, audio material can be misleading enough that Performer Lite’s tempo analyzer chooses a tempo that is actually twice or half the actual tempo. For example, a very fast jungle/drum ‘n bass break beat loop that is 170 BPM might be incorrectly detected at 85 BPM. To quickly correct errors like these, choose Audio menu > Soundbite Tempo > Double Soundbite Tempo or Halve Soundbite Tempo.

The audio in the file does not change (no time stretching occurs); just the tempo map is changed.

This command is also useful if you simply wish to play back the soundbite at twice or half its original tempo (in an audio track with Stretch enabled).

FIND TEMPO FACTOR NEAR SEQUENCE TEMPO
The Find Tempo Factor Near Sequence Tempo command (in the Audio menu > Soundbite Tempo sub-menu) scales the tempo map in the soundbite to match the sequence tempo as closely as possible. For example, if tempo analysis produces a tempo that is double or half the actual tempo of the audio, and you know that the soundbite’s actual tempo is very close to the sequence tempo, this command will multiply or divide the tempo map by 1.5 (or 2, 3, 3.5, etc.) as needed to match the sequence tempo as closely as possible.

COPY SEQUENCE TEMPO TO SOUNDBYTE
The Copy Sequence Tempo to Soundbite command (in the Audio menu > Soundbite Tempo sub-menu) copies tempo information from the sequence into any selected soundbites, replacing their existing tempo maps, if any.

Manual tempo mode vs. conductor track
If the sequence is in manual tempo (“Tempo Slider”) mode, it is the value of the tempo slider that is copied into the soundbites, not tempo changes from the conductor track. This command (as well as the ones described in the next two sections) always pays attention to the tempo that is actually being used by the sequence, whether it is the tempo slider, or the conductor track.

The audio in the file does not change (no time stretching occurs); just the tempo map is changed.

This command does not work on selections in the Soundbites list.

ADJUST SOUNDBITES TO SEQUENCE TEMPO
Select a soundbite that is out of alignment with the sequence tempo (one with red lines in the Sequence Editor), and choose Audio menu > Soundbite Tempo > Adjust Soundbites to Sequence Tempo. Performer Lite time-scales the soundbite to make it line up exactly with the sequence tempo. This may require compressing some parts of the soundbite and expanding others. It may require dozens or hundreds of different time scale factors. It doesn’t matter, just choose this command, and Performer Lite does the rest.
If you would like soundbites in a track to always remain conformed to the sequence tempo, so that you don’t have to take the time to do it manually with this command, see “Stretch” on page 59.

Only soundbites with tempo maps are affected. Also, any soundbites whose Time Compress/Expand preference in the Soundbites list is set to Don’t Time Scale will be left alone. Furthermore, any selected soundbites that match the sequence tempo are left alone.

Figure 43-6: In this example, the soundbite “Rubato Piano” has a varying tempo map that does not match the sequence, as indicated by the uneven spacing of its grid lines (above). It is then shown mapped to the sequence, which has a constant tempo (below).

**ADJUST SEQUENCE TO SOUNDBYTE TEMPO**

This command does the opposite of Adjust Soundbites to Sequence Tempo. It copies the tempo map from any selected soundbites into the sequence. If you are in Conductor Track mode, this modifies the conductor track. In Tempo Slider mode, it sets the tempo slider to the average tempo from the selected soundbites.

This is useful when creating a new sequence from an existing soundbite. For example, if you have a drum loop from a sample library, you can give it a tempo map with the Set Soundbite Tempo command, or use the tempo map created by Performer Lite’s Beat Detection Engine and automatic tempo analysis, and then copy that tempo into the sequence with Adjust Sequence To Soundbite Tempo.

Figure 43-7: In this example, a 114 bpm Drum Loop has been placed in a new sequence set to 120 bpm as shown by the tempo indication (above). After selecting the soundbite and choosing Adjust Sequence to Soundbite Tempo, the tempo slider now exactly matches the tempo of the soundbite, as indicated by the time ruler grid lines, which now match up (below).

As another example, you could import a full mix, or drum track stems for an entire song, and then make the sequence tempo map exactly match the imported audio. The basic procedure to do this would be:

1. Select the imported audio and choose **Audio menu > Analyze Beats and Tempo**.
2. Nudge all of the audio so that the first downbeat of the audio aligns with a measure downbeat.
3. Set the sequence to Conductor Track tempo mode.
4 Select the audio and choose Audio menu > Soundbite Tempo > Adjust Sequence to Soundbite Tempo.
CHAPTER 44 Audio Beats and Tempo Detection

OVERVIEW
This chapter gives you a brief overview of Performer Lite’s beat detection and tempo analysis features, which give you unprecedented rhythmic and tempo control over your audio.

Overview ................................................. 400
The Beat Detection Engine ................................. 400
What works and doesn’t work ............................... 401
Manually applying beat and tempo detection .......... 401
Where beats and tempo maps are stored ............... 402
Audio menu > Audio Beats ............................... 402
Using the beat grid ...................................... 406
Stretching audio beats ................................. 407
Quantizing beats within soundbites .................. 408
Applying a groove to beats within soundbites .......... 409
Extracting a groove from audio ...................... 409
Ideas for quantizing audio .......................... 409
Beats determine tempo detection .................... 409
Editing beats to improve tempo detection ............ 410
Reanalyzing tempo after editing beats ............... 410
Adjusting soundbite tempo maps .................... 410

THE BEAT DETECTION ENGINE
Using sophisticated transient detection algorithms, Performer Lite’s Beat Detection Engine can analyze any audio loop or audio file that contains rhythmic music and determine where the beats are in the music. After the beat locations have been determined, a wide variety of beat-related operations can be performed on the audio, giving you unprecedented rhythmic control over your music. For example, you can quantize — or apply a groove to — the audio without breaking it up into separate soundbites. Instead, Performer Lite applies time-stretching between beats. As another example, you can snap edits and selections directly to beats for quickly making beat-accurate loops, beat-relative split points, and much more.

After the Beat Detection Engine analyzes an audio file for beats, state-of-the-art tempo analysis technology can then be applied to determine the overall tempo of the file. After a tempo map has been determined, a wide variety of tempo-related features can be applied, such as conforming the audio to the sequence tempo, or generating a conductor track tempo map that precisely matches the audio file’s tempo.

The Beat Detection Engine can be highly accurate, depending on the nature of the audio material being analyzed. In most cases where a correct beat is found, the beat detection is sample accurate: it finds the exact sample where the beat transient begins. As a result, rhythmic manipulation, such as quantizing, groove extraction and groove application, will feel very accurate — or as they say, “in the pocket”.

Performer Lite’s beat detection features are designed to be smoothly integrated into the overall operation of the program. You can set up beat and tempo analysis preferences and then take advantage of Performer Lite’s powerful rhythmic editing and tempo-based processing during the course of your uninterrupted workflow.
WHAT WORKS AND DOESN’T WORK
Performer Lite’s Beat Detection Engine and Tempo Analyzer are highly developed technologies. However, they have their limits. If an audio file has no rhythmic information in it whatsoever, then clearly beats and tempos won’t be found. Examples of such audio include:

- Ambient pads with smooth changes between chords
- Percussion tracks with intermittent bursts of playing, separated by long silences (like a crash cymbal track)
- Non-musical sound effects
- Dialogue tracks

These are extreme examples, but they serve to illustrate one extreme: material that has no beats at all — or any sense of musical pulse.

Audio files with embedded beat and tempo information
What’s the other extreme? There are many cases where audio files already have embedded tempo information. Below are a few examples:

- Audio recorded directly in Performer Lite (and played to a click or other tempo reference to match Performer Lite’s beats and barlines)
- ACID WAVE files
- REX (Recycle) files
- Apple Loops

If an audio file has an embedded tempo map, then it won’t require tempo analysis in order for you to make it conform to the tempo of your Performer Lite project. Performer Lite simply uses the existing tempo map. However, if you wish to quantize the audio or perform other beat-related operations, you will still need to analyze it for beats (even if it is a REX file or Apple Loop).

Rhythmic audio with no embedded tempo information
Performer Lite’s Beat Detection Engine and Tempo Analyzer are intended for the middle ground between the two extremes just discussed and work best on audio files that have the following characteristics:

- The audio file has no embedded tempo information already.
- The audio material in the file has a perceptible rhythmic pulse.
- The audio file represents a single instrument or drum track.
- The audio material is not a full stereo mix.

The Beat Detection Engine is primarily designed for individual instrument parts that are rhythmic in nature and have a relatively steady tempo. It can often do a good job on complete mixes, but it is not fine-tuned for such material. However, you can often get great results, even on complete mixes, with a little bit of tweaking — far less work than would be needed using other much more painstaking techniques. For details, see “Editing beats to improve tempo detection” on page 410.

MANUALLY APPLYING BEAT AND TEMPO DETECTION
You may encounter situations where you need to manually apply beat and tempo analysis to soundbites or audio files.

To manually initiate beat analysis on individual soundbites, first select them in the Sequence Editor and then choose the Find Beats command (Audio menu > Audio Beats). This command opens a window that allows you to preview the beats found within the selected soundbites before applying them to the soundbite, with a slider to vary the analysis sensitivity setting of the beat detector. See “Find Beats” on page 402 for more information.
Similarly, if beats are present in an audio file and you would like to manually initiate a tempo analysis, first select the soundbites in the Sequence Editor or Soundbite List and then choose Analyze Soundbite Tempo (Audio menu > Soundbite Tempo).

Tempo analysis results depend on the quality of the beats detected in the audio file.

WHERE BEATS AND TEMPO MAPS ARE STORED
Beat information is stored with the Performer Lite project and therefore does not transfer from one project to another.

The audio file’s tempo map is stored with the audio file itself. Therefore, if the audio file is imported into another Performer Lite project, the tempo map is also imported and can be used to make the audio conform to the tempo map in the new project.

AUDIO MENU > AUDIO BEATS
The Audio Beats sub-menu (in the Audio menu) has several commands for managing audio beats. You can apply them to selected soundbites in the Sequence Editor or Soundbites list.

Find Beats
The Find Beats command opens a window that allows you to add beats to selected soundbites, detected using Digital Performer’s beat detection algorithm. Once a soundbite has been selected, the algorithm will find the beats and display a preview. Click Apply to save these beats to the soundbite.

The slider in the window adjusts the sensitivity setting, which alters how sensitive the beat detection algorithm is when finding beats in audio. A low sensitivity setting means the beat detector will detect fewer beats, and a high sensitivity setting will lead to more beats being found. Move the slider to the right to increase the sensitivity setting, or move it to the left to lower it: the preview will update the results accordingly. After clicking Apply the new sensitivity setting will be remembered so that any future beat detection on that audio file will use the updated sensitivity level by default.

There are situations in which it is useful to alter this setting. For example, in a live recording, audience noise or chatter could be mistaken for beats. In this case a lower sensitivity would remove these false positives. As another example, increasing the sensitivity would yield better results in recordings with very quiet transients.

In general, lowering the sensitivity setting reduces the detection of false positives while increasing the sensitivity will find more beats.

The Find Beats command is also available in the Audio menu so that you can use it on selected soundbites in the Sequence Editor, too.

Clear Beats
The Clear Beats command (Audio menu > Audio Beats) removes all the beats from selected audio files.

Disable Beats under Strength Threshold
Choose Disable Beats under Strength Threshold to open a window with a slider that lets you enable or disable beats based on a strength threshold.

This window applies to the beats within the current selection; you can make a selection before or after you open this window (with the window
open). If there is no selection, it applies to all the beats in the file. No changes are made to beats until you click the Apply button.

Move the slider towards the right to disable more beats; move it to the left to disable fewer beats. Click Apply when you have the desired result. You can quickly disable or enable a large number of beats in one operation using this command.

The `Disable Beats under Strength Threshold` command is also available in the Audio menu so that you can use it on soundbites in the Sequence Editor, as well as audio being displayed in the Waveform Editor.

**New Soundbites from Beats**

The `New Soundbites from Beats` command (Audio menu > Audio Beats) lets you split up a soundbite into pieces at beat boundaries. This can be useful when making drastic tempo changes that would...
not be suitable for time stretching beats within a soundbite. In addition, there may be other circumstances where smaller split up regions can be more useful than whole soundbites.

When you choose the New Soundbites from Beats command, a window appears with a slider in it:

![Figure 44-3: Creating soundbites from beats.](image)

Select the soundbites you wish to split up (or make a time range selection) in the Sequence Editor. You can select the audio you wish to split up either before or after you open the New Soundbites from Beats window, and you can change your selection at any time before you click the Apply button. Before you click Apply, you’ll see a preview of where the splits will take place:

![Figure 44-4: A selected soundbite with preview slices for the New Soundbites from Beats command.](image)

**Controlling the frequency of the splits**
Move the slider to control how frequently the soundbite will be split up. Split points are added or removed from the operation based on their associated beat velocity. As you move the slider, beat velocities fall either above or below the threshold, to be included or excluded, respectively.

**Splitting audio across multiple tracks**
If you are splitting a single soundbite, or several soundbites that are all in the same track, choose Each Soundbite from Use Beats From menu.

If you are splitting audio in multiple tracks across the same time range, the Use Beats From menu gives you two basic choices:

<table>
<thead>
<tr>
<th>To do this</th>
<th>What to choose from the Use Beats From menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>To split each track independently</td>
<td>Choose Each Soundbite</td>
</tr>
<tr>
<td>To split all tracks at the same locations, based on a guide track</td>
<td>Choose the track that you wish to use as a guide track</td>
</tr>
</tbody>
</table>

Figure 44-2 below demonstrates the difference between using the Each Soundbite setting and using a guide track. Using a guide track can be useful when you need to edit consistently across all of the tracks involved. If they all share the same split points, this will help your edits remain consistent, especially with regard to maintaining phase coherence. This can be especially critical when editing drum tracks that were recorded simultaneously from different mic positions.

**Using Smooth Audio Edits after creating soundbites from beats**
A common application for the New Soundbites from Beats operation is to split up a drum track or percussion track and then slow down the tempo of the sequence. Typically, time-stretching audio to slow it down can produce artifacts. By splitting up the audio beforehand, a minimum of time stretching occurs, and instead, gaps appear between the individual drum track slices as they are moved further from one another by the slower playback tempo. This technique is good because it minimizes audio time stretching artifacts. However, the trade-off is that the gaps of silence between the slices are audible and sound unnatural. The Smooth Audio Edits feature can be a huge help in this situation by filling the gaps with room tone or other ambient noise that fills and completely masks the gaps between the slices. Numerous options are provided to produce the best results, based on the audio material. For details, see “Smooth Audio Edits” and “Smooth Audio Edits Again” on page 385.
**Copy Beats**

In multitrack audio recording projects, it is often useful to take the beats from a guide track and apply them to other tracks so that their beats match the guide track. You can then apply beat-based edits or processing consistently across the tracks.

For example, you might have a kick and snare track that represent the beat structure of your music perfectly, and you might wish to apply it to a highly syncopated conga track so that its beat-based edits are more consistent and in line with the overall music.

The *Copy Beats* command *(Audio menu > Audio Beats)* lets you copy beats from one track to another. When you choose the *Copy Beats* command, a window appears:

![Copy Beats Window](image)

*Figure 44-5: In this example, beats are being copied from the click track to the guitar and drum tracks.*
Select both the source and destination soundbites or tracks. You can select them either before or after you open the *Copy Beats* window, and you can change your selection at any time before you click the *Copy* button. Before you click *Copy*, you’ll see a preview of the beats that will be copied, as shown in Figure 44-5 on page 405.

**Choosing the source track and beat frequency**

Choose the desired source track from the *Copy beats from* menu, as demonstrated in Figure 44-5. Move the slider to control the frequency of the beats to be copied. Beats are added or removed from the operation based on their associated beat velocity. As you move the slider, beat velocities fall either above or below the threshold, to be included or excluded, respectively. After you have the beat slider set as desired, click *Apply*.

**Copy Beats As MIDI**

Choose *Copy Beats as MIDI* to create a MIDI data stream with a MIDI note corresponding to each beat; each note’s start time is the relevant beat’s start time, and the note’s velocity is that beat’s strength. The end time of each note is set just before the following note’s start time. This MIDI data will then be placed in the Clipboard and, like all copied MIDI data, it can be pasted to any MIDI track.

**USING THE BEAT GRID**

The *Beat Grid* option in the Snap Information panel (Figure 38-2 on page 331) snaps your selection and edit operations to the beats within the waveform. Editing to the Beat Grid is different than editing to the time ruler Edit Grid. With the Edit Grid, your actions snap to the specified beat resolution at regularly spaced intervals that are prescribed by Performer Lite’s time ruler. But with the Beat Grid, your actions snap to actual beats within the waveform, as specified by the beat locations in the waveform, even if they don’t match up with beats in the time ruler.

Essentially, the Beat Grid allows you to edit to the audio data, instead of to the project’s time ruler. This is very powerful, especially when making edits that must remain faithful to the feel or “groove” of the audio, as this would not be reflected in the time ruler grid. Further, Performer Lite’s Beat Detection Engine goes to great lengths to place beats at exact transient onsets, usually down to the sample. This makes beat editing extremely accurate.

Beat Grid snapping works similarly to marker snapping: when you drag close to a beat, it snaps. But if you are not close to a beat, it won’t snap.

The Beat Grid can be enabled with the *Snap to Beats* checkbox in the Snap Information window. In the Sequence Editor, you can extend the selection across multiple audio tracks. In this case, your actions snap to the beats in the track under the cursor, so move the cursor over the track that contains the beat you wish to snap to.

If the Beat Grid is currently turned on, hold down the Command/Ctrl key to temporarily turn it off.

You can enable the Edit Grid, the Beat Grid and marker snapping at the same time, if you wish. In this case, your actions will snap to all three.
STRETCHING AUDIO BEATS

You can use beat markers to move — or stretch — their corresponding audio beat earlier or later in time, relative to the surrounding beats. This lets you seamlessly tweak the timing of individual beats in your audio.

In the Sequence Editor, choose the Stretch edit layer, as shown in Figure 44-7. Also be sure that Stretch mode is enabled for the track (see “Stretch” on page 59). Grab the beat you wish and drag it left or right. Use the Snap to Grid setting to determine the anchor points on either side of the beat you wish to drag, represented by purple lines. You might need to experiment a little bit to find the right grid setting, depending on the material. You can include surrounding beats if you wish, but if you only want to stretch the beat you are grabbing, choose a grid setting small enough that the surrounding beats don’t move when you drag the beat.

You can stretch as many audio beats as you wish in the Stretch layer.

Adjusting anchor points

If needed, you can drag the anchor points themselves using the arrow cursor shown in Figure 44-7. This gives you more control over the span of the audio affected by your adjustment. Often, anchor points have an initial position on an beat marker. Simply move the cursor over the purple line until it appears as an arrow cursor (rather than the hand cursor, which drags the beat itself). The arrow cursor moves the anchor point.

Clearing stretch edits

To clear a stretch edit, click the beat marker to select it (it turns yellow) and either hit the backspace key or choose Edit menu > Erase. You can also make a time range selection to clear multiple stretch edits in one operation. To clear all stretch edits in a soundbite, select it and choose Audio menu > Pitch and Stretch > Clear Bite Stretch.

Figure 44-7: The Stretch layer in the Sequence Editor. The Snap to Grid setting determines the anchor points surrounding the beat you drag.
**Quantize, Groove Quantize and beat stretching**

If you quantize or groove quantize beats within audio (as explained in the next few sections), those operations will override any manual beat stretching you’ve done to the audio. Conversely, however, you can certainly make manual tweaks to beats after applying Quantize or Groove Quantize, to further tweak the feel of the audio beats post quantizing.

**QUANTIZING BEATS WITHIN SOUNDBITES**

Soundbites that have been beat-analyzed (and have beats) can be quantized, without the need for splitting them into smaller soundbites first. Instead, the beats within the soundbite are quantized by many small time-stretching operations between each beat. Audio quality is preserved, and each beat is moved, just like MIDI notes, according to the settings in the Quantize dialog.

In general, quantizing beats within soundbites will produce best results when the soundbite has already been tempo-analyzed (as described later in this chapter) and has been adjusted to match the tempo of the sequence. Quantizing then fine-tunes beat placement with respect to the project’s time ruler grid.

To quantize the beats within a soundbite:

1. Select the soundbite and choose *Region menu → Quantize* (Figure 40-12 on page 352).

2. From the *What to quantize* menu, choose *Beats within Soundbites* and *Attacks* (if you are quantizing both audio and MIDI notes).

3. Choose the other settings in the Quantize dialog as desired.

When quantizing beats within audio, the *Attacks*, *Releases* and *Don’t change note durations* options are ignored, as these three options apply to MIDI notes only. The rest of the settings in the Quantize dialog apply to both MIDI and audio, including tuplet quantization, grid offset, swing, sensitivity, strength and randomize.

4. Click Apply.

**Beats within audio quantize differently than MIDI notes**

Beats within audio quantize slightly differently than MIDI notes. When you quantize MIDI notes, every single note moves to the nearest grid point (subject to the other settings you may have specified, such as strength, etc.) However, this is not the case for beats within audio. Instead, Performer Lite employs a more useful algorithm, which moves only the beat closest to each grid point and then smoothly scales all others between them. This produces much more useful results for audio, as it time-stretches the audio as little as possible while still achieving the desired...
quantizing results. As long as you choose a grid resolution that is appropriate for the audio (e.g. a 16th note grid for audio that has a 16th note subdivision pulse), then you’ll get great results.

**Previewing**
The real-time *Preview* button in the Quantize window (Figure 40-12 on page 352) only previews the quantize effect for MIDI data. It does not provide a real-time preview for beats within audio.

**Audio stretch and quantizing**
The *Stretch* audio track setting (“Stretch” on page 59) has an impact on quantizing beats within audio. If it is enabled, quantizing occurs in the Stretch layer of the track. This means that any stretch edits you’ve previously made to the material being quantized will be replaced by the quantize operation. In addition, you can go into the Stretch layer after quantizing and view the results of the quantizing, as explained in “Stretching audio beats” on page 407. You can even further hand-tweak beat locations, if you wish.

**APPLYING A GROOVE TO BEATS WITHIN SOUNDBITES**
Applying a groove to beats within soundbites works in a similar fashion as described above for quantizing. Select the soundbite and choose *Region menu* > *Groove Quantize*. In the case of Groove Quantize, however, there is no *What to Quantize* setting. The groove is applied to any selected MIDI notes and any beats within selected soundbites. All settings in the Groove Quantize window are applied to audio. The *velocity* slider applies the appropriate value to beat velocities. If the Stretch layer is enabled, you can further hand-tweak individual beats in the Stretch layer afterwards.

**EXTRACTING A GROOVE FROM AUDIO**
To extract a groove from audio, select the audio in any window and choose *Region menu* > *Create Groove*. Choose a groove file to save the new groove to, or create a new groove file. Name the groove and then click OK. Beat timing, velocities and duration are saved in the groove. You can then apply the groove to MIDI data and/or audio data.

** IDEAS FOR QUANTIZING AUDIO**
Performer Lite’s audio quantize, groove quantize and groove extraction features are very powerful and offer many creative opportunities. Here are a few things you can do when quantizing or groove quantizing audio:

- Take an existing audio recording with sloppy timing and quantize it to clean up the timing.
- Extract the rhythmic feel of an audio recording and then apply it to other audio tracks and/or MIDI tracks.
- Turn a loop with a straight feel into a shuffle feel, using one of the MPC shuffles - or any other shuffle groove.
- Tighten the timing of several rhythm section tracks (keys, bass, drum, rhythm guitar, etc.) by quantizing them with varying degrees of quantize strength.
- Take an existing audio recording with slight tempo changes in it make it a constant tempo throughout.

**BEATS DETERMINE TEMPO DETECTION**
Performer Lite uses beats to determine tempo. Even if beats are found at somewhat irregular intervals, the tempo analysis can, in most cases, still discern the correct tempo.

The tempo analyzer builds a tempo map by determining which beats represent the music’s barlines. Using this technique, the tempo analyzer is capable of creating sophisticated tempo maps.
that track long passages of recorded music. The tempo analyzer can save hours of painstaking tempo adjustments by tracking the tempo of your recordings automatically.

Since Performer Lite’s beat detection is sample accurate, the tempo analyzer is capable of determining very precise tempos for audio. It works best on steady, rhythmic, monophonic audio, but it is capable of tracking complex music with multiple instruments or live recordings with room noise. In most cases it determines the correct tempo, but there are some audio files, particularly long files of mixed music with varying tempo, where it can chooses the wrong tempo for sections of the music.

EDITING BEATS TO IMPROVE TEMPO DETECTION
Understanding how the tempo analyzer chooses tempos will allow you to guide its tempo detection. Often, only one or two adjustments to the beats in an audio file are needed in order for the tempo analyzer to compute the correct tempo throughout the file. By moving, enabling or disabling beats (as discussed earlier in this chapter) and reanalyzing the file’s tempo, you can effect the decisions that the tempo analyzer will make.

The tempo analyzer will only place tempo changes directly on beats with the goal of choosing which beats to align with measure boundaries. When it chooses the wrong tempo, it has likely chosen a beat near a barline but one that is slightly ahead of or behind the barline. This causes the resulting tempo at that location in the file to be incorrect.

In this case, you can try moving the offending beat to the correct position, and then reanalyzing the file. Other common cases are melody lines or vocals that are not precisely aligned with the barlines to which they were performed. For example, the singer might come in just a little early, before the beat. These vocalizations can be louder than other beats that would make better guides for the tempo analyzer. Disabling these beats will often produce more accurate tempos.

Here’s another common case: often the rhythmic elements of the music are represented by the loudest beats. If so, you can use Disable Beats under Strength Threshold (page 402) to disable quieter beats.

REANALYZING TEMPO AFTER EDITING BEATS
In all cases, you can freely experiment with beat adjustments. Just reanalyze the tempo again. You can reanalyze tempo as many times as you wish.

ADJUSTING SOUNDBITE TEMPO MAPS
The Soundbite Tempo sub-menu (Audio menu) provides several useful commands for further adjusting soundbite tempo maps. See “Audio menu > Soundbite Tempo” on page 396.
Performers Lite allows you to record, playback, and edit MIDI System Exclusive (SysEx) messages. Common types of System Exclusive messages include patch dumps, preset selections, editing parameters, etc. Performer Lite can thus store patches, samples, and other important information from your MIDI equipment in System exclusive form. Patches, edit parameters, and other special commands can be incorporated into musical sequences, greatly expanding the resources of your MIDI sound modules.

Basics ................................................................. 411
Recording and playing SysEx messages ........ 411
Viewing and editing SysEx data ..................... 412
Editing data in the system exclusive window .... 413
Inserting SysEx data ............................................ 414
Editing SysEx data with the Edit Menu .......... 414
Transmitting a SysEx message ................. 414
Recording SysEx into the Editor Window ...... 415
Recording SysEx into a track ......................... 415
Hints ................................................................. 415
Be Careful ......................................................... 416

BASICS
System Exclusive messages are a special type of MIDI data. A System Exclusive message consists of a header, body, and an ‘end of message’ byte. (A byte is a unit of digital information, roughly equivalent to a single character or letter.)

The header labels the following data as System Exclusive information, and includes a code identifying the manufacturer of the equipment transmitting the data.

The body of the message contains the actual data being sent. This data may take any form the manufacturer desires. There are some standards for the format of System Exclusive information, but for the most part a System Exclusive message is only understood by the type of equipment that generated it. As a result, recording a patch dump from one synthesizer and sending it to another will generally not produce useful results. Performer Lite does not respond to or interpret System Exclusive data; any analysis or editing of the body of the message is the user’s responsibility.

Finally, the end of message byte, F7, marks the end of the System Exclusive data, and signals Performer Lite to interpret subsequent information as standard MIDI data.

As defined in the MIDI specification, a System Exclusive message must begin and end with an F0 and F7 byte, respectively. In addition, only hexadecimal values of 7F (127 in base ten) or less are allowed. When you click the OK button after inserting or editing the contents of a System Exclusive event, Performer Lite will scroll to and highlight any bytes that violate the conditions just stated.

RECORDING AND PLAYING SYSEX MESSAGES
System Exclusive messages are recorded and played back like any other MIDI data. These messages vary in size; information for a bank of patches, for instance, may be 10-20K or more. No matter how long a message is, it is treated as a single event by Performer Lite. Note that a long System Exclusive message can briefly halt recording or playback as Performer Lite processes the data; it is best to place larger System Exclusive events like patch or bank dumps in separate sequences, or at the start of a sequence before the actual music begins.
Because System Exclusive messages have no channel assignment, they are sent to every MIDI device connected to a port. If you have several devices of the same model or brand connected to the same port they may all respond to a message sent to or from just one of them. Conversely, some manufacturers encode channel assignments into the body of the System Exclusive message. Performer Lite is unable to access or rechannelize such an assignment.

For example, if the playback assignment for a track is channel 1, but a System Exclusive message full of patches intended for that synth includes an encoded assignment to channel 16, the synth won’t receive the patches.

Find out if any of your equipment encodes channel assignments in its System Exclusive messages, and be careful about changing channel assignments on equipment to which you intend to send System Exclusive. If you encounter difficulty when working with System Exclusive data, try patching the MIDI device directly to your MIDI interface to prevent interaction with other equipment.

Note that the Input Filter, found in Performer Lite’s Setup menu, defaults to System Exclusive unchecked. Unless you explicitly check the box next to System Exclusive, you will be unable to record System Exclusive messages.

VIEWING AND EDITING SYSEX DATA
System Exclusive data can be viewed and edited as a singular event in System Exclusive edit layer in MIDI tracks or clips:

To see the entire message, Option/Alt-click or double-click on the System Exclusive event. A window appears:

The window is divided into a top and bottom portion. The bottom portion displays the system exclusive data contained in the event. The top portion is used to type in and transmit short system exclusive “request” messages, which can be sent to a synthesizer that requires a short system exclusive bulk dump request message to initiate a bulk dump to be recorded into the lower portion of the window.

The System Exclusive data is displayed in hexadecimal (base 16) numbering. Each pair of hexadecimal digits, which include the numerals 0-9 and the letters A-F, represents a byte of data. Each line contains eight pairs of digits. To the left of each line of data is a two-digit hexadecimal number indicating the position of the first byte of data in that row. The first row starts at position 00, the next at 08, the third at 10 (this equals 16 in hexadecimal), and so forth. To the right of each row of data is its translation into alphanumeric
characters (using the ASCII standard). Most of the
time this translation will be garbled and useless,
but patch names and other text in the System
Exclusive message may be visible.

The length of the System Exclusive message is
displayed at the top left. This is the number of
bytes of data in the message.

The scroll bars let you scroll through long
messages. The Grow box in the lower right corner
lets you adjust the size of the window. When you
press the OK button, Performer Lite checks the
changes you have made to the data and will scroll
to and highlight any byte that does not conform to
the MIDI specification. After confirming your
changes, Performer Lite closes the window.
Pressing the Cancel button closes the window
without making any changes to the data.

EDITING DATA IN THE SYSTEM EXCLUSIVE
WINDOW
You can directly edit the hexadecimal data in the
System Exclusive window using the mouse and
computer keyboard. There are two basic editing
modes: Insertion mode and Replacement mode.
The editing mode is selected by clicking on the
appropriate button at the top center of the
window; the currently selected mode is indicated
with a darkened border.

Insertion mode: This mode is similar to standard
computer text entry. To insert new values, click the
mouse to position the insertion point, and type in
new values. Use the delete key to delete previous
digits. You may edit only in the hexadecimal
portion of the display.

Replacement mode: In this mode, one character is
always highlighted. Typing a new character
replaces the current highlighted character, and
then highlights the next character. Use this mode
if you are just changing a few bytes in a system
exclusive message.

To edit a System Exclusive event:

1 Double-click on the System Exclusive event.
The System Exclusive window appears.

2 Select the editing mode.
Click on the appropriate button. If just a few bytes
need to be edited, use Replacement mode.
Otherwise, use Insertion mode.

3 Edit the data.
In Insertion mode, delete the incorrect bytes and
type in new data. In Replacement mode, click on
the first digit of data to be replaced and type in the
new data. The old data is written over.

4 Press OK to confirm your changes and close the
window, or Cancel to close the window without
making any changes to the data.

If you press OK, Performer Lite will scroll to and
highlight any byte that does not conform to MIDI
specification requirements.

Cutting, Copying, and Pasting
To Cut, Copy, or Paste a selection of hex data in
replacement mode:

1 Select the data.
To do so, drag over it with the mouse.
2 Cut, copy, or replace the selection.

To Cut or Copy, press Command/Ctrl-X or Command/Ctrl-C respectively. The selected data will be placed in the Clipboard. To replace the selected data, type in or paste new data, which will replace the highlighted data.

**INSERTING SYSEX DATA**

You can insert system exclusive data into a track or clip. This is handy for inserting a short system exclusive message, like a parameter change or dump request, without having to record it.

To insert a System Exclusive event into a track or clip:

1 Display the target track in the Sequence Editor or the target clip in the Clip Editor.

2 Choose System Exclusive from the Insert menu.

3 Click at the desired location in the track.

The System Exclusive window appears.

4 Select Insertion mode.

Click on the Insertion mode button at the center of the window.

5 Type in the data.

In Insertion mode, you can delete the incorrect bytes and type in new data. See the above section on editing System Exclusive data for more information.

6 Press OK to confirm the insert and close the window, or Cancel to cancel the insert and close the window.

When confirming your insert, Performer Lite will scroll to and highlight any byte that does not conform to MIDI specification requirements.

**EDITING SYSEX DATA WITH THE EDIT MENU**

The commands on the Edit menu work as normal on System Exclusive events; these events can be cut, pasted, shifted, etc. within a file or between files just like any other Performer Lite event. The only way to alter the body of a System Exclusive message is to use the System Exclusive window as described above. In all other cases, Performer Lite treats the message as a single event.

**TRANSMITTING A SYSEX MESSAGE**

To transmit a system exclusive message from the system exclusive editor window:

1 Click the insertion mode button.

2 Click between the F0 and F7 in the top portion of the window.

3 Type in the system exclusive data.

4 Click Transmit.
RECORDING SYSEX INTO THE EDITOR WINDOW
To record system exclusive into the system exclusive editor window:

1 Be sure that your MIDI hardware and cables are set up properly.

Make sure there is a MIDI cable from the MIDI OUT on the device you will be recording from to the MIDI IN on your interface.

2 Insert a sysex event as described earlier in “Inserting SysEx data” on page 414.

The system exclusive editor window will appear.

3 If necessary, type in a bulk dump request message in the top portion of the window.

This is only necessary if your synth requires it. Many synths allow you to initiate the transfer by pressing a button on the synth itself.

4 Initiate the system exclusive data transfer from your MIDI device.

To do so, press the button on the device—or whatever is needed—to cause it to transmit the desired system exclusive dump.

5 Wait a few seconds, longer if it is a large bulk dump, and then stop recording.

6 Look in the track in the Sequence Editor.

If you do not see a System Exclusive event, check the cable connections and try again.

HINTS
Most synthesizers and many other MIDI devices allow you to dump patch settings as System Exclusive messages. You can use Performer Lite to store and organize these messages, creating a library of patches and presets. Store each patch or bank of patches as a separate sequence in one or more files. This way you can use the name and comment fields to label your presets.

You can paste System Exclusive dumps of sounds and settings at the start of a sequence. This lets you use patches or settings that can’t fit into your MIDI devices’ preset storage, and ensures that the right sounds are loaded for the sequence. Use the standard Copy and Paste commands to place the system exclusive events at the start of the sequence. It is best to leave a measure or two of space after the system exclusive messages and the start of the music, to allow your equipment to process the data. Use the comments fields in the Set List to describe the system exclusive data.

RECORDING SYSEX INTO A TRACK
To record a system exclusive message into a track:

1 Be sure that your MIDI hardware and cables are set up properly.

Make sure there is a MIDI cable from the MIDI OUT on the device you will be recording from to the MIDI IN on your interface.

2 Record-enable a track.

3 Start recording.

4 Send the system exclusive data from your MIDI device.

To do so, press the button on the device—or whatever is needed—to cause it to transmit the desired system exclusive dump.

5 Wait a few seconds, longer if it is a large bulk dump, and then stop recording.

6 Look in the track in the Sequence Editor.

If you do not see a System Exclusive event, check the cable connections and try again.
you’ve pasted into your sequence; system exclusive messages are hard to identify from their appearance.

Some manufacturers allow you to edit patch parameters over MIDI, using short system exclusive messages. This can add a great deal of expression to a sequence. For example, the attack of a filter envelope could be controlled with system exclusive and controller data, creating different bowing effects for a violin patch.

Some instruments must receive a handshake message before they will transmit a System Exclusive message. If this is the case with one of your MIDI instruments, first consult the user’s manual for the instrument (or if necessary, the manufacturer) to find out the hexadecimal string that comprises the handshake message. Type this message into a Performer Lite track using the System Exclusive editing window as described above, then copy the track and paste it to a ‘library’ sequence for backup purposes. Back in the original sequence, play-enable the track containing the handshake message and record-enable an empty track. Upon playback, the handshake will be transmitted to the instrument, which will respond by dumping to the record-enabled track.

**BE CAREFUL**
System exclusive data is complex, and varies greatly from device to device. If you are uncertain about your equipment’s system exclusive implementation, you should be very careful in using or editing system exclusive data. Most of the time, turning a piece of equipment off and then on again will clear any strange behavior caused by incorrect system exclusive data; however, incorrect use of system exclusive data could permanently erase presets from a synthesizer or other MIDI device.

System exclusive data is not associated with a channel, as defined in the MIDI specification. System exclusive data in a track is merely sent to the port you specify for playback; no channel number can be attached. Some manufacturers have decided to include a channel number in some of their system exclusive messages. This number cannot be changed. Therefore, even if data is being sent to channel 3, for example, system exclusive messages contained in that data might be sent to a channel other than 3.
CHAPTER 46 Conductor Track

OVERVIEW
The Conductor track is a special track containing markers, meter, tempo and key change information. Every sequence has a Conductor track; it cannot be deleted. You may use the commands from the Edit menu in the Conductor track to Cut, Paste, Repeat, Shift, and otherwise edit tempo, meter, and key maps, as well as markers. In addition, the Conductor track can be used to directly insert simple tempo, meter, and key changes, as well as to ‘record’ a tempo map entered in real time using Tap tempo synchronization. The Conductor Track can be edited in the Sequence Editor.

Types of Conductor track events
The Conductor track contains the following types of events:

- Tempo changes
- Meter changes
- Key changes
- Markers
- Click changes

These events are not MIDI data; instead, they control or conduct your music’s performance during playback. These events can, however, be edited like standard MIDI events, either with the commands on the edit menu or directly in the Sequence Editor. Markers, click changes and film cue events may be edited in the Conductor Track with edit menu commands such as Cut, Copy and Paste.

The following sections describe each type of event in some detail; for more information on the Change Key, Change Meter, and Change Tempo commands, the Markers window, or film cue events, see their respective chapters.

Key changes

Key change events display the name of the key. User-defined key signatures are displayed as ‘Custom’. See chapter 50, “Change Key” (page 448) for a full description of key signatures in Performer Lite.

Meter changes

Meter change events display the time signature (the number of beats per measure, over the duration value which gets the beat) and the click value, (the duration value between metronome clicks). See chapter 49, “Change Meter” (page 443) for more information about these values. Moving meter change events, or inserting them using the Insert button, can cause partial measures. See “Meter changes and partial measures” on page 423 before attempting to move or insert a meter change.
Tempo changes

Tempo change events display the duration value for the tempo marking, i.e. the note value of the basic beat, and the tempo value itself, as a certain number of beats per minute. Tempo changes can appear as a single event, indicating an abrupt change in tempo, or as a series of events, approximating a smooth increase or decrease in tempo. In this regard they resemble continuous controller data. For more information on tempo events, see chapter 48, “Change Tempo” (page 435).

Tempo changes can be inserted graphically in the Conductor Track with the Pencil tool. See “Inserting CC data in Points or Bars mode” on page 299.

For information on recording a tempo map in real time, see “Tap Tempo” on page 560. Recording in Tap Tempo creates normal tempo events.

See “Editing in the Conductor Track” on page 421 for information on editing tempo changes graphically.

Viewing and typing in frame click tempos
If you write music for film, you might be accustomed to expressing tempos in frame-clicks as well as beats per minute. In Performer Lite, you can type in tempos using either format. You can also display tempos throughout the program, including the Change Tempo dialog, in frame click tempos (e.g. 12-6 or 13/4).

Markers can be edited with Edit menu commands such as Cut, Copy and Paste. To add a new marker, use the Markers window New Marker mini-menu command.

Click Changes
You can insert click change events in the Conductor track. There are three types of click change events: beat click, tacet click, and pattern click. Together, these click change events give you complete flexibility in programming even the most elaborate click tracks. For example, conductors of film cues can customize the click for each cue in ways that are commonly used on sound stages when recording music for films.

Beat click

A beat click event creates clicks on an even subdivision of the current beat. They are identical to the beat click that is part of a meter change event, except that they are independent of any meter change events. For example, you could insert a meter change event that clicks every quarter note, but then insert a beat click event a few measures later that clicks every eighth note.

Changing the beat sub-division of the click in this manner can be useful in a wide variety of situations. For example, clicking on quarter note downbeats might work at a medium tempo, but if the tempo then slows down due to a tempo change, then switching to eighth note clicks might work better.

Beat click events allow you to program any click pattern you wish by inserting a new beat click event whenever you wish to change the click.

Tacet click
A *tacet click* event silences the click until the next (non-tacet) click event in the Conductor track. For example, you might create a countoff in which the last two clicks before the downbeat are silent.

**Pattern click**

A *pattern click* is a customized click pattern that you program. Pattern clicks use an editable text code field for programming the pattern. You can easily program and audition different patterns in the Countoff or Click Defaults preferences windows (see “Click Preferences” on page 96), where you can choose *Pattern* for the click style and then type in different text codes and listen to the audition of the click to hear what they create. The syntax is as follows:

<table>
<thead>
<tr>
<th>What you type</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 1 1 1 / 4</td>
<td>Four quarter notes</td>
</tr>
<tr>
<td>2 2 1 1 1 / 8</td>
<td>Two quarter notes followed by four 8th notes</td>
</tr>
<tr>
<td>3 3 1 1 3 / 8d</td>
<td>Two dotted eighths, three 16th notes, then another dotted 8th</td>
</tr>
</tbody>
</table>

Somewhere in the string there is usually a number followed by a slash followed by a note type indicator, such as the “1 / 4” in the first example, above. The note type indicator must be one of the following:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Note type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Whole note</td>
</tr>
<tr>
<td>2</td>
<td>Half note</td>
</tr>
<tr>
<td>2t</td>
<td>Half note triplet</td>
</tr>
<tr>
<td>2d</td>
<td>Dotted half note</td>
</tr>
<tr>
<td>4</td>
<td>Quarter note</td>
</tr>
<tr>
<td>4t</td>
<td>Quarter note triplet</td>
</tr>
<tr>
<td>4d</td>
<td>Dotted quarter note</td>
</tr>
<tr>
<td>8</td>
<td>Eighth note</td>
</tr>
</tbody>
</table>

The number before the slash determines what numeric value is associated with the given note type indicator. So, “2 / 4” means “everywhere a 2 appears in this string, interpret that 2 as a quarter note.” If 2 means a quarter note, then 4 (twice as big as 2) means half note, and 1 (half as big as 2) means 8th note.

Often the slash will appear at the end of the string, but it can appear anywhere in the string. For example, the string “3 / 4 3 3 1 1 1 / 8” means that 3 equals a quarter note, making the pattern three quarter notes followed by three eighth note triplets.

If you don’t use the slash anywhere in the string, then the number 1 is assumed to mean an 8th note, and all other numbers a multiple of 8th notes. Therefore, the string “1 1 1 1”, with no slashes anywhere, means four 8th notes and the string “2 2 2 2”, with no slashes anywhere, means four quarter notes.

You can use any character you like to separate the numbers in the pattern code string. Spaces work well because they help keep the expression simple and clear. But you can also use the plus or period characters, which are handy in the number keypad, or any other non-digit. The parser just
looks for the next digit, slash, or non-digit, and understands that digits right next to each other make up a single multi-digit number.

So, if you want to be obscure, you could type:

```
256+256*256@256 ~ ~ / ===== 4
```

The above expression would mean four quarter notes, because the computer sees:

```
256 256 256 256 / 4
```

As a practical example, you could use the plus or the period key as a separator, making it quick and easy to type in the expression using just the numeric keypad.

**Accenting a click**

To accent a click in a pattern click, highlight the number you want to accent in the pattern code text and type Command/Ctrl-B. That makes it bold and red. Bold and red clicks are accented, plain black ones are not. Select an accented click and type Command/Ctrl-B again to remove the accent.

**Saving custom click patterns**

When you access the click type menu on a click change event, there are additional items at the bottom of the menu that let you create and save click patterns by name using the Save Pattern menu command (Figure 46-1).

---

**EDITING IN THE CONDUCTOR TRACK**

Conductor Track editing is similar to a regular MIDI track but has several differences. It does not have a Note Grid because the Conductor Track cannot contain notes. In addition, the Conductor Track has a Tempo Change Grid similar to the CC data Grid that displays tempo changes only.

**Working with meter and key changes**

Working with meter and key changes in the Conductor Track is similar to working with discrete MIDI events: first select the desired data type from the Conductor Track’s Edit Layer menu (Figure 46-2 on page 421).

To edit the settings of a meter or key change, click it to select it and then edit its values in the Information Bar.

To move a meter or key change, drag it left or right to change its location. Moving meter changes can produce partial measures and other situations that require an in-depth knowledge of how meter changes work. Before dragging meter changes, be sure to review chapter 49, “Change Meter” (page 443).

**Inserting a meter/ or key change**

To insert a meter change or key change:

1. If desired, set the Edit Resolution and turn on Snap to Grid (see “Snap to Grid” on page 331).
2 Choose either Meter Change or Key Change from the Conductor Track’s Insert menu (Figure 46-2 on page 421).

3 Click once at the desired time location in the track lane.

The meter or key change event will appear where you clicked. You can then modify its settings in the Information Bar.

**Working with markers**

Choose Markers from the Conductor Track Edit Layer menu (Figure 46-2 on page 421). Double-click a marker to change its name. Drag it to move it. Select it and hit the delete key to remove it. You can also cut, copy and paste markers. To insert markers, drag and drop them from the marker well into the marker strip (see “Markers” on page 109).

**The Tempo Change Grid**

Tempo changes are displayed and edited on the Tempo Change grid (Figure 46-2 on page 421) in the same fashion as CC data, except that the Tempo Grid is displayed in Bars mode only. Each tempo change event is displayed on the grid as a dot with a colored bar extending to its right until the next tempo event. When the tempo change event is selected, a line extends from its icon to the origin at the bottom of the grid. A tempo change ruler on the left measures events on the grid. Tempo changes can be selected and edited in the same way as a selected CC data type. For more information, “Editing MIDI CC’s in Points or Bars mode” on page 299.

**Inserting tempo changes**

Follow the same procedure for inserting CC data. See “Inserting CC data in Points or Bars mode” on page 299.

---

**Getting Performer Lite to follow tempo changes**

Performer Lite follows tempo changes when it is placed in *Conductor Track* tempo mode. For details, see chapter 48, “Change Tempo” (page 435).

**Zooming the Tempo Ruler**

The Tempo ruler in the Conductor track can be zoomed in for more precise tempo editing. Clicking the Tempo ruler toggles quickly between your custom zoom scale and the normal scale.

To zoom the Tempo ruler, drag over the range of values you wish to zoom. The Tempo ruler will zoom in on the range that you select. Then click the Tempo ruler to toggle between your custom zoom scale and the normal scale.

---

**Figure 46-3:** You can zoom in the Tempo Ruler to get better resolution when editing tempos. Just drag over the range you want to zoom in on, and then click the ruler to toggle between the zoomed in range and the normal range.

**Using Edit menu commands on the Conductor Track**

The Edit commands Cut, Copy, Paste, Erase, Duplicate, Repeat, and Paste and merge all function on the events in the Conductor track.
You can use them to move tempo and meter changes together with other tracks in a sequence, shift tempo maps for precise alignment with synchronized video or audio, or to repeat tempo, meter, and key changes in looped sections. You can insert and edit tempos in the Conductor track without stopping playback.

Be sure to learn how Performer Lite’s Smart Selections feature affects Conductor Track editing by reading “Barlines are preserved in the Conductor track” on page 288.

To use the Edit commands on the Conductor track of a sequence:

1. Highlight the Conductor track name in the Sequence Editor and make a time range selection in the Conductor track.
2. Select the desired command from the Edit menu.

The Edit menu commands affect events in the Conductor track in the same way as normal MIDI data. See chapter 34, “Selecting” (page 281) and chapter 33, “Editing Basics” (page 272) for more on how to select regions and use these commands.

When a region is cut or copied from the Conductor track, meter and tempo events representing the current meter and tempo values are automatically inserted at the beginning of the region in the clipboard. This guarantees that the region will keep its original meter and tempo when pasted elsewhere in the sequence. These automatically created meter and tempo change events may be edited normally after the region is pasted back into the Conductor track.

Note that editing meter changes can cause partial measures. See “Meter changes and partial measures” on page 423.

**Meter changes and partial measures**

Performer Lite lets you place a Meter change event anywhere in a sequence. This allows a great deal of flexibility in laying out your music, but can produce unexpected results. For example, it is possible to place a Meter change in the middle of a measure, but this measure will be truncated at the location you specify for the new meter. This location becomes the downbeat of the first measure in the new meter.

The following simple rule should help clarify what happens in such situations:

» A Meter change event always starts a new measure.

For example, if you insert a meter at 3|1|240, the meter change location will change to 3|1|000. This is because a meter must begin a new measure, and all measures begin at zero (000) ticks.

Here’s another example: if you insert a 3/4 meter at the third beat of a 4/4 measure, the result is a two-beat measure (still marked as 4/4!) followed by a whole 3/4 measure. Inserting the Meter change results in a partial measure, that is, a measure lacking its full duration.

Such partial measures are not always useful, but they can be handy in lining up cues for film and video work, since they let you start a measure precisely at a SMPTE time by creating a meter change at the right spot.

Partial measures may also result from using the Edit commands to Paste, Merge, or Repeat meter changes in the middle of existing measures. Once again, each new meter change event will begin a new measure.

You can help avoid partial measures by leaving the Smart Selections command in the Edit menu checked when you are editing the Conductor track.
Correcting unwanted partial measures
It is important to remember that meter changes only affect the way data is displayed; they never affect the MIDI data itself or the way it sounds when it is played back. If the meter map for a sequence becomes complex or confusing during editing, simply erase the meter changes and re-enter them from the start of the region.

Looping and the Conductor track
The Conductor track cannot be looped. If you need to repeat tempo or meter changes in a looped region, use the Repeat command from the Edit menu to make consecutive copies of the Conductor track over that region.

When using the Memory Cycle feature to play a section repeatedly, meter and tempo changes in the conductor track will play as usual. When doing so, it is often useful to switch tempo control in the Control Panel to the Tempo slider. Doing so temporarily disables tempo changes so that they don’t complicate recording.
CHAPTER 47  Markers

OVERVIEW
The Markers window allows you to display and edit the markers for a sequence. A marker is a name attached to a particular location. The Markers window can be used as a sophisticated autolocator, allowing you to move to a location instantly. The Markers window provides an easy way to organize your music; markers are visible in edit windows and are useful in quickly specifying editing regions. Markers are particularly useful when working with film and video; you can record them in real time to mark hit points, then use the Markers window as an intelligent cue sheet. With the commands in the Conductor Track sub-menu (in the Project menu) you can then adjust meters and tempos to automatically align musical cues to the hit points.

Overview ................................................. 425
Markers window quick reference .............. 426
Markers window menu ............................. 427
Basics .................................................. 427
Opening a Markers Window ....................... 428
Switching between sequences and songs ...... 428
Scrolling during playback ......................... 428
Creating new markers .............................. 428
Changing the name of a marker .................. 428
Changing a marker time location ................. 429
Marker streamer, punch & Flutter settings .... 429
Custom pre-gap for CD Burn ..................... 429
Setting the counter to a marker location ...... 429
Marker locate numbers ............................ 429
Jumping to a marker with a shortcut .......... 430
Selecting markers ................................. 430
Using markers to define an edit region ......... 430
Selecting with markers ........................... 431
Markers in edit windows ......................... 431
Markers in the Song window .................... 431
Editing markers in the conductor track ....... 431
Locking and unlocking markers .................. 432
Shifting locked markers in time .................. 432
Locked markers and the sequence start time .. 432
Locked markers and changing meter .......... 432
Recording hits ....................................... 432
Using markers to find a tempo ................... 433
Streamers ............................................ 433
Marker hints .......................................... 433
MARKERS WINDOW QUICK REFERENCE

**Position indicator:** Displays the current location in the Chunk. Drag on the indicator to move it. Click anywhere in this area to move the indicator to a marker. Moving the indicator changes the current location in the Chunk.

**Marker name:** Click on a marker’s name to select it. Option/Alt-click on the name to change it. Drag over several names to select several markers. Use Command/Ctrl-click to select or deselect several non-contiguous markers.

**Search:** Type in a marker name to search for it.

**Marker location:** Displays the marker locations in your choice of Performer Lite’s various time formats, including SMPTE time code. Click on a location to change it. Select the formats you wish to see in the Time Formats window (Setup menu).

**Locked indicator:** Indicates that the marker is locked to SMPTE frame time. Toggle from locked to unlocked and back by clicking in the lock column next to the marker name. Drag vertically to toggle multiple markers in a single gesture.

**NUM (locate number):** Lets you assign a locate number to each marker. When you invoke the Go To Marker command (found in the Commands window in the Setup menu), you can type in a marker’s locate number and press return (or enter) to go to that Marker.

**Find Tempo settings:** These settings (Find, Weight and Hit Range before/after) allow you to configure each marker for inclusion in Performer Lite’s powerful tempo searching features (via the Find Tempo mini-menu command). For complete details, see chapter 53, “Find Tempo” (page 455).

---

![Markers Window](image.png)

*Figure 47-1: Performer Lite’s Markers window.*
**MARKERS WINDOW MENU**

**New Marker:** Adds a new marker at the current location. Hold down the Option/Alt key while choosing Add to add several markers at once.

**New Marker with Options:** Adds a new marker at the current location, but first opens a dialog that lets you first access the marker’s settings.

**Record hits:** Enables a special mode such that during playback, every time you hit a key on your controller instrument, a marker will be added at that location.

**Lock Marker:** Locks the highlighted markers to real/frame time. A small lock icon appears by the marker’s location to indicate that it is locked.

**Unlock Marker:** Unlocks the highlighted markers.

**Shift locked markers:** Shifts all highlighted locked markers by a time offset.

**Show Streamers:** Shows or hides the streamer column in the Markers window.

**Toggle Streamer On/Off:** Toggles the streamer for the currently selected markers in the list on or off. This is the same as clicking the streamer’s icon in the streamer column. When the icon is hidden, the streamer is temporarily turned off.

**Set Marker/Streamer Options:** Opens the marker/streamer options dialog for the currently selected markers in the list.

**Generate Streamer Track For:** Creates a new MIDI track with the MIDI data necessary to recreate the current streamer settings for the hardware device that you choose from the sub-menu. The resulting MIDI track can be exported as a Standard MIDI File for file transfer to other MIDI software.

**Find Tempo for Locked Markers:** Opens the Find Tempo window.

**Include in Find Tempo Range:** Puts a check mark in the Find column for all currently selected markers in the list.

**Remove from Find Tempo Range:** Clears the check mark in the Find column for all currently selected markers in the list.

**Set Hit Range:** Lets you assign a hit range (in the Hit Range column) for all currently selected markers in the list.

**Next/Prev follows Marker Nums:** Check this menu item to follow markers by locate number (instead of their order in the sequence) when using the Next Marker or Previous Marker command.

**Renumber by Time:** Sets locate numbers for the selected markers (or all markers when none are currently selected) in ascending order from top to bottom in the Markers window.

**Renumber by Name:** Scans the names of the selected markers (or all markers if none are selected) and extracts the last number that appears in each name to determine the marker’s locate number.

**Delete:** Deletes the highlighted markers.

**BASICS**

The Markers window is used to display and manipulate markers. Each chunk listed in the Chunks window has its own set of markers. The Window Target tab in the title bar of the Markers window displays the sequence or song to which the markers belong. Each marker consists of a name and a time location it is associated with. Markers are listed in chronological order. You can
MARKERS

display the location of a marker in any combination of measure time, real time, frame time and samples.

**Measure location versus SMPTE location**

Normally a marker remains at the same measure location when you change the tempo of the sequence. In this case, changes in tempo or structure will affect the SMPTE frame location of the marker. However, when working with film or video, it is useful to assign a marker to a certain event in the action (termed a “hit point”). Such markers are intended to remain anchored to a SMPTE frame location. Since the location of the event in the film or video will not change, the location of the marker must not change either, even if you change the tempo of the music.

Performer Lite lets you ‘lock’ markers to a SMPTE frame location. When you change tempos or make edits, the SMPTE frame location of locked markers will not change and, instead, the measure location will change to reflect the new tempo or edit.

**OPENING A MARKERS WINDOW**

To open the Markers window, choose Markers from the Project menu.

If the project contains multiple sequences and songs, each sequence and song has its own set of markers, and the Markers window displays markers that belong to the currently play-enabled sequence or song. In addition, the Window Target tab displays the name of the chunk to which the markers belong.

**SWITCHING BETWEEN SEQUENCES AND SONGS**

The Markers window shows the markers for an individual sequence or song. If you are working with multiple sequences in a Performer Lite project, you may often work with just one Tracks window and one Markers window open at a time. If you switch the sequence being viewed in the

Tracks window (by clicking on the sequence name in the Window Target menu), the Markers window automatically switches to show the markers of the newly chosen sequence. The result is that the markers being shown in the Markers window match the sequence being viewed in the Tracks window. This only happens when one Markers window is open.

You can manually switch the Markers window from one sequence to another by clicking the name of the sequence in the Window Target tab as shown below:

**SCROLLING DURING PLAYBACK**

The Auto Scroll command (View menu > Scroll) can make the Markers window scroll during playback. In addition, the window will automatically open to the current playback location of the sequence.

**CREATING NEW MARKERS**

To add a new marker, choose New Marker or New Marker with Options from the Markers window mini-menu, or press their keyboard shortcut (assigned in the Commands window). The marker’s location will be the same as that showing in the Counter. To add several markers at once, hold down the Option/Alt key while choosing New Marker from the mini-menu. New Marker with Options lets you make marker settings while adding them.

**CHANGING THE NAME OF A MARKER**

To rename a marker, Option/Alt-click the marker name. Use the Enter or the Down Arrow key to approve the entry and move to the next marker name, or the Up Arrow key to approve the entry and move to the previous marker name.
CHANGING A MARKER TIME LOCATION
To change the time location of a marker, click the time location and type a new value. Use the Tab key to move between time fields. You can use the Enter or Down Arrow key to approve the change and move to the time location of the next marker; use the Up Arrow key to approve the change and move to the time location of the previous marker.

If you change the measure time of a marker, even a locked marker, the real and frame times will also change. Changing the real or frame time of a marker will cause the measure time location to change.

Since the markers are listed in chronological order, a marker may seem to vanish when you edit its location. In such cases, the marker has simply been moved out of the visible portion of the marker list.

Moving markers by dragging
You can drag markers in the Track Overview, Conductor Track Editor, and the Sequence Editor to reposition them.

MARKER STREAMER, PUNCH & FLUTTER SETTINGS
To access the streamer, punch & flutter settings for a marker, click it to highlight it and choose Set Marker/Streamer Options from the mini-menu.

CUSTOM PRE-GAP FOR CD BURN
This option can be used when burning a mix to a CD and tracks are based on markers. For more details, see “Track Pre-gap” on page 545.

SETTING THE COUNTER TO A MARKER LOCATION
You can easily set the current location displayed in the counter to the location of a marker. This lets you move to a location by its name instead of time, making it unnecessary for you to keep track of a number of arbitrary measures and times.

To move to the location of a marker, press on the position indicator and drag it to the marker you want. You can scroll the list up or down by dragging the position indicator slightly past the top or bottom of the marker list.

You can also jump to markers using the Marker menu in the Tracks window or Control Panel. See “Marker counter” on page 90.

MARKER LOCATE NUMBERS
The Markers window has a “NUM” (locate number) column. This lets you assign a locate number to each marker.

When you invoke the Go To Marker command (found in the Commands window in the Setup menu), you can type in a marker’s locate number and press return (or enter) to go to that Marker:

Marker numbers are flexible and convenient because they are not tied to the marker’s order in the marker list. Instead, you can assign any locate number to any marker you wish, regardless of their order in the Markers window. By default, each new marker that you add will receive the next highest locate number for that sequence.
For example, you could create marker 1 and marker 2, but then add marker 3 between markers 1 and 2. In doing so, marker 1 and 2 can maintain their original locate numbers, and marker 3 can be assigned a unique locate number (such as 3). This saves you from having to relearn all of the locate points in your song, every time you add a marker somewhere in the middle of the sequence. You have complete control over where each locate number takes you in the sequence.

Renumbering markers
You can edit a marker’s number by double-clicking in the “Num” column in the Markers window.

There are also two mini-menu commands which can be used to renumber multiple markers:

■ Renumber by Time: Sets locate numbers for the selected markers (or all markers when none are currently selected) in ascending order from top to bottom in the Markers window.

■ Renumber by Name: Scans the names of the selected markers (or all markers if none are selected) and extracts the last number that appears in each name to determine the marker’s locate number.

JUMPING TO A MARKER WITH A SHORTCUT
In the Commands window (Setup menu), there is a command called Go To Marker (in the Transport commands group). By default, the keyboard shortcut for this command is Shift-Control-M, but you can reassign it to any key you wish (that doesn’t conflict with another assignment, of course).

After invoking the Go To Marker command, either type in the desired marker number, or press a MIDI note on your MIDI controller that corresponds with the desired marker number, as specified by the Numeric Base Note. For details, see “Numeric Base note” on page 236.

There are also commands for Go to Previous Marker and Go to Next Marker. These commands move the counter to the next or previous marker in the sequence from the current counter location.

If you enable the Next/Prev follows Marker Nums mini-menu item, the Go to Previous Marker and Go to Next Marker commands will follow markers by locate number (instead of their order in the sequence).

SELECTING MARKERS
To select a marker in the Markers window list, highlight it by clicking on its name. There are several methods for selecting several markers at once:

To select several adjacent markers, press on a marker name and drag over the desired names. All markers dragged over will highlight.

To select several non-adjacent markers, hold down the Command/Ctrl key and click on the names of the markers you wish to select. They will highlight.

To deselect markers when more than one are highlighted, hold down the Command/Ctrl key and click on the markers you wish to deselect. They will unhighlight.

To extend the currently selected region, Shift-drag over the desired end location, or Shift-click on the desired end location.

USING MARKERS TO DEFINE AN EDIT REGION
You can use markers to define a region to be edited: instead of typing the Start and End locations in the Selection Information window, you can use the Markers window and the Selection Set To menu.
To define a region using the Markers window:

1. Select a group of markers such that the beginning and end marker of the group are at the starting and end times of the region to be edited.

If the marker with the start time you want for the edit region and the marker with the end time for the region are not adjacent, you must select all markers in between. Click on the starting marker and drag down until you reach the ending one.

2. Choose Set to Selection Bounds from the Set To menu in the Selection Information window.

You can now use one of the commands from the Edit or Region menus. You can also use this procedure to transfer marker times to the Memory and Auto Record bars in the Control Panel.

SELECTING WITH MARKERS
When you click a marker in a non-conductor track editor, it creates a time-range selection in that track that extends to the next marker or end-of-sequence, just like in the overview.

MARKERS IN EDIT WINDOWS
Markers appear in the edit windows, where they can be renamed (by Option/Alt-clicking) or relocated (by dragging). However, commands on the Edit menu may be applied to markers only in the Conductor track edit windows.

MARKERS IN THE SONG WINDOW
Markers in a song are displayed in the Markers Strip in the song window. Performer Lite automatically generates a column in the Song window for each marker.

Markers can be of great help when building a song or score because you can use the Song’s Markers window to create a list of section markers, which will become Chunk placement columns in the Song window. Marker-generated columns are particularly useful for placing Chunks at hit points, which can be created during playback using the Record Hits command.

Merging markers in the Song window
You’ll often find when you place a Chunk into a song that it would be useful to see the Chunk’s markers in the context of the whole song. The Merge Markers command in the Song window mini-menu lets you do just that. Simply select all the component Chunks whose markers you’d like to copy into the song, and choose Merge Markers. All unlocked markers in the selected Chunks now exist in the Song, and are displayed in the Song’s marker strip and Markers window.

Removing merged markers from a song
You can just as easily delete a Chunk’s markers from a song. Select the Chunks whose markers should be removed from the song and choose Delete Markers. Performer Lite compares the song’s markers to those of the selected Chunks, and removes any that match up by both name and location. The markers in the Chunk are not affected. Keep in mind that after you merge markers of a Chunk into a song, dragging the Chunk to a different location will not move the markers. Further, selecting the relocated Chunk and choosing Delete Markers will not have any effect, as the markers in the song no longer match the markers in the Chunk.

EDITING MARKERS IN THE CONDUCTOR TRACK
You may apply any of the Edit menu commands (Cut, Copy, Paste, etc.) to markers only in the Conductor track for the sequence. Select the Conductor track in the Sequence Editor, or make a selection in the Conductor Track in the Sequence Editor, and set the Start and End times in the Selection Information window before invoking one of the Edit commands. See chapter 33, “Editing Basics” (page 272) for more information.
LOCKING AND UNLOCKING MARKERS
Markers can be connected to a SMPTE frame location such that they will retain that location if the tempo is changed: they can be “locked” to the location. If the tempo is changed, the measure time location of the marker will change.

When a marker is unlocked, it remains anchored to a specific measure/beat/tick, and its SMPTE frame location is flexible.

To toggle a single marker between locked and unlocked states, click in the lock column next to the marker’s name. To lock or unlock several markers at once, select them and choose Lock or Unlock from the Markers window mini-menu.

SHIFTING LOCKED MARKERS IN TIME
The Shift Locked Markers command on the Markers window mini-menu lets you shift the times of highlighted locked markers by the amount you specify. Unlocked markers which are selected are unaffected by this command.

This feature can be useful if the film or video you are working with has been recut and the locations of the events have moved slightly. It is generally useful when changing the SMPTE frame locations of markers by a uniform amount.

To shift the times of locked markers, select them and choose Shift Locked Markers from the Markers window mini-menu.

LOCKED MARKERS AND THE SEQUENCE START TIME
There are several options in the Set Chunk Start dialog that affect the location of locked markers when changing the sequence start time.

The Preserve current frame time option, when checked, lets you preserve the absolute frame location of locked markers when changing the SMPTE start time of the sequence. In other words, locked markers won’t move; they will remain anchored to their SMPTE time code frame.

If the new SMPTE start time causes a locked marker to shift before the beginning of the sequence, the marker will be placed at the beginning of the sequence. If you would rather get rid of such markers altogether, check the Delete if before start of chunk option.

If you wish to leave locked markers in the same position relative to the start of the sequence, use the Preserve length of time from start of chunk option.

LOCKED MARKERS AND CHANGING METER
When the Don’t move locked markers option in the Change Meter dialog (Figure 49-1 on page 443) is checked, locked markers are not moved by the change meter operation and remain anchored to their SMPTE time code frame position.

RECORDING HITS
New markers can be entered in a sequence during playback by striking a key on your MIDI controller instrument. The time location of each
To create markers during playback:

1. Move to the location at which you wish to start playback.

   If slaved to an external master device, this step is not necessary: Performer Lite will locate automatically when you start the master.

2. Choose Record Hits from the Markers window mini-menu.

   A dialog box will appear.

3. Specify whether you want the markers to be locked or unlocked.

4. Press OK to confirm your choice or Cancel to cancel it.

   After you press OK, Performer Lite will start playback. If in external sync mode, the Play button will flash until the master device is started.

5. Press a key on your MIDI controller every time you wish to enter a marker.

   A marker will be entered at the current time in the Counter.

6. To stop entering markers in this way, press the Stop button in the main transport controls.

   Using the Auto Stop feature in the Control Panel will also stop this type of marker entry. If you are in external sync, note that stopping the master device does not take Performer Lite out of the Record Hits mode; you must press stop in Performer Lite to end recording hits.

**Using Markers to Find a Tempo**

The Markers window Find Tempo mini-menu command provides advanced tempo searching capabilities. For complete details, see chapter 53, “Find Tempo” (page 455).

**Streamers**

Streamers are visual cues superimposed on a film or video screen to assist composers, conductors, directors and producers in writing, recording and producing music and soundtracks for picture.

**Marker Hints**

Below are some helpful hints for using Markers.

**Composing and arranging**

Markers provide a useful tool for labeling structural sections of a piece of music. The music can be recorded first and markers added afterwards or markers can be entered first to lay out the structure of the sequence before recording. In the latter case, markers can be used as a kind of musical outline for the structure of the piece.

Markers can be used to quickly rewind to the beginning of a section. They can also be used as structural place holders to mark the ends of unfinished sections.

Since markers can be cut, pasted, merged, etc., in the Conductor Track, they can be moved around with the rest of the data as a sequence grows and changes. You can move them separately from the rest of the data if you wish.

Use the View Filter to specify if markers can be affected by Edit menu commands.

If you are not working with time code, you will probably not need to display real or frame time in the Markers window.
**Film and video scoring**

Markers make an excellent cue sheet for planning out or displaying the structure of your score. They can show you the relationship between time locations in the film and measure locations in the music. You can then use the Find Tempo window to find the tempo that best lines up metrical beats of the sequence with important visual events. This can all be done before recording a note of music.

In addition to using markers to define the structure and tempo of your score, you may want to add markers for visual cues and hit points. The Record Hits feature is especially suited for this. These markers should be locked since their time location corresponds to a frame location. When locked, the measure time location of the marker will be updated if you change the tempo and meter. The frame location will not change.

Markers can be an indispensable tool for triggering visual cues (streamers, punches and flutters).
CHAPTER 48  Change Tempo

OVERVIEW
Tempo is very flexible in Performer Lite. Not only can there be several tempos in a sequence but they can change dynamically, resulting in accelerandos, ritards other programmed tempo effects.

In Performer Lite, tempo is controlled by the Tempo Control in the Control Panel. There are four possible settings for tempo control:

- The Tempo slider
- The Conductor track
- The Tap Pad
- An external device, such as a mod wheel on a keyboard controller

Only one of these sources can be chosen at a time.

When Tempo Control is set to the Conductor track, you program all the tempo changes into the Conductor track. Collectively, these tempo changes are called the tempo map, and they occur automatically when you play the Sequence under Conductor track tempo control.

Tempo maps can be programmed using the Change Tempo command as described in this chapter. Alternatively, you can create a tempo map in real time by slaving Performer Lite to Tap tempo synchronization. See chapter 66, “Receive Sync” (page 554).

Overview .............................................. 435
Change Tempo quick reference .................. 435
Change Tempo basics ............................... 436
Using Change Tempo ............................... 437
Viewing and editing tempo changes .......... 442
Tempo editing resolution ........................ 442
Changing tempo on-the-fly during playback .... 442

Figure 48-1: Change Tempo (Project menu>Conductor Track>Change Tempo).

Beat Value: Displays the note value on which the tempo is based. Click on the desired note to choose it. Click on the dot to make the beat value a dotted duration (i.e. one and one half of the chosen note’s duration).

Start and End locations: Displays the time range over which the tempo change will take effect. Click on the box and type in the desired values. Use the Tab key to move from field to field.

Anchored Tempo Indicators: Click on the anchor icon to toggle a starting or ending tempo between anchored and unanchored. Anchored tempos are automatically set to the current tempo in the region, preventing unwanted jumps in tempo.
**Time Display Buttons:** Click on the appropriate radio button to select real or frame time for the tempo parameters.

**Tempo Density Buttons:** Click on the appropriate radio button to choose between Coarse and Fine tempo event densities. The Fine setting generates 12 tempo events a beat; the Coarse setting generates far fewer events.

**Tempo Curves:** Click on the desired curve button to select the type of tempo change desired. Each curve has a set of parameters and options which control the shape and range of the tempo change.

**Tempo Parameters:** The number and type of parameters depends on the Tempo Curve selected. Parameters outlined by a box can be set by the user; other parameters are computed and verified by Performer Lite as soon as you change any parameter. Values that are incalculable or out of range will highlight and cause the computer to beep (or the menu bar to flash). Press the Option button to change the parameters that can be edited.

**Randomize tempos:** Check this box to randomize tempos within a specified range, expressed as a percent or as a number of beats per minute (bpm).

**Emphasis:** Move the slider between -9 and +9 to weight the randomization either lower or higher.

**The Options Button:** Click on this button to select which parameters are user-definable.

---

**CHANGE TEMPO BASICS**

The Change Tempo command (Project menu>Conductor Track>Change Tempo) is used to create tempo changes. You can specify a static tempo change (i.e. a constant tempo) or a dynamic one (a smooth change) via a curve. A constant tempo contains no variation of the tempo for its duration; it is merely a change from one tempo to another. A smooth change contains varying tempo values. The way that these values change is specified by one of four curves. An accelerando, for example, is a smooth change with a linear curve in which the tempo gradually increases. When a smooth change is specified with a curve, Performer Lite approximates the smooth change with a large number of discrete tempo changes in quick succession.

When you use Change Tempo, any existing tempo data in the specified time range is erased and replaced by the new data generated by the command.

**Creating a tempo map**

A *tempo map* is simply the complete set of programmed tempo changes for an entire sequence. These changes are displayed in the Conductor track.

- The tempo changes for a sequence can only be edited in its Conductor track.

To get a clear picture of the tempo map of a sequence, view it in the Conductor Track Editor.

When you change the tempo map, the real time location of all markers and events (viewed in edit windows) are updated. The real time locations of locked markers do not change in this case. Rather, their measure times change.
Tempo resolution
Performer Lite’s tempo capabilities were designed to be very effective in film and video applications. Tempo calculations are very accurate resulting in very precise location abilities. Finding a frame time location will bring you to the exact measure time location consistently. Real time locations of events and markers are completely reliable and give an accurate representation of the timing of the music.

This precision is possible because Performer Lite maintains a very high degree of internal tempo resolution, much greater than the two decimal places that you can enter. This resolution allows you to set the tempo for a region by specifying its length in real or frame time: Performer Lite will calculate the correct tempo to make the end of the region occur at the time you specify.

Switching between a tempo map and manual tempo control
When you set the tempo control to the Tempo Slider, the programmed tempo map is temporarily disabled by the current metronome slider tempo setting. When you switch back tempo control to the Conductor track, the programmed tempo map is re-enabled.

USING CHANGE TEMPO
The Change Tempo command (Project menu>Conductor Track>Change Tempo) lets you create smooth tempo changes in a defined region of time. The start and end of the region are defined by measure locations. With this command, you can calculate a tempo for a region by giving a real time length for it.

Choosing the sequence in which to change tempo
If the Sequence Editor is active, the tempo change will apply to that sequence. If the Set List is active, the tempo change will apply to the highlighted sequence or, if no sequence is highlighted, to the current play-enabled sequence. If an edit window is active, the tempo change will apply to whatever sequence it belongs to.

When you open the Change Tempo dialog, the name of the selected sequence is displayed after the words “Change tempo of sequence” at the top of the dialog box.

Selecting a tempo beat value
Tempos are measured in beats per minute. You can select any beat value for the tempo from a sixteenth note to a whole note. The beat value can be dotted. The number of beats per minute can be between 20 and 400. At very slow tempos, you may want to use smaller beat values such as an eighth note. At fast tempos, you may want to use larger values such as a half note. Your choice of beat value does not affect the frequency of the Click. This is set separately with the Change Meter command.

When you type in a number of beats per minute in Performer Lite (in the Metronome, in a tempo event in the Conductor Track, or in the Change Tempo window), you can type in a timing resolution of up to a hundredth of a beat per minute (136.45, for example).

Viewing and typing in frame click tempos
If you write music for film, you might be accustomed to expressing tempos in frame-clicks as well as beats per minute. In Performer Lite, you can type in tempos using either format. You can also display tempos throughout the program, including the Change Tempo dialog, in frame click tempos (e.g. 12-6 or 13/4).

Selecting a time display
You can choose whether to display start and end times in real or frame time. This is very useful for calculating timings in film and video work.
Setting the start and end points
The measure time locations entered in the Start and End boxes in the Change Tempo dialog (Figure 48-1 on page 435) delineate the region in which the tempo change occurs. New tempo data will be inserted into this region according to your specifications.

Using the fine and coarse options
The Fine and Coarse options determine the density of tempo change data generated. Selecting the Fine option causes tempo changes to be generated 12 times per beat. This creates the smoothest changes but generates lots of data. This option is best used over regions of only a few measures. With the Coarse option, fewer tempo changes per beat are generated. This is the best option to use in a large region.

In most situations, the tempo changes generated by the Coarse option will sound completely smooth. The rule of thumb here is to use the Coarse option unless the tempo changes are not smooth enough: in this case, the Fine option can be used.

Anchoring the start and end tempos
The Start and End tempo parameters have an anchor icon next to them. When the anchor icon is highlighted, the tempo is anchored. If the anchor icon is unhighlighted, the tempo is not anchored.

To anchor or unanchor a tempo, click on the anchor icon next to it.

When a tempo is anchored, the current tempo at that location in the sequence is used. For example, if you anchor the Start tempo parameter, the value used for that parameter will be the pre-existing tempo at the Start location.

The anchoring option is used to make sure that tempos just before and just after the region are matched exactly. This insures that there are no sudden jumps in tempo at the start or end of the region. It is best to anchor tempos when you want this continuous tempo effect; you cannot achieve the same degree of accuracy when entering tempos manually.

Using tempo curves
The tempo curve buttons specify the values for the individual tempo change events created by the Change Tempo dialog box. Rather than inserting each tempo change manually, you can select a curve and set a few parameters; Performer Lite will calculate the tempo changes necessary to create the desired effect. The flat, straight line (the constant curve) generates just one tempo change at the beginning of the region. The other curves—linear, logarithmic, exponential and polynomial—generate a number of tempo changes which approximate the shape of chosen curve. These curve types are described in detail below.

To select a curve, click its button. The currently selected curve is highlighted. When a curve is selected, the associated parameter fields are displayed in the lower section of the dialog box.

The curves are all displayed as increasing values. However, if you specify an End tempo that is less than the Start tempo, the tempo changes generated will decrease over time according to the chosen curve. In effect, this flips the curve upside down. For example, if you wanted to program a ritard (slowing down), you’d choose the linear curve and enter a lower ending value. This would “flip” the effect of the curve from up to down.

Curve parameters
Each curve has unique parameters. These parameters are the specifications for the tempo change data to be generated: starting time, ending time, etc. In addition, these parameters can be
combined in several different ways for each curve. For example, the linear curve allows you to set different combinations of the Start tempo, End tempo and End time. After selecting a curve, pressing the Options button cycles through the various combinations of parameters possible for that curve. Parameters that you can enter are in boldface type and are enclosed in a box; parameters that Performer Lite will compute (and that you cannot enter) are in plain type without the box.

As soon as you change any parameter, Performer Lite instantly calculates other parameters on the fly that are affected by your change.

Each curve displays its Start time parameter. This value is not user-changeable; it is always computed from the starting measure time location. It is provided as a reference for viewing the length of the region.

The following paragraphs describe the effects of each curve on the specified region and the parameter options for each.

**The constant curve**
The constant curve sets the region to a constant tempo by inserting only one tempo change at the beginning of the region.

### Parameters:
- **Tempo**: This is the tempo for the entire region in beats per minute. You can use two decimal place values if you wish, e.g. 89.74. If you anchor the tempo, it will be the same as the pre-existing tempo at the Start location of the region.
- **End Time**: This is the time at which the end measure location will occur.

**The linear curve**
The linear curve creates a smooth tempo change with no fluctuations in the specified region.

### Parameters:
- **Start Tempo**: This is the tempo at the Start location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the Start location.
- **End Tempo**: This is the tempo at the End location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the End location.
- **End time**: This is the time at which the End location occurs.

**The logarithmic and exponential curves**
These two curves are similar: they both create a smooth change in the specified region. The logarithmic curve changes tempo more rapidly at the beginning of the region; the exponential curve changes tempo more rapidly at the end.

### Parameters:
- **Start Tempo**: This is the tempo at the Start location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the Start location.
End Tempo: This is the tempo at the End location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the End location.

End time: This is the time at which the End location occurs.

Curvature: This is a value that controls the degree of curve in the smooth change (i.e. its non-linearity). Enter a value between 1 and 99. Low curvature values flatten the curve and produce a more even rate of change. For example, a value of 1 results in a near-linear change that is similar to the linear curve. High curvature values round out the curve and result in more change at the beginning or end of the region depending on the button selected. For example, a value of 99 will cause much of the tempo change to occur at either the beginning (for the logarithmic curve) or the end (for the exponential curve). The higher the curvature value, the more pronounced the curve shape.

The polynomial curve
The polynomial curve creates a change in the specified region which starts smoothly at the beginning of the region, changes most rapidly in the middle and ends smoothly. Note that the unique parameter Mid Beat is included with this curve, allowing you to control aspects of the middle of the curve.

Parameters:

<table>
<thead>
<tr>
<th>Start tempo</th>
<th>End tempo</th>
<th>Curvature</th>
</tr>
</thead>
<tbody>
<tr>
<td>140.00</td>
<td>120.00</td>
<td>15 (1 to 99)</td>
</tr>
<tr>
<td>0:00:30:00</td>
<td>0:00:22:06</td>
<td></td>
</tr>
</tbody>
</table>

Start Tempo: This is the tempo at the Start location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the Start location.

End Tempo: This is the tempo at the End location of the curve in beats per minute. If you anchor this value, it will be the same as the pre-existing tempo at the End location.

Curvature: Allows values between 1 and 99. Low curvature values flatten the curve; high values round it. Values of 30 to 60 work particularly well with this curve.

Mid Beat: This is the measure time location at which the Mid Tempo value occurs. This is the point at which the most rapid tempo change occurs. This location can be any time between the Start and End times and allows you to control where most of the changing will occur.

End time: This is the time at which the End location occurs.

The Randomize option
The Randomize option causes the tempo or tempos being generated by one of the selected curves to be randomized within a range for the entire region over which the tempo change is being made. For example, if you are inserting a constant tempo of 120 bpm without randomization, the result is a single tempo event at the beginning of the region as shown below:
However, with the Randomize option checked and the range set to ±25 bpm, the result is a tempo map that constantly and randomly changes between 95 and 145 bpm:

**Randomization can be used in conjunction with any curve**
Randomization option is a check box option, which means that it can be used in conjunction with any of the tempo curves:

- A polynomial tempo curve with no randomization.
- The same curve with randomization set to 2%.

**Controlling the degree of randomization**
The Randomize option is ideal for adding “human feel” to the tempos of a sequence. By controlling the range over which the randomizing occurs, you control the degree of that feel. You can specify the range either as a percentage or as a range of bpm. In either case, each tempo event generated is placed randomly within the range.

**Emphasis**
This sub-option causes the tendency of the randomization to be higher or lower within the specified range. Thus, if you wish to randomize the tempos within a certain range, but you wish them to tend to be higher, use a positive emphasis; use a negative emphasis if you wish them to tend to be towards the lower end of the range. A value of zero equals no emphasis, which causes the randomization to occur evenly within the range.

**The effect of Density on randomization**
A Fine density setting causes tempo events to be generated more frequently than a Course density setting. Notice that these two settings have an effect on the constant tempo curve, which normally only produce a single tempo event.

**The Options button**
Pressing the Options button cycles through the different combinations of enteredcomputed parameters for the selected curve. This allows you to specify the curve in a variety of manners. For example, if you select a constant curve, you can specify just the tempo or you can specify the End time, in which case the tempo will be calculated to make the end measure location occur at the end time.

If you are not working with externally imposed timings, as required in film and video work, you will probably not need to use the Options button.
VIEWING AND EDITING TEMPO CHANGES
Tempo change data is stored in the Conductor track for the sequence. Tempo changes look like—and can be edited similarly to—continuous MIDI data (such as pitch bend or controller information) in the Conductor track editor windows.

Each tempo change has a time and a tempo value. The tempo has two parts, the tempo value in beats per minute and the beat value (e.g. 1/4 note, 1/8 note, etc.)

Editing tempo changes can be done in the Sequence Editor. You can apply all the commands on the Edit menu to tempo changes.

TEMPO EDITING RESOLUTION
Tempos can be manually edited to a resolution of a hundredth of a beat per minute. When you use the settings in the Change Tempo window, tempos are calculated to a much higher degree of accuracy.

CHANGING TEMPO ON-THE-FLY DURING PLAYBACK
You can use the Change Tempo command without stopping playback.
CHAPTER 49  Change Meter

OVERVIEW
Meters specify the way musical time is counted and measured. In Performer Lite, meters affect the way measure|beat|tick locations are displayed. Meters also affect the Click and countoff. In addition, they impact the way information is displayed in Performer Lite’s Notation Editor. The Change Meter command (Project menu>Conductor Track>Change Meter) allows you to enter any number of meter changes in a sequence.

Overview ............................................. 443
Change Meter quick reference .................. 443
Change meter basics ............................... 443
Using the Change Meter window .......... 444
Viewing meter changes ......................... 446
Editing meter changes in the Conductor track 446
Hints and examples .............................. 447

CHANGE METER QUICK REFERENCE

Meter marking: Displays the meter in standard musical format. Click on the numerator and/or denominator and type in new values to change it.

Start and End Locations: Displays the region over which the meter change takes effect. Click in the From box to set the starting location. Click in the To box to set the ending location. Click on the end of sequence button to extend the region to the end on the sequence.

Options: The Only move barlines option does not affect the actual events in the sequence. The Realign music automatically and Adjust durations options erase or change events to fit the meter.

Metronome Click value: Displays click associated with the meter change.

CHANGE METER BASICS
A meter consists of a beat value and the number of beats per measure. The beat value is generally the rhythmic pulse or beat of the music; a measure consists of a certain number of these beats. Performer Lite displays meters in the standard musical fashion as a fraction, with the beat value in the denominator (on the bottom) and the number of beats per measure in the numerator (on top). In Performer Lite, the numerator can be a value between 1 and 99. The denominator must be a power of 2 (1, 2, 4, 8, 16, 32, or 64).

Figure 49-1: The Change Meter window.
A Meter Change event in Performer Lite consists of a meter displayed in this way, along with a metronome click setting, which determines how the click will behave. It also determines how often the Counter is updated during playback or recording.

The meter’s denominator value, the beat value of the current tempo and the click settings are all related, though they need not be set to the same value. You may wish to have a meter of 4/4 with a tempo of half note = 180 with the metronome clicking every eighth note. The ability to use separate values allows a great deal of flexibility and accuracy during recording. In addition, the click can be fully, independently customized. You can even specify default click behavior for specific meters and tempo ranges. See “Click Changes” on page 419.

If a sequence contains several meters, the resulting configuration of meters is termed a *meter map*. This map is simply the complete set of programmed meter changes for an entire sequence. These changes are displayed and edited in the Conductor track.

It is often useful to set up the meter map before recording the music, this way the measure locations of the events you record will stay consistent through the recording and editing process. If you change the meter after recording a track or tracks, the measure|beat|tick locations of the events may change.

Inserting a new meter may or may not have an audible effect on the music. Depending on the options you select for inserting a new meter, note events may be excluded and durations may change. These options are explained in detail below.

Performer Lite starts a new measure at every meter change. Thus, if a meter change is inserted in the middle of a measure, that measure will terminate early, and a new one will begin with the meter change event. See “Meter changes and partial measures” on page 423.

**USING THE CHANGE METER WINDOW**

Use these general guidelines for changing meter.

**Specifying the sequence to insert meters into**

If the Sequence Editor is active, the meter insertion will apply to that sequence. If the Set List is active, the meter insertion will apply to the highlighted sequence or, if no sequence is highlighted, to the current play-enabled sequence. If an edit window is active, the meter insertion will apply to whatever sequence it belongs to.

When you open the Change Meter window (Project menu>Conductor Track>Change Meter), the name of the sequence in which the meter insertion will be placed is displayed at the top of the Change Meter window.

**Entering the meter**

Click in each box and type in the numbers. The numerator must be a value between 1 and 99. The denominator must be a standard note value: 1, 2, 4, 8, 16, 32 or 64.

**Specifying the From and To locations**

These locations specify the starting and ending locations for the meter change. Click on the fields and enter the desired measure|beat|tick values. If you have just entered a meter change, the From location is automatically set to the previous To
location. Click on the *end of sequence* button to change meter from the From location to the end of the sequence.

**Entering meters quickly one measure at a time**
If you are going to be entering a series of meter changes quickly, choose the *Next Measure* option. This option lets you press the enter key once for each measure. If you have several measures in a row in the same meter, just press the enter key once for each measure. The “from” measure is automatically updated as you do so. This lets you enter meter changes efficiently for an entire sequence by quickly pressing the enter key repeatedly as many times as necessary for measures with the same meter. When you need to change meter, type in the new meter and press enter again as many times as necessary for the new meter. Keep going as long as necessary.

**The metronome click**
Each meter change can have its own unique metronome click setting. There are four choices for a meter change metronome click:

<table>
<thead>
<tr>
<th>Metronome click</th>
<th>For more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>“Default for Meter” on page 96.</td>
</tr>
<tr>
<td>Tacet</td>
<td>“Tacet click” on page 419.</td>
</tr>
<tr>
<td>Beat value</td>
<td>“Beat Value” on page 96.</td>
</tr>
<tr>
<td>Pattern</td>
<td>“Pattern click” on page 420.</td>
</tr>
</tbody>
</table>

**The measure range**
When you enter a range of measures, Performer Lite will change the meter up to but not including the *to measure*. The *to measure* does not change; it remains in the same meter as before the operation. This is very similar to the way most edit/region operations work; events at the end time are not affected. If you choose the *end of sequence* option, the meter change will continue to the end of the sequence, no matter how the sequence may change.

For example, assume a sequence is completely in 4/4. Entering a change to 3/4 from measure 8 to measure 12 will place a 3/4 meter change in measure 8, and a 4/4 meter change in measure 12. The result is that measures 8 through 11 are now in 3/4, and measure 12 remains in 4/4.

**Realign music automatically**
This option allows you to maintain the metrical structure of each measure by deleting some note events and changing the durations of others. There is a sub-option, *Adjust durations*, which is discussed below. The following assumes that the *Adjust durations* box is not checked. When you change the meter of a measure that contains note events with this option on, beats are either added or removed according to the new meter you specify. If beats are added, rests are inserted for the new beats. If beats are removed, any note event occurring in the removed beat will be removed as well. The durations of note events that start before the deleted beats are preserved. For example, suppose you have the following two measure passage in 4/4 time:

![Graphically, the durations would be represented like this:](image)

Changing the meter to 3/4 and using the Realign music automatically without adjusting durations, the fourth beats would be removed. This would
remove the quarter note in the first measure but not the whole note since it began before the deleted (fourth) beat:

Don’t move locked markers
When the Don’t move locked markers option in the Change Meter dialog (Figure 49-1 on page 443) is checked, locked markers are not moved by the change meter operation and remain anchored to their SMPTE time code frame position.

Only move barlines
This option does not change any durations. It imposes the new barline structure over the music, keeping all durations the same. The above original 4/4 passage would look like this with the Only move barlines option:

VIEWING METER CHANGES
The meter changes in a sequence can be viewed in the Sequence Editor and Notation Editor. Meter changes can be edited only in the Conductor track; they cannot be modified in MIDI and audio tracks.

EDITING METER CHANGES IN THE CONDUCTOR TRACK
Meter changes can be edited directly in the Conductor track. See “Editing in the Conductor Track” on page 421 for details.
Using edit menu commands with meter changes
You can apply any editing command to meters in the Conductor track: they can be cut, copied, pasted, spliced, etc., just like other events. You can do so using all of the same techniques for editing MIDI and audio events. You can even edit meter changes along with MIDI data in other tracks by selecting the Conductor track along with the other tracks.

When cutting, copying, and pasting meter changes, it is strongly advised that you leave the *Fix partial measures automatically* preference (Performer Lite menu) checked. This preference helps avoid partial measures, which in most cases you do not want to create with editing operations.

**HINTS AND EXAMPLES**
Editing meter changes can be confusing, especially if you create partial measures by unknowingly putting a meter change in the middle of an existing measure. Another way to avoid partial measures is to turn on (check) the *Smart Selections* command in the Edit menu. Smart Selections helps to avoid partial measures. Also see “Correcting unwanted partial measures” on page 424.
CHAPTER 50  Change Key

OVERVIEW
Key signatures provide a way to interpret MIDI note data. In music notation, there are several ways to write every pitch. For example, although G sharp and A flat sound the same and describe the same pitch, a G sharp would make less sense in the key of E flat than an A flat would. Performer Lite allows you to specify key signatures in your sequences, making the naming and display of notes clear and musically accurate. Key signatures are also extremely important when viewing a sequence in music notation with Performer Lite’s Notation Editor; setting the correct key signatures ensures that the music will be properly notated.

Overview .................................................. 448
Change key Quick Reference .......................... 448
Change Key basics ........................................ 448
Types of key signatures .................................. 449
Inserting key signatures ................................. 449
Viewing and editing key changes .................... 450

CHANGE KEY QUICK REFERENCE

Start and End Locations: Displays the region over which the key change occurs. Click on a value to highlight it, and type the desired starting and ending measure locations. After each change is made, the From location is set to the previous To location. Click on the end of sequence button to change key from the From location to the end of the sequence.

Key type: Click on the appropriate radio button to select a Major, Minor, or user-defined Custom key.

Key Signature Scroll Box: Use the scroll bar and arrows to select the desired key signature. Changing the key in this box automatically updates the key name and spelling table.

Key Name: Displays the name of the key signature. The name is set automatically when the Major or Minor key types are chosen. Click the name and type to change it.

Spelling Table: Displays the spelling of the twelve chromatic notes for the currently selected key. Change a spelling by pressing on the note letter and selecting the desired spelling from the menu that appears.

CHANGE KEY BASICS
Key signatures in the Conductor track of a sequence apply to all the tracks in the sequence. At any given location, there can be only one key signature for all tracks. You can have as many key changes as you like in a sequence.

Key changes appear for reference in all windows. They may be edited only in the Conductor track. Each key change affects the spelling of notes to just before the beginning of the next key change. Key
changes only affect the display of note pitches; they do not change the actual MIDI data in your sequence.

If there is no key signature entered at the beginning of the sequence, the default key is C major (no sharps or flats).

**TYPES OF KEY SIGNATURES**

Key signatures in Performer Lite actually have two components: the standard key signature (up to seven sharps or seven flats), and note-spelling assignments for non-diatonic notes (notes not in the basic scale of the key). A key has five non-diatonic notes; Performer Lite allows you to decide how each of them will be spelled. In the key of D, for instance, you can name the note that lies between B and C sharp either B sharp or C natural.

You can choose from three types of key signatures:

- **Major:** Any key from C sharp major (7 sharps) to C flat major (7 flats)
- **Minor:** Any key from A sharp minor (7 sharps) to A flat minor (7 flats)
- **Custom:** You can choose a signature with 7 sharps to 7 flats and call it what you wish. This is useful for modal key signatures: C Phrygian, for example, has 4 flats. The key signature name is only for your reference: only the key signature itself is displayed on the staff in the Notation Editor.

**INSERTING KEY SIGNATURES**

To insert a key signature or add a key change, keep these guidelines in mind when using the Change Key window (Project menu>Conductor Track>Change Key).

**Specifying the sequence to insert a key change into**

If the Sequence Editor is active, the key insertion will apply to that sequence. If the Set List is active, the key insertion will apply to the highlighted sequence or, if no sequence is highlighted, to the current play-enabled sequence. If an edit window is active, the key insertion will apply to whatever sequence it belongs to.

When you open the Change Key window (Project menu>Conductor Track>Change Key), the name of the sequence in which the key change will be placed is displayed at the top of the dialog box.

**Specifying the From and To locations**

These locations specify the starting and ending locations for the key change. Click on the fields and enter the desired measure|beat|tick values. If you have just entered a key change, the From location is automatically set to the previous To location. Click on the *end of sequence* button to change key from the From location to the end of the sequence.

**Choosing note spellings**

Click on each note in the spellings list to select it and choose the desired spelling from the available ones displayed.
VIEWING AND EDITING KEY CHANGES
The key changes in a sequence can be viewed in all editor windows. Key changes can be edited in the Conductor track.

In the Conductor Track, the location of a key change can be edited by dragging it to move it or by altering its starting time in the Event Info bar. The key change itself may be modified by clicking it in the Event Info bar. The Change Key dialog box appears in which you can enter the modification (Figure 50-2 below). The box that appears is slightly different than the one chosen with the Change Key command: the Change button is replaced by OK and Cancel buttons, and the sequence name and From and To location fields are missing. Otherwise, this box works exactly as described above.

Using the edit commands with key changes
You can apply the commands from the Edit menu to key changes in the Conductor track: key signatures can be cut, copied, pasted, spliced, etc., just like other events. The region to edit in the Conductor track may be selected by using the I-Beam cursor. Key change information can be included in an edit operation involving note and other MIDI events by including the Conductor track along with the selected tracks.
CHAPTER 51  Insert Measures

OVERVIEW
The Insert Measures command (Project menu>Conductor Track>Insert Measures) lets you add any number of new, empty measures at any point in the sequence. This feature has an option that preserves all subsequent SMPTE locations after the insertion, if desired. For example, if you were working on a film cue, and you needed to add ten measures of extra music before the current start time of the cue, the Insert Measures command lets you insert 10 empty measures at the beginning of the sequence, while at the same time preserving all your existing material’s relationship to SMPTE time code.

BEFORE YOU USE INSERT MEASURES
The Insert Measures command automatically splits audio regions at the point of insertion. But it does not split MIDI notes. If MIDI notes extend through the insertion point, such as sustained chords, and you would like to split them, do the following before using the Insert Measures command: make a selection in the desired tracks with one edge of the selection at the split point. Then use the Split command in the Edit menu to split the MIDI notes.

USING THE INSERT MEASURES COMMAND
You don’t need to select anything before using the Insert Measures command. Just choose it from the Conductor Track sub-menu in the Project menu, type in the number of measures you want to insert and the downbeat where you wish to insert them. If you wish to preserve the SMPTE times of all events after the insertion point, check the option called Maintain all times following the insert point.

Figure 51-1: Insert Measures.
CHAPTER 52  Adjust Beats

OVERVIEW
Adjust Beats (Project menu>Conductor Track>Adjust Beats) lets you align Performer Lite’s time ruler to music (either MIDI or audio) in cases where the Beat Detection Engine and tempo analysis features are not suited for the material. For example, you might be importing a full mix of a rubato performance for which the Beat Detection Engine cannot accurately detect beats and tempo.

Overview .................................................. 452
The problem .............................................. 452
Using Adjust Beats ................................. 452

THE PROBLEM
Adjust Beats addresses the following problem: you’ve just imported an audio file into Performer Lite — or you recorded it without listening to Performer Lite’s metronome — and the audio is completely out of sync with the sequence’s tempo, beats and barlines. In addition, it cannot be accurately processed by the Beat Detection Engine or tempo analysis features because of the nature of the material.

How do you get Performer Lite’s measures and beats to line up with the audio?

USING ADJUST BEATS
The audio used in this example (Figure 52-1) is a simplified example for the purposes of demonstrating the Adjust Beats command. Note, however, that audio of this nature (monophonic audio with clearly defined transients) can be quite successfully analyzed with the Beat Detection Engine and should be aligned to the sequence tempo using beats and tempo analysis.

To use the Adjust Beats command to get Performer Lite’s beats and barlines to line up with audio:

1 Place the soundbite in a track.

2 Choose Project menu>Conductor Track>Adjust Beats.

3 Turn on Adjust Beats (check the box).

4 Adjust beats lets you adjust entire measures or specific beats. In this example, we’ll start adjusting the first measure and then fine-tune the beats, so for now, the Adjust menu is set to measures, and we’ll set the other options as shown below for now.
5 Zoom the Sequence Editor so you can easily see the beats in the waveform (you can even use the Zoom tool in the time ruler).

6 In this simplified example, the downbeat of measure two is shown above. With Adjust Beats, we can simply drag the downbeat of measure 2 in the time ruler over to the downbeat in the waveform. You can grab measure two by either clicking on the time ruler or clicking directly on the waveform below it.

7 Since the audio does not have a constant tempo, we now need to use the same technique to line up the beats in measure 1. First, we’ll switch the Adjust pop-up menu in the Adjust Beats window to Beats and choose the Move one beat at a time option.

8 Now we can line up the beats in measure one by dragging them in the time ruler to match the beat spikes in the audio waveform.

You can continue this process for any portion of the audio, adjusting measures for larger scale changes and using beat adjustment for fine-tuning.

---

Figure 52-2: Using Adjust Beats to line up time ruler (the sequence’s measures and beats) with audio. After dragging the downbeat of measure 2 in the time ruler, it now matches the audio.

Figure 52-3: Switching to beat adjustment, moving one beat at a time.

Figure 52-4: Adjusting the beats in measure 1. Above, beat four is being adjusted, and below, the final results.
The end result of this simple procedure is that the audio sounds the same: it plays exactly as it did originally. But now, the sequence has a rubato tempo map that was generated by your graphic adjustments — and its changing tempos will exactly match the changing tempos of the audio.

![Figure 52-5: This is the tempo map that was generated by beat adjustments made in example. These tempo changes make the sequence play along exactly with the rubato audio passage. (And the beats and barlines match up, too.)](image)

**Adjust Beats and grid lines**

Adjust Beats displays grid lines as follows:

- If the time ruler is displaying measures only, no grid lines are displayed.
- If an auxiliary time ruler is being displayed, Adjust Beats displays grid lines for the aux ruler.

Grid lines for a mensural auxiliary ruler are shown every measure.

Grid lines for real-time aux rulers (real time, SMPTE or samples) are shown at intervals representing the primary unit of measurement being displayed in the ruler (such as one-second intervals, for example).

**Adjust beats and snapping**

Adjust Beats can snap to audio beats and MIDI notes, if any, in the track you are dragging in. They can also snap to markers.

In the Sequence Editor, your cursor actions snap to the MIDI notes or audio beats in the track currently beneath the cursor. Just move the cursor over the track you wish to snap to.
CHAPTER 53  Find Tempo

The Find Tempo feature helps you find the tempo that best matches a list of locked markers ("hits"), with as many hits as possible falling on beats.

WHEN FIND TEMPO WORKS BEST
Find Tempo works best at the beginning of the scoring process, when you’ve got an EDL (Edit Decision List) or hit list, before you’ve written any music (although you can certainly experiment with it on existing material). If you do try it with existing material, it works better with music that is already a constant tempo. Lots of existing tempo changes in the conductor track do not generally produce good results.

Figure 53-1: The Find Tempo window.
PREPARING MARKERS
Use the Markers window to prepare your markers for effective tempo searches. Find Tempo only searches on locked markers, so be sure to lock any markers you wish to include in the search.

Choosing which locked markers to include
For any locked markers you wish to include as “hits” in the search, place a check mark in the Find column next to the marker name. To check or uncheck several (or all) markers at one time, select them and use Include in Find Tempo Range and Remove from Find Tempo Range in the Markers window mini-menu. Unlocked markers cannot be checked (because they would move when the tempo changes); lock them first and then check them.

Dragging in the Lock and Find columns
In the Markers window, you can vertically drag across multiple markers in the Lock and Find columns to enable them in one gesture.

Assigning weight (importance)
You can assign a degree of importance to each marker by choosing it from the menu in the weight column. Four weight settings are provided: none, least important, normal, and very important.

Assigning a hit range
In the Hit range before and Hit range after columns, you can enter a number of SMPTE frames before and after the marker that constitutes a hit. To assign a range to several markers at one time, select them and use the Set Hit Range mini-menu command.

OPENING FIND TEMPO
After you’ve prepared your list of locked markers, you’re ready to search for tempos. To open Find Tempo, choose Find Tempo for Locked Markers from the Markers window mini-menu.

ENTERING SEARCH PARAMETERS
As shown in Figure 53-1, use the area at the top of the window to enter basic guidelines for the search.

Search Start
Use the Search Start (Figure 53-1) to enter a measure|beat|tick where you want to start the tempo search. Applied tempos will be inserted at this point in the sequence. Click the Start button as a shortcut for entering the current counter time in the start field.

Chunk Selector
The Chunk Selector (Figure 53-1) lets you choose which cue (sequence) you are searching in. It also displays the start time of the chunk to the right of the selector popup. (Time code bits are displayed as 80ths of a frame.) This chunk start time will immediately update if you choose to apply a tempo with an offset, to show you what effect the offset had on the chunk start time. Therefore, it is
not necessary to go to the Chunks window mini-menu to open the Set Chunk Start dialog to verify what happened to the chunk start time.

**Tempo Range settings**
The Tempo Range settings (Figure 53-1) let you choose the metric division (quarter note, eighth note, etc.), the range of tempos in which you’d like to search, and the frequency of different tempos you’d like to try within that range.

The default frequency is 0.25 of a bpm, which means that every tempo, in quarter bpm increments, will be searched within the range you specify. Smaller frequency values produce more resulting tempos and increase the chances of finding the most hits. But they also take longer. Lower frequency produces fewer tempos and shorter calculation times.

Note that the BPM (Beats Per Minute) note value for the tempo is independent of the resolution setting for the search grid setting (shown in Figure 53-1 and explained in the next section).

**Search Grid**
The Search Grid note value menu (Figure 53-1) lets you set the beat resolution grid on which you would like to search for hits. Because this is separate from the tempo specification, you can search, for example, for quarter note tempos but evaluate hits according to the closest eighth note.

**Offset**
The Offset settings (Figure 53-1) allow you to specify how much of an offset (in frames) you wish to consider from the chunk’s current SMPTE start time, and how many different offsets to check. The offset settings shown in the example in Figure 53-1 would check the results of every tempo with offsets ranging between –3 and 3 frames. The Step setting specifies how many offsets to check between the minimum and maximum frame numbers. The Step setting in this example will test offsets at intervals of one and one-half frames. Therefore, the set of offsets that will be considered is {-3.0, -1.5, 0, 1.5, 3.0}.

If you choose to search for tempos using a range of offsets, every offset within the range is shown in the list of results, regardless of the number of hits and misses it contains. This allows you to inspect the complete set of search results.

**Search button**
The Find Tempo window automatically recalculates the tempo search results whenever a search parameter changes. But if you want to manually force Digital Performer to re-calculate the tempo search results for some reason, click the Search button (Figure 53-1).

**Max Hits**
The Max Hits (Figure 53-1) indicator is a static text readout that tells you how many searchable markers you have (the maximum possible number of hits). This is a convenient reference for evaluating the number of hits and near hits. In this example, if you get 10 hits, you’ll know that you got 10 out of 100. The Max Hits indicator counts only those markers that occur after the search start time.

**PROCESSING THE RESULTS**
As soon as you finish entering a new set of search parameters, an animated processing symbol appears in the upper right corner of the window to indicate that tempos are currently being searched. Find Tempo always begins searching automatically, as soon as you enter new parameters, change the existing parameters or even make changes to the locked markers in the sequence. But you can always initiate searching again by clicking the Search button.
Searching before the beginning of the sequence
If you’ve chosen to include a locked marker in your search that occurs at or before the sequence start frame, offsets cannot be applied. As a result, you will see a red warning message at the top of the Find Tempo dialog that warns you that a locked marker at or before the sequence start time prevents use of offsets.

BROWSING THE TEMPO SEARCH RESULTS
After a search is complete (when the processing symbol disappears), all of the tempos you specified (as prescribed by the tempo range) appear in the list, along with their Offset, total error, and their hits/near/misses count. You can sort the list in ascending or descending order by any one of these characteristics by simply clicking the title of the column. The list will immediately be resorted according to the column title you click. Use the triangle on the far right (as shown in Figure 53-1 on page 455) to toggle the list between ascending or descending order. For the sake of comparison, the sequence’s current tempo is also calculated and included in the list.

The following sections provide a brief explanation of each column in the Search Results list. You can sort the list by the values displayed in each column by clicking the column title.

Current
The Current column identifies the search results entry for the current sequence tempo (either a fixed tempo or the sequence’s tempo map). If the sequence is in Conductor Track tempo mode, then the current tempo displayed in this column is the average tempo for the sequence. The average tempo is shown in italic text.

Click the column title and use the ascending or descending order triangle (above the vertical scroll bar) to sort the list such that the current tempo is listed first, at the top.

Tempo
The Tempo column displays each tempo (in beats per minute) for which hits have been calculated. The number of tempos in the list is determined by the tempo range you specify, along with the frequency of tempos you’ve chosen to try within that range (as explained earlier in “Entering search parameters” on page 456). Click the column title and use the ascending or descending order triangle (above the vertical scroll bar) to sort the list by tempo.

Offset
The Offset column (Figure 53-1) shows you the offset (in frames and 80ths of a frame) that is associated with the tempo for this search result. A search result is the combination of a tempo and an offset. If you apply a tempo, its offset (if non-zero) will be added to the current chunk start time.

Negative offsets
Offsets can be either positive or negative, although negative offsets are limited so they can never shift the chunk start time to a value that is less than zero.

Partial frame offsets
Partial frame offsets are explicitly shown, rather than hidden (as in previous versions of Digital Performer). If you click the Tempo column heading to sort the results list by tempo, then each tempo is shown with all of its possible offsets before the next tempo is shown.

Total Error
The Total Error column gives you a bar graph representation of how well or poorly the tempo matches your hits. This measurement takes into account how close each locked marker is to the nearest beat, and then averages the total. Each marker’s weight is also factored into the total error, with important markers influencing the total error score more heavily than less important ones.
Hit / Near / Miss column
The Hit/Near/Miss column (Figure 53-1) shows three numbers: the number of hits, the number of markers that are within 1 frame of being a hit, and the number of misses. This is valuable information for honing in on tempo choices, and you can conveniently compare these numbers with the total possible number of hits (Max Hits) displayed just above this column. If you click the heading of the Hits/Near/Miss column to sort the tempo results list, it orders the results first by number of hits, and secondly by number of near misses.

AUDITIONING A SPECIFIC TEMPO
If Audible Mode is on and a tempo in the list is selected, the metronome will click at that tempo. You can turn Audible Mode on or off with the speaker button in the Control Panel.

VIEWING THE RESULTS OF A SPECIFIC TEMPO
To get a closer look at the results for a certain tempo, click the tempo in the list to highlight it. When you do, the list in the lower portion of the window shows details about every marker for that tempo, including the number of frames off it falls from a beat and the total amount of error for that marker. In addition, the closeness of the hit is indicated by color in the Hit column as a general reference. Green means a direct hit; yellow means it is close, and red means there was no direct hit.

The following sections provide a brief explanation of each column in the Find window marker list. Once again, you can sort the list by the values displayed in each column by clicking the column title.

Time
This is the location of the marker in measures|beats|ticks (as entered in the Markers window).

Frame
This is the marker’s SMPTE frame location (as entered in the Markers window).

Marker
This is the Marker name (as entered in the Markers window).

Weight
This is the Marker weight as specified in the Markers window. See “Preparing markers” on page 456.

Error
This is a bar graph representation of how far away the marker is from the nearest beat.

Frames off
This column tells you how many frames the marker is from the nearest beat.

Hit
This column gives you a visual indication of how close the marker is to a hit (beat). Green is a good hit (near the center of the marker’s hit range). Yellow is a near miss; red is a complete miss.

APPLYING THE TEMPO TO YOUR SEQUENCE
The Apply button writes the currently selected tempo to the sequence specified at the top of the Find Tempo window, starting at the Start Search location (Figure 53-1 on page 455).

COPY AND MOVE LOCKED MARKERS
The Copy and move locked markers option helps you if you are finding a tempo after you have written music. It creates an unlocked copy of each locked marker so that when you apply your tempo, the unlocked markers shift with the music, allowing you to see where your music data has moved after applying the tempo.
LOCKING TRACKS BEFORE APPLYING A NEW TEMPO

If you have data that you don’t want to move when applying a tempo to a sequence, then lock that track before applying the tempo.
Part 9
Mixing
CHAPTER 54  Mix Automation

OVERVIEW
Performer Lite’s mixing environment offers complete automation of effects plug-in parameters, track muting/unmuting, effects send levels, send mutes/unmutes and more.

AUTOMATED MIXING FOR MIDI AND AUDIO
The mix automation features discussed in this chapter apply to both MIDI and audio tracks, except as noted below.

Mix automation in MIDI tracks
Only the following mix automation parameters can be automated in a MIDI track:

- Volume and pan
- Track mute/unmute
- Any form of MIDI continuous data

Mix automation in audio tracks
Audio tracks can automate every mix parameter, including:

- Volume and pan
- Track mute/unmute
- Plug-in automation
- Plug-in bypass/unbypass
- All other mix parameters
- Pitch automation
- Soundbite volume

Mix automation in virtual instrument tracks
Virtual instrument tracks can automate every mix parameter, as above for audio tracks, but there is varying support among virtual instruments for audio track automation. Many virtual instrument products rely on MIDI controller data for automation. For details, see “Instrument track automation” on page 69.
MIDI volume and pan automation
Performer Lite automates MIDI track volume and pan using MIDI controller data (#7 for volume and #10 for pan) to create sudden or smooth volume changes, crossfade effects and panning effects in MIDI tracks. MIDI volume controllers have a range from zero to 127. Unlike note-on velocities, which only affect the initial volume of the note, volume controllers affect volume at any time while a note is playing. Controllers can be inserted, generated, drawn, reshaped, recorded and otherwise handled using the Mixing Board and Sequence Editor as described in the rest of this chapter.

Audio mix automation
Performer Lite provides continuous break-point automation for all audio mixing parameters, including volume, pan, and plug-in parameters. Audio mix automation data can be inserted, generated, drawn and reshaped. Unlike MIDI events, which create discrete changes in MIDI volume, audio automation events actually calculate a smooth, sample-accurate ramp from one event to the next. This effect is often referred to as “ramp” automation because graphically, audio volume events produce lines that ramp from one event to the next, as shown below in Figure 54-2. Several volume events can be used together to create volume curves, as demonstrated by the bottom track.

Pitch automation
For complete details on Performer Lite’s real-time pitch automation layer, see chapter 61, “Transposing Audio” (page 519).

MIX AUTOMATION SETUP
The Automation Setup window (Setup menu) provides dynamic control over automation, from a global level to the most detailed level in specific tracks. The Automation Setup window stays open so that you can easily access its features as you work.

GLOBAL AUTOMATION ENABLE/DISABLE
As you work with automation, there will be times when you want to temporarily disable automation and later re-enable it. Automation features can be enabled and disabled at any time on several levels:
- Globally (all automation)
- Globally by type of automation
- Per track
- Per individual effect parameters in a track

The global automation settings let you enable or disable automation altogether, or individually by several types of automation.

![Global Automation Enable Disable](image)

**Figure 54-4: The global automation enable/disable settings.**

To temporarily disable automation altogether, uncheck the *Enable Automation* check box. Doing so disables the playback or recording of all automation data (including volume and pan), although the data in each track remains unchanged (Figure 54-5), ready for reactivation. To re-enable automation, check the Global Automation check box.

![Enabled Disabled Automation Data](image)

**Figure 54-5: When you disable automation data, it appears as a dashed line in the Sequence Editor.**

**Enabling/disabling globally by data type**

Similarly, the Global Automation section (Figure 54-4) has individual enable/disable check boxes for categories of automation data (for both audio and MIDI tracks), including mute, volume, pan, send mutes, send levels, and plug-in parameters. For example, you might want to temporarily disable plug-in automation, while maintaining volume and pan automation.

**AUTOMATION SETUP FOR EACH TRACK**

The Automation Setup window (Figure 54-3) also provides independent automation settings for each track (Figure 54-6). You can enable/disable automation recording, playback, and even individual plug-in parameters. In addition, you can choose one of the different automation recording modes. For convenience, some of these settings are duplicated in each track’s channel strip in the Mixing Board, as well as the track settings section in the Sequence Editor (Figure 54-7).

![Track Automation Configuration](image)

**Figure 54-6: Automation setup for an individual track. In this example, the 'Gtr Leads' track has three plug-ins assigned to it: Echo, Reverb and PreAmp-1™.**

**The track menu**

Use this menu to choose the track for which you wish to make automation settings. All of the settings below this menu apply to the track currently chosen in the menu.
**Enable automation playback**
Check this box to enable automation during playback. Uncheck it to disable automation during playback. This option is a great way to temporarily listen to the material in a track without its automation data, while the rest of the mix is still fully automated.

**Enable automation recording**
Check this box to allow the recording of automation data during playback. This is an important control because when it is enabled, *any* changes you make to enabled automation parameters in the track — plug-in settings, panning, volume, etc. — will be recorded. So pay careful attention to this button and only enable it when you’re sure you want to record your moves.

**Automation record mode**
The *mode* menu lets you choose one of the different ways to record automation data into the track. You can change the mode at any time from the Automation Setup window, the track’s channel strip in the Mixing Board or the track settings in the Sequence Editor. For details, see “Automation modes” on page 466.

**Enabling automation by data type**
Initially, any plug-in parameter can be automated as soon as you begin using the plug-in.

However, you can be very specific regarding the types of data you wish to automate for each track, as shown previously in Figure 54-6. This allows you to automate certain controls, while leaving others ‘free’ to be tweaked at will. In the example shown in Figure 54-6, The ‘Gtr Leads’ track currently has three plug-ins assigned to it in the mixing board (as inserts): Echo, Reverb and PreAmp-1. These plug-ins appear in the Add menu, along with Volume, Pan, Send Level, Send Mute, and track Mute. Each plug-in displays a sub-menu for each one of its automatable parameters. Use the Add menu to add automatable parameters to the list, and then use the radio buttons above the list to specify *All Except* (what’s in the list), or *Only* (what’s in the list). To remove items from the list, click them to select them and click *Remove*. Choosing *All* enables all plug-in parameters, regardless of what is currently displayed in the list.

**‘Apply to selected audio/MIDI tracks’ button**
If you’d like to apply the automation types you’ve specified in the list to other tracks, select the desired tracks first and then click the *Apply to All selected audio/MIDI Tracks* button. This operation applies the current track settings to all currently selected audio or MIDI tracks (depending on what type of track is currently being displayed).

**‘Save as Default for Audio/MIDI tracks’ button**
If you’d like to apply the automation types you’ve specified in the list to new tracks automatically when you add them, click the *Save as Default for Audio/MIDI Tracks* button. There is a separate default state for MIDI and audio tracks. The button changes its wording (audio vs. MIDI) depending on what type of track is currently being displayed.

**Automation settings in other windows**
The Mixing Board displays several track-based automation settings directly in the channel strip for each track, just above the pan pot. These settings match the corresponding track settings in the Automation Setup window, the Sequence Editor and the Effects window, as shown in Figure 54-7. If you change them in one location, they’ll change in the others as well.
In the Mixing Board, the same Option/Alt-click and Command/Ctrl-click conventions apply to the automation play-enable buttons as for track play-enables. You can also ‘glide’ over the automation play-enable and record-enable buttons to quickly toggle a series of adjacent tracks.

The ‘Auto’ menu (automation menu)
As shown in Figure 54-7, the automation menu in the Sequence Editor contains the same basic automation mode settings as the Mixing Board and Automation Setup window. In addition, the ‘Auto’ menu changes color to further indicate the current automation record and playback settings as follows:

<table>
<thead>
<tr>
<th>‘Auto’ menu color</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Automation playback and recording are both disabled.</td>
</tr>
<tr>
<td>Green</td>
<td>Automation playback is enabled.</td>
</tr>
<tr>
<td>Red</td>
<td>Automation playback and recording are both enabled.</td>
</tr>
</tbody>
</table>

REASONS TO DISABLE AUTOMATION
Why would you ever want to disable automation, either globally, per track or even on the basis of individual plug-in parameters? Here are a few common reasons.

One of the main reasons to disable automation, or to enable only a particular plug-in parameter, is that often you are only automating one or two controls in a plug-in. You don’t want to worry about accidentally recording changes you make to other controls that you are not automating. By not activating them for automation in the first place, this will never happen, regardless of the track’s record mode setting.

Sometimes, you’ll want to temporarily experiment with automatable parameters, such as plug-in controls, without accidentally recording your moves as you experiment. For example, you might want to adjust the EQ for a track to get it just right, but you don’t want to record your moves as you’re doing so. You can use the Automation Setup window to temporarily disable plug-in automation — or even just the EQ control you are adjusting — while you experiment.

Here’s another case where you might want to temporarily disable automation: when you need to do A/B comparisons with and without it. For example, you might want to listen to a passage without the automation you’ve programmed for it, and then listen to it again with the automation re-enabled.

AUTOMATION MODES
Performer Lite’s automation modes provide different ways to record automation. For example, **Overwrite** mode starts recording immediately when playback begins, overwriting any existing automation in the track. **Touch** mode, on the other hand, waits for you to grab a knob or fader before it begins recording.
Each track in the Mixing Board can be independently assigned to one of the modes. The automation mode menu for each track is located just above the fader as shown below.

![Figure 54-8: The automation modes for each track.](image)

The automation modes are summarized below:

<table>
<thead>
<tr>
<th>Automation mode</th>
<th>When it punches in</th>
<th>When it punches out</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>As soon as playback begins</td>
<td>Never (When playback stops)*</td>
</tr>
<tr>
<td>Touch</td>
<td>As soon as you grab the fader or knob</td>
<td>As soon as you release the fader or knob</td>
</tr>
<tr>
<td>Latch</td>
<td>As soon as you grab the fader or knob</td>
<td>Never (when playback stops)*</td>
</tr>
<tr>
<td>Trim Touch</td>
<td>----- Same as Touch -----</td>
<td></td>
</tr>
<tr>
<td>Trim Latch</td>
<td>----- Same as Latch -----</td>
<td></td>
</tr>
<tr>
<td>Range Touch</td>
<td>-- See “The Range modes” on page 470--</td>
<td></td>
</tr>
<tr>
<td>Range Latch</td>
<td>-- See “The Range modes” on page 470--</td>
<td></td>
</tr>
<tr>
<td>Range Trim Touch</td>
<td>-- See “The Range modes” on page 470--</td>
<td></td>
</tr>
<tr>
<td>Range Trim Latch</td>
<td>-- See “The Range modes” on page 470--</td>
<td></td>
</tr>
</tbody>
</table>

*In Overwrite or Latch modes, there are actually two ways you can punch out of recording on the fly:

- Disable automation recording (using any available method for disabling it)

OR

- Switch to a different automation mode

### Playing versus recording

For all automation modes, the track can be either play-enabled for automation or record-enabled for automation. Except for Overwrite mode, the behavior of the controls you modify during playback is the same either way. The only difference is that automation data is or is not written into the track. For example, let’s say that a track is play-enabled for automation (but not record-enabled). If you place the track in Touch mode, and you move its volume fader, the fader will return to tracking any existing automated volume levels in the track as soon as you let go of it. On the other hand, if the track is in Latch mode, the fader will remain where you leave it until playback stops. The next time playback begins, the fader will then return to tracking any existing automated volume levels in the track. Since the track is not record-enabled, no automation data would be written in either case.

### Scaling volume data with the Trim modes

Trimming is the process of scaling existing volume or send level automation data in the track, instead of overwriting it entirely. This process is explained in further detail later in “The Trim modes” on page 469.

Overwrite, Latch and Touch modes overwrite existing automation data in the track, whereas Trim Touch and Trim Latch scale existing data. Only track volume and send levels can be...
trimmed. Other types of automation data are overwritten according to the mode chosen. Here’s a summary:

<table>
<thead>
<tr>
<th>Automation mode</th>
<th>Overwrite or scale?</th>
<th>Data that’s affected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overwrite</td>
<td>Overwrites</td>
<td>All parameters currently being automated in the track (except those that you’ve temporarily disabled).</td>
</tr>
<tr>
<td>Touch</td>
<td>Overwrites</td>
<td>Only the parameter currently being adjusted.</td>
</tr>
<tr>
<td>Latch</td>
<td>Overwrites</td>
<td>Only the parameter currently being adjusted.</td>
</tr>
<tr>
<td>Trim Touch</td>
<td>Scales existing data</td>
<td>Track volume or a send level (whichever item is currently being adjusted).</td>
</tr>
<tr>
<td>Trim Latch</td>
<td>Scales existing data</td>
<td>Track volume or a send level (whichever item is currently being adjusted).</td>
</tr>
</tbody>
</table>

**Overwrite mode**

As shown by the table above, *Overwrite* mode is special because it overwrites all of the parameters currently being automated in the track. In a sense, this is a way of ‘wiping over’ them all at once with the settings that you choose before you begin playback.

*Figure 54-9: Overwrite mode ‘wipes over’ all currently enabled automation data in the track. The current data is replaced by data that reflects the current knob, fader or other control setting for each parameter. So be sure to set every control you are overwriting to the desired setting before overwriting.*
Selective overwriting
You can selectively overwrite automation data while preserving other data by temporarily disabling certain effects parameters in the track beforehand. The disabled parameters will not be overwritten, as shown below in Figure 54-10.

![Figure 54-10: In this example, everything except volume automation has been temporarily disabled. In Overwrite mode, volume data is overwritten with the current positions of the fader.](image)

Switching to Touch mode after overwriting
Overwrite mode is generally used once in one pass, usually at the start of the mixing stage of your project, or perhaps to wipe over a section that you want to remix entirely. After overwriting, you generally want to touch up the mix from there with the other automation modes (Touch, Latch, etc.) For your convenience, the Automation Setup window (Figure 54-3) has a check box option called Overwrite mode changes to touch after pass. Check this option if you’d like tracks currently in Overwrite mode to automatically switch back to Touch mode after you do an overwrite record pass, so that you don’t keep overwriting again and again.

Touch and Latch modes
With the Touch, Latch, Trim Touch and Trim Latch modes, only the parameter you are adjusting is overwritten (or scaled, in the case of the two trim modes). In addition, recording only takes place when you adjust the knob, fader or other control item for the parameter. These modes are the safest because you won’t accidentally overwrite existing automation data; they’ll only record when you deliberately adjust a control. Just be careful not to record adjustments during playback that are not meant to be inserted. See “Reasons to disable automation” on page 466.

The Trim modes
Trim Touch and Trim Latch modes scale existing volume data or send level data in the track, rather than overwriting it. The two trim modes allow you to increase or decrease volume or send level while maintaining the existing contour in the track. For example, you might painstakingly program a detailed, dynamic volume mix for a track, but later decide that you want to raise the whole thing by 1 dB.

Accordingly, when you switch from a non-trim mode to a trim mode, the scale of the volume fader for the track changes from the normal scale where zero dB is unity gain to a relative scale where zero is the current volume level in the track, whatever it may be at any given moment. The two scales are shown below in Figure 54-11:

![Figure 54-11: Latch mode displays the usual volume scale, where 0 dB is unity gain. Trim Latch mode (and Trim Touch) show a relative scale where zero dB is the current automation level in the track at any given location. The send knobs also go into trim mode, as shown.](image)
In Figure 54-12 below, the volume curve is being scaled up by 8 dB using Trim Touch mode.

**The Range modes**

The Range Touch, Range Latch, Range Trim Touch, and Range Trim Latch modes behave similarly to the regular Touch, Latch, Trim Touch, and Trim Latch modes, but when recording automation using the Range modes, moving controls will change automation data only within a defined time range. The settings for the data on either side of the affected time range will be preserved.

**Determining a time range**

To specify a time range for the range automation modes, use one of the following methods, which are listed in order of their priority:

1. an event or time range selection in the track
2. a time range selection in another track
3. the Memory Cycle range

**Range Latch and Range Touch**

With the Range Latch and Range Touch modes, the value of the automation data within the defined time range will become constant according to the setting of the control. Therefore, these modes are useful for adjusting automation data that is already flat, or for leveling a data curve that you wish to flatten.

**Range Trim Latch and Range Trim Touch**

With the Range Trim latch and Range Trim Touch modes, the current shape of the automation data curve within the time range (if any) is preserved, and the entire curve is moved up or down. Therefore, these two trim modes are ideal when there is already a shape to the automation data within the time range, and you wish to preserve that shape and simply raise it or lower it altogether.

**Using the range automation modes**

All four range automation modes are useful when mixing groups of tracks, such as background vocals or horn sections, within a specific time range, where you want to jump in and change the mix just for that range without changing it before or after.

These modes provide the following additional benefits:

- The range automation modes allow you to use the same control for modifying the data as you did for entering it. For example, if you automated a plug-in filter sweep using the knob in the plug-in window, you can use that same knob to adjust your original sweep, without having to do so by some other means (such as editing the automation data in the track).

The range automation modes allow you to make changes to automation data without having to switch edit windows to display the automation data. Instead, you can continue viewing the data you are currently viewing, such as soundbites (or automation data of another type).

**Return ramps**

A return ramp (Figure 54-12) is an automation ramp automatically inserted by Performer Lite after you punch out from an automation edit. The
return ramp makes a smooth transition between the level you were at when you punched out and the level of the any existing automation in the track just after the point where you punched out.

The default length for return ramps is 500 milliseconds (half a second). You can change it to any length you prefer in the Automation Setup window (Figure 54-3 on page 463), and you can change it at any time.

**RECORDING AUTOMATION**

Automation data can be recorded in real time during playback. To do so, enable the automation record button for the track you wish to record (as shown in Figure 54-7), and choose the desired mode (Overwrite, Touch, Latch, etc.) You do not need to put Performer Lite into record mode to record automation. Just start playback and adjust volume, pan, plug-in settings, send levels, and mutes as desired during playback.

The automation data is recorded directly into the track, replacing existing automation data of the same kind, if any.

**Controlling MIDI data density**

The Min Time and Value Range mini-menu command in the Mixing Board window lets you control the density of the MIDI controller events generated by the Mixing Board faders and knobs in MIDI tracks. Higher minimum values produce lower density, which generally ensures smoother playback performance. But densities that are too low can cause zipper noise or “stair-stepping”. When experimenting with data density, factors such as playback tempo also come into play.

**INSERTING AND EDITING AUTOMATION**

All of the various types of automation data (plug-in automation, mute automation, send levels, etc.) can be inserted and edited in the Sequence Editor for both MIDI and audio tracks. Use the Insert menus in the Sequence Editor to insert and edit automation data. For complete details, see:

- “Editing MIDI CC’s in Points or Bars mode” on page 299
- “Editing CC data in Lines mode” on page 301
- “Working with breakpoint mix automation” on page 317.

![Figure 54-13: Automation data can be recorded or inserted directly into each audio track.](image)

![Figure 54-14: In these examples, automation data is being inserted in the Sequence Editor.](image)
**Generating automation curves**

You can generate volume curves using the Insert Continuous Data command in the Region menu. Be sure to select the region over which you’d like to generate the events first. This method gives you precise numerical control over the curve.

![Insert Continuous Data](image)

*Figure 54-15: You can create numerically precise automation changes with the Insert Continuous Data command.*

**Viewing automation in the Sequence Editor**

To view automation data in the Sequence Editor, choose the desired type of automation from the Active Layer menu as shown below in Figure 54-16. When you do, every type of automation data that currently exists in the track will be displayed together, superimposed over the audio waveform. The specific type of data that you chose from the menu will be activated (its ramps and control points will appear in bold). When activated, a parameter’s control points can be edited, and new points can be added by clicking anywhere on its line. In addition, some parameters display guides (faint horizontal lines) that indicate values of interest. For example, when you activate Volume, you’ll see a guide at unity gain (0 dB) and the top of the scale (6.02 dB). When you activate pan, you’ll see guides at pan center and pan hard left/right. For complete details, see “Working with automation control points” on page 474.

![Sequence Editor Automation](image)

*Figure 54-16: Choose any form of automation data from the Active Layer menu to display all automation data that currently exists in the track, superimposed over the waveform. To ‘activate’ (make bold) a particular data parameter, choose it from the Active Layer menu or click one of its control points.*

**The three types of plug-in automation data**

Plug-ins have a wide variety of controls that fall into three general types of data:

<table>
<thead>
<tr>
<th>Automation type</th>
<th>What it does</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ramp</td>
<td>Produces a smooth change between control points.</td>
<td>Volume, Pan, Send level, Mix gain</td>
</tr>
<tr>
<td>Stair-step</td>
<td>Produces sudden changes among several possible states.</td>
<td>LFO phase, Mute/unmute, Bypass/unbypass</td>
</tr>
<tr>
<td>Single event</td>
<td>Changes the setting of a parameter that has only a few settings or non-numeric settings</td>
<td>LFO waveform type (sine, sawtooth, etc.), Note values for beat-based effects</td>
</tr>
</tbody>
</table>

All three types of automation are displayed together in the Sequence Editor as shown below in Figure 54-17.
Sample-accurate ramps
Performer Lite’s ramp automation produces a smooth change from one control point to the next. Ramps are calculated with sample-accurate, 32-bit floating point processing. Sample-accurate processing ensures that the ramp will be perfectly smooth, with no zipper noise or other unwanted artifacts.

Stair steps
Stair-step automation produces a sudden change at each control point. Stair-step automation is used for plug-in parameters that by nature don’t call for smooth changes but instead provide discrete changes among several various states. A good example is the LFO phase controls in Sonic Modulator, which provide eight phase settings in 45-degree increments. Stair steps are also used for parameters that would be too “expensive” from a DSP bandwidth standpoint for calculating ramps. A good example of this is LFO rate.

Discrete events
Discrete events are used for any parameter that consists of two or more non-numeric settings (or just a few numeric ones). A good example is the waveform for an LFO: it could be a sine wave, square wave, sawtooth, triangle, etc. Depending on the number of possible settings for the event, Performer Lite displays the event either as a single automation event box, as shown in Figure 54-17, or as a stair-step event, with the possible values for the event shown in the ruler.

In the case of the single event box, here is a summary of what you can do with single automation events like these:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert an event</td>
<td>Choose it from the insert menu as shown in Figure 54-14 on page 471 and click at the desired location.</td>
</tr>
<tr>
<td>To delete an event</td>
<td>Click it to select it and press delete.</td>
</tr>
<tr>
<td>To change its setting</td>
<td>Press on its menu triangle and choose the desired setting from the menu as shown in Figure 54-17.</td>
</tr>
<tr>
<td>To move an event</td>
<td>Drag it.</td>
</tr>
</tbody>
</table>

One important thing to realize about discrete parameter boxes is that they don’t display their current value continuously throughout the track the way that ramps and stair steps do. To determine the current setting for a discrete parameter, you need to scroll backwards in the track to find the last discrete event of the type you’re concerned with, and then look at its setting there.

Units of measurement
In Performer Lite’s included plug-ins, the numeric value for each plug-in effect parameter (displayed in the Cursor Information and Event Information bar) is displayed with the appropriate format (percent, milliseconds, etc.) for the parameter. This is also true for most third-party plug-ins. Some third-party plug-ins, however, may have their own schemes for displaying parameter values. Check their documentation for details.
Working with automation control points
Here’s a summary of techniques for inserting and editing automation control points in the Sequence Editor, including a new technique for selecting and dragging multiple control points at one time:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To activate a data type*</td>
<td>Click one of its control points or choose it from the Active Layer menu (Figure 54-16).</td>
</tr>
<tr>
<td>(make it bold)</td>
<td></td>
</tr>
<tr>
<td>Note: activating is necessary for all of the following techniques.</td>
<td></td>
</tr>
<tr>
<td>To insert a control point</td>
<td>Activate the desired data type and then click anywhere.</td>
</tr>
<tr>
<td>To insert a ramp</td>
<td>Activate the desired data type. Then click anywhere on the line as many times as needed to create two or more control points, positioning the control points as needed to make the ramp.</td>
</tr>
<tr>
<td>To insert a curve</td>
<td>Activate the desired data type. Select Pencil tool and the desired waveform shape from the Tool palette and insert. For more information see “Inserting CC data in Points or Bars mode” on page 299.</td>
</tr>
<tr>
<td>To remove a control point</td>
<td>Click it to select it and press delete.</td>
</tr>
<tr>
<td>To remove a curve (multiple control points)</td>
<td>Select the control points (as described below) and press the delete key.</td>
</tr>
<tr>
<td>To select a curve (multiple control points)</td>
<td>Activate it and then drag horizontally over its control points.</td>
</tr>
<tr>
<td>To move a curve (multiple control points)</td>
<td>Select them as described above and drag one of the selected control points.</td>
</tr>
</tbody>
</table>

*To activate any type of data other than volume and pan, you must first insert some data (via the Insert menu or by recording) in order for the data to appear in the Active Layer menu (and be available for activation).
TEMPO LOCKED, BEAT-BASED AUTOMATION
Some plug-ins allow you to lock certain parameters, such as an LFO, to the tempo of your sequence. This allows the effect to stay in sync with the beat of your music.

For details on tempo-locking effects included with Performer Lite, see “Tempo lock” on page 8 in the DP Plug-in Guide. For details on tempo-locking third-party effects, refer to their documentation.

SNAPSHOT AUTOMATION
An automation snapshot is the process of inserting automation data for multiple mix parameters in one step at a particular location — or over a specified time range. For example, you might want to set initial values at the very beginning the project (e.g. bar 1) for all mix parameters you’ll be automating. Or, you might like to reset all values for an entire section of a mix, regardless of the automation data currently there. Performer Lite lets you take a snapshot at a particular point in time or apply it to any time range of your choice. You also have complete control over which parameters to include in a snapshot. Snapshot automation can be applied from the Mixing Board, Sequence Editor, Effects window or other windows. Different default settings can be stored for taking snapshots from these different windows.

Taking a snapshot
To take a snapshot:

1 Prepare for the snapshot as discussed in the next few sections.

2 Click the Snapshot button in the Sequence Editor, Mixing Board, or Effects window.

Doing so opens the Automation Snapshot dialog shown below in Figure 54-19:

![Automation Snapshot dialog](image)

**Figure 54-19: Taking an automation snapshot.**

3 Choose the desired settings and click OK.

Preparing for a snapshot
Before you take a snapshot, there are several preparations to make that determine the following characteristics of the snapshot:

- The time range to be affected
- The tracks to be included
- The automation data types to be included

Specifying a location or a time range
Even though automation data consists of discrete events (control points in audio tracks and MIDI controller events in MIDI tracks), it is important to realize that they actually affect your mix over a range of time. For example, if you click on a volume automation line in an audio track to insert a volume control point, ramps are created between the new point and the two points before it and after it. So you’ve actually affected the entire time range between all three points.

Similarly, when working with automation snapshots, you need to think about the time range that the snapshot will affect and specify it before inserting the snapshot. Performer Lite lets you specify a snapshot’s time range in two ways:

- by positioning the playback wiper (the current counter location)
by making a time range selection

The options in the Time Range menu (shown below in Figure 54-20) determine which method to use. Performer Lite then applies the snapshot by placing automation control points (or MIDI controller events) at the start and end of the time range (to maintain the existing automation levels beyond the time range).

When applying a snapshot to all time or a selected range, any existing automation data within the time range is removed.

![Automation Snapshot](image)

Figure 54-20: Specifying a time range for the snapshot.

**All Time**
Use All Time if you wish to apply the snapshot to your entire mix, start to finish. The current counter location or current selection does not matter for this option.

**Selected Range**
If you would like to apply the snapshot to a particular range of time, make a time range selection in any Performer Lite window before you take the snapshot and then choose the Selected Range option in the Automation Snapshot dialog (Figure 54-20).

**From Counter to Next/Previous Change (Flat or Ramp)**
This option applies the snapshot to the range of time from the current counter location to the next or previous automation control point (or MIDI controller). It does so independently for each parameter being included in the snapshot. The Flat option produces a constant parameter value throughout the time range being affected by the snapshot; the Ramp option produces a standard automation ramp from the control point inserted at the wiper location to the next or previous control point for each automation parameter. Note that the Ramp option only applies to ramp-style data types, such as volume and pan. See “Morphing’ between presets” on page 478 for an interesting way to use this option.

**From Previous Change to Next Change**
Use this option to apply the snapshot to the entire range of time between two existing snapshots (or any other arrangement of consecutive automation control points). Just place the playback wiper (or counter location) anywhere between them. Use this option to quickly adjust an existing snapshot by placing the wiper anywhere just to the right of it, rather than tediously attempting to place the wiper directly at the location of existing automation data.

If you situate control points at the beginning and end of a section, this option gives you a way to alter the automation in the section in one step.

**Specifying tracks**
The Tracks menu in the Automation Snapshot dialog gives you several convenient options (Figure 54-21 below) for choosing which tracks to include in the snapshot. If you wish to use the Selected Tracks option, select the desired tracks before taking the snapshot. If you wish to use one of the window display options, be sure to show and hide tracks as desired before taking the snapshot. When using the Edit Window and
Mixing Board options, all tracks currently highlighted in the track selector list are included in the snapshot, even if they are not currently visible in the window itself.

![Automation Snapshot](image)

**Figure 54-21: Specifying the tracks to be included in the snapshot.**

**Specifying data types**
The Data Types menu in the Automation Snapshot dialog gives you several convenient ways (Figure 54-22 below) for determining which types of automation data to write to each track with the snapshot operation.

![Automation Snapshot](image)

**Figure 54-22: Specifying the data types to be included in the snapshot.**

**All Enabled Data Types**
This option causes the snapshot to write all of the automation data types that are currently enabled in the Automation Setup window (Setup menu). This includes the global enables and the automation enable/disable settings for each individual track. Be sure to enable and disable automation as desired before taking a snapshot using this option.

**Current Data Types in Edit Window**
This option inserts automation data being displayed in the Sequence Editor window. More specifically, the snapshot only writes automation data that is currently ‘active’ (as demonstrated in Figure 54-16 on page 472) for each included audio track. Notice that only one data type can be active at a time. This option is good for quickly inserting snapshots for the data you are currently viewing in the Sequence Editor. For example, if you are currently displaying volume automation in all audio tracks (volume automation is the active data type for all tracks), use this option to quickly insert a volume-only snapshot.

**Data Types Visible in Mixing Board**
This option inserts automation data for all automatable controls currently visible in the Mixing Board window. For example, if the Inserts section is currently hidden, no insert level or pan data will be inserted by the snapshot. If you wish to use this option, be sure to use the Mixing Board window mini-menu to show/hide each section as desired before taking the snapshot.

**Data types for Current Effect in Effects Window**
This option inserts automation data for all automatable parameters of the plug-in currently being shown in the Effects window. This is a great way to automate plug-in presets (by inserting them as snapshots). Also see “‘Morphing’ between presets” on page 478.

**Using snapshots to capture automation and apply it elsewhere**
You can use Performer Lite’s snapshot feature to capture automation settings from one part of your mix and apply them somewhere else. To do so:

1. In the Automation Setup window (Setup menu), enable all automation types you wish to include in the operation.
2 Position the playback wiper (or main counter) at the location in the mix you wish to capture. Doing so causes all automation-enabled knobs, faders and other settings in the Mixing Board to update to their correct values at that point in the mix.

3 Back in the Automation Setup window, globally disable all automation by unchecking the global automation check box. Doing so ‘freezes’ all knob and fader settings in the Mixing Board, so that they will not move when you change the current playback location.

4 Scroll to the location in the mix at which you’d like to apply the Mixing Board’s current automation settings.

5 In the Automation Setup window, check the global automation check box to re-enable automation globally.

☛ At this point, make absolutely sure that the current playback location does not change. Otherwise, the current settings in the Mixing Board will be lost.

6 Take a snapshot of the plug-in parameters using the From Counter to Previous Change (Ramp) Time Range option.

7 Repeat as desired.

Alternatively, you could start with the final preset in the series you are inserting and work backwards with the From Counter to Next Change (Ramp) Time Range option.

**Snapshot settings are remembered**

You can take a snapshot from within the following windows (when the window is the front-most, active window):

- Sequence Editor
- Mixing Board
- Effects window

Performer Lite remembers the snapshot settings you last used in each context. For example, you might only include visible mix parameters when taking a snapshot in the Sequence Editor, but include only plug-in parameters when taking a snapshot from the Effects window. In addition, you might like to always include all mix parameters when taking a snapshot from the Mixing Board. You can specify snapshot settings for each window the first time you take a snapshot from within the window. Performer Lite then remembers the settings and will use them the next time you take a snapshot from the window.

To reinforce this concept visually, the Automation Snapshot window (Figure 54-19 on page 475) opens directly on top of the window from which it is being invoked.

Performer Lite also stores a generic set of snapshot settings for all other windows. As a result, if you take a snapshot with the Take Automation Snapshot command in the Region menu when the Sequence Editor, Mixing Board or Effects window
is not the front-most active window, the settings you see in the Automation Snapshot dialog (Figure 54-19 on page 475) will be remembered independently from the settings for those three windows.

**A shortcut for taking snapshots**
To take a snapshot from within a window with the same settings last used for that window, press Command–Control–single quote (’). Alternatively, you can hold down the Command/Ctrl key while choosing *Take Automation Snapshot* from the Region menu. Doing so changes the menu command into *Take Automation Snapshot Again*.

**Making the transition to an automated mix**
When you first begin working on a Performer Lite project, there is no existing automation data in each track until you record it, insert it by hand or insert it via a snapshot. Beforehand, your mix simply consists of the current fader, knob and insert settings in the Mixing Board. If you record or insert an automation control point for the first time in an audio track, somewhere in the middle of the sequence, Performer Lite automatically extends a line from the control point back to the beginning of the sequence to maintain the initial setting for that parameter in the mixing board. As a result, you get what you would expect: the initial setting you had made in the mixing board (before automation), followed by the automation data you recorded or inserted.

The above behavior does not apply to MIDI tracks. When you insert MIDI controllers for volume, pan or other mix-related parameters, Performer Lite does not automatically insert an initial value for them at the beginning of the sequence. Doing so is up to you.

Before you begin to automate the mix, you might want to insert initial values for all mix parameters you’ll be automating so that you have a convenient reference point to start from. This step is not necessary, but it you might find it helpful to have initial values before you begin automating, especially for MIDI tracks. You can always go back and change the initial values at any time, either by tweaking them individually in the edit window of your choice or by retaking the snapshot at the beginning of the sequence.

**AUTOMATION PREFERENCES**
The Automation Setup window offers several preferences.

![Automation Preferences](image)

**Overwrite mode changes to touch after pass**
This automation preference, when checked, causes tracks in Overwrite mode to automatically change over to Touch mode after you record a pass in Overwrite mode. This option helps you to avoid unnecessary or unwanted consecutive overwriting. For details, see “Switching to Touch mode after overwriting” on page 469.

**Solo & Play Phrase override mute automation**
When this option is checked, soloing a track causes mute automation in the track to be ignored, allowing you to always hear the audio in the track. Similarly, if you press Option/Alt-spacebar to audition some audio, it will play, even if it is currently being muted by mute automation data. If instead, you would like soloing and auditioning to reflect the track’s current mute automation, uncheck this option.
Auto return ramp length
At the end of an automation record pass, when you punch out by either releasing the fader or stopping recording altogether, Performer Lite automatically inserts a return ramp at the punch-out point. This ramp produces a smooth transition from the level you were at when you punched out and the existing data in the track at the punch out point. The Auto return ramp length preference determines the length of this ramp. For further details and an example, see “Return ramps” on page 470 and Figure 54-12 on page 470.

Auto punch out delay
This automation preference is useful when you are controlling Performer Lite automation parameters from an external control surface, such as a control surface or a MIDI fader box of some kind. The Auto punch out delay is the amount of time (in milliseconds) after the last event is received from the external knob or fader and the instant when Performer Lite drops out of record (stops recording moves from the external device).

Control surfaces send data with different degrees of sensitivity. With some, you may find that punch out occurs too frequently; with others, you might find that punch-out takes too long. To avoid punch outs that stutter, raise the punch-out delay. To reduce punch-outs that take too long, lower it (but be careful not to lower it so much that it begins to stutter).

Minimum time between recorded points
This automation preference determines how frequently control points will be generated during real-time recording. Lower settings generate more control points that result in finer tracking of your moves. Higher settings produce fewer control points that result in courser tracking of your moves.

Minimum change between recorded points
This automation preference determines how frequently control points will be generated during real-time recording. Lower percentages generate more control points that result in finer tracking of your moves. Higher percentages produce fewer control points that result in courser tracking of your moves.

REMOVING AND RESTORING PLUG-INS
If you remove a plug-in from a track entirely, its automation data remains in the track, and it can still be edited. If you later restore the plug-in (on any insert), the automation data will once again automate the plug-in. Orphaned automation data is displayed in the Track Display menu with italic text, along with the word missing, as demonstrated earlier in Figure 54-16 on page 472.

VCA TRACK AUTOMATION
VCA tracks can be automated, just like audio tracks. Two types of automation data are supported: volume and track mute. Automation is handled in the same fashion as audio tracks. However, there are several unique ways that VCA automation interacts with VCA group tracks. See “VCA tracks and mix automation” on page 483.

AUTOMATION AND SYSTEM RESOURCES
Automation adds to overall CPU processing overhead. If your mix is taxing your computer, you can conserve CPU overhead by enabling automation only for data types and plug-in parameters that you need. For example, don’t enable automation for an effect parameter and then insert only one setting for the parameter in the track. Only enable automation for parameters that need to change over time.
CHAPTER 55  VCA Tracks

OVERVIEW
On large-format analog mixing consoles, a VCA (Voltage Controlled Amplifier) is a channel gain control used to adjust the volume faders of multiple tracks simultaneously. In Performer Lite, a VCA track does the same thing: after being assigned to a track group, it controls the relative volume of all the tracks in the group. It also controls the Solo, Mute and Record-enable status for all tracks in the group. In addition, VCA tracks can be automated, as explained later in this chapter. VCA tracks can be assigned to any track group, even groups that contain other VCA tracks.

Creating a VCA track
To create a VCA track, choose Project menu > Add Track > VCA Track. The new VCA track appears in the Track List, Sequence Editor, Mixing Board, etc. as usual. From it’s output menu, choose the desired track group that you wish to control with it.

As a shortcut, you can create both the VCA track and its track group together in one operation. First, in the Track List or Sequence Editor, select the tracks you wish to include in the group, and then Choose Project menu > Add Track > VCA Track And Group. A dialog appears for naming the group and choosing the placement for the VCA track. Click OK and a new VCA track is created, assigned to a new VCA track group consisting of the tracks selected.

VCA tracks and track groups
Creating a VCA track
VCA control
Shared tracks and nested VCA groups
VCA tracks and mix automation
Releasing a VCA track from its group
MIDI tracks and VCA tracks
Exporting to earlier versions of DP

VCA TRACKS AND TRACK GROUPS
VCA tracks depend on track groups, so be sure to familiarize yourself with this feature before using VCA tracks. See “Track Groups” on page 73.

CREATING A VCA TRACK
To create a VCA track, choose Project menu > Add Track > VCA Track. The new VCA track appears in the Track List, Sequence Editor, Mixing Board, etc. as usual. From it’s output menu, choose the desired track group that you wish to control with it.

As a shortcut, you can create both the VCA track and its track group together in one operation. First, in the Track List or Sequence Editor, select the tracks you wish to include in the group, and then Choose Project menu > Add Track > VCA Track And Group. A dialog appears for naming the group and choosing the placement for the VCA track. Click OK and a new VCA track is created, assigned to a new VCA track group consisting of the tracks selected.

Figure 55-1: VCA tracks in the Mixing Board, along with their assigned track groups.

VCA track settings
Each VCA track has the following universal track settings (“Track settings” on page 51):

- Name
- Track type icon
- Play/mute
- Level meter
- Record-enable
- Input monitoring
- Output (see below)
- Take
- Automation settings
- Lock
Color

The VCA track output menu
For VCA tracks, the output menu shows available track groups that the VCA track can be assigned to control. If two or more tracks are selected when you access the output menu, choosing Make New Group from the menu creates a new group consisting of the selected tracks, and the VCA track is assigned to the new group. If you wish to disconnect a VCA track from its currently assigned group, choose None from its output menu. See “Releasing a VCA track from its group” on page 484.

Assigning VCA tracks to non-VCA groups
You can assign a VCA track to any type of group, even non-VCA groups: Edit, Mix, Edit & Mix, or Custom. When doing so, the group converts to Custom with inherited settings from its previous group type, which you can further customize as desired. The Volume Fader setting becomes grayed out to indicate that the group is under VCA control. See “Custom group” on page 75.

VCA track level meter
The level meter in a VCA channel strip in the Mixing Board (Figure 55-1) shows the current peak level of all tracks in the VCA track group.

VCA CONTROL
VCA tracks control the following channel settings of the tracks in its assigned group.

Volume fader
Drag the VCA track’s volume fader to control all the track faders in its assigned group. The grouped faders scale their position relative to the VCA fader. To adjust their faders relative to the VCA, simply move their faders. Unlike mix groups, VCA controlled faders don’t affect other faders in the group. Also note that a fader can’t be raised above its +6 dB max level, as scaled by its VCA fader. If you try to do so, it will snap back down to its scaled +6 dB level. VCA faders can also be automated. See “VCA tracks and mix automation” below.

Mute/Solo/Record-enable/Input monitoring
VCA track channel strips in the Mixing Board display Mute, Solo, Record-enable and Input Monitoring enable switches above the fader (Figure 55-1). These switches toggle the corresponding setting for all tracks in the group.

SHARED TRACKS AND NESTED VCA GROUPS
Tracks can be freely shared among VCA-controlled groups, so a single track could be controlled by several different VCA tracks. Similarly, you can nest VCA tracks within VCA-controlled groups, allowing you to control VCA tracks with other VCA tracks. This gives you a great deal of flexibility when setting up control of your mixes. For example, you could create several VCA groups for multi-track drum mics:

- Kit
- Toms
- Overheads
- Room

Then you could combine the VCA tracks for these four groups into another VCA group called Drums.

You could then combine the VCA track for the Drums group with VCA tracks for Bass, and Guitar groups to create another VCA group called Rhythm Section, as shown in Figure 55-2.
VCA TRACKS AND MIX AUTOMATION

If a VCA group track contains volume automation, the group’s VCA track fader will affect that automation. In the VCA group track, the modified automation is represented by a green line, while the original automation appears as the usual black line (Figure 55-4). The green line represents what is actually played, based on the effect of the VCA fader.

VCA track automation

VCA tracks can be automated, just like audio tracks. Two types of automation data are supported: volume and track mute. Automation is handled in the same fashion as audio tracks. See chapter 54, “Mix Automation” (page 462).
**VCA volume automation**

VCA volume automation scales any volume automation in the VCA group tracks it controls. In the VCA group track, two automation curves are displayed: the original (black) and the scaled curve (green), which represents the effect of the VCA automation on the track automation. Therefore, you can always clearly see the effect that the VCA automation is having on the track automation, as shown in Figure 55-3. If multiple VCA tracks are controlling a VCA group track, their automation curves are combined in the group track to produce the resulting green line (what actually gets played).

**VCA track mute automation**

VCA track mute automation overrides any track mute automation in the grouped tracks controlled by the VCA track. Similar to volume automation, green lines in the group track indicate the effect of the VCA mute automation.

**Setting the colors for VCA volume and mute automation**

To customize the colors for VCA volume and mute automation, choose *View menu > Colors > Set VCA Volume Color* and *View menu > Colors > Set VCA Mute Color*. A standard macOS or Windows color picker appears, allow you to set the color.

To reset the colors, choose *Reset VCA Colors to Default* from the same sub-menu.

**RELEASING A VCA TRACK FROM ITS GROUP**

If you wish to disconnect a VCA track from its currently assigned group, choose *None* from its output menu. When you do so, you will see the alert shown in Figure 55-5.

As explained earlier, VCA tracks scale the volume fader and any volume automation of the tracks they control. If you want to retain that scaled result, even after the VCA is disconnected, click *Retain*. If you want the track to revert to its volume setting and/or original automation data, unaffected by the VCA, choose *Revert*.

**MIDI TRACKS AND VCA TRACKS**

MIDI tracks can be controlled by a VCA track in similar fashion to audio tracks. Automation data is displayed in green, as with audio tracks, in points, bars and lines mode, as shown in Figure 55-6. VCA mute events appear in the median strip.

![Figure 55-6: Similar to audio tracks, MIDI volume controllers scaled by VCA faders display their scaled value in green.](image)
EXPORTING TO EARLIER VERSIONS OF DP
If you use the Save As command to save your project as a Digital Performer Version 9 project (or earlier), which does not support VCA tracks, VCA tracks will disappear from the project. In addition, group tracks with automation data being scaled by a VCA track will retain the VCA scaling, similar to clicking the Retain button in Figure 55-5. This means that the track will sound the same, even after being exported to an earlier version.
Part 10

Processing
CHAPTER 56  Effects Window

OVERVIEW
The Effects window is a like a virtual effects rack for real-time, non-destructive MIDI and audio effects and virtual instruments. It displays all of the controls for a given effect on a given insert on a certain track. You can quickly and easily switch the effect, insert, and track you are viewing in the Effects window at any time.

The Effects window settings modify the track’s playback only. The original data in the track is not changed. As a result, effects settings can be adjusted or turned off (bypassed) at any time.

This chapter provides general information about the Effects window. For details on using audio effects, MIDI effects, and virtual instruments, see chapter 57, “Audio Effects Plug-ins” (page 493), chapter 58, “MIDI Effects Plug-ins” (page 503), and chapter 12, “Instrument Tracks” (page 67).

EFFECTS WINDOW QUICK REFERENCE
Below are the basic controls in the Effects window. The controls for each specific effect will, of course, vary.

Figure 56-1: The Effects window.
Window Target menu: This menu is used to change the sequence or V-Rack that the Effects window is showing. The name of the selected sequence or V-Rack is displayed.

Track menu: This menu is used to change the track that the Effects window is showing. The name and track type icon of the selected track is displayed.

Insert menu: This menu is used to change the insert that the Effects window is showing. The name of the selected insert is displayed.

When the Insert menu is open, all inserts for the track are shown, with each occupied insert also including the name of plug-in loaded in that insert.

Plug-in chooser/menu: The Plug-in chooser/menu is used to change the plug-in for the selected insert. The name of the selected plug-in is displayed.

Bypass: Temporarily disables the plug-in.

Automation menu: This menu is used to change the automation play-enable/record-enable state and automation mode for the track the effect is on.

Preset menu: This menu is used to save and recall presets. The name of the currently loaded preset is displayed. If you have made changes to the plug-in after loading a preset, the name becomes italicized to indicate that the preset’s settings have been altered.

Learn Controller: Lets you assign a knob, slider or button from an external MIDI controller to a parameter in the plug-in window for MIDI remote control (“MIDI Learn”). See “Attaching a MIDI controller to plug-in parameters” on page 500.


Effect-specific controls: Controls for the specific plug-in are displayed here. These will be different, depending on the selected plug-in.

Effects window mini-menu
The Effects window mini-menu contains the following commands:

Floating: When checked, this menu item causes the window to stay in front of all other windows.

Float Effects by Default: When checked, plug-in windows are set to float when they are first opened. This is the same setting as the global preference (“Plug-in windows float above other windows by default” on page 500).

V-Rack Edit: Use the V-Rack Edit command to toggle between the current sequence and the last viewed V-Rack. You can also use its default key binding, Command/Ctrl-Shift-V.
OPENING AND CLOSING THE EFFECTS WINDOW

Opening the Effects window
There are several ways to open the effects window:

- In the Mixing Board, choose an effect from any insert menu, or double-click an insert that already has an effect.
- For virtual instruments, double-click the track name in the Sequence Editor.

You can have many Effects windows open at once, if you’d like.

Choosing a new effect for an insert
To choose an effect for an insert, select the desired effect from the Mixing Board insert. (See “Choosing a plug-in for an insert” on page 161).

When creating a new effect, Performer Lite uses the most recent settings for that effect. For example, if you tweak quantize parameters on one track until they are just right, adding the quantize effect to another track will initially apply the same settings.

Floating effects windows
Effects windows can be made to “float” (stay in front of) other windows. This can be done on a per-window basis by checking the Floating mini-menu item of the Effects window itself. There is also a global preference to make all newly opened effects windows float. See “Plug-in windows float above other windows by default” on page 500.

Closing the Effects window
You can close the Effects window by:

- Clicking its close button
- With the standard ‘Close window’ key binding (Command/Ctrl-W)
- With the Window menu > Close command

Hold Shift and Option while closing an Effect window in any of those ways to close all open Effect windows.

BYPASSING AN EFFECT
An effect can be bypassed by clicking the Bypass button in the Effect window. As a shortcut, you can bypass an effect directly in the Mixing Board by Option/Alt-clicking the effect insert with the finger cursor.

SAVING, LOADING, AND EDITING PRESETS
Presets are found in the Preset menu in the Effects window when the desired effect is being displayed in the window. For example, when the Effects window is showing the Reverb plug-in, you’ll see Reverb presets in the Preset menu.

The current preset
When you choose a plug-in preset from the Preset menu, the preset name is displayed in the Preset menu, as shown in Figure 56-2. It also gets a check mark next to the name when the menu is open. If no preset has been loaded, “None” is displayed.

If you modify the settings, the name of the preset will become italic to let you know that you are now working with a modified preset. If you like, you can save the modified preset as a new preset with the Save Settings Preset menu command.

Figure 56-2: The current preset being used is displayed in the Preset menu. If you modify the settings of the effect, the preset name becomes italic to indicate that it is now modified.
Where presets are stored
Plug-in ‘factory’ presets are stored with the plug-in itself, so they are always available in any Performer Lite project.

User presets are stored in separate folders for each plug-in, with each preset saved as a separate file. See “Saving plug-in settings as a user preset” below.

Saving plug-in settings as a user preset
To save the current plug-in settings as a preset, choose Save Settings from the Preset menu and type in the desired name. You can save the settings anywhere you wish on disk, but if you would like them to appear in the User Presets sub-menu, save them in the plug-in’s presets folder. For example, presets for the Chorus plug-in would be stored here:

macOS /Library/Audio/Presets/Performer Lite/Chorus
Windows User\Documents\MAS Presets\MOTU\Chorus

If it is saved in this location, the new preset appears in the User Presets sub-menu.

Use the Show Presets in Finder/Explorer mini-menu command to go to the folder where user presets are stored for a plug-in. There, you can rename, duplicate, delete, etc. your preset files.

VST and Audio Unit presets
Some VST and Audio Unit plug-ins have the ability to save presets as a standard preset file on disk. Performer Lite supports these preset files. You can save them and load them in the same way as MAS plug-in presets, including the ability to drag and drop them to inserts in the Mixing Board.

Loading plug-in user presets
To load a user preset, choose it from the User Presets sub-menu in the Presets menu. User presets can be dragged and dropped from the Finder or Explorer directly to inserts in the Mixing Board.

Changing a preset
To change an existing preset:

1 Choose the preset.
2 Modify it as desired.
3 Choose Save Preset from the Presets.
4 Save it with the same name. An alert dialog will confirm that you wish to change the existing preset.

Accessing user presets in other projects
Because user presets are stored independently from Performer Lite documents or the Performer Lite application itself, they automatically appear in projects other than the one in which you created the preset. You can also drag and drop them from their folder into any project at any time.
**Next/Previous Preset**
You can quickly cycle through the available presets by:

- Click the Next Preset/Previous Preset buttons (Figure 56-1 on page 488)
- Choosing Next Preset/Previous Preset from the Preset menu
- Using the Next Preset/Previous Preset key commands (Shift-Control/Win-equal and Shift-Control/Win-minus)

**‘Compare’ Preset menu item**
The Compare Preset menu item lets you compare a modified preset with the original, unmodified preset. You can freely switch back and forth between them to make a thorough A/B comparison.

When you first call up a preset from the Effects window Presets menu (either a factory preset or a user preset you created), the Compare menu item is grayed to indicate that the preset is currently unmodified.

As soon as you modify a plug-in parameter, the Compare menu item becomes ungrayed, indicating that the preset has been modified.

If you now choose Compare, it becomes checked, and the original preset settings are restored. In addition, your modified settings are stored by the Compare feature, ready for recall.

If you choose the Compare menu item again, it becomes unchecked, and your modified preset is restored. You can then freely switch back and forth between the original preset (checked) and the modified preset (unchecked).

Here is a summary of the compare feature:

<table>
<thead>
<tr>
<th>Compare mini-menu item</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grayed</td>
<td>Unmodified preset (or no preset)</td>
</tr>
<tr>
<td>Active (not grayed)</td>
<td>Modified preset is active.</td>
</tr>
<tr>
<td>Checked</td>
<td>Original preset is active.</td>
</tr>
</tbody>
</table>

**EDITING EFFECTS**
The controls provided for the effect itself depend on the plug-in. Refer to the documentation included with the plug-in for information on how to edit the plug-in. For information on automation plug-ins, see chapter 54, “Mix Automation” (page 462).
CHAPTER 57  Audio Effects Plug-ins

OVERVIEW
An audio effects plug-in is a piece of peripheral software (developed by MOTU or another company) that can be used from within Performer Lite. Performer Lite serves as a host program for the plug-in, allowing you to apply its processing to your audio. Depending on the type of plug-in, you can either use the plug-in as an offline operation, selecting individual soundbites and then choosing the plug-in from the Audio menu, or you can apply it to an entire track as a real-time insert for the track in the Mixing Board.

Native plug-in processing ........................................... 493
Real-time versus rendered effects ................................. 494
File-based plug-in processing ................................. 494
Working with MAS plug-ins ........................................ 495
Working with VST and Audio Unit plug-ins .......... 496
Organizing plug-ins .................................................. 497
Audio plug-in preferences ........................................ 497
Using effect presets ............................................. 500
Busing, master faders & aux tracks ..................... 500
Copying and pasting effect settings ...................... 500
Plug-ins from other companies ............................. 500
Plug-in automation ............................................... 500
Taking an automation snapshot of plug-in parameters 500
Attaching a MIDI controller to plug-in parameters .... 500
Tempo-locked effects ........................................... 501
Channel configurations ......................................... 501
Side chain inputs ................................................ 501
Multiple audio outputs ....................................... 501
Making a real-time plug-in effect permanent ........ 501
Performer Lite plug-ins ........................................ 502
Performer Lite virtual instruments ..................... 502

NATIVE PLUG-IN PROCESSING
Almost all MOTU Audio System plug-in effects can be processed dynamically during playback. They do not require extra hardware installed inside your computer because their processing is handled by the computer itself (referred to as native processing). Performer Lite includes dozens of MOTU Audio System plug-ins, from basics (such as 8-band parametric EQ, reverb, and dynamics) to vintage gear emulations to exotic forms of processing that are unique to Performer Lite. Performer Lite also includes virtual instruments. See “Performer Lite plug-ins” on page 502 for a list, and consult the separate Performer Lite plug-ins guide PDF in the Help menu for complete information about each plug-in.

Many third-party plug-ins are also available.

The amount of effects processing you can apply at one time has no inherent limit in Performer Lite. Instead, it depends on how fast your computer is: the faster the computer, the more real time effects you can use simultaneously.

Using effects plug-ins
Applying audio effects plug-ins to your audio tracks is straightforward: just choose the desired plug-in from one of the inserts for the track in the Mixing Board as shown in Figure 57-1 on page 494. Once you choose the effect (either from the plug-in chooser window or the menu provided), the Effects window appears with the settings for the plug-in. If the Effects window is already open, you can choose the effect from the menu provided at the top of the window.
All of the features in the Effects window apply to audio effects, including using the Bypass button to temporarily remove the effect. See chapter 56, “Effects Window” (page 488) for details about the Effects window.

**Automatic latency (delay) compensation**
Performer Lite provides automatic latency compensation for all real-time audio plug-ins and virtual instruments. For details, see “Automatic plug-in latency (delay) compensation” on page 24.

**REAL-TIME VERSUS RENDERED EFFECTS**
By default, Performer Lite transparently pre-renders audio output from virtual instrument tracks and audio tracks with plug-ins instantiated on them to dramatically reduce their CPU load. This is called pre-generation, and it greatly enhances Performer Lite’s CPU performance, allowing you to instantiate many times the number of instruments and plug-ins that you would be able to run in real time.

Performers Lite seamlessly manages transitions between pre-generated audio and live audio as needed (such as when you record a virtual instrument live). In addition, virtual instruments are always available for preview activities, such as editing notes in the Sequence Editor or using a VI’s on-screen keyboard.

To fine-tune the responsiveness of plug-ins and virtual instruments, go to Setup menu > Configure Audio System > Configure Studio Settings and adjust the **Prime Milliseconds** setting (see “Prime Milliseconds” on page 23).

**Pre-gen operation with 3rd-party plug-ins**
MOTU works hard to ensure a high level of compatibility with 3rd-party virtual instruments and effects. There may be cases where pre-generation may not work as expected with 3rd-party plug-in. These cases should be reported to MOTU and the plug-in vendor so that compatibility can be fully established. In the meantime, you can run the plug-in or instrument in real time. To force a virtual instrument track into real-time operation, record-enable any MIDI track that targets the instrument. To force an audio track’s effects into real time, the track can either be record-enabled or monitor-enabled. Alternately, the effect can be placed on an aux track, either in a sequence or a V-rack, with bussing used to access the effect. Aux track effects are always rendered in real-time.

**FILE-BASED PLUG-IN PROCESSING**
File-based processing does not occur in real time. Instead, it is applied similarly to Performer Lite’s time-stretching features: you select soundbites to be processed (using one of Performer Lite’s many methods for selecting soundbites), and then you apply the plug-in by choosing it from the Audio menu. A window appears for the plug-in, you make settings, preview the settings (if previewing is available), and then click OK. When you do, a new audio file is created on your hard drive that...
consists of the original soundbites with the effect applied to them (plus any bite gain, if any has been applied to the original soundbite). Processing occurs in the background. All MAS plug-ins can be applied as file-based processing.

**Reverse**
There is one plug-in that is provided as a file-based plug-in only (in the Audio menu only): Reverse.

**Previewing a file-based plug-in**
When applying audio plug-ins from the Audio menu > Apply Plug-in sub-menu, you can preview the effect before applying it permanently:

![Previewing a file-based plug-in](image)

When you click the Preview button, the currently selected region loops continuously until you click the Stop button (or click anywhere outside the effect window). Parameter adjustments can be heard in real time as you change them. A preroll and postroll amount can be added to the beginning and end of the currently selected region for previewing purposes.

These previewing features can also be used for VSTs and Audio Units being applied as region operations.

**WORKING WITH MAS PLUG-INS**
Performer Lite can host MOTU Audio System (MAS) plug-ins. The MAS specification is a plug-in standard developed by MOTU that has been adopted by audio plug-in developers to optimize their products for use with Performer Lite. You can install MAS plug-ins on your computer and use them from within Performer Lite. The plug-in may also be supplied and installed in other plug-in formats as well for use with other host applications.

**Installing MAS plug-ins**
Performer Lite looks for MAS plug-ins in these locations on your computer’s hard drive:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>macOS</td>
<td>/Library/Audio/Plug-ins/MAS</td>
</tr>
<tr>
<td></td>
<td>/Library/Audio/Plug-ins/MAS</td>
</tr>
<tr>
<td>Windows*</td>
<td>C:\Program Files\Common Files\MOTU\Plug-ins\MAS</td>
</tr>
</tbody>
</table>

*If you are running the 32-bit version of Performer Lite on a 64-bit Windows system, the root of the path is: C:\Program Files (x86).

**MAS plug-ins in MacOS**
For MacOS, the user library directory refers to the user who is currently logged in to Mac OS X.

Depending on how they were installed, plug-ins for Performer Lite are placed in one of the two locations shown above. If plug-ins are installed into the user library directory, they are installed for the user who is currently logged in to Mac OS X at the time of installation.

**Organizing MAS plug-ins in MacOS**
You can organize the plug-ins across the system and user library directory locations as you prefer, with the following rules in mind:

- Plug-ins are bound to log-in access. For example, plug-ins that are placed in a user directory are available only when that user is
logged in. This allows you to maintain different sets of Performer Lite plug-ins in multi-user environments.

- Never duplicate a plug-in across the system and user directories (although you could duplicate a plug-in across multiple user directories, since only one user directory is active at a time).
- You can organize plug-ins into folders, as explained in the next section.

WORKING WITH VST AND AUDIO UNIT PLUG-INS
Performer Lite can host VST plug-ins (VST2 or VST3) on both Mac and Windows, and Audio Unit (AU) plug-ins on MacOS. The VST and AU specifications are a plug-in standards that are widely adopted by music and audio software developers. You can install VSTs and AUs on your computer, and use them from within Performer Lite or other host applications that support them.

Installing VSTs and AUs
Performer Lite looks for VST and AU plug-ins in these locations on your computer’s hard drive:

<table>
<thead>
<tr>
<th>Platform</th>
<th>Format</th>
<th>Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>MacOS</td>
<td>AU</td>
<td>Startup disk/Users/Current user/Library/Audio/Plug-ins/Components</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Startup disk/Library/Audio/Plug-ins/Components</td>
</tr>
<tr>
<td>MacOS</td>
<td>VST2</td>
<td>Startup disk/Users/Current user/Library/Audio/Plug-ins/VST</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and Startup disk/Library/Audio/Plug-ins/VST</td>
</tr>
<tr>
<td>MacOS</td>
<td>VST3</td>
<td>C:\Program files\Vstplug-ins\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and C:\Program files\Steinberg\VstPlugins\</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and C:\Program files\Common Files\VST2 or C:\Program files\Common Files\VST3</td>
</tr>
</tbody>
</table>

*If you are running the 32-bit version of Performer Lite on a 64-bit Windows system, the root of the path is: C:\Program Files (x86).

For MacOS, the user library directory refers to the user who is currently logged in to Mac OS X. If AU plug-ins are installed into the user library directory, they are installed for the user who is currently logged in to Mac OS X at the time of installation.

Third-party plug-in compatibility
Audio plug-in specifications continue to evolve, and developers are modifying and improving their plug-ins on an on-going basis to conform to each specification as it develops. MOTU has worked closely with many developers to ensure compatibility and smooth performance. Always try to stay current with the latest versions of the plug-ins you use.

Plug-in examination
When you run Performer Lite for the first time, or after installing one or more new plug-ins, Performer Lite examines them during the loading process, checking them for problems. On MacOS, Performer Lite will first ask you to choose a primary external plug-in format (VST2, VST3 or AU) to examine and use as your preferred format (see “Primary external plug-in format (Mac only)” on page 499). This process may take a few minutes, depending on the nature and quantity of the plug-ins installed in your system. Each plug-in is examined only once, the first time it is loaded by Performer Lite. On subsequent launches, plug-ins that have already been examined will not be examined again. If a problem is detected with a particular plug-in, it will not be loaded for use in Performer Lite to prevent crashing and other serious problems.

You can choose to skip the examination of a particular plug-in, in which case it is not loaded and will not be available for use in that particular
session. Skipped plug-ins can be examined later, the next time you launch Performer Lite or in the Plug-in Manager (see below).

If you wish to completely remove a plug-in so that it will not be examined or loaded, simply remove it from the folder where it is installed.

If a problem is detected with a particular plug-in, it will not be loaded for use in Performer Lite to prevent crashing and other serious problems. In the event that problems are found, the plug-in will be disabled and will not be loaded by Performer Lite. Contact the developer for information about updates for the plug-in.

For more information on managing third-party plug-ins, see “Audio plug-in preferences” below.

**Using VSTs and AUs**
Performer Lite supports two basic varieties of VSTs and AUs: effects plug-ins and virtual instruments. The effects plug-ins operate as described in this chapter. Just choose them from the desired effect insert and you are ready to go.

AU virtual instruments work as described in chapter 12, “Instrument Tracks” (page 67).

For details about using plug-in presets, see “VST and Audio Unit presets” on page 491.

**ORGANIZING PLUG-INS**
Performer Lite’s plug-in chooser provides flexible and convenient plug-in organization and browsing. For details, see “Choosing a plug-in for an insert” on page 161.

**AUDIO PLUG-IN PREFERENCES**
To access Performer Lite’s audio plug-in preferences (Figure 57-3), go to Preferences in the Performer Lite menu (Mac OS) or Edit menu (Windows) and click Audio Plug-ins in the list.

These settings allow you inspect, enable, disable and otherwise manage the audio plug-ins installed in your system.

When you change any settings in the audio plug-in preferences pane (except for the Ramp event density setting, see below), the MOTU Audio System must restart to apply your changes. You will be prompted to do so when closing the Preferences window, or when switching to another preference pane.

The plug-in preferences only apply to operation under the MOTU Audio System; when Performer Lite is operating under MIDI Only mode, the plug-ins list display will be empty.
Plug-ins list
All MAS, VST and Audio Unit plug-ins installed in your system and available to Performer Lite will be listed in this preference pane, with the plug-in format shown to the right of each plug-in. Use the search field to quickly locate a particular plug-in.

Each plug-in has a checkbox next to it. When the box is checked, the plug-in is enabled; when unchecked, the plug-in is disabled. Disabled plug-ins will not be loaded and will not appear in your audio plug-in lists in the Mixing Board or Audio menu > Apply Plug-in sub-menu (or in the case of instrument plug-ins, under the Project menu > Add Track > Instrument Track sub-menu).

You can also enable or disable multiple plug-ins simultaneously by selecting them and using the Enable and Disable buttons. Shift-click in the plug-in list to select a range of plug-ins, or Command/Ctrl-click to select non-contiguous plug-ins.

Examining VSTs and Audio Units
As explained earlier in “Plug-in examination” on page 496, VSTs and Audio Units will be automatically examined the first time Performer Lite is launched after they are installed. The result of the examination is listed next to each plug-in. The possible results are:

- **Passed**: The plug-in passed examination and is available for use.
- **Failed**: The plug-in did not pass examination and will not be loaded.
- **Skipped**: Examination of the plug-in was skipped and will be automatically reexamined the next time the MOTU Audio System is restarted.
- **Duplicate**: Multiple versions of the plug-in exist; for example, both a VST and MAS version exist. The MAS version is loaded.
- **Non-primary**: Indicates that the plug-in is not the primary format chosen in the preferences (Figure 57-3). See “Primary external plug-in format (Mac only)” on page 499.

If you wish to reexamine a plug-in or plug-ins, select the desired plug-ins and press the Reexamine button.

Plug-ins with multiple versions (formats)
Some plug-ins are supplied (and installed into your system) in several plug-in formats. For example, you might see both a VST and AU (or MAS) version of the same plug-in in the list. By default, one of the formats is enabled and the other is disabled and labeled either Duplicate or Non-primary. You can manually switch formats by unchecking and checking the boxes next to each plug-in as needed.

Perform Lite allows both AU and VST versions of the same plug-in to be activated at the same time. While this may be useful in some circumstances, it may make it hard to tell which format you are using. In the case of some plug-ins, activating both formats can cause problems with their operation. To avoid confusion or operational issues, only enable one format or the other.

Plug-in sets
Plug-in sets (Figure 57-4) are custom collections of enabled audio plug-ins. Loading a plug-in set will enable only a specific subset of your plug-ins.

To choose a plug-in set, select it from the plug-in set menu. The chosen plug-in set will be displayed, but its plug-ins will not be loaded until you restart the MOTU Audio System.
Enable All
When you choose the Enable All plug-in set (Figure 57-4), all plug-ins (except ones that did not pass examination) are enabled. This is the default plug-in set.

Disable All
When you choose the Disable All plug-in set (Figure 57-4), all plug-ins will be disabled.

Safe
When you choose the Safe plug-in set (Figure 57-4), only the plug-ins which are included with Performer Lite are enabled; all other plug-ins will be disabled.

Creating and deleting plug-in sets
To create a new plug-in set, click the New button, enter a name, and click OK. To delete a plug-in set, choose it from the plug-in set menu and click the Delete button. When Enable All, Disable All or Safe is chosen, the Delete button will be grayed out as these plug-in sets cannot be deleted.

Editing plug-in sets
To edit a plug-in set, choose it from the plug-in set menu, then enable or disable the desired plug-ins.

The Enable All, Disable All or Safe plug-in sets cannot be modified. If you attempt to enable or disable any plug-ins while one of them is selected, you will be prompted to create a new set. You can then edit the new plug-in set just as you would any other.

Ramp event density
The Ramp event density option (Figure 57-3) sets the default density when writing ramp automation for plug-ins.

Primary external plug-in format (Mac only)
The Primary external plug-in format option is for MacOS only and determines the format of the plug-ins that Performer Lite will examine and enable by default. Choose Audio Units if you have a large number of existing Performer Lite projects that use AUs, and you don’t need to transfer Performer Lite projects to and from Windows systems. Choose VST2 or VST3 to increase the cross-platform compatibility of your projects. This setting can be changed at any time.

Selecting a plug-in set at startup
Hold the Option/Alt key while launching Performer Lite to bring up a dialog which allows you to choose the plug-in set which will be loaded:
Plug-in windows float above other windows by default
When checked, the **Plug-in windows float above other windows by default** preference causes newly opened plug-in windows to appear in front of all other windows. This allows you to work in other Performer Lite windows without plug-in windows disappearing behind them. This preference only affects new plug-in windows when they are first opened. Once a plug-in window is open, it can float or not, as determined by its **Floating** mini-menu setting (see “Effects window mini-menu” on page 489).

**USING EFFECT PRESETS**
Many audio effect plug-ins provide factory presets, and you can also save and recall your own presets. This works in the same way as it does with MIDI effects and virtual instruments. See “Saving, loading, and editing presets” on page 490.

**BUSING, MASTER FADERS & AUX TRACKS**
The MOTU Audio System provides a flexible virtual mixing environment. You can take advantage of features like the internal audio buses to apply effects as needed and even conserve your computer’s processing power by busing multiple tracks to the same effect insert. You can also apply effects to aux tracks and master faders as pre or post fader effects. For details, see chapter 19, “Mixing Board” (page 156) for more ideas about how to work with real time audio effects within Performer Lite’s virtual mixing environment.

**COPYING AND PASTING EFFECT SETTINGS**
As with MIDI effects, you can copy and paste audio effect parameters from one insert to another. Just choose **Copy** from the Edit menu while a specific insert’s effect is being displayed, switch to a different insert with another effect, and choose **Paste**. Even if the destination plug-in is completely different, any parameters of the same kind are pasted.

**PLUG-INS FROM OTHER COMPANIES**
The three plug-in architectures (MAS, VST and AU) are open systems. Many other companies have developed plug-ins that are compatible with these plug-in formats, running in real time on your computer with no extra hardware required.

**PLUG-IN AUTOMATION**
Plug-ins can be automated in real time. For complete information, see chapter 54, “Mix Automation” (page 462).

![Figure 57-5: Click the Auto (automation) button to access the automation settings menu for this track. The menu has checkable items that enable/disable automation playback and recording. It also lets you choose the current automation mode for the track.](image)

**ATTACHING A MIDI CONTROLLER TO PLUG-IN PARAMETERS**
The **Learn Controller** command (Project menu> Consoles) allows you to map controls on your MIDI controller to plug-in parameters.

> **Learn Controller** can also be used to map your MIDI controller to Mixing Board sends and send pan, as explained in “Attaching a MIDI controller to sends or send pan” on page 175.
To attach a MIDI controller:

1. Choose Project menu > Consoles > Learn Controller, or click the Learn Controller icon at the bottom of the plug-in window (Figure 56-1 on page 488).

2. Click the desired plug-in parameter.

3. Move, turn or press the desired control on your MIDI device. To cancel the operation before completing it, choose Learn Controller (or click the icon) again at any time during the process.

**TEMPO-LOCKED EFFECTS**

Many plug-ins allow you to lock certain parameters, like their LFOs, to the tempo of your sequence. This allows the effect to stay in sync with the beat of your music, even if there are tempo changes.

For details on tempo-locking effects included with Performer Lite, see “Tempo lock” on page 8 in the DP Plug-in Guide. For details on tempo-locking third-party effects, refer to their documentation.

**CHANNEL CONFIGURATIONS**

Performer Lite allows you to configure your system with a combination of mono and stereo signal paths. For more details, see “Channel configurations” on page 7 in the DP Plug-in Guide.

**SIDE CHAIN INPUTS**

A side chain input allows you to route any audio directly into the plug-in itself to control a parameter with the side chain input signal. It appears in a plug-in window as a menu that shows a list of Performer Lite’s virtual busses. For many MAS plug-ins, the menu appears within the plug-in itself:

For some plug-ins, the side chain input menu appears in the Effects window:

To use the side chain input, choose an audio input or bus from the menu and then route a signal to the bus from any source you want in Performer Lite’s mixing environment (a track, a live aux input, etc.). Several included plug-ins have side chain inputs, including Dynamics, Ring Modulator, and Multimode Filter. Refer to chapter 1, “Audio Effects Plug-ins” (page 7) in the DP Plug-ins Guide.

**MULTIPLE AUDIO OUTPUTS**

Some effects plug-ins provide multiple audio outputs. You can access them in the Instruments tab in the Bundles window, just as with virtual instruments. For details, see “Multiple audio outputs” on page 69.

**MAKING A REAL-TIME PLUG-IN EFFECT PERMANENT**

All real-time plug-ins that appear in the Mixing Board window effects inserts also appear in the Audio menu > Plug-ins sub-menu. To apply them, you can select audio in any window you prefer.
PERFORMER LITE PLUG-INS
For details on the following plug-ins included with Performer Lite, see chapter 1, “Audio Effects Plug-ins” (page 7) in the DP Plug-ins Guide (Help menu).

- ACE-30
- Analog Chorus
- Analog Delay
- Analog Phaser
- Custom ’59
- Delay
- Delta Fuzz
- Diamond Drive
- Hardware Insert
- Intelligent Noise Gate
- Invert Phase
- Live Room B
- Live Room G
- Live Stage
- MasterWorks Compressor
- MasterWorks EQ
- MasterWorks Gate
- MasterWorks Limiter
- Pattern Gate
- ProVerb
- RXT
- Soloist
- Trim
- Tuner

PERFORMER LITE VIRTUAL INSTRUMENTS
For details on the following virtual instrument plug-ins included with Performer Lite, see chapter 2, “Instrument Plug-ins” (page 55) in the DP Plug-ins Guide (Help menu).

- Bassline
- PolySynth
- Nanosampler
- Modulo
- Model 12
- Proton
CHAPTER 58  MIDI Effects Plug-ins

OVERVIEW
Performer Lite provides many real-time, non-destructive MIDI effects plug-ins. This chapter discusses the specifics of each MIDI plug-in.

For general information about the Effects window, see chapter 56, “Effects Window” (page 488). For general information about using plug-ins, organizing them, creating and managing user presets, and other related topics, see chapter 57, “Audio Effects Plug-ins” (page 493).

Overview .......................................................... 503
Change duration .............................................. 503
Change velocity ................................................ 503
DeFlam ........................................................... 504
Echo and Arpeggiator ................................. 504
Groove Quantize ........................................... 508
Humanize ....................................................... 508
Invert Pitch ..................................................... 509
Quantize .......................................................... 509
Reassign Continuous Data ......................... 510
Remove Duplicates ........................................ 510
Time Shift ....................................................... 510
Transpose .......................................................... 510

CHANGE DURATION
The Change Duration plug-in can non-destructively modify the durations of MIDI notes during playback. It has the same settings as the Change Duration command in the Region menu (page 371).

Change Duration modifies the duration without changing the placement of attack times. This means that the amount of time a note is “on” or sounding can be changed without affecting its actual rhythmic placement in relation to other notes and events. The Change Duration command is useful for changing the articulation or space between notes. You can make note events sound connected or separate in relation to each other, for example. It also provides some useful utility functions.

For more information, see “Change Duration” on page 371.

CHANGE VELOCITY
The Change Velocity plug-in can non-destructively modify the on and/or off velocities of MIDI notes during playback. It has the same settings as the Change Velocity command in the Region menu (page 367).

For the Compress/Expand option, the graph shows the result of the compression/expansion settings. A diagonal line from lower left to upper right represents no compression or expansion. Drag the Threshold, Ratio and Gain handles to change their settings. The higher the ratio, the higher compression; ratios below 1 produce expansion. Gain allows you to raise or lower the overall level. Threshold sets a cutoff value, below which no compression or expansion will occur.
DEFLAM
The DeFlam MIDI effects plug-in is a non-destructive version of the DeFlam region operation found under the Region menu (page 367).

DeFlam looks for groups of note that are very close together. When such a group is found, the average attack time of the group of notes is computed. All notes in the group are moved such that their attack times are aligned exactly to the average time.

The group of notes that is deflammed is determined by the tick value you specify. This creates a “window” of effectiveness. Groups of notes within that window will be deflammed.

For more information, see “DeFlam” on page 367.

ECHO AND ARPEGGIATOR
The Echo effect is similar to a traditional digital delay. It remembers material played in, then repeats it later on. There are some interesting differences, though. You are not restricted to simple fixed delays. In fact the “rhythmic pattern” used by the Echo for regenerating the material is completely customizable. Additionally, each repetition of the material can be sent to a different output assignment. Furthermore, a transpose effect is hooked into the Echo’s feedback loop, allowing you to transpose on each repetition.

The Arpeggiator watches what notes are sounding (being held) and then arpeggiates them (plays them one at a time). The Arpeggiator gives you complete control over the rhythm and order in which the notes are played back. In addition, each arpeggiated note can be sent to a different output assignment.

Rhythmic patterns
Both the Echo and Arpeggiator effects are built around a flexible rhythmic architecture. In the Echo effect the Rhythm section determines how each event will be delayed. In the Arpeggiator it determines the rhythm that will be used for each arpeggiated note. Rhythms can be set up using one of three modes: Grid, Custom and Raw Ticks.

Grid: You will notice that the Grid mode settings are almost identical to the Quantize effects grid settings. They function in a similar fashion. You can set up rhythms consisting of any metric subdivision. You can “swing” the grid, and you can offset the entire grid by an arbitrary number of ticks. (For more info, see the section on the Quantize effect.) Rather than a check box for “Tuplets”, there is a popup menu. This menu lets you turn off the tuplet feature, turn it on (select Tuplet) or put the grid into “poly rhythm” mode (select Poly). The “Off” and “Tuplet” settings are identical in effect to checking or un-checking the Tuplet box in the Quantize effect. The Poly mode combines both sides of the tuplet expression (you will notice that the words “in the time of” change to “against”) to create a standard rhythmic interference pattern. For example if you pick Poly and choose 3 against 2 (eighth notes) you will hear both a straight eighth note pulse and a “3 in the
time of 2" pulse. Try different values to create interesting textures (5 against 3 is an interesting one).

**Custom:** This setting lets you define your own rhythmic patterns based on selected notes. You can make “Groove Echos”, arpeggiation based on melodic patterns, bizarre multi-tap echo effects — the sky’s the limit. To create a rhythmic pattern, just select some notes in a single track, enter a name, and press Learn.

When a pattern is learned, it is the time between note events that is remembered. Thus, if you select 4 notes, only 3 grid spaces will be learned (the distance from note 1 to note 2, 2 to 3 and 3 to 4). With this in mind, you may need to add an extra note at the end of your selection to delineate the final grid span.

![Rhythmic patterns created in the Echo effect can also be used with the Arpeggiator effect. Rhythms can be loaded into Performer Lite from other files.](image)

**Raw Ticks:** Simply lets you specify the echo or arpeggiation in raw ticks. This is handy for creating rhythms that are “off” from the main pulse of the music.

### Echo Settings

Here is a brief explanation of each setting for the Echo effect:

**Num Repeats:** Sets how many times each event will be repeated. The number includes the first time you hear the note. (If you enter 4, and play a note, you will here that note a total of 4 times.)

**Decay:** An amount that will be subtracted from the velocities of note events each time they are regenerated. This lets you create echos that sound like they are fading out. You should coordinate this setting with Num Repeats so that the note stops repeating around the same time it finally fades out, otherwise you will be echoing almost silent notes.

**Cycle through device group assignments:** If you check this box and assign the track’s output to a MIDI device group, each repetition of each event will be sent to a different assignment in the MIDI device group. For example, let’s say that you have a track assigned to a MIDI device group with two devices in it (SC7 channel 1 and SC7 channel 2) and you have “Num Repeats” set to 4. When you play a note, the first repeat will go to SC7 channel 1, the second will go to SC7 channel 2, the third
will go to SC7 channel 1, and the fourth will go to SC7 channel 2. There are many ways to use this feature. Here are a few examples.

Create true echos including controller data. Normally, controllers and pitch bend are not echoed. This is because overlapping streams of controller data almost always lead to unpleasant results. “Cycle through device group assignments”, however, lets you send each instance of the echo to a different MIDI channel, circumventing this problem. To use the echo in this way, set up a MIDI device group containing the same number of assignments (on the same device) as number of repeats. (For example, if you wanted a 4-repeat echo, you could make a MIDI device group on your SC7 on channels 1, 2, 3 and 4.) Each assignment should have the same patch set as its default. (You can create panning echo effects by setting the pan differently on each channel in the group. To do this, add a track assigned to each channel in the group (SC7 1, SC7 2, etc.), open the Mixing Board, show only those tracks, set the pan knobs appropriately, rewind to measure 1 and take a snapshot.) In this way, each echo goes to a different channel, and none of the controller information collides with previous data.

Create weird rhythmic and “cannon” effects by setting things up the same way as above, but then give each device in the group a different patch. You can have a sax echo your piano line or a murky voice echo your synth lead. Adding percussion assignments creates interesting rhythmic accents to your echos. Experiment!

Feedback Transpose: Each time the echo processor regenerates a note event, it passes it through the Feedback Transpose effect. (If the Transpose Effect is set to “unity transpose”, i.e. C3 to C3, it has no affect.) You can use this to create all sorts of cascading note effects. Since the Transpose effect can use arbitrary Custom Maps, any sort of transpose is possible. For example, you could have your echos cascade up, while remaining in key. Or have each repetition of the echo jump to any arbitrary pitch. (Twisted!) Watch out for the Harmonize option, though. It can really chew through your polyphony in a hurry; it is best used only with short delays. See “Transpose” on page 510 for more info.

Arpeggiator Settings
Here is a brief explanation of each setting for the Arpeggiator:

- **Duration**: This sets the length of each arpeggiated note as a percentage of time until the next note. 100% makes each note last until the next note begins. 1% makes each note very short. Try using sustain pedal for legato effects.

- **Range**: This lets you arpeggiate across a specified number of extra octaves. You can choose Normal (no additional octaves) or +1, +2, or +3 octaves.

- **Cycle through device group assignments**: This is similar to the Echo effect setting, but it has no affect over controllers. The Arpeggiator always sends all controllers to all output assignments in the MIDI device group. When this option is
checked, each arpeggiated note will be sent to a different output assign. You can create all sorts of interesting effects with this. The tricks with panning mentioned in the Echo section also apply here. Try a MIDI device group with several slightly different guitar patches for a “League of Crafty Guitarists” in a box. Try a group consisting of several different horn patches, or percussion instruments. Great fun.

**Melodic Pattern:** This setting determines the order in which the held notes are played back. There are several built-in patterns. You can also define your own custom patterns.

**Built-in patterns:** In each of the following examples, assume a 6 note chord, with each note numbered 1 to 6, 1 being the lowest and 6 being the highest.

**Up:** plays the notes in order, starting with the lowest, and moving to the highest. Note order: 1,2,3,4,5,6.

**Down:** Plays the notes in order, starting with the highest and moving to the lowest. Note order: 6,5,4,3,2,1.

**Up - Down:** First plays Up, then plays Down: Note order 1,2,3,4,5,6,5,4,3,2,1

**Down - Up:** First plays Down, then plays Up: Note order 6,5,4,3,2,1,1,2,3,4,5,6

**Staircase Up:** Walks up the notes in a zig-zag pattern: Note order 1,3,2,4,5,4,6

**Staircase Down:** Walks down the notes in a zig-zag pattern: Note order 6,4,5,3,4,2,3,1.

**Staircase Up - Down, Staircase Down - Up:** Same idea as Up - Down and Down - Up.

**Spiral In:** Starting at the outside edges alternately walks into the center. Note order 1,6,2,5,3,4.

**Spiral Out:** Starting in the middle, alternately walks to the edges. Note order 4,3,5,2,6,1.

**Spiral In and Out, Spiral Out and In** You get the idea.

**Random:** Randomly picks the note order.

**As Played:** This option takes into account the order in which you play the notes of a chord and plays them back in the same order as played. The pattern is repeated for each additional octave (if any) specified by the Range option.

**Chord Play:** This option plays notes as repeated chords instead of arpeggios.

**Custom Melodic Patterns:** When custom is selected, the window expands to show controls similar to those for creating and picking Custom Rhythmic Patterns. To create a Custom Melodic Pattern, select some notes in a single track, enter a name, and press “Learn”. The Arpeggiator analyzes the selected note data and remembers the order that the pitches are in. This order is then applied to the notes that you hold down. Note that the built in patterns work well no matter how many notes you are holding down. This is not as true of Custom Melodic Patterns. Custom patterns work best if you play the same number of notes as were in the learned pattern. (Note: There currently is no way to edit or retrieve the patterns after-the-fact, so you should save your source notes somewhere so you can tweak and relearn later on.) You can use Custom Melodic Patterns to mimic all sorts of finger picking, and even strumming styles.

**Repeat bottom/top note:** These check boxes only apply to the following melodic patterns:
- Up-Down, Down-Up, Staircase Up-Down,
- Staircase Down-Up, Spiral In and Out, and Spiral Out and In.
Therefore, these new check boxes are grayed out unless one of these patterns is chosen in the Melodic Pattern menu.
Double strike notes at ___% velocity: This option causes each note to be played twice. The on-velocity of the second note can be specified from 0-200% of the first note’s velocity.

Hold Notes: This option causes notes to be held even after you release them. They remain held (and will continue to arpeggiate) until you release all notes and play a new note.

Applying the echo and arpeggiator effects as Region menu commands
Both the Echo and Arpeggiator effects are available as MIDI effects plug-ins in the Region menu, which allows you to render the effect permanently to a track. This is great for editing the effect further. For details, see “MIDI Effects Plug-ins” on page 377.

Fun things to do with the Echo and Arpeggiator effects
Add a Transpose effect before the Arp effect. (Apply Transpose in Insert A and Arpeggiator in Insert B). Set the Transpose effect to Harmonize and transpose an octave up or down. This doubles the notes sent to the Arp effect, and gives it more notes to play with.

Learn bits of your song, both as melodic patterns, and as rhythmic patterns. Mix and match for Arpeggiator and Echo effects that compliment the rhythm and melodies of your music.

Use the Arpeggiator with a drum kit. Set the rhythm to a Poly 3 against 2. Hold down a big clump of drum note. Try using different melodic patterns. (Random works great.)

Echo your Arpeggiator. Add an Echo effect after the Arpeggiator, and set it for a long delay. Set the Arpeggiator to play with a grid that has an interesting rhythmic relationship to the echo. For example, set the Arpeggiator to a straight eighth note grid an the Echo to Tuplets, 3 in the time of 2 [quarter note]. Now, set the Echo effect to 2 repeats, and transpose up an octave (C3 to C4) with the Feedback Transpose section.

The Arpeggiator effect uses the velocities of the notes that you played in its arpeggiation. This can be used to great effect. Play a clump of notes with a medium velocity, then strike a new note with force. The new note will stand out in the arpeggiation in an interesting fashion. If desired, add a Change velocity effect after it to keep the velocities in a normalized range.

GROOVE QUANTIZE
Groove Quantize is a real-time version of the Groove Quantize region operation found under the Region menu. For more information, see “Groove Quantize” on page 358.

![Figure 58-6: The Groove Quantize effects processor.](image)

HUMANIZE
Humanize is a real-time version of the Humanize Region command found under the Region menu.
The Humanize command lets you add a “random” element—or “humanized” feel—to your music. With this command, you can randomize any combination of the following elements of your music:

■ Note placement
■ Note durations
■ Velocities
■ Pitches
■ Tempo

In addition, you can create a unique blend of these humanize elements and save it as a humanize style, which you can recall and use at any time. You can use the Humanize command to create arpeggiation effects, hi-hat (or other percussion instrument) grooves, and other dramatic musical effects.

**INVERT PITCH**

The Invert pitch processor allows you to specify an axis point around which your MIDI note data will be inverted. For example, if C3 is specified as the center pitch, C#3 will sound as B3 and B3 will sound as C#3. The Invert Pitch MIDI plug-in functions as a non-destructive version of the Invert Pitch region operation detailed in “Invert Pitch” on page 377.

**QUANTIZE**

The Quantize effects processor is identical to the Quantize command in the Region menu, except, of course, that it has no permanent effect on the data in the track. Since it only affects data upon playback, it can be adjusted and even turned off (bypassed) at any time. For details on Quantize options, see “Quantize” on page 352.
REASSIGN CONTINUOUS DATA
This real-time effect modifies only MIDI continuous data (but not audio volume, audio pan or audio plug-in automation).

As shown in Figure 58-10 below, notice that this plug-in can also generate registered and non-registered parameters (RPN’s and NRPN’s).

REMOVE DUPLICATES
Remove Duplicates is a real-time plug-in that eliminates duplicate notes on the fly. This is useful for situations when quantization creates a ‘chord’ consisting of the exact MIDI note. Placing Remove Duplicates in line after Quantize helps eliminate this problem.

TIME SHIFT
The Time Shift moves the playback of data earlier or later than its location in the track. It has no permanent effect on the data in the track. Since it only affects data upon playback, it can be adjusted and even turned off (bypassed) at any time.

TRANSPOSE
Choose the type of transposition you would like: either by a single interval or using a custom transpose map you have created with Transpose command in the Region menu (page 343). With interval transposition, enter any interval you like in the value boxes provided by editing the pitch text box (type, drag up/down, or use MIDI entry). The specific pitches do not matter: the interval between them determines the degree of transposition. For example, to transpose an octave up or down, choose C4 or C2, respectively.

The Harmonize option causes the newly transposed data to be combined with the original data, so that they both play simultaneously.
CHAPTER 59  Audio File Conversion

OVERVIEW
The Convert Audio File command in the Soundbites menu allows you to change the sample rate, sample format (bit depth), file format, and interleave format of an audio file or soundbite.

You can change:
- sample rate: any sample rate between 1 kHz and 200 kHz
- sample format: 16-bit integer, 24-bit integer, or 32-bit floating point
- file format: Broadcast WAVE, AIFF, or Sound Designer II
- interleave format: interleaved or deinterleaved

Like Performer Lite’s other “constructive” DSP processes, these conversions can occur in the background.

PERFORMING CONVERSIONS
To open the Audio File Conversion window, select a soundbite or audio file and choose Convert Audio File from the Soundbite window mini-menu.

Using the checkbox next to each section, each conversion operation can be turned on or off to perform any combination of operations.

CONVERTING THE SAMPLE RATE
Performer Lite uses a highly precise, efficient, and transparent sample rate conversion algorithm, with a 138 dB signal-to-noise ratio.
To sample rate convert some audio, select one or more soundbites in the Soundbites list and choose Convert Audio File from the Soundbites list mini-menu. The Audio File Conversion dialog appears.

**Changing the recognized sample rate for an audio file**

When checked, the Only change the file’s recognized sample rate but do not process the file’s audio option changes the sample rate attribute for the audio file, but it does not actually process or otherwise alter the audio data in the file. Use this command in situations where the sample rate being reported by the file (as listed in Performer Lite’s Soundbites list, or the info window in other audio applications) erroneously does not match the actual sample rate of the audio contained in the file.

**CONVERTING THE SAMPLE FORMAT**

The Convert Sample Format section of the Audio File Conversion, as shown below in Figure 59-1, allows you to change the sample format of an audio file or soundbite. You can change to 16 bit integer, 24 bit integer, or 32 bit floating point. Like Performer Lite’s other file-based “constructive” DSP processes, sample format conversion can occur in the background.

**Dither**

Performer Lite incorporates dither when converting to a lower bit depth—rather than truncating the extra bits—to ensure the smoothest possible conversion.

**CONVERTING THE FILE FORMAT**

In the File Format section of the Audio File Conversion window, you can convert the file format of your audio files between Broadcast WAVE, AIFF, and Sound Designer II. You can convert from any format to any other.

Note that if a file’s sample format is 32-bit floating point, when converting the file format to Sound Designer II the resulting file’s sample format will be converted to 24-bit integer (32-bit floating point is not supported with Sound Designer II files).

**CONVERTING THE INTERLEAVE FORMAT**

Interleaved audio uses one file for all channels, whereas deinterleaved uses one file for each channel. In the Interleave Format section of the Audio File Conversion window, you can convert the interleave format of your audio files between interleaved and deinterleaved.

**CONVERTING ENTIRE AUDIO FILES**

When you choose a soundbite for conversion, you can choose between converting only the soundbite itself (the portion of the audio file that falls within the soundbite) or the entire parent audio file. If you will need to use other parts of a audio file (edge editing the converted soundbites, for example), you should choose to convert the whole file.

**SOUNDBITE REPLACEMENT OPTIONS**

In Performer Lite, sample rate and sample format conversion is a “constructive” editing process, which means that it always generates new audio files and preserves the original ones. Several options are provided to specify what to do with the old audio, and how to replace existing soundbites.

If the Replace soundbites and Convert entire audio file options are chosen, you may also enable the Move the original file to the trash option.

**AUTOMATIC CONVERSIONS**

Performer Lite can perform certain conversions automatically. For more information, see “Automatic conversions” on page 204.
CHAPTER 60 Time-stretching and pitch-shifting

OVERVIEW
This chapter gives you a brief overview of Performer Lite’s audio time-scaling and pitch-shifting capabilities. It then discusses the following important topics that are common to all of Performer Lite’s Digital Signal Processing (DSP) tasks:

Overview ........................................... 513
ZTX™ audio processing ....................... 513
Selecting audio for processing ............. 513
Editing MIDI and audio together ............. 514
Constructive editing .......................... 514
Audio quality is preserved ................. 514
Handling lengthy processing tasks .......... 515
ZTX Preferences .............................. 516

ZTX™ AUDIO PROCESSING
Performer Lite’s ZTX™ time-stretching and pitch-shifting technology has been developed by (and licensed from) Zynaptiq GmbH (zynaptiq.com). ZTX represents cutting edge, state-of-the-art audio time-stretching and pitch-shifting DSP technology developed and refined through years of advanced research and development by the renowned audio DSP engineering team at Zynaptiq.

With very high quality results, Performer Lite’s ZTX capabilities give you the ability to:

- Change the pitch of audio without changing its tempo
- Change the length or tempo of audio without affecting the pitch
- Change the tonal quality (the formants) of audio without affecting pitch or tempo
- Transpose pitched audio with or without the traditional “sampler” effect

Performer Lite can use these basic abilities to make it easier for you to do more complicated things:

- Apply a tempo map (e.g., ritards and rubato) to audio that was recorded at a fixed tempo
- Change audio that was recorded with a tempo map to play back at a constant tempo, or with a new tempo map
- Easily make the sequence play at the tempo of imported audio
- Quantize or groove-quantize audio
- Transpose audio and MIDI together in a single operation
- Quantize or groove-quantize audio and MIDI in a single operation

These operations are discussed in detail in the next few chapters. The rest of this chapter explains several important things you should know that are common to all DSP operations.

SELECTING AUDIO FOR PROCESSING
Most of the DSP commands allow you to select audio data in all of the usual ways. Unless stated otherwise in the chapters that follow, all commands work with all these types of selections:

- Selections of whole soundbites in the Sequence Editor.
- Time-range selections in the time ruler of the Sequence Editor. If a soundbite crosses the start or end of the selection time range, only the part of the soundbite within the selection is affected.
■ Selections within a pop-edited soundbite in the Sequence Editor.

■ Soundbites selected in the Soundbites list.

You are not limited to thinking about your edits one soundbite at a time. If you want to transpose a whole track, or even your entire sequence, it’s no problem. On the other hand, if you just want to correct the pitch in a small section of a soundbite, make a pop-edit selection. If a soundbite appears in many different places in several tracks or even several sequences, and you want it transposed or time-scaled in all those instances, just select it in the Soundbites list and make the edit there.

All of Performer Lite’s DSP commands make sure they don’t create any more new audio files than they need to. If you transpose a selection that includes the same soundbite 10 times, Performer Lite only transposes the soundbite once, and replaces all 10 occurrences with the new soundbite. Or if you have selected several soundbites that come from neighboring or overlapping parts of the same audio file, they are all processed together, and only a single new audio file is created.

On the other hand, if you are applying a rubato tempo map to 40 repetitions of a drum loop, Performer Lite is perfectly happy to create how ever many new soundbites are necessary – whether it’s 2, 10, or 40 – as a result of a single command.

EDITING MIDI AND AUDIO TOGETHER

As a digital audio sequencer, Performer Lite is designed to give you a seamless, integrated environment in which to create music using both digital audio and MIDI data. Accordingly, most of Performer Lite’s DSP operations can be applied to MIDI data in the same operation, so that you do not necessarily need to be concerned with the type of data being edited, and so that you do not have to do two separate operations to achieve a single effect. For example, if you want to transpose your entire piece of music up a whole step, you can select all tracks, MIDI and audio, and choose Transpose from the Region menu.

CONSTRUCTIVE EDITING

All of Performer Lite’s DSP functions are “constructive” edits. Performer Lite never modifies your original audio files. When you transpose, time-scale, spectral-shift, or tempo-adjust an audio selection, Performer Lite creates new audio files to hold the new audio data (except when using the Transpose window’s “Transpose audio by adjusting pitch automation” option – see “Transpose audio by adjusting pitch automation” on page 345). This means you can always go back to the original if need be; it’s always your decision, if you want to delete original source material.

In order to help you work faster, Performer Lite doesn’t waste your time with dialog boxes asking you where you want to put the new files, and what you want to call them. Audio files are automatically created in the same folder as the original, with a name that indicates which soundbite or audio file it is based on. If you want to rename or move the file, you can feel free to do so at your leisure.

AUDIO QUALITY IS PRESERVED

Performer Lite keeps track of where a soundbite came from. For example, if you time-stretch a soundbite, creating a new audio file at the new tempo, Performer Lite remembers its original soundbite. If you then time-stretch the already stretched soundbite, instead of just stretching the already-stretched soundbite again, Performer Lite refers back to the original soundbite to create the very latest version. The same is true for pitch-shifting. This allows you to freely time-stretch and pitch-shift audio consecutively as many times as you like without worry about artifacts that may arise due to multiple time-stretch or pitch-shift
operations applied to the same audio. The results will always be the same as if you time-stretched or pitch-shifted the original soundbite.

The link between soundbites and their original source soundbites can be viewed in the Soundbites list. For details, see “Viewing soundbite sources hierarchically with ‘By Folder’ view” on page 198.

HANDLING LENGTHY PROCESSING TASKS
Performer Lite’s DSP processing requires a great deal of computation, and may be applied to audio files containing millions of samples, so it may take many seconds or even minutes to complete a single command. However, to prevent you from staring at progress bars, Performer Lite has features that allow you to be as productive as possible during lengthy processing tasks:

- Background processing
- Audio file analysis that is done separately before the actual processing and saved on disk so that it does not need to be recalculated every time you invoke a DSP task

The following sections further discuss these features.

Background Processing
Because audio processing can take time, Performer Lite does all of its file-based processing in the background, allowing you to continue editing, playing, or even recording while it’s working.

When you use one of the commands that initiates background processing, such as Transpose or Scale Time, Performer Lite immediately creates new Soundbites for the resulting audio. As long as the new soundbites are “under construction,” their waveforms appear as an empty outline in the Sequence Editor as shown in Figure 60-1, so you can tell at a glance when they have finished being constructed.

When processing is complete, the waveform fills in solid to indicate that it is finished and ready to be played back. You can do just about any type of editing on a hollow waveform, such as cut, copy, paste, split, and even edge editing. The only commands that don’t work are ones that require knowledge of the sample data, such as Strip Silence.

Editing audio that is “under construction”
After the new constructed soundbites appear, you do not need to wait; you can continue editing, recording (audio or MIDI), playing back, or whatever. It is perfectly fine to move, duplicate, split, trim, or even edge edit these unfinished soundbites. However, commands such as Strip Silence, which need to know the actual sample data, will not work on these soundbites until they are done being constructed.

Audio file analysis
Before pitch-shifting or time-scaling a soundbite, Performer Lite needs to perform a sophisticated analysis of the audio data. The actual pitch-shifting or time-scaling is relatively fast, but the analysis can take a while. Therefore, Performer Lite saves the results of the analysis in an analysis file, so that any given audio file only needs to be
analyzed once. Analysis files are created automatically, and are kept in a folder called “Analysis Files” in the project folder.

**Automatic background analysis**

By default, Performer Lite will analyze audio only when needed. However, analysis can be set to automatically analyze any audio files used by your project that have not been analyzed yet. This analysis goes on in the background, so it does not interfere with your work. By the time you need to pitch-shift or time-scale a soundbite, it will probably already be analyzed, so the processing will take a fraction of the time.

**Analysis Files**

For the most part, you don’t need to think much about analysis files. Performer Lite creates them automatically, and uses them to do DSP functions. They are stored in a folder called Analysis Files in your project folder.

If you use the same audio file in multiple projects, you should be aware that Performer Lite knows not to create multiple analyses for the same audio file.

Performer Lite attempts to delete the analysis file when you delete a audio file. However, if you delete audio files in the Finder or Explorer, rather than with the Delete command in the Soundbites list, Performer Lite has no way of knowing this. In this case, you will probably want to delete the analysis file yourself. Since Performer Lite can always reanalyze an audio file, there is no harm in throwing out an analysis file, except that you may need to wait for the audio file to be analyzed again later.

**ZTX PREFERENCES**

In Preferences > Pitch and Stretch (Figure 27-5 on page 232), you can choose the quality of the ZTX processing, which in turn impacts your computer’s CPU performance during playback (for real-time processing) or the time it takes to complete the processing (for offline tasks). Generally speaking, higher quality settings take more time and more CPU load.

Separate settings can be made for new projects and the current project you have open.

**Pitch Automation Playback**

The Pitch Automation Playback setting (Figure 27-5 on page 232) controls the ZTX playback quality level for any pitch automation edits you make in the Sequence Editor pitch editing layer (Figure 61-2 on page 521 and Figure 61-4 on page 522). Pitch layer edits are always rendered in real time (not written to disk), so this setting can have a fairly dramatic impact on the CPU load of your computer. If you find that making pitch edits causes your computer to have difficulty during playback, try choosing a lower quality setting (Better or Good). This setting pertains only to pitch layer edits and has no effect on the quality of time-stretching edits.

**Offline Processing**

The Offline Processing setting controls the ZTX time stretching and pitch shifting quality level for new audio files created by offline audio processing operations such as Time Scaling, Tempo Adjustments, Spectral Effects and Transpose (when creating new soundbites). In other words, any time new audio is written to disk as a result of time stretching or pitch shifting, this settings controls the quality of the operation. Higher quality settings increase the amount of time the operation takes. Other factors that impact how long it takes include the length of audio selected and the CPU power of your computer.
**ZTX quality settings**
The ZTX quality settings (Figure 60-2) appear at the bottom of the pitch mode menu (Figure 61-1 on page 519). They also appear in the ZTX quality menus in the *Audio Options* preferences (Figure 27-5 on page 232).

![Available for offline processing only](image)

Figure 60-2: ZTX quality settings.

The categories (*Efficient*, *Solo*, *Standard* and *Detailed*) are meant to serve as general guidelines: *Efficient* for fast processing, *Solo* for monophonic audio material, *Standard* for normal quality and *Detailed* for higher quality, CPU-intensive processing. Results, however, can vary significantly depending on the audio material. Don’t hesitate to experiment. For example, the *Standard* setting may produce better results than *Detailed* on a certain polyphonic audio clip.

**Efficient (Good, Better, Best)**
These three modes require the least amount of CPU power. They are recommended if you desire quick audio rendering times.

**Solo (Good, Better, Best)**
Zynaptiq describes this algorithm as “full time localization”. This mode is recommended for dry monophonic audio material or dry percussive audio material.

**Standard (good, better, best)**
Zynaptiq describes this algorithm as “50% time localization and 50% frequency localization”. This mode is recommended for polyphonic audio material and will yield satisfactory results on most audio material.

**Detailed (good, better, best)**
Zynaptiq describes this algorithm as “full frequency localization”. This mode is recommended for complex full mixes and will require the most CPU power. This mode may not produce the best results for solo voice or rhythmic audio material. See “CPU strain” below.

**For best results, experiment with the settings**
There is no setting that will automatically yield the best results for all audio material. It is recommended that you spend a moment to experiment with the different settings to find the most desirable result.

**Best mode**
*Best* mode may not always produce the best results, depending on the audio material. If you are not fully satisfied with the quality of the results you are getting when applying pitch-shifting or time-stretching in a particular case, undo and try again with *Good* or *Better*, which may produce better results. You can change the settings on the fly at any time, as you work.

**Time versus frequency localization**
Technically speaking, *Solo* mode employs maximum ZTX time localization, *Standard* mode employs equal time and frequency localization, and *Detailed* mode employs maximum frequency localization. *Efficient* mode employs variable time and frequency localization, depending on the material, which can sometimes produce the best results (in addition to being the most CPU efficient).
CPU strain
Generally speaking, processing gets more intensive as you go down the list from Efficient to Detailed. Due to their intensive CPU processing requirements, the Detailed settings (Figure 60-2) are only available for file-based processing, as explained earlier in “Offline Processing”.

CHAPTER 61  Transposing Audio

OVERVIEW
Overview .................................................. 519
Pitch Shifting mode ....................................... 519
Pitch automation ........................................... 520
Using the Transpose command ......................... 527
Transposing audio and MIDI together ............... 527
Temporarily disabling pitch modifications .......... 527
Converting audio pitch to MIDI data ................ 528
ZTX processing preferences ............................ 529
Background processing ................................. 529

PITCH SHIFTING MODE
When transposing audio in Performer Lite, there are four possible modes to choose from:

- ZTX Formant-Corrected
- ZTX Standard
- PureDSP Solo Vocal
- No Pitch Shift

The Pitch shifting mode is chosen in a menu on the soundbite title bar (Figure 61-1). Each soundbite can be assigned its own mode. You can also access this menu by right-clicking on the soundbite. To assign multiple soundbites to the same setting at one time, select them and then do one of the following:

- press option/alt while accessing the pitch-shift mode menu (Figure 61-1) on one of the selected bites, or
- press option/alt while right-clicking one of the selected bites (in any edit layer).

ZTX Formant-Corrected
Formant-corrected pitch shifting preserves the original character of the sound by separately transposing the pitch and formants (resonant frequencies) by different amounts. This type of pitch shifting avoids the classic “sampler” effect. For example, vocals transposed up will not get the “chipmunk” effect or, when transposed down, the “Darth Vader” effect. Instead, the quality remains the same and just sounds higher or lower. The advantage of formant-corrected shifting is that results are more true to the original audio’s tone or timbre.

ZTX formant-corrected pitch shifting works well on just about any material, including polyphonic material, such as keyboard tracks, and even full mixes.

Figure 61-1: Choosing the pitch-shifting mode for a soundbite.
ZTX Standard
Standard pitch-shifting transposes pitch and formants by the same amount, producing the classic “sampler” effect described above. It can be applied as desired to any audio material.

PureDSP Solo Vocal
Performer Lite’s PureDSP Solo Vocal formant-corrected pitch shifting (carried forward from earlier versions of Performer Lite) often works exceptionally well on solo vocal material. If you are transposing or pitch-correcting solo vocals, try this mode (instead of ZTX Formant-Corrected) to see if it produces the best results.

☛ Pure DSP Solo Vocal does not work on polyphonic material. Use one of the ZTX modes instead for polyphonic material.

When tuning monophonic audio, you may find that PureDSP Solo Vocal often works better than ZTX, especially when fine-tuning vocals.

No Pitch Shift
Use the No Pitch Shift setting for any audio that you would never want to pitch-shift. For example, you would likely not want to transpose audio in dialog tracks, sound effects tracks or percussion tracks. This setting ensures that you won’t accidentally transpose the audio (when making multi-track time range selections, for example).

ZTX quality setting
For information about the ZTX quality setting (Figure 61-1 on page 519), see “ZTX Preferences” on page 516 and “ZTX quality setting” on page 520.

PITCH AUTOMATION
Performer Lite allows you to manipulate the pitch of audio material in the form of pitch automation data that can be edited directly in the track where the audio resides. Like volume and pan, pitch automation is applied non-destructively to track output in real-time during playback.

A wide variety of pitch-related operations can be performed on audio data, from simple pitch correction using the Pencil tool, to individual note transposition, to wholesale transposing of an entire track from one mode or key to another using the Transpose command. The success of these operations depends highly on the nature of the audio material itself.

Pitch automation can be applied to mono and stereo audio files, and it can be applied to any pitched audio material, including the spoken human voice.

Latency compensation
Pitch automation requires Performer Lite’s latency compensation features, so be sure that the Automatic Plug-in Latency Compensation option is enabled in the Setup menu> Configure Audio System> Configure Studio Settings dialog. See “Automatic plug-in latency (delay) compensation” on page 24.

Pitch automation note range
Pitch automation edits are limited to the note range C0 through C6.

Pitch edits are bound to soundbites
Even though they look just like volume, pan and other track-based automation data types, pitch automation edits are bound to the specific soundbite on which you perform the edit. This means that if you then move the soundbite, the pitch edits move with it. In addition, all instances of the soundbite in the project are affected. Conversely, you can create harmonies from the same source audio by creating different soundbites from the same parent audio file region. Each separate soundbite can have unique pitch edits.

Pitch adjustments are non-destructive
Any adjustments that you make to the pitch of audio are non-destructive and non-constructive. In other words, the original audio data is not
modified in any way, nor is any new audio data generated on disk. Instead, pitch modifications are rendered in real-time by Performer Lite’s processing engine. Therefore, they can be quickly applied, modified and removed, even during playback. In fact, you might find it most useful to keep playback going — and even loop sections — when you are editing pitch, as you will enjoy the benefit of instant feedback as you work. Pitch adjustments can, however, be permanently applied to audio by merging the soundbite or (unlike other forms of automation) exporting the soundbite.

**Viewing pitch automation**

To access pitch automation, choose Pitch from the Sequence Editor track layer menu (Figure 61-2).

The pitch layer represents the pitch of the audio in two forms, superimposed on top of the waveform: 1) as a blue line (the *pitch curve*) and 2) as bars or *pitch segments*. Both are measured by the pitch ruler along the left edge of the track. You can expand the vertical size of the track, zoom the vertical resolution and scroll the vertical position of the pitch layer information, all independently of the waveform display. This allows you, for example, to position the pitch information above or below the actual waveform, rather than directly on top of it.

**Absolute vs. relative pitch editing**

There are two modes for editing pitch: Absolute and Relative, chosen from the *Pitch layer mode* menu (Figure 61-2). These two modes do not change how the audio plays back, just how it is viewed and edited.

**Absolute**

*Absolute* mode displays pitches as directly editable bars in a piano roll style edit layer with a vertical, multi-octave pitch ruler along left edge of the track lane (as shown in Figure 61-2). This mode is best for tuning monophonic audio (i.e. solo vocals, solo instruments, etc.)
Relative
Editing in Relative mode simply allows pitch to be offset by some amount. The pitch ruler keyboard shows interval offsets, mirrored above and below a center (root) line, rather than absolute pitches from top to bottom (Figure 61-3). The root pitch in the pitch ruler is indicated by the track color.

Initially, Relative mode displays a single bar for the entire soundbite (Figure 61-3), which you can drag up and down. Use the scissor tool to split the bar into segments, which can then be individually dragged up or down (Figure 61-4), similar to Absolute mode. The scissor tool responds to grid snapping, if enabled. When dragged vertically, pitch bars snap to the chromatic scale in the pitch ruler. For fine-tuned adjustments, hold down command/ctrl to override pitch snapping while dragging vertically.

Relative mode can be used for monophonic material, but it also works well for full mixes and polyphonic audio, which cannot be represented with single pitch bars.

The pitch curve
The blue pitch curve (Figure 61-2) represents the original pitch. If you modify the pitch curve in any way, the modified portions of the curve are displayed in red. You can select and edit the pitch curve directly using the Arrow tool and the Pencil tool, as follows:

<table>
<thead>
<tr>
<th>To do this to the pitch curve</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To redraw the pitch curve</td>
<td>Set the Pencil/Reshape curve menu in the Tool palette to Free and drag over the pitch curve with the Pencil tool.</td>
</tr>
<tr>
<td>To select the pitch curve</td>
<td>Drag over it with the Arrow tool (lasso cursor), or click a pitch segment to select the part of the curve that it represents.</td>
</tr>
<tr>
<td>To get rid of any red portions (modifications)</td>
<td>Select the curve and hit delete, or choose Audio menu &gt; Pitch and Stretch &gt; Clear Pitch.</td>
</tr>
<tr>
<td>To scale the existing curve</td>
<td>Option/Alt-click the curve and then drag vertically. See “Scaling the pitch curve” below for further details.</td>
</tr>
<tr>
<td>To reshape the curve</td>
<td>Choose the desired shape from the Pencil/Reshape curve menu in the Tool palette, set the edit grid resolution (if desired) and drag over the pitch curve with the Pencil tool.</td>
</tr>
</tbody>
</table>

Pitch curve control points
Control points can be added to the pitch curve to modify it as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To add a control point</td>
<td>Double-click the pitch curve with the Arrow tool.</td>
</tr>
<tr>
<td>To modify the pitch curve with the control point</td>
<td>Drag the control point with the Arrow tool.</td>
</tr>
<tr>
<td>To anchor the pitch curve on either side of a control point when you drag it</td>
<td>Add control points on either side of the location where you want to anchor the curve.</td>
</tr>
<tr>
<td>To select a control point</td>
<td>Drag over it with the Arrow tool (lasso cursor).</td>
</tr>
<tr>
<td>To delete a control point</td>
<td>Select the portion of the pitch curve and choose Audio menu &gt; Pitch and Stretch &gt; Clear Pitch Control Points.</td>
</tr>
</tbody>
</table>
For best results
Although you can make precise pitch adjustments on the pitch curve with the Pencil tool and control points, often you will achieve more natural results by simply transposing and scaling the original curve as described in the following sections.

Scaling the pitch curve
Option/Alt-drag vertically on the pitch curve to scale it. Dragging upwards accentuates the existing curve; dragging down flattens it. The portion of the curve that is affected by the scaling operation is determined by:

- the end points of the pitch segment at the location where you click, or
- the currently selected portion of the pitch curve, if any.

You can also scale the pitch curve by selecting the portion you wish to scale and choosing Audio menu > Pitch and Stretch > Scale Expression.

Scaling the pitch curve can be used for a variety of applications. Here are a few examples:

- To produce more or less vibrato in audio that already has some vibrato
- To reduce unwanted variations in pitch
- To enhance variations in pitch

Editing the pitch curve in relative mode
You can edit the pitch curve in both absolute and relative modes. If you don’t see the pitch curve, try zooming in horizontally. Keep in mind that Absolute and Relative modes are different views of the same pitch curve. If edits are made in Absolute mode, Relative mode’s pitch bar(s) will move accordingly (and vice versa).

Pitch segments
In Absolute mode, Pitch segments (Figure 61-2) represent the detected average root pitch of each note in the audio. In Relative mode (Figure 61-4), they represent deviations from the original pitch. They are displayed in the color assigned to the track. These segments can be fine-tuned in a variety of ways to accurately represent individual notes in the audio — without changing the audio itself. You can then use the pitch segments to modify the pitch of the audio in a wide variety of ways, from micro-tonal tuning adjustments to wholesale transposition and key changes. You can even copy and paste pitch segments into a MIDI track to create MIDI notes that match the source audio.

Fine-tuning pitch segments
In Absolute mode, pitch segments are most useful when they accurately represent the pitch and duration of each individual note in the audio. Performer Lite does its best to detect the root pitch, beginning and end of each note. But further adjustment may be necessary. For example, a singer may bend the pitch of a held note, causing Performer Lite to represent the audio as two

Figure 61-5: Pitch curve control points.

Figure 61-6: Option/Alt-drag vertically to scale the existing pitch curve. In this example, vibrato is being reduced and increased.

Figure 61-7: Editing the pitch curve in Relative mode.
different pitch segments. To accurately represent them as one continuous segment, you can go in by hand to merge them together into a single pitch segment. As another example, you might want to slightly adjust where the transition from one segment to another occurs.

**Fine-tuning pitch segments does not affect audio**

It is crucial to understand that the changes to the pitch segments being discussed so far have no effect whatsoever on the audio signal itself. Instead, the purpose of these changes is to represent as accurately as possible the notes in the original audio signal itself. The more accurate the pitch segment representation, the more successfully you will be able to modify the pitch of the audio using the pitch segments (via several techniques discussed later).

**Setting the pitch mode**

Before you make individual adjustments to pitch segments, you should first choose an overall pitch mode for the audio. There are two different pitch modes: *vocals* and *instruments*. Choosing the appropriate pitch mode for the audio material you are working with can dramatically improve the initial representation of the pitch segments, so that you’ll have much less tweaking to do by hand, if any. To set the pitch mode for a track or soundbite, select it (in the Sequence Editor) and then choose Audio menu > Pitch and Stretch, and then choose the desired sub-menu command:

![](image)

**Figure 61-8: Setting the pitch mode for a soundbite or track.**

Here is a summary of how these three pitch mode commands affect pitch segments:

<table>
<thead>
<tr>
<th>Pitch mode command</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Track Pitch Mode</td>
<td>Sets the default pitch mode for any audio material newly recorded into that track. It does NOT affect existing soundbites already in the track, or soundbites dragged into the track.</td>
</tr>
<tr>
<td>Set Pitch Mode for Selected Bites</td>
<td>Sets the pitch mode and modifies the pitch segments accordingly for the currently selected audio in the Soundbites list or in any tracks.</td>
</tr>
<tr>
<td>Set Pitch Mode for Track and Selected Bites</td>
<td>Applies the pitch mode to both the track and any currently selected soundbites as described above in one operation.</td>
</tr>
</tbody>
</table>

**Adjusting pitch segmentation**

Another way to control overall pitch segmentation accuracy is to select the desired audio and then choose Audio menu > Pitch and Stretch > Adjust Pitch Segmentation:

![](image)

**Figure 61-9: Adjust Pitch Segmentation.**

Move the slider to the right for more detailed segmentation; move it left for less detail. The *Instruments* and *Vocals* settings along the slider match their corresponding menu settings shown in Figure 61-8 on page 524 and produce the same results and the respective menu setting.

![](image)

**Figure 61-10: Adjusting pitch segmentation.**
Adjusting pitch segments while playing back
It can help to loop a section and make pitch segment adjustments during playback to match what you are seeing with what you are hearing. This goes for all pitch segment editing.

Editing pitch segments
After you’ve chosen the pitch mode for the track or soundbite, you can further modify the pitch segments to more accurately reflect the notes in the audio as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>To join adjacent segments</td>
<td>Click between them with the Mute tool.</td>
<td><img src="before_after1.png" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="before_after2.png" alt="Example" /></td>
</tr>
<tr>
<td>To split adjacent segments</td>
<td>Click with the Scissor tool.</td>
<td><img src="before_after3.png" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="before_after4.png" alt="Example" /></td>
</tr>
<tr>
<td>To move the boundary between two segments</td>
<td>Drag one of the adjacent segment edges with the Arrow tool (using the trim cursor shown below)</td>
<td><img src="before_after5.png" alt="Example" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="before_after6.png" alt="Example" /></td>
</tr>
</tbody>
</table>

Trimming pitch segments
As noted above, you can position the Arrow tool over the edge of a pitch segment to get the trim cursor (shown in the table). Drag horizontally with the trim cursor to move the edge of the segment. If the pitch segment you are trimming lies adjacent to silence (at the beginning or end of the audio signal), you are not allowed to extend the segment into the silence, as segments only represent portions of the soundbite that have audio signal of some kind.

Gray pitch segments
Gray pitch segments represent portions of the audio signal that have no detectable pitch. For example, a percussive drum sound, such as a cymbal, has no clearly defined root pitch. Another example are the sibilants found in vocal tracks: these are sounds such as “s” or “ch” that do not have pitch to them.

Gray segments are displayed to indicate that there is signal present in the audio, but that the signal has no detectable pitch. Gray segments cannot be modified (since there is no pitch information to transpose).

Dangling segments
A dangling segment is a portion of a segment for which there is no pitch curve. This is most often the result of unpitched material that is not yet split into its own gray segment. In the example below, the dangling segment on the left has been split into a gray segment using the Scissor and Trim tools. There may be situations, however, where dangling segments are preferred, such as when you convert pitch segments into MIDI notes (“Converting audio pitch to MIDI data” on page 528).
Transposing audio

Reverting to the default pitch segmentation
If you edit the pitch segments and then decide you want to start over, select the soundbite and choose Audio menu > Pitch and Stretch > Set Pitch Mode for Selected Bites > and then choose either vocals or instruments. Doing so recomputes the pitch segments and restores them to their original state, before any modifications.

Modifying pitch using pitch segments
After the pitch segments accurately reflect the notes in the audio, as explained in the previous sections, you can use the pitch segments to transpose the audio as follows:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To transpose a note chromatically</td>
<td>Drag its pitch segment vertically. The note snaps to the root pitches in the pitch ruler, but also maintains its relative position to the root pitch (if its a little sharp or flat).</td>
</tr>
<tr>
<td>To correct the pitch slightly or perform other micro-tonal adjustments</td>
<td>Command/Ctrl-drag the pitch segment vertically.</td>
</tr>
<tr>
<td>To select the pitch segment (and the portion of the pitch curve that Arrow (finger) tool represents)</td>
<td>Click the pitch segment with the Arrow (lasso) tool.</td>
</tr>
<tr>
<td>To select multiple pitch segments</td>
<td>Shift-click them or drag over them with the Arrow (lasso) tool.</td>
</tr>
<tr>
<td>To drag multiple pitch segments</td>
<td>Select them first and then drag them.</td>
</tr>
<tr>
<td>To return a pitch segment to its original pitch</td>
<td>Select it and hit delete, or choose Audio menu &gt; Pitch and Stretch &gt; Clear Pitch.</td>
</tr>
</tbody>
</table>

Figure 61-14: Editing pitch by dragging a pitch segment.

Quantizing pitch
If you would like to “center” one or more pitch segments, so that they are tuned exactly to their relative root pitch (to fix any notes that are a little sharp or flat), select their pitch segments and choose Audio menu > Pitch and Stretch > Quantize Pitch. Doing so centers each pitch segment with its corresponding root pitch (or relative interval) in the pitch ruler. In general, you achieve best results from this operation if you first edit pitch segments with the Mute and Scissor tools, as explained in “Editing pitch segments” on page 525.

The pitch reference
By default, pitch editing is based on the standard “A 440” tuning reference, where the A above middle C is 440 Hz.
USING THE TRANSPOSE COMMAND
You can use Performer Lite’s standard Transpose command (Region menu) to apply a wide variety of transpose operations on the pitch segments and the audio data they represent. Select the pitch segments you wish to transpose (using any of the techniques discussed in the previous section) — or just select the audio itself — and choose Region menu> Transpose. Make sure the Transpose audio check box is checked, and the Transpose audio by adjusting pitch automation option is chosen, as demonstrated in Figure 61-15 below:

![Transpose window](image)

Figure 61-15: Check the 'Transpose audio' check box to transpose audio data.

You can then choose any form of transposition option you wish, including Interval, Diatonic, Key/Scale and even Custom Map. This is a very powerful feature because it gives you the same level of complete control when transposing audio as you do when transposing MIDI data. Keep in mind, however, that the success of audio transposition operations like this, as with all pitch-shifting, depends on the size of the intervals involved and the nature of the audio material being transposed. Some types of audio material transpose better than others.

Another important factor for successful transposition is the accuracy with which the pitch segments in the pitch layer of the track represent the actual notes in the audio, as explained in the previous sections. So before using the Transpose command to transpose audio, it is a good idea to spend some time reviewing the pitch segments for accuracy.

In the example above (Figure 61-15), audio is being transposed from one key and mode (C minor) to an entirely different key and mode (D Phrygian).

TRANSPOSING AUDIO AND MIDI TOGETHER
When using the Transpose command (Figure 61-15), you can of course select both audio and MIDI tracks together to transpose them in one operation. Just be sure to check both the MIDI and audio check boxes as shown in Figure 61-15.

TEMPORARILY DISABLING PITCH MODIFICATIONS
Any modifications you make to the pitch of audio in the Pitch Layer of an audio track can be temporarily disabled using the techniques described below. When you disable pitch modification in this way, all pitch edits are fully preserved, and you can re-enable them at any time:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>To temporarily disable all pitch modifications in the entire track</td>
<td>Click the ‘P’ button at the bottom of the track’s pitch ruler in the Sequence Editor. You can also use Performer Lite’s Option/Alt-click and Command/Ctrl-click shortcuts. Or choose Pitch from the track settings menu.</td>
</tr>
<tr>
<td>To temporarily disable a specific soundbite’s pitch modifications</td>
<td>In the Sound File Info window, set the soundbite’s Transpose attribute to Don’t Pitch Shift.</td>
</tr>
</tbody>
</table>

When pitch edits are disabled, you cannot edit the track pitch layer information.

When pitch automation is bypassed using the ‘P’ button, the data is still processed in real-time so that you can immediately hear the results when
you unbypass. In this case, the bypassed pitch automation takes up just as much computer processing resources as when it is unbypassed (playing).

When pitch automation is bypassed via the Don’t Pitch Shift soundbite setting, the pitch data is completely ignored, therefore conserving your computer’s processing resources.

**CONVERTING AUDIO PITCH TO MIDI DATA**

Pitch segments (Figure 61-2) can be copied and pasted into MIDI tracks, essentially allowing you to convert the pitch information in the audio into MIDI data. This powerful feature can be used for a wide variety of applications. For example, you could layer a vocal part with MIDI parts, or sing a melody and then convert it to MIDI data for further development. The possibilities are endless.

The accuracy of the MIDI transcription is entirely dependent on the accuracy with which the pitch segments represent the notes in the audio. The more accurately the pitch segments represent the actual audio, the more accurate the MIDI transcription.

**Preparing for MIDI pitch transcription**

Pitch segments are copied and pasted as is, so if you have made any modifications to the pitch segments — or changes to the pitch curve that are reflected by the pitch segments — the changes will be carried over into the MIDI track.

For best results, try these preparations on the pitch segments before you copy and paste them:

- Quantize pitch (*Audio menu* > *Pitch and Stretch* > *Quantize Pitch*) to ensure that each note is centered on its root pitch.
- Make sure there is a one-to-one correspondence between each pitch segment and each note that you hear in the audio.

Review the timing of the pitch segments — where they start and end — to accurately reflect the full duration of each note.

These preparations will help a lot, but it is important that you realize that the resulting MIDI notes will not match the pitch segments exactly. See “What you see is not what you’ll necessarily get” below.

**Copying and pasting pitch segments**

After making the preparations listed above, copy and paste pitch segments as follows. This procedure assumes that you want the resulting MIDI notes to play in time with the original audio, so you will be pasting the MIDI data at the location where the first pitch segment begins:

1. Select the pitch segments with the Arrow tool (lasso cursor).
2. Choose *Copy* from the Edit menu.
3. To paste the resulting MIDI notes so that they play in time with the original audio, leave the pitch segments selected and choose *Set to Selection Bounds* from the Selection Information window’s Set To menu as shown below in Figure 61-16.

![Figure 61-16: Setting the selection to match the currently selected pitch segments.](image)
4 Click the name of the MIDI track you wish to paste into to create a time range selection in the destination track that matches the current selection start time (which now matches the start time of the first pitch segment you copied).

5 Choose Paste from the Edit menu.

What you see is not what you’ll necessarily get
When you copy pitch segments and paste them into a MIDI track, the resulting MIDI notes will likely not exactly match the original pitch segments. This is because Performer Lite interprets the pitch segments with respect to the waveform to create a MIDI performance that matches the audio as closely as possible.

To further refine the timing of the resulting MIDI notes, try quantizing them. Best results are often achieved by quantizing both attacks and releases of the MIDI notes.

ZTX PROCESSING PREFERENCES
In Preferences > Audio Options (Figure 27-5 on page 232), the Pitch and Time Stretch Options let you adjust the quality and speed of the ZTX processing. Try experimenting with different settings here for best results. You can change the settings on the fly at any time.

BACKGROUND PROCESSING
As soon as you OK the Transpose dialog, the selected soundbites (or pieces of soundbites, for a time-ruler selection) are replaced with new soundbites, which are analyzed and processed in the background as described in “Background Processing” on page 515.
CHAPTER 62  Spectral Effects

OVERVIEW
Performer Lite combines formant-corrected pitch shifting, standard pitch shifting, and time scaling to allow some rather surprising effects. The Spectral Effects command (Audio menu) allows you to shift the formants of a audio independently from its pitch. This effect lets you turn a female voice into a male one or vice versa. It also can be used more subtly, to make a soprano sound more like an alto while singing the same pitches, for instance. Spectral Effects can be applied to any pitched monophonic or polyphonic audio material.

THE SPECTRAL EFFECTS COMMAND
The Spectral Effects command lets you independently modify the pitch, formants, and tempo of selected soundbites (or parts of soundbites).

Figure 62-1: The Spectral Effects dialog (in the Audio menu) lets you transpose, time-scale, and gender-bend audio all in one operation. Just drag the globe to the desired position within the space, or type in values as desired. You can save favorite settings for future recall.

WHAT IS A FORMANT?
When you speak (or sing), there are two factors that combine to give your voice its sound. Your vocal cords vibrate at some frequency, and this determines the pitch of the sound. If your vocal cords could somehow vibrate in free space, they would have a buzzy, sawtooth-wave sound to them. The sound contains the fundamental frequency, as well as all of its harmonics, or overtones.

However, your vocal tract (mouth, tongue, and lips) also has a very significant effect on the sound of your voice. Depending on what you are saying, there are different resonant frequencies that are boosted, and other frequencies that are damped. These resonant frequencies are called formants. There are typically three or four formants, which
SPECTRAL EFFECTS

are constantly changing, depending on whether you are saying “ee,” or “oo,” or “ah,” et cetera. These formants are what determine the vowel or consonant sound that is perceived.

As you can see, the voice is very much like an analog synthesizer. The vocal cords are a sawtooth oscillator, whose output is fed through a series of filters. The words you are speaking determine the resonant frequencies of those filters, i.e., the formants.

WHAT DOES SPECTRAL EFFECTS DO?
The Spectral Effects command lets you change the pitch of a sound and its formants independently. Changing the pitch and the formants by the same amount is identical to Standard pitch shifting. Changing just the pitch is identical to formant-corrected pitch-shifting. Changing both by different amounts produces results that are, to say the least, even more interesting.

GENDER-BENDING
For example, if you leave pitch and tempo alone, and only change the formants by a half-step or two, you can make a soprano sound more like an alto, or make an adult have a more child-like voice. More dramatically, lower the pitch by an octave and the formants by a third or a fourth, and a female voice sounds remarkably like a male voice. This can be a very useful effect for creating a chorus of different sounding voices.

SPECIAL EFFECTS SUCH AS “CHIPMUNKING”
The Spectral Effects command also allows you to get more carried away. If you shift the formants up an octave without changing the pitch or the tempo, you get the famous “chipmunk” effect, without having to sing an octave lower! Obviously this isn’t something you want to do all the time, but it’s there if you need it.

ANY PITCHED AUDIO CAN BE USED
Spectral shifting works best on pitched sounds. (Note that the spoken voice falls within this category.) Our explanation this far has dealt with voice only, but the concept carries through to other sounds. Many sounds are formed by applying resonances to a pitched source. For example, the strings and fretting of a guitar determine the pitch, but the shape of the body gives it its resonances. You can use Spectral Effects to change the tone of a guitar recording without transposing it.

SPECTRAL EFFECTS DIALOG CONTROLS
As shown in Figure 62-1 on page 530, the Spectral Effects window has a 3-D controller that lets you see at one glance the effect you are applying to all three parameters: pitch, formants, and tempo. The position of the ball within the space provided shows the current setting. You can drag it up and down to change the pitch, left and right to change formants (left is lower), and front and back to change the tempo (front is slower). There are also boxes showing the current settings, and you may type in new values (or drag vertically in the text box to change them).

SPECTRAL EFFECTS PRESETS
The controls are useful for fine-tuning an effect, or trying something brand new, but in general you will probably want to use the presets. The preset menu has a number of built-in “factory” presets, with fairly descriptive names. Just choose one from the menu, and it will set the controls. You will probably want to try out some of these presets first to get a feeling for how the controls work.

If you come up with a new setting you’d like to use again, you may save it as a new preset. Just type in a name for it, and hit Save. If you want to delete a preset, select it from the menu, and then hit Delete. Presets are saved in your Preferences file.
APPLYING SPECTRAL EFFECTS TO AUDIO
Like Transpose and Scale Time, the Spectral Effects command works with all the different ways of selecting audio as summarized in “Selecting audio for processing” on page 513. Unlike these other commands, however, Spectral Effects is an Audio-only command; it has no effect on selected MIDI data. Also, unlike the other commands, it is not affected by the settings of the DSP preferences in the Soundbites window. Spectral Effects always processes all selected soundbites.
TIME SCALING
Time scaling means you can change the length of recorded digital audio without changing the frequency. As with pitch-shifting, there are limits as to how far you can shift and still have a musically useful result. The limits are not hard and fast, however. They depend on the audio, and on the intended use (e.g., soloed versus buried in a mix). Some audio sounds fine after its tempo has been halved or doubled, but most will start sounding a little unusual before such an extreme compression or expansion is reached.

THE SCALE TIME COMMAND
The Scale Time command (in the Region menu) now allows you to compress or expand soundbites. It also has an improved, more flexible interface.

The Scale Time dialog shows the current start and end times and duration of the selection. Below that are values for the new start and end times and duration. A button to the right lets you choose whether to display these times as measures, real time, or SMPTE time. If you know the new duration or end time, you can just type in either field and hit OK. If you’d rather enter the scale factor as a ratio or a percentage, you may do that as well, as shown in Figure 63-1.

The Scale Audio checkbox determines whether selected soundbites (or pieces of soundbites) should be time-scaled. If it is not checked, only the start times are changed. When scaling audio, you may not expand by a factor of more than 10 to 1, or compress by more than 1 to 10. (This is not much of a practical limitation — very few soundbites will sound good when stretched by a factor of 2, let alone 10.) If the Scale Audio checkbox is not checked, you may scale by up to a factor of 100.

SELECTING A REGION TO TIME SCALE
As with Transpose, the Scale Time command works with any of the methods of selection discussed in “Selecting audio for processing” on page 513, and it allows you to scale audio and MIDI data together. It can also be used to change the duration of a single soundbite, selected in the Sequence Editor or Soundbites list.

AUDIO AND TEMPO
See chapter 43, “Tempos and Audio” (page 394).

GRAPHICALLY TIME-SCALING AUDIO
See “Graphic time stretching of audio” on page 314.
Part 11

Bouncing & Mastering
CHAPTER 64  Bounce To Disk

OVERVIEW
Bounce to Disk lets you mix down an output (or outputs) to an audio file (or set of audio files). Original tracks are preserved and new audio files are created. A bounce operation can be done offline (faster than real-time) or in real-time (so you can listen to audio playback of your mix during the bounce process).

Bouncing is commonly used for creating a final mix of a project for mastering and delivery. Bouncing can also be used:

- to create a single, contiguous audio file out of a track composed of many smaller ones
- to temporarily bounce down multiple tracks to conserve CPU resources
- to export a project as multiple “stems” (separate audio files) for import into other audio apps

Since bouncing occurs in the digital realm, no noise or sonic degradation is introduced. You can bounce as many times as you like without introducing any artifacts as a result of bouncing.

When bouncing, you can choose to create a single resulting audio file or multiple separate files (stems) generated from multiple tracks or audio outputs in your system.

You can also use the Bounce to Disk feature to burn a CD, create a disk image or to export a movie with your Performer Lite sound track.

Bouncing to a CD or disk image (Mac only) ............... 542
Bouncing to a Movie ..................................... 547
Bouncing stems .......................................... 548

PREVIEWING
When bouncing, what you hear on each output when you play back the sequence is what you will get in the resulting mixdown of that output. To preview the results of the bounce, solo the tracks you wish to include in the bounce and play back the sequence.

BOUNCING TO DISK
Bouncing to disk is a simple three step process:

1  Select any portion of one or more audio tracks.

2  Choose Bounce to Disk from the File menu.

3  Adjust the settings in the Bounce to Disk dialog as desired (Figure 64-1 on page 536) and click OK.

You’ll then see the progress window shown below.

![Figure 64-1: The progress window for the Bounce command.](image)

The resulting audio file will sound exactly the same as the output of the track(s) you selected, including volume/pan automation, mute/solo settings, real time MAS, VST and AU effects, EQ and any other real time processing that is applied to the selected output. Here is a summary of what is included:
**Audible tracks**
All audible tracks that are routed to the output which is selected as the source of the bounce are included in the bounce. Muted tracks are not included. If you solo one or more tracks, only the soloed tracks are included in the bounced mix.

**Automation**
All enabled automation is played back and incorporated in the bounced mix.

**Inserts and sends**
All active inserts, including real-time plug-ins and hardware inserts, are applied to the bounced mix.

**Selection length**
The bounced mix will be the length of the selection you made before initiating Bounce to Disk.

**Time stamps**
Bounced material is automatically time stamped so that you can drag it into a track and place it at the same location as the original material.

**Delay compensation**
Bounce to Disk compensates for any bus and plug-in delays. If a bounced file is imported back into a session and aligned with the source mix, it will be correctly aligned with the original source mix.

**BOUNCE TO DISK SETTINGS**
The Bounce to Disk dialog (Figure 64-2) provides the following settings.

**File Format**
The File Format menu (Figure 64-2) lets you bounce to variety of file formats or destinations (Figure 64-3).

To use the project’s current file format and interleaved format, choose *Project Format*.

For details about bouncing to an audio CD or audio CD disk image, see “Bouncing to a CD or disk image (Mac only)” on page 542.

The Core Audio file formats, which are supplied by macOS, always create interleaved files.

*Figure 64-2: Performer Lite’s Bounce to Disk feature (File menu).*
For details about bouncing to the MP3 format, see “Bouncing to MP3” on page 541.

For details about bouncing to a QuickTime movie (on macOS), see “Bouncing to a Movie” on page 547.

Offline Bounce

When Offline Bounce is enabled, processing occurs faster than real time. Therefore, there is no playback during the bounce operation. Factors that affect the speed of offline bouncing include:

- **The speed of your computer’s CPU** — The faster your computer is, the faster the offline bounce.

- **The number of tracks selected** — If what you have selected can be played by your computer in real time, then offline bouncing will probably occur faster than real time. If you have selected more tracks than you can play at one time, then the operation may not occur faster than real time.

  - **Disk speed** — Potentially large amounts of audio data are pulled from your hard drive during offline bouncing. The performance of your storage device can therefore impact offline speed.

  - **Third-party plug-ins** — Some third-party plug-ins may slow down offline bounce operations due to their CPU requirements.

    - If you experience issues with third-party plug-ins during bounce operations, first try doing a real-time bounce (with Offline Bounce disabled).

Limitations of Offline Bounce

When using Offline Bounce, the following are not included in the resulting mixdown:

- Hardware inserts
- External audio sources monitored by aux tracks
- Any audio source that is synchronized externally

Real-time bounce (Offline bounce disabled)

When Offline Bounce is turned off, the bounce operation proceeds exactly as if it were playing back in real time. This offers several advantages:

- You can listen to the results of the bounce as it processes.
- You can include hardware inserts.

Channels

The Channels menu (Figure 64-2) lets you choose the channel format for the bounced material with four choices (Figure 64-4):
Mono (no attenuation)
Mono (Figure 64-4) creates a single monophonic audio file. Performer Lite simply sums the left and right channels of the outputs of the source tracks, so there is a possibility that the resulting mono mix might clip, even when the source material does not. If this is the case, undo the bounce operation, adjust the levels of the source tracks and bounce again.

Mono (with 3.5 dB attenuation)
When bouncing to mono, the with 3.5 dB attenuation option (Figure 64-4) preserves the level when bouncing a signal that is panned center. The attenuation compensates for the 3.5 dB boost you get from summing the left and right channels of a centered signal with equal-power panning.

Stereo
The Stereo option (Figure 64-4) creates a stereo file. If you’ve chosen a multi-channel bundle as the source, it will be folded down to stereo.

If an interleaved format is chosen, Stereo creates an interleaved stereo file. If a deinterleaved format is chosen, Stereo creates two mono audio files with the same file name, but with “.L” or “.R” appended to the end of the file names.

Same as Source
The Same as Source option (Figure 64-4) creates a file with the same channelization as the Source bundle (see “Source” below). The resulting file can be interleaved or deinterleaved, depending on the format chosen.

Match Track Format
The number of channels for a track’s output may not match the track’s channel format. For example, a mono track might be assigned to a stereo output, so the track output is stereo, even though the track format is mono. When you choose the Match Track Format option (Figure 64-4), the resulting bounce mix is folded down to match the track channel format, such that mono tracks will result in mono files, even if they are assigned to stereo outputs.

Sample Format
The Sample Format menu (Figure 64-2) lets you choose the bit depth for the bounced audio (Figure 64-5):

Supported fixed bit depths include 8, 16 or 24 bit integer. You can also choose 32 bit Floating Point, if the format you’ve chosen (Figure 64-3) supports this resolution. If not, this menu choice is grayed out.

Choose Project Default to use the current project sample format. If you choose 8 bits (a sample format not supported by Performer Lite for playback), the Import option below will force you to choose the Do not import setting.

Supported resolutions
8-bit resolution it typically applied to audio that will be used in multimedia and internet applications because it significantly reduces the size of the audio files, halving the bandwidth required to deliver the sound. When you are bouncing down to 8-bit audio, you may want to...
apply Performer Lite’s MasterWorks Compressor (or a third-party dynamics plug-in of your choice) to the mix to counteract the effect of halving the dynamic range that results from going to 8 bits.

16-bit resolution is the standard resolution for compact disc audio.

24-bit audio provides greater resolution and headroom and is used by many mastering systems.

32-bit floating point audio file resolution is an emerging standard used for high-end recording, mixing and mastering applications. Performer Lite’s mix engine employs 32-bit floating point precision throughout, as do other advanced digital audio workstation systems. If you plan to use the bounced material with Performer Lite or another system that supports 32-bit floating point processing, this option is a good way to preserve and carry over the floating point precision employed by these systems.

**Import**

The *Import* menu (Figure 64-2) lets you choose what to do with the audio files generated by the bounce operation. If you choose *Do not import*, the file will be created on the hard drive but it will not be imported into Performer Lite. Otherwise, you can import the audio file into the Soundbites list or into the current sequence as a new audio track. If you have chosen a format not supported by Performer Lite, you will not be allowed to choose either of these import options.

**Source**

There are two types of sources you can select to capture in a bounce: *Tracks* and *Outputs*. Multiple tracks and outputs can be selected, resulting in multiple mixdown files (to export stems, for example). Selecting an output captures the audio from that output in the resulting mixdown file. Selecting a track captures the audio from the track’s output.

When more than one source is selected, each resulting mixdown audio file is given a unique name as follows: the base name entered in the *File Name* field (Figure 64-2 on page 537), plus the name of the track or output appended to the end of the file name.

**Source tracks**

Disk tracks, instrument tracks and aux tracks appear in the Sequence Editor as possible sources. Master faders do not: choose their corresponding outputs instead. For instrument tracks, be sure their corresponding MIDI track is play-enabled during the bounce operation.

**Source outputs**

Any outputs or busses available in your project (in the Bundles window Outputs tab) are available as source outputs.

**External sources**

External audio sources, such as hardware synthesizers or outboard processors, can be included in real-time bounce operations. For offline bounces, record the external source to a disk track beforehand (because its real-time performance cannot be faithfully reproduced in the faster-than-realtime offline mixdown).

If an external source is being monitored through an aux track, make sure that the aux track (or the output it is assigned to) is selected as a source.

**File name**

In the *File Name* field (Figure 64-2), type in the desired name for the resulting audio files. If multiple files are generated (due to a deinterleaved stereo bounce operation), appropriate extensions will be appended to the end of each file name to indicate its channel (“.L”, “.R”, etc.)
**Destination**

The destination (Figure 64-2) displays the disk location for the resulting audio files created by the bounce operation. Click the Choose button to change it.

**Overwrite Existing Files**

Normally when you Bounce to Disk, Performer Lite generates a new file name — one that does not conflict with existing files on your disk. However, if you check the Overwrite Existing Files option (Figure 64-2), then Performer Lite will overwrite any file (or set of files for split stereo files) of the same name.

This option can be especially useful in the final stages of mastering. Suppose you have several sequences that go into making an album, where each sequence represents one track. You can then create a separate Performer Lite project that is the “album master” project, which includes the final bounce of each component track sequence (track). With the Overwrite Existing Files option unchecked, you would need to re-create the “album master” project each time you performed a bounce on any of the component track sequences, since the bounce results would go into new (different) files. However, if Overwrite Existing Files is checked, the existing files are overwritten, and the album master project file references will therefore remain in tact, as they will still point to the latest exported data with the same name (and file path).

If the “Import” option on page 540 is currently set to Add to sequence or Add to soundbites window, then the OverWrite Existing Files option is grayed out.

**BOUNCING TO MP3**

As shown in the menus in Figure 64-3 on page 538 and Figure 22-17 on page 207, Performer Lite can export audio to the MP3 audio file format, either using the Bounce to Disk command or the Export Selected Soundbites command in the Soundbites list mini-menu.

**MP3 export options**

To bounce or export an MP3, choose the L.A.M.E. audio export: MP3 format, as shown in Figure 64-3 and Figure 22-17 on page 207. When you choose this format, you will see the following MP3 export options:

![Figure 64-6: The MP3 export options.](image)

If you don’t have any specific needs or requirements for your MP3 file, the default settings in the MP3 export options window will give you very good results. If you have specific needs, the export options give you the following choices:

**Channels:** The choices here are Mono, Stereo or Auto. This option lets you force the MP3 to be either Mono or Stereo. If you want the MP3 to automatically match the channel format (mono or stereo) of the source material, use the Auto setting. Mono files are about half the size of stereo files. Mono is appropriate if you don’t have stereo speakers or if your audio files are monaural. If you’ll be listening to your MP3 files using your stereo system, choose Stereo or Auto.

**Stereo mode:** The two choices here are Normal and Joint Stereo. In Normal mode, your MP3 files contain one track for the right stereo channel and
one track for the left. In many cases, the two channels contain related information. In Joint Stereo mode, one channel carries the information that is identical on both channels, and the other channel carries the unique information. At bit rates of 128 kbps and below, this can improve the sound quality of your converted audio. Generally, Joint Stereo mode is the best choice.

**Output Sample Rate:** The choices here are *Auto*, and a list of specific bit rates. The best choice is usually the *Auto* setting, which makes the MP3 match the source material sample rate automatically. The *sample rate* is the number of times per second that the music waveforms are captured digitally. The higher the sample rate, the higher the quality and the larger the file size. Be sure to choose a sample rate that is no higher than the rate used to originally store the music, or you'll waste disk space and streaming bandwidth. CD quality, for example, is 44.1 kHz, so choosing a higher rate when you’re encoding from a CD is unnecessary.

**Encoding mode:** This option lets you specify the bit rate (number of bits per second). This is an important setting because it has a high degree of impact on both the file size and quality of the sound. The four choices are summarized below:

<table>
<thead>
<tr>
<th>Encoding mode</th>
<th>What it does</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Bit Rate (VBR) Standard</td>
<td>Varies the bit rate as needed, depending on the material.</td>
<td>In general, you’ll get the best results with this option (the best sound and the smallest file).</td>
</tr>
<tr>
<td>Variable Bit Rate (VBR) Fast</td>
<td>Same as above, except that the encoding process will be faster.</td>
<td>The results will still be good, but perhaps not quite as good as the standard VBR above.</td>
</tr>
<tr>
<td>Average Bit Rate</td>
<td>The bit rate is still variable, but the encoder restricts the overall average bit rate of the entire file to the specific value chosen in the Bit Rate menu.</td>
<td>Use this encoding method if you need to restrict the file size or overall bandwidth.</td>
</tr>
<tr>
<td>Constant Bit Rate</td>
<td>Forces the same bit rate throughout the file, regardless of the material.</td>
<td>This gives you the most control over the file size and streaming bandwidth.</td>
</tr>
</tbody>
</table>

**VBR (variable bit rate) quality:** This option appears if you’ve chosen one of the two VBR encoding modes above. If so, this option lets you control the quality of VBR encoding on a scale from 10 (good) to 100 (best).

**Bit Rate:** This option appears if you’ve chosen either the *average* or *constant* bit rate encoding modes above. If so, this option lets you specify the desired bit rate in kilo bits per second (kbps). The range is from 16 kbps (lowest quality but smallest file size) to 320 kbps (best quality but largest file size). For internet distribution of reasonably high-quality music, 128-160 kbps are common bit rates.

**Filter frequencies below 10 hz:** Humans can’t hear frequencies below 10 hertz (cycles per second). But these inaudible frequencies can unnecessarily increase the file size and adversely affect quality, so you’ll get better results when these frequencies are filtered out.

**BOUNCING TO A CD OR DISK IMAGE (MAC ONLY)**

The Bounce to Disk window lets you bounce directly to an audio CD (or and audio CD disk image) in one convenient operation. This feature can be used to burn a quick reference CD for one track or to master a complex, full-length CD with many tracks.

**Preparing material for a multi-track CD**

If you are creating a CD with just one track — perhaps as a quick reference disc to play in the car — then all you need to do is select the material you wish to “bounce and burn”.

If you are going to create a CD with multiple tracks, however, you may want to assemble them together into a separate Performer Lite project that serves as your “CD master” project. This project can be very simple: one stereo track, with the
desired gap between each track. Here is a suggested quick way to assemble a CD master sequence:

1 Bounce each song to disk to create a master stereo mix for each song.

2 Create a new Performer Lite project with one stereo track.

3 Select all your master stereo mix audio files and drag them together into the new project sequence while holding the Control/Win key. Doing so places them end to end with no gaps.

4 Choose Edit menu> Select All and then choose Region menu> Set Gap Between Soundbites to set the desired gap between the soundbites. (Note that this command does not place a gap in front of the very first audio file at the beginning of the sequence.)

This procedure produces a typical CD with individual tracks and a gap between them. You’ll learn more about positioning track start times, applying crossfades, if desired, and other additional CD mastering techniques later in this chapter.

If you are likely to continue making changes to the material on the CD as you refine it, be sure to enable the Overwrite Existing Files option (Figure 64-2) when bouncing each song to disk. This will maintain the link between the bounced song files and the master CD project you’ve created. For a further explanation, see “Overwrite Existing Files” on page 541.

The bounce and burn procedure
To bounce and burn an audio CD:

1 Make sure the tracks you wish to include are assigned to the same output bundle.

2 Make a selection over all the material you wish to include on the CD.

3 Choose File menu> Bounce to Disk.

4 Choose Burn Audio CD from the Format menu:

5 See “Base CD Tracks on” on page 544 and “CD Text” on page 545 for further information about these two audio CD burning options.

6 After you’ve set the CD burning options as desired, click OK to initiate the bounce and burn.

7 Next, you’ll see the macOS “burn disc” dialog:

8 Insert a blank disc and click Burn.

CD track info panels
When you first choose the Burn Audio CD option (Figure 64-7), you will see shaded areas in the Sequence Editor (behind the Bounce to Disk window), as shown in Figure 64-8. These shaded
areas indicate the gaps between tracks. You will also see a CD track info panel at the beginning of each track (Figure 64-8) to visually indicate where the track boundaries will occur on the audio CD. Each info panel displays the CD track’s name, pre-gap, start time and duration.

**Base CD Tracks on**
In the Bounce to Disk window, the *Base CD Track On* menu (Figure 64-7) determines where the start of each track will occur on the resulting audio CD. This menu provides three choices: *Soundbites*, *Markers*, or *Soundbites and Markers*.

**Soundbites**
In *Soundbite* mode (Figure 64-7), a CD track start will be placed at the beginning of each soundbite encountered in the selection, as long as it is not connected to the previous soundbite with a crossfade. Using crossfades allows you to “stitch together” several soundbites into a single track.

**Markers**
In *Markers* mode (Figure 64-7), a CD track start will be placed at each marker encountered in the selection.

If you have a complex sequence in which the soundbite boundaries have nothing to do with how you want the audio to be divided into tracks, enter a marker at each point where a track should begin and use *Markers* mode. A new track will begin at each marker location, and the soundbite boundaries will be ignored.

---

*Figure 64-8: When you choose Burn Audio CD or Audio CD Disk Image from the Bounce to Disk window Format menu (Figure 64-7)*
**Soundbites and Markers**

In *Soundbites and Markers* mode (Figure 64-7), a CD track start will be placed at each soundbite and marker encountered in the selection, as long as the soundbites are not connected to the previous soundbite with a cross fade.

Suppose you have two or more soundbites that you have faded into one another, but you want them to show up as separate tracks. Simply add a marker where you want the new CD track to begin, and select *Soundbites and Markers* mode.

**Track Pre-gap**

A subtle yet important feature of an audio CD is the notion of *pre-gap*. This is audio that plays before a track begins, but it is not part of the previous track. For example, you could have one track that ends with some echo spill-over, creating a short period of additional ambient noise, and then the next track begins. You might not want that short period of ambient noise to be part of either the previous song or the next song. This material can be categorized as pre-gap. In many audio CD players, the track number will increment while the pre-gap is being played, and you will see negative times in the “time remaining” display to indicate that the next track has yet to begin.

**How Performer Lite determines track pre-gap**

If a Soundbite was used to determine a CD track start, then the pre-gap amount is simply the space between the last soundbite’s end and the new soundbite. (So, if you use *Region menu > Set Gap Between Soundbites*, you will notice the pre-gap in the track boundary display is the same as you just applied.)

If a marker is used to determine a CD track start, the default pre-gap is zero (since markers are used in situations where the audio is continuous). You can override the default pre-gap time for a marker (or more than one marker) by selecting them in the Markers window, and choosing *Set Marker/Streamer options*. In the dialog that appears, choose *Custom pre-gap for CD burn* and enter the pre-gap amount (as minutes:seconds: hundredths of a second).

**CD Text**

Although the original audio CD specification did not allow for the inclusion of track names or other information in the data on the disk, a mechanism known as *CD Text* has been developed over the years. It allows for the embedding of some text data on the CD, most notably track names.

If you check the *Save Titles as CD Text* box in the Bounce to Disk dialog (Figure 64-7 on page 543), the track titles will be added to the burned disc. Each track’s name is taken from the soundbite or marker used to determine its start time. If the track start time is being specified by the soundbite start, the track name will be the name of the soundbite. Similarly, if a marker is used to determine the track start, the marker name is used. These names are displayed in the track info panels (Figure 64-8 on page 544).
iTunes does not automatically read in track names from CD Text. (With commercially available CDs, the track names come from an online database rather than the disc itself.) Fortunately, however, there are free scripts available on the internet that can import your audio CD track names into iTunes.

Audio CD Disk Images
Along with the Burn Audio CD choice in the Bounce to Disk dialog, there is also an Audio CD Disk Image option in the Format menu (Figure 64-7 on page 543) that lets you save the bounce as an image on your hard drive to be burned to a CD at a later time. This is useful when you want to burn more than one CD or to simply save a snapshot of your work.

Image files have the extension acdi (Audio CD Image). Double clicking an acdi file in the Finder or Explorer will launch Performer Lite and present the burn dialog.

“Enhanced” CDs
You can use Performer Lite’s CD burning features in combination with macOS X’s Disk Utility to create an Enhanced CD: a hybrid audio CD and data disc. Insert it into a CD player and it plays your sequence as an audio CD. Insert it into a Mac and it mounts on the desktop as a data CD volume with a backup copy of your Performer Lite project data files.

The audio portion of the CD must be burned first by Performer Lite, followed by the data portion by Disk Utility.

1 Choose File menu > Bounce To Disk and choose the desired settings for your CD burn. Click OK to begin the bounce.

2 When the bounce finishes and you are prompted to insert a CD and configure the burn options, expand the dialog to show all settings and then check the Leave disc appendable box.

3 Click Burn.

4 When the burn finishes, you will have an audio CD. However, the disc is not closed so it is still possible to add further disk images to it.

5 Launch Disk Utility (found in /Applications/Utilities).

6 Choose File menu > New > Disk Image from Folder.

7 Select the folder containing the data you wish to burn to the CD and click Image.

8 Specify where the image file will be saved on your hard drive and choose a name for it. Make sure the Image Format menu is set to “compressed”. Click Save.

9 The image file (ending in .dmg) will be created on your hard drive. This may take some time, as the data must be copied into the image file.

10 After the .dmg file is created, it will appear in the list along the left of the window. Select it and choose Images menu > Burn.
In the Burn Settings dialog, uncheck Leave disc appendable.

Press the Burn button and insert the CD you burned with Performer Lite.

When the burn finishes and your CD is complete, it will mount on the Mac desktop as two CDs: one audio and one data.

If you would like to add more than one data session to the disc, keep the Leave disc appendable box checked in Step 11, then repeat Step 5 through Step 9 as many times as you would like. When you add the final session, uncheck the Leave disc appendable.

BOUNCING TO A MOVIE
You can bounce an audio output bundle (mono or stereo), together with video, to a movie file. This allows you to export a complete movie from Performer Lite in one easy operation, complete with a sound track that you’ve created in Performer Lite. To do so:

1 Open a project that has a sequence with a movie.

2 Assign the audio tracks you wish to include in the movie to the same audio output bundle. It can be any channel format (mono or stereo).

3 Select the audio tracks over the range you wish to bounce in the usual fashion.

4 Choose File menu> Bounce to Disk.

5 Choose QuickTime Export: Movie (Mac) or Windows Video Exporter: H.264 MP4 (Windows) from the Format menu.

Choose the appropriate output bundle from the Source menu, and specify a destination folder as usual.

If you wish to replace the existing movie, check the Overwrite Existing Files option.

Click OK.

Mac only: The QuickTime export options appear. If you are running MacOS 10.7 or later, set Include film scoring events track as desired.

Click OK.

Mac only: Exported audio tracks are encoded as Apple AAC in the sample rate of the Performer Lite project. Apple’s AAC encoder only supports sample rates up to 48 kHz, so Performer Lite will downsample, if necessary, during the bounce operation.

Video black
If the audio starts before the source video begins or extends past where the source video ends, Performer Lite appends the movie with video black so that the resulting movie matches the length of the audio.

Include film scoring events track
Under MacOS 10.7 or later, this option lets you include film scoring events as part of the video.
BOUNCING STEMS
To bounce stems, the basic procedure is as follows:

1 Preview your mix to make sure all tracks to be mixed down are unmuted.

2 Select All.

3 Choose Bounce to Disk.

4 For the source options, choose both Tracks and Outputs.

5 Select each track for which you wish to create a stem file.

6 If you wish to include a full stereo mix as part of your stem export, select your primary output pair (e.g. Main Outs).

7 Enter an appropriate file name as a base name for all the stems.

8 Make the other settings in the Bounce to Disk dialog as desired.

9 Click OK.
CHAPTER 65  Mastering

OVERVIEW
Mastering is the process of preparing your mix for final delivery on audio compact disc, in MP3 format, or any other delivery medium of your choice. This chapter discusses several topics related to mastering that are specific to Performer Lite. However, there is much more to know about the art of mastering and the many engineering techniques involved. The internet is an excellent resource for further information. As you learn more about general mastering principles, keep in mind that Performer Lite provides all of the tools you need to achieve even the most advanced mastering objectives.

Overview .......................................................... 549
Master fader ....................................................... 549
Allocating processing power ............................... 549
Real-time bounce to disk ................................. 550
Rendering audio ................................................. 551
Bounce to disk .................................................... 552
Delivery ............................................................... 552

MASTER FADE
The master fader is the most important element in your mix. If you are not using a master fader on your mix and are encountering distortion, chances are, you are overloading the mix bus. The solution for this is very simple. Create a master fader and assign its output to the same output as the rest of your faders. This allows you to pull down the overall level of your mix to avoid distortion.

MasterWorks Limiter
The next step is to apply the MasterWorks Limiter to the master fader to control the overall average level of your mix. For complete details, see “MasterWorks Limiter” on page 39 in the DP Plug-in Guide. Here is a brief overview of how to get started:

1 Set the master fader at unity gain (0.0 dB).
2 Lower the MasterWorks Limiter ceiling to -0.5dB.
3 Set the MasterWorks look-ahead to 1ms.
4 Set the MasterWorks release to 0.10ms.
5 Be sure dithering is on.
6 Press play in Performer Lite.
7 Gradually bring the threshold down until you see gentle gain reduction in the area of –2 to –4dB. You may have to use the input gain to bring the mix into the range of the limiter.

At this point, you have accomplished a gentle normalization of your audio with dithering. Experiment with the threshold control to bring up the overall average level of your mix.

ALLOCATING PROCESSING POWER
When using a native audio system such as MOTU Audio System, you may find it necessary to juggle buffer settings depending on what you wish to accomplish. When finalizing a mix and then mastering it, your goal should be to maximize the amount of processing power available for real time MOTU Audio System effects. One way to do this is to raise the buffer settings for your audio system. 1024 is a good setting at which to mix.

Higher buffer settings free up more processing power for mixing at the expense of increased input monitoring latency. This may or may not be an issue for you, depending on how you go about mixing and mastering your project. In many cases, input monitoring latency only comes into play at the
beginning of a recording project when you are first laying down tracks. While monitoring live input during recording, you can reduce the buffer size to eliminate monitoring delay and afterwards raise it again for increased processing power during mixing and mastering.

While mastering, however, your mix may include real-time elements (software synths or MIDI triggered effects, for example) that require that you maintain low buffer settings. In this case, you need to do the best you can to balance your system resources with the demands of these real-time elements of your mix.

If your project contains only audio and MIDI assigned to virtual instruments (e.g. no real-time input from aux tracks from external sources), then you are ready to bounce your project to disk. If your project contains any external real-time sources (MIDI tracks assigned to hardware MIDI Instruments, external processing, virtual instruments, etc.) you have two strategies for finishing your mix:

- Real-time bounce to disk
- Rendering

These techniques are discussed in the next few sections.

**REAL-TIME BOUNCE TO DISK**

Let’s say you have a fairly complex project with MIDI tracks submixed externally and their combined audio signal entering Performer Lite via an aux track. You may also have some external virtual instruments (like Propellerhead’s Reason) coming into some aux tracks as well. If your mix sounds good at this point, you can perform a real time bounce to disk as follows:

1. Reassign the outputs of all your audio and aux tracks to an unused stereo bus. You may have to create one if one does not exist. It might help to use an audio bundle and give it a name such as ‘my mix bus’.

2. Create a new stereo audio track and set the input of the audio track to the newly created bus (‘my mix bus’). You may also set the output of your audio track to your original monitor outs so you can monitor the progress.

3. One final touch: rename the new audio track ‘final mix’. When Performer Lite writes the new file to disk, the file will assume the track name.

**External virtual instrument compensation**

If you are using a virtual instrument that runs as a stand-alone application alongside Performer Lite (like Propellerhead’s Reason), you may wish to compensate for latency by pushing the MIDI tracks assigned to that instrument ahead in time. This can easily be accomplished with the non-destructive Time Shift MIDI plug-in. If your virtual instrument MIDI track has data starting at 1|1|000, you can shift your entire project later by one measure to avoid having the first note of that track disappear.

For virtual instrument plug-ins, Performer Lite provides automatic latency compensation.

**External effects compensation**

Externally processed tracks can also benefit from latency compensation. For example, you may decide to send a drum submix out to a vintage compressor and feed the result back into Performer Lite’s mixing board. If the input buffers are set at 256 samples, for example, you can use the Shift command (Edit menu) to advance your drum tracks by 256 samples.
**RENDERING AUDIO**

Another strategy for finishing your mix is to render all elements of your mix as audio. This procedure requires more disk space, but these commodities are quite affordable these days. One strong advantage of this approach is complete portability. For example, you may open up the project in the future and find that you don’t have access to the same outboard processing gear or virtual instruments. If this is a concern for you, it may be a good idea to render these elements. After all the elements of your mix are rendered as audio, then you can perform a normal, non-real time bounce to disk.

**Rendering software MIDI instruments**

In most cases, Bounce to Disk can be used to render your virtual instruments as audio. See “Source tracks” on page 540 for more details.

**Rendering external MIDI instruments**

Recording the audio output of MIDI modules as audio exactly preserves the performance of that instrument.

Some MIDI modules include digital outputs which you may want to take advantage of. If you own many instruments with digital outputs, it may be a good idea to consider a MOTU 308 digital interface. In addition to functioning as a digital patchbay, it allows you to keep all your digital gear wired directly into Performer Lite. This means you can record the output of a sound module without disconnecting the analog outputs.

If you use multiple MIDI modules, chances are good that you are already using a mixer to sum the outputs of these devices. You can render the entire MIDI submix by recording the output of the mixer. Another method is to use an alternative set of outputs or busses to avoid re-patching the outputs of your mixer.

Under some circumstances, you may want to record the outputs of your MIDI tracks individually for more flexibility when mixing in Performer Lite. If you find yourself doing this frequently, you may want to dedicate a set of sends to inputs on your audio interface. Another technique is to employ a patchbay so you can quickly route signals from the mixer to the audio interface. This also eliminates unnecessary additional gain stages between the output of your MIDI module and the input of your audio interface.

Recording individual MIDI tracks presents some opportunities to enhance your mix. You may own an outboard processor that has a certain ‘magic’. Recording individual MIDI tracks through this processor one at a time effectively multiplies the number of instances that you have of this processor.

**Rendering external processors**

Recording the output of a signal processor does not require any latency compensation as discussed earlier because it does not involve real-time monitoring. This is another advantage to rendering, as it leaves you with one less thing to worry about.

If you feed a Performer Lite disk track to an external signal processor and then feed the processor output back into Performer Lite as a live input, you can precisely compensate for the delay. See “External effects compensation” on page 550.

**Rendering MIDI triggered effects**

In a bounce to disk operation, MIDI elements are ignored because bouncing is not a real time process. If you used MIDI triggering of effects in Performer Lite, such as with MasterWorks Gate or Multimode Filter, you will need to capture the real time output of that effect. Create a new audio track and set the output of the original track to a bus assigned to the input of the new track. Lower the
hardware buffer setting and record the result. Be sure to mute the original track before you bounce to disk.

**BOUNCE TO DISK**
Now that you have rendered all elements of your mix to audio tracks, you can now touch up your final mix and bounce to disk. See chapter 64, “Bounce To Disk” (page 536) for complete details. Be sure the *Add to soundbites window* option is enabled. Name your mix something memorable, such as ‘final mix’.

**DELIVERY**
Performer Lite supports a variety of native file formats: interleaved and deinterleaved Broadcast WAVE and AIFF files at 16-bit, 24-bit, or 32-bit floating point. When you need to export your mix out of Performer Lite, open the Soundbites list, select your ‘final mix’ file and choose *Export Selected Soundbites* from the mini-menu. You can export the mix in all of Performer Lite’s supported formats and more.

**Create an MP3 file**
Use Performer Lite’s Bounce feature or the *Export Selected Soundbites* feature mentioned above to export directly to MP3 file format.
Part 12

Synchronization
CHAPTER 66  Receive Sync

OVERVIEW
The Receive Sync command (Setup menu) allows you to ‘slave’ Performer Lite to a wide variety of ‘master’ timing sources. Performer Lite supports all standard MIDI synchronization formats, including MIDI Time Code and MIDI beat clocks with Song Position Pointer data for synchronization with drum machines, hardware sequencers, and other MIDI devices. With a SMPTE-to-MIDI converter such as MOTU’s MIDI Express XT, Performer Lite can sync to audio tape, video, or film, ensuring that events in your sequence happen at exactly the same spot on tape or film every time. Performer Lite also supports sample-accurate digital audio synchronization with devices that support the ADAT and Tascam sample-accurate digital audio synchronization protocols. Performer Lite also has a Tap Tempo feature for synchronizing to prerecorded music, conducting a sequence as it plays back, or simply recording a tempo map in real time.

RECEIVE SYNC BASICS
Performer Lite supports all standard modes of synchronization: Sample Accurate Sync, MIDI Time Code, MIDI Beat Clocks, and Tap Tempo. These modes are selected in the Receive Sync settings window. When MIDI Beat Clock or Tap Tempo is selected, other parameters appear in the Receive Sync settings window and must be set correctly; the MIDI Time Code and Sample Accurate modes have no other parameters (except for the frame rate). The mode you use depends on the equipment to which you are synchronizing.

BASIC TYPES OF SYNC
The following section describes the common forms of synchronization and the corresponding modes in Performer Lite.

Sample Accurate
Sample-accurate synchronization is the tightest possible synchronization between two devices. It offers the strong advantage of exactly preserving the phase relationship between digital audio tracks in a multitrack project, even when they are not transferred at the same time. For example, if you transfer 8 tracks from the ADAT into Performer Lite, sample accurate sync ensures that they will maintain their exact phase relationship to one another, even if you record them into Performer Lite one at a time.

SMPTE time code
SMPTE time code is an international standard that was developed for film and video work but has proven to be very useful in normal audio work as well. This is an absolute time code, expressing hours, minutes, seconds and divisions of the
second in digital form. It can be recorded on tape or film and read by a special device to convert it to MIDI.

Since SMPTE has no intrinsic tempo information, the sequencer or device converting SMPTE to MIDI must generate its own tempo. Performer Lite’s flexible tempo map and frame time display make it ideal for work with SMPTE time code. Because of its accuracy and wide-spread acceptance, SMPTE is the most powerful of the time code formats.

Depending on your converter, you can use the MIDI Beat Clock or MIDI Time Code modes. MIDI Time Code is the easiest and most accurate mode. MIDI Time Code allows the use of Performer Lite’s tempo maps, and is far superior to the MIDI Beat Clocks mode.

In addition, MOTU Audio interfaces can slave directly to SMPTE timecode – consult your MOTU Audio interface user guide.

**MIDI beat clocks**

*MIDI Beat Clocks* are produced by most MIDI compatible drum machines and sequencers, and by some synthesizers (particularly those with built-in sequencers).

MIDI beat clocks are transmitted 24 times a beat. If the master device changes tempo, the MIDI beat clocks slow down or speed up accordingly; any slave device will follow this tempo change. Most devices that generate MIDI beat clocks also send Start, Stop, and Continue messages; slave devices will start playback, pause, rewind, or play from the current location according to the combination of these messages received. In addition, many devices send Song Position Pointer data. These messages set the current location for playback, much like setting the Counter in Performer Lite.

To sync Performer Lite to devices using these MIDI messages, use the MIDI Beat Clock mode in the Receive Sync settings window.

**Tap Tempo**

*Tap Tempo* is Performer Lite’s real-time tempo control facility. This form of synchronization slaves Performer Lite to a ‘tap’ entered from your MIDI controller. Performer Lite receives a MIDI event for each tap and computes a tempo based on the current meter, the click value, and each event’s distance in time from the previous event. Any tempo information in the sequence is ignored while Performer Lite is slaved to Tap Tempo. Tap Tempo supports both recording and playback, so your tap can conduct or be recorded into any sequence, empty or finished. When you record in Tap Tempo, each tap becomes a tempo event in the Conductor Track. Even if you have a minimal MIDI setup, you have everything you need to use Tap Tempo synchronization.

**USING RECEIVE SYNC**

The following sections explain the Receive Sync settings (opened from the Setup menu).

**CHOOSING A SMPTE FRAME FORMAT**

If you are slaving to any sync type that involves SMPTE time code, or if the work you are doing in Performer Lite requires that you reference SMPTE time code, be sure to choose the correct SMPTE frame format at the top of the Receive Sync settings window as shown below in Figure 66-1. This setting is the same setting as the Frame Rate selection in the Setup menu.

All standard SMPTE frame rates are provided: 23.976, 24, 25, 29.97 drop, 29.97 non-drop, and 30 fps.
CHOOSING A SMPTE START FRAME
When slaving Performer Lite to SMPTE Time Code (via MTC or LTC), you need to specify a SMPTE start time for the sequence. This is the frame location at which the sequence begins to play. See “Setting the start time” on page 90.

SYNC TO PORT MENU
The Sync to Port menu lets you choose the source from which Performer Lite will receive MIDI timing information (beat clocks, MIDI Time Code, etc.)

Any device in your MIDI device configuration (Setup menu > Bundles > MIDI Devices tab) that has the MIDI Beat Clock or MIDI Time Code attribute checked will appear in this menu. Choose Any Port to allow Performer Lite to slave to any timecode that it receives, regardless of its source.

RECORD WHILE STILL-FRAMED
The Receive Sync preferences has an option called Record while still-framed. Without this option checked, Performer Lite drops out of record as soon as you stop the tape after a record pass while slaved to tape; Performer Lite will not record again until you press the Record button. This prevents unintentional recording while cuing and accidental loss of Undo Record. When this option is checked, Performer Lite stays in record when you stop the tape so that you can record a hit while parked on a frame. This is particularly useful when frame-advancing while slaved to a VITC-compatible synchronizer such as a MOTU Video Timepiece or Digital Timepiece, which provides accurate frame-advancing. Unless you are recording while frame-advancing, we recommend that you leave this option unchecked.
**SAMPLE-ACCURATE SYNC**

![Sample-accurate sync settings. Notice that there is no 'Sync to Port' setting for sample-accurate sync, since Performer Lite directly accesses the audio hardware for sample address information.](image)

If you are using Performer Lite with a MOTU PCI-424 system, MOTU 828mkII, or any other sample-accurate audio interface, Performer Lite can achieve sample-accurate synchronization with ADATs or any external recording device that supports sample-accurate synchronization. This allows you to transfer digital audio — entirely in the digital domain — between Performer Lite and an ADAT (or similar ADAT-compatible digital audio recorder) via ADAT optical cables (or other digital audio format) with single-sample accuracy. For example, if you record some audio from the ADAT into Performer Lite, and then send it back to the ADAT, it will be placed at exactly the same location — to the very sample — from where it originated (assuming you don’t move it while it’s in Performer Lite). You could transfer audio back and forth digitally between Performer Lite and the other device as many times as you like, and the audio will not drift even one sample earlier or later, no matter how many times it is transferred between the two devices.

Sample-accurate transfers like this can also be achieved with Tascam family tape decks (such as the DA-38, DA-88, or DA-98) via a 2408mk3/PCI-424 system. A MOTU Digital Timepiece is required.

**Digital audio I/O is required**

Sample-accurate digital transfers require a digital audio interface such as a MOTU 828x, which supports sample-accurate sync. MOTU’s audio interfaces provide a variety of digital audio formats, including 8-channel ADAT optical, AES/EBU and S/PDIF. For details, visit www.motu.com/products.

**MOTU PCI-424/FireWire hardware setup**

If you have MOTU PCI-424 or FireWire Audio system, refer to your hardware manual for specific details about how to connect your system for sample-accurate sync to an ADAT or Tascam tape deck.

**Performer Lite settings**

For sample-accurate sync, choose the Sample-accurate sync setting as shown above in Figure 66-4. No additional sync settings are required. Notice that the Sync to Port setting disappears when you choose Sample-accurate sync. This is because Performer Lite accesses the sample address information directly in the hardware (via the hardware driver, e.g. the PCI-424 driver for the MOTU 2408mk3, or the MOTU FireWire Audio driver for the MOTU 828mkII FireWire audio interface).

**Hardware driver settings**

Choose Setup menu>Configure Audio System>Configure Hardware Driver and make the appropriate clock source setting for the hardware you are using. For the 2408mk3, choose PCI-424: ADAT from the Clock Source menu as shown below.
Transport control from Performer Lite via MMC
If you have a MIDI Timepiece AV or other MMC-capable ADAT synchronizer and would like to control everything from Performer Lite’s transport controls via MMC, open the MMC window and enable MMC. This puts Performer Lite in Slave to External Sync mode. Make sure your MIDI Timepiece AV (or other MMC synchronizer) is on-line.

Optical input/output settings
To transfer audio digitally from another device to Performer Lite, be sure to choose a digital input for the track you will be recording into. Conversely, when you want to transfer audio from Performer Lite to the other device, make sure you’ve chosen digital output assignment of the track you want to transfer.

MTC (MIDI TIME CODE)
Use the MTC mode when you are slaving Performer Lite to SMPTE time code via a converter that supports MTC (MIDI Time Code).

SMPTE time code (an analog audio signal) is fed from a master source such as an audio tape recorder, video tape recorder, or SMPTE generator into a SMPTE-to-MIDI converter such as a MOTU MIDI Express XT, which translates the SMPTE time code into MIDI timing information. This MIDI timing information is produced in the form of MIDI time code (MTC), an industry standard format.

MTC sync mode is a simple and direct way to slave Performer Lite to an external source generating SMPTE time code. Performer Lite is able to lock to the frame times of the master, insuring precise synchronization between devices. In addition, Performer Lite remains under its own tempo control, allowing you to program sophisticated tempo maps while slaved to time code.

To use MTC sync mode, you must have a SMPTE-to-MIDI converter that supports MTC, such as a MIDI Express XT from MOTU.

There are no special options to select in the Receive Sync settings window: when in MTC mode, Performer Lite simply responds to timing data directly.
After Performer Lite is locked to the master, there is no need to use Performer Lite’s main transport controls unless you wish to record. Performer Lite will start, stop and locate under control of the master. Also upon lockup, if Click is enabled, Performer Lite will click in the meter specified at 1/1|000 or will default to 4/4.

You can put Performer Lite into play or record either before or after you start rolling tape. In either case, Performer Lite will lock up quickly.

Using MTC sync mode
After you have chosen MTC mode, slave Performer Lite as explained in “Tap Tempo” on page 560.

MIDI BEAT CLOCKS

This is a standard form of synchronization between two MIDI devices. When the MIDI Beat Clocks option is selected, Performer Lite can sync to a master device that is generating MIDI clock signals. If you want to slave Performer Lite using a drum machine, external sequencer or other MIDI device as master, use this mode. This mode may also be used with a SMPTE converter that generates its own tempo map. In MIDI Beat Clocks mode, Performer Lite’s tempo will match that of the master device; Performer Lite’s tempo features are disabled.

Implementations of MIDI have evolved over the years. As a result, not all devices transmit and send MIDI clock signals in the same way. Performer Lite provides several options for maximum synchronization compatibility with your master device:

24 clocks per metronome click/
24 clocks per quarter note
Some manufacturers make devices which send 24 clock signals per beat (one click of the device’s metronome) instead of the standard 24 clocks per quarter note. This method is very useful when there are meters which do not use the quarter note as the beat unit: 3/8, 5/16, etc. In 6/8, for example, there might be a metronome click every three eighth notes; in 4/1, the metronome would click once every whole note. If you were using a less common meter such as 5/32 or 3/16 + 4/16, using the quarter note as the timing base would not be very useful. Instead, use the 24 clocks per metronome click option.

Start on any clock
When this option is checked, Performer Lite will automatically start if it receives a time clock even if no start or continue command was received. This option is necessary when using some early MIDI devices which don’t send start or continue commands, only timing clocks.

First clock is time 1
When this option is checked, Performer Lite interprets the first MIDI clock signal it receives as the second timing clock of the sequence, 1/24th of a beat after the beginning. Devices manufactured recently send the first clock signal (time 0) after the start command for the sequence. Some earlier devices assume the start command to be the first clock signal. The first clock signal they send would be 1/24th of a beat after the beginning. If you are using one of these devices, you should check this option.
Since manufacturers rarely explain this aspect in their documentation, you may not know if your device behaves this way. The best way to find out is to experiment: set the metronome to the slowest possible tempo, play both devices (with Performer Lite as slave) and listen for discrepancies in attacks and beat alignment. The difference of 1/24th of a beat is very audible at a slow tempo. If Performer Lite seems slightly behind the master device, try checking this option.

**Default beat clock settings**
The default settings reflect the most commonly used MIDI standards. It is best to set them this way before choosing to alter them:

- 24 clocks per quarter note
- start on any clock: unchecked
- first clock is time 1: unchecked

**Using MIDI Beat Clocks mode**
After you have made the MIDI Beat Clock settings as needed, slave Performer Lite as explained in “Tap Tempo” on page 560.

**TAP TEMPO**

Tap Tempo is Performer Lite’s real-time tempo control feature. Tap Tempo lets you slave Performer Lite to a tap entered from any MIDI controller before, during, or after the recording of your sequence. You can ‘conduct’ an existing sequence by tapping the tempo, complete with accelerandos, ritards, and rubato passages; Performer Lite will follow precisely. More importantly, you can record your tap into the Conductor Track for use in subsequent playback and recording.

Tap Tempo can be used during virtually any stage in the creation of a sequence. For example, if you have acoustic music on tape, two completed tracks in Performer Lite, and three more Performer Lite tracks to record, you can ‘teach’ the two existing tracks to follow the prerecorded music. Your remaining tracks will be recorded into a sequence that has all of the temporal nuances of the prerecorded music.

**Preparing for Tap Tempo**
The following are general points to consider when preparing to use Tap Tempo sync.

**Establish a meter**
When slaving to Tap Tempo, Performer Lite must know how many of your taps to group as one measure. Before recording or playing back a passage in Tap Tempo mode, make sure you’ve entered the correct meter using the Change Meter command (Project menu>Conductor Track>Change Meter).

**Establish a metronome click value**
Your taps correspond to the current metronome click value, specified using the Change Meter command. For example, the tempo of a 4/4 passage can be tapped and expressed in whole notes, one tap per measure, or in sixteenth notes, sixteen taps per measure. Each tap becomes a tempo change event, so the smaller the click value, the higher the resolution of the resulting tempo map.

**Choose a tap source**
You can use any standard MIDI event as your tap source. Performer Lite will interpret this MIDI event as a tap whenever it occurs on the specified input channel. If you plan to record music while
slaved to Tap Tempo, choose a combination of MIDI event and channel that won’t be needed in the musical passage. For example, let’s say you’re tapping C3 on a controller keyboard, transmitting on channel 1. The result? Any other C3’s transmitted on the same channel will not be recorded. Again, this is only true for C3’s transmitted on channel 1. C3’s transmitted on other channels will be recorded normally.

Note that although pitch bend and controller events are acceptable as tap sources, the most common controls for sending them (wheels, joysticks) make reproduction of a single, specific value difficult. For example, to define your tap you enter a pitch bend value of 392 using a pitch bend wheel. To slave Performer Lite, you’ll need to generate values of 392 or higher — you send a 392 value by going precisely to it, but also by going past it. That much is easy, but remember that Performer Lite will treat only the events with 392 values as taps. All other values sent by your mod wheel will be recorded and interpreted as normal pitch bend events. This makes bend and controller events less practical tap choices than events with precise triggers or more limited values, such as a note or a Controller #64 (sustain pedal) event.

**MIDI beat input data**

**Source**

Choose the MIDI device you will be tapping from in the menu provided.

**Event**

Specify the MIDI event you wish to use as a tap. Tab to the Event box or click in it, then enter a MIDI event from any MIDI controller connected to the specified port (play a note, tap a sustain pedal, etc.). The event appears, highlighted; click on the highlighted event if you wish to change it. You can use any standard MIDI event as a tap source.

**Countoff beats**

Specify the number of times you wish to tap as a countoff. The default number of sync countoff beats is four, but the countoff can be any number between 1 and 127. If you enter a number outside this range, the computer will beep when you click the OK button and the number will be highlighted. If this happens, click on the highlighted value and enter a new one.

**Using Tap Tempo mode**

After you have made the Tap Tempo settings as needed, follow the steps explained in “Using Tap Tempo” on page 562.

**SLAVING TO EXTERNAL SYNC**

After you have chosen one of the desired sync modes already discussed in this chapter, slave Performer Lite to an external source as follows (refer to the next section for Tap Tempo):

1. Select Slave to External Sync from the Setup menu.

This puts Performer Lite into slave mode, waiting for sync information from an external device.

2. Click on the Play or Record button in the main transport controls.

The Play button will flash on and off, meaning that Performer Lite is waiting for sync information to start.

3. To start Performer Lite, start the external device.

When Performer Lite is locked and playing, the Play button will turn blue. When locked, Performer Lite will follow, start, stop and rewind under control of the master.

4. To terminate the lock up with the master, click on the Stop button.
Clicking on the Stop button will both stop Performer Lite and remove it from the master’s control. This can be done at any time. To return to normal operation, turn off Slave to External Sync by reselecting it from the Studio menu.

**USING TAP TEMPO**

To use Tap Tempo mode:

1. Choose Slave to External Sync from the Setup menu.

This puts Performer Lite in slave mode; it is now waiting for sync information from an external source.

2. If you wish to record the tap into your sequence, record-enable the Conductor Track. Your tap will be stored as tempo change events in the Conductor Track and used in subsequent playback and recording. Existing tempo changes will be replaced. Other Conductor Track information will be unaffected.

3. If you wish to record music into your sequence, record-enable the desired tracks.

If you wish to record the tapped tempo and music simultaneously, or record music onto more than one track, specify the record device for each track that is record-enabled. The Conductor Track will record from the device specified in the Receive Sync settings window.

4. Press the Play or Record button in the main transport controls.

The Play button will flash, meaning that Performer Lite is waiting to receive sync information. Overdub mode will not function on the Conductor Track; that is, recording in either normal or overdub mode will erase any existing tempo events.

5. If you will be tapping along with a prerecorded passage, start playback of the recording.

Ideally, the prerecorded music will have a sufficient countoff so that you can tap the number of countoff beats specified in the Receive Sync settings window.

6. Begin ‘tapping’ the MIDI event that you designated in the Receive Sync settings window.

Performer Lite will listen for the specified number of countoff beats to predetermine the tempo for the beginning of playback or recording. When Performer Lite has received the countoff, playback or recording will begin.

7. Tap the desired tempo and tempo changes.

Make your tap as expressive and dynamic as you wish; Performer Lite will follow. The Counter display will update as you tap.

8. To end recording or playback, press the Stop button in the main transport controls.

Don’t be alarmed if the computer pauses after you stop recording. Performer Lite is calculating precise tempo changes from the taps you just recorded.

9. Take Performer Lite out of slave mode by choosing Slave to External Sync from the Setup menu.

10. If you recorded your tap, you can hear the results by rewinding the sequence, making sure the metronome under Conductor Track tempo control, and pressing Play.

Your sequence will play back using the tempo that you tapped. If you are not satisfied with the results, you can use the Undo Record command in the Edit menu and then repeat the above process. You
can make adjustments by rerecording certain sections and by editing individual tempo changes in one of the Conductor Track’s edit windows.

**Tapping to prerecorded music on tape**
You can use Tap Tempo to record a tempo map while Performer Lite is slaved to tape—or, more accurately, referenced to external time code. You can record a tempo map that matches the music on tape, allowing you to perfectly synchronize your sequence to the prerecorded music. This process is explained in detail in “Using Tap Tempo while slaved to external sync” on page 564.

**Hints for using Tap Tempo**
Here are some ways to use Tap Tempo.

**Recording music simultaneously**
If you plan to record music simultaneously with your tap, choose a tap event that doesn’t require use of your hands. Controller #64, sustain, is usually triggered by a foot pedal and is a good choice for a tap because it has only two values: On or Off.

Further, Performer Lite will let you use either value for your tap.

**Using alternative tap values and sources**
You can set the tap as an Off value for a particular note or controller:

1. In the Receive Sync settings window with Tap Tempo chosen, Tab to the Event box.
2. Depress the note or controller, leaving it depressed.

For example, push a modulation wheel away from its ‘zero’ location. The controller number and its value will appear in the box, highlighted.

3. Without releasing the note or pedal, click on the highlighted Event value.

4. Release the note or pedal.

To continue the example, let the mod wheel spring back to its zero location. The Event box will show Off or 0 as the tap value.

So far, our examples of using Tap Tempo have involved tapping a MIDI instrument to ‘teach’ Performer Lite the temporal details of a sequence. When you tap, you simply send a MIDI event and Performer Lite does the rest. This means you can use any MIDI sequencer to load its own tempo map into Performer Lite — just program the sequencer to play a song’s worth of quarter notes while Performer Lite is slaved to Tap Tempo sync.

Yet another way of sending Performer Lite a tap is to use a device that converts an audio click into a MIDI event. A click or other regular, amplified signal (a click track on tape, a miked rim shot, etc.) can be fed into such a device and converted into MIDI events from which Performer Lite can generate a tempo map.

**Punching in a tempo**
AutoRecord can be used with Tap Tempo to ‘punch in’ tempo changes for a section while preserving the tempi outside that section. Enter the Punch In and Out times in the Auto-Record bar, found in the Control Panel, click on the Auto-Record button, then follow the applicable steps above. (Don’t be alarmed if both the Play and Record buttons go grey at first; the Play button is waiting for sync information, and the Record button is waiting for the Counter to reach the punch In location.)

Remember also that slaving Performer Lite to Tap Tempo disables the sequence’s existing tempo map. So when you start playback in Auto-Record mode, even though Performer Lite will only record taps from the In location to just before the Out location, you will have to tap throughout the pass. Give yourself the most accurate temporal
‘context’ — the tempi before and after the punch-in passage — as is possible, so that the recorded section will fit smoothly into the rest of the sequence. As always, you can fine-tune all tempo change events in the Conductor Track.

**USING TAP TEMPO WHILE SLAVED TO EXTERNAL SYNC**

You can use Tap Tempo to record a tempo map while Performer Lite is slaved to tape—or, more accurately, referenced to external time code. You can record a tempo map that matches the music on tape, allowing you to synchronize your sequence to the prerecorded music.

This process can be performed in a more precise fashion if you have an audio click track recorded on the tape and a click-to-MIDI converter such as a MOTU MIDI Express XT.

**Preparation**

The following are general points to consider before tapping tempo to prerecorded music:

*Before you begin, establish SMPTE synchronization to tape.* This is necessary for two reasons: 1) Performer Lite needs to receive a timing reference from the tape while creating the tap tempo map, and 2) later on, after you successfully record the tempo map, you will be using the SMPTE to lock the sequence to the tape. To establish SMPTE synchronization, see chapter 66, “Receive Sync” (page 554).

*After you have set up SMPTE sync, set up Tap Tempo.* To do so, simply follow the directions in the Receive Sync chapter for setting up Tap Tempo, as explained in “Tap Tempo” on page 560. Test it to be sure that when you tap, Performer Lite does indeed follow your taps. This will ensure that you have the proper channel and event for Tap Tempo mode. Remember, you may also need to set up a meter map in the sequence that matches the meter map of the music on tape.

If possible, set up two full measures of countoff on the tape before the first downbeat of music. This will be extremely helpful to your accuracy when tapping the first downbeat, which is the most important downbeat because all subsequent taps—the entire tempo map—will be referenced to its exact location.

**Setting up Tap Tempo**

After you have made these preparations, you are ready to begin. To Tap Tempo to prerecorded music on tape:

1. Open the Receive Sync settings (Setup menu).

2. Set the **Sync to port** option to **Any Port**.

3. Select the Tap Tempo option.

4. Choose the Tap Tempo settings as described earlier in “Preparing for Tap Tempo” on page 560.

If you are feeding a click track through a click-to-MIDI converter, make sure that the Tap Tempo event setting matches the MIDI event being generated by the converter.

Also be sure that the number of countoff beats you choose here corresponds in a useful way to the number of countoff beats on tape. For example, ideally, you should have 2 measures of countoff on tape; if so, set the countoff beats here to 1 measure.
When you roll the tape, you can get ready during the first measure of countoff, tap along for the second measure, and hit the downbeat right on the money. If you don’t have an countoff on the tape, you will have to develop a system that works best for you. You might try just one countoff beat.

5 Check the *External time code* option.

Performer Lite will now reference your taps to incoming timecode.

6 Select the *Capture start time* option.

This option makes Performer Lite remember the exact SMPTE frame of your first tap (excluding the countoff beats) so the sequence will start at the correct SMPTE time.

**The procedure**

Now you are ready to go:

1 Record-enable the Conductor Track.

2 Choose Slave to External Sync (Setup menu).

3 Press the Record button.

4 Get ready to tap, and roll the tape.

5 Listen for the countoff, and ‘tap’ along with it such that the first downbeat of the sequence corresponds to the first downbeat of music on tape.

Performer Lite automatically remembers the exact SMPTE time of your tap on the first downbeat of the sequence and saves it as the sequence start time. When you later slave the sequence to tape, Performer Lite will automatically start the sequence at the correct SMPTE time.

6 Tap along with the music as accurately as possible.

Remember that synchronization later on will only be as accurate as the accuracy with which you tap in this procedure.

7 To end recording, press the Stop button in the main transport controls.

Don’t be alarmed if the computer pauses for a while after you stop recording. Performer Lite is calculating precise tempo changes from the taps you just recorded.

**Listening to what you have done**

Now that you have recorded the tempo map, try slaving Performer Lite to the tape using your usual method of synchronization, such as Direct Time Lock or MIDI Time Code, in the Receive Sync window. Also, make sure that the Metronome is under Conductor track tempo control. You will now be able to playback, rewind, or fast forward anywhere in the song on tape, and your Performer Lite sequence will exactly reproduce your tapping performance with respect to the music on tape. If you tapped accurately, Performer Lite will play along accurately. If you are not satisfied with your tapping performance, just try again.
CHAPTER 67 Transmit Sync

OVERVIEW
The Transmit Sync settings, available from the Setup menu, allow you to configure Performer Lite as a master time source. When being used as a master, Performer Lite sends synchronization signals to which other MIDI devices can slave. Performer Lite can generate these types of MIDI timing and synchronization data:

- Standard MIDI beat clocks
- MIDI Time Code (MTC)
- Analog SMPTE timecode (LTC); requires a MOTU Audio interface

For more information on synchronization, see chapter 66, "Receive Sync" (page 554).

You may use Performer Lite as a master of some devices while Performer Lite itself is slaved to another device. This is especially useful when slaving Performer Lite to SMPTE time code; Performer Lite (slaved to the tape) can generate tempos for other sequencers slaved to Performer Lite.

Overview ...........................................566
MIDI Time Code .................................566
MIDI Beat Clocks ...............................567
Turn off Transmit Sync when you don’t need it ........568

MIDI TIME CODE
MIDI Time Code (MTC) is the MIDI equivalent of SMPTE Time Code. It is a steady stream of MIDI events that expresses time in hours, minutes, seconds and frames. (For further explanation, see “Basic types of sync” on page 554.) MIDI Time Code provides the following two basic components of synchronization:

- Time base — a common reference for the passage of time that devices can follow
- Address — an indication of where playback is at any moment

MIDI Time Code does not provide tempo or beat information. Devices that slave to MIDI Time Code will either have no need for tempo and beat information, or they have their own idea of tempo and meter. (MIDI Beat Clocks, however, do provide tempo and meter beat information. See “MIDI Beat Clocks” on page 567.)

Transmitting MTC to another device
When you transmit MIDI Time Code from Performer Lite to a device that can slave to MTC, such as a tape deck of some kind or a mixing console, Performer Lite serves as the timing master and the other device follows as the slave.

On macOS, the other “device” doesn’t necessarily have to be hardware: it could be other Core MIDI-compatible software running at the same time as Performer Lite.

To slave a device to Performer Lite via MIDI Time Code, choose Transmit Sync from the Setup menu, and choose it as a destination for MTC from the menu.
Choosing multiple MTC destinations
You can choose more than one destination by clicking on the menu as many times as needed. Choose the destination again from the menu to turn off MTC transmission (and uncheck the destination in the menu). On MacOS, you can also send MTC to other Core MIDI-compatible applications.

Setting the SMPTE frame rate
Choose the appropriate SMPTE format from the Frame Rate command in the Setup menu.

Make sure both Performer Lite and the other device is set to the same SMPTE frame rate.

Choosing a SMPTE start time
Choose Set Sequence Start Time from the sequence menu in the Control Panel to set the sequence’s SMPTE start frame. See “Setting the start time” on page 90 for details. The start frame is the hour, minute, second, and frame which Performer Lite (and the other device) consider to be the beginning of the sequence (on the first downbeat). Other devices may refer to this as the SMPTE offset.

Transmitting MTC while slaved to external Sync
When Performer Lite is set to Slave to External Sync and is receiving MTC, incoming MTC is echoed directly, rather than being regenerated by Performer Lite.

MIDI BEAT CLOCKS
When you tell Performer Lite to transmit beat clocks, Performer Lite becomes a master time source: any MIDI devices (that can slave to beat clocks) connected to Performer Lite will follow Performer Lite’s tempo changes, and start or stop along with the program. If the slave devices respond to MIDI Song Position Pointer data, then they will also follow Performer Lite when the Counter location is changed or the Rewind button is used.

Choosing a USB interface to transmit beat clocks to
Unlike MIDI Time Code, which can be routed to specific devices on a multi-port interface like the MIDI Express XT, beat clocks are not channel or port specific, as defined by the MIDI specification. As a result, they are sent to all devices connected to the USB interface that you choose in the Transmit Sync settings window.
You can choose more than one USB interface in the menu by clicking on the menu as many times as needed. Choose the port again from the menu to turn off beat clock transmission (and uncheck the port in the menu). If no USB interface is selected, Performer Lite will not generate or echo MIDI beat clocks.

Echo received sync vs. Generate MIDI beat clocks
Performer Lite can transmit beat clock information in two ways: it can simply pass on (or echo) any beat clock messages it receives, or it can generate new beat clocks based upon its own tempo map and controls. These options are described below:

Echo received sync
This option echoes beat clocks that are received by Performer Lite from some other source. No processing is performed. The reception port must be selected in the Receive Sync settings window, and Performer Lite must be in External Sync mode for beat clocks to be echoed. Beat clocks are echoed to the ports selected in the Transmit Sync settings window. There is less delay between reception and re-transmission using this mode than if Generate MIDI beat clocks is selected.

Use this mode if you wish to slave Performer Lite and another device to a master that generates MIDI beat clocks. However, for best results, you should use a MIDI thru box and connect both Performer Lite and the other slave directly to the master. Echoing sync through Performer Lite results in a small delay.

Generate MIDI beat clocks
Performer Lite generates MIDI beat clocks in tandem with the other MIDI information being played back. Use this mode when Performer Lite is the master. You may also find this mode useful when slaving Performer Lite to SMPTE using one of the time lock modes. Performer Lite will generate MIDI beat clocks according to its tempo map in sync with the SMPTE code, so you can slave a sequencer, drum machine or device that doesn’t support SMPTE through Performer Lite.

24 clocks per metronome click/24 clocks per quarter note
Some MIDI devices expect 24 clock signals per beat (one click of the device’s metronome) instead of the standard 24 clocks per quarter note. This method is very useful when there are meters which do not use the quarter note as the beat unit: 3/8, 5/16, etc. In 6/8, for example, there might be a metronome click every three eighth notes; in 4/1, the metronome would click once every whole note. If you were using a less common meter such as 5/32 or 3/16 + 4/16, using the quarter note as the timing base is not very useful. Instead, use this option to make the metronome click value the timing base.

First clock is time 1
When this option is checked, Performer Lite interprets the first MIDI clock signal it sends as the second timing clock of the sequence, 1/24th of a beat after the beginning. Recently manufactured devices expect to receive the first clock signal (time 0) after the start command for the sequence. Some earlier devices assume the start command to be the first clock signal; the first clock signal would thus be 1/24th of a beat after the beginning. If you are using one of these older devices, you should check this option.

Turn off transmit sync when you don’t need it
If you are not slaving external devices to Performer Lite, set both of the Transmit Sync settings window menus to None to improve performance.
Part 13
More Information
CHAPTER 68  Hard Disk Recording Concepts

OVERVIEW
This chapter briefly covers several important concepts about hard disk-based digital audio recording. You may not feel that you have the time to review the “basics”, but the more you know, the more you will be able to accomplish. After you read this chapter (it will only take a few minutes):

- You will get a better sense of the vast creative possibilities open to you with this technology.
- You will work more efficiently.
- You will be less likely to make costly mistakes.

If you are using an audio interface from another company, be sure to consult the owner’s manual, as the use of third-party hardware can impact Performer Lite in many important ways.

HOW AUDIO IS RECORDED ON DISK
Overview ..............................................................570
How audio is recorded on disk .........................570
How much disk space does audio require? ........571
Hard disk requirements and maintenance ...........572
Digital audio terms .............................................572

Performer Lite and other computer-based digital audio recording systems record audio data in much the same way. Audio data gets recorded onto the hard disk in the form of an audio file: you press record in Performer Lite, play in some music, and the audio signal is encoded digitally in the audio file.

Performer Lite automatically creates a separate audio file for each record take. By default, Performer Lite uses interleaved audio, which stores all channels for each track in a single file. If you record onto a mono audio track and a stereo audio track, Performer Lite will create two audio files.

Every time you press the record button, record some music, and then stop, Performer Lite automatically creates a new audio file when you start recording, records the audio data into the audio file as you play, and then closes the audio file when you press stop. Performer Lite immediately readies another audio file for the next take while inserting the last one into the audio track at the appropriate time and adding it to the list in the Soundbites list.

Random access
A computer hard drive provides instantaneous access, often called random access, to the audio files you record, allowing you to cue immediately to any location in your music. Hard disk recording systems convert an audio signal into digital data (basically transforming the audio signal into a continuous stream of numbers), and then write the digital data sequentially to the hard disk. Because of the extremely high speed of the hard disk read/write mechanism, you have instant access to any part of the recorded audio.

Non-destructive editing
With their random access capability, hard disk recording systems provide other important advantages over tape machines. For example, you can cut, snip, splice, shift, re-arrange, and otherwise edit the original pass of audio without actually modifying the original data. If you rearrange the order of a few sections in a digital audio track, Performer Lite simply rearranges references to those sections of data without affecting the original audio data itself. This process, called non-destructive editing, is possible because Performer Lite stores the edit points separately from the audio data. You can always
revert to the original audio data if you want, up until the time that you decide to permanently erase it from the hard disk.

**Instantaneous editing**
Non-destructive editing is a virtually instantaneous process because the edit points you create during editing are very small (only a few bytes) and can therefore be handled quickly by the computer. As a result, your edits in Performer Lite take effect immediately as you do them.

**Non-linear editing and playback**
As you can see in Figure 68-1, non-destructive editing makes it quick and easy to re-arrange the order of any portion of the originally recorded audio. You can revert to the original take at any time.

**Repetition without duplication**
Random access also allows you to repeat the same section of music as many times as you like within your piece of music without duplicating the actual audio data itself. For example, you could have a one-measure drum loop that repeats for 60 measures, but it only consists of one measure’s worth of audio—approximately two seconds. The loop is simply placed end to end in the track sixty times. (Alternatively, it could be looped with a loop in the track.) You can even play back the same region of audio on several tracks *at the same time*. A chorus effect can be created with a vocal passage by placing it in four separate tracks and slightly offsetting the audio in each track. When you do so, Performer Lite does not actually create four copies of the audio data on your hard disk; instead, the computer references the same passage of audio on the hard disk four times simultaneously. As a result, you are actually conserving hard disk space when using a single region of audio in multiple places.

**HOW MUCH DISK SPACE DOES AUDIO REQUIRE?**
The freedom you enjoy as a result of the benefits described above comes at a price: hard disk space. One mono minute of CD-quality (16-bit, 44.1 kHz) audio takes up about 5 megabytes (MB) of space on your hard disk. A stereo minute takes up 10 MB. If you have a MOTU UltraLite audio interface, and you have audio playing on 24 channels for a five minute tune, that’s 24 channels times 5 minutes, which adds up to 120 minutes of audio. Multiply that by 5 MB per minute, and your 5 minute song takes up 600 MB of hard disk space! And that doesn’t count alternative takes, overdubs, and other audio that you generate during the course of a recording session. During a typical session, you can easily fill upwards of 1 GB (1 gigabyte) of hard disk space in no time.
The table below shows disk space (in Megabytes) for one minute of digital audio at various sample rates and bit depths:

<table>
<thead>
<tr>
<th>Bits</th>
<th>Ch</th>
<th>44.1 kHz</th>
<th>48 kHz</th>
<th>88.2 kHz</th>
<th>96 kHz</th>
<th>176.4 kHz</th>
<th>192 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>1</td>
<td>5.3</td>
<td>5.7</td>
<td>10.5</td>
<td>11.5</td>
<td>21</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>1</td>
<td>7.9</td>
<td>8.6</td>
<td>15.9</td>
<td>17.3</td>
<td>31.7</td>
<td>34.6</td>
</tr>
<tr>
<td>32</td>
<td>1</td>
<td>10.5</td>
<td>11.5</td>
<td>21</td>
<td>23</td>
<td>42.3</td>
<td>46</td>
</tr>
<tr>
<td>16</td>
<td>2</td>
<td>10.6</td>
<td>11.5</td>
<td>21.2</td>
<td>23</td>
<td>42.3</td>
<td>46</td>
</tr>
<tr>
<td>24</td>
<td>2</td>
<td>15.9</td>
<td>17.2</td>
<td>31.7</td>
<td>34.5</td>
<td>63.5</td>
<td>69</td>
</tr>
<tr>
<td>32</td>
<td>2</td>
<td>21.1</td>
<td>23</td>
<td>42.3</td>
<td>46</td>
<td>84.7</td>
<td>92</td>
</tr>
</tbody>
</table>

Figure 68-2: Hard disk space requirements for one minute of mono and stereo digital audio at various sample rates and bit depths.

In addition, Performer Lite provides audio management features that let you easily identify unused audio and delete it from the hard disk.

HARD DISK REQUIREMENTS AND MAINTENANCE
Performer Lite itself does not have any special requirements with regard to the performance of the hard disks on which you will be recording audio. If you are using Performer Lite without a sound card, the faster your hard drive, the more tracks you will be able to play and record simultaneously. (To learn more about getting the most out of your computer’s performance, see “Configure Studio Settings” on page 23.)

If you are using an audio interface from another company, it may have certain requirements for hard disk performance. To avoid problems, be sure to consult the manual.

In either case, hard disk maintenance procedures such as defragmenting and re-initializing will help improve overall performance.

DIGITAL AUDIO TERMS
Here are some terms and concepts you should be familiar with.

Project
A project is a folder that Performer Lite creates on your hard disk when you start a new recording session. It includes a Performer Lite file, along with a folder for the audio files you’ll generate while recording.

Audio file (or Sound file)
An audio file is a document on your computer’s hard disk that contains digital audio data. Its size is determined by the duration of the audio data, by the sample resolution, and by the number of audio channels (1 for mono files, 2 for stereo files). A one-minute mono audio file recorded at 44.1 kHz takes up about 5 megabytes of hard disk space. Stereo files are twice as large as mono files. Therefore, a one-minute stereo file is about 10 megabytes.

Audio files come in several different formats. In Performer Lite, the default format for recording is Broadcast WAVE, but you can also record as AIFF (Audio Interchange File Format).

Audio files contain more than just the audio information. They also contain a list of regions (explained below) in the audio file, as well as any playlists (also explained below) that have been created for it using other audio software programs.

Figure 68-3: An audio file contains the original audio recorded into it, as well as any regions (soundbites) and playlists created by Performer Lite or other audio editing software you might use to edit the file.
Region
This is the term most commonly used to refer to a section of audio in an audio file. It could be a one-second sound effect, a 16-bar phrase, or the entire length of the audio file. You can define an unlimited number of regions in an audio file. Technically speaking, a region consists of pointers, which are references to the exact location (digital sample) in the audio file where the region begins and ends. These pointers are very small compared to the amount of audio data they represent. This is why region editing is so fast and efficient: it deals with the manipulation of pointers, which consist of a very small amount of data.

Soundbite
The word Soundbite is synonymous with the word Region as described above. In Performer Lite, we call regions soundbites because the word region means something entirely different in Performer Lite: it is a period of time within one or more tracks over which an editing command will take effect. (For example, consider Performer Lite’s Region menu.) Therefore, to avoid confusion with the word region, we use the term soundbite to describe an audio region. They are one and the same.

Soundbites can be placed in any audio track at any time location. They can be duplicated as many times as you like with virtually no additional memory overhead, since they are merely pointers to audio data on the hard disk. With only two exceptions, soundbite editing and management in Performer Lite is entirely non-destructive. (The exceptions are the Compact command and deleting the very last soundbite in an audio file, which cause audio data to be deleted from disk.)
the system you have, Performer Lite allows you to freely assign audio tracks to whatever physical inputs and outputs are provided.

![Figure 68-5: Assigning an audio track to an audio output.](image)

**MOTU Audio System**

The *MOTU Audio System* is the “audio engine” that provides digital audio recording and playback in Performer Lite. The MOTU Audio System can operate with no extra audio hardware installed in the computer, although it also supports all MOTU audio interfaces and a wide variety of third-party audio hardware.

The MOTU Audio System also supplies real-time effects plug-ins that you can use to process audio tracks in real time with effects like parametric EQ, reverb, chorusing, etc. It is also an open system, supporting real time plug-ins from other companies as well. All plug-ins are processed with extremely high fidelity 32-bit, floating point calculations.

In general, the overall performance of the MOTU Audio System (the number of audio tracks you can play simultaneously, along with the maximum amount of effects processing you can employ in real time) depends on the overall speed and performance of your computer. Together with these features, the MOTU Audio System also supports all MOTU Audio interfaces, as well as a wide variety of third-party audio hardware. When you use the MOTU Audio System with one of these systems, you get the best of both worlds: you get to take advantage of the large number of possible audio tracks and real-time effects provided by the MOTU Audio System, along with the high-fidelity analog and digital inputs and outputs supplied by the audio hardware.

For the most part, you don’t need to be concerned with the MOTU Audio System. It runs automatically when you use Performer Lite. The only time you would think about it is if you would like to try to optimize its performance with the *Configure Audio System* in the Setup menu of Performer Lite. For details, see “Configure Studio Settings” on page 23.
CHAPTER 69  Audio File Management

OVERVIEW
This chapter tells you:

■ Where audio files are stored on disk
■ How to manage the audio files associated with a Performer Lite project
■ How to get rid of unused audio
■ How to reclaim hard disk space using the Compact command

THE AUDIO FILES FOLDER
Overview ........................................575
The Audio Files folder .........................575
Renaming audio files ..........................575
Moving audio files ............................575
Working with multiple drives ...............575
Deleting audio files ...........................575
Getting rid of unused audio .................576

As explained in “Components of a Performer Lite Project” on page 79, each Performer Lite project includes an Audio Files folder (Figure 15-1 on page 79).

The Audio Files folder keeps track of all of the audio files for a Performer Lite project. In a new project, takefiles are placed in the Audio Files folder by default. You can record an entire Performer Lite session without concern for the location of the audio files you record because Performer Lite will automatically store them by default in this folder. However, audio files do not have to be located in this folder. For example, you might import an audio file into the project that is located on another hard drive.

RENAMEING AUDIO FILES
You can rename audio files at any time by editing the file name on the computer desktop or by Option/Alt-clicking its name in the Soundbites window. In either case, Performer Lite automatically updates the name in the other location so that they always match.

MOVING AUDIO FILES
You can freely move audio files to any location you want and Performer Lite will automatically keep track of them. You can even place them on a different hard drive. If you are not sure where an audio file is, and you would like to find out, click one of its soundbites in the Soundbites window and look at the information for the parent audio file in the Sound File Information window. If necessary, you can make the window larger to see the entire path.

If you copy a file onto another volume and delete the original, Performer Lite will not know about it and will ask you to find it.

WORKING WITH MULTIPLE DRIVES
Since Performer Lite does not care on which hard drive you record and store your audio files, you can store audio files for a single Performer Lite project on several different hard drives. This can help improve the overall disk performance of your system because it distributes the intensive disk accessing burden across more than one disk.

DELETING AUDIO FILES
You can delete audio files by dragging them into the trash or recycle bin. The only drawback to this method is that you can’t view or audition the regions that the file contains to verify that you don’t need them. If you want to inspect the soundbites in the audio file before deleting it, use
Performing Lite’s Soundbites window. Open the
Performing Lite file associated with the audio file
(or import its soundbites into Performing Lite) and
do the following:

1. View by file name (using the View by menu the
top of the window).

This groups the soundbites together by audio file.

2. If you want to check the soundbites by listening
to them, turn on the Audible Mode button (in the
Control Panel) and click them.

3. Drag over their names to highlight them.

4. Choose Delete from the mini-menu and answer
Yes when asked if you would like to delete the
audio file.

As a shortcut, hold down the Option/Alt key when
selecting the Delete mini-menu command to
bypass the warning dialog.

GETTING RID OF UNUSED AUDIO
Performing Lite provides several simple techniques
for permanently removing unused audio data
from the hard drive. You can employ these
techniques at any time to generate more free hard
disk space. Just be aware that they permanently
remove audio data, so be careful when choosing
what to delete. The next few sections cover these
techniques.

Selecting and deleting unused soundbites
The Soundbites window mini-menu has an item
called Select Unused Soundbites. This command
highlights all soundbites in the list that are not
being used in any track in any sequence in the file.
(For more information, see “Selecting unused
soundbites” on page 201.)

As a shortcut, hold down the Option/Alt key when
selecting the Delete mini-menu command to
bypass the warning dialog.

You can delete the highlighted soundbites by
choosing Delete from the mini-menu.

Compacting audio files
After a recording session, you may wish to get rid
of all the data that ended up not being used in any
of the tracks to reclaim significant amounts of free
space on the hard disk. Compacting is a process

![Figure 69-1: Compacting removes all audio data that doesn’t fall within an existing region. Depending on how much unused audio gets removed, this process can free up large amounts of space on the hard disk.](image-url)
that deletes portions of an audio file that are not part of a soundbite and then closes the gaps between the leftover regions.

As shown in Figure 69-1, the unused data between soundbites is removed, and the remaining soundbites are placed end to end. Compacting conserves disk space by removing unwanted data from within a file, while preserving data being used for soundbites.

You can compact all audio files at once or individually.

When compacting occurs, there is only one criterion for determining if data is thrown out:

☛  Is the data part of a region in the audio file’s region list?

If the data is part of a region in the audio file’s region list, it is not deleted.

If the data is not part of a region, it is deleted.

The key to successfully compacting a file is to make sure that the region list in the audio file contains regions that you want to keep, and only those regions that you want to keep.

How do you do this? With the Soundbites window. If you delete a soundbite that you want to discard, Performer Lite removes the soundbite’s corresponding region in the audio file’s region list (see “Deleting soundbites” on page 201), and the remaining audio data is deleted when compacted. Conversely, soundbites that are not deleted are not compacted.

If any audio data in the audio file is being used by other Performer Lite files, it is not deleted by these commands as long as you have not deleted the region from the audio file’s region list with Performer Lite or other sample editing software. Performer Lite does not delete any regions in the audio file, even if they are not used in the currently open Performer Lite file.

Since compacting results in the erasure of audio data on the hard disk, and possibly very large amounts of audio data, this operation may take a few moments, depending on how much audio data is being removed.

To compact one or more audio files:

1  (Optional) Choose Select unused soundbites from the Soundbites window mini-menu.

This highlights all of the soundbites that are not being used in any track in the file. These are likely candidates for disposal.

2  Delete all soundbites from the Soundbites window that you want to discard using the Delete command in the mini-menu.

If necessary, you can audition ones that you aren’t sure about using Audible mode. To delete the soundbite, highlight its name and choose Delete from the mini-menu. Don’t use the Remove from list command—it will not remove the regions from their audio files.

3  Highlight a soundbite from each audio file that you wish to compact.

If you want to compact all the audio files, choose Select All from the Edit menu (or press Command/Ctrl-A).

4  Choose Compact from the Soundbites window mini-menu.

**Compacting won’t work if…**

There is one condition in which compacting won’t do the right thing for you: if the data you want to get rid of exists as a region in the audio file and
there is no corresponding soundbite for it in Performer Lite’s Soundbites window. This situation can arise if:

- the region wasn’t created in the current Performer Lite file

OR

- at some point you highlighted the region and chose the Remove from list mini-menu command, which removes the soundbite name from the Soundbites window but doesn’t delete the corresponding region from the audio file region list.

The first case is rare. It isn’t often that you want to delete a region from anywhere other than the file it was first created in. Otherwise, the region is probably there for a purpose — and therefore you don’t really want to delete it.

To avoid the second case, only use the Remove from list command with soundbites you are absolutely sure that you will never want to discard. Otherwise, they might take up hard disk space without you even knowing it. If this is the case, import the region into Performer Lite and then delete the soundbite with the Delete command.
CHAPTER 70  Frequently Asked Questions

OVERVIEW
This chapter provides answers to frequently asked questions, organized by topic.

Overview ................................................................. 579
Setting up ............................................................... 579
Becoming familiar with Performer Lite .................. 580
Recording and playback ............................................ 581
Editing ................................................................. 583
Mixing and Finishing .................................................. 583
Plug-ins ................................................................. 584
Virtual instruments (“soft synths”) ............................... 584

SETTING UP
On Windows, the buffer size setting is grayed out in the Configure Hardware Driver dialog (Setup menu). Why?
Some ASIO drivers don’t allow host applications to change their buffer size setting. In this case, click the Configure Driver button (Figure 3-1 on page 20) to launch the hardware’s console software to make the setting there.

How do I configure my audio inputs and outputs?
Use the Bundles window (Studio menu). See and “Bundles” on page 238.

How do I change the input and/or output on multiple tracks simultaneously?
Select the desired tracks, then choose Studio > Track Assignments (or press Option/Alt-A). If you don’t see the inputs or outputs available that you wish to use, go to the Bundles window and create bundles for them.

Why do I get a “no outputs enabled” error when launching Performer Lite?
If your computer has separate drivers for input and output, and only the input driver has been enabled in Performer Lite, you’ll get an error telling you that there are no outputs enabled. Open the Configure Hardware Driver dialog and enable both the input and output drivers.
☛ See “Enabling multiple drivers (Mac only)” on page 22.

How do I change the tempo, meter, or key of my project?
The two most common tempo modes are the Tempo Slider and the Conductor Track. To change the tempo mode, click the Tempo menu to the right of the tempo value.

For information on these and other tempo modes, see “Tempo Controls” on page 92. Here are brief overviews of the Tempo Slider and Conductor Track modes.

Tempo Slider:
- The tempo can be set using the slider or the tempo text field in the Tempo Control section of the Control Panel (beneath the counters).

The meter is set at 4/4 in Tempo Slider mode, and a key of no sharps or flats. To switch to other meters or keys, use Conductor Track mode. In Tempo Slider mode, there is one tempo, beat, and meter for the whole sequence. If you need changes throughout your sequence, use Conductor Track mode.

☛ See “Making I/O assignments for multiple tracks” on page 61.
Conductor Track:

- In Conductor Track mode, Performer Lite follows the Conductor Track for tempo, meter, and key changes. Each type of event can be inserted and manipulated in a number of ways. The Conductor Track can be edited in the Sequence Editor and altered with the commands found under Project menu > Modify Conductor Track.

How do I hear a click or countoff? To configure a metronome click:

1. Choose Click preferences from the Studio menu, or Option/Alt-click the Click button in the Control Panel.
2. Choose the type of click you want to hear: MIDI click or audio click. You can enable one or the other, or both.

   For a MIDI click, choose a MIDI device, channel, and note; for an audio click, choose the audio output and click file (mono AIFF, WAVE, or SDII).

   ☚ If you are using MIDI Only mode, the audio click routing option is not available; the click & countoff will then be automatically routed to a device in your MIDI configuration (in the Bundles window MIDI Devices tab).

3. To audition the click to hear what it will sound like, check the Audition click option in the lower left; it will audition at the current tempo.

4. Close the Preferences window, then enable the Click button in the Control Panel.

To configure a Countoff:

1. Open the Preferences and choose Countoff from the list on the left, or Option/Alt-click the Countoff button in the Control Panel.

2. First, set the number of measures and beats for your countoff; the default is 2 measures, 0 beats.

3. Next, choose whether you want to have a Countoff all of the time, or only when recording.

4. Audition the Countoff in the same way as the Click: enable the Audition Countoff box in the lower left.

5. Close the Preferences window, then enable the Countoff button in the Control Panel.

How do I view or change key commands? To configure a metronome click:

1. Choose Click preferences from the Studio menu, or Option/Alt-click the Click button in the Control Panel.
2. Choose the type of click you want to hear: MIDI click or audio click. You can enable one or the other, or both.

   For a MIDI click, choose a MIDI device, channel, and note; for an audio click, choose the audio output and click file (mono AIFF, WAVE, or SDII).

   ☚ If you are using MIDI Only mode, the audio click routing option is not available; the click & countoff will then be automatically routed to a device in your MIDI configuration (in the Bundles window MIDI Devices tab).

3. To audition the click to hear what it will sound like, check the Audition click option in the lower left; it will audition at the current tempo.

4. Close the Preferences window, then enable the Click button in the Control Panel.

   You can save or load sets of key bindings via the mini-menu’s Export and Import commands.

   To Print the key commands, open the Commands window and choose Print from the File menu. Note that you can collapse any section by clicking its disclosure triangle (holding option while clicking a disclosure triangle collapses or expands all sections at once).

For more information, see “Commands” on page 234.

BECOMING FAMILIAR WITH PERFORMER LITE

I’m familiar with an older version of Performer Lite. What changes have been made? If you are familiar with Performer Lite version 5 or earlier, some user interface elements have changed in Performer Lite version 6 and later. For information on these changes, please refer to the “Users of previous versions of Performer Lite” page in Performer Lite’s online help files (Help menu > Performer Lite Help).
**RECORDING AND PLAYBACK**

*MIDI input is not recording. What should I do?*
Here are some things to try if you are not able to record MIDI into Performer Lite:

- Make sure the MIDI input light of your MIDI interface is lighting up when you play your MIDI controller keyboard. If not, check you have a MIDI cable going out of the keyboard into the interface.
- Try a different MIDI cable.
- Make sure your keyboard is set up to Local Off or Local Control: Off mode, and configured to send out MIDI notes. If you have other MIDI keyboards or modules with a MIDI IN connection, try connecting the MIDI OUT of your controller directly into the MIDI IN connection of one of those pieces of MIDI gear: does it receive MIDI notes?
- Check that the interface and MIDI keyboard is properly configured in your MIDI device configuration (Setup menu > Bundles > MIDI Devices tab).
- Check that you have specified the specific input and channel your controller is transmitting on.
- Try using the MIDI Keys window (Studio menu). Open the MIDI Keys window and press any letter in the “ASDF” row of your computer keyboard. You can also click the keys on-screen in the MIDI Keys window.

*How do I use my USB MIDI keyboard with Performer Lite?*
Some MIDI controller keyboards have USB connections that allow them to connect directly to the computer, instead of through a MIDI interface.

Some keyboards will be recognized automatically. Once connected via USB, they will simply appear as an input option and an output option (if the keyboard has MIDI output ports).

If the keyboard isn’t automatically recognized:

1. Install the drivers and software provided by the keyboard’s manufacturer.
2. When that is successful, you will see the keyboard in your MIDI device configuration (Setup menu > Bundles > MIDI Devices tab). It will appear similar to a MIDI interface, with its MIDI ports displayed on the bottom of the device.
3. Choose *Add New External Device* from the MIDI Devices menu, and double-click the *New external device* to open its Device Properties window.
4. For Device Name, type the name of the keyboard (this name is what it will be referred to as in Performer Lite).
5. Hit Apply and close the Device Properties window.
6. Draw a connection in and out of this device to the keyboard that originally appeared (the one with the ports on the bottom).

Now when you choose MIDI inputs or outputs in Performer Lite you will be able to choose your USB MIDI keyboard.

*MIDI input is recording, but I can’t hear my MIDI instrument.*
If you’re sending MIDI to a virtual instrument on an instrument track in Performer Lite:

- Make sure the instrument track has its output assigned to a valid audio bundle. If the output assignment is italicized then it is invalid; reassign the output to a valid bundle.
- Make sure the instrument track is not muted.
- If the instrument is multi-timbral, make sure that you’ve assigned your MIDI track to the correct MIDI channel.

If you’re sending MIDI to a hardware MIDI instrument:
■ Have you connected the audio output of the MIDI device to an input on your audio interface? This must be done to bring the audio output from the MIDI device back into your Performer Lite project.

■ Have you created an audio or aux track in your sequence that corresponds to the hardware input you’ve connected the MIDI device’s output to? Make sure the input and output assignments are valid and that the track is not muted.

■ Try listening directly to the MIDI device’s output, perhaps from its headphone output. Do you hear output there?

■ If the MIDI device responds to MIDI volume messages (CC 7), try adjusting the MIDI track’s fader in the Mixing Board to send MIDI volume messages to the MIDI device.

■ If the MIDI device doesn’t respond to MIDI volume message, make sure the volume control on the hardware is turned up.

■ If the MIDI device has multiple audio outputs, check that the MIDI channel you are triggering is assigned to the desired outputs on the device.

Audio input is not recording.
■ Make sure the input meters on your audio interface are lighting up when you send input. If they’re not, check that you have audio cables connected properly.

■ Try a different cable or microphone. For condenser microphones, make sure that you have phantom power enabled.

■ Try using a different input on your interface. If you have one, try a different interface.

■ Check that the audio interface is properly configured. For example, if you can enable or disable inputs on the interface, make sure that the input you want to use is enabled.

■ Make sure that the inputs your tracks are assigned to are the inputs you are recording from. For example, if your microphone is connected to Mic/Guitar 1 on an 828mk3, make sure your audio track is assigned to Mic/Guitar 1.

■ Are your input assignments in italics? Make sure that your audio interface is being seen in the Setup > Configure Audio System > Configure Hardware Driver window, and that it is the selected driver. If it is being seen, open Studio > Bundles and make sure that the bundles you have are assigned the inputs you want.

■ Is the track record-enabled?

■ Is the track enabled? The Enable item is accessible under the Track Settings menu in the Sequence Editor, and from the track pop-up menu available at the bottom of the channel strip in the Mixing Board.

I press play and I do not hear anything.
■ Make sure that the outputs your tracks are assigned to are the outputs you are monitoring from. For example, if you are monitoring from an 828mk3’s Main Outs, make sure your tracks are assigned to Main Out 1-2.

■ Are your output assignments in italics? Make sure that your audio interface is being seen in the Setup > Configure Audio System > Configure Hardware Driver window, and that it is the selected driver. If it is being seen, open Studio > Bundles and make sure that the bundles you have are assigned the outputs you want.

■ Are the tracks muted in the Mixing Board?

■ Is Solo Mode engaged?

■ Are the tracks enabled? The Enable item is accessible under the Track Settings menu in the Sequence Editor, and from the track pop-up menu available at the bottom of the channel strip in the Mixing Board.
FREQUENTLY ASKED QUESTIONS

■ Is the Master Fader and main outs of your audio interface or mixer turned up?

■ Speakers on? Volume turned up on your speakers and/or amplifier?

■ Everything plugged in the way it should be? Try different cables, headphones, or speakers.

■ Try bypassing plug-ins to see if an effect is altering your audio in a way that it cannot be heard.

**How do I convert my MIDI sequence to Audio?**
MIDI is a language and does not contain audio in and of itself, rather it gives commands and triggers MIDI devices to play sounds and controller information.

If your MIDI triggers sounds that are generated from an external sound source such as a MIDI sound module, synthesizer, or sampler, then you will need to connect the analog or digital outputs of that device into your audio interface to record the audio onto an audio track.

If your MIDI sequence uses sounds from virtual instruments, you can simply select the MIDI tracks and use Bounce to Disk.

A limited number of virtual instruments may not Bounce to Disk. If so, you can use the Freeze command:

■ Highlight the instrument track that your instrument is on

■ Highlight the MIDI tracks that are assigned to that instrument track

■ Choose **Audio menu > Freeze Selected Tracks**.
The audio output of the instrument will be recorded onto a new audio track.

If your MIDI sequence is using sounds from a ReWire application like Reason or another application:

■ Add a stereo audio track or mono audio track.

■ Set the input to be the outputs of whichever application you are sending from.

For example, if you are using Reason, add a stereo audio track and set the input to be **Reason Main: L-R**, or any specific output that your Reason rack unit is outputting to.

**EDITING**

**Why is my track name underlined in the Sequence Editor?**
When a track name is underlined, it indicates that the track is frame-locked.

**Why do my crossfades have a blue or red outline?**
Fades and crossfades are normally the same color as the soundbites underneath, as are the fade outlines. Two special colors are used to indicate problems:

■ Blue fade outlines mean that there is not enough audio to compute the fade

■ Red fade outlines mean that the faded audio is clipping.

**MIXING AND FINISHING**

**Why are the meters in the Mixing Board labeled as +/-48 dB?**
When an audio track’s meter scale is labeled as +/-48 dB instead of -48 to +6 dB, the track is in Trim Touch or Trim Latch automation mode. For more information, refer to “The Trim modes” on page 469.

**How do I mixdown my project to a stereo file?**
Use the Bounce to Disk command. See “Bounce To Disk” on page 536.

**How do I burn a song made in Performer Lite to a CD? (Mac only)**
Refer to “Bouncing to a CD or disk image (Mac only)” on page 542.
**FREQUENTLY ASKED QUESTIONS**

**How do I export as an MP3?**
To take a finished mix done in Performer Lite and convert it to an MP3, follow these steps:

1. Prepare the project as if you were bouncing down to any other format, such as WAVE, AIFF, etc. See “How do I mixdown my project to a stereo file?”

2. After choosing *File menu > Bounce to Disk*, select *LAME Audio Export: MP3* as the Format. Give the file a name, and choose the location where you’d like the file to be saved. When you press OK, you’ll see a second dialog with some options for the MP3 you are creating. If you don’t have any preference for these settings, just use the default settings. Press OK in this dialog, and the file will begin bouncing.

3. After the bounce is complete, you can open this file in your MP3 player software of choice, such as iTunes.

You can also export any soundbite in the Soundbites List as an MP3. Select the desired soundbites and choose *Export Selected Soundbites* from the mini-menu. Choose *LAME Audio Export: MP3* from the File Format menu.

**How do I back-up a Performer Lite project?**
To backup the data for your entire Performer Lite project, use the *File > Save A Copy As* command. Make sure to check the *Duplicate audio and copy shared samples to project* option. This will take all of the audio files that your project is using and make a copy of them into the new project’s Audio Files folder, and also copy any samples you are using with nanosampler or Model12.

Performer Lite supports WAVE and AIFF files. For the most broadly compatible back-ups, using WAVE files is recommended.

**PLUG-INS**

**How do I use MAS, VST and Audio Unit (AU) plug-ins?**
See chapter 12, “Instrument Tracks” (page 67) and chapter 57, “Audio Effects Plug-ins” (page 493).

**How do I force Performer Lite to rescan my VST and Audio Unit plug-ins?**
Open the Plug-in Preferences, select the desired plug-ins, and hit Reexamine. For more information on managing your plug-ins, see “Audio plug-in preferences” on page 497.

**How do I use RTAS plug-ins?**
RTAS plug-ins are not supported.

**VIRTUAL INSTRUMENTS (“SOFT SYNTHS”)**

**How do I use virtual instruments (“soft synths”) in Performer Lite?**
Performer Lite includes six virtual instruments, and you can also use third-party MAS, VST and Audio Unit instruments. To use a virtual instrument in Performer Lite:

1. Add an Instrument Track (*Project menu > Add Track > Instrument Track*).

2. Choose the desired instrument from the Instrument Tracks list, and it will create an Instrument Track for it.

3. Next, add a MIDI track; you’ll see the virtual instrument you just added in the list of outputs.

4. Assign the output of the MIDI track to the instrument you just created.

5. Record enable the MIDI track and the instrument will be receiving MIDI data.

For more information, see chapter 12, “Instrument Tracks” (page 67).
FREQUENTLY ASKED QUESTIONS

I closed the window for my virtual instrument, how do I open it again?
In Performer Lite’s Mixing Board (Project menu, or press Shift-M), locate the instrument track. The first insert will be tinted yellow; this is the instrument plug-in. Double-click this yellow insert to open the instrument’s interface.

Alternatively, you can open the Effects window (Project menu, or press Shift-F) and select your instrument track from the first drop-down menu. You may also double-click an instrument track name in the Sequence Editor to open its instrument plug-in interface.

How do I use multiple outputs from my virtual instrument?
To use multiple outputs from Performer Lite’s included MAS instrument plug-in, VST instruments, Audio Unit instruments, and ReWire applications, see “Multiple audio outputs” on page 501.

Some MAS instruments tap directly into Performer Lite’s internal busses. For such instruments, assign the part to the desired bus in the instrument plug-in window.

After the bundles are created, you can create an aux track or an input monitor-enabled audio track with that same bus as the input.

Input monitor-enabled audio tracks have the benefit of being able to switch between monitoring and recording audio easily. For example, while composing you will leave the track input monitor-enabled, but once the part is finished you can record-enable the audio track and record the instrument’s output in real-time. This is particularly advantageous when you have many outputs from one instrument, as you can record all of them to their corresponding audio tracks at once.

Under macOS, how do I access the QuickTime General MIDI sounds in Performer Lite?
Performer Lite can access QuickTime’s GM sounds in two ways: via the Apple Software Synth or the Apple DLSMusicDevice.

Using the Apple Software Synth
1 Go to Setup menu > Interapplication MIDI
2 Check the box for “Software Synthesizer”
3 Select the resolution at which you’d like the sounds to render. If you’re just using the QuickTime GM sounds as a “scratch pad” or a quick reference, try the lower resolutions.
4 Go to Project > Add Track > MIDI Track.
5 Assign the output of this MIDI track to any of the 16 channels of “Apple Software Synth”.
6 You will hear this MIDI track’s output from the hardware device you have selected for “Default Output” under Audio MIDI Setup. If you don’t hear anything, go back to Setup menu > Interapplication MIDI and uncheck and re-check “Software Synthesizer”.

One advantage to this method is that you can use it while Performer Lite is in MIDI Only mode.

Use the Apple DLSMusicDevice
1 Go to Performer Lite’s Project menu > Add Track > Instrument Track > Apple: DLSMusicDevice (stereo)
2 Assign this instrument track a valid stereo output bundle.
3 Go to Project > Add Track > MIDI Track.
4 Assign the output of this MIDI track to any of the 16 channels of “DLSMusicDevice-1”.
One advantage to this method is that you can add a second DLSMusicDevice instrument track, and have 16 more channels of GM sounds. You can add as many DLSMusicDevice instrument tracks as you need.
OVERVIEW
This Getting Started guide is just the beginning. There are a variety of resources available to help you get the most out of Performer Lite.

Overview ......................................................... 587
Frequently Asked Questions (FAQ) ....................... 587
The Performer Lite User Guide ............................ 587
Help Tags ......................................................... 587
Tutorials ......................................................... 587
motu.com ....................................................... 587
Training webinars ............................................. 588
Youtube.com/motuTV ........................................ 588

FREQUENTLY ASKED QUESTIONS (FAQ)
Refer to the previous chapter starting on page 579 for frequently asked questions (FAQs).

THE PERFORMER LITE USER GUIDE
The Performer Lite User Guide is a comprehensive resource for all of the windows, functions, commands, and options in Performer Lite. It is provided in printed form and on-line form in the Help menu. There are a number of ways to quickly locate information.

HELP TAGS
Performer Lite provides “tool tip” help tags to help you identify the names of buttons, controls, and other window elements. Place your mouse cursor above an item for a few seconds and the help tag will appear. Some items also have extended descriptions that can be accessed by holding the Command/Ctrl key while viewing the help tag. To turn off help tags, uncheck Help menu > Show Help Tags.

TUTORIALS
An excellent way to learn Performer Lite quickly is to follow the tutorials. Choose Help menu > Tutorials to open the Tutorials sidebar.

MOTU.COM
Our web site is continually updated with new resources and downloads to complement Performer Lite and other MOTU products. RSS feeds are provided to help you keep up-to-date with new content.

Tech Notes
Tech Notes are short pieces of technical information, usually in the form of a question, such as Do I need an external drive to record audio with a laptop?, and so on. Tech notes sometimes cover late-breaking information not found in the manual, so if you have a question you may want to search the tech notes for an answer even if you have your manual handy. The answers to many common questions can be found in the tech notes, so try searching the tech notes before contacting tech support:

motu.com/techsupport/technotes

If you want information on… look in the…

A broad topic (ex: “Editing”, “Mix Automation”, “the Sequence Editor”)

A specific topic (ex: “Editing during playback”, “Tempo-locked, beat-based automation”, “Scrubbing in the Sequence Editor”)

A specific command, window, dialog, tool, etc. (ex: “Change Tempo”, “Pencil tool”, “Edge Edit Copy”)

You can also use the text search feature in your PDF viewer to find all instances of the text string you are searching for in the manual.
Downloads
Keep up-to-date with the latest software updates for Performer Lite with our downloads section: motu.com/download.

Tech Support
If you have a question or problem that isn’t answered or resolved with the above resources, registered users should contact technical support. If you haven’t already done so, you should register your copy of Performer Lite online at www.motu.com/registration. For more information on contacting tech support, please see “Technical support” on page 592.

Other resources
Links to additional resources, such as books, tutorial movies and links to MOTU-related social media can be found at motu.com.

TRAINING WEBINARS
MOTU often hosts Performer Lite training webinars. Visit motu.com for information about the next webinar and for links to recordings of past webinars.

YOUTUBE.COM/MOTUTV
Visit youtube.com/motuTV for Performer Lite how-to videos.
Part 14

Appendices
APPENDIX A Troubleshooting and Support

OVERVIEW
Overview ......................................................... 590
Preventing Catastrophe .................................. 590
General troubleshooting .............................. 590
MIDI troubleshooting ................................. 591
Audio troubleshooting ................................. 591
Technical support ........................................ 592

PREVENTING CATASTROPHE
Keep up-to-date backups of your sequences as you work, so that you always have copies of the most recent work you have done. Almost any software problem is survivable as long as you have kept backups of your work. Refer to “Helpful project and disk hints” on page 85 for detailed suggestions about file management.

Keep plenty of free space on any disk containing sequences which you are actually working on. This will prevent the computer from running out of disk space. Running out of disk space can result in an unreadable and irretrievable sequence.

GENERAL TROUBLESHOOTING
Troubleshooting is always simplest and most effective when the exact problem can be specified clearly and concisely. If you are surprised by an error message or by seemingly erratic behavior in the program, take a moment to jot down the relevant details: exactly what the error message said (including any error ID numbers), what actions were done on-screen just before the problem occurred, what kind of file you were working with, how you recovered from the problem, and any unusual conditions during the occurrence of the problem. This may not enable you to solve the problem at once, but will greatly aid in isolating the problem should it reoccur.

If the problem you are encountering seems inconsistent, try to determine what the necessary pattern of actions are that will cause it to occur. Genuine bugs in application software like Performer Lite are almost always consistent in their manifestation: the same set of actions under the same conditions invariably brings about the same results. Determining the exact cause of a bug often requires experiments which replicate the problem situation with one factor changed: working with a new sequence instead of an existing one, trying a different plug-ing, etc.

If the problem is truly inconsistent, then it is likely to be a hardware problem: improper disk drive alignment, a loose connection, overlong cables, signal ‘aliasing’, etc. For example, if you play a sequence several times consecutively from 1|1|000 without making any changes to it, and on one pass you hear a wrong note at 3|1|043, and on another pass you hear a different wrong note at 6|2|332, and the other times it plays back without any errors, the problem is almost certainly external to Performer Lite. At this point you will want to experiment with changes in your MIDI hardware configuration (where possible) to attempt to isolate the source of the problem.

Isolate the problem
One of the best troubleshooting techniques is to try to isolate the problem. If you can whittle down a complicated setup or scenario to a much simpler case, chances are you’ll zero in on the problem more quickly.
**Simplify your setup**
One of the most common causes of problems is a conflict with other software in the system. Run Performer Lite by itself, with no other plug-ins or virtual instruments, and see if the problem you are having still happens.

**Check the ‘Read Me First’**
It’s human nature to blow right past the Read Me First, but you’ll probably be glad you took the time. If you experience problems with Performer Lite, check the Read Me notes that ship with the current version you are using.

**If you cannot open a particular file**
First try opening other existing files, or a new file, to be sure Performer Lite is working at all. If a file is opened and seems damaged, will not let you save changes, etc., you still may be able to save some or all of its musical information by using the Clipboard to copy the tracks and paste them into another file.

**MIDI TROUBLESHOOTING**
*If Performer Lite starts correctly, but you are unable to record (or play) any MIDI data*
Double-check your cable connections and MIDI instrument settings. Check your MIDI device configuration (Setup menu > Bundles > MIDI Devices tab) and the connections to the computer. Often only A/B tests will reveal the source of the problem. It may be necessary to switch your MIDI cables, and if possible, to try using a different MIDI interface or MIDI instrument for input/output. Make sure that any recording channel assignments correspond to the MIDI channels set in the controlling keyboard or device.

*If you’re having problems synchronizing Performer Lite with other equipment*
Refer carefully to chapter 66, “Receive Sync” (page 554). Try to deduce exactly which signals are not being sent or are being misinterpreted by which pieces of equipment.

**AUDIO TROUBLESHOOTING**
Here are some additional issues related specifically to audio recording and playback.

*If Performer Lite can’t find the audio card*
If you launch Performer Lite and see a warning box that says that there is no audio hardware, when actually there is, quit Performer Lite, shut down your computer, and make sure that the audio recording card is seated properly in its slot. Make sure you have the correct versions of the drivers.

*If you record and get nothing*
If you record but don’t get anything, the track you are recording on may be set to the wrong channel. Set it to another channel and try again.

*If you don’t hear sound*
If you don’t hear sound, check the following things:

- Make sure the volume is turned up on the audio hardware units.
- Make sure you have cables connected to the correct plugs on inputs and outputs for the audio recording hardware
- Try setting the volume in the Mixing Board. See chapter 19, “Mixing Board” (page 156) for details.
- If you don’t hear sound while recording, make sure the Audio Patch Thru is on.

*If you see an error message after playback or recording*
Performer Lite keeps close track of whether or not it had any trouble processing the audio data during the last record or playback pass. If conditions prevent Performer Lite from successfully handling all of the digital audio information, it presents an error message letting you know how many errors occurred. These errors can be due to conditions such as these:

- Highly fragmented audio files on the hard disk
A hard disk with an access time that is too slow
Other background software interruptions
Other third party software

If you are running under the MOTU Audio System, you may also get an error message if available RAM is tight.

If you get such an error message, try optimizing the hard disk with defragmentation software. You can also try adjusting the buffer size of the MOTU Audio System as described below.

Adjusting buffer sizes to avoid playback error messages
Sometimes adjusting the size of the MOTU Audio System disk buffers can help. For details, see “Configure Studio Settings” on page 23.

If you experience a crash or other interruption while playing or recording
When Performer Lite begins recording or playback, it allocates a large amount of the free space on your audio hard disk to the current take files. If audio recording (or playback with at least one track record-enabled) is ever interrupted at this point due to a power failure or system error, this free space will remain allocated to the interrupted takefiles. When this happens, The next time Performer Lite is launched, it displays the Rescued Takefiles dialog.

This dialog shows partially recorded takefiles and allows you to recover or delete these files. You can click the takefile to audition it and determine whether there is useful audio data in it. In most cases, you should choose to delete the files. If you believe that important audio data exists in the files, use the Recover button to move the file into the Trash. You can then drag the file out of the Trash and then extract the important audio data from the file. You should choose to either recover or delete these files. Otherwise, they will needlessly take up hard disk space.

Before auditioning soundbites in this window, turn down the volume of your sound system or headphones, as the results can sometimes be random noise at full volume (0 dB).

If you suddenly have very little hard disk space free
See the previous section regarding the rescue of takefiles after a crash or other interruption during playback and recording.

If the screen redisplay gets jerky
During playback, Performer Lite does its best to update items on the computer screen, such as the Counter and scrolling windows. However, audio recording, playback and effects processing can place a high demand on the computing power of the machine, and Performer Lite makes playback a higher priority than refreshing the screen display. Therefore, you may find at times that the counter will stop and start during playback or recording. This effect is minimized on faster computers.

If you run out of disk space
If you run out of hard disk space, compact existing audio files and delete unused audio files. For details, see “Compacting audio files” on page 576.

TECHNICAL SUPPORT
We are happy to provide customer support to our registered users. If you haven’t already done so, please take a moment to visit motu.com/registration (or complete and mail the Competitive Upgrade envelope if you purchased the Performer Lite Competitive Upgrade). Then you’ll be properly registered for technical support.

Registered users who are unable, with their dealer’s help, to solve problems they are encountering with Performer Lite may contact our technical support department in one of the following ways:

- Phone: (617) 576-3066
- Online: www.motu.com/support
■ Web site (for information, tech support database and downloads): www.motu.com

Technical support is staffed Monday through Friday 9 AM to 6 PM, Eastern Time.

If you decide to contact technical support, please have your Performer Lite manual at hand, and be prepared to provide the following information to help us solve your problem as quickly as possible:

■ **The serial number of the program.** This is printed on the cardboard page at the front of the User Guide. (If you purchased Performer Lite as an upgrade, your manual won’t have this cardboard page. Instead, MOTU will have notified you separately of your serial number.) Be sure to retain this page in the manual for your reference. You must be able to supply this number to receive technical support.

■ **The version of Performer Lite you are working with.** This is displayed briefly in the start-up screen when Performer Lite is started; it is also available through the *About Performer Lite* command in the Performer Lite menu from within Performer Lite.

■ **A brief explanation of the problem**, including the exact sequence of actions which cause it, and the contents of any error messages which appear on the screen. It is often very helpful to have brief written notes to refer to.

■ **The pages in the manual** which refer to the parts of the program which you are having trouble with.

■ **The version of the system software.**

We’re not able to solve every problem immediately, but a quick call to us may yield a suggestion for a problem which you might otherwise spend hours trying to track down.

Our technical support telephone line is dedicated to helping registered users solve their problems quickly. In the past, many people have also taken the time to write to us with their comments, criticism and suggestions for improved versions of our software. We thank them; many of those ideas have been addressed in this version of Performer Lite. If you have features or ideas you would like to see implemented in our music software, we’d like to hear from you. Please visit motu.com/other/feedback/suggestions, or write to the Performer Lite Development Team, MOTU Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138.

Although we do not announce release dates and features of new versions of our software in advance, we will notify all registered users immediately by mail as soon as new releases become available. If you move or otherwise change your mailing address, please send us a note with your change of address so that we can keep you informed of future upgrades and releases.
Auto Zoom Track 276
Auto/Manual end time 210, 214
Auto-locating 46
Automated mixing 171, 462
Automatic Conversions 194, 204, 229
preferences 229
Automatic Conversions Settings 194
Automatic Plug-in Latency Compensation 24, 494
Automatic tempo mode 435
Automatically Add Inserts 160
Automation
modes 466
show lanes 297, 318
snapshot 475
Automation Setup window 463, 479
AutoPan (see DP Plug-ins Guide)
Auto-Record 99-100
loading remembered times 286
Tap Tempo 563
Autosave preference 229
Aux tracks 70-71, 174
applying effects to 500
Average Bit Rate 542
Backup copies of files 81, 590
Barlines 147
Base CD Tracks On menu 544
Bassline instrument plug-in (see DP Plug-ins Guide)
Beat click 419
defined 96
Beat clocks (see MIDI beat clocks)
Beat Detection Engine 400
disable/enable beats
Beat division (in Groove Quantize) 363
Beat Grid 105, 406
Beat value 92
Counter window 91
meters 443
tempo 435, 437
Beats per minute 92
Beats within soundbites 352, 353
Bite
Gain 311, 321, 385
Bite volume 321
Blend (patch thru) 257
Bounce to Disk 536-548
in real time 550
movies 547
MP3 format 541
offline bounce 538
outputs 540
QuickTime movies 270
Sample Format 539
source 540
stems 536, 540
track bouncing 62
tracks 540
bpm 93
Broadcast WAVE 205
Buffer Size 21
Built-in audio
improving performance 19
input monitoring 257
Bundles window 238
importing/export bundles 240
instruments tab 69, 241
MIDI Devices tab 26, 241
Burn Audio CD option 543
Bus
applying audio effects to 500
defined 173
Buses
setting number of 23
Byte 411
Capture start time 565
Cascade overlapping markers option 127
CD
burning 542
importing 205
Chaining
sequences 210, ?-210, 214-??, 214-??
sequences$startrange> 210
Change Duration 371-373
plug-in 503
Change Key 418, 448-450
custom key signatures 449
Notation Editor 137
Change Meter 418, 443-447
Adjust durations 443, 446
denominator 443
meter maps 424, 444
Notation Editor 137
numerator 443
Only move barlines 443, 446
Realign music automatically 443,
445-446
Change Selected Notes to Automatic Durations 133
Change Selected Notes to Manual Durations 133
Change Tempo 419, 435-442
Anchor indicators 435, 438
beat value 435, 437
curves 438-440
density 436, 438
mid-beat 440
Notation Editor 137
Options 436, 441
Change Velocity 170, 367-371
compress 368
expand 368
limiting velocities 368
Channel
audio 57-62
Channel Strip window 42, 336
Channels ?-51, 215-?
playback ?-51, 53, 215-??, 245-246, 253
recording 252, 255
Tap Tempo 560-561
Chord Play 507
Chord symbols 134-135
Clear
all clipping indicators 170
Arrangement 120
Bite Gain 385
Bite Stretch 407
Bite Volume 385
Continuous Data Color 298
default patch 105
Keyboard button 375
MIDI Controller command 160
Movie 269
Mute Automation 310, 474
Pitch 386, 522, 526
Pitch Control Points 386, 522
Clear Beats 386, 402
Clear Mixer MIDI Controller 182, 189
Click 96-?
accented 96, 98
beat click 419
change event 419
pattern click 420
sound 96
tacet 420
value 96, 418, 443, 444, 445
Tap Tempo 560
volume 97
Click preferences 96
audition click 98
No accent 98
Clicks per frame (display) 419, 437
Click-to-MIDI converter 564
Clip Editor 187
opening 317
Clipping
indicators in Mixing Board 170
Clips
editing 315-?, 317, ?-317
looping 317
Sequence Editor 315-317
Clips window 179-189
Editor 187
Ink Clip to Master 185, 187
MIDI binding 187
Clock Source 21
Cloning 307
Close All Effect Windows command 43, 490
Close All Windows command 43
Close command (Window menu) 43
Color schemes 54
Colors 54
Assign Track Colors 56
Clear Continuous Data Color 298
color scheme 54
Edit Track Color Schemes 54

INDEX
Reset Continuous Data Color To Default 298
Set Continuous Data Color 298

Column setup
Soundbites list 194

Columns Setup 194

Commands
Run command 236
Tap to Enter Tempo 92, 94

Comments
Conductor Track 418
Set List 210, 213, 415-416

Comp takes 388-392

Compact disc
burning 542
Compact disc (see CD)

Compare 492

Composite tracks 62

Conductor Track 421-424

click change 419
Edit commands 422-423
key changes 418
looping 424
Markers 419

meter changes 418
partial measures 423-424
meter maps 424, 444
recording 562
Sequence Editor 424-425

Crescendos 367, 370
Decrescendos 367, 370

Default patch 65
DeFlam 358, 367
Delay compensation 24, 494
pitch automation 520

Delete Fades command 383
Delete if before start of chunk option 432
Delete Mix command 178
Delete Track Folders 73
Delete Track Group 77
Delete Tracks 54
Delta Fuzz (see DP Plug-ins Guide)
Denominator 443
Deselect All 341
Device

Patch 65
Diamond Drive (see DP Plug-ins Guide)
Diatomic transposition 347-348
Digital video (see Movie Window)
Diminuendo 367, 370
Direct Echo 255
Direct hardware playthrough option 259
Disable Beats under Strength Threshold 386, 402
Disks
   errors 85
   keeping enough free space 590
Display menu 139
Display Resolution 121
Display-only notes 119, 149
Divide Comp at Selected Soundbite Boundaries 392
Divide Comp at Selection Boundaries 392
Do not import option (Bounce to Disk) 540
Do to Selected Measures
   Hide 145
   Move 147
   Pop Out 147
Don't move locked markers 432, 446
Don't Pitch Shift 527
Double Soundbite Tempo 397
Double strike notes 508
Dragging & dropping soundbites 203, 307
Drop frame 29.97 555
Drum machine
   Patch Thru 256
   short note durations 373
   transposing 350-351
Duplicate 339
   Sequence 210
   sequence 211
   Track Layout 210, 211
Duplicate audio data and copy shared samples to project 82
Duplicate Mix command 178
Duplicate Take 387
Duplicate Tracks 54
Duplicates, Remove 510
Duration 292, 295
   adjusting short durations 373
   Change Duration 371-375
   Change Duration plug-in 503
   drum machines 373
   Scale Time 379
   soundbites 196
Dynamic Equalizer (see DP Plug-ins Guide)
Dynamics 166
   audio 463
Dynamics (Mixing Board) 166
Dynamics Palette 119

E
 Echo
   applying to your playing 256
   MIDI echo 254-256
   synchronization 256, 568
   Echo effect 504
Edge
   Edit Copy 106, 313
   Audio Export Formats 194
   grid 105
   Resolution 105
   scales button 344
   Edit commands
      Edit windows 278
      Markers 431-??
      selecting region 109, 294-295
   Edit Layer menu 111
   Edit menu 337-341
      Copy 337
      Cut 337
      Deselect All 341
      Duplicate 339
      Erase 339
      Merge 339-340
         At Original Time 340
         At Original Time Multiple 340
         At Wiper 340
         At Wiper Multiple 340
      Paste 338
         At Original Time 338
         At Original Time Multiple 338
         At Wiper 338
         At Wiper Multiple 338
      Redo 337
      Repeat 339
         Conductor track 424
      Select All 340-341
      Trim 340
      Trim Audio 340
      Trim End 340
      Trim Start 340
      Undo 337
      Undo History 272
      Edit resolution box 278, 331-332
      Edit Selected Measures
         Hide 120
         Move 120
         Pop Out 120
      Edit System Margins 118
      Edit windows
         editing 277-278
         selecting events
            Note grid 277
         Shift key 277
      Editing
         audio 573
         Counter 46
         during playback 85, 88, 246, 272
         Markers 419, 428-429, 431-??, 431
         selecting 332
         selecting data for editing 281
         sequences 210-211, 211-212, 213-214
         System Exclusive 412-414
         tracks 284
      EDL (creating with Find Tempo) 455
      Effects
         accessing 161
         Next/Previous Preset 492
         side chain input 501
         window 494
      Effects window 488
         and Patch Thru 256
         applying effects 175
         closing 490
         compare presets 492
         copying & pasting parameters 176
         opening 490
         plug-ins 493
         Presets menu 490
         quick reference 488
         User Presets 491
      Emphasis 382
         quantizing 357
         tempos 441
         velocities 370
      Enable Mouse Wheel for Sliders and Knobs 159
      Enable Multi-Queue 182
      Enable Preview (Content Browser) 192
      Encoding mode 542
      End time
         Auto/Manual 214
         Set List 210, 212, 214
      Endings 148
      Enter Chord Symbol 134, 141
      Enter/Exit Fullscreen 43
      EQ 488
      EQ (Mixing Board) 166
      Equal Gain fade 326
      Equal power fade 326
      Erase 339
      Error messages 590, 591
         audio playback/recording 591
      Errors
         disk 85
         file 85, 590, 591
         fonts 141
         system 590, 593
      Event & Phrase Selections Only command 282
      Event Chasing 247-??
         forward chasing CCs 249
         importance for automated mixing 171
      Event Information 333-334
      Event List window
         Markers 431-??
      Events
         selecting 283
         Tap Tempo 560-561
      Exclude soundbites 352, 353
      Expansion board setup 27, 243
      Export key bindings 237
      Export Selected Soundbites 194, 207, 552
      Exporting
         audio export presets 207
         bundles 240
         movies 547
         MP3 files 207, 541
         MusicXML notation file 153
         QuickTime movies 270
      Extend releases to closest attack 372-373
      External time code option 565
### INDEX

- Extracting grooves 364
- Extracting parts 376

**F**
- Factory presets (plug-ins) 491
- Fade command 383
- Faders temporarily removing from group 77
- Fades command 322
- FAQs 579
- Fast forward/rewind 88, 232
- File Format
  - conversion 511
- File menu
  - Exit 85
  - Export MusicXML notation file 153
  - Import Audio 194
  - New 80
  - Open 81
  - Open Recent 81
  - Page Setup 84
  - Print Window 84
  - Revert to Saved 83
  - Save 81
  - Save a Copy As 81
  - Save As 81
- Files 85
  - errors 85, 590, 591
  - opening new file 81
  - Revert to Saved 83
  - Save As 81
- Film Cues Only 123, 151
- Film Cues View 150
- Film Scoring Events 268
- Film/video
  - hit points 425, 431, 432-433, 434
  - Markers 425-434
  - partial measures 423-??
  - synchronization 432-433, 554-555
  - tempo maps 436-437
- Filter frequencies below 10 Hz 542
  - Filters
  - Input Filter 252
  - Patch Thru 256
  - System Exclusive 412
- View Filter
  - Markers 433
- Find Beats 386, 402
- Find Tempo
  - command 455
  - for Locked Markers 427, 456
- Find Tempo Factor Near Sequence Tempo 397
- Fixed (Snap to Grid) 331
- Float Effects by Default 489
- Floating 489
- Folders
  - soundbites (see Soundbites list)
  - tracks (see Track folders)
- Fonts
  - installing in text menu 141
- Frame Rate 555
- Frame time 90-91
- Frame-click tempo display 419, 437
- Fullscreen 43

**G**
- Gain (in velocity compressor) 503
- Generate Streamer Track for 427
- Generate VTP Streamers option 427
- Go To
  - Marker 429, 430
  - Grand staff
    - bracket 124
- Grid
  - Continuous data 296-??
  - MIDI Editing Note Grid 290, 292-??
  - offset 355
  - Quantize 352, 354-355
- Groove Editor 365
- Groove Quantize 358-367
  - applying a groove 359
  - creating a groove 364
  - deleting, moving, duplicating 361
  - Groove folder 361
  - grooves defined 359
  - Move Controllers and Automation 360
  - renaming a groove 361
- Grouping (see Track Groups)

**H**
- Halve Soundbite Tempo 397
- Hand tool 226, 291, 305
- Handshake 416
- Hard disk
  - access time 266, 592
  - compacting audio files 576-578
  - deleting audio files 575-576
  - fragmentation 266, 591
  - managing audio files 575-578
  - recommendations 572
  - requirements 572
  - running out of space 592
  - size of files on disk 571
  - spreading audio over several drives 575
- Hardware
  - requirements 25
  - setup 25-??
- Hardware Insert (see DP Plug-ins Guide)
- Harmonic transposition 348
- Harmonies
  - creating 347
  - Harmonizing 344
- Help menu
  - Show Help Tags 587
  - Hexadecimal 411, 412-413
  - Hide Lanes 318
  - Hide markers when showing _ or more bars per line 127
  - Hide measures in sequential bars 146
  - Hit points 425, 432-433, 434
  - Hit range before/after 456
  - Hi-Top Booster (see DP Plug-ins Guide)
  - Hold Notes 508
  - Humanize
    - existing tempos 382
    - tempos 440-441

**I**
- I-Beam tool 222
- Ignore Mistakes 124
- Import Audio command 194
- Import key bindings 237
- Import Movie Audio 270
- Import option (Bounce to Disk) 540
- Importing
  - Acid files 205, 207
  - AIFF files 205
  - Apple Loops 205
  - audio (entire file) 205
  - audio (Soundbites) 194, 204-207
  - bundles 240
  - CD audio 205
  - MP3 files 205
  - REX files 206
  - Sound Designer II files 205
  - WAVE files 205
- Importing audio 204
- Include in Find Tempo Range 427, 456
- Information Bar 107, 330
  - Edit grid 331
  - Edit resolution box 278
  - preferences 107
- Information windows 336
- Input Filter 252
  - Patch Thru 256
  - System Exclusive 412
  - echo options with Patch Thru 256
- Interapplication MIDI 29
  - Render quality 30
  - Software synthesizer 30
- Interface 25-??
  - playing from computer keyboard 65
  - Instruments tab (Bundles window) 69, 241
  - Intelligent Noise Gate (see DP Plug-ins Guide)
  - Interapplication MIDI 29
  - Render quality 30
  - Software synthesizer 30
- Interface 25-??
  - echo options with Patch Thru 256
- Interleaved Format
  - conversion 511
  - Interleaved format 570
  - Interval transposition 346
  - Invert Phase (see DP Plug-ins Guide)
  - Invert Pitch 377
### K
- Key changes 418, 448-450
- Conductor track 418-450
- custom key signatures 449
- Edit windows ??-450
- editing 450
- Sequence Editor 110
- Key/scale transposing 348-349
- Keyboard commands 45-46
- Customizing 46
- Keyboard controller 254-255
- changing values from 295-296, 300-301
- Keyboard note entry (computer) 65
- Keyboard parts, splitting into right/left hand 374, 376-377
- Keypad 89
- troubleshooting 47
- Keypad controls 100-101

### L
- Lasso selection 282
- Latch mode 467
- Latency compensation 24, 494
- pitch automation 520
- Lead line
  - enhancing 376
  - extracting 376
- Learn Controller 175
- Learn controller 488, 489, 500
- Legato 372-373
- Level meters
  - Mixing Board window 170
- Link Clip to Master 185, 187
- Live performance
  - cueing sequences 212-213, 214-215
- Live Room B (see DP Plug-ins Guide)
- Live Room G (see DP Plug-ins Guide)
- Live Stage (see DP Plug-ins Guide)
- Lock 426, 432
- Lock Marker 427
- Locked tracks 111
- Locking markers 426, 427, 432
- Loop recording (see Cycle-recording)
- Loops
  - Conductor Track 424
  - graphic editing of 317
  - meter changes 424
  - recording (see Cycle-recording)
- Loops (clips) 317
- Lyrics 141-143
  - arranged score 143
  - hiding 143
  - Notation Editor lyrics options 118
  - preferences 143

### M
- Mac
  - built-in audio performance 19
  - requirements 15
  - Mac keyboard shortcuts 100-101
- macOS
  - Audio MIDI Setup 28
  - Core MIDI 28
- Magnifying glass tool (see Zoom tool)
- Make Arrangement Markers 120
- Manual button 92-93
- Manual end time 210, 214
- Manual tempo mode 435
- Margins 129
- Marker strip
  - Sequence Editor 104, 109
- Markers 425-434
  - changing font in notation window 127
  - changing location 429, 432
  - Conductor Track 419, 431
  - Deleting 427, 431
  - displaying in Notation Editor 127
  - Event List window 421-22
  - Find Tempo 455
  - Generate Streamer Track for 427
  - Generate VTP Streamers 427
  - hit points 425, 432-433
  - hit range before/after 456
  - locating with 429
  - Lock 426, 432
  - Lock Marker 427
  - Make Arrangement Markers 120
  - mini-menu 427
  - naming 426, 428
  - New 428
  - New Marker 427
  - New Marker with Options 427, 428
  - Notation Editing window 431-450
  - Notation Editor marker options 118
  - NUM (locate number) 426, 429
  - opening Markers window 428
  - position indicator 426, 429
  - printing 84
  - Record hits 427, 432-433
  - selecting 430
  - Set Marker/Streamer Options 427
  - setting Counter location 429
  - Shift locked markers 427, 432
  - show streamers 427
  - snapping to 110
  - time display 426
  - Toggle Streamer On/Off 427
  - Unlock 427, 432
  - weight 456
- MAS plug-ins 495
  - delay compensation 24
- Master faders 174
  - applying effects to 500
  - tracks 71
- Mastering 549
- MasterWorks Compressor 167
  - (see also DP Plug-ins Guide)
- MasterWorks EQ 167
  - MasterWorks EQ plug-in
    - (see also DP Plug-ins Guide)
- MasterWorks FET-76
  - (see DP Plug-ins Guide)
- MasterWorks Gate 167
  - (see also DP Plug-ins Guide)
- MasterWorks Leveler
  - (see also DP Plug-ins Guide)
- MasterWorks Limiter 167
  - (see also DP Plug-ins Guide)
- Measure numbers 118
  - display options 128
- Measure range
  - Change Key 444, 448, 449
  - Change Meter 443, 445
  - selecting 334-336
- Measure spacing 118, 119, 128
- Megav3 (see DP Plug-ins Guide)
- Melodic Pattern 507
- Melody
  - enhancing 376
  - extracting 376
- Memory Bar ??-99
  - loading Remembered Times 286
- Memory Cycle 98
  - selecting the region 99
  - Sequence Editor strip 99, 104, 110
  - when applying a groove 359
- Memory-shuttle 98-99
- Merge 339-340
  - At Original Time 340
  - At Original Time Multiple 340
  - At Wiper 340
  - At Wiper Multiple 340
- Merge Soundbites 383
- Meter
  - display 92
  - Meter changes 418, 443-447
  - Conductor Track 418
  - editing 447
  - looping 424
  - partial measures 423-424
  - Sequence Editor 110
- Meter maps 424, 444
- Mid-beat 440
- MIDI
  - arpeggiator 504
  - beat clocks (see MIDI beat clocks)
  - binding (Clips) 187
  - channels 51, 215
  - playback ??-51, 53, 215-216
  - recording 51
  - Tap Tempo 560-561
  - controller
    - instruments 37
  - controllers
    - controlling volume 370-371
    - Input Filter 253
    - Tap Tempo 561, 563
  - Controllers and Track Automation
    - option 354
- data stream 247
- Device Properties 27, 242
- Devices tab (Bundles window) 26, 241
- discrete events 303
- echo 254-256
MW FET-76 (see MasterWorks FET-76 in DP Plug-ins Guide EQ)
MW Gate (see MasterWorks Gate)
MW Leveler (see MasterWorks Leveler)
MW Limiter (see MasterWorks Limiter)

N
Naming
Files 81
Markers 426, 428
sequences 209
Tracks 51
Nanosampler instrument plug-in (see DP Plug-ins Guide)
New Audio File 194
New Audio File from Selected Soundbites 194
New Marker 427, 428
New Marker with Options 427, 428
New Mix command 178
New Sequence 210, 211
New Soundbite Folder 194
New Soundbites from Beats 386, 403
New Take 387
New Track Folder 73
New Track Folder from Selected Tracks 73
New Track Group 73, 77
New Track Group command 73, 160
New V-Rack 210, 211
Next/Prev follows Marker Nums 427
No accent option 98
No pitch shift 520
Non-destructive editing 307, 573
defined 570
explained 278
Normal Notation 123, 151
Normal noteheads 133
Notation Editor 116-??
Allow Measure Selection 120
Arrangement 144
Arrangement palette 119, 147
Barlines 147
Change Meter/Key/Tempo 137
chord symbols 134-135
Chord Symbols options 118
Clear Arrangement 120
Consolidate Rests 120, 148
date 140
displaying markers 127
Display-only notes 119, 149
Do to Selected Measures 145
Hide 145
Move 147
Pop Out 147
dragging notes 132
Dynamics palette 119
Edit Selected Measures 145
Hide 120
Move 120
Pop Out 120
Edit System Margins 118
Endings 148
Exporting as MusicXML notation file 153
Film Cues Only 123, 151
Ignore mistakes 124
inserting notes 130
Lyrics options 118
Make Arrangement Markers 120
margins 129
Marker options 118
markers 127
Measure numbers 118
measure numbers 128
Measure spacing 118, 119
Normal Notation 123, 151
Notation+Film Cues 123, 151
Open Selected Ending Bracket 120
opening, opening multiple 120
Options 123
page numbers 140
page size 129
Pixel offsets 124
Playback-only notes 119, 149
Print Individual Parts 119
Repeat barlines 147
Score Options 118, 123
scrubbing with the wiper 250
Segno 148
Set Score Length 118
show alternate bar menus 123
show arranged score 119
show film cues 150
show film tools 119
show lyrics 119, 143
show tools 119
Split Selected Normal Notes 119
Switch Staff 119
Text 138
Tool palette 129
Track Options 118
track splitting 125
Notation Editor 116-??
Note events 128
doubling 376
mapping to single pitch 350
MIDI Editing 290, 292-296, 298-??
Notation Editor 130
Note grid 128
MIDI Editing 290, 292-296
Notehead size 133
NRPN 510
Nudging 332
in the MIDI Editing 295
Num Lock Key (Windows) 47
Numerator 443
Numeric Base 236, 429, 430
Numericals 46
Octave range 128
transposing 349-350
Off velocities 368, 375
MIDI Editing 298
Offline Bounce 538
Offline Processing setting 516
Offset
SMpte 91
sequence start time 90-91
Offset grid option 355
On velocities 368, 375
MIDI Editing 298
One new track option 374
One track option 374
Only during countoff option 98
Only move barlines 446
Only when recording option 98
Open Audio MIDI Setup command 64
Open Movie window 269
Open Recent sub-menu 81
Open Sequence 210
Open Selected Ending Bracket 120
Options 436, 441
Output column 64
Overdub 94-95, 262-263
Override internal buffer size 21
Overwrite Existing Files option 541
Overwrite mode 467
Overwrite Mode changes to Touch after pass 479
Pack into Clips 316
Page numbers 140
Page Setup 84
Page size 129
Palette 129
Panic 250
Panning 169
curve, removing 320
curves, inserting 319
curves, reshaping 320
cut, copy, paste 321
deleting and event (point) 320
disabling automation temporarily 321
graphic editing of 317
Partial measures 423-??
Paste 338
At Original Time 338
At Original Time Multiple 338
At Wiper 338
At Wiper Multiple 338
Conductor track 422-423
deleting and event (point) 320
disabling automation temporarily 321
dragging notes 132
dynamics palette 119
dynamics, inserting 319
dynamics, reshaping 320
expansion boards 27, 243
printing 84
Patch change events 303
Patch chasing 247-??
Patch Lists 65
expansion boards 27, 243
printing 84
Patch Thru 65
applying MIDI effects 175
Audio 257
in Background option 257
Input Filter 256
MIDI interfaces 256
timing information 256
Pattern click 420
Pattern Gate (see DP Plug-ins Guide)
Patterns
  Cycle (see Memory Cycle)
  see Memory Cycle
Pencil tool 222
Performer
  as master sync device 566-568
  as MIDI merger 256
  Cycle-record 264
  overview 36
  Producer Pack 192
  project 79-86
  version number 593
Performer menu
  Quit 85
phrases
  auditioning 280
Piano parts
  splitting into right/left hand 374, 376-377
Piano roll 37
Pick-up
  measures 91
Pitch
  automation 520
  Automation Playback setting 24, 494
  transposing 247-250
Pitch (Track settings menu) 228
Pitch and Stretch 385, 522-524, 526
Pitch and Time Stretch options 232
Pitch bend
  MIDI Editing 296, 297-298
  Pitch ruler 290, 293-294, 295-296
  zooming 293
Pitch segments 523
Pitch-shifting 513-518
Pixel offsets 124
Places 191
Play button 87-88
Play on Clip Queue 181
Playback 52, 245-250
  audio 57-62
  channels 53, 245-246, 253
  chasing during 247-250
  controller chasing 247-250
  features active during 88, 246
  locating with mouse 109
  scrubbing 250
  selecting a device 64
  sequence 212-213, 212-213, 212-213
  System Exclusive 411-412
  track play assignment 64
Playback dashes 89
Playback-only notes 119, 149
Play-Enable button 52, 245, 246-247
  Set List 209, 212-213
Play-enabling sequences 209
player piano 37
Playlists
  building in Sequence Editor 308
  defined 573
Plug-in management 497
Plug-ins 493
  (see also DP Plug-ins Guide)
  accessing 161
  Audio Units (see Audio Units)VST plug-ins
  delay compensation 24, 494
  effects presets 490
  floating windows preference 500
  instruments 67-69, 171
  latency compensation 24, 494
  Learn controller 488, 489, 500
  management 497
  MAS 495
  MIDI effects 377
  MIDI Learn 488, 489, 500
  preferences 497
  ramp event density 499
  scanning Audio Units
  virtual instruments 67-69, 171
  VST (see VST plug-ins)
Pointer Coordinates (see Cursor Information)
Pointer tool 221
PolySynth instrument plug-in (see DP Plug-ins Guide)
Post-fader sends 165
Postroll 335
file-based plug-in previewing 495
Pre-fader sends 165
Preferences 228, 229
  Ask before closing 229
  audio plug-ins 497
  Autosave 229
  Chord Symbols 135
  Click 96
  Countoff 95
  Cursor Selection Mode 282
  data display 229
  Film Scoring Events 268
  Information Bar 107
  Lyrics 143
  MIDI Editing 230
  MIDI Solo & Patch Thru 231
  Punch Guard 516, 529
  Receive Sync 555
  Region Commands 343
  Soundbite List 195
  Tool palette 231
  Tools 231
  Transmit Sync 566
  Transport 232
  Undo Pruning 231
Preferences & Settings command 228
Pre-generation (pre-gen) 494
Preroll 335
file-based plug-in previewing 495
Preserve current frame time option 432
Preserve length of time from start of chunk option 432
Preset s
  effects 490
  Region menu 343
Preview check box 343
Preview Stays on when Window Not in Front 343
Primary external plug-in format 499
Prime Milliseconds 23
Print Individual Parts 119
Print Window 84
Printing 83-84, 116
  instrument parts 152
  keyboard part 153
  list windows 84
  margins 129
  page size 129
  score 153
  title page 123
Project 79
  Content Browser 191
  creating new 80
  opening 81
  saving 81
Project folder 79
  defined 572
Project menu
  Add Instrument 67
  Add Instrument with Options 67
  Add Similar Tracks 53
  Add Track 53, 57, 63, 260
  Add Unassigned Instrument 68
  Adjust Beats 452
  Change Key 418, 448-450
  Change Meter 418, 443-447
  Change Tempo 419, 435-442
  Content Browser 191
  Delete Tracks 54
  Duplicate Tracks 54
  Effects 68, 493
  Insert Measures 451
  Markers 425-434
  Mixing Board 156-178
  Modify Track Groups 73, 174
  Movie 267
  New Track Group 73
  Notation Editor 116-155
  Project Notes 83
  Sequence Editor 102-115, 116-321
  Soundbites 193-208
  Suspend Track Grouping 77
  Track folders 73
  Track Groups 73, 74, 174
  Ungroup Tracks 74
  Project Notes 83
  Propellerhead Reason
  multiple outputs 69, 501
  ProVerb (see DP Plug-ins Guide)
  ProSynth instrument plug-in (see DP Plug-ins Guide)
  Proverb (see DP Plug-ins Guide)
  Preroll 335
  preferences 231
  Punch Guard
  preferences 516, 529
  PureDSP solo vocal 520
INDEX

Push Window to Back command (Window menu) 43

Q
Quantize 352-358
   Attacks 352-353
   beats within soundbites 352, 353
   custom edit filter 352, 353
   Don't change note durations option 353
   Durations 352-353
   Exclude soundbites 352, 353
   for notation 121
   grid 352, 354-355
   MIDI Controllers and Track Automation option 354
   Move audio effect plug-in automation with soundbites option 353
   Move MIDI controller events with notes 353
   non-destructive (without changing actual data) 509
   Offset grid option 355
   Quantize MIDI controller events to grid 353
   Releases 352-353
   Sensitivity option 355-356
   Strength 356-357
   Swing 355
tuplets 354
Quantize (MIDI effects processor) 509
Quantize MIDI controller events to grid 353
Quantize Pitch 386, 526
Question mark icon (on move handle) 196
QuickTime Export 547
QuickTime video (see Movie Window)
Quitting Performer 85

R
RAM
   recommendations/requirements 15
Ramp event density 499
Random Access
   defined 570
Randomize
   quantizing 357
   tempos 382, 440-441
   velocities 370
Range Latch mode 467, 470
Range Selections Only 282
Range Touch mode 467, 470
Range Trim Latch mode 467
Range Trim Touch mode 467
Ratio (in velocity compressor) 503
Real time
   editing 85, 88, 246, 272
Realign music automatically 445-446
Reason
   multiple outputs 69, 501
Reassign Continuous Data 510
Receive Sync 554-565
preferences 555
Recent Files pop-up menu 360
Record hits 427, 432-433
Record while still-framed 265, 556
Record With Overdub Off 263
Record With Overdub On 263
Recording 88, 99-100, 251-265
   audio 254-266
   audio with MIDI 261
   Auto-Record 99-100
   Bar 99-100
   button 99-100
   Tap Tempo 563
Conductor Track 352
   hits 427, 432-433
   in a sequence 212
   in external sync 265
   Input Filter 252
   Overdub 262-263
   real-time 253-255
   Record channels 252
   Record-Enable button 59, 64, 253
   sequence 212
   stereo 260
   System Exclusive 411-412, 415
   Tap Tempo 562, 562, 563
   Undoing 88
   Recover Takefiles dialog 592
   Recycle
   importing files 205
   Red outline (soundbites) 307
   Redo 337
   Redo/Undo
   Edit windows 278
Region
   defined 573
   Region Commands
   preferences 343
   Region menu 342-382
   Audition Selection 247, 280, 282
   Change Duration 371-373
   Change Velocity 367-371
   compressing 368
   limiting 368
   limiting velocities 368
   Create Groove 364
   DeFlam 358, 367
   editing on audio 272
   Groove Quantize 359
   Invert Pitch 377
   MIDI Effects Plug-ins 377
   Pack into Clips 316
   Presets 343
   Quantize 352-358
   Retrograde 378-379
   Reverse Time 378-379
   Scale Tempo 381-382
   Scale Time 379-381
   Split Notes 374-377
   Transpose 343-351
   Unpack Clips 316
   windows that stay open 342
Region selection
MIDI Editing 294-295
Sequence Editor 109, 284
   using Markers 430-431
Registration
   card 593
   number 593
Releases
   Extend Releases to Closest Attack 372-373
   Move Releases to Closest Attack 372
   Quantize 352-353
   Remember Times 268, 430-431
Remote Controls
   cueing with 212
   Cycle-record control 264
   Enter Counter options 335
   Play-enabling sequences 214
   Play-enabling with 212
   printing 84
Remove Duplicates 510
Remove from Find Tempo Range 427, 456
Remove from list 194, 202-203, 578
Remove Tracks from Group 77
Rename Mix command 178
Rename Take 387
Render quality 30
Renumber by Name 427
Renumber by Time 427, 430
Repeat 339
   Conductor track 424
   Repeat barlines 147
   Repeat bottom/top note 507
   Reset Continuous Data Color To Default 298
   Reshape Mode menu 223
   Reshape tool 223
   Retina display support 15
   Retrograde 378-379
   Reveal In Finder 307
   Reveal Movie in Finder 269
   Reveal Presets in Finder/Explorer 343
   Reverb 488
   Reverse Time 378-379
   Revert to Saved 83
   Rewinding 88, 99-100
   Markers 426, 429
ReWire
   multiple outputs 69, 501
   REX files
   importing 205, 206
   Right-click menu (see Contextual menu)
   Ritard 438, 560
   Roll tool 226
   Round on Entry 89
   RPN 510
   Rubato 560
   Run command 236
   RXT (see DP Plug-ins Guide)
Sample
   format conversion 511, 512
   rate conversion 205, 511
   Sample Format 265, 539
INDEX

Reset Continuous Data Color
To Default 298

Set Continuous Data Color 298

Commands 234

Configure Audio System
Input Monitoring Mode 259
MOTU Audio System 254
Event Chasing 248
Frame Rate sub-menu 555
Input Filter 252
Patch Thru 256
System Exclusive 412

Shade Notes using Velocity 230
Shift
non-destructive (without changing actual data) 510
Shift locked markers 427, 432
Shortcut commands 46
Show
Active Layer Only 274
Alternate Bar Menus 119
Arranged Score 119
Clip Editor 182
Film Cues 119, 150
in Explorer 307
Lanes 297, 318
Lyrics 119, 143
Mixer (Clips window) 182
Movie in Explorer 269
note pitch 230
Notes When Scrolling Offscreen 231, 292
notes with gradient 230
notes with rounded corners 230
Presets in Finder/Explorer 491
Streamers 427
Times 106
Tools 119
velocity as bar 230
Show/hide takes 388
Side chain input 501
Skip buttons 214
Skip Master Fader tracks 61
Slave to External Sync 561
Tap Tempo 564-565
Slide tool 226
Sip tool 226
Slow forward/rewind 88, 232
Small noteheads 133
Smart Selection 286-288, 336
check box 336
how it affects pasting 288
Smart Selections 338, ?-341
helping with editing conductor track 423
helping with meter editing 447
how it affects pasting 338
Smooth Audio Edits 383
Smooth Audio Edits Again 383
SMPTE 554-555
29.97 drop & non-drop 555
bit offset 91
bits per frame 91
converters 555
Drop frame 555
Frame Rate 555
frame time display 91
MIDI beat clocks 559
offset 90
Set Sequence Start 90-91
SMPTE-Z (see DP Plug-ins Guide)
Snap Information 331-333
Snap Relative 105, 332
Snap to Beat 332
Snap to Grid 331
Snap to Markers 332
Snapshot

to set initial levels with 171
Snapshot automation 479
Snapshot button 158
Software synthesizer 30
Solo & Play Phrase override mute
automation 479
Solo button
exemption 52, 171
in Mixing Board 168
Solo exception 52, 171
Soloing tracks 246-??
exemption 52, 171
Soloist (see DP Plug-ins Guide)
Song Position pointer 555
Song Select 209-210, 212-??
Song window
Delete Markers 431
Sonic Modulator (see DP Plug-ins Guide)
Sort by file name 200
Sort by name
Soundbites 200
Sort by size 200
Sound Designer II files
 importing interleaved 194, 207
Sound effects
stutter 310
Sound file (see Audio file)
Sound module 256
Soundbite
Tempo sub-menu 386
Soundbite List
preferences 195
Soundbites 193-??
‘X’ icon 201
‘throwing’ 309
applying Region operations 272
Automatic Conversions 204
beat enable/disable
Bite Volume 311, 321
compacting 203
converting ones that can’t play 205
copying while dragging 309
creating 199
deleted 573
definition 573
deleting 201-202
dragging and dropping 203
dragging and dropping in Sequence Editor 307
duplicating end to end 310
dry editing 312
dry editing basics 278
Editing with MIDI 279
exporting 194, 207
extending a selection 286
gain 311, 321, 385
icon for lost soundbites 200
in audio tracks 278
inserting in Edit window 308
managing 200-203
moving 308
moving multiple 309
moving vertically in Sequence Editor 309
name 196
naming 200
playback 57-62
question mark icon 200
red outline 307
region editing 272
removing from list 202-203
renaming in Sequence Editor 308
replacing in Sequence Editor 308
selecting 291, 315
selecting regions of 272
selecting unused 201
Sequence Editor 105
snapping to grid while moving 309
snapping to next/previous 309
Sort by file name 200
Sort by name 200
Sort by size 200
stutter effect 310
tempo 394
can’t be played 201
trimming 312
Soundbites list
folders 197-199
Spectra Display 112
Spiral In/Out 507
Split Notes 264
Staccato 373
Staff names
changing font in notation view 124
Staff system
INDEX

bracket 124
spacing 124
Staircase Up/Down 507
Standard beat clocks (see MIDI beat clocks)
Stem bounce 536, 540
Stereo
creating a stereo track 57
recording 260
soundbites 199
Stereo audio files
converting 205
size on disk 572
Stereo buses setting (Configure Studio Settings dialog) 23
Stop button 88
Stop Sounding MIDI Notes 250
Straighten Swing 125
Streamers
Generate Streamer Track for 427
Set Marker/Streamer Options 427
Toggle Streamer On/Off 427
Strength 356-357
Stretch 59, 232
Studio menu
Audio Patch Thru 257
Bundles 238
clear all clipping indicators 170
Click 96
value 96, 418, 443, 444, 445
volume 97
Click Preferences 96
Control Panel 87-101
Cursor Information 333
Event Information 333-334
MIDI interface
echo options with Patch Thru 256
Patch Thru 256
MIDI Keys 65
MIDI Patch Thru 254-256
Selection Information 334-336
Slave to External Sync 561, 562
Snap Information 331-333
Stop Sounding MIDI Notes 250
Tools 220
Track Assignments 61, 65
Track Selector 336
Suspend Track Grouping 77
Sustain MIDI controllers 303
Sustain pedal
Tap Tempo 563
Swing Quantize 355
Switch controllers 303
Switch Staff 119, 133
Sync (see also Synchronization)
Sync Recorded MIDI to Patch Thru 257
Sync to Port menu 556
Synchronization
basic types 555
MIDI beat clocks 555
converted from SMPTE 559
start/stop clocks 555, 559, 568
transmitting 566-568
recording in external sync 265
sample-accurate 554
Slave to External Sync 561, 562
SMPTE 554-555
Tap Tempo slaved to tape 564-565
System
troubleshooting 590
System errors 590, 593
System Exclusive 411-416
editing 303
SysEx editing window 413-414
handshake 416
Input Filter 412
insertion mode 413, 414
playback 411-412
recording 411-412, 415
replacement mode 413-414
System exclusive 303
System Requirements 15
Tap Tempo
Anchoring tempos 435, 438
beat value 435, 437
Change Tempo 435, 438-442
Conductor Track 562, 563-564
countoff 561
event 560-561
recording 562
recording music 562
slaved to tape 564-565
tap source 561
tempo maps 435, 563
turn Takes into Tracks option 388
Tap to Enter Tempo 92, 94
Tempo Controls 92-93
Remote Control 93
resolution 92, 437
Temporarily Group Selection 77
Temporarily Group Visible Tracks 77
Temporarily Toggle Track Grouping 77
Tempo
and audio 394
Text 138
box
defined 138
pasting into notation editor from other programs 141
typing and editing 140
Text menu
display 139
Threshold (in velocity compressor) 503
Time
anchored text 139
display 89
frame time 90-91
range selecting 284-286
Sequence Editor 109, ??-109
Shift (MIDI effects processor) 510
Time ruler 104
Sequence Editor 109
locating playback 109
Timecode bits 91
Time-stretching 513, 518
Timing resolution
beats per minute 92, 437
frames 91
INDEX

Title page 123
Toggle Bite Volume Bypass 385
Toggle Streamer On/Off 427
Tool palette 220, 312
  MIDI Editing 291, 299, 305
  Notation Editor 129
  preferences 231
  Studio menu 220
Tools
  Comp tool 226, 390
  Cycle to Next Tool 221
  Hand tool 226, 291, 305
  I-beam tool 222
  Insert/Reshape Curve 223
  Mute tool 224, 291, 296, 305
  palette 220
  Pencil tool 222
  Pointer tool 221
  preferences 231
  Reshape Mode menu 223
  Reshape tool 223
  Roll tool 226
  Scissors tool 224
  Slide tool 226
  Slip tool 226
  Trim tool 225
  Velocity tool 226, 291
  Zoom tool 223
Touch mode 467
Track 50, 73
  color 54
  display 105
  enable/disable 60
  folders (see Track folders)
  locked 111
  name underlined 111
  options 118
  selector list 41
  Stretch 395
Track Assignments command 61, 65
Track Color 54
Track folders 73
  Delete Track Folders 73
  in the Sequence Editor 106
  New Track Folder 73
  New Track Folder from Selected Tracks 73
Track Group Enable 77
Track Groups 73, 174, 481
  Add Selection to Group 77
  Delete Track Group 77
  Modify Track Groups 73
  New Track Group 73, 77, 160
  Remove Tracks from Group 77
  Set Temporary Group Type to Custom Type 77
  Set Temporary Group Type to Edit 77
  Set Temporary Group Type to Edit & Mix 77
  Set Temporary Group Type to Mix 77
  Suspend Track Grouping 77
  Temporarily Group Selection 77
  Temporarily Group Visible Tracks 77
temporarily overriding 77
Temporarily Toggle Track Grouping 77
Track Group Enable 77
Track Groups window 74
Ungroup Tracks 74, 77
Track Inspector window 42, 336
Track Selector 104, 336
Track selector button 40
list 41
Tracks
  (see also Audio tracks)
  color 54
  creating a MIDI track 63
  enable/disable 60
  folders (see Track folders)
  grouping (see Track Groups)
  instrument tracks 67-69
  selecting 283
  splitting in Notation Editor 125
  types of tracks 50
  virtual instrument tracks 67-69, 171
Tracks Overview
colors 54
Tracks window
colors 54
Transmit Sync 566-568
  echoing sync 568
  generate sync 568
  generating MIDI beat clocks 567
  generating MIDI Time Code 566
  preferences 566
Transport
cueing 88, 232
  preferences 232
Transmute 343-351
  audio 520, 527
  audio by adjusting pitch automation 345, 527
  audio by creating new soundbites 345
  chord symbols 135
  key/scale transposing 348-349
  Map 345-346
  MIDI effects processor 510
  non-destructive (without changing actual data) 510
  poly pressure option 345
  portamento controller option 345
  saving maps 346
Triggering MIDI notes 65
  Trim 340
  Trim Audio 340
  Trim End/Trim Start 340
  Trim Latch mode 467
  Trim plug-in (see DP Plug-ins Guide)
  Trim tool 225
  Trim Touch mode 467
  Trimming soundbites 312
Triples
  notating 121
Quantize 354
Troubleshooting 579-586, 590-593
  audio 591-592
  buffer size option grayed out 21
  disk errors 590
  error messages 590, 593
  file errors 590, 591
  fonts 141
  input monitoring delays 258
  Keypad on Windows 47
  monitoring problems 70
  system errors 590, 593
  Tuner plug-in (see DP Plug-ins Guide)
  Tuplets
    notating 121
    Quantize 354
  Turn Takes into Tracks 388
Type icon 209, 213
  Typing MIDI note entry 65
U
  Uber Tube plug-in (see DP Plug-ins Guide)
  UI
    scaling 15, 232
  Unassigned (instrument track) 68
  Unconsolidate Rests 120, 148
  Undo 357
  Undo History 272
    preferences 231
  Undo/Redo 337, 344
    Edit windows 278
    Record 88
  Ungroup Tracks 77
  Ungroup Tracks command 74
  Unlock 432
  Unlock Marker 427
  Unlocking markers 427, 432
  Unmuting
    audio tracks 246
  Unpack Clips 316
  Update existing fades option 328, 329
  Updates 16
  Urei metronome click 97
USB
  MIDI hardware (installing) 25
  Use Narrow view 159
  Use Same Movie for All Sequences 267, 269
  User interface 39-47
  User Presets 491
  User time (see User timestamp)
V
  Variable Bit Rate (VBR) Fast 542
  Variable Bit Rate (VBR) Standard 542
  VBR (variable bit rate) quality 542
  VCA
    track 51, 174, 481-485
    track group 73, 75, 481
  Velocities
    Change Velocity 367-371
    compressing 368, 503
    expanding 368
    limiting 368
Off Velocities 298, 368, 375
On Velocities 298, 368, 375
randomizing 370
Velocity compressor (MIDI effects processor) 503
Velocity tool 226, 291
Version numbers
Performer 593
Video Window (See Movie Window)
View by menu (Soundbites list 197
View Filter
Markers 433
View menu 273-274
scale
scale all windows up/down 15, 232
View Mode 112
Virtual instruments 67-69, 171
playing from computer keyboard 65
Volume
Click 97
creating volume changes 370-371
curve, removing 320
curves, inserting 319
curves, reshaping 320
cut, copy, paste 321
deleting an event (point) 320
disabling automation temporarily 321
faders 170
generating volume curves 472
graphic editing of 317
V-Rack Edit 489
V-Racks 216-218
declared 215
in Set List 215
instrument plug-ins 69
V-Rack Edit command 158, 159
VST 499
VST plug-ins
delay compensation 24
scanning
W
WASAPI 20
WAVE files
importing 205
Waveforms
explained 306
Welcome to Digital Performer window 18
Welcome window 18
What to quantize 352
Window controls 39
Window menu 43
Close 43
Close All Effect Windows 43, 490
Close All Windows 43
Pop Out of Consolidated Window 43
Push Window to Back 43
Set Focus to Next/Previous Cell 43
Window Sets 43
Window target 40
Window title 39
Windows 39-40
Audio driver 20
Num Lock key 47
WASAPI 20
Windows Video Exporter 547
Wiper
scrubbing with 250
zooming 249
Work Priority 22
X
X icon (on soundbite move handle) 196
X tool (see Mute tool)
Z
Zoom 110, 318
auto zoom track 276
back/forward 276
buttons 275
Edit windows 274-277
in/out 275
keystroke shortcuts 275
menu 275
MIDI Editing ??-293
Pitch ruler 293
playback wiper 249
scroll wheel 275
Sequence Editor 105
settings 276
shortcuts 224
to default zoom 275
to selected time range 276
to selection 276
to track 276
tool 223, 276
tool pad 275
wiper zoom 275
Zoom box 40
Zoom buttons 40
ZTX
formant-corrected 519
Pitch and Time Stretch Options 232
preferences 232
standard 520
technology explained 513